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C650 Bay Controller & Monitoring System

Chapter 1:  Getting Started

GE
Grid Solutions

 GETTING STARTED

1.1  Important procedures
Use this chapter for initial setup of your new C650 Bay Controller & Monitoring System.

1.1.1  Cautions and warnings
To help ensure years of trouble free operation, please read through the following chapter for information to help guide you 
through the initial installation procedures of your new relay.

Before attempting to install or use the unit, it is imperative that all warnings and cautions in this manual are reviewed to 
help prevent personal injury, equipment damage, and/or downtime.

The following safety and equipment symbols are used in this document.

Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

Indicates practices not related to personal injury.



1-2 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

1.1 IMPORTANT PROCEDURES CHAPTER 1:  GETTING STARTED

1.1.1.1  General cautions and warnings

The following general safety precautions and warnings apply.

Follow the requirements of this manual, including adequate wiring size and type, terminal torque settings, voltage, 
current magnitudes applied, and adequate isolation/clearance in external wiring from high to low voltage circuits.

Use the device only for its intended purpose and application.

Ensure that all ground paths are uncompromised for safety purposes during device operation and service.

Ensure that the control power applied to the device, the AC current, and voltage input match the ratings specified on 
the relay nameplate. Do not apply current or voltage in excess of the specified limits.

Only qualified personnel are to operate the device. Such personnel must be thoroughly familiar with all safety 
cautions and warnings in this manual and with applicable country, regional, utility, and plant safety regulations.

Hazardous voltages can exist in the power supply and at the device connection to current transformers, voltage 
transformers, control, and test circuit terminals. Make sure all sources of such voltages are isolated prior to 
attempting work on the device.

Hazardous voltages can exist when opening the secondary circuits of live current transformers. Make sure that 
current transformer secondary circuits are shorted out before making or removing any connection to the current 
transformer (CT) input terminals of the device.

For tests with secondary test equipment, ensure that no other sources of voltages or currents are connected to such 
equipment and that trip and close commands to the circuit breakers or other switching apparatus are isolated, 
unless this is required by the test procedure and is specified by appropriate utility/plant procedure.

When the device is used to control primary equipment, such as circuit breakers, isolators, and other switching 
apparatus, all control circuits from the device to the primary equipment must be isolated while personnel are working 
on or around this primary equipment to prevent any inadvertent command from this device.

Uses an external disconnect to isolate the mains voltage supply.

Ensure that all connections to the product are correct so as to avoid accidental risk of shock 
and/or fire, for example such as can arise from high voltage connected to low voltage terminals.

LED transmitters are classified as IEC 60825-1 Accessible Emission Limit (AEL) Class 1M. Class 1M 
devices are considered safe to the unaided eye. Do not view directly with optical instruments.

This product is rated to Class A emissions levels and is to be used in Utility, Substation Industrial 
environments. Not to be used near electronic devices rated for Class B levels.
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Figure 1-1: Front view of C650 half-rack unit

Figure 1-2: Front view of C650 full-rack unit
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1.1.1.2  Communication board withdrawal/insertion

The modular design of the unit allows for the withdrawal and insertion of the communication module.

Figure 1-1: Module withdrawal/insertion for half-rack unit shows the location of communication modules on the rear part 
of the relay. Qualified personnel must carry out the insertion or extraction of the communication boards only after 
disconnecting the unit auxiliary voltage and ensuring that all the rear terminals are potential free.

Communication boards are installed on the rear of the unit, with upper port reserved for the asynchronous 
communications board and CAN bus, and the lower port for the ETHERNET board. (The Ethernet module can be withdrawn 
or inserted only in models with Rear Ethernet Communication Board 2: "B", "C", "D" or "E". For the remaining options, 
Ethernet communications are included in the main CPU).

Figure 1-1: Module withdrawal/insertion for half-rack unit

MODULE WITHDRAWAL AND INSERTION SHALL ONLY BE PERFORMED BY DULY QUALIFIED 
SERVICE PERSONNEL. FOR PERSONAL SECURITY PURPOSES, BEFORE ACCOMPLISHING ANY 
WITHDRAWAL OR INSERTION OPERATION, THE UNIT MUST BE POWERED OFF AND ALL THE REAR 
TERMINALS MUST BE POTENTIAL FREE. THE UNIT MUST BE GROUNDED USING THE REAR 
GROUNDING SCREW.

Before performing any of these actions, control power must be removed from the unit and all the rear terminals must 
be potential free. A grounded anti-static wristband must be used when manipulating the module in order to avoid 
electrostatic discharges that may cause damage to the electronic components.

WITHDRAWAL: Loosen the small screws that keep the faceplate in place and extract the module. 

INSERTION: Insert the module and press it firmly in the case, until it is completely fixed. After this, bolt the faceplate 
screws and replace the control power. Check that the unit is fully operative.

GE Multilin will not be responsible for any damage to the unit, connected equipment or personnel whenever these 
safety rules are not followed.
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1.1.1.3  Magnetic module terminals

Magnetic module terminals are only available in models with Enhanced functionality (Display option E, C, D). The 
transformer module for the VTs and CTs is already connected to a female connector screwed to the case. The current 
inputs incorporate shorting bars, so that the module can be extracted without the need to short-circuit the currents 
externally. It is very important, for safety reasons, not to change or switch the terminals for CTs and VTs.

Figure 1-1: Rear view of C650 unit

GE Multilin will not be responsible for any damage of the relay, connected equipment or personnel whenever 
these safety rules are not followed.
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1.1.2  Inspection checklist
1. Unwrap the unit and inspect the unit for physical damage.

2. View the nameplate and verify that the correct model has been ordered and delivered. The model number is at the 
top.

Figure 1-2: Identification label (A4454P45)

Please ensure that you received the following items with your unit:

• Mounting screws for fixing the unit to a cabinet

• GE EnerVista™ DVD (includes the EnerVista 650 Setup software and manuals in PDF format)

• Wiring diagram.

• Certificate of Compliance

For product information, instruction manual updates, and the latest software updates, please visit the GE Multilin Home 
Page: http://www.gegridsolutions.com/multilin/
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Note: If there is any physical damage detected on the unti, or any of the contents listed are missing, please contact GE 
Grid Solutions, Multilin immediately:

EUROPE, MIDDLE EAST AND AFRICA:

GE Grid Solutions

Av. Pinoa, 10

48170 Zamudio, Vizcaya (SPAIN)

Tel.: (34) 94-485 88 54

Fax: (34) 94-485 88 38

E-mail: multilin.tech.euro@ge.com

AMERICA, ASIA AND AUSTRALIA:

GE Grid Solutions

650 Markland Street

Markham, Ontario

Canada L6C 0M1

North America toll-free: +1 800 547 8629

Tel.: +1 905 927 7070

Fax: +1 905 927 5098

E-mail: multilin.tech@ge.com

Should you wish to receive additional information, or for any particular problem that cannot be solved by referring to the 
information contained herein, please contact General Electric, Grid Solutions.

The information provided herein is not intended to cover all the details of the variations of the 
equipment, nor does it take into account the circumstances that may be present in your 
installation, operating or maintenance activities.
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1.1.3  Safety instructions
The C650 ground screw shown in Figure 1-3: Location of grounding screw must be correctly grounded.

Figure 1-3: Location of grounding screw

Before communicating with the C650 through the front USB port, ensure that the computer's power supply is grounded. 
When using a laptop, it is recommended that the power supply be disconnected. In many cases the laptop may not be 
correctly grounded either due to the power supply or to the connector cables used.

GE Multilin will not be responsible for any damage to the unit or connected equipment when this basic safety rule 
is not followed.
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1.1.3.1  General safety instructions

• Failure to practice safe working procedures is likely to damage the equipment, cause severe injury and/or death.

• The use of appropriate safety gloves, safety glasses and protective clothing are recommended during equipment
installation, maintenance and service of the equipment.

• All procedures must be strictly adhered to.

• Failure to observe and follow the instructions provided in the equipment manual(s) could cause irreversible
damage to the equipment and could lead to property damage, personal injury and/or death.

• Before attempting to use the equipment, it is important that all danger and caution indicators are reviewed.

• If the equipment is used in a manner not specified by the manufacturer or functions abnormally, proceed with
caution. Otherwise, the protection provided by the equipment may be impaired and can result in Impaired
operation and injury.

• Beware of potential hazards, wear personal protective equipment and carefully inspect the work area for tools
and objects that may have been left inside the equipment.

• Caution: Hazardous voltages can cause shock, burns or death.

• Test/Installation/Service personnel must be familiar with general device test practices, safety precautions and
follow standard ESD precautions to avoid personal injury or equipment damage.

• Before performing visual inspections, tests, or periodic maintenance on this device or associated circuits, isolate
or disconnect all hazardous live circuits and sources of electric power.

• Failure to shut equipment power off prior to removing the power connections could expose you to dangerous
voltages causing injury or death.

• All recommended equipment that should be grounded must have a reliable and un-compromised grounding path
for safety purposes, protection against electromagnetic interference and proper device operation.

• Equipment grounds should be bonded together and connected to the facility's main ground system for primary
power.

• Keep all ground leads as short as possible.

• At all times, equipment ground terminal must be grounded during device operation.

• While the equipment manual may suggest several safety and reliability steps, safety precautions must be used in
conjunction with the safety codes in force at your location.

• LED transmitters are classified as IEC 60825-1 Accessible Emission Limit (AEL) Class 1M. Class 1M devices are
considered safe to the unaided eye. Do not view directly with optical instruments.

• It is the responsibility of the user to check the equipment ratings and installation instructions prior to
commissioning, service.

• Use a lift system with side rails/bucket to reduce a fall hazard as opposed to other means when installing or
servicing.

• In addition to the safety precautions mentioned all electrical connections made must respect the applicable local
jurisdiction electrical code.

• Before working on CTs, they must be short circuited.

• Do not remove the voltage terminal blocks or disconnect the voltage input wires when the voltage phases are
live. The voltage inputs must be de-energized prior to any servicing.
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1.1.3.2  Warning symbols

The following table explains the meaning of warning symbols that may appear on the device or in this manual.

Note: Read all instructions included in package before using your product. Additional safety information

Product Safety Supplement document available at; http://www.gegridsolutions.com/ProductSafety/

The relevant circuit is direct current.
Le circuit principal est à courant continu.

The relevant circuit is alternating current.
Le circuit principal est à courant alternatif.

CAUTION: Refer to the documentation for important operating and maintenance 
instructions. Failure to take or avoid a specified action can result in loss of data or 
physical damage.
AVERTISSEMENT: Se réferer à la documentation pour l'entretien et l'utilisation. 
L'absence ou èviter de prender des mesures spècifiques peut entraîner des pertes 
de données ou même causer des dommages physiques.

WARNING! Dangerous voltage constituting a risk of electric shock is present 
within the unit. Failure to take or avoid a specified action can result in physical 
harm to the user.
AVERTISSEMENT! Tensions dangereuses comportant un risque de choc électrique 
sont presents dans l'equipement. L'absence ou èviter de prender des mesures 
spècifiques peut causer des dommages physiques à l'utilisateur.

CAUTION: Class 1M Laser (IEC 60825-1 Safety of laser products)
DO NOT VIEW DIRECTLY WITH OPTICAL INSTRUMENTS.
AVERTISSEMENT: Laser de classe 1M (IEC60825-1) ÉVITER DE REGARDER 
DIRECTEMENT LE DISPOSITIF QUI ÉMET LE LASER OPTIQUE.

CAUTION: Hot surface.
AVERTISSEMENT: Surface chaude.

Earth (Ground) Terminal.
Terminal de terre (masse).

Protective Earth Terminal.
Terminal de terre de protection.

!
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1.2  Overview

1.2.1  Introduction to the 650 family of relays
The GE 650 family relay is a new generation of digital and multifunction equipment that is easily incorporated into 
automation systems, at both the station and enterprise levels.

1.2.2  Hardware architecture

1.2.2.1  C650 basic design

The 650 is a digital-based device containing a central processing unit (CPU) that handles multiple types of input and output 
signals. The 650 family can communicate over a local area network (LAN) with an operator interface, a programming 
device, or another 650 device.

The CPU module contains firmware that provides protection elements in the form of logic algorithms, as well as 
programming logic gates, timers, and latches for control features.

Input Elements accept a variety of analog or digital signals from the field. The 650 isolates and converts these signals into 
logic signals used by the unit. 

Output Elements convert and isolate the logic signals generated by the relay into digital signals that can be used to 
control field devices.

Figure 1-1: 650 concept block diagram
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1.2.2.2  C650 signal type

Contact Inputs/Outputs: Digital signals.

CT and VT inputs: Signals coming from the inputs of current and voltage transformers, used for monitoring the power 
system signals.

Remote CAN Bus Inputs/Outputs: Signals associated with physical input/output contacts from a Remote Digital Input/
Output Module (CIO) connected to the 650 unit via the CAN Bus existing in options X, Y, Z, C and M for rear serial 
communication board 1.

PLC: Programmable Logic Controller. Control module that enables the unit configuration (assignment of inputs/outputs) 
and the implementation of logic circuits.

Remote inputs and outputs: Provide a means of sharing digital point state information between remote devices using IEC 
61850 GSSE and GOOSE messages. 

Analog Inputs: Signals associated with transducers.

1.2.3  Communications architecture
A dedicated serial port is used for communication between the main processor and the human-machine interface. The 
serial connection provides immunity against electromagnetic disturbances, thus increasing system safety.

All 650 units incorporate one USB serial port on the front of the relay. They can also incorporate up to two additional 
communication modules on the rear.

The rear serial communications board 1 provides asynchronous serial communications, using different physical media 
(Cable remote CAN bus I/O or RS485 + cable remote CAN bus I/O, plastic or glass fiber optic) depending on the selected 
model. The module incorporates two identical ports, COM1 and COM2. The COM2 port is multiplexed with the front port. 
Additionally, this module may incorporate a port for CAN bus communications, used for the connection to the remote CAN 
Bus I/O module. This feature increases the I/O capability by up to 100% if the maximum number of I/Os available inside the 
relay is not enough for a specific application. Available options are:

Table 1-1:  Rear serial communications board 1

Rear serial communications board 2 provides Ethernet communications (COM3). For C650 models, this board is only used 
for bootware and firmware upgrades, and is not available during normal operation.

Board Code Functionality

F Without additional communication ports

A Two RS485 ports

P Two Plastic F.O. ports

G Two Glass F.O. ports

X Two RS485 ports and a CAN port for remote CAN bus Inputs/Outputs 

Y Two Plastic F.O. ports and a CAN port for remote CAN bus Inputs/Outputs (fiber)

Z Two Glass F.O. ports and a CAN port for remote CAN bus Inputs/Outputs (fiber)

C CAN port for remote CAN Bus I/O (cable)

M RS485 port (Modbus RTU)+ RS485 port and a CAN port for remote CAN Bus I/O (cable)
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Available Options are:

Table 1-2: REAR ETHERNET COMMUNICATIONS BOARD 2

Finally, internal communication with input and output modules is performed via an internal CAN Bus, independent of the 
one used for remote CAN Bus I/Os. This provides increased communication speed, and acknowledgment of modules, 
abnormalities, etc. As this is a serial port supporting a communications protocol, it provides immunity against external or 
internal disturbances.

G 1588, 10/100 Base TX* + 100 Base TX 

H 1588, 10/100 Base TX* + 100 Base FX 

J PRP, 1588, 10/100 Base TX* + Redundant 100 Base FX 

K PRP, HSR, RSTP, 1588, 10/100 Base TX* + Redundant 100 Base FX 

L PRP, 1588, 10/100 Base TX + Redundant 100 Base TX 

M PRP, HSR, RSTP, 1588, 10/100 Base TX + Redundant 100 Base TX 
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Figure 1-1: Communications architecture (B6816F2)
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1.3  EnerVista 650 Setup software

1.3.1  System requirements
The relay front panel or the EnerVista 650 Setup software can be used to communicate with the relay. The software 
interface is the preferred method to edit settings and view actual values because the computer monitor can display more 
information.

The minimum system requirements for the EnerVista 650 Setup software are as follows:

• Pentium® 4 (Core Duo recommended).

• Windows® XP with Service Pack 2 (Service Pack 3 recommended), Windows 7, or Windows 8

• 1 GB of RAM (2 GB recommended).

• 500 MB free hard drive space (1 GB recommended).

• 1024 x 768 display (1280 x 800 recommended).

• USB serial and/or Ethernet port for communications with the relay.

1.3.2  Installation
After ensuring the minimum requirements for using EnerVista 650 Setup are met (see previous section), obtain the 
software from the GE EnerVista DVD, or download from: http://www.gegridsolutions.com/multilin/ as follows:

1. Insert the GE EnerVista DVD into the DVD drive of your computer.

2. Click Install Now and follow the installation instructions to install the complimentary EnerVista software.

3. When installation is complete, start the EnerVista Launchpad application.

4. Click IED Setup in the Launch Pad window.

Figure 1-2: Launchpad window
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5. Click Add Product and select the “C650 Bay Control and Monitoring System” relay from the Install Software window as 
shown below. Select the “Web” option to ensure the most recent software release, or select “CD” if you do not have a 
web connection, then click Add Now to list software items for the C650.

Figure 1-3: Add Product window

6. EnerVista Launchpad obtains the installation program from the Web or CD. Once the download is complete, double-
click the installation program to install the EnerVista 650 Setup software.

7. Follow the on-screen instructions to install the EnerVista 650 Setup software. When the Welcome window appears, 
click Next to continue with the installation. 

Figure 1-4: EnerVista 650 Setup installation
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8. When the Choose Destination Location window is displayed, change the installation directory id needed by clicking 
Change… and typing in the complete path name including the new directory name. Click Next to continue with the 
installation.

Figure 1-5: EnerVista 650 Setup installation cont.

9. The default program group containing the application is added to as shown in the Selected Program Folder window. 
Click Next to begin the installation process, and all the necessary program files are copied into the selected directory. 

Figure 1-6: Select program folder
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10. To complete the installation, select the desired language for startup.

Figure 1-7: Language window

11. Click Finish to end the installation. The C650 device has been added to the list of installed IEDs in the EnerVista 
Launchpad window, as shown below.

Figure 1-8: EnerVista Launchpad

1.3.3  USB-serial driver installation
1. Insert the GE EnerVista DVD into your CD-ROM drive.

2. Select the Driver USB TUSB3410 folder and click Win9x Setup.exe for Windows 9X operating systems or click "WinXP 
Setup.exe" for Windows 2000 and XP operating systems
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3. Follow the installation instructions to install the Win9X or WinXP USB-Serial Adapter drivers in your computer. Select 
the complete path, including the new directory name where the USB-Serial Adapter driver will be installed (for 
example: "C:\Program Files\Texas Instruments\USB-Serial Adapter\")

Figure 1-9: INSTALLATION PATH

4. When the installation is finished, the serial USB adapter driver is installed on the PC, ready to be enabled.

5. Use a USB type AB plug cable for the serial connection. Connect the USB type B plug connector on the USB port of the 
C650 unit (when it is switched on) and the USB type A plug connector on the USB port of your computer. 

6. The computer plug and play option detects new hardware connected and asks to update the controller drivers. When 
the update window appears, select the third option No, not this time, to perform the driver update directly from the 
files previously installed on your computer.

Figure 1-10: FOUND NEW HARDWARE WIZARD

7. Select the second option Install from a list or specific location (Advanced)
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Figure 1-11: FOUND NEW HARDWARE WIZARD

8. Select with a check mark in the exact path "C:\Program Files\Texas Instruments\USB-Serial Adapter\" where the 
drivers were previously installed.

Figure 1-12: SEARCH AND INSTALLATION OPTIONS

9. Continue with the installation process. Click Continue Anyway if a windows message appears. 
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10. Click the Finish button to complete the installation for the TUSB3410 device.

Figure 1-13: FINISHING THE INSTALLATION OF THE DEVICE

11. When finished with the "TUSB3410 device" installation, the computer starts installation of the "Texas Instrument UMP 
Serial Port". Follow the same procedure as in steps 6, 7, 8 and 9.

12. Click the Finish button to complete the installation for the USB - Serial Port.

Figure 1-14: FINISHING THE INSTALLATION OF THE USB

13. A message is shown stating, Your new hardware is installed and ready to use.

14. In case of any problems during the installation process, go to Settings > Control Panel and select Control Panel > 
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System > Hardware > Device Manager to see the list of all the hardware devices installed on your computer.

Figure 1-15: SYSTEM PROPERTIES

15. Check that the Multiport serial adapters option shows that TUSB3410 Device is correctly installed (no question mark 
should appear on it) and the USB - Serial Port has been correctly assigned to a COM port on your computer (it must 
have no question mark on it and a COM port number).

Figure 1-16: DEVICE MANAGER

16. In case of a yellow "!" mark on any of the previous options, TUSB3410 Device or USB - Serial Port, switch the 
computer off and then on again to force the drivers to reload. If the problem persists try to reinstall the drivers.
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1.3.4  Connecting EnerVista 650 Setup to the C650
This section is intended as a quick start guide to using the EnerVista 650 Setup software. Refer to section 4.1 in this manual 
for more information about the EnerVista 650 Setup software interface.

1.3.4.1  Configuring an Ethernet connection

Before starting, verify that the Ethernet network cable is properly connected to the Ethernet port on the back of the relay. 

1. Install and start the latest version of the EnerVista 650 Setup software (available from the GE EnerVista DVD or online 
from http://www.gegridsolutions.com/multilin (see previous section for installation instructions).

2. Go to Communication > Computer.

3. Select Control Type as MODBUS TCP/IP from the drop-down list. This option displays a number of interface 
parameters that must be entered for proper Ethernet communications.

4. Enter the relay IP address (from Setpoint > Product Setup > Communication Settings > Network > IP Address) in the 
IP Address field in MODBUS TCP/IP SETUP.

5. Enter the relay ModBus address (from Setpoint > Product Setup > Communication Settings > ModBus Protocol > 
ModBus Address COM1/COM2 setting) in the Unit Identifier (Slave Address) field.

6. Enter the ModBus port address (from Setpoint > Product Setup > Communication Settings > ModBus Protocol > 
ModBus Port Number setting) in the ModBus Port field.

7. The Device has now been configured for Ethernet communications. Click ON to begin communicating.

1.3.4.2  Configuring a USB-serial connection

Before starting, verify that the RS232 USB cable is properly connected to the USB port or the USB port on the front panel of 
the unit.

1. Check that the USB - Serial Adapter drivers have been properly installed. See 1.3.3 USB-serial driver installation.

2. Install and start the latest version of the EnerVista 650 Setup software (available from the GE EnerVista DVD or online 
from http://www.gegridsolutions.com/index.htm (see previous section for installation instructions).

3. Go to Communication > Computer and enter the following data referred to communications:

4. Under Control Type select No Control Type from the drop-down list.

5. Enter the communication Port corresponding to the USB – Serial port (COMX) previously installed.

6. Enter the relay Slave Address (Setpoint > Product Setup > Communication Settings > ModBus Protocol) in the Slave 
Address field. The default value is 254.

7. Enter the physical communications parameters (Baud rate and parity settings) from the Setpoint > Product Setup > 
Communication Settings > Serial Ports menu. Default values are 19200 for baud rate and none for parity.

8. The unit has now been configured for USB-serial communications. Click ON to begin communicating.
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1.4  650 hardware

1.4.1  Mounting & wiring
Refer to Chapter 3. Hardware for detailed mounting and wiring instructions.

1.4.2  650 communications
The EnerVista 650 Setup software communicates with the relay via the faceplate USB Type B port or the rear RS485/
Ethernet ports. To communicate via the faceplate USB Type B Port, a standard USB type AB plug cable is used. The USB 
type B plug end is connected to the C650 unit and the USB type A plug en is connected to the PC USB type A port.

To communicate via the C650 rear RS485 port from a PC RS232 port, the GE Multilin RS232/RS485 converter box is 
required. This device (catalog number F485) connects to the computer using a “straight-through” serial cable. A shielded 
twisted-pair (20, 22 or 24 AWG according to American standards; 0.25, 0.34 or 0.5 mm2 according to European standards) 
connects the F485 converter to the C650 rear communication port.

To minimize communication errors that can be caused by external noise, a shielded twisted pair is recommended. In order 
to avoid loops where external currents can flow, the cable shield must be grounded at one end only.

The converter box (-, +, GND) terminals are connected to the relay (SDA, SDB, GND) terminals respectively. For long 
communications cables (longer than 1 km), the RS485 circuit must be terminated in an RC network (i.e. 120 ohm, 1 nF). This 
circuit is shown in Figure 1-1: RS485 connection for 650 units, associated with the text Zt(*).

To minimize errors from noise, the use of shielded twisted pair wire is recommended. For correct operation, polarity must 
be respected, although a different polarity will not damage the unit. For instance, the relays must be connected with all 
RS485 SDA terminals connected together, and all SDB terminals connected together. This may result in confusion, as the 
RS485 standard refers to terminals “A” and “B”, although many devices use terminals labeled “+” and “-“. 

As a general rule, terminals labeled “A” should be connected to terminals “-“, and terminals “B” to “+”. The GND terminal 
should be connected to the common wire inside the shield, when provided. Otherwise, it should be connected to the shield. 
Each relay should also be daisy chained to the next relay in the system. A maximum of 32 relays can be connected in this 
manner without exceeding driver capability; for larger systems, additional serial channels must be added. It is also possible 
to use commercially available repeaters to increase the number of relays on a single channel. Do not use other connection 
configurations.

Lightening strikes and ground surge currents can cause large momentary voltage differences between remote ends of the 
communication link. For this reason, surge protection devices are provided internally. To ensure maximum reliability, all 
equipment should have similar transient protection devices installed.
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Figure 1-1: RS485 connection for 650 units

To communicate through the C650 rear Ethernet port from a PC, a crossover cable is required. If the connection is 
performed through a hub or a switch, a direct Ethernet cable is required.

1.4.3  Faceplate display
All messages are displayed on a 20x4 character LCD display. An optional graphic display is also available. Messages are 
displayed in different languages depending on the model and configuration settings.
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1.4.4  Maintenance

1.4.4.1  General maintenance

The C650 requires minimum maintenance once it is commissioned into service. C650 is a microprocessor based relay and 
its characteristics do not change over time; as such no further functional tests are required. While the C650 performs 
continual self-tests, it is recommended that maintenance be scheduled with other system maintenance. This maintenance 
can involve in-service, out-of-service, or unscheduled maintenance.

If it is concluded that the relay or one of its modules is of concern, contact GE Multilin or one of its representative for 
prompt service.

1.4.4.2  In-service maintenance

1. Visual verification of the analog value integrity such as voltage and current (in comparison to other devices in the 
system).

2. Visual verification of active alarms, relay display messages and LED indications.

3. Visual inspection for any damage, corrosion, dust or loose wires.

4. Event recorder file download with further event analysis.

1.4.4.3  Out-of-service maintenance

1. Check wiring connections for firmness.

2. Analog value (current, voltages, analog inputs) injection test and metering accuracy verification. Calibrated test 
equipment is required.

3. Protection element setpoint verification (analog values injection or visual verification of setting file entries against 
relay settings).

4. Contact inputs and outputs verification. This test can be conducted by direct change of state forcing or as part of the 
system functional testing.

5. Visual inspection for any damage, corrosion or dust.

6. Event recorder file download with further events analysis.

1.4.4.4  Unscheduled maintenance

Unscheduled maintenance such as during a disturbance causing system interruption:

• View the event recorder and oscillography for correct operation of inputs, outputs and elements.

1.4.5  Storage
Store the unit indoors in a cool, dry place. If possible, store in the original packaging. Follow the storage temperature range 
outlined in the Specifications.

To avoid deterioration of electrolytic capacitors, power up units that are stored in a de-energized 
state once per year, for one hour continuously.

To avoid deterioration of electrolytic capacitors, power up units that are stored in a de-energized 
state once per year, for one hour continuously.
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1.4.6  Repairs
The firmware and software can be upgraded without return of the device to the factory.

For issues not solved by troubleshooting, the process to return the device to the factory for repair is as follows:

• Contact a GE Grid Solutions Technical Support Center. Contact information is found in the first chapter.

• Obtain a Return Materials Authorization (RMA) number from the Technical Support Center.

• Verify that the RMA and Commercial Invoice received have the correct information.

• Tightly pack the unit in a box with bubble wrap, foam material, or Styrofoam inserts or packaging peanuts to cushion
the item(s). You may also use double boxing whereby you place the box in a larger box that contains at least 5 cm of
cushioning material.

• Ship the unit by courier or freight forwarder, along with the Commercial Invoice and RMA, to the factory. 

• Fax a copy of the shipping information to the GE Grid Solutions service department. Customers are responsible for
shipping costs to the factory, regardless of whether the unit is under warranty. 

Use the detailed return procedure outlined at

https://www.gegridsolutions.com/multilin/support/ret_proc.htm

The current warranty and return information are outlined at

https://www.gegridsolutions.com/multilin/warranty.htm

1.4.7  Disposal
The C650 is intended to be part of defective large-scale stationary industrial tools and large-scale fixed installations. This 
product cannot be disposed of as unsorted municipal waste in the European Union. For proper recycling return this 
product to your supplier or a designated collection point. For more information go to www.recyclethis.info.



1-28 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

1.4 650 HARDWARE CHAPTER 1:  GETTING STARTED



1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 2-1

C650 Bay Controller & Monitoring System

Chapter 2:  Product Description

GE
Grid Solutions

PRODUCT DESCRIPTION

2.1  C650 Overview
C650 is a, control, monitoring, metering and registering unit, suitable for many different applications, such as Bay Control 
and Monitoring Systems. Voltage, current, power, and energy metering is built into the relay as an optional feature (only 
included in C650 units with Enhanced functionality). Current parameters are available as total waveform RMS magnitude, 
or as fundamental frequency only RMS magnitude and angle (phasor).

Diagnostic features include a sequence of records. The internal clock used for time-tagging can be synchronized with an 
IRIG-B signal or via SNTP, DNP or Modbus protocol over the Ethernet port. From firmware version 7.00 and above, IEEE 
1588 time protocol is also available. Precise time stamping allows the sequence of events to be determined throughout the 
system. Oscillography data capture may be set to record the measured parameters before and after the event for viewing 
on a personal computer (PC). These tools significantly reduce troubleshooting time and simplify report generation in the 
event of a system fault.

The C650 unit provides one HMI with a configurable LED matrix of 16 LED indicators, 15 user programmable plus one non-
configurable LED (READY) that shows if the relay is in service. The HMI also provides 3 dedicated keys for command (I/O) 
and element selection (SEL). The LED matrix can be configured with any of the four switchgear elements with the open, 
closed and selected status available for each of them. A faceplate USB - serial port (COM2) may be used to connect to a PC 
for programming settings, configuration and the monitoring of actual values. A faceplate RS232 or USB port may be used 
to connect to a PC for programming settings and monitoring actual values.

A variety of communications modules are available. Two rear RS485 ports allow independent access by operating and 
engineering personnel. All serial ports use the Modbus® RTU protocol. Optional communications modules include a 
100BaseFX Ethernet interface which can be used to provide fast, reliable communications in noisy environments.
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Another option provides two 100BaseFX fiber optic ports for redundancy. The Ethernet port supports IEC 61850, Modbus®/
TCP, DNP 3.0 and TFTP protocols, and allows access to the relay via any standard web browser. The IEC 60870-5-104 
protocol is supported on the Ethernet port. The Ethernet port also supports the Parallel Redundancy Protocol (PRP) and 
High-availability Seamless Redundancy (HSR) of IEC 62439-3 (clause 4 (PRP) and clause 5 (HSR)) for firmware version 7.10 
and up.

The C650 IEDs use flash memory technology which allows field upgrading as new features are added:

Figure 2-1:  FUNCTIONAL BLOCK DIAGRAM

2.2  ANSI device numbers and functions

Main features available in the relay are gathered in tables below

(*) These functions are available only in C650 models with Enhanced functionality. See section 2.4 Order codes for details.

DEVICE NUMBER PROTECTION & CONTROL FUNCTIONS

25* Synchronism Check

79* Autoreclose (Four shot recloser)
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2.3  Other device functions

*This functionality is available for firmware version 7.10 onwards.

** Maximum number of events can vary depending on firmware version. See Snapshot events in section 2.5.2: Monitoring 
on page 2–9.

INPUTS/OUTPUTS METERING (OPTIONAL) COMMUNICATIONS

9 Analog Inputs:
5 current inputs (3 for phases, 1 for ground, 1
for sensitive ground),
4 voltage inputs (3 for phases, 1 for busbar or
auxiliary voltage) (Optional)

Metering Current for phases, ground and
sensitive ground inputs

Front USB port, Two rear RS485/fibre
optic ports, 10/100 TX and 100 FX
Mbps Ethernet port

Digital Programmable Contact Inputs (up to
64)

Voltages phase to phase and phase to
ground

ModBus Communications RTU and
over TCP/IP

Digital Programmable Contact Outputs (up to
16)

Real, Reactive and Apparent Power and
Power Factor

DNP Multimaster (3.0 Level 2)

32 Latched Virtual Inputs
32 Self-Reset Virtual Inputs

Three Phase Energy IEC 870-5-104

Virtual Outputs (up to 512) Frequency ModBus User Map

Tripping and closing circuit supervision Sequence components of currents and
voltages

IEC 61850 protocol

Remote Inputs/Outputs (GSSE and GOOSE
messages)

Pulse Counters

Analog Inputs (dCmA) Analog Comparators

*Digital Counters

USER INTERFACE RECORDS OTHERS

Alphanumerical display (4x20) Data Logger Breaking Arcing Current (I2t)

Graphic display (16 x 40) Demand Breaker Control

User Programmable LEDs (15) Event Recorder (up to 128 configurable
events)

IRIG-B synchronization/SNTP/
IEEE 1588

User Programmable Keys (up to 5) Fault Locator (up to 10 records) Logic Equations (PLC Editor)

Easy menu management Oscillography (up to 20 records) Operations (up to 24)

Configurable One-Line Diagram (Graphic
model only)

Snapshot Events (up to 1023)** Web Server Application

Phasor Diagram (available in EnerVista 650
Setup)



2-4 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

2.4 ORDER CODES CHAPTER 2:  PRODUCT DESCRIPTION

2.4  Order codes
C650 units are supplied as ½ 19” rack, 6 units high, containing the following modules: power supply, CPU, I/O modules, 
communication modules. The required information to completely define an C650 model is shown in Table 2–1:

Table 2-1: Order codes 
C650 - - - F - G - - - - - DESCRIPTION

DISPLAY OPTIONS (See Note 8)

B Basic Display and Basic Control Functionality. (See 
note 1) (See Note 2)

M Graphic Display with Standard Symbolsand Basic 
Control Functionality. (See note 1.
(See Note 2)

N Graphic Display with IEC symbols.and Basic Control 
Functionality.(See note 1) (See Note 2)

E Basic Display and Enhanced Control Functionality. 
(See note 1)

C Graphical Display with Standard Symbols and 
Enhanced Control Functionality. (See note 1)

D Graphical Display with IEC Symbols and Enhanced 
Control Functionality. (See note 1)

E Basic Display and Enhanced Control Functionality. 
(See Note 2)

C Graphical Display with Standard Symbols and 
Enhanced Control Functionality. (See Note 2)

D Graphical Display with IEC Symbols and Enhanced 
Control Functionality. (See Note 2)

FORM FACTOR 19" SERIAL COMMS

N RS485

REAR SERIAL COMMUNICATIONS BOARD 1

F None

A Redundant RS485 

P Redundant plastic fiber optic 

G Redundant glass fiber optic

X Redundant RS485 + fiber remote CAN bus I/O

Y Redundant plastic fiber optic + fiber remote CAN 
bus I/O

Z Redundant glass fiber optic + fiber remote CAN bus 
I/O

C Cable Remote CAN bus I/O

M RS485 + cable Remote CAN bus I/O

REAR ETHERNET COMMUNICATIONS BOARD 2 

G 1588, 10/100 Base TX* + 100 Base TX (See Note 3)

H 1588, 10/100 Base TX* + 100 Base FX (See Note 3)

J PRP, 1588, 10/100 Base TX* + Redundant 100 Base 
FX (See Note 4)

K PRP, HSR, RSTP, 1588, 10/100 Base TX* + 
Redundant 100 Base FX (See Note 4)

L PRP, 1588, 10/100 Base TX*+ Redundant 100 Base 
TX (See Note 4)

M PRP, HSR, RSTP, 1588, 10/100 Base TX*+ Redundant 
100 Base TX (See Note 4)

I/O BOARD IN SLOT F

1 16 Digital Inputs + 8 Outputs
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Notes:

(*)    For firmware version 7.00 or above, Port E is only intended for maintenance purposes.

2 8 Digital Inputs + 8 Outputs + 2 trip/close circuit 
supervision circuits

4 32 Digital Inputs

5 16 Digital Inputs + 8 Analog Inputs

I/O BOARD IN SLOT G

0 None

1 16 Digital Inputs + 8 Outputs

4 32 Digital Inputs (see Note 12)

5 16 Digital Inputs + 8 Analog Inputs (See Note 12)

AUXILIARY VOLTAGE

LO 24-48 Vdc (range 19.2 – 57.6)

HI 110-250 Vdc (range 88 – 300). 
120-230 Vac (range 96 – 250)

LOR Redundant LO 

HIR Redundant HI 

LANGUAGE

- English/English

F French/English

S Spanish/English

T Turkish/English

COMMUNICATION PROTOCOL

- Modbus® RTU, TCP/IP, DNP 3.0 Level 2, IEC 60870-
5-104

6 IEC 61850 (See Note 7), Modbus® RTU and TCP/IP, 
DNP 3.0 Level 2, IEC 60870-5-104

ENVIRONMENTAL PROTECTION

- Without Harsh (Chemical) Environment Conformal 
Coating

H Harsh (Chemical) Environment Conformal Coating

I/O Board in slot H (only for FORM FACTOR 19”)

0 None
1 16 Digital Inputs + 8 Outputs
4 32 Digital Inputs (See Note 12)
5 16 Digital Inputs + 8 Analog Inputs (See Note 12)

I/O Board in slot J (only for FORM FACTOR 19”)

0 None
1 16 Inputs + 8 Outputs
4 32 Digital Inputs (See Note 12)
5 16 Digital Inputs + 8 Analog Inputs (See Note 12)

I/O Board in slot 2H (only for FORM FACTOR 19”)

0 None
1 16 Digital Inputs + 8 Outputs
4 32 Digital Inputs (See Note 12)
5 16 Digital Inputs + 8 Analog Inputs (See Note 12)

I/O Board in slot 2J (only for FORM FACTOR 19”)

0 None
1 16 Inputs + 8 Outputs
4 32 Digital Inputs (See Note 12)
5 16 Digital Inputs + 8 Analog Inputs (See Note 12)
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(1) Control Functionality description for basic and enhanced models. See table below.  Order code option F4 requires option G4 or G5. 
Order code option F5 requires option G5. F1G5 is a valid selection and F5G1 is an invalid selection. Similarly, order code options J, 2H, and 
2J must be greater than or equal to the preceding order code option for options including boards 4 and 5.

(2)    The number selected for option G must be equal or higher than the number selected for option F for models including boards 4 and 5 
Control Functionality description for basic and enhanced models:

(3)    The number selected for option G must be equal or higher than the number selected for option F for models including boards 4 and 
5. Advanced functionality Level I:

G, H: IEEE1588 Precision Time Protocol (PTP), 61850 Edition 2.0. Digital counters. Max numbers of starts and Cold Load Pick-up 
functionality.

(4)    The number selected for option G must be equal or higher than the number selected for option F for models including boards 4 and 
5. Advanced functionality Level II:

J, L: Parallel Redundancy Port (PRP,) IEEE1588 Precision Time Protocol (PTP), 61850 Edition 2.0. Digital counters, DFT, 16 Switchgear 
mapped in IEC61850, 16 nodes CILO, mapping of BlkOpn and BlkCls leafs of XSWI nodes, Max numbers of starts and Cold Load Pick-
up functionality.

K, M: High-Availability Seamless Redundancy (HSR), Rapid Spanning Tree Protocol (RSTP), Parallel Redundancy Port (PRP,) IEEE1588 
Precision Time Protocol (PTC), 61850 Edition 2.0. Digital counters, DFT, 16 Switchgear mapped in IEC61850, 16 nodes CILO, mapping of 
BlkOpn and BlkCls leafs of XSWI nodes, Max numbers of starts and Cold Load Pick-up functionality.

(5)    The number selected for option G must be equal or higher than the number selected for option F for models including boards 4 and 
5. For special models requested, relay order code shall be codified as a standard model (Table 2-1) following by Abbreviation + MX 
where X indicates the number of special model selected.

(6)    The number selected for option G must be equal or higher than the number selected for option F for models including boards 4 and 
5. For non-last released firmware version models requested, relay order code shall be codified as standard model (Table 2-1),    
following by Abbreviation +VXXXXXBYYYYY where XXXXX is the firmware version requested and YYYYY is the corresponding 
bootcode version.

(7)    For C650 with Communication Option "6", Rear Ethernet Communication Board 2, and  firmware version 7.70 or higher, IEC 61850 Edition 
1.0 is also available in relays with this option selected. Relay will work with IEC 61850 Edition 1.0 or Edition 2.0 depending on which ICD is 
sent to the device. See section 7.6.3.1.2 Open IEC61850 file from disk / open *CID file on page  7–120.

(8)    The number selected for option G must be equal or higher than the number selected for option F for models including boards 4 and     
5. Display options with language selection:

Graphic display: available for English, French and Spanish languages.

Basic display: available for all languages

2.4.1  CIO Modules
For applications requiring a high number of inputs and outputs, C650 half-rack units can be connected up to two CIO 
modules (Remote CAN Bus I/O module) to use up to 4 additional boards. Also C650 19" rack models are available, which 
hold a C650 unit and 2 CIO modules. The 19" RACK device can manage up to 6 I/O boards, however it cannot be externally 
connected to a CIO module.

C650 units monitor and configure these I/O boards as if they were internal boards, located on slots F and G. In this case, 
the slots are labeled H, J, 2H, and 2J.

The required information to completely define a CIO Module is shown on Table 2–2.

Note1: The CIO 1 rear roulette must be set to 1 and the CIO 2 rear roulette must be set to 3. Both CIO units must be 
powered Off and ON after changing the roulette setting.

ANSI code Control Functionality C650 Basic C650 Enhanced

25 Synchrocheck X

79 Recloser X

Metering X

ANSI Code Protection & Control Functions C650 Basic C650 Enhanced

25 Synchronism Check X

79 Recloser X

Metering X
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Note2: For C650 half-rack models, only one CIO can be linked by CAN fiber to the 650 unit. The second CIO must be linked 
by CAN cable to the additional CIO.

Table 2-2: Order code for CIO module

(1) The digit selected for option J must be equal or higher than the digit selected for option H for models including boards 4 and 5.
       CIOH1J5**: is a valid selection       CIOH5J1**: is an invalid selection

CIO H - J - - DESCRIPTION

I/O BOARD IN SLOT H

1 16 Digital inputs + 8 outputs

2 8 Digital Inputs + 8 Outputs + 2 trip/close circuit supervision circuits

4 32 Digital Inputs

5 16 Digital Inputs + 8 Analog Inputs

I/O BOARD IN SLOT J

0 None

1 16 Digital inputs + 8 outputs

4 32 Digital Inputs (See Note 1)

5 16 Digital Inputs + 8 Analog Inputs (See Note 1)

AUXILIARY VOLTAGE

LO 24-48 Vdc (range 19.2 – 57.6)

HI 110-250 Vdc (range 88 – 300)
120-230 Vac (range 96 – 250)

ENVIRONMENTAL PROTECTION

H Harsh (Chemical) Environment Conformal Coating
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2.5  Technical specifications

 TECHNICAL SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT NOTICE

2.5.1  Control

AUTORECLOSE (79)
Schemes: ......................................................................................three-pole tripping schemes
Number of Shots:......................................................................up to 4 reclose attempts before lockout
Dead Time:...................................................................................independent dead time setting before each shot

adjustable between 0.00 and 900.00 s in steps of 0.01 s.
Reclaim Time: .............................................................................0.00 and 900.00 s in steps of 0.01 s
Condition Permission:.............................................................selectable by setting
Hold Time: ....................................................................................0.00 and 900.00 s in steps of 0.01 s
Reset Time: ..................................................................................0.00 and 900.00 s in steps of 0.01 s
Snapshot Events: ......................................................................selectable by setting

Protection settings can be modified after each shot through PLC programming (block signals are available after each shot).

SYNCHROCHECK (25)
Dead/live Level for Line and Bus:......................................0.00 to 300.00 in steps of 0.01 V
Maximum Voltage Difference:............................................2.00 to 300.00 V in steps of 0.01 V
Maximum Angle Difference:................................................2.0º to 80.0º in steps of 0.1º
Maximum Frequency Slip: ....................................................10 to 5000 mHz in steps of 10 mHz
Synchronism Time: ..................................................................0.01 to 1.00 s in steps of 0.01 s
Angle Accuracy: ........................................................................3º
Dead Source Function: ..........................................................None

(DL-DB) Dead Line - Dead Bus
(LL-DB) Live Line-Dead Bus
(DL-LB) Dead Line – Live Bus

Snapshot Events: ......................................................................selectable by setting

PULSE COUNTERS
Number of Pulse Counters Available: .............................up to 8
Multiplier Factor: .......................................................................0.000 to 65000.000 in steps of 0.001
Overload Factor: .......................................................................0 to 10000000 in steps of 1
Board Origin:...............................................................................all available input/output boards in the device. See order code (F, G, H, J)
Input Origin: ................................................................................up to 32 (depending on board type selection)

ANALOG COMPARATORS
Analog Input: ..............................................................................any analog value in the device
Analog Maximum Threshold Value:.................................-100000.000 to 100000.000 in steps of 0.001
Analog Minimum Threshold Value: ..................................-100000.000 to 100000.000 in steps of 0.001
Analog Delay: .............................................................................0.00 to 900.00 in steps of 0.01
Analog Hysteresis: ...................................................................0.0 to 50.0 in steps of 0.1
Analog Direction (for activation inside or outside the 

deadband: ..............................................................................IN or OUT

BREAKER SETTINGS
Number of Switchgear:..........................................................1 to 16 (selection of switchgear for breaker control)
Maximum KI2t: ...........................................................................0.00 to 9999.99 (kA)2s in steps of 0.01 (kA)2s
KI2t Integration Time: .............................................................0.03 to 0.25 s in steps of 0.01
Maximum Openings:...............................................................0 to 9999 in steps of 1
Maximum Openings in One Hour: ....................................1 to 60 in steps of 1
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Snapshot Events: ..................................................................... selectable by setting

BREAKER MAINTENANCE
KI2t Breaker Counters for Phases A, B, C: ..................... 0.00 to 9999.99 (kA)2s in steps of 0.01 (kA)2s
Breaker Opening Counters:................................................. 0 to 9999 in steps of 1
Breaker Closing Counters: ................................................... 0 to 9999 in steps of 1

SWITCHGEAR
Switchgear:................................................................................. 1 to 16 (configurable in Relay Configuration)
Snapshpt Events: ..................................................................... selectable by setting (for each switchgear, in System Setup)

DIGITAL COUNTERS
Function: ...................................................................................... Disabled, Enabled
Name:............................................................................................ any 12 alphanumeric characters
Preset: ........................................................................................... -2147483648, 0, +2147483647
Compare: ..................................................................................... -2147483648, 0, +2147483647

2.5.2  Monitoring

OSCILLOGRAPHY
Maximum Records: ................................................................. up to 20 oscillography records
Sampling Rate:.......................................................................... programmable to 4, 8, 16, 32, or 64 samples per power cycle
Capacity per record:............................................................... (27592 samples)/(number of oscillos x number of samples/cycle)
Trigger Position:........................................................................ 5% to 95% of total length
Trigger:.......................................................................................... programmable via PLC
Data: .............................................................................................. 5 current channels and 4 voltage channels

up to 16 digital channels programmable through PLC
Data Storage:............................................................................. non-volatile (flash) memory without battery
Format: ......................................................................................... International Standard COMTRADE ASCII - IEEE C37.111-1999
Automatic Overwrite:............................................................. selectable by setting (oscillography records can be concatenated)
Snapshot Events: ..................................................................... selectable by setting

SNAPSHOT EVENTS
Capacity*:.................................................................................... 1023 scrolling events
Time-tag:...................................................................................... 1 ms using an internal clock of 100 μs
Timing Accuracy: ..................................................................... 1 ms (using IRIG-B synchronization)
Triggers:........................................................................................ any element pickup, dropout, or operation

digital input/output change of state
virtual inputs and control events

Data Storage:............................................................................. non-volatile (flash) memory without battery
*Note: For firmware 7.20, up to 511 snapshot events are available. For firmware below 7.20, up to 479 snapshot events are available.

CONTROL EVENTS
Capacity: ...................................................................................... 128 events programmable through PLC
Time-tag:...................................................................................... 1 ms plus one PLC cycle using an internal clock of 100 μs. For digital inputs, 

the debounce time of these digital inputs must be added.
Timing Accuracy: ..................................................................... 1 ms (with IRIG-B synchronization input)
Trigger:.......................................................................................... Any digital signal programmable through the PLC
Alarm: ............................................................................................ Control events can be displayed as an alarm on the alarms panel. Information is 

always available through Communications for all models and in the HMI for models 
with a graphical display (M in order code).

Data Storage:............................................................................. non-volatile (flash) memory without battery
Control events are also displayed in the snapshot events recording

DEMAND
Channels: ..................................................................................... 9



2-10 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

2.5 TECHNICAL SPECIFICATIONS CHAPTER 2:  PRODUCT DESCRIPTION

Parameters:.................................................................................Ia (kA RMS), Ib (kA RMS), Ic (kA RMS), Ig (kA RMS), Isg (kA RMS), I2 (kA), P (MW), Q (MVAr) 
and S (MVA)

Current and Power Method: ................................................Thermal Exponential, Block Interval, Rolling Demand
Measurements:..........................................................................Each channel shows the present and maximum measured value, with date and time 

for the maximum recorded value.
Samples: .......................................................................................5, 10, 15, 20, 30, 60 minutes
Accuracy:......................................................................................±2%
Trigger Input: ..............................................................................selectable by setting (operation mode selection for the block interval calculation 
method)
Snapshot Events: ......................................................................selectable by setting

DATA LOGGER
Number of Channels:..............................................................1 to 16
Parameters:.................................................................................any available analog actual value
Samples: .......................................................................................1 second, 1, 5, 10, 15, 20, 30, 60 minutes
Storage Capacity:.....................................................................fixed, 32768 measurements

2.5.3  User-programmable

PLC LOGIC
Programming language:.......................................................The logical configuration is performed using graphical functions based on the 

IEC 61131-3 standard.
Lines of code*: ...........................................................................1000 total equations or 15360 bytes, whichever is greater (for versions >= 7.00)

640 lines of code or 15360 bytes, whichever is greater (for versions < 7.00)
(*) Note: Reserved Modbus memory space of PLC equations in text format is up to 15360 bytes. This space is shared with information 
configured in Enervista at Setpoint > Relay Configuration. According to this, the number of PLC equations can be limited by values 
configured on that section.
Supported operations: ...........................................................NOT, XOR, OR (2 to 8 inputs), AND (2 to 8 inputs), NOR (2 to 8 inputs), 

NAND (2 to 8 inputs), Latch (Reset Dominant), Edge Detectors, Timers.
2 inputs default gates, from 3 to 8 inputs provided in library format. 
Starting in version 7.20, analog operators are also available.

Libraries: .......................................................................................Logical gates fully programmable by user. Used to create user-programmable logic to 
be distributed as a single object.

Inputs: ............................................................................................any logical variable, contact or virtual input
Number of Timers: ...................................................................8 maximum in each logic scheme (provided in library format)

USER-PROGRAMMABLE LEDS
Number: ........................................................................................15 configurable LEDs plus the Ready non-configurable LED
Programmability: ......................................................................any logical variable, contact, or virtual input
Reset Mode:.................................................................................self-reset or latched. 

The first 5 LEDs (red) are latched by hardware, usually configured for trip signals.
The following 10 LEDs (yellow and green) are self-reset but can be latched through PLC 
configuration.

Reset Signal:................................................................................The LEDs can be reset by hardware, pressing the front “esc” key for more than 3 
seconds or using the LED reset signal through PLC configuration.

USER-DEFINABLE DISPLAYS
Number of Configurable Displays: ...................................1: one line diagram fully configurable. In graphical displays only
Number of Fixed Displays: ...................................................6: Metering (selectable between Primary and Secondary values), Snapshot Events (all 

and new), Alarms, Inputs and Outputs screen with test functionality for inputs and 
outputs. (In graphical displays only.)

Number of Selectable Displays:.........................................2: Logotype, Metering, or both in scrolling mode can be selected as the default screen 
in text display for all models (basic and mimic). The metering screen contains current 
and voltages for phases and ground in primary or secondary values.

USER-PROGRAMMABLE FRONT KEYS
Number of Configurable Keys: ...........................................5
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Operation: ................................................................................... Drive PLC operands

2.5.4  Metering (optional)

CURRENT
Accuracy (at nominal frequency): .................................... ±0.5% of the reading ± 10 mA from 0.05 to 10.00 A (for phases and ground)

±1.5% of the reading ± 1 mA from 0.005 to 5 A (for sensitive ground)
±1.5% of the reading for higher values

% of Load-to-trip Accuracy: ............................................... ±0.5% of full-scale

VOLTAGE
Accuracy: ..................................................................................... ±1% of reading from 10 to 208 V

REAL POWER (WATTS)
Accuracy: ..................................................................................... ±2.0% of the reading at -0.8 ≤ PF ≤ -1.0 and 0.8 < PF ≤ 1.0

REACTIVE POWER (VARS)
Accuracy: ..................................................................................... ±2.0% of the reading at -0.2 ≤ PF ≤ 0.2

APPARENT POWER (VA)
Accuracy: ..................................................................................... ±2.0% of the reading

WATT-HOURS (POSITIVE AND NEGATIVE)
Accuracy: ..................................................................................... ±2.0% of the reading
Range: ........................................................................................... -2147483 to +2147483 MWh
Parameters: ................................................................................ 3-phase only
Update Rate: .............................................................................. 100 ms

WAR-HOURS (POSITIVE AND NEGATIVE)
Accuracy: ..................................................................................... ±2.0% of the reading
Range: ........................................................................................... -2147483 to +2147483 MVArh
Parameters: ................................................................................ 3-phase only
Update Rate: .............................................................................. 100 ms

FREQUENCY

Accuracy: ..................................................................................... +/- 0.03Hz
 From 30 to 80 Hz

Note: Voltage input must be above 10 V to start measuring frequency

ANGLE
Accuracy: ..................................................................................... ±3º

2.5.5  Inputs

AC CURRENT INPUTS (OPTIONAL)
CT Ratio: ....................................................................................... 1.0 to 6000.0 in steps of 0.1
Rated Currents:......................................................................... Appropriate for 1 or 5 A. C650 has universal range for CT (valid for 1 or 5 A to only one 

terminal).
Relay Burden:............................................................................. < 8 mVA at 1 A 

< 200 mVA at 5 A
Input Impedance: .................................................................... < 8 mOhm 
Current Withstand:.................................................................. Continuous at 20 A

1 s at 500 A for phases and ground
1 s at 50 A for sensitive ground
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AC VOLTAGE INPUTS (OPTIONAL)
VT Ratio: ........................................................................................1.0 to 6000.0 in steps of 0.1
Rated Voltage: ...........................................................................275 Vac
Metering Range:........................................................................From 2 to 275 Vac
Relay Burden: .............................................................................0.05 VA at 120 Vac (50 or 60 Hz)
Voltage Withstand: ..................................................................Continuous at 275 V to neutral

1 min/hr at 420 to neutral
VAC inputs do not need varistors, as the impulse test is applied to 100% of the transformers

CONTACT INPUTS
Input Activation Threshold:..................................................10 to 230 Vdc in steps of 1 V (selectable by setting)
Impedance: .................................................................................> 100 kΩ
Maximum Error:.........................................................................±10% setting or ± 5 V
Load for Voltage Supervision Inputs (for board type 

2 (supervision) in slot H (for CIO selection) or in 
Slot F: ........................................................................................2 mA + V/100 kΩ

Voltage Threshold for Voltage Supervision Inputs 
(for board type 2 (supervision) in slot H (for CIO 
selection) or in Slot F:.........................................................< 19 V (fixed) (Typical)

<10 (fixed) (Worst case scenario)
Debounce Time: ........................................................................1 to 50 ms in steps of 1 ms
Recognition Time:.....................................................................2 ms (typical)
Timing Resolution:....................................................................1 ms
For Activation Voltage Threshold and Debounce Time there is a single setting for all inputs in the same group (all inputs sharing the same 
common).
Input Type and Delay Input Time are not grouped; there is a different setting for each input.
Input Type: ...................................................................................positive-edge/negative-edge/positive/negative
Delay Input Time:......................................................................0 to 60000 ms in steps of 1 ms (input signal time delay)

REMOTE INPUTS (IEC61850 GSSE/GOOSE)
Number of Input Devices:.....................................................32, configured from 64 incoming bit pairs
Number f Remote Devices: ..................................................16 (24 for relay version 7.10 and above)
Default States on Loss of Comms: ...................................On, Off, Latest/on, Latest/off

ANALOG INPUTS
Input Impedance: .....................................................................116Ω
Current Input (mADC):.............................................................0 to -1; 0 to +1; -1 to +1; 0 to 5; 0 to 10; 0 to 20; 4 to 20 (programmable)
Conversion Range:...................................................................-1 to +20 mA
Accuracy:......................................................................................±0.2% of full scale
Type: ...............................................................................................passive

IRIG-B INPUT
Amplitude Modulation:...........................................................DC SHIFT = demodulated input (no carrier)
Input Voltage: .............................................................................TTL
Input Burden:..............................................................................1.5 mA
Input Impedance: .....................................................................3.3 kΩ
Minimum Input Voltage:........................................................2.4 V
Maximum Input Voltage: ......................................................± 24 V
Formats:........................................................................................B000 (*) B001, B002 and B003 (*

(*) Signal combinations recognized in accordance with IRIG Standard 200-95
Isolation: .......................................................................................2 kV
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2.5.6  Real time clock
Accuracy: ..................................................................................... typical ±20 ppm
Backup Energy:......................................................................... more than 1 week
Note: For relay versions before 7.10, when the relay date and time is changed using any documented methods (Modbus, IRIG-B, SNTP, 
Front Panel...) the relay acknowledges and updates the time instantly but it takes nearly 3 minutes for the new time to be permanently 
stored in the Real Time Clock’s NVRAM.

2.5.7  Outputs
Single Contact Carry continuous: .................................... 16 A at 20ºC
Make and Carry for 1 s:......................................................... 60 A
Break at L/R of 40 ms: ........................................................... 0.3 A DC max. at 125 Vdc

0.25 A DC max. at 250 Vdc
Operate Time: ............................................................................ < 8 ms
Contact Material: ..................................................................... silver alloy
Output Logic Type, Output Type and Pulse Output Time are selectable by setting for each output
Output Logic Type: .................................................................. positive/negative
Output Type:............................................................................... normal/pulse/latch (selectable by setting for each output)
Pulse Output Time: .................................................................. 0 to 60000 ms in steps of 1 ms (applicable only to signals sent as pulse type)
Separate operate and reset signals can be configured by any digital signal programmable through the PLC
Contact Outputs (H31-H33, H34-H36) for board 

type 2 (supervision) in slot H (for CIO selection): .. The current seal-in circuit is used for verifying the current condition in a circuit during 
the time that the tripping contact remains closed. If the current in the tripping circuit is 
maintained over 500 mA, the function is sealed independently of the status of the 
function that caused the trip.

REMOTE OUTPUTS (IEC61850 GSSE/GOOSE)
Standard Output Points: ....................................................... 32
User Output Points:................................................................. 32

2.5.8  Control power supply

LOW RANGE (LO) ALL RANGES
Nominal DC Voltage: 24 to 48 V Power Consumption: Typical =25 VA, Maximum =45 VA
Min/Max DC Voltage 19.2 / 57.6 V Display backlight auto power-off mode after 15 minutes without touching 

any key, in order to ensure long life and 
minimum consumption

Note: Low range is DC only

Voltage Loss hold-up time:(*) 24 Vdc 30 ms
48 Vdc 100 ms

Note: (*) These figures have been calculated for models with the following characteristic:
- IEC Symbols Graphic display
- Rear Ethernet Communication Board 2: PRP, 1588, 10/100 Base TX+ Redundant 100 Base FX 
- F and G I/O Board:
        Slot F: 8 Digital Inputs + 8 Outputs + 2 Trip / Close circuit supervision circuits 
        Slot G: 16 Digital Inputs + 8 Outputs 

HIGH RANGE (HI) INTERNAL FUSE
Nominal DC Voltage: 110 to 250 V V: 250 VAC
Min/Max DC Voltage 88 / 300 V I: 2.5A
Nominal AC Voltage: 120 to 230 V Size: 5 x 20 mm
Min/Max AC Voltage: 102 / 250 V Type: Quick acting (F)
Voltage Loss Hold-up Time
(1/2 rack model):

200 ms typical
100 ms worst case 

UL listed miniature Fuse

Voltage Loss Hold-up Time
(full rack model):

50 ms worst case 
(without unit reset)
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2.5.9  Communications

FRONT PORT:
Front port: COM2
Type: USB type B Jack
Baud Rate: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600 and 115200 baud
Default Baud Rate: 19200 baud
Protocols: ModBus® RTU/DNP 3.0
Typical Distance: 3 m
Isolation: 2 kV
USB FEATURES:
Fully compliant with USB 2.0 full speed Specifications
Supports 12-Mbps USB data rate (full speed)
Supports USB suspend, resume, and remote wakeup operations
Supports two power source modes:
Bus-powered mode
Self-powered mode
Can support a total of 3-input and 3-output (interrupt, bulk) endpoints
ASYNCHRONOUS REAR PORTS:
None or one rear ports (depending on model): COM1, COM2 (rear COM2 multiplexed with front port)
Type (depending on model):
Model F None
Model A Redundant RS485
Model X Redundant RS485 + fiber CAN for inputs/outputs module 
Model P Redundant 1mm-plastic F.O.
Model Y Redundant 1mm-plastic F.O. + fiber CAN for inputs/outputs module 
Model G Redundant multimode glass F.O. 
Model Z Redundant multimode glass F.O. + fiber CAN for inputs/outputs module 
Model C Cable CAN port for I/O module 
Model M Cable CAN port for I/O module (cable) + RS485 (ModBus RTU)
Optic Features for ST Connector Devices: Wave length: 1300nm

Fiber type: multimode 62.5/125 μm or 50/125 μm
Baud Rate: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600 and 115200 baud
Default Baud Rate: 19200 baud
Protocols: ModBus® RTU/DNP 3.0/IEC103
Typical Distance: 1200 m for copper cable, 1000 m for glass fiber and 50 m for plastic fiber
Isolation: 2 kV
CAN PORT: 
Rear Port: CAN port in models C and M for asynchronous rear ports
Type: Multimode glass F.O. port with ST connectors
Fiber Wavelength: 820 nm
Fiber Type: Multimode 62.5/125 μm or 50/125 μm
Maximum Recommended Length: 300 m for cooper cable and glass fiber
Isolation: 2 kV
ETHERNET PORT:
Rear port: ETH_E/ ETH_A/ ETH_B
Type (depending on model):
Model G: 1588, 10/100 Base TX* + 100 Base TX
Model H: 1588, 10/100 Base TX* + 100 Base FX
Model J: PRP, 1588, 10/100 Base TX* + Redundant 100 Base FX
Model K: PRP, HSR, RSTP, 1588, 10/100 Base TX* + Redundant 100 Base FX
Model L: PRP, 1588, 10/100 Base TX* + Redundant 100 Base TX
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Model M: PRP, HSR, RSTP, 1588, 10/100 Base TX* + Redundant 100 Base TX 
     Note: (*) Ethernet port E (ETH_E) is intended only for maintenance purposes.
10/100BaseTX: RJ45 connector
100BaseFX: ST connectors
Wavelength: 1300 nm
Fiber Type: multimode 62.5/125 μm or 50/125 μm
Protocols: ModBus® TCP/IP

DNP over TCP/IP and UDP/IP
IEC 61850
http, ftp, tftp (allow the use of a standard Internet browser)

Typical Distance: 1000 m for glass fiber and 150 m for RJ45 cable
Response Time to ModBus Commands: 10 ms typical
Isolation: 2 kV
      Note: In Models C and D, the 10/100BaseTX port is selected by an internal switch.
      (see section 3.4.3: Cable/fiber Ethernet board on page 3–12)
      Note: Two witness LEDs for transmission and reception are included
SIMPLE NETWORK TIME PROTOCOL (SNTP)
Clock Synchronization error: <10 ms (typical)
PRECISION TIME PROTOCOL (PTP)
PTP IEEE Std 1588 2008 (version 2)
Power Profile (PP) per IEEE Standard PC37.238TM2011
Slave-only ordinary clock
Peer delay measurement mechanism
PARALLEL REDUNDANCY PROTOCOL (PRP) (IEC 62439-3 CLAUSE 4, 2012) 
Ethernet ports: A and B
Networks: 10/100 MB Ethernet
PARALLEL REDUNDANCY PROTOCOL (HSR) (IEC 62439-3 CLAUSE 5, 2012)
Ethernet ports: A and B
Networks: 10/100 MB Ethernet
RAPID SPANNING TREE PROTOCOL (RSTP) (IEC 62439-1, IEEE 801.2D)
Ethernet ports: A and B
Networks: 10/100 MB Ethernet
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2.5.10  Optical
Wave length: 1300 nm
Connector types: ST package style 
Fiber type: multimode 62.5/125 μm or 50/125 μm

Notes:

1. These optical power values are measured with the following conditions:

The Beginning of Live (BOL) to the End of Life (EOL) optical power degradation is typically 1.5 dB per industry
convention for long wavelength LEDs. The actual degradation observed in Agilent’s 1300nm LED products is <1 dB, as
specified in this data sheet.

Over the specified operating voltage and temperature ranges.

With HALT Line State, (12.5 MHz square-wave), input signal.

At the end of one meter of noted optical fiber with cladding modes removed.

The average power value can be converted to a peak power value by adding 3 dB. Higher output optical power
transmitters are available on special request.

2. The transmitter provides compliance with the need for Transmit_Disable commands from the FDDI SMT layer by 
providing an Output Optical Power level of <-45 dBm average in response to a logic “0” input. This specification 
applies to either 62.5/125 μm or 50/125 μm fiber cables.

3. This specification is intended to indicate the performance of the receiver section of the transceiver when Input Optical 
Power signal characteristics are present per the following definitions. The Input Optical Power dynamic range from the 
minimum level (with a window time-width) to the maximum level is the range over which the receiver is guaranteed to 
provide output data with a Bit Error Ratio (BER) better than or equal to 2.5e-10.

At the Beginning of Life (BOL).

Over the specified operating temperature and voltage ranges.

4. All conditions for Note 3 apply except that the measurement is made at the center of the symbol with no window 
time-width.

Transmitter characteristics

Parameter Min. Typ. Max. Unit Reference

Output Optical Power                   BOL
62.5/125 μm, NA = 0.275 Fiber    EOL

-19
-20

-14 dBm avg. Note 1

Output Optical Power                   BOL
   50/125 μm, NA = 0.275 Fiber    EOL

-22.5
-23.5

-14 dBm avg. Note 1

Output Optical Power at
Logic “0” State

-45 dBm avg. Note 2

Receiver characteristics

Parameter Min. Typ. Max. Unit Reference

Input Optical Power
Minimum at Window Edge

-33.9 -31 dBm avg. Note 3

Input Optical Power
Minimum at Eye Center

-35.2 -31.8 dBm avg. Note 4

Input Optical Power Maximum -14 dBm avg. Note 3
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2.5.11  Environmental
Operating Temperature:....................................................... - 10°C to + 60°C
Storage Temperature: ........................................................... - 40°C to + 85°C
Humidity (non-condensing): ............................................... 95%
Altitude: ........................................................................................ up to 2000 m
Class of Equipment: ................................................................ I
Equipment Mobility: ................................................................ fixed
Overvoltage Category: .......................................................... III
Pollution Degree:...................................................................... 2

2.5.12  Packaging and weight

FOR 1/2 RACK UNIT
Net Weight:................................................................................. 5 kg
Packaged Weight: ................................................................... 6 kg
Package Dimensions: ............................................................ 30 x 40 x 40 cm (D x W x H)

FOR ONE RACK UNIT
Net Weight:................................................................................. 5 kg
Packaged Weight: ................................................................... 6 kg
Package Dimensions: ............................................................ 30 x 40 x 40 cm (D x W x H)

2.5.13  Type tests

CATEGORY STANDARD CLASS TEST

SAFETY Dielectric voltage withstand IEC60255-27 2 KV / 2.3 KV

Impulse voltage withstand IEC60255-27 5 KV

Insulation resistance IEC60255-27 500 V (test level)

EMC Electrostatic Discharge Immunity IEC60255-26/IEC61000-4-2 Level 4

Radiated RF Electromagnetic Field Immunity IEC60255-26/IEC61000-4-3 Level 3

Electrical Fast Transient Immunity IEC60255-26/IEC61000-4-4 Zone A

Surge Immunity IEC60255-26/IEC61000-4-5 Zone A

Conducted RF Immunity IEC60255-26/IEC61000-4-6 Level 3

Power magnetic Immunity IEC60255-26/IEC61000-4-8 Level 5

Power Frequency Immunity IEC60255-26/IEC61000-4-16 Zone A

Damped Oscillatory Wave Immunity IEC60255-26/IEC61000-4-18 2.5 KV Common Mode 1 KV Diff. Mode

Voltage Dips & Interruptions IEC60255-26/IEC61000-4-11/
IEC61000-4-29

Levels based on IEC61000-4-11 & 
IEC61000-4-29

Ripple on DC IEC60255-26/IEC61000-4-17 15% Rated DC value

Radiated & Conducted Emissions IEC60255-26/CISPR11/
CISPR22

Class A

MECHANICAL Sinusoidal Vibration IEC60255-21-1 Class 1

Shock & Bump IEC60255-21-2 Class 1

Seismic IEC60255-21-3 Class 2

Enclosure Protection IEC60255-27/IEC60529 IP52

CLIMATIC Cold test (storage) IEC60068-2-1 -40˚C 16 hrs

Cold test (operational) IEC60068-2-1 -20˚C 16 hrs

Dry heat test (storage) IEC60068-2-2 85˚C 16 hrs

Dry heat test (operational) IEC60068-2-2 60˚C 16 hrs

Change of Temperature IEC60068-2-14 5 cycles (3+3) -20˚C/60˚C

Damp Heat Humidity Cyclic IEC60068-2-30 6 cycles (12+12) 55˚C @ 93% R.H.

Damp Heat steady state IEC60068-2-78 40˚C @ 93% R.H.
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Type test reports available upon request.

C650 has been designed to comply with the highest existing requirements. More specifically, UNIPEDE recommendations 
for high voltage substations are followed, even if for most applications such high classes are not required.

The relay complies with ANSI C37.90 standards, and has been designed to comply with international standards.

2.5.14  Approvals

EAC

The EAC Technical Regulations (TR) for Machines and Equipment apply to the Customs Union (CU) of the Russian 
Federation, Belarus, and Kazakhstan

APPLICABLE COUNCIL DIRECTIVE ACCORDING TO
CE COMPLIANCE Low voltage directive IEC60255-27

EMC Directive IEC60255-26

NORTH AMERICA UL UL508

EAC Machines and Equipment TR CU 010/2011

ISO Manufactured under a registered quality program ISO9001

Item Description

Country of origin Spain

Date of manufacture See label on the C650 unit

Declaration of Conformity and/or Certificate of Conformity Available on request
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2.6  External connections

Figure 2-2: C650 wiring diagram for 1/2 rack (189C4216H22)
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Figure 2-3: C650 wiring diagram for one rack (189C4216H25)
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Figure 2-4: Input/output configurations for boards F1 and F2 (189C4216H23)

Note: For detailed information about different I/O boards types configuration. Go to section 5.5.1 Input/output placement 
on page  5–53.
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3.1  Module description

Figure 3-1: Block diagram

C650 units incorporate the following modules:

• Power supply, which can be simple or redundant, depending on the selected model

• Front module with 15 configurable LEDs, 3 dedicated front keys and one USB-serial com port with alphanumerical (4
x 20) or optional graphical (16 x 40 characters) display. It includes the USB-serial connector on one lateral for
Modbus RTU communications. The HMI is connected to the main C650 module with an RJ45 straight through cable.

• Optionally, a Transformer module with 5 current transformers and 4 voltage transformers can be added.

• CPU including a powerful DSP for measure processing as well as synchronous and asynchronous communication
accessories.

• Input/Output module included in basic unit

• Optionally, a second I/O module can be added.
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3.2  Power supply
C650 can incorporate a simple or redundant power supply. The main and backup modules are identical.

In the case of a redundant power supply the two modules work in parallel continuously, distributing 50% of the load on 
each, thus ensuring greater reliability and an instantaneous load transfer from a failed power supply to the backup, 
without loss of time or module reset.

A contact relay connected to the low voltage side of the power supply monitors this voltage. The three contact terminals, 
normally open, common, and normally closed, are available at the external connector terminals. The contact monitors the 
power supply integrity and it is not controlled by the main microprocessor. In order to monitor whether the unit is ready to 
protect (READY), an auxiliary output contacts in the unit should be programmed. This “fly-back” type power supply provides 
high efficiency, stability and reliability and is available in two ranges, Hi and Low, in order to optimize efficiency and 
general performance, including the capability to tolerate auxiliary voltage interruptions (dips).

Oversized components highly resistant to temperature are used. For example, all capacitors are specified to stand up to 
105ºC, transformer components are specially designed to stand up to 180ºC, the MOSFET transistor has very low 
resistance, supports high voltage and is refrigerated by an oversized heat sink. This allows temperatures over the 60ºC 
shown in the Technical Characteristics section, and prolonged overloads such as those occurring at batteries in deep 
charge mode (much higher than +15% voltage shown in the Technical Characteristics section).

High capacitance capacitors are also used, providing high tolerance to prolonged dips, 100ms, even in the most 
unfavorable consumption conditions. This allows the relay to continue operating normally without undesired resets leaving 
protection features offline.

Fuse Requirements:

Note: Contact technical support for further guidance.

Control power supplied to the relay must be connected to the matching power supply range of the 
relay. If the voltage is applied to the wrong terminals, damage can occur.

The C650 relay contains electrolytic capacitors. These capacitors are well known to be subject to 
deterioration over time if voltage is not applied periodically. Deterioration can be avoided by 
powering the relays up once a year.

In the case of a blown fuse, replacement should be conducted by authorized/trained personnel 
only. Use replacement fuses with the same characteristics.

V: 250 VAC

I: 2.5A

Size: 5 x 20 mm

Type: Quick acting (F)

UL listed miniature fuse
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3.3  Mechanical description
The model number and electrical characteristics of the unit are indicated on the label located on the right side of the relay 
case.

The metallic case of the unit is highly resistant to corrosion. It is made of stainless steel (AISI 430), coated with an epoxy 
layer. The rest of the metallic pieces are covered with a high quality resistive coating that has successfully passed at least 
96 hours in the salt spray chamber (S/N ASTM B-117).

The front of the relay is made of a thermoplastic, flame retardant (V0, UL94), highly resistive material, which guarantees the 
unit’s immunity to all kinds of EMI/RFI/ESD interferences. There is also an IP52 (IEC 529) protection rating against dust and 
water through the front and with the relay mounted in the panel.

3.3.1  Mounting
The unit is designed for semi-flush mounting of the main box. The unit is secured to the panel with the 4 M6 screws 
provided with the unit. The wiring is at the rear of the unit. Drilling dimensions are shown in Figure 3-3: Drilling dimensions 
for 1/2 rack relay (B2216H03) on page  3–5, and Figure 3-4: Drilling dimensions for full rack relay (B2216H2) on page  3–6.

Figure 3-2: Panel mount

The relay width allows the mounting of one 19" unit or two 1/2 RACK units on a standard 19” panel, 8 units high.
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Figure 3-3: Drilling dimensions for 1/2 rack relay (B2216H03)
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Figure 3-4: Drilling dimensions for full rack relay (B2216H2)
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Figure 3-5: Drilling dimensions for  two 1/2 rack relays on one 19” rack 8U high (B1351H88)
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3.3.2  Rear description

The unit is wired through the terminal blocks located at the rear of the unit.

The magnetic module, which receives the CT secondary currents and the metering voltages, incorporates a very robust 
terminal board (columns A and B) The maximum tightening torque for the screws on terminal boards A and B is 1.2 Nm. 
Current inputs provide automatic shorting of external CT circuits. The maximum recommended cable section for this 
terminal board, with the appropriate terminal, is 6 mm2 (AWG 10).

The use of twisted pair wire and/or shielded is recommended for the CT secondary current Isg.

The rest of the terminal blocks, incorporate high quality connectors with the capacity to withstand a rated current of 15 A 
at 300 V. These terminal blocks admit a cable section of up to 2.54 mm2 (AWG 12).

The relay should be connected directly to the ground bus, using the shortest practical path. A tinned copper, braided, 
shielding and bonding cable should be used. As a minimum, 96 strands of number 34 AWG should be used.

The communication boards have different types of connectors depending on the selected media: RS485, glass or plastic 
fiber optic. 

Figure 3-6: Connector locations

Module withdrawal and insertion may only be performed when control power has been removed 
from the unit.

Proper electrostatic discharge protection (i.e. a static wrap) must be used when coming in 
contact with products while the relay is energized.
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Figure 3-7: Communications media selector guide

Communication boards are installed at the rear part of the unit, the upper port being reserved for the asynchronous 
communications board and CAN, and the lower port for the Ethernet board in any of its configurations.The USB port type B 
jack is located in the front HMI of the C650 unit.

TYPE OF COMMUNICATION CONNECTOR

RS485 / CAN cable Plug-in, 3 poles.

IRIG B Plug-in, 2 poles.

Plastic fiber optic Versatile Link

Ethernet 10/100 UTP (10/100BaseTX) RJ45, Class 5.

Glass fiber optic (100BaseFX) ST

Ethernet 100 FX (100BaseFX) ST

CAN Fiber ST

USB serial USB type B plug
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Figure 3-8: Detail of insertion/extraction of communication modules

Note: For version 7.00 and above, only the serial card can be removed

A grounded antistatic wristband must be used when manipulating the module in order to avoid electrostatic discharges 
that may cause damage to the electronic components

The transformer module housing the VTs and CTs is already connected to a female connector 
screwed to the case that incorporates shorting bars in the current inputs, so that it can be 
extracted without the need to short-circuit the currents externally. It is very important, for 
safety reasons, not to change or switch the terminals for CTs and VTs.

Special care is required when disconnecting CT wire leads from the terminal block. 

A high voltage potential can occur if a wire is disconnected while a CT is energized. 

CT isolation or de-energization is required prior to CT terminal wire removal.
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3.4  Wiring

3.4.1  External connections
C650 units can have different options for the slot F module:

Option 1: Board with 16 digital inputs and 8 outputs. 

Option 2: Board with 8 digital inputs, 4 circuit supervision inputs, 6 conventional outputs, and two current sensing 
outputs 

Option 4: Board with 32 digital inputs. 

Option 5: Board with 16 digital inputs and 8 analog inputs. 

For the modules in slots G, H, J, 2H, and 2J, there are different options:

Option 0: No board 

Option 1: Board with 16 digital inputs and 8 outputs. 

Option 4: Board with 32 digital inputs. 

Option 5: Board with 16 digital inputs and 8 analog inputs. 

The number selected for slot G must be equal or higher than the number selected for option F for models including boards 
4 and 5. F1G5 is a valid selection and F5G1 is an invalid selection.

Similarly, the number selected for slots J, 2H, and 2J must be greater than or equal to the preceding order code option for 
models including boards 4 and 5.

3.4.2  Digital inputs with trip circuit supervision 
The Option 2 I/O board includes two groups of 4 inputs with one common, in terminals F9 to F10. It also includes 6 auxiliary 
outputs, in terminals F19 to F30 with normally open contacts and two current sensing (latching) outputs (F31-F33 and F34-
F36).

Besides, there are 2 groups of inputs for trip circuit supervision. The first group includes two isolated digital inputs, 
terminals F1-F2 and F3-F4. The second group, symmetrical and identical to the first, is formed by isolated voltage inputs 
F15-F16 and F17-F18.

Using voltage detectors and current sensing, it is possible to implement several trip or close circuit supervision schemes, as 
well as protection of the unit output contact. 

In order to implement these schemes, it is not necessary to perform any setting in the unit. 
Internal functions are always operative. A detailed description of trip circuit supervision is 
included in chapter 5 in this manual.
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3.4.3  Cable/fiber Ethernet board
The Ethernet board for versions prior to 7.10 is an independent module located in the bottom at the rear part of the relay.

In models C and D (options for versions prior to 7.10), the 10/100BaseTx port is selected by an internal switch. This switch 
must be configured as shown in the Figure 3-9: Fiber/cable selection in order to select between fiber or cable.

Figure 3-9: Fiber/cable selection 

3.5  Transceiver optical power budget vs. link length
Optical Power Budget (OPB) is the available optical power for a fiber optic link to accommodate fiber cable losses plus 
losses due to in-line connectors, splices, and optical switches. OPB also provides a margin for link aging and unplanned 
losses due to cable plant reconfiguration and repair.

OPB (dB) Fiber optic Cable length 
(km)

62.5/125 μm 50/125 μm

11.4 8 0

10.9 7.4 0.3

10.5 7.1 0.5

9.6 6.2 1.0

8.5 5.3 1.5

7.3 4.3 2.0

6 3.3 2.5



1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 4-1

C650 Bay Controller & Monitoring System

Chapter 4:  Interfaces, Settings & Actual Values

GE
Grid Solutions

INTERFACES, SETTINGS & ACTUAL VALUES 

4.1  EnerVista 650 Setup software 

4.1.1  Introduction
The EnerVista 650 Setup software provides a graphical user interface (GUI) as one of two direct interfaces with a 650 
device. The alternate interface is implemented via the device faceplate keypad and display (see the Human Machine 
Interface (HMI) section in this chapter).

The EnerVista 650 Setup software interface provides access to configure, monitor, maintain, and trouble-shoot the 
operation of relay functions, connected over local or wide area communication networks. It can be used while 
disconnected (offline) or connected (online) with a 650 device. In offline mode, settings files can be created for eventual 
download to the device. In online mode, real-time communication with the device is supported.

The EnerVista 650 Setup software, provided with every C650 relay, can be run from a computer supporting Microsoft 
Windows XP(SP 2 or 3), Windows 7 or Windows 8. This chapter provides a summary of the basic EnerVista 650 Setup 
software interface features. The EnerVista 650 Setup Help File provides details for getting started and using the EnerVista 
650 Setup software interface.

The EnerVista 650 Setup software package uses ModBus protocol, and is designed to communicate with a single relay at a 
time. GE offers different communication software packages, such as GE-POWER, which can be used to communicate 
simultaneously with several relays.

EnerVista 650 Setup software provides an easy way to configure, monitor and manage all C650 features.
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4.1.1.1  Using settings files

The EnerVista 650 Setup software interface supports three ways of handling changes to relay settings:

1. In offline mode (relay disconnected), create or edit relay settings files for later download to communicating relays.

2. In online mode (relay connected), modify any relay settings via relay data view windows, and then save the settings to 
the relay.

3. Combining online and offline modes, create/edit settings files and then write them to the relay while the interface is 
connected to the relay.

Settings files are organized on the basis of file names assigned by the user. A settings file contains data pertaining to the 
following types of relay settings:

• Product Setup

• System Setup

• Protection Elements

• Control Elements

• Inputs/Outputs 

• Quick Settings

• Relay Configuration

• Logic Configuration

4.1.1.2  Viewing actual values

You can view real-time relay data such as input/output status and measurements while connected to a relay.

4.1.1.3  Viewing triggered events

In online mode, you can view and analyze data generated by triggered specified parameters, via one of the following:

• Event Recorder: The event recorder captures contextual data associated with the last 479 events, listed in
chronological order from most recent to oldest. For firmware version 7.20 or higher, 511 events are available. 

• Oscillography: The oscillography waveform traces and digital states are used to provide a visual display of power
system and relay operation data captured during specific triggered events.

4.1.1.4  Firmware upgrades

The firmware of a C650 device can be upgraded, locally or remotely, via the EnerVista 650 Setup software. Instructions are 
provided in Chapter 9: Bootcode and firmware upgrade.

Modbus addresses assigned to firmware modules, features, settings, and corresponding data items (i.e. default values, 
minimum/maximum values, data type, and item size) may change slightly from version to version of firmware.

The addresses are rearranged when new features are added or existing features are enhanced or modified.

4.1.1.5  One line diagrams

Users can configure a one line diagram (bay mimic) to be used in models with a graphical display.
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4.1.2  Main screen
The EnerVista 650 Setup software main window includes the following components:

• Title bar

• Main menu bar

• Main icon bar

• Working area

• Status bar

Figure 4-1: EnerVista 650 Setup main screen

Working Area

 Title
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4.1.3  Connect to the relay
To start communicating with the relay go to Communication > Computer in the main EnerVista 650 Setup menu. 

When working online, ensure that all relay communication parameters, such as baud rate, slave ModBus address, etc., 
match the computer settings before connected to the relay. 

Figure 4-2: Communication parameters menu

The Communication > Computer screen is divided in several subsections:

• Computer settings: Main communication parameters for serial communication and control type selection.

• Modbus/TCP Setup (if ModBus /TCP is selected as control type): Communication parameters for ModBus TCP
communication.

• Communication control: Device communication status (communicating or not communicating).

• Communication optimization: allows optimizing the communication time outs and failure establishing.

Safety instructions must be followed before connecting the computer to the relay. Safety instructions 
are detailed in section 1.1.3 Safety instructions. Connect the relay ground terminal and the 
communicating computer to a good grounding. Otherwise, communication may not be viable, or 
even, in worst cases, the relay and/or the computer can result damaged by overvoltages.
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4.1.3.1  Computer Settings

This section shows the communication parameters needed to establish communication with the unit, such as slave 
address, communication port, baud rate, parity, control type and startup mode.

Baud rate, parity, data bits, stop bits and ModBus slave address for Com2 (RS232 front port and second serial port in the 
rear communication board) are displayed in the default text on the relay main screen.

ModBus Slave Address: ModBus address used for serial and Ethernet communication; default 254.

Communication ports: Ports used in the computer for serial communication.

Baud Rate: Baud rate for serial communication (from 1200 to 115200 baud in EnerVista 650 Setup, from 300 to 115200 
baud in relay).

Parity: Parity for serial communication. None, odd or even can be selected.

Control Type: The available control modes are:

• No Control Type, this option selects the serial communication mode, for use with serial communication ports (front
port, RS485, or plastic or glass fiber optic).

• MODBUS/TCP, this option selects ModBus TCP/IP communication mode, for communication through the Ethernet port.
In this case, the top right window shows the typical parameters to be programmed; IP address, port address and unit
identifier in the MODBUS TCP SETUP section.

• MODEM, this option displays the parameter to set in case of using a modem for the communication, such as Phone
number, Time out (sec.), init. command, type of dialing (tones or pulses).

4.1.3.2  Communication Control

Located at the bottom of the screen, this section shows the status of communication with the relay. When the relay is not 
communicating, the message "650 Setup is not talking to a 650" is shown and the ON button is enabled. Click ON to start 
the EnerVista 650 Setup software communicating with the relay.

When the relay is communicating, the message "650 Setup is now talking to an 650" is shown and OFF is enabled. Click OFF 
to disconnect communications between the relay and PC.

4.1.3.3  Communication Optimization

Adjusting the parameters in the Communication optimization section can improve communication, although using the 
default values is recommended in most cases. These parameters are the maximum time to wait for a response in the relay 
(in ms) and the maximum number of connection attempts to perform before assuming communications failure.
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4.1.4  File management menu
File management with EnerVista 650 Setup software:

4.1.4.1  File Management menu for firmware below v7.70

4.1.4.1.1  Offline mode

Figure 4-3: Offline mode file management1

Run EnerVista 650 Setup

Open a *.650 file 
(“File>Open” menu)

Modify  Settings and relay 
configuration

Is it necessary to 
program 

additional logic?

Launch the Logic Configuration tool in EnerVista 
650 Setup (“Setpoint>Logic Configuration”)

Create new or modify the existing logic: 
(“File>Open Project”)

Compile and save logic file (*.pep) and drawing 
design (*.aut) in Logic Configuration tool

Exit PLC Graphic Editor and save the *.650 file 
from the main application menu

Is the relay 
completely 
configured? 

Save *.650 settings & configuration file 

Store in the computer the Logic configuration files (*.pep, *.aut, *.lib) as 
well as the *.650 for further logic changes. 

YES

YES

NO NO
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 1. “Relay and logic configuration” and “Protection and Control Settings” must be uploaded to the C650 relay or the device 
to operate properly

Table 4-1: Types of files generated by EnerVista 650 Setup software, offline: 

When using element libraries (both pre-existing in File Library > Open Library or created by the user in File Library > New 
Library), the program creates and manages the corresponding files (*.lib) in a folder named FDB (Functional Block 
Diagram). These files are used for PLC project compilation. The element library files must be stored with the other logic 
configuration files that build the PLC project (*.pep, *.aut, *.lib).

Besides sending configuration information to the relay (Settings & configuration in *.650 format), storing the complete set 
of *.650, *.pep, *.aut and *.lib files inside the relay is recommended (Communication > Upload info files to relay). This 
ensures that logic configuration files are available in future for logic modifications. Even if these files are not used by the 
relay, they are required to connect to the relay and analyze its configuration. The EnerVista 650 Setup software program 
manages the logic configuration files globally, so that when the *.pep file is uploaded to the relay, the associated *.aut and 
*.lib files are also stored.

Settings & Configuration File *.650
Logic Configuration Files (*.pep, *aut, *.lib)

*.pep *.aut *.lib

Description Settings and Configuration Section Header for Logic 
project

Graphical edition 
container. Logic 
equations (Virtual 
Outputs) in FDB 
format.

User programmable 
logic objects

Created by EnerVista 650 Setup Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Contents Relay configuration file containing all elements 
Settings, input/output and LEDs configuration, graphic 
display configuration, etc.
Equations corresponding to the logic created and 
compiled in the PLC Editor

PLC project file 
containing the 
necessary 
information 
relative to the relay 
model, logic 
libraries included in 
the project (*.lib), 
graphic file name 
(*.aut), etc.

PLC Project file 
containing all the 
drawings used by 
the logic, required 
by 650 relay based 
on IEC 61131-3 
standard. Functional 
block diagram (FDB).

Library file to be 
included as an 
object in a PLC 
project. Logic 
packages that can 
be stored into 
libraries and be 
distributed in 
different PLC 
projects.

How to save EnerVista 650 Setup:
File > Save *

PLC Editor:
File > Save Project

PLC Editor:
File > Save Project

PLC Editor:
File > Save Library

How to open EnerVista 650 Setup:
File>Open *

PLC Editor:
File > Open Project

PLC Editor:
File > Open Project

PLC Editor:
File > Library > New 
Library

How to 
transfer to 
relay

Connect with the relay (Communications > Computer)
Open the created file (File > Open *)
Send to relay from the menu: File > Send info to relay
Note that texts used in the configuration of inputs, 
outputs, etc. are not sent to the relay. The only texts 
sent to relay are operations, events, and LEDs.

Connect with the relay (Communications > Computer)
Launch Logic equations Editor (Setpoint > Logic 
Configuration)
Open the created PLC project (File > Open Project)
Compile the project (Run > Compile)
Now the logic (virtual outputs) can be sent directly to relay (Run 
> Send Equations to Relay). Texts of virtual outputs are not 
stored in the relay, only in the logic configuration files to be 
edited.

File storage inside the relay 
(RECOMMENDED)

Communication > Upload info files to relay through Ethernet 

Retrieval of files stored in the relay 
(RECOMMENDED)

Communication > Download info files from relay through Ethernet
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4.1.4.1.2  Online mode 

Figure 4-4:  Online mode file management

NO

Run  EnerVista 650 Setup

Connect to the relay 
(“Communication>Computer>ON”)

Modify and send to the 
relay protection Settings 
and relay configuration

Is it necessary to 
program 

additional logic?

Launch the Logic Configuration tool in EnerVista 
650 Setup (“Setpoint>Logic Configuration”)

Create new or modify the existing logic 
(“File>Open Project”)

Compile (“Run>Compile”)
and save logic file (*.pep) and drawing design 
(*.aut) in Logic Configuration tool (“File>Save 

Project”)

Send logic to relay (“Run>Send Equations to 
Relay”) and Exit PLC Graphic Editor

Is the relay 
completely 
configured? 

Save all settings & configuration (“File>Get info from relay”)

Store in the relay the Logic configuration files (*.pep, *.aut, *.lib) as well as the 

*.650 for further logic changes. (“Communication>Upload info files to relay”)

NO

YES

YES
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Table 4-2:  Types of files generated by EnerVista 650 Setup software, online 

Settings & Configuration File *.650
Logic Configuration Files (*.pep, *.aut, *.lib)

*.pep *.aut *.lib

Description Settings and Configuration Section Header for Logic 
project

Graphical edition 
container. Logic 
equations (Virtual 
Outputs) in FDB 
format.

User programmable 
logic objects

Created by EnerVista 650 Setup Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Contents Relay configuration file containing all  elements, 
settings, input/output and LEDs configuration, graphic 
display configuration, etc.
Equations corresponding to the logic created and 
compiled in the PLC Editor

PLC project file 
containing the 
necessary 
information 
relative to the relay 
model, logic 
libraries included in 
the project (*.lib), 
graphic file name 
(*.aut), etc.

PLC Project file 
containing all the 
drawings used by 
the logic, required 
by 650 relay based 
on IEC 61131-3 
standard. 
Functional block 
diagram (FDB).

Library file to be 
included as an object 
in a PLC project. 
Logic packages that 
can be stored into 
libraries and be 
distributed in 
different PLC 
projects.

How to 
transfer to 
relay

Connect with the relay (Communications > Computer) Connect with the relay (Communications > Computer)

Send settings and configuration from file Launch 650 Logic equations editor (Setpoint > Logic 
Configuration)

Open the created PLC project (File > Open Project)

Compile the project (Run > Compile)

Now the logic (virtual outputs) can be sent directly to relay (Run 
> Send Equations to Relay). Texts of virtual outputs are not 
stored in the relay, only in the logic configuration files to be 
edited.

Modify settings and configuration directly in the relay:

How to save EnerVista 650 Setup:
File > Get info from relay. User definable texts retrieved 
are operations, events, and LEDs.

PLC Editor:

File > Save Project File > Save Library

The relay does not 
provide this 
information unless 
the *.pep file is 
stored in the relay 

The relay does not 
provide this 
information unless 
the *.pep file is 
stored in the relay.

The relay does not 
provide this 
information unless 
the *.pep file is 
stored in the relay.

To store the logic configuration files in the relay use the 
Communication > Upload info files to relay option

How to store 
in the relay

Communication > Upload info files to relay through 
Ethernet

Communication > Upload info files to relay through Ethernet 

How to 
retrieve from 
the relay

Communication > Download info files from relay 
through Ethernet

Communication > Download info files from relay through 
Ethernet

REMINDER:

Logic programming support files (*.pep, *.aut, *.lib) CANNOT be retrieved directly from the relay.

It is necessary to do one of the following to store support files:

* Store in the PC 

* Upload to the relay (Communication > Upload info files to relay), after which they can be retrieved from the relay
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4.1.4.2  File Management menu for firmware v7.70 and above

Firmware versions 7.70 and above work with EnerVista 650 Setup software version 8.10 and above (see corresponding 
release notes).

EnerVista 650 Setup software 8.10 and above uses a new *.650 file format, combining previous settings and configuration 
files (*.650) along with Logic configuration files (*.pep, *.aut,*.lib) into a single *.650 file.

4.1.4.2.1  Offline mode (firmware v7.70 and above)

This mode will allow to create, open and/or modify only one file (*.650) instead of multiple files that are managed for 
firmware versions below 7.70 (setting and configuration file (*.650) and Logic configuration files (*.pep, *.aut,*.lib)). 

Existing *.650 files for firmware below 7.70 must be converted to files supported by firmware version 7.70 or above using 
Enervista 650 Setup version 8.10 or above. During the update process, a PLC project file (*.aut,*.pep,*.lib) must be selected. 
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Figure 4-5: Offline mode file management (firmware v7.70 and above))
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4.1.4.2.2  Online mode (firmware v7.70 and above)

This mode allows the modification of Logic Configuration that is running in the relay without having to store a backup of 
the PLC project (*.pep,*.aut,*.lib) on the local computer or by running Communication > Upload info files to relay as was 
done previously.

NOTE: Storing a local PC back-up of the following 650 relay configuration files before changing settings or logic is highly 
recommended:

• *.650 configuration file

• Logic programming support files (*.pep, *.aut, *.lib) inserted into *.650 (PLC Editor> File> Export)

Do not try to communicate with the relay during the start-up process. Doing so may cause loss 
of the configuration file (*.650), leading to unexpected behavior.

Communication can be established safely once relay has fully started-up. The relay has completed 
its start-up process when Menus are accessible from the HMI.
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Figure 4-6: Online mode file management (firmware v7.70 and above)
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4.1.5  EnerVista 650 Setup menu
The EnerVista 650 Setup menu structure is shown in Table 4-3: EnerVista 650 Setup menu structure. 

Unless specified, options are available in both online and offline mode.

(*) indicates options enabled only in online mode.  (**) indicates options enabled only in offline mode.

Table 4-3: EnerVista 650 Setup menu structure

The View > Language submenu allows the user to change the default language for the EnerVista 
650 Setup program. This feature is only enabled when the relay is not communicating and no file has 
been opened.

File Setpoint Actual Operations(*) Communication IEC 61850 
CONFIGURATOR Security View Help

New (**) Product Setup Front 
Panel

Fixed 
commands

Computer Login user Traces Instruction 
Manual

Open (**) System Setup Status Modem (*) Change 
Password

ModBus 
Memory 
Map

GE Multilin 
on the web

Save (**) Protection 
Elements

Metering Troubleshooti
ng (*)

User 
Managemen
t

Languages 
(**)

About 
EnerVista 
650 Setup

Save As (**) Control 
Elements

Inputs/
Outputs

Calibration (*)

Close (**) Inputs/Outputs 
Quick Settings

Records 
(*)

Upgrade Relay 
(*)

Config File
(* 650) Converter

Relay 
Configuration

Compare to 
settings file

Logic 
Configuration

Properties (**) Clock (*) Upgrade 650 
Web Server

Get info from 
relay (*)

Upload info 
files to relay

Send info to 
relay (*)

Download info 
files from relay

Print Setup (**)

Print Preview (**)

Print (**)

Print to file

PLC Checksum 
Calculation

Settings 
Checksum 
Calculation

Order Code

Exit
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4.1.6  File menu

(*) indicates online only, (**) indicates offline only

File

New (**) Create a new settings and configuration file, with the default relay 
settings and no configuration 

Open (**) Open a settings and configuration file for offline working. 

Save (**) Save *.650 settings and configuration file 

Save As (**) Save as *.650 settings and configuration file.

Close (**) Close the opened *.650 file in EnerVista 650 Setup. 

Config File (*.650) Converter Tool to convert the *.650 files from one version to another

Compare to settings file Compare online unit or opened settings file to another settings file

Properties (**) File properties for *.650.

Get info from relay (*) Retrieve the *.650 settings and relay configuration compiled equations 
from the relay.

Send info to relay (*) Send and write the *.650 settings and configuration to the relay. 

Print Setup (**) To configure printer settings.

Print Preview (**) Preview of settings and configuration file printing format.

Print (**) Launch the *.650 file to be printed.

Print to file (*.xls) (**) *.650 printed to file in excel format. 

PLC Checksum Calculation Calculate the CRC of PLC equations of the .650 file (When a .650 is 
uploaded to the relay, the calculate PLC CRC and the actual value of the 
PLC CRC read from the relay must match).

Settings Checksum 
Calculation

Calculate the CRC of settings of the .650 file (When a .650 is uploaded to 
the relay, the calculate Setting CRC and the actual value of the Setting 
CRC read from the relay must match).

Order code(*) Option available for C650 with firmware version 7.00 or above. This 
allows a model to have special functionality (see model selection) with 
password requirements. For detailed information go to section 9.2.2.3 
Order code upgrade process on page 9–26. 

Exit Quit the application closing all the open windows.
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4.1.6.1   New

Use the File > New menu option to create a new default settings file while working offline.

To access this menu, there must be no communication between the Enervista 650 Setup program and the relay (offline 
mode).

1. Select File > New.

EnerVista 650 Setup opens a pop-up window with a list of all files available for different models/firmware versions.

– Relay Selection: Select a 650 family relay (F650, R650, C650, W650 or G650).

– Redundancy Selection (firmware v7.00 and above only): Select to include files for F650/C650 relays with Rear
Ethernet Communications 2 Board options J, K, L and M.

– Models and Firmware Selection: Click to select one of the different models and firmware versions available.

2. Once you have selected a file, click OK and wait until the file has finished loading.
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3. A message indicates when the new *650 file has been created. Click OK to access the new file in offline mode.

4.1.6.2  Open

Use the File > Open menu option to open an existing settings file while working offline.

To access this menu, there must be no communication between the Enervista 650 Setup program and the relay (offline 
mode).

Open a *.650 configuration file for firmware versions below 7.70:
• Navigate to File > Open and select a file to open.

Figure 4-7: Open file menu

Open a *.650 configuration file for firmware versions 7.70 and above:

Enervista 650 Setup version 8.10 or above is required.

1. Navigate to File > Open and select a file to open.

– If the file is a firmware v7.70 or higher file, or has already been converted, proceed to edit the settings and
configuration.

– If the file has logic configuration that has not yet been updated for firmware v 7.70 and higher, continue to follow
these steps.
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2. The following message is shown:

Click OK to continue with the update process.

3. Select a name and path for the new, updated *650 file being created.

A message explains that the *.650 file needs a PLC project
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4. Select PLC files (*.pep, *.aut, *.lib) as prompted.
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Depending on the *.650 file and selected PLC project files, one of the following messages may be displayed:

5. Upon successful file conversion, the newly converted *.650 file is saved.

Message Meaning

Warning: Opening a file with firmware version x.xx while editing a file 
with firmware version y.yy
Logic might be modified. Continue anyway?

The version of the *.650 configuration file and version of the PLC 
project (*.pep, *.aut,*.lib) do not match.

Some PLC project variables may not be supported by the *.650 
configuration file.

Compiled equations are different from the ones stored. Do you want 
to overwrite the stored equations?

Logic equations compiled in the *.650 configuration file do not match 
equations in the selected PLC project (*.pep, *.aut,*.lib). 

Select Yes, and logic configuration from the selected PLC project 
(*.pep, *.aut,*.lib) will be compiled and saved into *.650 configuration 
file.

Select No, and the original logic will remain in the *.650 configuration 
file.

File conversion failure. You must select an existing or a new PLC 
project to continue with file conversion.

This message indicates that the conversion process is unsuccessful 
because a PLC project has not been selected.

A PLC project (*.pep, *.aut,*.lib) must be selected for insertion into the 
*.650 configuration file, and the conversion process restarts.
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4.1.6.3  Save/Save as

The Save as and Close file options are used to save the *.650 file into the computer and to close the current file. To work in 
offline mode for settings and configuration editing, a new *.650 file can be opened without closing the previous file.

To access this menu, there must be no communication between the Enervista 650 Setup program and the relay (offline 
mode).

During settings and configuration edits, saving your file regularly is recommended. Unsaved changes will be lost when the 
file is closed.

Figure 4-8: Save/Save as file menu

4.1.6.4  Close

In addition to closing the working file, the File > Close option is used to clear all data in the EnerVista 650 Setup program, 
enabling the Language, Upgrade firmware version, and Upgrade Operating system menu options.

Use the File > Close menu option to close a settings file while working offline.

To access this menu, there must be no communication between the Enervista 650 Setup program and the relay (offline 
mode).

If File > Close is selected during *.650 configuration process, without first saving the file (File > Save), the following warning 
message is shown:
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Click OK to open the File > Save/Save as window, or Cancel to close without saving.

4.1.6.5  Configuration file converter 

The configuration file converter tool provides automatic conversion of configuration files from and older firmware version 
to a newer version. In order to convert a configuration file, follow these steps:

1. Working in offline mode, go to File > Config File (*.650) Converter

2. Select the file to be converted.

3. After source file selection is complete, select conversion settings. Make the following selections:

Source Model: Indicates source C650 model and original version of selected file.

Destination model: Drop-down list of available C650 models and firmware versions. Select a
destination model and firmware version. In the bottom part of this section, a
brief description of all models affected is displayed in green after selecting one
model in the list. 

Source file path Indicates the path where source model file is located.

Figure 4-9: Config file (*650) converter menu

Source Model

Destination Model

Source file path
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It is possible to change the model type (FXGX) using the conversion tool. It must be taken into account that part of the logic 
can be readjusted to fit the new input and output board selection. Notice also that the external wiring of input and output 
boards is different for type 1, 2, 4 and 5.

File conversion to firmware version 7.70 or above

The *.650 configuration files for firmware v7.70 and above include the logic configuration and don’t require separate PLC 
project files (*.pep, *.aut, *.lib), some extra actions are required when converting configuration files from below firmware 
v7.70 to firmware v 7.70 or above.

After selecting the *.650 source file and conversion settings:

• If the source (*.650) configuration file does not contain Logic configuration, file conversion is completed automatically.

• If the source (*.650) configuration file contains Logic configuration, a PLC project (*.pep, *.aut, *.lib) must be selected
for insertion into the converted (*.650) configuration file.:

The selected PLC project file is checked against the (*.650) configuration file to ensure they match. If the files do not match, 
the following message pops-up:

 

Select Yes, and the equations available on selected PLC project (*.pep, *.aut, *.lib) will be compiled and stored into (*.650) 
configuration file. New equations will overwrite the equations existing in (*.650) configuration file
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Select No, and the following message will display to indicate that file conversion process has failed.

 

To convert the *,650 file, a new PLC project (*.pep, *.aut, *.lib) must be selected for insertion into the converted (*.650) 
configuration file.

Note: If the PLC editor is closed before selecting, compiling and storing a PLC project, the file conversion process will not be 
successful.

4.1.6.6  Properties

When this option is selected, the program displays the relay model information, firmware version, etc. of the file being 
edited, as shown:

Figure 4-10: File properties menu

4.1.6.7  Print options

The printing options are active only in offline mode with a file open, and not in online mode, connected with the relay.

Print setup

Option to configure the printer options and settings.
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Print preview

Option to preview the whole settings and configuration file (*.650) in paper format to be printed as shown:

Figure 4-11: Print preview of settings file

Print

Option to print the relay configuration using the PC default (active) printer on port COMx or LPT. This option is active only in 
offline mode and in file edition (not in online mode while connected to the relay).

Print to file (*xls)

Option to export the configuration file to an Excel file.

4.1.6.8  Compare to settings file

This tool provides an automatic comparison of two different configuration files, or of an online unit to one settings file.

Open the source *.650 file and select the version and model to compare against. The results of the comparison are 
displayed as shown:
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Figure 4-12: Compare to settings file

4.1.6.9  PLC checksum calculation

When working in offline mode, the PLC Checksum calculation option calculates the CRC of the PLC equations and Relay 
configuration section for the open *.650 file. When a *.650 file is uploaded to the relay, the calculated PLC Checksum and 
the actual value of the PLC Checksum read from the relay (Actual values > Status > System Info) must match.

In order to calculate this checksum, the following sections of the * .650 file are considered:

• All equations compiled in the file and located in EnerVista 650 Setup Setpoint > Logic configuration

• Configuration available in the file and located in EnerVista 650 Setup Setpoint > Relay configuration, excluding:

– HMI tab configuration

– All configured text

– Opening and closing time in the Switchgear section

4.1.6.10  Setting checksum calculation

When working in offline mode, the Settings Checksum calculation option calculates the CRC of different configured 
settings for the open *.650 file. When a *.650 file is uploaded to the relay, the calculated Settings Checksum and the actual 
value of the Settings Checksum read from the relay (Actual values > Status > System Info) must match.

In order to calculate this checksum, the following sections of the * .650 file are considered:

• All settings in the relay configuration section (Setpoint > Relay configuration) excluding:

– Those communication settings: Setpoint > Product Setup > Communication settings > SerialPorts or
Network (Ethernet) or Modbus Protocol or Routing

– Relay calibration factors

– Opening and closing time in the Switchgear section
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4.1.7  Setpoint menu

(*) indicates online only, (**) indicates offline only

4.1.7.1  Product setup menu

(*) indicates online only, (**) indicates offline only

4.1.7.2  Communication settings menu

This section details the settings related to communication parameters for the different protocols available in the C650.

Setpoint

Product Setup Communications settings for all protocols and physical mediums. ModBus user map 
definition, oscillography, data logger  demand settings and Time Settings.

System Setup General Settings, Flex Curves Definition, Breaker settings, maintenance, switchgear 
snapshot events management and Miscellaneous Settings.

Control Elements Synchrocheck, autoreclose, Pulse Counters, Analog comparators, Digital Counters and 
PLC Timer Masks.

Inputs/Outputs Contact I/O settings for all boards available in device, Remote Comms Force Outputs and 
Virtual inputs.

Quick Settings Menu that encompass the most important settings to configure the device such as; 
Current and Voltage sensing or current protection element.

Relay Configuration Configuration of Outputs, LEDs, Operations, Protection Elements, Oscillography, Control 
Events, Control Elements, Switchgear, Inputs, Virtual Inputs, Operations and HMI. Whole 
relay configuration with internal relay signals or user-definable ones as logic (virtual 
outputs).

Logic Configuration Logic configuration graphic editor (PLC Editor). It is a PLC Project file editor that contains all 
the internal drawings used to make the logic (virtual outputs) based on IEC 61131-3 
standard. Functional block diagram (FDB).

Clock (*) Relay synchronization to computer clock or to user-definable date and time. Online mode 
only.

Product Setup

Communication 
Settings

Serial Ports, Network (Ethernet), ModBus Protocol, DNP Slave, IEC 870-5-104,  SNTP settings 
and procome (if available on model selection), PTP1588 and Routing (for firmware version 
7.00 and higher) 

ModBus User Map ModBus user map definition. The ModBus user map is formed by 256 records, selectable 
from the complete relay ModBus map.

Oscillography Oscillography settings (trigger position, samples per cycle, etc.). The trigger and digital 
channels (up to 16) must be configured in Setpoint > Relay configuration.

Data Logger Data logger configuration

Demand Demand settings. The demand trigger and demand reset signals must be configured in 
Setpoint > Relay configuration

Time Settings Time settings.

COMMUNICATIoN 
SETTINGS

Serial Ports Baud rate and parity for COM1 and COM2 serial communication ports.

Network (Ethernet) Ethernet communication parameters for ETH_1/ETH2 or ETH_E/ETH_A/ETH_B 
(Depending on model) (IP Address, Netmask, Gateway IP)

NOTE: The ModBus Slave address used by Ethernet ports is the one set for 
COM2.EnerVista 650 Setup software allows programming two different Ethernet 
addresses, but the first IP has always to be set as the second IP Address is an Alias.
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(*) indicates online only, (**) indicates offline only

4.1.7.3  System setup menu

(*) indicates online only, (**) indicates offline only

4.1.7.4  Breaker menu

ModBus Protocol ModBus Slave Addresses for serial and Ethernet communication and the ModBus port 
number used for ModBus TCP/IP

DNP3 Slave Physical port, Slave Address for DNP, IP Addresses for Masters, TCP/UDP Port, 
Unsolicited Response parameters, Analog scale factors and deadbands, message 
fragment size, Binary input block.Available for standard and IEC61850 models.

IEC 870-5-104 TCP Port, Common Addr of ASDU, Cyclic Meter Period and, Synchronization Event 
settings.Available for standard and IEC61850 models.

SNTP (*) Synchronization over Ethernet settings

PTP 1588 Precission Time Protocol 1588 settings. (Available on fw version 7.00 or higher)

Routing A default route and a maximum number of 6 static routes may be configured. The 
default route is used as the last choice, if no other route towards a given destination is 
found.This option is only available for version 7.00 and higher.

SYSTEM SETUP

General Settings This screen describes and enables the settings of the power system where the relay 
operates. Some of these settings are used only for metering values presentation purposes; 
however, some of them apply directly to the sampling and analog-digital conversion 
process (rated frequency setting). Therefore, these settings need to be adjusted to fit the 
system settings.

Breaker Breaker Configuration

Switchgear Configuration of snapshot events for each switchgear (enable or disable)

Miscellaneous Settings This screen contains settings related with relay working mode. Out of service setting, Local/
Remote mode and Active language mode are options listed below. 

Breaker settings Breaker settings, maintenance and switchgear selection of the device configured as breaker in the C650. The 
selected switchgear is used in recloser, breaker failure and synchronism functions. The settings are Number of 
Switchgear, Maximum KI2t, KI2t Integ. Time, Maximum Openings, Max.Openings 1 hour and Snapshot Events.

Breaker maintenance These settings correspond to the initialization of (KI)2t counters, and the counting of number of openings and 
closings of the switchgear configured as breaker. These Counters allow the breaker Maintenance. They are 
used to cumulate the breaker ageing produced by a trip or a breaker opening. In order to incorporate the 
breaker historic, in case of existing breakers, the system allows assigning an initial value to accumulated 
amperes, and to the number of opening and closing operations.
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4.1.7.5  Control elements menu

This option shows all protection elements available in the relay as shown in the following two tables (exact menu depends 
on firmware version).

Table 4-4: Control elements menu, firmware version below 7.50

Table 4-5: Control elements menu, firmware version 7.50 and above

4.1.7.6  Inputs/Outputs menu

Section that contains the settings for all input and output boards and the Force Outputs and Virtual inputs activation tools.  

(*) indicates online only, (**) indicates offline only

This section shows the settings related to inputs and outputs for the different boards available in C650 (F, G, H, J, 2H, 2J) 

Control Elements

Synchrocheck Synchronism check unit (25). Single element.

Autoreclose Recloser (79). Single element.

Pulse Counters Pulse counters function. 8 counters provided.

Analog Comparators Analog comparator function. 20 analog comparators provided.

Digital Counters Up to 8 Digital Counters

PLC Timer Masks  Configuration of masks that can be assigned to PLC timers

Control Elements

Setting Group  C650 incorporate a flexible grouping capability for protection units can be used in either 
single setting group (default mode- All units that belong to Active group, configured in 
Setpoint > Control > Setting Group, can operate simultaneously ) or up to six setting groups 
(in this mode, all protection elements, that are available when setting group function is 
disabled, will be available in each individual setting group (Up to maximum of 6). Only one 
of setting group will be active at a given time). Units grouped under Protection elements 
section will be the units affected by changing of setting group.

Synchrocheck Synchronism check unit (25). Single element.

Autoreclose Recloser (79). Single element.

Pulse Counters Pulse counters function. 8 counters provided.

Analog Comparators Analog comparator function. 20 analog comparators provided.

Digital Counters Up to 8 Digital Counters

PLC Timer Masks Configuration of masks that can be assigned to PLC timers

Inputs/Outputs

Contact I/O Inputs and outputs settings for all boards in C650. The I/O settings configuration can only 
be performed through EnerVista 650 Setup, not available through the HMI.

Force Outputs (*) This menu allows activating each contact output in the relay, to facilitate maintenance 
testing. Online mode only. 

Virtual Inputs (*) This menu allows operating virtual inputs. These variables are used as inputs to logic 
schemes configured in the relay. Virtual inputs can be operated in a latched mode (32 
latched virtual inputs) or in Self-reset mode (32 self reset virtual inputs).

Remote Comms. This menu allows configuring remote inputs coming from other devices and allow 
enabling None, GSSE or GOOSE messages. Available for IEC61850 (6) models only.

Contact I/O

Board F Board located in first slot, always connected.

Board G Board located in second slot, depending on model definition. If model is type G0 there is no 
board in second slot.
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4.1.7.7  Relay configuration menu

This is the relay configuration section in which the relay can be configured using internal states or already compiled 
equation on PLC Editor

.

The following figures show an example of the default factory configuration for C650:

Board H Board located in first slot of CIO Module (external inputs/outputs module) or in 1 rack 
models

Board J Board located in second slot of CIO Module (external inputs/outputs module) or in 1 rack 
models

Board 2H Board located in first slot of CIO Module (external inputs/outputs module) or in 1 rack 
models

Board 2J Board located in second slot of CIO Module (external inputs/outputs module) or in 1 rack 
models

Relay 
Configuration

Outputs Configuration of contact output operate and reset signals for all boards.

LEDs 15 LEDs fully configurable from any logical variable, contact or virtual input. First 5 LEDs 
are latched by hardware, the rest are self-reset but can be latched through PLC 
configuration. For firmware version 7.20 and higher, all 15 LEDs can be latched by setting. 
From the LED configuration screen, it is possible to print the vertical LED label for the relay.

Operations Configurable operations up to 24. Operation texts, interlocks, final states, frontal keys, time 
outs and masters.

Protection Elements N/A

Control Elements This tab allows assigning operands (logic signals) as inputs to different control elements.

Oscillography Trigger and up to 16 digital channels to be included in oscillography records, are 
programmable from any logical variable, contact or virtual input. Text configuration is only 
for offline mode.
NOTE: This screen is used for the configuration of digital channels and oscillography 
trigger. The rest of parameters, such as function enabling/disabling, sampling rate, 
number of oscillography files, etc. must be set on the Setpoint > Product Setup > 
Oscillography menu. For C650, Oscillography is only available for models with enhanced 
functionality.

Control Events Up to 128 user programmable events from any logical variable, contact or virtual input. 
Possibility to display the event as an alarm on the alarms panel. Control events are also 
displayed in the snapshot events recording. 1 ms time tagging.
A control event is a logic signal associated with an operand or combination of operands, 
that allows following the status of that signal. 

Switchgear Up to 16 configurable switchgear elements. A switchgear element can be a breaker, a line 
selector switch, a grounding selector switch, a busbar selector switch, etc. This screen 
allows configuration of type of contacts, opening and closing time, contact assignation 
and text for events related to switchgear. There are 64 pre-established events for 
switchgear, which correspond to opening, closing, Error01 and Error11 of the 16 
programmable switchgear elements.

Remote outputs Up to 32 DNA bits and 64 user St bits to be transmitted to remote devices over CAN using 
GSSE messages

Inputs Text configuration for offline mode file management for all the contact inputs available in 
device.

Virtual Inputs Text configuration for offline mode file management. 32 latched and 32 self reset virtual 
inputs.

MMI (HMI-Human 
Machine Interface)

Screen one line diagram configuration. This menu shows a canvas to draw a simplified 
one-line diagram of a bay in a feeder, line, transformer, etc. The menu includes a library for 
power elements, metering elements, text and drawings. See an example on the next page.
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Figure 4-13: Relay configuration

Figure 4-14: HMI configuration
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4.1.7.8  Logic Configuration menu

This logic configuration allows creating more complex configurations, using the graphical PLC, than using the tables from 
Relay Configuration. For file management detailed information go to section 4.1.4 File management menu.

File description:

*.pep:Header for Logic project: PLC project file containing the necessary information relative to the relay model, logic 
libraries included in the project (*.lib), graphic file name (*.aut), etc.

*.aut:PLC Project file containing all the drawings used by the logic, required by 650 relay based on IEC 61131-3 standard. 
Functional block diagram (FDB).

*.lib:User programmable logic objects: Library file to be included as an object in a PLC project. Logic packages that can be 
stored into libraries and be distributed in different PLC projects.

4.1.7.9  Clock menu

This menu allows updates to the date and time of the relay, either synchronizing them with the PC clock, or entering the 
information manually. 

Figure 4-15: Clock
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4.1.8  Actual values menu
The menu bar in the main screen of EnerVista 650 Setup software shows the ACTUAL menu option. This option 
concentrates and displays all the status of operations, control elements, metering, counters information, oscillography, 
events, fault locator, etc. This section shows only the structure of menus in EnerVista 650 Setup.

4.1.8.1  Front panel

The front panel menu shows the LEDs submenu where all the front LEDs can be monitored.

4.1.8.2  Status

The following menu includes all the available control and general status in the device. Location of different menus can vary 
depending firmware version.

Actual

Front Panel The relay front LED status is shown on this menu.

Status Protection and control status signals for all available protection functions in device.

Metering All metering values available in device. Primary and secondary values, frequency and 
phasor diagram provided.

Inputs/Outputs All input and output status provided. For contact inputs and contact outputs as well as 
virtual input and virtual output signals.

Records Only enabled in online mode, retrieval of all the available records in device. Snapshot 
events, control events, oscillography and fault reports.

Status

Operation Bits Up to 24 elements. OPERATION BIT XX is (0) when the configured time out for the operation 
XX expires or when success conditions are met. And it is (1) if operation XX is executed and 
interlocks are fulfilled.

Breaker Breaker status (open, closed or undefined). The rest of the status signals corresponding to 
the switchgear XX configured as breaker are in the Status > Switchgear Status > 
Switchgear XX menu.

Protection Status of all the protection units in the device.

Control Elements Status of all the control units available in the device. 

Protection Summary This screen shows a complete list of all protection and control elements in the relay, 
showing their status (enabled or not). 

Snapshots Events 
summary

Summary of the snapshot events status (enabled or disabled) for protection, control, inputs 
and outputs boards and switchgear. 

ModBus User Map Up to 256 elements. Value in SIGNED INT 16 BIT format of the reading for the selected 
address configured in Setpoint > Product Setup > ModBus User Map

Switchgear Status Up to 16 blocks of switchgear status signals for the 16 configurable devices. Status signals 
such as inputs for A and B contacts, status for A and B, open and close status, error 00 and 
error 11, open init and close init, fail to open and fail to close signals.

Calibration Internal states for calibration. Factory calibration and calibration error signals.

System Info This screen can monitor the system parameters and the internal status of the Relay 
operating system. Not enabled by default, password required

Records Status Information related to the different records stored in the Relay, such as: Control events, 
oscillography, data logger, demand, energy, and breaker maintenance.

 SNTP-IRIG_B & PTP 
1588

Information related to synchronization via IRIG_B, SNTP or PTP1588.

Versions Information related to the different firmware versions and hardware revisions.

Redundancy Information related to the status of the frames sent through PRP and HSR. Also information 
related to the status of RSTP port.
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Table 4-6: Control elements, actual values menu, firmware versions below 7.50

Table 4-7: Control elements, actual values menu, firmware version 7.50 and above

Table 4-8: Records status, actual values menu

Control Elements

Synchrocheck Status signals for synchrocheck function (25).

Autoreclose Status signals for autoreclose function (79). Close signal, recloser status (ready, lockout, 
etc.), block signals after each shot.

Setting Groups Status signals (activations and blocks) for the relay setting group change. By default the 
"setting group" setting is disabled and all the grouped elements can be enabled at the 
same time.

Pulse Counters Status signals for pulse counters units.

Analog Comparator Status signals for analog comparator units.

Digital Counters Status signals for the Digital Counter units.

Control Elements

Synchrocheck Status signals for synchrocheck function (25).

Autoreclose Status signals for autoreclose function (79). Close signal, recloser status (ready, lockout, etc.), 
block signals after each shot.

Setting Groups Status signals (activations and blocks) for the relay setting group change. By default the 
Setting Groups setting is disabled and all the grouped elements can be enabled at the same 
time.

Pulse Counters Status signals for pulse counters units.

Analog Comparator Status signals for analog comparator units.

Digital Counters Status signals for the Digital Counter units.

Record Status

Control Events Status of the control events (if the signal configured to launch the control event is active or 
not).

Oscillography Status of signals related to oscillography recording, such as status or digital channels, 
oscillography trigger, number of records available, etc.

Data Logger Data logger information about oldest and newest sample time stamp, and number of 
channels and days configured in data logger settings.

Demand Demand trigger and reset inputs status.

Energy Freeze, unfreeze and reset input signals for energy counters.

Breaker Maintenance All signals related to breaker maintenance, such as number of openings, closings, (KI)2t 
counters, alarm signal for (KI)2t, etc.
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4.1.8.3  Metering

The Metering menu includes all the measurements available in the device. Primary and secondary values, and also the 
data related to the recording functions in the relay

4.1.8.4  Inputs/Outputs menu

The Inputs/Outputs menu includes all the inputs and outputs signals available in the device. Contact and virtual type.

(*) indicates online only, (**) indicates offline only

4.1.8.5  Records menu

The Records menu is only available in online mode and includes the possibility to retrieve all the records available in the 
device. By serial or Ethernet.

(*) indicates online only, (**) indicates offline only

metering

Primary Values Primary values measurements for currents, voltages, power, energy and demand

Secondary Values Secondary values measurements for currents, voltages and power.

Phasor Diagram Current, voltage and sequence components.

Frequency Line and Bus frequencies.

inputs/outputs

Contact Inputs Status of digital inputs in the Relay for each board according to the relay model.

Contact Output Status Status of digital outputs in the Relay for each board according to the relay model.

Contact Outputs 
Operates

Status (activated or not) of the variables used to operate a contact output. To configure 
these signals go to Setpoint > Relay Configuration > Outputs menu.

Contact Outputs 
Resets

Status (activated or not) of the variables used to reset a contact output. To configure these 
signals go to Setpoint > Relay Configuration > Outputs menu. This output reset 
Command is only effective if latch is selected for Output Type setting on the I/O board, 
thus the contact output has been configured to emulate function 86 (latching relay).

IO Board Status Status of I/O boards. This status provides if the hardware it is OK (boards matching relay 
model, correctly inserted in their tracks, in good state and communicating through the 
internal CAN bus).

Virtual Inputs Status of Virtual inputs latched (32) and self-reset (32).

Virtual Outputs Status of virtual outputs (configured in PLC Editor). Up to 512.

Remote Outputs States of remote outputs for IEC61850 models.

Remote Inputs Status of remote device and remote inputs  for IEC61850 models.

Analog Inputs (*) Measurements coming from analog inputs (DCMA)

Virtual Output Latched Status of Virtual Output Latched (configured in PLC Editor). Up to 16. 

Virtual output 
Analogue

Status of Virtual OutputAnalogues configured in PLC Editor). Up to 49 float values and 49 
integer values can be used.

Records (*)

Event recorder (*) Retrieval and visualization of snapshot event (all and new), control events and alarm panel. 
By serial or Ethernet (ModBus RTU or TCP/IP)

Waveform capture (*) Retrieval of oscillography files, by Ethernet.

Data logger (*) Retrieval and visualization of data logger files. Only by Ethernet.
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4.1.9  Operations menu
Option only available in online mode, showing all the operations previously configured in the relay with their corresponding 
texts, which must be different from the default text (Op_X not configured). 

(*) indicates online only, (**) indicates offline only

4.1.10  Communications menu
The communication menu includes the computer screen to start communicating with the relay, the different update 
procedures available in device: firmware, operating system, web server and other file storing capabilities (upload and 
download info files to/from relay).

For more detail information go to section 4.1.3 Connect to the relay for communication menus description and to section 5 
for flash memory update procedures.

(*) indicates online only, (**) indicates offline only

operations

Operation 1 (*) Entry to first operation (with its corresponding text)

... ...

Operation 24 (*) Entry to 24th operation (with its corresponding text)

Communication

Computer Menu to start communication with the relay.

Modem (**) Configure the unit for remote communications via modem, using a telephone line. This is 
only available if the relay is not communicating and if modem has been selected under 
Communication > Computer control type. 

Troubleshooting (*) Read/write to ModBus addresses, for verifying communications and access to different 
positions in the ModBus memory map. Only available if the communication has already 
been established.

Calibration (*) Retrieve the unit calibration settings and storing them in a file (with extension *.cal). For 
reading or storing the calibration settings in the relay go to Communications > 
Calibration > Get or Set calibration settings and select the intended calibration file. The 
calibration retrieval process must be performed before updating the operating system. 
When the firmware and bootcode are updated, all the data in the relay is deleted, 
including the factory calibration settings. When only the firmware is updated (for versions 
higher than 1.50), the calibration settings are automatically saved in the relay.

Upgrade relay (**) Upgrade firmware version (Ethernet connection): Update the relay firmware through 
Ethernet communication . Firmware is related to the relay internal program, designed by 
GE Multilin, which performs the protection and control functions, and which is run by the 
relay main microprocessor.

Upgrade 650 web 
server

Upgrade 650 web server (Ethernet connection): Go to Communications > Upgrade 650 
web server. The relay web server application can be updated to further versions (if 
available) using this menu without modifying the relay operating system.

Upload info files to 
relay

Upload info files to relay (Ethernet connection): This functionality is used to store setting 
files (*.650) inside the relay, as well as auxiliary files used by the programmable logic 
graphical editor (*.pep, *.aut, *.lib).

Download info files 
from relay

Download info files from relay (Ethernet connection): This functionality is used for 
retrieving the files (*.650 and *.pep, *.aut, *.lib) that have been previously stored in the 
relay flash memory.
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CAREFULLY READ THE FLASH MEMORY UPDATE PROCEDURE DESCRIBED IN SECTION 
“BOOT CODE AND FIRMWARE" AND CLOSE ALL RUNNING APPLICATIONS BEFORE 
PERFORMING FIRMWARE AND OPERATING SYSTEM UPDATES.

For firmware versions below 7.00, check that the firmware version that is going to be 
updated matches the operating system version of the relay before updating firmware. If 
not, update the operating system before proceeding to update the firmware. Other 
combinations of firmware and operating system different from the listed in section 5 will 
not be operative.

For previous version than 7.00 the operating system version is available in the logotype 
main screen in HMI; it is the number between brackets in the first line, e.g. C650 1.70 (2.35). 
The operating system version is 2.35

*.650 files contain protection, control settings, relay configuration and compiled logic equations. This 
file can be retrieved from the relay, using the File > Get info from relay option in EnerVista 650 Setup 
(through serial or Ethernet communication). File > Send info to relay option stores this *.650 file in 
the relay.

*.pep, *.aut and *.lib files contain the logic configuration projects necessary to modify the logic 
(virtual outputs) in the relay. These files can be stored in the relay, using the Communication > 
Upload info files to relay option in EnerVista 650 Setup (through Ethernet communication). They can 
be retrieved using Communication > Download info files to relay option in EnerVista 650 Setup 
program (Ethernet communication). Take into account that the *.pep, *.aut and library files are 
necessary to modify the PLC logic (virtual outputs). Without these files setting and configuration can 
be modified but not logic equations (virtual outputs). It is advisable to use the Communication > 
Upload info files to relay option to store these logic configuration files into the relay.

*.pep, *.aut and *.lib files contain the logic configuration projects necessary to modify the logic 
(virtual outputs) in the relay. These files can be stored in the relay, using the Communication > 
Upload info files to relay option in EnerVista 650 Setup (through Ethernet communication). They can 
be retrieved using Communication > Download info files to relay option in EnerVista 650 Setup 
program (Ethernet communication). Take into account that the *.pep, *.aut and library files are 
necessary to modify the PLC logic (virtual outputs). Without these files setting and configuration can 
be modified but not logic equations (virtual outputs). It is advisable to use the Communication > 
Upload info files to relay option to store these logic configuration files into the relay.
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An example of Communication > Troubleshooting follows:

Figure 4-16: Communication troubleshooting example

4.1.11  Security menu
The security menu includes all the menus related to security control in EnerVista 650 Setup. EnerVista 650 Setup security 
users and passwords are not related to passwords in HMI. Each security level has its own access for HMI management and 
EnerVista 650 Setup management.

(*) indicates online only, (**) indicates offline only

security

Login User (*) Log on menu for EnerVista 650 Setup. Enabled after security control has been enabled in 
user management menu.

Change Password (*) Menu to change passwords and establish password recovering questions.

User Management (*) User management dialog box.
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4.1.12  View menu
The view menu includes the computer screen to start communicating with the relay, the different update procedures 
available in device: firmware, operating system, web server and other file storing capabilities (upload and download info 
files to/from relay).

The ModBus memory map is detailed in the complete instruction manual (English only) and can be obtained from EnerVista 
650 Setup program.

(*) indicates online only, (**) indicates offline only

4.1.13  Help menu
Complete instructions manual and data about EnerVista 650 Setup release.

View

Traces (*) ModBus communication traces between the EnerVista 650 Setup and the relay.

ModBus Memory map Complete ModBus memory map description.

Languages (**) Option to change the EnerVista 650 Setup default language. Only available if the relay is 
not communicating and no file (*650) is open.

Help

Instruction Manual Instructions manual in the language selected in View > Languages.

GE Mulitlin on the Web GE Multilin web page link.

About EnerVista 650 
Setup

Release version and date of the EnerVista 650 Setup program.
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4.2   Human-machine interface (HMI)
The HMI interface consists of several functional panels. The faceplate can be unscrewed to allow easy access to the 
removable modules. There is also a removable dust cover that fits over the display and other cover that protects the front 
RS232 Communications port and the commands buttons that can be sealed. 

Figure 4-17: Enhanced HMI interface

4.2.1  Display 
C650 units are available with two different options for the front display. The first option is an alphanumerical display of 4 
lines with 20 characters each, and the second option is a graphical display of 16 lines with 40 characters each (128x240 
pixels).

The boot code and firmware versions can be seen in the relay text main screen, this screen is the default screen in the text 
menu for all models: After the text "C650", appears the relay firmware version (7.00 in the example), and between brackets 
the boot program version (7.00 in the example), followed by "General Electric", the relay model and the default front  port 
(COM2) communication parameters. 
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Figure 4-18: Text main screen

4.2.2  LED indicators
The relay provides 16 LED indicators, 15 user programmable plus one non-configurable LED (READY) that shows if the relay 
is in service.

Programmable LEDs are divided into groups of 5 LEDs, each of the groups having a different color. The first group of LED 
indicators is latched by hardware (red), usually configured for trip signals. The second group (yellow) and third group 
(green) of LED indicators are self-reset and will reset once the condition has been cleared. These LEDs can also be latched 
using logic through PLC configuration. For firmware version 7.20 and above, all 15 LEDs are latched through relay settings.

The ESC key is used to reset any latched LED indicator, once the condition has been cleared. Keep the ESC button pressed 
for more than 3 seconds; all LEDs light up, verifying their correct operation. When releasing the ESC key, all indicators 
programmed with memory, such as tripping LEDs, are reset. For models with enhanced display, there is a reset LEDs 
button dedicated for this purpose.

The latched conditions can also be reset via communications using the LED reset input (to configure this signal go to 
Setpoint > Relay Configuration > Control Elements > LED RESET INPUT). By default this LED reset input signal is set to 
LEDS RESET operation.

4.2.3  Pushbuttons
The front panel provides:

Push buttons: keypad (5 user programmable plus ESC/ESCAPE non configurable), shuttle key or keypad for easy 
navigation, command pushbutton to select operations mode.

USB port: intended for connection to a portable PC.

C650 7.00 (7.00)
General Electric

C650MZKF2G1HI6E
19200N81: MODBUS: 254
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Figure 4-19: Enhanced keypad description

4.2.3.1  Command push button

The unit incorporates a command pushbutton located at the bottom right side of the HMI interface and at the top left for 
Enhanced interface, with three options: local, remote, and off. The first option (LOCAL) allows executing operations in local 
mode (HMI, front  port, and rear COM2 port). The second option (REMOTE) allows operation execution only through remote 
communications (COM1 and ETH_1/ETH2 or ETH_E/ETH_A/ETH_B (Depending on model)). The third option (OFF) blocks the 
execution of operations. Each position is identified with an LED indicator, as follows:

LOCAL operations (green)

REMOTE operations (green) 

OFF (red)

Press the command button to switch from local to remote operations mode and vice versa. OFF status (operation inhibited 
for maintenance and safety) can be reach pressing the commands pushbutton during several seconds (local-remote-off 
sequence).

The local-remote-off sequence can be also available through communications (see chapter 5.8), with a configurable signal 
that can be set in the Setpoint > Relay Configuration > Control Elements screen.

sed for closing the user programmable 
switchgear. It is fully rogrammable.

F1. User programmable.

F2. User programmable.

F3 / *. User programmable.

Up Key. Used for selecting menus, 

submenus, se tin

Down Key. Used for selecting menus, 
submenus, and chang values of settings

Enter Key. Press to enter to submenus 
or to change values.

Escape key. Press key to exit from menus

Reset key.  test all LEDs and reset 

the trip LEDs.



CHAPTER 4:  INTERFACES, SETTINGS & ACTUAL VALUES 4.2 HUMAN-MACHINE INTERFACE (HMI)

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 4-43

4.2.4  Screen contrast
Regulation of screen contrast should be performed as described below depend on display model selected:

Enhanced HMI: Backlight level regulation can be performed by using enhanced keypad. Reset button must be pressed at 
the same time that the up or down key is pressed to increase or decrease the contrast.

4.2.5  Text menus

4.2.5.1  Navigation

Text menu is available for all models, this is the main menu for visualizing actual values, metering, changing settings, etc. 
through the HMI. In models with graphical display besides this text main menu there are several screens providing more 
performance for control purposes.

Press (or rotate left or right) the enter/shuttle key to enter the main menu, starting from the standby screen (default main 
screen). The default main screen can be accessed pressing ESC key until it appears. In all the navigation press the enter/
shuttle key to select the desired header display (top-level menu). Each press of the enter/shuttle key advances through the 
main heading pages as illustrated below. To return to previous menus press the ESC key. To move inside the top-level 
menu without changing to other low levels, rotate the shuttle key left to move up and right to move down (or use up/down 
keys). 

When rotating the shuttle key (or up/down keys) the selected menu is marked by a single scroll bar character. The mark (>) 
in the right part of any menu means that contains more than one level.

Figure 4-20: Text menu navigation Shows an example of main menu navigation:

Figure 4-20: Text menu navigation
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4.2.5.2  Text menu hierarchy

The structure of HMI text menu is similar to the EnerVista 650 Setup menu in the actual values and settings (view and 
change) menus. The main menu shows the following options:

4.2.5.3  Actual Values

The Actual Values menu option in HMI concentrates and displays all the status of protection, control elements, metering, 
counters information, oscillography, events, fault locator, etc. 

Name Description Navigation in menu

Actual Values Actual values of all the signals available in device. 
Status of protection and control elements, 
measurements, inputs and outputs, etc.

Press shuttle key or enter key to enter next level. 
Press ESC to return to default main screen.

Snapshot events Visualization of all snapshot events in text mode (two 
screens for each snapshot event). In graphical displays 
there can be seen in a dedicated screen.

Press shuttle key or enter key to visualize snapshot 
events in text menu. Press ESC to return to default 
main screen.

View Settings Visualization of all protection and control settings 
available in device.

Press shuttle key or enter key to enter next level. 
Move Up/Down to select submenu. Press ESC to 
return to previous level.

Change Settings Menu that allows changing all protection and control 
settings available in device. Inputs and outputs 
settings, relay configuration and logic configuration 
are not available in HMI, only via EnerVista 650 Setup 
software.

Press shuttle key or enter key to enter next level. 
Move Up/Down to select submenu. Press esc to 
return to previous level.

Date & Time Date and time visualization and modification by user. First mode is visualization. Press again shuttle key 
or enter key to start modification in date and time. 
Press ESC to return to previous level.

Commands Operations execution in local mode. Move Up/Down to pre select operation. Press 
shuttle key or enter key to select and confirm. 
Press ESC to return to previous level.

Password Password menu for settings and commands Move Up/Down to select submenu. Press shuttle 
key or enter key to enter next level. Press ESC to 
return to previous level.

Select Main Screen Selection of default main screen in text menu. Move Up/Down to select the default main screen 
type. Press shuttle key or enter key to confirm.

Select Language Language selection. Between default language (see 
order code) and English.

Move Up/Down to select the default language. 
Press shuttle key or enter key to confirm selection. 
Switch the relay off and on.

< - return Return to previous level Press shuttle key or enter key to return to previous 
level.

Front Panel   >

LEDs

Status            >

Operation Bits

Breaker

Control Elements > Synchrocheck 
Autoreclose 
Analog Comparators
Digital Counters

Switchgear Status > Switchgear 1
Switchgear...
Switchgear 16

Calibration

System Info
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To enter this menu press the shuttle key or enter key when the option Actual Values is selected in main menu. A secondary 
level is displayed with different sublevels as shown on 4.2.5.5 View settings menu. Pressing Up/down keys or rotating the 
shuttle key, (left for moving up and right for moving down) select the next level to be displayed, press the enter/shuttle key 
again to enter in next level and press ESC key to return to previous level if desired. This navigation is performed the same 
for all the menus in Actual Values. Once the last sub-level is reached, move up and down to visualize the actual values 
selected. 

Records Status > Control Events
Oscillography
Data logger
Demand
Energy
Breaker Maintenance

SNTP-IRIG_B-PTP

Versions

Redundancy

Metering          >

Primary Values > Current
Voltage
Power
Energy
Demand

Secondary Values > Current
Voltage
Power

Frequency

Inputs/Outputs    >

Contact Inputs    > Board F/ Board G/ Board H/ Board J

Cont. Output St. > Board F/ Board G/ Board H/ Board J

Cont. Output Op. > Board F/ Board G/ Board H/ Board J

Cont. Output Rs. > Board F/ Board G/ Board H/ Board J

IO Board Status

Virtual Inputs    > Virtual Inp.Latched
Virtual Inp.SR

Virtual Outputs

Remote Outputs (for 
IEC61850 models only) >

DNA
User St
GOOSE Dig Outputs

Remote Inputs for IEC61850 
models only)>

Remote Input
Remote Devices
GOOSE Dig Inputs
GOOSE Analog Inputs

Analog Inputs > Board F/ Board G/ Board H/ Board J/ Board 2J/ 
Board 2H

Virtual out. Latched

Virtual out. Analogue
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One example of data screen for actual values is shown in Figure 4-21: Actual values screen data. 

First Line: Header of last level in actual values (Switchgear 1 in the example)

Second Line: Data identifier (in the example SWITCH 1 A INPUT). 

Third line: Status of the displayed actual value.

Fourth Line: Relative position in the menu (it is the first value of 12)

Figure 4-21: Actual values screen data

In the Actual Values menus are different types of data; each type of data displays its particular status type (on and off, 0 or 
1, OK or fail, analog values, etc.)

4.2.5.4  Snapshot events

To enter this menu press the enter/shuttle key when the option Snapshot events is selected in main menu (). In this menu 
all the snapshot events stored can be displayed.

Snapshot events are changes in the relay internal status. 

One snapshot event is displayed in two text screens:

The first screen display the status, date and time of the snapshot event: the snapshot event identifier, its status, event 
number and the date and time of the occurrence. If the snapshot event identifier does not fit the first line, the whole text is 
shown using as well the second line alternating with the status and event number.

The second screen displays currents and voltages in primary values for that particular snapshot event. Ia, Ib, Ic and Ig for 
currents and Vab, Vbc, Vca and V0 for voltages. To access the metering screen in snapshot events menu, press shuttle key 
from the snapshot event first screen. To exit from the metering screen press ESC. 

To select different snapshot events to be displayed, press the up-down keys or rotate the shuttle key to select the snapshot 
event and then press the enter/shuttle key to enter the metering screen. Press esc to exit the metering screen and return 
to snapshot events menu.

Switchgear 1

OFF
(1/ )



CHAPTER 4:  INTERFACES, SETTINGS & ACTUAL VALUES 4.2 HUMAN-MACHINE INTERFACE (HMI)

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 4-47

Figure 4-22: Snapshot event navigation HMI shows an example of snapshot events navigation:

Press enter/shuttle key from the default main screen and enter in the main text 
menu.

Move the shuttle key or press up-down keys until a single scroll bar character (o) 
appears in the left part of Snapshot event header.

Press enter/shuttle key to enter in the snapshot events menu)

Select the snapshot event to display using the up/down keys or shuttle key (left and 
right to move up and down inside the recorded snapshot events).

Once selected the snapshot event, identifier, status, date and time are displayed.

In the second line St: is showing the status and the relative snapshot index from the 
whole recorded number. Third and fourth lines are used to display the time and 
date of the snapshot event.

Pressing the enter/shuttle key the metering screen for the snapshot event is 
displayed.

To exit from this screen press the ESC key and return to the snapshot events menu.

Figure 4-22: Snapshot event navigation HMI

4.2.5.5  View settings menu

To enter this menu press the enter/shuttle key when the option View Settings is selected in main menu (o). A secondary 
level is displayed with different sublevels. Pressing up-down keys or rotating the shuttle key, (left for moving up and right 
for moving down) select the next level to be displayed (o), press the enter/shuttle key again to enter in next level and press 
esc key to return to previous level if desired. This navigation is performed the same for all the menus in "View Settings". 
Once the last sublevel is reached, move up and down to see the available settings. 

MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL

Product Setup     >

Communication     >

Serial Ports

Ethernet          > Ethernet A
Ethernet B
Ethernet E
Redundancy

ModBus Protocol

DNP3 Slave (Available for standard and 
IEC61850 models)>

DNP3 Slave 1..3

IEC 870-5-104(Available for standard and 
IEC61850 models)>

SNTP

PROCOME (Available for procome models 
only).

PTP 1588

Breaker Closed ON >
St: ON (4/479)
Time: 16:35:02.027
Date: 04/May/2016

C650  7.10 (7.10)
General Electric

C650MZKF2G1HI6E
19200N81: MODBUS: 254

ENTER
ESCAPE

Actual Values
Snapshot Events
Fault report
View Settings

ENTER
ESCAPE

ENTER
ESCAPE

Ia  0.000    Vab  0.000
Ib  0.000    Vbc  0.000
Ic  0.000    Vca  0.000
Ig  0.000    V0    0.000
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Routing

Oscillography

Demand

Time Settings

System Setup      >

General Settings

Breaker           > Breaker Settings
Breaker Maintenance

Misc. settings

Control elements >
(*) See note

Synchrocheck

Autoreclose

Breaker Failure

PLC Timer Masks

MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL



CHAPTER 4:  INTERFACES, SETTINGS & ACTUAL VALUES 4.2 HUMAN-MACHINE INTERFACE (HMI)

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 4-49

4.2.5.6  Change Settings

To enter this menu press the enter/shuttle key when Change Settings is selected in main menu. A secondary level is 
displayed with different sublevels. Press up-down key or rotating the shuttle key, (left for moving up and right for moving 
down) select the next level to be displayed, press the enter/shuttle key again to enter in next level and press ESC key to 
return to previous level if desired. This navigation is performed the same for all the menus in Change Settings. Once the 
last sublevel is reached, move up and down to visualize the settings selected. 

To change a particular setting, press the enter/shuttle key on the setting to be modified. After selecting the setting, the 
value for that setting appears between brackets. Choose the new value moving up and down . After selecting the 
appropriate value press again the enter/shuttle key to fix that value. To save the new settings, go to the end of the menu  
pressing down key or rotating the shuttle key right, and select Press Enter to save settings. When pressing the shuttle key 
inside this menu the new settings is saved. 

Select the menu Change settings and press the enter/shuttle key to enter in the next 
sub-level.

 

If there is more than one sub-level, select the next sub-level by pressing the up-
down keys or rotating and pressing the enter/shuttle key until the last level is 
reached.

Press the enter/shuttle key in the function to be modified

-> Group of settings

-> Setting to be modified

-> Value

-> Range and step

Pressing the enter/shuttle key, value appears between brackets and can be 
modified pressing the up-down keys or rotating the shuttle key. Pressing again the 
enter/shuttle key, the new value is accepted.

Once all settings inside the group have been modified, go to the last screen pressing 
the down key or rotating the shuttle key and press Enter. At this moment of time, the 
new settings is active in the relay.

Figure 4-23: Change settings in HMI 

Phase CT Ratio
1
–
[ 1:6000:1 ]

General Settings
Breaker
<-  return

Product Setup
System Setup
Control Elements

Snapshot Event
Fault report
View settings
Change settings

Phase CT Ratio
1
20
[ 1:6000:1 ]

Press Intro
to save settings
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4.2.5.7  Date & time

The "Date & Time" menu shows the relay date and time information in the following format: 

DST: Daylight Saving Time information

Date:Day/Month/Year

Time:Hour:Minutes:Seconds

To modify date and time, press the enter/shuttle key. The relay shows the year between brackets at the top of the screen. 
By pressing the up-down keys or rotating the shuttle key, reach the desired value for the year, and press the enter/shuttle 
key to select and store that value. After the year, the relay shows the month. Proceed as in the case of the year. The date & 
time modification sequence is as follows:

Press the up-down key or rotate the shuttle key to select the "Date and Time" menu 
and press to enter in it

The date and time data appear in the format described above. 

Pressing the enter/shuttle key the year can be modified pressing up-down key or  
rotating the shuttle key, after selecting the desired value, press again the enter/
shuttle key to store the value.

"Year"

Date:Day/Month/<Year>

Time:Hour:Minutes:Seconds

After storing the value for Year, Month appears between brackets and can be 
modified

"Month"

Date:Day/<Month>/Year

Time:Hour:Minutes:Seconds

After storing the value for Month, Day appears between brackets and can be 
modified

"Day"

Date:<Day>/Month/Year

Time:Hour:Minutes:Seconds

After storing the value for Day, Hour appears between brackets and can be 
modified

"Hour"

Date:Day/Month/Year

Time:<Hour>:Minutes:Seconds

After storing the value for Hour, Minutes appears between brackets and can be 
modified

"Minute"

Date:Day/Month/Year

Time:Hour:<Minute>:Seconds

After storing the value for Minutes, Seconds appears between brackets and can be 
modified

"Second"

Date:Day/Month/Year

Time:Hour: Minute:<Seconds>

Figure 4-24: Change date & time in HMI
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Once this sequence is completed, these values remain stored in the relay, and the display once again shows the date at 
the bottom of the text screen.

4.2.5.8  Commands

Commands are configured using EnerVista 650 Setup, and they can be executed using the pushbuttons on the relay front.

Use the EnerVista 650 Setup software to configure up to 24 commands with a descriptive text. When executing the 
operations from the relay front panel, the operation description is displayed.

Example of commands (operations) executions via HMI

Press the enter/shuttle key when Commands is selected in the display (o).

All the previously configured commands are displayed. Press up-down keys or 
rotate the shuttle key to move through the available commands. Press ESC to 
return to previous level.

Press the enter/shuttle key to pre-select the operation to execute.

When the message Push Enter for Confirmation appears, press the enter/shuttle 
key to confirm.

Once the command has been performed or the time out has expired the Command 
completed message is shown on the display.

Figure 4-25: Commands in HMI
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4.2.5.9  Passwords

The C650 units incorporate independent passwords for protection and control, in order to prevent unauthorized keypad 
and display access to the relay.

Settings Password:

This password restricts access to settings changes in the relay protection elements.

Commands Password:

This password restricts access to executing operation commands through the keypad and display.

If the Commands Password is activated, when the user tries to execute an operation, the relay requests this password. 
When using single-line diagrams for graphical display models, all objects are not operational until the password is entered, 
either by logging in to Login Pwd Commands, or by entering the password in the Commands menu.

Relay settings view, measures, and other monitored information are not password-protected, and can be accessed by all 
users.

The password menu is located at the Password option in the relay text menu. This menu includes the following options:

   "Login Pwd Settings"

   "Logout Pwd Settings"   

   "Change Pwd Settings"

   "Login Pwd Commands"

   "Logout Pwd Commands"

   "Change Pwd Commands"

   "Forgot Password?"   

Among the available options in this menu, there are three types of functionality:

Login: For entering the password, either for settings or commands, and enable access to settings
or commands. Once entering the password the relay is no longer password protected, and
access is enabled to settings modification or commands execution.

Logout: Once the necessary setting changes or operation commands have been executed, the
user can log out, so that the relay is password protected again.

Change: Setting or modifying the desired password.

Forgot Password: Retrieves the encrypted password, so that it can be recovered if the user loses or forgets it. 

Passwords are restricted for Settings change and Commands execution. To password-protect the relay, it is first necessary 
to set the desired password, using the corresponding Change Pwd... menu. The default password is 0000. This password 
provides access to the whole relay functionality. 

Once a new password has been set, the user must log in to access the protected functionality; otherwise, the relay 
requests the password when trying to change settings or execute commands. Once the password is entered the relay is 
unprotected (as if the user had logged in), and remains so for 15 minutes of inactivity or until the user logs out.

Password range

The valid range for C650 passwords is a number from 0000 to 9999. 

The default password is 0000, which provides access to the whole relay functionality. This is the default option for enabling 
relay use without using passwords.

Entering passwords (Login PWD)

This operation is the same for both the settings and commands passwords. The only difference is the access menu. For 
entering the password, the user must access the Login menus inside the Password menu.

Login Pwd Settings or Login Pwd Commands:

The relay requests the password with the following message on the screen:
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Setting passwd.

Login: < 1000 >
For entering the desired password, the user must press up-down key or rotate the shuttle key to the left (decrease) or to 
the right (increase), and establish the desired number. Once entered, the selected password between brackets has been 
entered, the relay shows the message "Processing passwd. Wait...". If the password is correct, the relay allows access to 
the settings change or command execution. It is not necessary to enter the password every time a change is to be 
performed. The relay requests the password again after 15 minutes of inactivity. This period of time is the same that takes 
the relay to turn off the display backlighting. 

Logging out (Logout PWD)

To disable access to settings and commands, the user must logout.

Logout Pwd Settings or Logout Pwd Commands:

For safety reasons, the relay automatically logs out the active user 15 minutes after the last keypad action.

Changing the password (Change PWD commands)

To set a password in the relay, both for settings and commands, the corresponding menu must be accessed inside the 
Password menu:

Change Pwd Settings or Change Pwd Commands:

To change the password, the user must first log in with the existing password; if the relay has the default factory password, 
this would be 0000.

The relay requests the existing password with the following message:

(Setting or Command) passwd.
Login: < 0000 >

Once the existing password has been acknowledged, the new password must be entered:

(Setting or Command) passwd.
New passwd: < 1000 >

Once the new password has been entered, the relay returns to the general Passwords menu.

Service Command for password recovery

In the event of losing all passwords, the Service Command allows the customer to reset both Settings and Commands HMI 
Passwords.

1. Customer must call the customer support service.

2. A secret key will be provided by customer support to facilitate the reset

3. At the moment, the HMI has no passwords for Settings and Commands. The customer can reintroduce new 
passwords.
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4.2.5.10  Select main screen

The relay display offers the possibility to select the default main screen. For this purpose, the user must access Select Main 
Screen through the HMI. This menu includes the following options:

Logotype

This option selects as main screen the relay logotype including the firmware and boot code versions, the relay model and 
the communication parameters for local port COM2.

Figure 4-26: Default logotype screen

Metering

This option shows a Metering screen including the phase and ground currents as well as phase-to-phase voltage, and zero 
sequence voltage values, all of them in primary values.

Figure 4-27: Default metering screen

All

This option alternates in time the two previous options.

4.2.5.11  Select language

Option only available for versions 1.70 or higher than 5.20.

The relay display offers the possibility to select the default language for the relay. For this purpose, the user must access 
the "Select language" menu located at the end of the main menu through the HMI. This menu allows the user to set the 
default language of the relay between English (always available) and second language selected in the relay model. 

For example one relay in French language (e.g. FC650MZDF2G1HIRF) can be displayed in French or in English only by 
changing the language setting in HMI. It is necessary to switch off and on the relay to start working with the new language 
configuration in the relay. In EnerVista 650 Setup it is possible to select the language for the software (View > Languages).

Example of language selection in HMI

Ia   0.000  Vab   0.000
Ib   0.000  Vbc   0.000
Ic   0.000  Vca   0.000 
Ig   0.000  V0     0.000
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Press the enter/shuttle key to enter the select language menu.

Depending on the relay model there are different language selections available: 
English/French, English/ Russian, etc.

Press up-down keys or rotate the shuttle key to select the desired language and 
press enter to store the selection in the relay

Once the new language has been selected it is necessary to reboot the relay in 
order to start working with the new language in the device.

Figure 4-28: Language selection in HMI

4.2.6  Graphic display

4.2.6.1  One-line diagram

In models with graphic display default main screen is the single-line diagram. This single-line diagram can be configured 
using EnerVista 650 Setup software by choosing the HMI menu inside Relay Configuration (Setpoint > Relay 
Configuration > HMI).

Figure 4-29: One-line diagram

The bottom of the display shows a legend that indicates the possible selections that can be made from this screen.

Esc: Menu.                            Enter: Next.                               : Select.
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The meaning of these options is as follows:

Esc: Menu.

Press the ESC key to access the relay main menu, similar to the one displayed by the text-display model (C650B).

Press the ESC key again and the menu selection screen (Actual Values, Snapshot events, etc.) is displayed. This main menu 
screen is identical to the one described for the text display, with functionality described in section 4.2.5 Text menus. 

Intro: Next.

Press the enter/shuttle key to access the next graphical screen, which in this case corresponds to the primary metering 
values screen.

: Select

Once the different switchgear elements have been configured using EnerVista 650 Setup, they can be operated from the 
graphic display. 

If a single-line diagram has been configured in the EnerVista 650 Setup software, in the HMI option inside the Relay 
Configuration menu, the different switchgear elements configured for the display are operative from the graphic display. 
By pressing the up-down key or rotating the shuttle key to the left and right, the cursor moves among the elements and 
blinks on each of them. When an element is selected by pressing the enter/shuttle key, the relay indicates the command to 
be executed, and the user needs to confirm by pressing the enter/shuttle key.

The following sections describe only the operation of screens that are specific for the graphic display models.

4.2.6.2  Metering screen

The Metering screen displays relay analog measures in their primary values. Available metering values are as follows:

Figure 4-30: METERING SCREEN

As in the rest of graphical display screens, the bottom part shows a legend that indicates the possible options for the user. 
In this case, the options are:

Enter: Next.Esc: Prev. : Scroll.

Intro: Next.

Pressing the enter shuttle key the user accesses the next screen, in this case the ALL EVENTS screen.

Esc: Prev.

Pressing the ESC key the user returns to the previous screen (One-line diagram)

: Scroll.

Pressing the up-down key or rotating the shuttle key to the left (L) or right (R) the user can access all the Metering values in 
the screen. 

Metering Screen.   Total metering 53 
 Phasor Ia Primary   0.000 KA 
 Phasor Ib Primary   0.000 KA 
 Phasor Ic Primary   0.000 KA 
 Phasor Ig Primary   0.000 KA 
 Phasor Isg Primary   0.000 KA 
 RMS Ia Primary   0.000 KA 
 RMS Ib Primary   0.000 KA 
 RMS Ic Primary   0.000 KA 
 RMS Ig Primary   0.000 KA 
 RMS Isg Primary   0.000 KA 

I0 Primary    0.000 KA 

Enter: Next.  ESC: Prev :Scroll.
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4.2.6.3  All events screen

This screen shows all events that have been produced in the relay. The top of the screen shows its name (All Events), and 
the relative and total number of events contained in the screen.

All Events (1/479) or (1/511 for Firmware version 7.20 or higher)

This legend means that there are a total of events stored in the relay, and that the cursor is located on event number 1. The 
information shown on this screen for each event is as follows:

"Hour:Minute:Second:Millisecond" "Event text" "Event status (ON/OFF)"

Figure 4-31: All events screen

The screen legend options are:

Esc: Prev.                        Enter: Menu.                     : Scroll.

Esc: Prev.

METERING SCREEN ANALOG MEASURES IN PRIMARY VALUES

Phasor Ia Primary V0 Primary Phase A Real Pwr Line Frequency Primary

Phasor Ib Primary V1 Primary Phase B Reactive Pwr Bus Frequency Primary

Phasor Ic Primary V2 Primary Phase B Apparent Pwr Vx Primary

Phasor Ig Primary Vab Primary Phase B Real Pwr Pos MVarhour Freeze

Phasor Isg Primary Vbc Primary Phase C Reactive Pwr NegMVarhour Freeze

Phasor In Primary Vca Primary Phase C Apparent Pwr PosMWatthour Freeze

RMS Ia Primary Vn Primary Phase C Real Pwr Neg MWatthour Freeze

RMS Ib Primary Va Primary 3 Phase Reactive Pwr Positive MVarhour 

RMS Ic Primary Vb Primary 3 Phase Apparent Pwr Negative MVarhour 

RMS Ig Primary Vc Primary 3 Phase Real Pwr Positive MWatthour

RMS Isg Primary VL Primary Phase A Power Factor Negative MWatthour 

I0 Primary VBB Primary Phase B Power Factor  % of Load-to-trip

I1 Primary Phase A Reactive Pwr Phase C Power Factor

I2 Primary Phase A Apparent Pwr 3 Phase Power Factor

All Events (1/479). 
- [ Ready LED ON ] - 

16:11:08.035 Ready LED ON    ON 
16:11:08.017 Breaker Closed ON   ON 
16:11:08.005 Isolated Gnd3 Block OFF  OFF 
16:11:08.005 Isolated Gnd2 Block OFF  OFF 
16:11:08.005 Isolated Gnd1 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC3 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC2 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC1 Block OFF  OFF 
16:11:08.005 Ground TOC3 Block OFF  OFF 
16:11:08.005 Ground TOC2 Block OFF  OFF 
16:11:08.005 Ground TOC1 Block OFF  OFF 
Esc: Prev.  Enter: Menu. : Scroll. 
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Pressing the ESC key, the user returns to the previous screen (Metering screen) 

Intro: Menu.

Pressing the enter/shuttle key, the user accesses the Events menu that offers the following options at the bottom of the 
screen: 

nextprevreloaddetailsAt

To access the different options in the snapshot events graphic menu the user must move the cursor from up to down or 
from left to right. The selected option is displayed in upper case and between brackets. To access the selected option, the 
user must press again the enter/shuttle key.

<NEXT>

The user accesses the next available graphic screen (Events ‚Äì New) 

<PREV>

This option returns to the general events graphic menu (All Events)

<RELOAD>

This option updates all events stored in the relay and returns to the general events screen.

<DETAILS>

The Details screen provides access to metering values, and date and time related with the event.

The top of the screen displays a legend with the event text, followed by the date and time, the event status (ON or OFF),
and the event index number related to the complete list of events in the relay, for example (1/479). The rest of
information provided by the Details screen corresponds to the relay measures in the moment of the event. Metering
values provided in the events are secondary, and voltage values correspond to phase-to-ground voltage.

Figure 4-32: Snapshot events details screen

To navigate this screen the user must follow the legend at the bottom of the screen:

Enter: Meters.                             ESC: Prev.                       : Scroll.

Ready LED ON  
Date: 07/Nov/2004    St:ON 
Time: 16:11:08.035    (1/479) 

Phasor Ia Primary    0.000 
Phasor Ib Primary    0.000 
Phasor Ic Primary    0.000 
Line Frequency    0.000 
Phasor Ig Primary    0.000 
Phasor Isg Primary    0.000 
I0 Primary     0.000 
I1 Primary     0.000 

Enter: Meters.    ESC: Prev  : Scroll. 
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Enter: Meters.

To access the metering values in the moment of the event, the user must press the enter/shuttle key. A new metering
screen is displayed, containing the primary metering values in the snapshot event, such as:

Once inside the Metering screen, a new legend is shown for each event (Intro or ESC: Prev. U-D (L-R: Scroll); press ESC
or the shuttle key to return to the Event Details screen, and press the up-down key or rotate the shuttle key to access
all the metering values contained in the metering screen of the selected event.

ESC: Prev.

If the user presses the ESC key from the event detail screen, the system returns to the all events screen.

: Scroll.

Pressing the up-down key or rotating the shuttle key left (L) or right (R) moves among all the events contained in the all
events screen, allowing a preview of the details for each of them.

<AT>

When this option is selected, the system marks the event where the cursor is located. A relative time stamp is
performed, in such a way that the selected event, marked with an asterisk (*) between the time and the event name is
set with a relative time of 00:00:00:000 on the top line of the event screen, together with its relative index, and the rest
of events in the screen shows a date/time that relates to the marked event. This operation mode allows a quick
inspection of the relative time passed between several events, which is very useful for analyzing events in the field.
The corresponding legend to this relative event-marking screen is as follows:

Esc: Out At.Enter: Tag event.

Esc: Out At.

The relative event marking is eliminated and the system returns to the general events screen.

Enter: Tag event.

If the user places the cursor on a different event by pressing the up-down key or rotating the shuttle key left or
right, pressing the enter/shuttle key changes the relative mark to that new event.

4.2.6.4  New events screen

This screen shows the new events that have been produced in the relay since the last time the New Events screen was 
read. The top of the screen shows a "New Events" legend, and the relative and total number of events contained.

Navigation through the different menus in this New Events screen is similar to the one described in the previous section for 
All Events. The main difference is that in the case of new events it is necessary to select the RELOAD submenu to update 
the screen with new events that have been produced, while in the All Events screen, this refreshment is automatic.

After the new events have been read, if the user selects again the Reload menu, the system shows a <No new events 
available.> message, indicating that there are no more new events available since the last reading.

Phasor Ia Primary I2 Primary

Phasor Ib Primary Vab Primary

Phasor Ic Primary Vbc Primary 

Line Frequency Primary Vca Primary

Phasor Ig Primary V1 Primary

Phasor Isg Primary V2 Primary

I0 Primary V0 Primary

I1 Primary 3 Phase Power Factor
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4.2.6.5  Alarms panel

Alarms panel can be viewed in all C650 models using communication software EnerVista 650 Setup, however, only models 
with graphic display allow access to the alarms panel from the HMI.

First line shows the relative and total number of alarms existing in that screen. The relative number refers to the alarm on 
which the cursor is located, and the total number refers to the total amount of alarms available. The second line on this 
screen shows an index that indicates the number of the configured control event that corresponds to the displayed alarm, 
followed by the alarm text configured in the Control Events menu inside the Relay Configuration option (Setpoint > Relay 
Configuration > Control Events). 

Figure 4-33: Alarms panel in HMI

The rest of the screen shows the different alarms produced in the relay with the date and time when the corresponding 
event was produced, followed by the alarm identification text, and its status, active (ON) or inactive (OFF).

In the previous example, the produced alarm is the change to local of the execution of operations (OPERATIONS IN LOCAL 
MODE), the date and time when this event has been produced, and its status (ON):

The bottom of the screen shows the legend that indicates how to navigate through the different options available in the 
screen.

ESC: Prev.Enter: Next.

ESC: Prev.

Pressing the ESC key, the system returns to the previous New Events screen.

Enter: Next.

Pressing the enter/shuttle key, the user accessed the available alarms menu, which includes the following options.

next prev ack ack all

To access the different options provided by the alarms graphic menu, the user must press the up-down key or move   the 
shuttle key left to right. The selected option is displayed in upper case and between brackets. To access the selected 
option, the enter/shuttle key must be pressed.

<NEXT>

This option provides access to the next available graphic screen (I/O boards) 

<PREV>

The system returns to the previous New Events screen. 

<ACK>

This option acknowledges the alarm on which the cursor is located.

Alarm Panel (1/3). 
#1 OPERATIONS IN LOCAL MODE 

7/11/04 16:54:16 OPERATIONS IN LO.  ON 
7/11/04 16:54:16 GENERAL PICKUP  ON 
7/11/04 16:54:16 GENERAL TRIP  ON 

Esc: Prev.  Enter: Next 
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<ACK ALL>

This option acknowledges all alarms. Alarm acknowledgment through the graphic HMI is considered as through
communication port COM2, as it is considered to be Local in both cases.

When an alarm has been acknowledged, a selection mark appears to the right of its status. Inactive alarms disappear
from the screen once they are acknowledged.

4.2.6.6  Input/output monitoring screen

This is the last screen available in the graphic display. This screen allows viewing the status of the relay inputs and outputs, 
as well as emulate inputs (for verification of the logic, or related functions), and contact outputs (to verify wiring). 

The format of this screen is shown on the figure below.

The first line shows the name of the screen "I/O Cards", followed by the type and description of the board where the cursor 
is located, which appears between selection marks > < and blinking.

Figure 4-34: INPUTS/OUTPUTS GENERAL SCREEN

The navigation legend on this screen is as follows: 

Esc: Prev.             Enter: Menu.        :  Chg Card
Esc: Prev.

This option returns to the previous screen (Alarms Panel).

Enter: Menu.

This option provides access to the selected I/O board menu:

This menu includes the following options.

nextviewtest inputtest output

As in previous screens, to access the different options provided by the inputs/outputs graphic menu, the user must press 
the up-down key or move the shuttle key left to right. The selected option is displayed in upper case and between brackets. 
To access the selected option, the enter/shuttle key must be pressed.

IO Card. 
Type: 2, Nº IN 8,  Nº OUT 8 

  >F< 
  G 
  H 
  J  

Esc: Prev.  Enter: Menu.  : Chg Card. 
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Figure 4-35: Input/output viewing screen

<NEXT>

This option brings the system back to the one-line diagram.

<VIEW>

This option shows the real status of all inputs and outputs in the selected board. Depending on the type of board, with
or without supervision, the screen varies depending on the board characteristics.

The first line of this screen shows the slot where the board is located, F, G, H or J, and the type of board. The view
menu differentiates inputs and outputs; the active status (ON) is represented by the lighting of the corresponding input
or output.

The legend at the bottom of the screen indicates how to navigate:

Esc: Prev. Enter: Menu. : Chg Card

Esc: Prev.

Returns to the general I/O screen

Enter: Menu.

Provides access to the I/O menu (next, view, test input, test output). 

: Chg Card

Pressing the up-down key or Moving the shuttle key to the left or right provides access to the status of inputs/
outputs for the different boards available in the relay.

<TEST INPUT>

This option allows testing the input activation (in emulation mode). The displayed screen is similar to the viewing
screen, but in this case the user can operate the different relay inputs.

This screen shows the Input name lit up, showing that this is an Input emulation mode.

The first relay input appears blinking and between brackets; the user can select a different input by pressing up-down
key or rotating the enter/shuttle key. When the shuttle key is pressed, the selected input is activated. Navigation
through this screen is indicated by the following legend:

Esc: Exit Text. Enter: Chg Input.

IO Card F. Type: 2, # IN 8,  # OUT 8 

Input  (ON OFF)  Output 

next  >VIEW< test input test output 

 0 CC1   8 Va COIL1 
 1 CC2   9 Vb COIL1 
 2 CC3  10 Va COIL2 
 3 CC4  11 Vb COIL2 
 4 CC5  12 Isense1 
 5 CC6  13 Isense1 
 6 CC7  14 SUP21 
 7 CC8  15 SUP22
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Esc: Exit Text.

The ESC option returns to the general I/O board menu.

Enter: Chg Input.

Pressing the enter/shuttle key on the blinking input, this input is activated in emulation mode.

Note: input emulation can only be executed through the TEST INPUT tool on the graphic display.

<TEST OUTPUT>

This option allows testing the output activation in emulation mode. The displayed screen is similar to the viewing
screen, but in this case the user can operate the different relay contact outputs to test the wiring.

This screen shows the Output name lit up, showing that this is an output emulation mode.

The first relay output appears blinking and between brackets; the user can select a different output by pressing the
up-down key or rotating the shuttle key. When the enter/shuttle key is pressed, the selected output is activated.
Navigation through this screen is indicated by the following legend:

Esc: Exit Text. Enter: Chg Output.

Esc: Exit Text.

The ESC option returns to the general I/O board menu.

Enter: Chg Output.

Pressing the enter/shuttle key on the blinking output, this output is activated in emulation mode.

Note: Output emulation can be executed through the TEST OUTPUT tool on the graphic display, and also
through communications using EnerVista 650 Setup software for all C650 models.

: Chg Card

Pressing the up-down key or rotating the shuttle key allows to change the selected I/O board in the main I/O screen.
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4.3   Web server

4.3.1  Home
The web server in the C650 can be accessed running the Windows explorer, and typing http://xxx.xxx.xx.xxx, where 
xxx.xxx.xxx.xxx is the relay IP address, which must be configured in Setpoint > Product Setup > Communication Settings 
> Ethernet. 

The main screen of the C650 web server shows the different monitoring possibilities for snapshot events, events, alarms, 
oscillography, data logger and metering values provided by the relay through the web.

In order to access the different functions provided by the web server, the user must simply click the list name on the left 
side of the screen.

The web server (for version 1.70 and higher ones) allows the user to visualize the different web server screen languages: 
English, French, Spanish, Russian and Chinese by pressing the language button on the top right corner of the main window. 
Take into account that this selection only changes the language in the web server screen, all the relay texts, such as 
snapshot events, control events, etc. are in the language selected in the relay (see section 4.2.5.11 Select language in this 
manual).

Figure 4-36: Web server main screen
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4.3.2  Snapshot events
The Snapshot events screen shows all Snapshot events produced in the relay. This screen is refreshed automatically every 
minute.

The information provided in this screen includes: first, the relative event index, the lowest index corresponding to the most 
recent event; next, the event text that shows the reason for the event, its status, active (ON) or inactive (OFF), and finally the 
date and time when the event was produced.

The bottom of the screen shows a Metering screen; clicking on one of the events, the associated metering values are 
shown on that screen.

Figure 4-37: Snapshot events screen
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4.3.3  Control events
The control events screen provides access to all events that have been configured in the Control Events screen inside the 
Relay Configuration menu of EnerVista 650 Setup.

Figure 4-38: Control events screen

Unlike the case of Snapshot events, in this screen the highest index corresponds to the most recent event. The information 
provided is the control event index, the text that has been associated with the event when configured, its status, active 
(ON) or inactive (OFF), and its date and time.
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4.3.4  Alarms
The alarms screen provides access to alarms configured in the relay. As in the case of snapshot events and control events, 
this screen allows only to view the alarms, but not to acknowledge them.

Figure 4-39: Alarms screen
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4.3.5  Oscillography
The oscillography screen allows obtaining from the relay available oscillography records in that moment.

This screen includes two windows. The first window shows oscillography records available in the relay, identified by an 
index, being the highest index the most recent record (oscillography record No 6 in the example below).

Figure 4-40: Oscillography screen

If the user clicks on the oscillography record he wants to retrieve, the window on the right shows a description of the 
record header, indicating its date, time, and the most relevant parameters of the record. Once a record is selected, it is 
required to press the Download button. The system then opens a window to allow saving the files in Comtrade format on 
the PC hard drive. Once the records have been saved, the system asks if the user wants to open GE-OSC tool (Comtrade 
record viewer) to view the downloaded files.

Figure 4-41: GE-osc launch screen
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4.3.6  Data logger
The data logger screen allows viewing the data logger first and last value retrieval date and allows downloading the data 
record files in Comtrade format, by pressing the Download option. Stored files can be viewed later using any Comtrade 
format viewer.

Figure 4-42: Data logger screen



4-70 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

4.3 WEB SERVER CHAPTER 4:  INTERFACES, SETTINGS & ACTUAL VALUES



1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 5-1

C650 Bay Controller & Monitoring System

Chapter 5:  Setpoints

GE
Grid Solutions

SETPOINTS

5.1  Overview

5.1.1  Setpoint main menu
Table 5-1: Setpoint main menu in EnerVista 650 Setup software:
Product Setup

Communication settings

Serial Ports

Network (Ethernet)

ModBus Protocol

DNP3 Slave (Available for standard and 
IEC61850 models, not available for IEC 870-
5-103 models)

IEC 870-5-104 (Available for standard and 
IEC61850 models, not available for IEC 870-
5-103 models)

SNTP

PTP 1588 (Available from V7.00)

Routing (Available from V7.00)

ModBus User Map

Oscillography

Data Logger

Demand

Time Settings

System Setup

General settings

Flex Curves

Breaker

Breaker Settings

Breaker Maintenance
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Switchgear

Miscellaneous Settings

Control Elements

Setting Group

Underfrequency

Overfrequency

Synchrocheck

Autoreclose

Breaker Failure. 

VT Fuse Failure. 

Broken Conductor

Locked Rotor

Pulse Counters

Analog Comparator

Frequency rate of change

Load Encroachment

Digital Counters

Input/Outputs

Contact I/O

Board F

Board G

Board 2H

Board 2J

Force Outputs.

Remote Comms (Available for IEC61850 
models only).

Virtual Inputs
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5.2  Product setup

5.2.1  Communication settings

5.2.1.1  Serial ports

Baud rate and parity for COM1 and COM2 serial communication ports.

5.2.1.2  Network (Ethernet)

For firmware versions 7.00 or higher; the Network settings are the Ethernet communication parameters for Port A, Port B 
and Port E. Depending on the order code, up to three different Ethernet addresses can be used, The ModBus Slave address 
used by Ethernet ports is the one set for COM2.

Table 5-2: Network settings for firmware version 7.00 and above

IP ADDRESS: This setting sets the ports IPv4 address in standard IPV4 format. Note that this setting is only valid on port B if 
port A’s REDUNDANCY is set to INDEPENDENT.

NETMASK: This setting sets the ports IPv4 subnet mask in standard IPV4 format. Note that this setting is only valid on port 
B if port A’s REDUNDANCY is set to INDEPENDENT.

Product Setup > Communication Settings > Serial Ports

Name Default Value Step Range

COM1 Baud Rate 19200 N/A [300 : 115200]

COM2 Baud Rate 19200 N/A [300: 115200]

COM1Parity NONE N/A [NONE:ODD:EVEN]

COM2Parity NONE N/A [NONE:ODD:EVEN]

PRODUCT SETUP > COMMUNICATION SETTINGS > NETWORK (ETHERNET) NETWORK 
(ETHERNET)A > NETWORK (ETHERNET)B > NETWORK (ETHERNET) E > REDUNDANCY 

NAME DEFAULT 
VALUE

STEP RANGE USER VALUE

IP Address Oct1 0 N/A [0 : 255]

IP Address Oct2 0 N/A [0 : 255]

IP Address Oct3 0 N/A [0 : 255]

IP Address Oct4 0 N/A [0 : 255]

Netmask Oct1 0 N/A [0 : 255]

Netmask Oct2 0 N/A [0 : 255]

Netmask Oct3 0 N/A [0 : 255]

Netmask Oct4 0 N/A [0 : 255]
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Table 5-3: Redundancy settings

REDUNDANCY MODE: This setting is available only if the hardware has multiple ports. The setting determines if ports A and B 
operate in redundant or independent mode. Different options are listed below:

· Independent: In non-redundant mode, port A and B operate independently with their own MAC, IP address, mask and
gateway. 

NOTE: When using more than one Ethernet port, each port must be configured to belong to a different network, otherwise
communications becomes unpredictable. 

NOTE 2: When non-redundant mode is selected, MAC address assigned to port A is the same as MAC address assigned to
port E but increased in one unit and MAC address assigned to port B is the same as MAC address assigned to port A but
increased in one unit. 

E.g (MAC_portE: 00AFF40A24DA, MAC_portA:00AFF40A24DB, MAC_portB: 00AFF40A24DC)

· LLA (Link Loss) operation: The operation of ports A and B are as follows: 

Ports A and B use port A’s MAC and IP address settings while port B is in standby mode in that it does not actively
communicate on the Ethernet network but monitors its link. 

· PRP (Parallel Redundancy Protocol): ports A and B use the same MAC (physical device) address and combine
information at the link layer. It is intended to only be used if the two ports are connected to separate parallel LAN’s. In
this mode of operation both ports cannot be connected to the same LAN. The receiving devices process the first frame
received and discard the duplicate through a link redundancy entity (LRE) or similar service that operates below layer 2.
Aside from LRE, PRP uses conventional Ethernet hardware but both ports must know they are in PRP. Both ports of PRP
devices operate with the same Internet Protocol (IP) addresses for traffic that uses IP Management protocols such as
Address Resolution Protocol (ARP). 

· HSR (High-availability Seamless Redundancy): ports A and B use the same MAC (physical device) address and combine
information at the link layer. It is intended to work in a ring topology. In this mode of operation port A is connected to
other device's port B, and port B is connected to other device's port A provided that ring topology is respected. The
receiving devices process the first frame received and discard the duplicate through a link redundancy entity (LRE) or
similar service that operates below layer 2. Aside from LRE, HSR uses conventional Ethernet hardware but both ports
must know they are in HSR. Both ports of HSR devices operate with the same Internet Protocol (IP) addresses for traffic
that uses IP Management protocols such as Address Resolution Protocol (ARP). 

· RSTP (Rapid Spanning Tree Protocol): ports A and B use the same MAC (physical device) address and can operate with
different network topologies. The device operates only with one IP address through these 2 ports

· DAISY CHAIN: ports A and B use the same MAC (physical device) address and operate by chaining one device with the
next one. Note that it is important not to create a loop in this topology. Both ends of the chain can be connected to
different networks. The device operates only with one IP address through these 2 ports. 

PRODUCT SETUP > COMMUNICATION SETTINGS > NETWORK (ETHERNET) > REDUNDANCY

NAME DEFAULT VALUE STEP RANGE

REDUNDANCY MODE INDEPENDENT N/A [INDEPENDENT; LLA; PRP; HSR; RSTP; 
DAISY_CHAIN]

LLA Priority DISABLED N/A [ENABLED; DISABLED]

LLA Timeout 5000 N/A [0 : 600000]

RSTP BRIDGE PRIORITY 32768 N/A [0 : 61440]

RSTP PORT A PRIORITY 128 N/A [0 : 240]

RSTP PORT A PATHCOST 200000 N/A [0 : 2000000]

RSTP PORT B PRIORITY 128 N/A [0 : 240]

RSTP PORT B PATHCOST 200000 N/A [0 : 2000000]
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NOTE 3: When LLA/PRP/HSR or PRR mode is selected, MAC addresses assigned to port A and B are the same between 
them and a consecutive value of MAC address assigned to port E. 

E.g (MAC_portE: 00AFF40A24DA, MAC_portA:00AFF40A24DB, MAC_portB: 00AFF40A24DB)

NOTE 4: When LLA/PRP/HSP/RSTP or DAISY CHAIN mode is selected, the IP configured at 
Product Setup > Communication Settings > Network (Ethernet) > Network (Ethernet) A is the one used by both ports 
(A and B) to communicate in these modes.

LLA PRIORITY: If this setting is set to enabled, the port A has the priority. If PORT A’s LLA detects a problem with the link, 
communications is switched to Port B. Port B is, in effect, acting as a redundant or backup link to the network for port A.

LLA TIMEOUT: This setting is active only when the LLA PRIORITY is set to ENABLED. When the link on primary port is 
detected again after it fails, there is LLA TIMEOUT (ms) monitoring time for the health of the network. During this time, the 
secondary port remains active. If primary network is healthy for more than LLA TIMEOUT value, the switch over to primary 
port is automatic.

RSTP BRIDGE PRIORITY: Specifies the switch (bridge) priority value. This value is used along with the switch MAC address to
determine which switch in the network is the root device. Lower values mean higher priority. The value ranges from 0 to
65535, with a default of 32768.

RSTP PORTA PRIORITY: This is to determine which ports are used for forwarding. Lower the number means higher priority.
Value ranges from 0 to 255. Default is 128.

RSTP PORTA PATHCOST: This is the assigned port cost value used for the switch to determine the forwarding points.
Values range from 1 to 2000000. The lower the value, the lower the cost and hence the preferred route. 

RSTP PORTB PRIORITY: This is to determine which ports are used for forwarding. Lower the number means higher priority.
Value ranges from 0 to 255. Default is 128.

RSTP PORTB PATHCOST: This is the assigned port cost value used for the switch to determine the forwarding points.
Values range from 1 to 2000000. The lower the value, the lower the cost and hence the preferred route. 

For this setting change to take effect, a reboot is required. 

5.2.1.3  MODBUS protocol

ModBus Slave Addresses for serial and Ethernet communication and the ModBus port number used for ModBus TCP/IP. For 
more detailed information go to appendix B in this manual.

Product Setup > Communication Settings > ModBus Protocol

Name Default Value Step Range

ModBus Address COM1 254 1 [1 : 255]

ModBus Address COM2 254 1 [1 : 255]

ModBus Port Number 502 1 [0 : 65535]
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5.2.1.4  DNP3 slave

Physical port, Slave Address for DNP, IP Addresses for Masters, TCP/UDP Port, Unsolicited Response parameters, Analog 
scale factors and deadbands, message fragment size, Binary input block. For more detailed information go to appendix C 
in this manual. DNP protocol is available for standard and IEC61850 models.

Table 5-4: DNP protocol settings
Product Setup > Communication settings > DNP3 Slave
DNP3 Slave 1 > DNP3 Slave 2 > DNP3 Slave 3

Name Default Value Step Range

Physical Port NONE N/A [COM1:COM2:NETWORK]

Address 255 1 [0 : 65534]

IP Addr Client1 Oct1 0 1 [0 : 255]

IP Addr Client1 Oct2 0 1 [0 : 255]

IP Addr Client1 Oct3 0 1 [0 : 255]

IP Addr Client1 Oct4 0 1 [0 : 255]

IP Addr Client2 Oct1 0 1 [0 : 255]

IP Addr Client2 Oct2 0 1 [0 : 255]

IP Addr Client2 Oct3 0 1 [0 : 255]

IP Addr Client2 Oct4 0 1 [0 : 255]

IP Addr Client3 Oct1 0 1 [0 : 255]

IP Addr Client3 Oct2 0 1 [0 : 255]

IP Addr Client3 Oct3 0 1 [0 : 255]

IP Addr Client3 Oct4 0 1 [0 : 255]

IP Addr Client4 Oct1 0 1 [0 : 255]

IP Addr Client4 Oct2 0 1 [0 : 255]

IP Addr Client4 Oct3 0 1 [0 : 255]

IP Addr Client4 Oct4 0 1 [0 : 255]

IP Addr Client5 Oct1 0 1 [0 : 255]

IP Addr Client5 Oct2 0 1 [0 : 255]

IP Addr Client5 Oct3 0 1 [0 : 255]

IP Addr Client5 Oct4 0 1 [0 : 255]

TCP/UDP Port 20000 1 [0 : 65535]

Unsol Resp Function DISABLED N/A [DISABLED – ENABLED]

Unsol Resp TimeOut 5 1 [0 : 60]

Unsol Resp Max Ret 10 1 [0 : 255]

Unsol Resp Dest Adr 200 1 [0 : 65535]

Current Scale Factor 1 N/A [0.00001-0.0001-0.001-0.01-0.1-1-10-
100-1000-10000]

Product Setup > Communication Settings > DNP3 Slave
DNP3 Slave 1 > DNP3 Slave 2 > DNP3 Slave 3

Voltage Scale Factor 1 N/A [0.00001-0.0001-0.001-0.01-0.1-1-10-
100-1000-10000]

Power Scale Factor 1 N/A [0.00001-0.0001-0.001-0.01-0.1-1-10-
100-1000-10000]

Energy Scale Factor 1 N/A [0.00001-0.0001-0.001-0.01-0.1-1-10-
100-1000-10000]

PF Scale Factor 1 N/A [0.00001-0.0001-0.001-0.01-0.1-1-10-
100-1000-10000]

Other Scale Factor 1 N/A [0.00001-0.0001-0.001-0.01-0.1-1-10-
100-1000]

Current Deadband 30000 1 [0 : 65535]

Voltage Deadband 30000 1 [0 : 65535]

Power Deadband 30000 1 [0 : 65535]

Energy Deadband 30000 1 [0 : 65535]
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PF Deadband 30000 1 [0 : 32767]

Other Deadband 30000 1 [0 : 65535]

Msg Fragment Size 240 1 [30 : 2048]

Binary Input Block 1 CTL EVENTS 1-16 N/A

Binary Input Block 2 CTL EVENTS 17-32 N/A

Binary Input Block 3 CTL EVENTS 33-48 N/A

Binary Input Block 4 CTL EVENTS 49-64 N/A

Binary Input Block 5 CTL EVENTS 65-80 N/A

Binary Input Block 6 CTL EVENTS 81-96 N/A

Binary Input Block 7 CTL EVENTS 97-112 N/A

Binary Input Block 8 CTL EVENTS 113-128 N/A

Binary Input Block 9 SWITCHGEAR 1-8 N/A

Binary Input Block 10 SWITCHGEAR 9-16 N/A

Default Analog Map ENABLED N/A

Analog Input Point 0 End of list N/A

Analog Input Point 1 End of list N/A

Analog Input Point 2 End of list N/A

Analog Input Point 3 End of list N/A

Analog Input Point 4 End of list N/A

Analog Input Point 5 End of list N/A

Analog Input Point 6 End of list N/A

Analog Input Point 7 End of list N/A

Analog Input Point 8 End of list N/A

Analog Input Point 9 End of list N/A

Analog Input Point 10 End of list N/A

Analog Input Point 11 End of list N/A

Analog Input Point 12 End of list N/A

Analog Input Point 13 End of list N/A

Analog Input Point 14 End of list N/A

Analog Input Point 15 End of list N/A

Analog Input Point 16 End of list N/A

Analog Input Point 17 End of list N/A

Analog Input Point 18 End of list N/A

Analog Input Point 19 End of list N/A

Analog Input Point 20 End of list N/A

Analog Input Point 21 End of list N/A

Analog Input Point 22 End of list N/A

Analog Input Point 23 End of list N/A

Analog Input Point 24 End of list N/A

Analog Input Point 25 End of list N/A

Analog Input Point 26 End of list N/A

Analog Input Point 27 End of list N/A

Analog Input Point 28 End of list N/A

Analog Input Point 29 End of list N/A

Analog Input Point 30 End of list N/A

Analog Input Point 31 End of list N/A
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5.2.1.5  IEC 60870-5-104

Communication settings for IEC 60870-5-104 protocol. For more detailed information go to appendix D in this manual. DNP 
protocol is available for standard and IEC61850 models.

Table 5-5: IEC 60870-5-104 protocol settings
Product Setup > Communication Settings >IEC 870-5-104

Name Default Value Step Range

Function DISABLED N/A [DISABLED-ENABLED]

TCP Port 2404 1 [1 : 65535]

Common Addr of ASDU 255 1 [0 : 65535]

Cyclic Meter Period 0 1 [0 : 3600]

Synchronization Event 0 1 [0 : 3600]

IEC104 NET1 CLI1 OCTET1 0 N/A [0 : 255]

IEC104 NET1 CLI1 OCTET2 0 N/A [0 : 255]

IEC104 NET1 CLI1 OCTET3 0 N/A [0 : 255]

IEC104 NET1 CLI1 OCTET4 0 N/A [0 : 255]

IEC104 NET1 CLI2 OCTET1 0 N/A [0 : 255]

IEC104 NET1 CLI2 OCTET2 0 N/A [0 : 255]

IEC104 NET1 CLI2 OCTET3 0 N/A [0 : 255]

IEC104 NET1 CLI2 OCTET4 0 N/A [0 : 255]

Function 2 DISABLED N/A

TCP Port 2 2404 N/A [0 : 65535]

Common Addr of ASDU 2 255 N/A [0 : 65535]

IEC104 NET2 CLI1 OCTET1 0 N/A [0 : 255]

IEC104 NET2 CLI1 OCTET2 0 N/A [0 : 255]

IEC104 NET2 CLI1 OCTET3 0 N/A [0 : 255]

IEC104 NET2 CLI1 OCTET4 0 N/A [0 : 255]

IEC104 NET2 CLI2 OCTET1 0 N/A [0 : 255]

IEC104 NET2 CLI2 OCTET2 0 N/A [0 : 255]

IEC104 NET2 CLI2 OCTET3 0 N/A [0 : 255]

IEC104 NET2 CLI2 OCTET4 0 N/A [0 : 255]

IEC104 SCALE CURRENT 1 [0,00001; 0,0001; 0,001; 0,01; 0,1; 1; 10; 
100; 1000; 10000]

IEC104 SCALE VOLTAGE 1

IEC104 SCALE POWER 1 [0 : 65535]

IEC104 SCALE ENERGY 1 [0 : 65535]

IEC104 SCALE OTHER 1 [0 : 65535]

IEC104 DEADBAND CURRENT 30000 [0 : 65535]

IEC104 DEADBAND VOLTAGE 30000 [0 : 65535]

IEC104 DEADBAND POWER 30000 [0 : 65535]

IEC104 DEADBAND ENERGY 30000 [0 : 65535]

IEC104 DEADBAND OTHER 30000 [0 : 65535]

IEC104 IOA BINARIES 1000 [0 : 65535]

IEC104 IOA DOUBLE POINTS 1500 [0 : 65535]

IEC104 IOA ANALOGS 2000 [0 : 65535]

IEC104 IOA COUNTERS 4000 [0 : 65535]

IEC104 IOA COMMANDS 3000 [0 : 65535]

IEC104 IOA ANALOG PARAMETERS 5000 [0 : 65535]
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5.2.1.6  SNTP

The C650 supports the Simple Network Time Protocol specified in RFC-2030. With SNTP, the C650 can obtain the clock time 
over an Ethernet network. The C650 acts as an SNTP client to receive time values from an SNTP/NTP server, usually a 
dedicated product using a GPS receiver to provide an accurate time. Three different modes of SNTP operation are 
supported. These modes are unicast, broadcast and anycast. 

If SNTP functionality is enabled at the same time as an IRIG-B source is connected to the C650, the IRIG-B signal provides 
the time value to the C650 clock for as long as a valid signal is present. If the IRIG-B signal is removed, the time obtained 
from the SNTP server is used. 

To use SNTP in unicast mode, Server IP Oct1...4 must be set to the SNTP/NTP server IP address. Once this address is set 
and the Function setting is “UNICAST”, the C650 attempts to obtain time values from the SNTP/NTP server. Since many 
time values are obtained and averaged, it generally takes forty seconds until the C650 clock is synchronized with the SNTP/
NTP server. It may take up to one minute for the C650 to signal an SNTP FAIL state if the server is offline. 

To use SNTP in broadcast mode, set the Function setting to “BROADCAST”. The C650 then listens to SNTP messages sent to 
the “all ones” broadcast address for the subnet. The C650 waits up to eighteen minutes (>1024 seconds) without receiving 
an SNTP broadcast message before signalling an SNTP FAIL state. 

To use SNTP in anycast mode, set the Function setting to “ANYCAST”. Anycast mode is designed for use with a set of 
cooperating servers whose addresses are not known beforehand by the client. The C650 sends a request to a multicast 
group address assigned by IANA for NTP protocol. This address is 224.0.1.1 and a group of SNTP/NTP servers listens to it. 
Upon receiving a request each server sends a unicast response to the SNTP/NTP client. The C650 relay binds to the first 
unicast message received from any server. Then it continues operating with SNTP/NTP server in unicast mode. Any further 
responses from other SNTP/NTP servers are ignored. In unicast mode of operation the chosen time server can go offline, in 
that case it takes about one minute for the C650 to signal an SNTP FAIL state and to switch again to anycast mode to try to 
find another time server. In anycast mode the C650 tries to send multicast messages up to five minutes before signalling 
an SNTP FAIL state.

The C650 relay does not support the multicast mode of SNTP functionality. 

For firmware version 7.20 or above, C650 shall accept time synchronization from up to two different SNTP servers. In order 
to define number of SNTP servers to be used, different settings for each SNTP server must be configured in the C650. 
SNTP1 or/and SNTP2 tab settings shall be configured.

 If only one SNTP server is used to synchronize the relay, SNTP1 tab settings shall be filled with its corresponding settings. If 
two SNTP servers are used, SNTP1 and SNTP2 tab shall be filled as follow:

"SNTP1 tab shall contain settings of main SNTP server.

"SNTP2 tab shall contain settings of back-up SNTP server.

If two SNTP servers are configured, C650 operation mode is described as follows: 

Product Setup > Communication Settings > SNTP > SNTP1/SNTP2

Name Default Value Step Range

Function DISABLED N/A [DISABLED – ENABLED]

UDP Port 123 1 [1 : 65535]

Server Ip Oct1 0 1 [0 : 255]

Server Ip Oct2 0 1 [0 : 255]

Server Ip Oct3 0 1 [0 : 255]

Server Ip Oct4 0 1 [0 : 255]
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NOTE: SNTP settings take effect after rebooting the device.

5.2.1.7  PTP IEEE 1588 protocol settings

 

C650 relay supports IEEE 1588 version 2.

The relay meets the time accuracy requirements of IEC 61850-5-Ed2 clause 11.1.3.3 time synchronization class T5 (± 1 µs) 
and of the IEEE Std. PC37.118.1 Draft 1.6 clause 4.3 (± 1 µs), given an error-free PP input and stable temperature

The relay resynchronizes to a grandmaster slewing at ±2 µs/s when the rate of change of frequency stabilizes.  It may 
become unsynchronized when the ramp starts or stops.

The relay only supports Peer-To-Peer delay mechanism.

PTP FUNCTION

While this port setting is selected to disabled, PTP is disabled on this port.  The relay does not generate or listen to PTP 
messages on this port.

PORT A, B PATH DELAY ADDER

The time delivered by PTP is advanced by the time value in this setting prior to the time being used to synchronize the 
relay’s real time clock. This is to compensate to the extent practical for time delivery delays not compensated for in the 
network. In a fully compliant PP network, the peer delay and the processing delay mechanisms compensate for all the 
delays between the grandmaster and the relay. In such networks, this setting should be zero. 

In networks containing one or more switches and/or clocks that do not implement both of these mechanisms, not all 
delays are compensated, so the time of message arrival at the relay is later than the time indicated in the message. This 
setting can be used to approximately compensate for this delay. However, as the relay is not aware of network switching 

Scenario Expected Behavior

SNTP1 server= Available
SNTP2 server= Available

C650 shall be synchronized by SNTP1 server.
No alarm

SNTP1 server= Available
SNTP2 server= Not Available

C650 shall continue to be synchronized by SNTP1 server
No alarm

SNTP1 server= Not Available
SNTP2 server= Available

If SNTP1 server fails, C650 shall get synchronization from SNTP2 
server. When SNTP1 server recovers, C650 shall switch to be 
synchronized by SNTP1 server.
No alarm

SNTP1 server= Not Available
SNTP2 server= Not Available

"Not Synchronized" Alarm shall appear in local mimic 

Product Setup > Communication Settings > PTP 1588

Name Default Value Step

PTP FUNCTION DISABLE [DISABLE; ENABLE]

PORTA DELAY ADDER 0 ns [0 : 60000]

PORTA DELAY ASYM 0 ns [-1000 : 1000]

PORTB DELAY ADDER 0 ns [0 : 60000]

PORTB DELAY ASYM 0 ns [-1000 : 1000]

STRICT POWER PROFILE DISABLED DISABLED/ENABLED

PTP DOMAIN NUMBER 0 [0 : 255]

PTP VLAN PRIORITY 4 [0 : 7]

PTP VLAN ID 0 [0 : 4095]

PTP EPOCH UTC SINCE 2000 UTC SINCE 2000; UTC SINCE 1970; UTC SINCE 1900
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that dynamically changes the amount of uncompensated delay, there is no setting that is always completely correct for 
uncompensated delay. A setting can be chosen to reduce the worst-case error to half of the range between minimum and 
maximum uncompensated delay, if these values are known.

PORT A, B PATH DELAY ASYMMETRY 

Range: -1 000 … +1 000 ns

Default: 0

This setting corresponds to “delayAsymmetry” in PTP, which is used by the peer delay mechanism to compensate for any 
difference in the propagation delay between the two directions of a link.  Except in unusual cases, the two fibers are of 
essentially identical length and composition, so this setting should be set to zero.  

In unusual cases where the length of the link is different in different directions, this setting should be set to the number of 
nanoseconds the Ethernet propagation delay to the relay is longer than the mean of path propagation delays to and from 
the relay. For instance, if it is known say from the physical length of the fibers and the propagation speed in the fibers that 
the delay from the relay to the Ethernet switch it is connected to is 9 000 ns and the that the delay from the switch to the 
relay is 11 000 ns, then the mean delay is 10 000 ns, and the path delay asymmetry is +1 000 ns. 

STRICT POWER PROFILE

Power profile (IEEE Std C37.238™-2011) requires that the relay only select as a grandmaster power profile compliant 
clocks, that the delivered time have worst-case error of ±1 µs, and that the peer delay mechanism be implemented. With 
the strict power profile setting enabled, the relay only selects master clocks displaying the IEEE_C37_238 identification 
codes. It uses a port only when the peer delay mechanism is operational. With the strict power profile setting disabled, the 
relay uses clocks without the power profile identification when no power profile clocks are present, and uses ports even if 
the peer delay mechanism is non-operational.

This setting applies to all of the relay’s PTP capable ports.

PTP DOMAIN NUMBER

This setting should be set to the domain number of the grandmaster-capable clock(s) to be synchronized to. A network 
may support multiple time distribution domains, each distinguished with a unique domain number. More commonly, there 
is a single domain using the default domain number zero.

This setting applies to all of the relay’s PTP capable ports.

PTP VLAN PRIORITY 

This setting selects the value of the priority field in the 802.1Q VLAN tag in request messages issued by the relay’s peer 
delay mechanism. In compliance with PP the default VLAN priority is 4, but it is recommended that in accordance with PTP 
it be set to 7.

Depending on the characteristics of the device to which the relay is directly linked, VLAN Priority may have no effect. 

This setting applies to all of the relay’s PTP capable ports.

PTP VLAN ID 

This setting selects the value of the ID field in the 802.1Q VLAN tag in request messages issued by the relay’s peer delay 
mechanism. It is provided in compliance with PP. As these messages have a destination address that indicates they are not 
to be bridged, their VLAN ID serves no function, and so may be left at its default value.

Depending on the characteristics of the device to which the relay is directly linked, VLAN ID may have no effect.

This setting applies to all of the relay’s PTP capable ports. 

PTP EPOCH

This setting sets the reference point from which time is measured.

NOTE: PTP settings take effect after rebooting the device.
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5.2.1.8  Routing

 A default route and a maximum number of 6 static routes may be configured. The default route is used as the last choice, 
if no other route towards a given destination is found. 

Product Setup > Communication Settings > Routing

Name Default Value Step

Default RT GWY Oct1 10 [0 : 255]

Default RT GWY Oct2 3 [0 : 255]

Default RT GWY Oct3 32 [0 : 255]

Default RT GWY Oct4 1 [0 : 255]

Static RT1 IP Oct1 0 [0 : 255]

Static RT1 IP Oct2 0 [0 : 255]

Static RT1 IP Oct3 0 [0 : 255]

Static RT1 IP Oct4 0 [0 : 255]

Static RT1 Mask Oct1 0 [0 : 255]

Static RT1 Mask Oct2 0 [0 : 255]

Static RT1 Mask Oct3 0 [0 : 255]

Static RT1 Mask Oct4 0 [0 : 255]

Static RT1 GWY Oct1 0 [0 : 255]

Static RT1 GWY Oct2 0 [0 : 255]

Static RT1 GWY Oct3 0 [0 : 255]

Static RT1 GWY Oct4 0 [0 : 255]

Static RT2 IP Oct1 0 [0 : 255]

Static RT2 IP Oct2 0 [0 : 255]

Static RT2 IP Oct3 0 [0 : 255]

Static RT2 IP Oct4 0 [0 : 255]

Static RT2 Mask Oct1 0 [0 : 255]

Static RT2 Mask Oct2 0 [0 : 255]

Static RT2 Mask Oct3 0 [0 : 255]

Static RT2 Mask Oct4 0 [0 : 255]

Static RT2 GWY Oct1 0 [0 : 255]

Static RT2 GWY Oct2 0 [0 : 255]

Static RT2 GWY Oct3 0 [0 : 255]

Static RT2 GWY Oct4 0 [0 : 255]

Static RT3 IP Oct1 0 [0 : 255]

Static RT3 IP Oct2 0 [0 : 255]

Static RT3 IP Oct3 0 [0 : 255]

Static RT3 IP Oct4 0 [0 : 255]

Static RT3 Mask Oct1 0 [0 : 255]

Static RT3 Mask Oct2 0 [0 : 255]

Static RT3 Mask Oct3 0 [0 : 255]

Static RT3 Mask Oct4 0 [0 : 255]

Static RT3 GWY Oct1 0 [0 : 255]

Static RT3 GWY Oct2 0 [0 : 255]

Static RT3 GWY Oct3 0 [0 : 255]
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The redundancy communications comes with the capability of setting a number of static routes and one default route, 
which is used instead of default gateway.

PRODUCT SETUP > COMMUNICATION SETTINGS > ROUTING

Name Default Value Step

Static RT3 GWY Oct4 0 [0 : 255]

Static RT4 IP Oct1 0 [0 : 255]

Static RT4 IP Oct2 0 [0 : 255]

Static RT4 IP Oct3 0 [0 : 255]

Static RT4 IP Oct4 0 [0 : 255]

Static RT4 Mask Oct1 0 [0 : 255]

Static RT4 Mask Oct2 0 [0 : 255]

Static RT4 Mask Oct3 0 [0 : 255]

Static RT4 Mask Oct4 0 [0 : 255]

Static RT4 GWY Oct1 0 [0 : 255]

Static RT4 GWY Oct2 0 [0 : 255]

Static RT4 GWY Oct3 0 [0 : 255]

Static RT4 GWY Oct4 0 [0 : 255]

Static RT5 IP Oct1 0 [0 : 255]

Static RT5 IP Oct2 0 [0 : 255]

Static RT5 IP Oct3 0 [0 : 255]

Static RT5 IP Oct4 0 [0 : 255]

Static RT5 Mask Oct1 0 [0 : 255]

Static RT5 Mask Oct2 0 [0 : 255]

Static RT5 Mask Oct3 0 [0 : 255]

Static RT5 Mask Oct4 0 [0 : 255]

Static RT5 GWY Oct1 0 [0 : 255]

Static RT5 GWY Oct2 0 [0 : 255]

Static RT5 GWY Oct3 0 [0 : 255]

Static RT5 GWY Oct4 0 [0 : 255]

Static RT6 IP Oct1 0 [0 : 255]

Static RT6 IP Oct2 0 [0 : 255]

Static RT6 IP Oct3 0 [0 : 255]

Static RT6 IP Oct4 0 [0 : 255]

Static RT6 Mask Oct1 0 [0 : 255]

Static RT6 Mask Oct2 0 [0 : 255]

Static RT6 Mask Oct3 0 [0 : 255]

Static RT6 Mask Oct4 0 [0 : 255]

Static RT6 GWY Oct1 0 [0 : 255]

Static RT6 GWY Oct2 0 [0 : 255]

Static RT6 GWY Oct3 0 [0 : 255]

Static RT6 GWY Oct4 0 [0 : 255]
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Default RT GWY: 

This setting sets the gateway of the default route to be used by IP traffic sent from the relay, if no other route towards a 
given IP destination is found. 

Note that this setting is only valid on port B if port REDUNDANCY is set to INDEPENDENT.

Static RTX IP: This setting sets the destination IPv4 route. 

Static RTX MASK: This setting sets the IP mask associated with the route.

Static RTX GWY: This setting sets the gateway to reach the destination IP route.

Important Notes:
1. Host routes are not supported at present.

2. The route mask has IPv4 mask format. In binary this should be a set of contiguous bits of 1 from left to right, followed 
by one or more contiguous bits of 0.

3. The route destination and mask must match. 

•This can be verified by checking that RtDestination & RtMask == RtDestination

•Example of good configuration: RtDestination= 10.1.1.0; Rt Mask= 255.255.255.0

•Example of bad configuration: RtDestination = 10.1.1.1; Rt Mask= 255.255.255.0

4. The route destination must not be a connected network. 

5. The route gateway must be on a connected network. This rule applies to the gateway address of the default route as 
well.

5.2.2  MODBUS user map settings
The ModBus user map definition. 256 records, selectable from the complete relay ModBus map, from the ModBus user 
map. For more detailed information go to appendix B in this manual.

Product Setup > ModBus User Map

Name Default Value Step Range

Address 00 0000 [0000 : FFFF]

Address 01 0000 [0000 : FFFF]

... ...

Address 254 0000 [0000 : FFFF]

Address 255 0000 [0000 : FFFF]
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5.2.3  Oscillography settings
Oscillography records contain waveforms captured at the sampling rate as well as other relay data at the point of trigger. 
This trigger can be configured with a programmable logic operand.

Oscillography records are stored in COMTRADE ASCII - IEEE C37.111-1999 standard format.

The oscillography module is in charge of storing the instantaneous values of the 9 analog signals and the 16 
programmable digital signals at Setpoint > Relay Configuration > Oscillography in fault conditions (OSCILLO TRIGGER 
signal activation).

All oscillography records store all analog signals (fixed) plus 16 digital signals (programmable). The order of storage in the 
case of analog signals is as follows:

Analog 1 IA channel.

Analog 2 IB channel. 

Analog 3 IC channel. 

Analog 4 IG channel. 

Analog 5 ISG channel. 

Analog 6 VA or VAB channel, depending on the selected configuration (Wye or Delta, at “Setpoint > System Setup > 
General Settings > Serial VT Connection”). 

Analog 7 VB or VBC channel, depending on the selected configuration (Wye or Delta, at “Setpoint > System Setup > 
General settings > Phase VT Connection”). 

Analog 8 VC or VCA channel, depending on the selected configuration (Wye or Delta, at “Setpoint > System Setup > 
General settings > Phase VT Connection”). 

Analog 9 VN or VX channel, depending on the selected configuration (zero sequence measured, or busbar voltage, at 
“Setpoint > System Setup > General settings > Auxiliary Voltage”).

The 16 digital channels and the oscillography trigger signal are programmable using the EnerVista 650 Setup software at 
Setpoint > Relay configuration > Oscillography. Each digital channel can be associated with a single status or to a logic 
status. In this last case, the logic must be configured using the PLC Editor tool, at Setpoint > Logic Configuration inside 
EnerVista 650 Setup. The oscillography trigger signal can be a single status or a configured logic. The relay’s default 
configuration associates the oscillography trigger to Virtual Output 83, which corresponds to the logic associated with the 
general trip of protection elements.

5.2.3.1  Oscillography settings

Function Permission (Function): Enabling this setting allows to create an oscillography record when the “TRIGGER 
OSCILLO” signal is activated.

Trigger Position: This setting defines the prefault data (in percentage) stored every time a new oscillo is 
produced.

Samples/Cycle: This setting defines the number of samples per cycle stored in each oscillography 
record. 

Setpoint > Product Setup > Oscillography

Setting Description Name Default Value Step Range

Function Permission Function ENABLED N/A [DISABLED – ENABLED]

Prefault Trigger Position 30 1% [5 : 95]

Samples per cycle Samples/Cycle 64 N/A [4 – 8 – 16 –32 – 64]

Maximum number of oscillos Max. Number Osc. 4 1 oscillo [1 : 20]

Automatic oscillography overwrite Automatic Overwrite DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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Maximum Number of Oscillos (Max. Number Osc.): 

1 to 20 oscillography records can be selected. 

Automatic Overwrite: This setting allows chained oscillographies during the fault (TRIGGER OSCILLO signal 
activated). The oscillography module is reset once the data has been completely 
stored in Flash memory and the TRIGGER OSCILLO state is deactivated.

Snapshot Events: This setting enables or disables snapshot event generation for the oscillography 
element.

Oscillography files calculations

The overall maximum samples capacity is allocated for 27594 samples. The size of each oscillography file depends on the 
configured number of oscillographies and is evenly distributed based on the maximum samples value using these 
formulas:

Number of samples per oscillography = (27594 samples)/(Max. Number Osc. setpoint)

Number of cycles per oscillography = (Number of samples per oscillography)/(Samples / Cycle setpoint).

EXAMPLE

For a Max. Number Osc. of 4, each record stores 27594 / 4 = 6898 samples per stored oscillo.

If we set the Samples /Cycle setpoint to 64 samples per cycle, each record stores up to 6898 / 64 = 107.78 signal cycles. 
This value expressed in terms of time is:

For 50 Hz: 204.79 cycles x 20 ms/cycle = 4095.8 ms.

For 60 Hz: 204.79 cycles x 16.67 ms/cycle = 3413 ms.

5.2.3.2  Oscillography states

After a change in oscillography settings all oscillography files stored on the flash memory are erased.

OSCILLOGRAPHY STATES

OSC DIG CHANNEL 1

OSC DIG CHANNEL 2

OSC DIG CHANNEL 3

OSC DIG CHANNEL 4

OSC DIG CHANNEL 5

OSC DIG CHANNEL 6

OSC DIG CHANNEL 7

OSC DIG CHANNEL 8

OSC DIG CHANNEL 9

OSC DIG CHANNEL 10

OSC DIG CHANNEL 11

OSC DIG CHANNEL 12

OSC DIG CHANNEL 13

OSC DIG CHANNEL 14

OSC DIG CHANNEL 15

OSC DIG CHANNEL 16
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OSC DIGITAL CHANNEL XX: These states are configured at “Setpoint > Relay configuration > Oscillography”. 
Each of these states can be associated with a protection state or to a virtual output. 
Each oscillography record reflects the changes experienced by this state during the 
record.

OSCILLO TRIGGER: The activation of this state produces the oscillography record capture. Each record 
uses a percentage of its capacity to store prefault information. This percentage is 
selected in the Trigger Position setting, and the rest of the record’s capacity stores 
post-fault information.

NUMBER OF TRIGGERS: This is the number of the most recent oscillography record stored in the relay. The 
record is stored in COMTRADE format. The range is 0 to 999.

CYCLES PER RECORD: This state displays the number of cycles that are stored in each oscillography record. 
Although the number of cycles can be a decimal number, the record represents only 
the integer part.

AVAILABLE RECORDS: This shows the number of records stored in the relay, which can be retrieved by serial 
communication (ModBus RTU) or Ethernet (ftp, tftp). The range is 0 to 20.

5.2.3.3  Oscillography file retrieval

Oscillography files can be retrieved using the EnerVista 650 Setup software, or the web server at “http:\\relay IP address”.

To obtain the oscillography records using the EnerVista 650 Setup software, go to “Actual > Records > Waveform 
capture”. The top of the window shows the number of the last oscillography record stored by the device (Newest Record 
Number), followed by the maximum number of oscillos available (Available Records in Device). Click View header to show 
the header of the record selected at Select Record.

Click Download and the three files (*.DAT, *.HDR, *.CFG) that form the oscillography record in the COMTRADE standard are 
retrieved and viewed automatically if the GE-OSC software is installed in the computer. Retrieved oscillography records 
can be viewed using any Comtrade viewer. The EnerVista 650 Setup software stores oscillography records in the folder 
“.\EnerVista 650 Setup\files\osc” by default, in the same directory where the program is installed. The file names are 
“OSCxxx.DAT”, “OSCxxx.CFG”, “OSCxxx.HDR”, where xxx is the corresponding record number.

For firmware versions above 7.00 and below 7.70, oscillography record retrieval Ethernet communications ports (tftp). For 
firmware versions 7.70 or above, oscillography record retrieval uses serial (ModBus RTU) or Ethernet (tftp) communication 
ports

5.2.4  Data logger
The C650 data logger can store information from up to 16 analog channels, among all channels available in the relay, with 
a selectable sampling rate. The memory of the data logger is fixed at 64 Kilobytes with two bytes needed per channel. The 
selected channels take all available memory space, therefore, the number of days of storage depends on the selected 
number of channels and sampling rate.

OSCILLO TRIGGER

NUMBER OF TRIGGERS

CYCLES PER RECORD

AVAILABLE RECORDS
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5.2.4.1  Data logger settings

Function permission (Function): This must be enabled to start storing information. 

Data Logger Rate: the data logger can be configured in rates of 1 second, and 5, 10, 15, 
20, 30 and 60 minutes

Data Logger Analog Channel X (Data Logger Chnl X): Analog Channels programmable in the data logger. The X value has 
a range from 0 to 16. 

Any setting change in the Data Logger erases all stored information.

5.2.4.2  Data logger associated states

States associated with the data logger module (“Actual > Status > Records Status > Data Logger) are shown on the table 
below:

OLDEST SAMPLE TIME: The Date/time of the oldest state with 6 characters. This is the time that corresponds 
to the oldest sample. This value remains constant until the available memory capacity 
is exceeded. Afterwards, this value changes according to the sampling rate (Data 
Logger Rate).

NEWEST SAMPLE TIME: The Date/time of the newest state with 6 characters. This is the time when the most 
recent sample was taken. This value is updated according to the sample rate selected.

If no channel has been selected, these settings do not change.

DATA LOGGER CHANNELS: This state shows the number of channels selected.

DATA LOGGER DAYS: This state shows the number of days that can be stored. It depends on the Data 
Logger Rate setting, and on the number of channels selected.

5.2.4.3  Data logger file format and retrieval 

File Retrieval

Data logger files can be retrieved using the EnerVista 650 Setup software, or the web server at “http:\\relay IP address”.

For obtaining the data logger files using the EnerVista 650 Setup software, the user must access “Actual > Records > Data 
Logger”. The top of the window shows the date when the oldest sample was taken, and then the date when the newest 
sample was taken. 

This screen shows the measurements stored for the different channels through the time.

Clicking on the “Download” button, all the information contained in the file can be read.

Setpoint > Product Setup > Data Logger

Setting Description Name Default Value Step Range

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Data logger Rate Data Logger Rate 1 s N/A [1 s, 5 min., 10 min., 15 min., 20 min., 30 min., 60 min.]

Data Logger analog channels X Data Logger Chnl X None N/A [1 to 16]

DATA LOGGER STATES

OLDEST SAMPLE TIME

NEWEST SAMPLE TIME

DATA LOGGER CHANNELS

DATA LOGGER DAYS
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Clicking on the “Save” button, the data logger files (*.DAT, *.CFG) are retrieved in COMTRADE format, and saved by default in 
the folder “...\EnerVista 650 Setup\files\osc”, using “DLGxxx.DAT”, “DLGxxx.CFG” names, where xxx is the corresponding 
record number. 

For firmware versions below 7.70, datalogger record retrieval uses Ethernet communications ports (ftp, tftp). For firmware 
versions 7.70 or above, datalogger record retrieval uses serial (ModBus RTU) or Ethernet (ftp, tftp) communication ports

File Format

Data logger information is made of two text files: configuration file (datalogger.cfg), and data file (datalogger.dat).

5.2.5  Demand settings

5.2.5.1  Metering values and settings

The demand calculation is made according to the following primary parameters:

Table 5-6: Primary demand values

*Note: The step depends on the selected “Primary Meter Units” in System Setup > General Settings (A_V; KA_KV)

Different integration methods can be selected to calculate current and power values.

Calculated demand values are as follows:

Table 5-7: Demand calculated values

The relay measures current demanded on each phase, ground and sensitive ground, negative sequence and three-phase 
demand for real, reactive and apparent power. Current and Power methods can be chosen separately. Settings are 
provided to disable certain measuring techniques. These techniques are used by many utilities for statistical or control 
purposes.

PRIMARY DEMAND VALUES STEP

IA (RMS) KA

IB (RMS) KA

IC (RMS) KA

IG (RMS) KA

ISG (RMS) KA

I2 KA

Three phase active power (W) MW

Three phase reactive power (VAR) MVAr

Apparent power (VA) MVA

DEMAND CALCULATED VALUES

DEMAND IA DEMAND IG DEMAND W

DEMAND IA MAX DEMAND IG MAX DEMAND W MAX

DEMAND IA DATE DEMAND IG DATE DEMAND W DATE

DEMAND IB DEMAND ISG DEMAND VAR PWR

DEMAND IB MAX DEMAND ISG MAX DEMAND VAR MAX

DEMAND IB DATE DEMAND ISG DATE DEMAND VAR DATE

DEMAND IC DEMAND I2 DEMAND VA PWR

DEMAND IC MAX DEMAND I2 MAX DEMAND VA MAX

DEMAND IC DATE DEMAND I2 DATE DEMAND VA DATE

DEMAND W MIN DEMAND VAR MIN DEMAND VA MIN
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Demand module settings are as follows:

Table 5-8: Demand settings

Function permission (Function): This setting enables the demand function.

Demand Method for Current values (CRNT Demand Method): Selection of the demand calculation method for current 
values. Available methods are Thermal Exponential, Block interval, and Rolling 
Demand. 

Demand Method for Power values (POWER Demand Method): Selection of the demand calculation method for power 
values. Available methods are Thermal Exponential, Block interval, and Rolling 
Demand.

Demand Interval: Integration interval. Available intervals are 5, 10, 15, 20, 30, 60 minutes. 
Measurement integration is performed in the period adjusted in the Demand Interval 
setting.

Demand Trigger: Operation mode selection for the Block Interval calculation method. This operation 
mode depends on the “Trigger Enabled” setting. If trigger enabled is set as disabled, 
measurement integration is made in the Demand Interval period. If trigger enabled is 
enabled, measurement integration is made during the time interval between two 
consecutive pulses of the input assigned as DEMAND TRIGGER INP,. This input is set 
at Setpoint > Relay configuration > Protection Elements

Snapshot Events: This setting enables or disables the snapshot event generation for the demand 
element.

5.2.5.2  Demand calculation methods

Calculation Method 1: Thermal Exponential

This method simulates the action of an analog peak recording thermal demand meter. The relay measures the magnitude 
for each phase (or three-phase, depending on the case) every second, and it assumes that the magnitude remains the 
same until the next update. It calculates the equivalent thermal demand using the following equation:

Where:

D Input signal (constant).

d(t) Demand value after applying the input value during time t (in minutes)

K 2.3 / thermal 90% response time

Setpoint > Product Setup > Demand

Setting Description Name Default Value Step Range

Function permission Demand Function DISABLED N/A [DISABLED – ENABLED]

Demand method for current 
values

CRNT Demand Method THERMAL EXPONENTIAL N/A [BLOCK INTERVAL -
ROLLING DEMAND -
THERMAL EXPONENTIAL]

Demand method for Power values POWER Demand Method THERMAL EXPONENTIAL N/A [BLOCK INTERVAL -
ROLLING DEMAND -
THERMAL EXPONENTIAL]

Demand interval Demand Interval 5 Minutes N/A [5 – 10 – 15 – 20– 30–60]

Trigger Enabled Trigger Enabled DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

)1()( KteDtd −−=
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Illustrated bellow is the curve with a 90% characteristic time of 15 minutes. A setting establishes the time to reach 90% of 
a steady-state value, just as the response time of an analog instrument. A steady-state valve applied for twice the 
response time indicates 99% of the value.

Calculation Method 2: Rolling Demand.

This method calculates the linear average of the quantity over the set demand time interval. The calculation is made every 
second. The value is updated every minute and indicates the demand over the time interval just preceding the time of 
update. 

Calculation Method 3: Block Interval

The Block Interval operation mode depends on the “Trigger Enabled” setting.

Calculation Method 3a: Block Interval – With trigger setting DISABLED.

This method consists on integrating the measurements during the time period specified in the DEMAND INTERVAL
setting. The calculation is made every second and the demand value is the average of all values produced during the
time interval. The time interval is chosen in the DEMAND INTERVAL setting. The interval demand value is shown once
this time has expired.

If, for example, the setting indicates 15 minutes for integration, the demand value update is made every 15 minutes
(although the calculation is made every second). This method calculates a linear average of the magnitude.

Calculation Method 3b: Block Interval – With trigger setting ENABLED.

The demand value is given by integration of the measurement during the time between two consecutive pulses in the
input assigned. The input is assigned to DEMAND TRIGGER in Relay Configuration. The integration is made every
second with each new measure. 

In case the interval between two consecutive pulses exceeds 60 minutes, the relay calculates the demand after 60
minutes from the last pulse, this measure is updated in the status and a new demand count starts. This method
calculates a linear average of the magnitude.
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Figure 5-1: Response to different demand methods shows the behavior of the demand, depending on the Selected setting 
for demand calculation.

Figure 5-1: Response to different demand methods
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5.2.5.3  Demand function measurements and states

Demand values are available at Actual > Metering > Primary Values > Demand.

Table 5-9: Demand measurements

*Note: The step depends on the selected “Primary Meter Units” in System Setup > General Settings (A_V; KA_KV)

Demand measurements for current values are as follows:

DEMAND IX This is the demanded value every minute or every integration period, depending on the
selected settings.

DEMAND IX MAX Demanded maximeter; it stores the Maximum demand value until a demand reset is
issued.

DEMAND IX DATE Date of the Maximum demand value 

Being X the phase considered in each case.

Demand measurements for power values are as follows:

DEMAND Y This is the demanded value every minute or every integration period, depending on the
selected settings 

Name Default Value Step

DEMAND IA 0.000  KA

DEMAND IA MAX 0.000  KA

DEMAND IA DATE 01-Jan-2000 00:00:00.000

DEMAND IB 0.000  KA

DEMAND IB MAX 0.000  KA

DEMAND IB DATE 01-Jan-2000 00:00:00.000

DEMAND IC 0.000  KA

DEMAND IC MAX 0.000  KA

DEMAND IC DATE 01-Jan-2000 00:00:00.000

DEMAND IG 0.000  KA

DEMAND IG MAX 0.000  KA

DEMAND IG DATE 01-Jan-2000 00:00:00.000

DEMAND ISG 0.000  KA

DEMAND ISG MAX 0.000  KA

DEMAND ISG DATE 01-Jan-2000 00:00:00.000

DEMAND I2 0.000  KA

DEMAND I2 MAX 0.000  KA

DEMAND I2 DATE 01-Jan-2000 00:00:00.000

DEMAND W 0.000  MW

DEMAND W MAX 0.000  MW

DEMAND W MIN 0.000  MW

DEMAND W DATE 01-Jan-2000 00:00:00.000

DEMAND VAR PWR 0.000  MVAr

DEMAND VAR MAX 0.000  MVAr

DEMAND VAR MIN 0.000  MVAr

DEMAND VAR DATE 01-Jan-2000 00:00:00.000

DEMAND VA PWR 0.000  MVA

DEMAND VA MAX 0.000  MVA

DEMAND VA MIN 0.000  MVA

DEMAND VA DATE 01-Jan-2000 00:00:00.000
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DEMAND Y MAX Demanded maximeter; it stores the Maximum demand value until a demand reset is
issued.

DEMAND Y MIN Demanded minimeter; it stores the Minimum demand value until a demand reset is issued.

DEMAND Y DATE Date of the Maximum demand value.

Being Y the power considered in each case.

W Three-phase active power

VAR Three-phase reactive power

VA Three-phase apparent power

The maximum or minimum demanded values are stored in non-volatile memory. They are not cleared when the relay is 
turned off. When the relay is turned on again, the values are updated.

States associated with the demand (“Actual > Status > Records Status > Demand”) are the following:

Table 5-10: Demand associated values

Besides the previously considered demand measures, two states are used for demand control:

DEMAND TRIGGER INP Bit type state, Programmable at “Setpoint > Relay Configuration > Protection Elements” in the 
EnerVista 650 Setup software. This signal is used by the Block Interval demand method.

DEMAND RESET INP Bit type state, programmable at “Setpoint > Relay Configuration > Protection Elements” in the 
EnerVista 650 Setup software. When this bit is activated, the demand measures are reset. All 
stored values are reset to zero (for demand dates, this value represents January 1st, 2000).

5.2.6  Time Settings
The date and time can be synchronized to a known time using the SNTP protocol, IRIG-B protocol (when it provides UTC 
Time) or IEEE1588 (Available starting from version V7.00) and the TIME SETTINGS allow setting the date and time provided 
by these protocols to the proper local time on the Real Time Clock.

When there is no SNTP protocol enabled, IRIG-B protocol is not set to UTC Time or IEEE1588 synchronization, the TIME 
SETTINGS are not used in the Real Time Clock but are still used to calculate the UTC Time (i.e., for the IEC61850 protocol), 
but its behavior is not assumed correct in several critical hour changes because of Daylight Savings Time getting effective. 
In these configuration cases, it is recommended to disable Daylight Savings Time.

DEMAND ASOCIATED STATES

DEMAND TRIGGER INP

DEMAND RESET INP
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Table 5-11: Time Settings

The TIME SETTINGS settings are as follows:

LOC. TIME OFFS. UTC:    

Is used to specify the local time zone offset from Universal Coordinated Time (Greenwich Mean Time) in hours.

DAYLIG. SAVINGS TIME:

Allow the unit clock to follow DST rules of the local time zone.

DST START MONTH:

Allow to set the start month of the DST from January to December

DST START WEEKDAY       

Allow to set the start weekday of the DST from Monday to Sunday

DST START DAY INST:        

Allow to set the start day instance from First, Second, Third, Fourth or Last

DST START HOUR              

Allow to set the starting hour of the DST (in local time)

DST STOP MONTH             

Allow to set the stop month of the DST from January to December

DST STOP WEEKDAY       

Allow to set the stop weekday of the DST from Monday to Sunday

DST STOP DAY INST

Allow to set the stop day instance from First, Second, Third, Fourth or Last

DST STOP HOUR

Allow to set the stop hour of the DST (in local time)

IRIG-B LOCAL TIME: 

Determines, in case of being enabled, if the IRIG-B protocol would carry the date in local time or else in UTC Time.

IRIG-B FUNCTION: 

Setting for enable or disable the IRIG-B protocol



5-26 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

5.2 PRODUCT SETUP CHAPTER 5:  SETPOINTS

PTP IRIG-B PRIORITY: 

If two or more time sources are setup the time source with the higher priority shown in the table below is used where 1 is 
considered to be the highest priority. Note that the time source priority of PTP and IRIG-B can be swapped. Setting changes 
become active after reboot.

The C650 is capable of receiving a time reference from several time sources in addition to its own internal clock for the 
purpose of time stamping events, transient recorders and other occurrences within the relay. The accuracy of the time 
stamp is based on the time reference that is used. The C650 supports an internal clock, SNTP, IRIG-B and 1588 as potential 
time references.

Regarding the PTP, C650 acts as an ordinary clock, with only Sync and Pdelay_Req messages.
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Table 5-12: Synchronization priority table

The priority of IRIG B and PTP can be swapped

Note:

Synchronization by IEC103, DNP, Modbus and IEC104 is not going to be issued if there is a sync source from IRIG-B, SNTP or 
PTP. 

Time source Accuracy Priority 

PTP 1*

IRIG-B 2*

SNTP 3

Internal Clock 4
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5.3  System setup

This section shows the settings related to the system setup definition.

5.3.1  General settings
This section determines the settings of the element configuration regarding its connection to the power system.

The system rated voltage is used as reference by the voltage restraint in the phase timed overcurrent element.

The Frequency reference marks the voltage channel to which the system Frequency is measured.

The auxiliary voltage setting can be selected between VN and VX. 

VN means that all elements using neutral voltage take the value directly from the fourth voltage input.

VX means that all elements using neutral voltage take the value calculated from phase voltages.

5.3.2  Miscellaneous settings
This section determines the relays status configuration regarding the service and local or remote modes.

5.3.2.1   Out of service setting

The unit Relay Out of Service setting is configured in Setpoint > System Setup > Miscellaneous. The unit also has an Out 
of Service status that is configured in Relay configuration > Protection elements. When active, these states stop all 
changes to PLC equations and functions, including changes in the input/output boards, so if there is a change in any input 

Setpoint > System Setup > General settings

Setting Description Name Default Value Step Range

Phase CT ratio Phase CT Ratio 1.0 0.1 [1.0 : 6000.0]

Ground CT ratio Ground CT Ratio 1.0 0.1 [1.0 : 6000.0]

Sensitive ground CT ratio Stv Ground CT Ratio 1.0 0.1 [1.0 : 6000.0]

Phase VT ratio Phase VT Ratio 1.0 0.1 [1.0 : 6000.0]

Phase VT connection Phase VT Connection WYE N/A [WYE – DELTA]

Rated voltage Nominal Voltage 100.0 0.1 [1.0 : 250.0]

Rated Frequency Nominal Frequency 50 Hz N/A [50-60]

Phase rotation Phase Rotation ABC N/A [ABC – ACB]

Frequency reference Frequency Reference VI N/A [VI-VII-VIII]

Auxiliary Voltage Auxiliary Voltage VX N/A [VX – VN]

Snapshot Event generation Snapshot Events DISABLED N/A [DISABLED – ENABLED]

Primary Meter Units Primary Meter Units KA_KV N/A [KA_KV; A_V]

Device Name Device Name N/A

Setpoint > System Setup > Miscellaneous Settings

Setting Description Name Default Value Step Range

Relay Out of Service Relay Out of Service ENABLED N/A [DISABLED – ENABLED]

Local/Remote Blocked Local/Remote Blocked OFF N/A [ON -OFF]

Active Language Active Language 0 N/A [0;1]



CHAPTER 5:  SETPOINTS 5.3 SYSTEM SETUP

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 5-29

or output the unit will not show this change until has returned to ready mode. For example, if an output is closed and the 
unit goes to the Out of Service state, the output is kept closed even if the state that closed it changes and would otherwise 
open the output. When the unit goes out of the Out of Service state, the output is then opened.

Functions affected by Out of service State

- IO Boards.

- Protection functions

• Setting Groups

• Recloser (79)

• Oscillography

• Synchrocheck (25)

• Fuse Failure (VTFF)

• Data Logger

• Comparator

• Switchgear

• Breaker

When the Out of Service status goes to ON, or the setting has been changed to Enabled, the ready LED changes to red. Be 
careful if the ready LED is linked to an output, because the output will not change its state. To set an output to the ready 
state, see the factory default Logic & Configuration. Take notice that VO_000 is set to the output instead of VO_099

The following figure shows the flow chart of these states

                                 Only if there is a change

from Disabled to Enabled

Only if there is any change from Enabled to 

Disabled
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5.3.2.2  Local - remote block setting

In the enhanced HMI with USB port new setting has been released in order to be able to lock the Local/Remote front key. 
This setting is available via COMS or frontal HMI menu. The settings can be locked by password, so the operator wouldn't 
be able to change the local-remote without inserting the password.

Definitions

The value is defined as:

• OFF: The operator is able to change the operations from local to remote or OFF.

• ON: The operator is not able to change the operations from local to remote or OFF.

Settings

The unit is set by the HMI and by 650PC software as it is shown in the following figure.
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5.3.3  Breaker settings
There are two types of breaker settings:

Breaker settings: These settings correspond to the switchgear configured as a breaker in the C650; this switchgear is used 
in the recloser functions, breaker failure and synchronism.

Breaker Maintenance: These settings correspond to the initialization of the (KI)2t counters, and the counting of the number 
of openings and closings of the switchgear configured as a breaker.

Breaker settings are as follows: 

Number of switchgear: This is the Number of the Switchgear that is configured as a breaker. It is the reference for 
breaker failure (50BF), recloser (79) and synchronism (25) elements. The selected 
switchgear in the breaker settings must be previously configured at Setpoint > Relay 
Configuration > Switchgear. The relay allows to configure up to 16 switchgear elements, 
but the one configured as a breaker is the reference for (KI)2t, openings and closings 
counters.

Maximum (KI)2t: This is the maximum set value for the square of the current multiplied by the breaker 
opening time. There is a separate counter for each phase, but the value stored as the 
maximum is a single value for the three phases.

(KI)2t Integration Time: This is the integration time taken as the base (fixed opening time) for the calculation of 
(KI)2t.

Maximum Openings: This is the maximum number of openings allowed in the relay, with a limit of 9999; once 
this value is exceeded, the relay produces an alarm. When the limit 9999 is reached the 
maximum openings counter starts from zero.

Maximum Openings in 1 hour: This is the maximum number of openings allowed in the relay during one hour; once this 
value is reached, the corresponding alarm signal is activated; this value is updated and 
reset after one hour.

Snapshot Events: This setting enables or disables the snapshot event generation for the breaker signals.

The interrupted current limit setting, fixes the Maximum breaker capacity (this value is set depending on the information 
provided by the breaker manufacturer); the relay incorporates a (KI)2t counter for each phase, when a breaker opening 
occurs, the counter increases its value (in primary values). If the flowing current is lower than the rated current, the relay 
takes the rated current value for its calculations. When the accumulated counter for each phase reaches or exceeds the 
set value, the corresponding alarm signal is activated. 

The purpose of this function is to provide closer information of the current status of the breaker’s internal contacts. This is, 
in order to ensure appropriate breaker maintenance, and to decrease the risk of damage when the breaker has suffered 
severe operations during a long time. Once the breaker has been operated, and the preventive maintenance is in place, 
the accumulated I2t values and the number of operations are reset to zero.

Setpoint > System Setup > Breaker > Breaker Settings

Setting Description Name Default 
Value

Step Range

Number of Switchgear selected as breaker Number of Switchgear 1 1 [1 : 16]

Maximum value of (KI)2t Maximum (KI)2t 9999.99 0.01(KA)2 s [0.00 : 9999.99]

(KI)2t integration time (KI)2t Integ. Time 0.03 0.01s [0.03 : 0.25]

Maximum number of openings Maximum Openings 9999 1 [0 : 9999]

Maximum Openings in one hour Max.Openings 1 hour 40 1 [1 : 60]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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5.3.3.1  Breaker maintenance

To consider used breakers, the relay allows to set initial I2t values as well as an initial number of operations, in order to take 
into account previous breaker operations, as well as operations produced during testing. Breaker maintenance 
parameters can be set in the breaker maintenance menu.

In this group of settings, the start values of the breaker Counters can be set.

These Counters allow the breaker Maintenance. They are used to accumulate the breaker aging produced by a trip or a 
breaker opening. In order to incorporate the breaker’s history, in case of used breakers, the system allows assigning an 
initial value to accumulated amperes, and to the number of opening and closing operations.

To supervise breaker aging, S(KI)2t accumulated values are calculated and stored for each phase in each opening. If the 
rated current is not exceeded, as in the case of a manual opening command, without fault current, the relay uses the rated 
current instead of the measured value.

(KI)2t value is accumulated and maintained in independent Counters for each phase. Counters can be accessed through 
the local HMI as well as through the EnerVista 650 Setup software. The element incorporates a setting to select the 
integration time ((KI)2t Integ. Time).

The signals associated with the opened or closed status of the breaker can be monitored at Actual > Status > Breaker

Table 5-13:  Breaker status

The signals associated with breaker maintenance can be monitored at Actual > Status > Records Status > Breaker 
Maintenance, and they are as follows:

Table 5-14:  Breaker maintenance status

Setpoint > System Setup > Breaker > Breaker Maintenance

Setting Description Name Default Value Step Range

(KI)2t Counter Phase A (KI)2t BKR Ph A Cnt 0.00 0.01 (KA)2 s [0.00 : 9999.99]

(KI)2t Counter Phase B (KI)2t BKR Ph B Cnt 0.00 0.01 (KA)2 s [0.00 : 9999.99]

(KI)2t Counter Phase C (KI)2t BKR Ph C Cnt 0.00 0.01 (KA)2 s [0.00 : 9999.99]

Openings counter BKR Openings Cnt 0 1 [0 : 9999]

Closings counter BKR Closings Cnt 0 1 [0 : 9999]

BREAKER STATUS DESCRIPTION

BREAKER OPEN Breaker in open position.

BREAKER CLOSED Breaker in close position

BREAKER UNDEFINED Breaker undefined

BREAKER MAINTENANCE DESCRIPTION

(KI)2t PHASE A ALARM This signal activates when the set value for phase A is exceeded.

(KI)2t PHASE B ALARM This signal activates when the set value for phase B is exceeded.

(KI)2t PHASE C ALARM This signal activates when the set value for phase C is exceeded.

BKR OPENINGS ALARM Relay total Number of Openings alarm 

BKR OPEN 1 HOUR ALRM Relay total Number of Openings in one hour alarm

RESET (KI)2t COUNTERS (KI)2t Counters reset signal. This signal is configured at Setpoint > Relay Configuration > Protection
Elements, and it is used for resetting the (KI)2t counter through the corresponding signal, command,
digital input, etc.

RESET BKR COUNTERS Reset signal for the Opening and Closing Counters. This signal is configured at Setpoint > Relay
Configuration > Protection Elements, and it is used for resetting the breaker Opening and closing
counters.

BREAKER OPENINGS Number of Breaker openings

BREAKER CLOSINGS Number of Breaker closings

(KI)2t PHASE A Accumulated (KI)2t value for phase A ((KI)2t Counter for Phase A)
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5.3.4  Switchgear settings
There is the possibility to enable or disable the generation of internal signals for the different elements (protection, control, 
inputs and outputs, switchgear) available in the device.

(KI)2t PHASE B Accumulated (KI)2t value for phase B ((KI)2t Counter for Phase B)

(KI)2t PHASE C Accumulated (KI)2t value for phase C ((KI)2t Counter for Phase C)

BKR OPENING TIME Maximum breaker Opening time. This signal is configured at Setpoint > Relay Configuration >
Switchgear in the number of switchgear corresponding to the breaker selection 

BKR CLOSING TIME Maximum breaker Closing time. This signal is configured at Setpoint > Relay Configuration >
Switchgear in the number of switchgear corresponding to the breaker selection

BKR OPEN TIMING Exact time in opening the breaker

BKR CLOSE TIMING Exact time in closing the breaker

Setpoint > System Setup > Switchgear

Setting Description Name Default 
Value

Step Range

Snapshot Event generation for switchgear #1 Snapshot Events SWGR 1 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #2 Snapshot Events SWGR 2 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #3 Snapshot Events SWGR 3 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #4 Snapshot Events SWGR 4 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #5 Snapshot Events SWGR 5 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #6 Snapshot Events SWGR 6 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #7 Snapshot Events SWGR 7 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #8 Snapshot Events SWGR 8 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #9 Snapshot Events SWGR 9 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #10 Snapshot Events SWGR 10 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #11 Snapshot Events SWGR 11 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #12 Snapshot Events SWGR 12 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #13 Snapshot Events SWGR 13 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #14 Snapshot Events SWGR 14 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #15 Snapshot Events SWGR 15 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for switchgear #16 Snapshot Events SWGR 16 DISABLED N/A [DISABLED – ENABLED]
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5.4  Control elements
The C650 incorporates the following control elements:

Synchrocheck (25)

Autoreclose (79)

Pulse Counters

Digital Counters

Analog Comparators

PLC Timer mask

Note: for all control elements related to the breaker, it must be considered that all operations are performed considering 
the status of the switchgear configured as breaker. In Setpoint > Relay Configuration > Switchgear up to 16 switchgear 
elements can be configured to operate and be monitored, but only one of them can be configured as a breaker, for 
monitoring, number of openings and closings counters, (KI)2t.

5.4.1  Synchronism check element - synchrocheck (25)
Note: The Switchgear element used in the C650 synchronism element is the one configured in the Number of Switchgear 
setting inside Breaker settings, at “Setpoint > System Setup > Breaker > Breaker Settings”.

The synchronism element is used for monitoring the connection of two parts of the circuit by the close of a breaker. This 
element verifies that voltages (V1 and V2) at both sides of the breaker are within the magnitude, angle and frequency limits 
set by the user. V1 and V2 are the line and busbar voltage values measured by the relay.

Synchronism check (25) is defined as the comparison of the voltage difference of two circuits with different sources to be 
either linked through an impedance element (transmission line, feeder, etc.), or connected through parallel circuits of 
defined impedance (Figure 5-2: Synchronism check element) The voltage comparison between both sides of a breaker is 
performed before closing the breaker, in order to minimize internal damage that can occur due to the voltage difference, 
both in magnitude and angle. This is extremely important in steam generating plants, where reclosing output lines with 
angle differences can lead to severe damage to the turbine axis.

Figure 5-2: Synchronism check element

The difference in voltage level and phase angle in a given moment is the result of the existing load between remote 
sources connected through parallel circuits (load flux), as well as a consequence of the impedance of those elements 
connecting them (even if there is no load flux in parallel circuits, or because sources to be connected are completely 
independent and isolated from one another). 

WARNING

When testing this function do not forget that the relay must detect an open breaker to operate.
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In interconnected systems, the angle difference between both ends of an open breaker is usually negligible, as its sources 
are remotely connected through other elements (equivalent or parallel circuits). However, in isolated circuits as in the case 
of an independent generator, the difference in angle, voltage levels and relative slip of voltage phasors can be very 
important. It may happen that the relative slip of voltage values is very low or null so that they are rarely in phase. Luckily, 
due to the changing conditions of a power system (connection-disconnection of loads, sources, and new inductive-
capacitive elements) the relative slip between phasors is not null and they can be synchronized.

In the first case, even if we must take into consideration the length of the line whose ends (sources) are connected for 
determining the angle difference between them, this is not enough to fix the synchronism conditions before closing the 
breaker. Experience tells us that the window of angle difference between voltage phasors must be fixed to a value of 15º-
20º.

5.4.1.1  Voltage inputs

In order to perform the synchronism check function, the C650 uses only one voltage from each end of the breaker. Voltage 
values to be compared must be on the same basis, either phase-to-phase or phase-to-ground voltage; they must be the 
same at both ends of the breaker; it is not possible to compare a phase-to-ground voltage at one end with a phase-to-
phase voltage at the other end.

Additionally, if on one end, three voltages have been connected, the necessary voltage on the other end for Function 25 is 
only single-phase voltage. If there is only one voltage (either phase-to-phase or phase-to-ground) at both ends of the 
breaker, this must be from the same phase in both cases. 

The selection of voltage values to be used by the synchronism element is made in the relay General settings:

V1 is the line voltage, selectable from the relay voltage channels, using the “Frequency Reference” setting at Setpoint
> System Setup > General settings > Frequency Reference. (refer to the voltage correspondence Table 5-15: Voltage
correspondence element 25)

V2 is the busbar voltage measured at the auxiliary voltage input (terminals A11-A12). To enable the busbar voltage
metering in the relay, it is required to select VX in the Auxiliary Voltage setting at Setpoint > System Setup > General
settings > Auxiliary Voltage. 

The voltage correspondence is detailed in the following table:

Table 5-15: Voltage correspondence element 25

Setpoint > System Setup > General settings > Auxiliary Voltage setting must be set to Vx, in order to monitor auxiliary 
voltage instead of Vn (neutral voltage, coming from an open delta connection).

5.4.1.2  Application

Even if the application range of the C650 is quite wide and the element can be used in distribution lines at any voltage 
level, it must be taken into account that it is a three-pole tripping relay, designed for managing a single breaker. This is 
why C650 is not suitable for one and a half breaker configurations, or ring configurations where a transmission line or 
feeder has two breakers.

Voltage Correspondence

Setpoint > System Setup > General Settings > Frequency Reference
Voltage selection for element 25 of C650

VI VII VIII

Setpoint > System Setup > General Settings > Phase VT Connection=WYE
Phase-to-ground voltage connection.(Wye connection)

Va-g Vb-g Vc-g

Setpoint > System Setup > General Settings > Phase VT Connection=DELTA 
Phase-to-phase voltage connection.(Delta connection).

Va-b Vb-c Vc-a

Setpoint > System Setup > General settings  
Auxiliary Voltage=Vx

Vx
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5.4.1.3  Settings

There is only one synchrocheck element in the C650.

Settings description for element 25:

Function permission (Function): This setting allows enabling and disabling the synchrocheck element.

Voltage Level determination settings for busbar and line: 

This setting group allows determining the voltage levels considered as dead and live for line and busbar voltage.

Dead Bus voltage level (Dead Bus Level):  Voltage level considered as dead bus 

Live Bus voltage level (Live Bus Level):  Voltage level considered as live bus

Dead Line voltage level (Dead Line Level):  Voltage level considered as dead line

Live Line voltage level (Live Line Level):  Voltage level considered as live line

Synchrocheck settings (live bus, live line):
C650 relays verify synchronism by establishing and comparing three basic parameters: the difference in module and angle of
voltage phasors, and the frequency slip of a phasor related to the other one. synchrocheck settings include a fourth time setting,
that allows using an anticipative algorithm to issue a closing signal.

Voltage Difference (Max Volt Difference): Maximum Difference in module between the line and busbar 
voltage to allow a closing in the synchrocheck element.

Angle Difference (Max Angle Difference): Maximum Difference in angle between the line and busbar 
voltage to allow a closing in the synchrocheck element.

Frequency Slip (Max Freq Difference): Maximum difference in frequency (slip) between both voltage 
values to be compared in the synchrocheck element.

Breaker Closing time (Time): Estimated breaker Closing time, used for establishing the Closing 
order in a moment that allows the busbar and line voltages to be 
in phase.

This time is considered if the relative slip is higher than 20 mHz; in this case, an anticipative algorithm is 
executed to calculate the closing signal with the necessary advance for the breaker effective Closing to be 
produced when voltages are in phase. The limit for the anticipative algorithm is two times the maximum 

Setpoint > Control Elements > Synchrocheck

Setting Description Name Default Value Step Range

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Dead bus voltage level Dead Bus Level 10.00 0.01 V [0.00 : 300.00]

Live bus voltage level Live Bus Level 50.00 0.01 V [0.00 : 300.00]

Dead line voltage level Dead Line Level 10.00 0.01 V [0.00 : 300.00]

Live line voltage level Live Line Level 50.00 0.01 V [0.00 : 300.00]

Voltage Difference Max Volt Difference 10.00 0.01 V [2.00 : 300.00]

Angle Difference Max Angle Difference 10.0 0.1 Deg [2.0 : 80.0]

Frequency Slip Max Freq Difference 20 10 mHz [10 : 5000]

Breaker Closing time Time 0.50 0.01 s [0.01 : 1.00]

Dead Line – Dead Bus Function permission DL-DB Function DISABLED N/A [DISABLED – ENABLED]

Live Line – Dead Bus Function permission LL-DB Function DISABLED N/A [DISABLED – ENABLED]

Dead Line – Live Bus Function permission DL-LB Function DISABLED N/A [DISABLED – ENABLED]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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angle difference. This means that if the product of the frequency slip multiplied by the breaker closing time 
covers an angle greater than two times the maximum angle, closing is not allowed. For further information 
see 5.5.4.5.

Closing permission logic settings:

In case that the voltage at one or both ends of the breaker is null, the synchronism element cannot establish the necessary 
parameters to give closing conditions, and therefore it does not issue synchronism permission. For those situations where 
the user wants to enable the closing permission in a condition of loss of one or both voltages at both ends of the breaker, 
C650 elements incorporate closing permission logics for the cases of: dead line-dead bus, live line-dead bus and dead line-
live bus.

Dead line- Dead Bus Function permission (DL-DB Function): Enabling this Function allows issuing a 
Closing permission signal in dead line and dead bus Condition (without voltage at both sides of the breaker).

Live line- Dead Bus Function permission (LL-DB Function): Enabling this Function allows to issue a Closing 
permission signal in live line and dead bus Condition (without voltage at the sides of the breaker that 
corresponds to the busbar voltage)

Dead line- Live Bus Function permission (DL-LB Function): Enabling this Function allows issuing a Closing 
permission signal in live line and dead bus Condition (without voltage at the sides of the breaker that 
corresponds to the line voltage).

Snapshot event: The snapshot event setting enables or disables the snapshot event generation for this element.

5.4.1.4  Synchrocheck states

Internal signals provided by the C650 (Actual > Status > Control Elements > Synchrocheck) for the synchronism element 
are as follows:

Table 5-16: Synchrocheck internal states

SYNCROCHECK BLK INP: Block signal for the synchrocheck element, configurable at Setpoint > Relay 
Configuration > Control Elements

SYNCROCHECK OP: Closing permission signal in live line-live bus conditions with open breaker.

SYNCHK CLOSE PERM: General Closing permission of the Synchronism element. It contemplates all possible 
situations, live line-live bus conditions, and the closing permission logics (dead line-
dead bus, live line- dead bus, dead line-live bus). Note: in case the Function is 
disabled, the Closing permission signal is activated in order not to interfere with 
possible logics where it is included. If the synchronism element is enabled, this signal 
is only activated in the closing conditions established by setting.

SYNCROCHECK COND OP: Closing permission according to permission logics (DL-DB, LL-DB, DL-LB).

DL-DB OPERATION: Closing permission in dead line – dead bus condition.

DL-LB OPERATION: Closing permission in dead line – live bus condition.

SYNCHROCHECK ACTUAL VALUES

SYNCROCHECK BLK INP

SYNCROCHECK OP

SYNCHK CLOSE PERM

SYNCROCHECK COND OP

DL-DB OPERATION

DL-LB OPERATION

LL-DB OPERATION

SLIP CONDITION

BUS FREQ > LINE FREQ

BUS FREQ < LINE FREQ

VOLTAGE DIFFERENCE

FREQUENCY DIFFERENCE
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LL-DB OPERATION: Closing permission in live line – dead bus condition.

SLIP CONDITION: Internal signal indicating frequency slip between the line voltage and bus voltage 
phasors.

BUS FREQ > LINE FREQ: Busbar Frequency higher than line frequency 

BUS FREQ < LINE FREQ: Busbar Frequency lower than line frequency

VOLTAGE DIFFERENCE: Voltage difference in Volts between line and busbar

FREQ. DIFFERENCE: Frequency difference in Hz between line and busbar

Voltage and frequency values for the line and busbar can be obtained, both in primary and secondary values at:

Actual > Metering > Primary Values > Voltage

VBB Primary (KV) Busbar voltage in primary values

VL Primary (KV) Line voltage in primary values

Actual > Metering > Secondary Values > Voltage

Line Voltage (V) Line voltage in secondary values 

Bus Voltage (V) Busbar voltage in secondary values

Actual > Metering > Frequency

Line Frequency (Hz) Line frequency in Hz

Bus Frequency (Hz) Bus frequency in Hz

The voltage angles can be obtained in primary metering values (Actual > Metering > Primary Values > Voltage), being the 
line voltage angle, the one that corresponds to the voltage set in the frequency reference in General settings (refer to the 
voltage correspondence table (Table 5-15: Voltage correspondence element 25), and the angle of the busbar voltage the 
one that corresponds to Vx Angle, when the Auxiliary Voltage setting as been selected as VX.

5.4.1.5  Algorithm

C650 elements perform the synchronism check by basically establishing and comparing three parameters:

Module difference of voltage phasors DV (V)

Phase angle of voltage phasors Dj (º)

Frequency slip between two phasors S (Hz)

These parameters are continuously determined and managed once that element 25 has been enabled by setting, and 
in open breaker conditions. It is necessary to consider that all calculations are made once the open breaker condition is 
detected; if the breaker is closed or undefined, the synchronism element does not issue a closing permission signal, even 
when closing conditions are met.

If voltage on one side of the breaker to be closed is null, the synchronism element cannot establish the synchronism check, 
and therefore it does not issue synchronism permission. For these cases, usual in breaker maintenance situations, or in 
new installations where voltage might not be present, but the breaker operation needs to be verified, C650 elements 
incorporate closing permission logics for situations of:

Dead Line – Dead Bus (DL-DB)

Live Line – Dead Bus (LL-DB)

Dead Line – Live Bus (DL-LB)

In order to establish the closing permission signal, the first parameter used by the algorithm is the difference in magnitude 
between line and bus voltages, and afterwards, the angle difference and frequency slip are verified.

Voltage Difference DV
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Comparing the voltage values for line voltage (V1) and busbar voltage (V2) at both sides of the breaker, the relay can 
determine the synchronism situation of the element (see Table 5-17: Synchronism conditions).

Being:

V1 line voltage

V2 bus voltage

VL Minimum acceptable voltage by setting to establish synchronism conditions (dead line and bus levels).

VH Appropriate voltage to establish synchronism conditions, configured by setting (live line and bus levels).

Table 5-17: Synchronism conditions

Table 5-17: Synchronism conditions shows the different synchrocheck and closing logic situations, that can be produced 
depending on the line and busbar voltage levels.

Live Line – Live Bus (Synchronism check): Only in case number (2), with live line and live bus, the element starts evaluating 
the line and busbar voltage comparison with respect to the setting DVset established 
by setting (Max Volt Difference). In this case, if the voltage difference is lower than 
DVset, the synchronism check element (25) verifies the angle difference Dj adjusted by 
setting (Max Angle Difference).

Dead Line – Dead Bus (DL - DB):       Case number (3) does not allow the synchronism function, but it does allow DL-DB 
operation logic, if this logic is enabled by setting (DL-DB Function).

Dead Line – Live Bus (DL - LB): Case number (6) does not allow the synchronism function, but it does allow DL-LB  
operation logic, if this logic is enabled by setting (DL-LB Function)

Live Line – Dead Bus (LL - DB): Case number (7) does not allow the synchronism function, but it does allow LL-DB 
operation logic, if this logic is enabled by setting (LL-DB Function)

Case numbers (1), (4) and (5) are not considered neither for synchronism check purposes, nor for closing logic.

Synchronism Situation Synchronism Check Closing Logic Line Voltage Levels Busbar Voltage Levels

(1) VL < (V1 & V2)< VH Not permitted Not permitted V1 > dead line level
V1 < live line level

V2 > dead bus level
V2 < live bus level

(2) (V1 & V2) > VH Permitted Live Line – Live Bus V1 > live line level V2 > live bus level

(3) (V1 & V2) < VL Not permitted Dead Line – Dead Bus V1 < dead line level V2 < dead bus level

(4) (V1 < VL) & (VL< V2 < VH) Not permitted Not permitted V1 < dead line level V2 > dead bus level
V2 < live bus level

(5) (V2 < VL) & (VL < V1 < VH) Not permitted Not permitted V1 > dead line level
V1 < live line level

V2 < dead bus level

(6) (V1 < VL) & (V2 > VH) Not permitted Dead Line – Live Bus V1 < dead line level V2 > live bus level

(7) (V2 < VL) & (V1 > VH) Not permitted Live Line – Dead Bus V1 > live line level V2 < dead bus level
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Phase Angle Difference Dj

In the live line-live bus Condition, once the voltage difference has been successfully verified in magnitude, the system 
establishes the angle difference between both voltage phasors. If the angle difference is lower than the Djset (Max Angle 
Difference) setting, then the system verifies the frequency slip S (Max Freq Difference).

Figure 5-3: Voltage angle difference

In the live-live bus condition, once the voltage difference has been successfully verified in magnitude, the relative 
frequency slip between phasors is calculated. From the information obtained from the relay, the algorithm knows the slip 
(mHz) of both phasors and it takes as reference (VRef) the lowest frequency phasor. The behavior of the algorithm depends 
on the slip frequency and the breaker close time as follows:

1. If the relative slip, ∆f, is equal or lower than 20 mHz, the algorithm gives permission to close as soon as the angle 
difference is slower than the ∆?set (Max Angle Difference), because at such a low speed, the hold time for getting an 
“in-phase” closing permission would be too long.

2. If the relative slip is higher than 20 mHz, the element performs an anticipative algorithm, determining the right 
moment to give the closing command to the breaker, so that the breaker closes when the line and busbar voltages are 
in phase. When the difference between voltage values equals “two times” the set angle as maximum angle difference 
(∆V = ∆Vset), the anticipative algorithm starts running and uses the set breaker closing time to establish the initiation 
of permission, so that it is executed in the moment when both voltage phasors are completely in phase, thus 
minimizing the voltage difference in the breaker chamber to negligible values. The main benefit is that after a 
considerable number of breaker operations, damage to internal connection elements, as well as to the chamber 
isolating element is drastically reduced, ensuring a longer life for the breaker, and reducing costly maintenance 
operations.

3. If the product of frequency slip and breaker closing time is higher than Max Angle difference and lower than two times 
this setting, as an in phase close is not possible, the algorithm ensures that the difference between voltages in the real 
closing moment is not higher than the set value (Max Volt Difference). 

4. If this product is beyond two times Max Angle difference, closing operation is not allowed.

V1 V2

VH

actua

VL

set
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The Closing process using anticipative algorithm is described on the following figure:

Figure 5-4: Anticipative algorithm
Where:

Vref Referenced phasor (the one with lower frequency)

Vs Actual voltage phasor (the one with lower frequency)

V’s Calculated voltage phasor, depending on the set breaker closing time (anticipative algorithm)

j 360º *TCB *Df = Calculated angle for phasor V’s

TCB Breaker Closing time defined by setting 

Df Frequency slip (mHz) between phasors

j1 Angle difference set as maximum angle difference (Djset , Max Angle Difference)

j2 = Angle difference between Vref and Vs. The algorithm starts operating when j2 equals two times the angle set as

maximum angle difference.

Closing permission is given when V’s is over Vref, which means that line and busbar voltages are in phase.

If the frequency slip is high, it is possible that as soon as the window defined by two times the maximum angle difference 
(j2) is entered, the relay produces a closing permission output, if it is guaranteed that the projected phasor is within the limit 
marked by the setting, as shown in the following figure. Besides, when the product of frequency slip and breaker close time 
goes beyond this window, closing is not allowed. 

Figure 5-5: High slip closing permission signal
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5.4.2  Autoreclose (79)
Note: The Switchgear element used in the C650 autoreclose element is the one configured in the Number of Switchgear 
setting inside Breaker settings, at “Setpoint > System Setup > Breaker > Breaker settings”. Configuration of these 
Switchgear parameters is performed at Setpoint > Relay Configuration > Switchgear using the EnerVista 650 Setup 
software.

The C650 autoreclose element produces up to four breaker “shots” prior to lockout. Thanks to the great flexibility of C650 
configurable logic, the conditions to produce the autoreclose initiation and the selection of protection elements is enabled 
after each shot can be programmed. This flexibility allows implementing protection schemes that used to require wiring 
and special functions in conventional equipment. One application is, for instance, programming as instantaneous the first 
protection trip while the second one is time delayed, in order to give time for output fuses to burning of a feeder branch. 
This can be as simple as disabling the instantaneous elements after the first shot using programmable logic. (see example 
in section 5.4.2.5 Logic for blocking protection functions during reclose cycle)

5.4.2.1  Main autoreclose settings

Autoreclose settings description:

Function: This setting allows enabling or disabling the autoreclose operation. If this setting is adjusted as 
DISABLED, the recloser is out of service.

Max Number Shots: This setting specifies the number of autoreclose shots allowed in the element. If this number is 
exceeded, the autoreclose goes to LOCKOUT status, and the fault is considered to be permanent.

Dead Time 1 ... 4: These times correspond to the first, second, third and fourth breaker reclosings configured in the 
element.

Reclaim Time (also known as safety time or reset lockout delay): This is the time required to go from LOCKOUT to 
READY status once the breaker is closed.

Cond. Permission: This setting enables the verification of the relay reclose conditions. If this setting is enabled, before 
the breaker closing command execution the system verifies the possible reclose conditions. If this 
setting is disabled, the closing command is executed after the reclose time without verifying these 
conditions. The reclose conditions input is configured as AR CONDS INPUT at Setpoint > Relay 
Configuration > Protection Elements

Hold Time: This setting indicates the waiting time for the reclose conditions to be present. This setting is only 
operative if the Cond. Permission setting is enabled.

Reset Time: This is the time that the autoreclose takes to return to READY status after a successful reclose. Once 
this time has expired, the shot counter resets and the autoreclose goes to READY.

Setpoint > Control Elements > Autoreclose

Setting Description Name Default Value Step Range

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Maximum Number of shots Max Number Shots 1 N/A [1 : 4]

Dead time 1 Dead Time 1 0.00 0.01 s [0.00 : 900.00]

Dead time 2 Dead Time 2 0.00 0.01 s [0.00 : 900.00]

Dead time 3 Dead Time 3 0.00 0.01 s [0.00 : 900.00]

Dead time 4 Dead Time 4 0.00 0.01 s [0.00 : 900.00]

Reclaim time or reset lockout delay Reclaim Time 0.00 0.01 s [0.00 : 900.00]

Reclose conditions permission Cond. Permission DISABLED N/A [DISABLED – ENABLED]

Hold time Hold Time 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Time 0.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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5.4.2.2  Autoreclose inputs

For the correct operation of the autoreclose element, it is required to configure several input signals in the Relay. These 
signals can be configured using the EnerVista 650 Setup software, at Setpoint > Relay Configuration > Protection 
Elements. The Protection Elements screen allows to select simple signals provided directly by the relay (states), or to use 
more complex logics using virtual outputs, configured at Setpoint > Logic Configuration using the PLC Editor tool inside 
EnerVista 650 Setup.

Actual > Status > Control Elements > Autoreclose

Table 5-18: 79 configurable inputs

AR LEVEL BLOCK: This signal is configured to block the autoreclose by level; when the block signal disappears, the 
recloser goes to Lockout status before returning to either the READY status, or the corresponding 
status in the reclosing cycle.

AR PULSE BLOCK: This signal is configured to block the autoreclose by pulse; a pulse moves the autoreclose to 
BLOCK status. The autoreclose block is active until an unblock signal is received.

AR PULSE UNBLOCK: This signal is configured as autoreclose unblock by pulse; this pulse is required to bring the 
recloser out of the block status. The autoreclose goes to Lockout after a block situation.

AR INITIATE: This signal indicates the autoreclose initiation. Usually, the factory default configuration sets this 
signal as a combination of the general trip signal (Virtual Output 83), and an external input 
configured as AR Initiate.

AR CONDS INPUT: This signal configures the conditions that are to be met before executing a breaker close 
command. These conditions are verified once the configured Dead Time has expired, and they 
are only considered if the Cond. Permission setting is enabled. Otherwise, these conditions 
wouldn’t have any effect. In the default factory configuration, the conditions input is associated 
with the synchronism check element close permission.

5.4.2.3  Autoreclose internal status

Actual > Status > Control Elements > Autoreclose. These signals can be used as conditions for executing logics in the 
relay; they are also useful to know the autoreclose behavior.

Table 5-19: 79 Internal Status

AUTORECLOSE INPUTS

AR LEVEL BLOCK

AR PULSE BLOCK

AR PULSE UNBLOCK

AR INITIATE

AR CONDS INPUT

AUTORECLOSE SINGLE STATUS AUTORECLOSE ENUMERATED STATUS

AR CLOSE BREAKER AR STATUS

AR OUT OF SERVICE AR READY

AR READY AR LOCKOUT

AR LOCKOUT AR BLOCK

AR BLOCK AR RCL IN PROGRESS

AR RCL IN PROGRESS AR LOCKOUT MODE

AR LCK BY ANOMALY AR LCK BY ANOMALY

AR LCK BY FAIL OPEN AR LCK BY FAIL OPEN

AR LCK BY FAIL CLOSE AR LCK BY FAIL CLOSE

AR LCK BY USER AR LCK BY USER
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Description of autoreclose internal status:

AR CLOSE BREAKER  Breaker close command given by the autoreclose

AR OUT OF SERVICE  Autoreclose out of service (Disabled)

AR READY  Autoreclose in service

AR LOCKOUT  Autoreclose in lockout status (finished cycled-definite trip)

AR BLOCK  Autoreclose blocked (by input, logic, others, etc.).

AR RCL IN PROGRESS  Cycle in course (autoreclose in progress).

AR LCK BY ANOMALY  Autoreclose in “Lockout” by anomaly.

AR LCK BY FAIL OPEN  Autoreclose in “Lockout” by failure to open

AR LCK BY FAIL CLOSE  Autoreclose in “Lockout” by failure to close

AR LCK BY USER  Autoreclose in “Lockout” by user Command; manual breaker close during the autoreclose cycle 

AR LCK BY CONDS  Autoreclose in lockout by non-compliance of the autoreclose conditions 

AR LCK BY TRIPS  Autoreclose in “Lockout” by maximum number of trips (Lockout status not available)

AR LCK BY SHOTS  Autoreclose in “Lockout” at the end of cycle – Definite trip (due to Maximum Number of shots 
reached).

AR BLK AFTER 1 SHOT  Block signal sent by the autoreclose after the first shot 

AR BLK AFTER 2 SHOT  Block signal sent by the autoreclose after the second shot

AR BLK AFTER 3 SHOT  Block signal sent by the autoreclose after the third shot

AR BLK AFTER 4 SHOT  Block signal sent by the autoreclose after the fourth shot

AR BLOCK BY LEVEL  Autoreclose blocked by level. See AR block signals configuration (AR LEVEL BLOCK)

AR BLOCK BY PULSE  Autoreclose blocked by pulse. See AR block signals configuration (AR PULSE BLOCK)

AR STATUS  Autoreclose status (see Table 5-19: 79 Internal Status)

AR LOCKOUT MODE  Autoreclose lockout mode (see Table 5-19: 79 Internal Status)

AR BLOCK MODE  Autoreclose block mode (see Table 5-19: 79 Internal Status)

AR LCK BY CONDS AR LCK BY CONDS

AR LCK BY TRIPS AR LCK BY TRIPS

AR LCK BY SHOTS AR LCK BY SHOTS

AR BLK AFTER 1 SHOT AR BLOCK MODE

AR BLK AFTER 2 SHOT AR BLOCK BY LEVEL

AR BLK AFTER 3 SHOT AR BLOCK BY PULSE

AR BLK AFTER 4 SHOT

AR BLOCK BY LEVEL

AR BLOCK BY PULSE
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5.4.2.4  General autoreclose staus diagram

The following diagram describes the different autoreclose states, as well as the transitions between states.

Figure 5-6: General autoreclose status diagram

Description of the general autoreclose status:

OUT OF SERVICE / AR DISABLE

In this status, the autoreclose is disabled. From any state, if the Function setting is set as DISABLED, the autoreclose moves 
to OUT OF SERVICE status, where it is not operative.

AR READY

This is the initiation and normality situation status: closed breaker. There are neither faults producing a autoreclose
initiation nor Block signal.

If the autoreclose was in LOCKOUT, if the breaker is closed and the time set in Reclaim Time setting expires, the
autoreclose goes to the initial status of READY.

From RECLOSE IN PROGRESS, the recloser moves to READY, if the Reset Time setting expires without any autoreclose
initiation condition.

AR RECLOSE IN PROGRESS

From READY status, a reclose initiation sets the cycle counter to 1 and a reclosing sequence is initiated, which
produces breaker close commands, unless any abnormality is produced that makes the autoreclose go to LOCKOUT
status.

The reclosing sequence consists on the following steps:

Wait until the breaker is open, if the waiting exceeds the Fail to Open Time setting, the autoreclose goes to LOCKOUT
by failure of opening status (AR LCK BY FAIL OPEN).
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Once the breaker is open, it waits for the time set in the Dead Time N setting, N being the number of the cycles in
progress. If during this waiting the breaker is closed or reclose initiation conditions are given, the recloser goes to
LOCKOUT status by anomaly (AR LCK BY ANOMALY).

Once the Dead Time has expired, in case the Conditions Permission setting is disabled, a closing command would be
produced. If the conditions permission setting is enabled, the system waits for the conditions fixed in the conditions
input (AR CONDS INPUT) configured at Setpoint > Relay Configuration > Protection Elements; if the waiting period for
the reclosing conditions signal activation exceeds the Hold Time, the autoreclose goes to Lockout status by conditions
(AR LCK BY CONDS).

The autoreclose gives a Closing command and waits for the breaker to close. If the Fail to Close Time setting is
exceeded, the autoreclose goes to lockout by failure to close (AR LCK BY FAIL CLOSE).

At this point, the diagram indicates that a reclosing cycle has been reached, and so the cycle counter is increased. In this 
time, the period set in Reset Time starts to count. If during the set element reset time there is no autoreclose initiation, the 
cycle counter resets to its initial value (1), and the autoreclose returns to the standby status (READY). If during the Reset 
Time setting period, there is a new autoreclose initiation, the Reclose In Progress sequence starts again. If this reclose is 
produced after the last configured cycle in the Maximum Number of Shots setting, the autorecloser goes to Lockout by 
maximum number of shots (AR LCK BY SHOTS).

AR LOCKOUT

This is a safety status, scheme lockout blocks all phases of the reclosing cycle, preventing automatic reclosure.

From the out of service (AR DISABLE) and BLOCK statuses, the autoreclose stays in LOCKOUT prior to going to READY.

From the RECLOSE IN PROGRESS status, the recloser goes to LOCKOUT status if any of the anomalies described above
occur.

To go from the LOCKOUT status to READY it is necessary that the breaker is closed and stays closed for preset time in 
Reclaim Time setting.

AR BLOCK

The BLOCK status is similar to the LOCKOUT status, as it guarantees that if the autoreclose is in Block, no breaker close
command is produced, but the difference between them is that this Block status is reached by an external action. The
autoreclose block can be configured by pulse or level signals. This configuration must be selected at Setpoint > Relay
Configuration > Protection Elements 

When the autoreclose block signal is deactivated, either by a level change in the set signal (in case of block by level) or
by an Unblock pulse (in case of block by pulse), the block status is abandoned and the autoreclose returns to the
Lockout status.

Configurable signals to block the autorecloser are described in section 5.4.2.2 Autoreclose inputs.

5.4.2.5  Logic for blocking protection functions during reclose cycle

The C650 autoreclose generates a series of internal signals that allow performing block logics for Protection elements 
during the reclosing cycle. These signals are blocks after autoreclose shots (BLK AFTER SHOT). For example, if the user 
wants to block a protection element during the complete reclosing cycle, it is necessary to configure a signal as an OR of 
the four blocking signals provided after each reclosing cycle in the logic configuration tool Setpoint > Logic Configuration, 
and then use it to block the desired protection elements at Setpoint > Relay Configuration > Protection Elements. 

Figure 5-7: clock signal during reclose cycleshows an example of the logic configuration for the block signal during the 
reclosing cycle.
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Figure 5-7: clock signal during reclose cycle

Figure 5-8: Reclose initiation and block signals configuration example shows an example of the autoreclose initiation and 
protection element block signals after the different trips. The autoreclose initiate signal is configured to the relay general 
trip that corresponds to virtual output 83 configured in the logic configuration tool, and a physical contact to generate an 
external autoreclose initiation.

In the example shown on the figure, the 50PH element block signal is configured as a combination of block by digital input, 
block by non-trip permission of the directional element, and finally the element remains blocked during the reclosing cycle. 
This means that only the first trip can be executed by the phase instantaneous overcurrent element; after the first reclose 
trip, the element remains blocked until the end of the cycle.

Figure 5-8: Reclose initiation and block signals configuration example
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5.4.3  Pulse counters
The C650 includes eight pulse counters, each pulse counter stores the activation number to that pulse counter. This value 
can be multiplied for a factor selectable by setting.

The inputs used in this pulse counter function can be selected from all the available in the C650 device. Take into account 
that the input/output settings are both set for the generic input as well as for the pulse counter input, e.g. Debounce time.

Pulse Counters settings are:

CntPulses Enabled: Enable/disable each pulse counter.

CntPulses Name: Each pulse counter can have a configurable user name.

CntPulses Factor: This is the factor multiplier applied to the input activations number stored in the 
pulse counter, providing possibilities to adjust the obtained value to any scale. It the 
"CntPulses Factor X" is set to zero it takes no effect.

CntPulses Overflow: It is the maximum value set as result of the CntPulses Factor plus the number of 
inputs activation. This means that after reaching that value, the pulse counter value 
starts counting from zero.

CntPulses Board Origin: Board selection for the pulse counter input.

CntPulses Input Origin: Index of the input select in the board origin.

The signals related to the 8 pulse counters can be viewed at Actual > Status > Control Elements > Pulse Counters and 
they are as follows:

Table 5-20: Pulse counters status

Setpoint > Control Elements > Pulse Counters

Setting Description Name Default Value Step  Range

Pulse counter enabling setting CntPulses Enabled X DISABLED N/A [DISABLED – ENABLED]

Name of the pulse counter CntPulses Name X Pulse Counter X N/A N/A

Multiplier factor for the pulse counter CntPulses Factor X 1.000 0.001 [0.000 : 65000.000]

Overflow value for the pulse counter CntPulses Overflow X 65535 1 [0 : 1000000]

Board selection for the pulse counter CntPulses Board Origin X F N/A [F,G,H,I]

Input index inside the selected board CntPulses Input Origin X 1 1 [1 : 32]

Note: X is the pulse counter index, up to 8. 

PULSE COUNTERS STATUS

CntPulses Value 1

CntPulses Value 2

CntPulses Value 3

CntPulses Value 4

CntPulses Value 5

CntPulses Value 6

CntPulses Value 7

CntPulses Value 8

CntPulses Freeze 1

CntPulses Freeze 2

CntPulses Freeze 3

CntPulses Freeze 4

CntPulses Freeze 5

CntPulses Freeze 6

CntPulses Freeze 7
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The C650 includes eight different pulse counters in which the value shown is the result of the number of activation of the 
input configured for that counter multiplied plus the CntPulses Factor set for that pulse. For each pulse counter there are 
two magnitudes available, the actual value and the frozen value. 

The freeze and unfreeze and reset operations are similar to the energy management, the signals used for that purpose are 
the same for both energy and pulse counters.

By default, all the values are unfreeze, updating the values in a continuous mode. After a freeze operation the freeze value 
stops updating and the actual value is being updated. If a freeze operation is set again, the actual value is copied to the 
freeze one, which remains frozen again.

To unfreeze all the values it is necessary to perform an unfreeze operation.

If a reset operation is set, all the values, actual and frozen ones goes to zero.

All the operations (freeze, unfreeze and reset) are performed over all the energy counters (both energy and pulse counters). 
It is not possible to set them to a particular counter. 

5.4.4  Analog comparators
The C650 provides 20 different analog comparators in an analog comparator module located in the control elements part 
of the device. Each analog comparator gives indication when the analog variable selected is inside or outside some 
minimum and maximum threshold values.

The analog comparator settings includes two global settings such as

Analog Function: This setting allows enabling or disabling the analog comparators module. Each analog 
comparator can not be enabled/disabled individually.

Analog Snapshot Events: The snapshot event setting enables or disables the snapshot event generation for this element.

Besides the main settings there are some settings for each analog comparator (up to 20) as 
follows:

Analog Input: Analog value selected by the user from the available analog variables in the device. This is 
used to make the comparison inside a set band for that magnitude.

Analog Maximum: Maximum threshold value for the comparison band.

Analog Minimum: Minimum threshold value for the comparison band.

Analog Delay: Time value for the analog signal to be active inside the comparison band before setting the 
Analog Level signal to 1.

Analog Hysteresis: It establishes the deadband at each extreme when going out of operation band.

Direction IN:    min value = min - hysteresis (in %)
max value = max + hysteresis (in %) 

CntPulses Freeze 8

Setpoint > Control Elements > Analog Comparators

Setting Description Name Default Value Step  Range

Generic Analog Function Permission Analog Function DISABLED N/A [DISABLED – ENABLED]

Generic Snapshot Events Generation Analog Snapshot Events DISABLED N/A [DISABLED – ENABLED]

Analog Input Value Selection Analog Input X None N/A [All available analog values]

Analog Maximum Threshold Value Analog Maximum X 1.000 0.001 [-100000.000 : 100000.000]

Analog Minimum Threshold Value Analog Minimum X 1.000 0.001 [-100000.000 : 100000.000]

Analog Delay for Activation Signal Analog Delay X 0.00 0.01 s [0.00 : 900.00]

Analog Hysteresis for the Deadband Analog Hysteresis X 1.0 0.1 [0.0 : 50.0]

Analog Direction for Activation Inside 
or Outside the Deadband

Analog Direction X Out N/A [IN-OUT]

Note: X is the analog comparator index, up to 20
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Direction OUT: min value = min + hysteresis (in %)
max value = max - hysteresis (in %)

Analog Direction: Analog direction for the activation signal to be set Inside or Outside the Deadband. 

OUT: The "Analog Level X" gives an activation signal when the analog value is located outside the 
comparison band.

IN: The "Analog Level X" gives an activation signal when the analog value is located inside the 
comparison band.

The C650 provides 20 different analog comparators. Their status values can be viewed at Actual > Status > Control 
Elements > Analog Comparators:

Table 5-21: Analog comparator status

The analog level value is by default in a reset state, when the value meets the comparison (inside or outside the 
comparison band) the "Analog Level X" signal is activated if the analog value remains active the time set in the analog 
delay setting. When the activation conditions are not met the "Analog Level X" value goes to the reset state. 

An analog change must remain active at least 40 ms to be considered, plus the analog time setting. Besides the snapshot 
event data has a 20 ms accuracy.

ANALOG COMPARATORS STATUS

Analog Level 01

Analog Level 02

Analog Level 03

Analog Level 04

Analog Level 05

Analog Level 06

Analog Level 07

Analog Level 08

Analog Level 09

Analog Level 10

Analog Level 11

Analog Level 12

Analog Level 13

Analog Level 14

Analog Level 15

Analog Level 16

Analog Level 17

Analog Level 18

Analog Level 19

Analog Level 20
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5.4.5  Digital counters
Digital Counters are functions to count discrete bit logic value changes, for example, it is able to count the number of 
pickups of a protection element, the number of breaker openings or the contact inputs state changes.

There are 8 identical digital counters and they count the number of state transitions from Logic 0 to Logic 1, of the logic 
states configured by the user, that trigger the increment or decrement commands of the digital counter value. 

Settings

For each of the 8 digital counters, there exist independent and identical groups of settings:

DigCnt X Function: This setting allow to Enables or disables the specified counter. If a counter’s DigCnt X 
Function is set to Disabled, then the DIGCNT X HI, DIGCNT X EQ and DIGCNT X LO are 
set to OFF and the DIGCNT X VALUE, DIGCNT X FROZENVALUE and DIGCNT X 
FROZENDATE are set unaltered.

DigCnt X Name: Sets a name to identify the specified counter. Note that the name length is cut down to 
only 12 characters long.

DigCnt X Preset: Indicates the preset value that the specified counter can be set before counting 
operations begin or after a reset command is accomplished.

DigCnt X Compare: Indicates the comparison value that the specified counter current value is compared 
to and several logic bits (HI, EQ and LO) are updated accordingly.

Snapshot Events: This is a global setting that affects all of 8 digital counters. Enables or disables the 
snapshot events for this function. Note that all enabled digital counters are affected by 
this setting.

Relay configuration 

To the correct operation of each counter, there are several PLC status variables in EnerVista 650 Setup at Setpoint > Relay 
Configuration > Control Elements section that should be configured properly. Each one of the 8 digital counters has its 
own PLC statuses and they are identical:

Setpoint > Control Elements > Digital Counters

Setting Description Name Default Value Step Range

Digital counter enabling 
setting

DigCnt Function X DISABLED N/A [DISABLED – ENABLED]

Name of the digital 
counter

DigCnt Name X Digital Counter X N/A N/A

Initial Digital counter 
value

DigCnt Preset X 0.00 0 [-2,147,483,648 : 2,147,483,647]:

Compare Digital 
counter value

DigCnt Compare X 0.00 0 [-2,147,483,648 : 2,147,483,647]:

Note: X is the pulse counter index, up to 8. 

Setpoint > Relay Configuration > Control Elements

Setting Description Name

Digital counter block DigCnt X Block

Digital counter UP DigCnt  X UP

Digital counter DOWN DigCnt X DOWN

Digital counter SETPRESET DigCnt X SetPreset

Digital counter RESET DigCnt X Reset

Digital counter FREEZERESET DigCnt X FreezeReset

Digital counter FREEZECOUNT DigCnt X FreezeCount

Note: X is the pulse counter index, up to 8. 
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DIGCNT X BLOCK: Blocks the functionality of the specified counter. If a counter’s DIGCNT X BLOCK is set to 1, all the 
counter’s values remain unaltered and no counter commands are processed. When the 
counter’s DigCnt X Function is set to Enabled and the DIGCNT X BLOCK is set to 0, then the 
counter starts running and accepting counter commands.

DIGCNT X UP: Counter command. When this element changes from 0 to 1, the value of the specified counter is 
incremented by 1. If the current counter value is 2,147,483,647 and is incremented, the updated 
value is set to -2,147,483,648.

DIGCNT X DOWN: Counter command. When this element changes from 0 to 1, the value of the specified counter is 
decremented by 1. If the current counter value is -2,147,483,648 and is decremented, the 
updated value is set to 2,147,483,647.

DIGCNT X SETPRESET: Counter command. This element defines the behavior of the specified counter’s Reset and the 
Freeze/Reset commands or when counter is set from Disabled to Enabled: 

• If set to 0, all commands with a Reset involved or when counter is Enabled set the initial counter value to 0

• If set to 1, all commands with a Reset involved or when counter is Enabled set the initial counter value to the one
specified in the setting DigCnt # Preset.

DIGCNT X RESET: Counter command. It sends a Reset command to the specified counter.

DIGCNT X FREEZERESET: Counter command. It copies the current counter value to the DIGCNT X FROZENVALUE 
actual value and the current date to the DIGCNT X FROZENDATE actual value. Then a 
Reset command is sent to the specified counter.

DIGCNT X FREEZECOUNT: Counter command. It copies the current counter value to the DIGCNT X FROZENVALUE 
actual value and the current date to the DIGCNT X FROZENDATE actual value. Then the 
specified counter value DIGCNT X VALUE is set to 0 or to the DigCnt X Preset setting 
value.

Periodically the counter current Value and Frozen Value and Date are saved to non-volatile memory to keep them safe 
from an unexpected energy loss.

Note: Digital Counters only appear in the Actual Values menu option in HMI, in the Control Elements level.



CHAPTER 5:  SETPOINTS 5.5 INPUTS/OUTPUTS

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 5-53

5.5  Inputs/outputs

5.5.1  Input/output placement
Boards type 1 (mixed) are used in C650 models in F and G slots.

All the other board types (including type 1) can be used in CIO modules. This section explains the different I/O board 
configurations available.

Figure 5-9: Input/output location and type

MIXED SUPERVISION INPUTS ANALOG

TERMINALS 1 2 4 5

1CC1CC1 LIOC1CC1

2CC2CCa/252CC2

3CC3CC1 LIOC3CC3

4CC4CCb/254CC4

5 CC5 CC1 CC5 CC5

6 CC6 CC2 CC6 CC6

7 CC7 CC3 CC7 CC7

8 CC8 CC4 CC8 CC8

9 COMMON 1/8 COMMON 1/4 COMMON 1/8 COMMON 1/8

10 COMMON 9/16 COMMON 5/8 COMMON 9/16 COMMON 9/16

11 CC9 CC5 CC9 CC9

12 CC10 CC6 CC10 CC10

13 CC11 CC7 CC11 CC11

14 CC12 CC8 CC12 CC12

15 CC13 COIL 2 CC13 CC13

41CC41CCa/2541CC61

17 CC15 COIL 2 CC15 CC15

61CC61CCb/2561CC81

4/1 DLEIHS71CC91

81CC02

91CC12

02CC22

12CC32

22CC42

32CC52

42CC62

42/71 NOMMOC72

23/52 NOMMOC82

52CC92

62CC03

72CCSNES I13

82CC23

92CC33

03CCSNES I43

13CC53

8/5 DLEIHS23CC63

O1
O1

         AI 1

O2

O2
         AI 2

O3

         AI 3

O3 O4

         AI 4

O4 O5

         AI 5

O5 O6

         AI 6

O6

7 IA         7O

O7

         AI 8

O8 O8

V
V

V
VV

V
I

II
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5.5.2  Control settings for input/output
Configuration of settings relative to inputs and outputs can only be accessed through the EnerVista 650 Setup 
software, and not via the HMI. For this purpose, the user must access Setpoint > Inputs/Outputs > Contact I/O > Board 
X, being X the corresponding I/O board.

Settings relative to I/O boards are described in Table 5-22: I/O board settings

Table 5-22: I/O board settings

For versions previous to 7.00, the snapshot event setting enables or disables the snapshot event generation for this 
element. It is mandatory to enable this setting in order the input/output values to be refreshed in IEC61850 protocol.

Being:

X F, G, H, J, 2H, or 2J, the I/O board name, depending on the Relay model.

F and G are internal Relay boards and H, J, 2H and 2J are additional boards available in CIO modules (remote Bus CAN I/O 
module) or a C650 19" rack.

Setpoint > Inputs/Outputs > Contact I/O >

Board F > Board G > Board H > Board J

Setting Description Name Default Value Step Range

I/O board type (available only for CIO modules) I/O Board Type_X NONE N/A [NONE,
16 INP + 8OUT,
8 INP + 8OUT + SUPV,
32 INP
16 INP + 8 ANA]

Input activation voltage threshold Group A Voltage Threshold A_X 80 1 V [10 : 230]

Input activation voltage threshold Group B Voltage Threshold B_X 80 1 V [10 : 230]

Input activation voltage threshold Group C Voltage Threshold C_X 80 1 V [10 : 230]

Input activation voltage threshold Group D Voltage Threshold D_X 80 1 V [10 : 230]

Debounce time for Group A Debounce Time A_X 15 1 ms [1 : 50]

Debounce time for Group B Debounce Time B_X 15 1 ms [1 : 50]

Debounce time for Group C Debounce Time C_X 15 1 ms [1 : 50]

Debounce time for Group D Debounce Time D_X 15 1 ms [1 : 50]

Input type Input Type_X_CCY (CCY) POSITIVE N/A [POSITIVE-EDGE,
NEGATIVE-EDGE,
POSITIVE,
NEGATIVE]

Input signal time delay Delay Input Time_X_CCY (CCY) 0 1 ms [0 : 60000]

Output logic type Output Logic_X_0Z POSITIVE N/A [POSITIVE,
NEGATIVE]

Output type Output Type_X_0Z NORMAL N/A [NORMAL,
PULSE,
LATCH]

Output pulse length Pulse Output Time_X_0Z 10000 1 ms [0 : 60000]

Analog Inputs Range Range_X_0Z NONE N/A [NONE,
-1 to 0mA,
0 to 1 mA,
-1 to 1 mA,
0 to 5 mA,
0 to 10 mA]

Minimum Value Min_Value_X_0Z 0.00 0.01 [ -9999.99 : 9999.99]

Maximum Value Max_Value_X_0Z 0.00 0.01 [ -9999.99 : 9999.99]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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For the I/O board selection in the relay model, associated digits to each board type are as follows:

Table 5-23: I/O board type

CCY Is the name used for inputs in I/O boards

0Z Is the name used for the different outputs in I/O boards

5.5.3  Inputs

Input settings description

Input Activation Voltage Threshold: The range of this value goes from 20 to 230 volts. There is a single setting for all 
inputs in the same group (inputs sharing the same common). In mixed and supervision boards there are two groups of 
inputs, called A and B., in 32DI board there are four groups of 8 inputs each.

Debounce Time: This is the debounce time set for inputs (1 to 50 ms). The debounce time is the time window for input 
filtering. If an input suffers a change of level that lasts less than this set time, the change is not considered. There is a single 
setting for all inputs in the same group.

Input Type: Type of logic associated with the physical input. Possible settings are, positive and negative.

Positive and Negative settings correspond to signals that are activated or deactivated with the input level, considering the 
delay setting. Positive-edge, and Negative-edge settings correspond to signals that are activated with the change of the 
input signal; in this case, the Delay Input Time is not considered, only the Debounce Time; this edge signals are deactivated 
automatically after one PLC scan cycle. Figure 5-10: INPUT LOGIC TYPES shows the types of signals associated with the 
different input configuration types.

Delay Input Time: This is the delay applied to the input signal; the default value is zero, meaning no delay; the setting 
range is 0 to 60000 milliseconds (1 minute). This setting is used in slow switchgear applications.

This is not a grouped setting; there is a different setting for each input. It is important to distinguish between this delay 
input time and the debounce time used for filtering undesired transients in the input signal. The Debounce time is always 
added to the delay input time. 

Associated Digit ENERVISTA 650 Setup Board Settings Board Type

0 NONE None 

1 16 INP+ 8OUT Mixed

2 8 INP +8 OUT +SUPV Supervision 

4 32 INP 32 digital inputs 

5 16 INP + 8 ANA 8 Analog Inputs + 16 digital inputs 
(C650 and CIO module)
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Figure 5-10: INPUT LOGIC TYPES

Input status signals

Actual > Inputs/Outputs > Contact inputs > Board X (being X the corresponding board in each case). Depending on the I/
O board, inputs are represented as follows:

Table 5-24: Contact inputs status

The operation logic for supervision signals (board type 2) is detailed in section 5.5.5 Circuit supervision and contact seal-in 
circuits in this manual.

Input Status
(X: board F, G, H, J, 2H, 2J)

Mixed And Analog Board
(Types 1 And 5)

Supervision Board
(Type 2)

32 di
(Type 4)

CONT IP_X_CC1 CC1 CC1 CC1 CC17

CONT IP_X_CC2 CC2 CC2 CC2 CC18

CONT IP_X_CC3 CC3 CC3 CC3 CC19

CONT IP_X_CC4 CC4 CC4 CC4 CC20

CONT IP_X_CC5 CC5 CC5 CC5 CC21

CONT IP_X_CC6 CC6 CC6 CC6 CC22

CONT IP_X_CC7 CC7 CC7 CC7 CC23

CONT IP_X_CC8 CC8 CC8 CC8 CC24

CONT IP_X_CC9 CC9 Va_COIL1 CC9 CC25

CONT IP_X_CC10 CC10 Vb_COIL1 CC10 CC26

CONT IP_X_CC11 CC11 Va_COIL2 CC11 CC27

CONT IP_X_CC12 CC12 Vb_COIL2 CC12 CC28

CONT IP_X_CC13 CC13 O7_SEAL CC13 CC29

CONT IP_X_CC14 CC14 O8_SEAL CC14 CC30

CONT IP_X_CC15 CC15 SUP_COIL1 CC15 CC31

CONT IP_X_CC16 CC16 SUP_COIL2 CC16 CC32
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5.5.4  Outputs

Output settings description

Output Logic_0X _0Z: Type of logic applied to outputs. Possible values are positive and negative. The default value is 
positive. Depending on the type of setting selected, the physical output is in the same direction (positive) or opposite 
(negative) the output activation command.

Output Type_0X _0Z: Type of output adjusted. Possible values are normal, pulse or latched, the default value is Normal. 

Normal: The contact output follows the activation command. Remains active while the operation signal is active.

Pulse: The contact output is active for the pulse output time, according to the Pulse Output Time setting.

Latched: The output remains active after the operation signal has been cleared. The reset signal for the latched
outputs is configured at Setpoint > Relay Configuration > Outputs > Contact Output Reset”.

Pulse Output Time_0X _0Z: This is the length of the output pulse in case the output type is selected as pulse; the default value is
10000 ms.

Figure 5-11: Output logic typesshows the types of signals associated with the different output configuration types.

Figure 5-11: Output logic types

5.5.4.1  Output status signals

Boards types 1 and 2 have both 8 outputs, so the representation is the same for both types as shown in Table 5-25: 
Contact output signals

Actual > Inputs/Outputs > Contact Output Status

Real status of the contact output, which corresponds to the transformation of the output activation signal (Contact output 
operate), by the logic applied to this output in Setpoint > Inputs/Outputs > Contact I/O > Board X

Actual > Inputs/Outputs > Contact Output Operates

Activated or deactivated status of those variables used internally to operate a contact output.

Actual > Inputs/Outputs > Contact Output Resets
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These are the logic signals associated with the contact output reset, which produce the reset of those signals previously 
configured as Latched. Configuration for the contact output reset signal is set at Setpoint > Relay Configuration > 
Outputs > Contact Output Reset.

Actual > Inputs/Outputs > I/O Board Status

These signals are associated with the different I/O boards. There are internal signals that provide information about the 
status of these boards, indicating whether there is any anomaly in the board, or whether the board is not available in the 
relay according to the relay model.

Table 5-25:  Contact output signals

Being X the corresponding board in each case

5.5.5  Circuit supervision and contact seal-in circuits

Circuit Supervision:

C650 elements can include supervision boards (type 2), either in their internal slot F, or in an additional CIO module 
connected to the element via a CAN Bus (slots H and J). This type of board includes 4 voltage detectors for implementing 
tripping or opening circuit supervision control logic.

Contact Seal-in:

The current seal-in circuit is used for verifying the current condition in a circuit during the time that the tripping contact 
remains closed. If the current in the tripping circuit is maintained over 500 mA, the function is sealed independently of the 
status of the function that caused the trip.

This current seal-in function in tripping circuits is mainly used in applications where auxiliary contacts 52/a (in charge of 
cutting the current in the tripping circuit) are very slow. This may cause that, once the function that produced the trip is 
reset, the relay contact opens before the breaker auxiliary 52/a, even if the time delay of the first has expired.

By using this function, we prevent the relay contact from cutting the current (basically inductive and high) from the tripping 
circuit, which can cause damage to the element, as these currents exceed the nominal breaking characteristics.

The circuit and the current threshold of the function are as follows: 

Figure 5-12: Current supervision

CONTACT OUTPUT STATUS CONTACT OUTPUT OPERATES CONTACT OUTPUT RESETS IO BOARD STATUS

CONT OP_X_01 CONT OP OPER_X_01 CONT OP RESET_X_01 BOARD F STATUS

CONT OP_X_02 CONT OP OPER_X_02 CONT OP RESET_X_02 BOARD G STATUS

CONT OP_X_03 CONT OP OPER_X_03 CONT OP RESET_X_03 BOARD H STATUS

CONT OP_X_04 CONT OP OPER_X_04 CONT OP RESET_X_04 BOARD J STATUS

CONT OP_X_05 CONT OP OPER_X_05 CONT OP RESET_X_05

CONT OP_X_06 CONT OP OPER_X_06 CONT OP RESET_X_06

CONT OP_X_07 CONT OP OPER_X_07 CONT OP RESET_X_07

CONT OP_X_08 CONT OP OPER_X_08 CONT OP RESET_X_08

500 mA min 
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5.5.5.1  Digital inputs

5.5.5.2  With trip circuit supervision 

The supervision board includes:

8 digital inputs in two groups of 4 inputs with one common, in terminals F/H9 to F/H10

8 auxiliary outputs: 6 normally open contacts in terminals F/H19 to F/H30 and two current sensing (latching) outputs (F/
H31-F/H33 and F/H34-F/H36).

2 groups of inputs for trip circuit supervision with 4 voltage detectors. The first group includes two isolated digital inputs, 
terminals F/H1-F/H2 and F/H3-F/H4. The second group, symmetrical and identical to the first, is formed by isolated voltage 
inputs F/H15-F/H16 and F/H17-F/H18.

Using voltage detectors and current sensing, it is possible to implement several trip or close circuit supervision schemes, as 
well as protection of the element output contact. 

In order to implement these schemes, it is not necessary to set any setting in the element. Internal functions are always 
operative and provide the following logic operands:

Table 5-26: Supervision logic operands

A continuity failure is detected in a circuit when both voltage detectors (Va and Vb) detect lack of voltage during more than 
500 ms. This function is not influenced by the breaker status.

These operands can be associated with internal signals (virtual outputs), LEDs or element outputs, to issue alarm signals or 
to block elements, for example for blocking the Breaker close if an anomaly is detected in the trip circuit.

Available schemes are as follows:

1. Without supervision

2. With current supervision (with seal-in)

3. With simple voltage supervision

4. With double voltage supervision

5. With current and simple voltage supervision (with seal-in)

6. With current and double voltage supervision (with seal-in)

7. With current and double voltage supervision (with seal-in) and serial resistor in voltage monitors.

The following subsections describe the different types of connection to create each supervision scheme in an easy way. As 
the supervision circuits are identical, only the first group connection examples are described, being also applicable to the 
second group.

Actual > Inputs/Outputs > Contact inputs > Board X
Being X the corresponding board in each case

OPERAND DESCRIPTION

CONT IP_X_CC9 (Va_COIL1) Active when voltage is detected in terminals F/H1 - F/H2 (circuit 1)

CONT IP_X_CC10 (Vb_COIL1) Active when voltage is detected in terminals F/H3 - F/H4 (circuit 1)

CONT IP_X_CC11 (Va_COIL2) Active when voltage is detected in terminals F/H15 - F/H16 (circuit 2)

CONT IP_X_CC12 (Vb_COIL2) Active when voltage is detected in terminals F/H17 - F/H18 (circuit 2)

CONT IP_X_CC13 (O7_SEAL) Active if current is detected by sensor in output O7 (F/H31-F/H33)

CONT IP_X_CC14 (O8_SEAL) Active if current is detected by sensor in output O8 (F/H34-F/H36)

CONT IP_X_CC15 (SUP_COIL1) Active when continuity is detected in circuit 1

CONT IP_X_CC16 (SUP_COIL2) Active when continuity is detected in circuit 2
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In order to assure a high isolation level between groups, the digital inputs for supervision have been located in a 
symmetrical basis. That is to optimize the isolation between groups that can be connected to different batteries, and 
therefore requiring a greater distance between circuits.

5.5.5.3  Without supervision

This is a very frequent common case, and we must only wire the tripping circuit to terminals F/H35 and F/H36, leaving 
unused terminals F/H34, F/H15, F/H16, F/H17, F/H18.

Figure 5-13: Circuit without tripping circuit supervision (A6631F1)
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5.5.5.4  With current supervision (with SEAL-IN)

In this case, as shown in Figure 5-14: Current supervision of the tripping contact (A6631F2), the current supervision circuit 
consists of a circuit connected in series with the output contact, so that the external circuit is wired to terminals F/H34 and 
F/H36. This supervision circuit includes a low impedance reed relay that is activated when the current value exceeds 200 
mA, and sends a signal to the main microprocessor. This latches the output relay in such a way that this indication can be 
used to produce a latching of the output relay, so that it remains closed while the circulating current is over 200 mA. To use 
the seal-in feature in the relay it is not necessary to configure any setting. It works, we only must program the 
corresponding Circuit latching setting wiring the external circuit to terminals F/H34 and F/H36.

With this scheme, in the case of a failure to open from the breaker auxiliary contact, the C650 output relay does not open 
the tripping coil current, as in this case the contact may be damaged, as it is prepared for opening currents around 0.35 A 
at 125 Vdc. This latching or memory function is only guaranteed while the element is powered.

Figure 5-14: Current supervision of the tripping contact (A6631F2)
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5.5.5.5  With simple voltage supervision

Figure 5-15: Supervision application with auxiliary contact 52a and a resistor (A6631F3)

Table 5-27:  Supervision with 52/a 

There is a possibility to monitor the trip circuit and trip coil continuity. This can be done by monitoring Vdc through the 
output contact when this is open.

INTERNAL STATE V 52/a SUPERVISION

52 open ON OK

52 closed ON OK

TRIP OFF OK if t < 0.5 s

TRIP with 52 open OFF OK if t < 0.5 s
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Table 5-28: Supervision algorithm with simple voltage supervision scheme

In this table, ON means that the voltage detector V52/a is active, detecting a voltage.

In the first case shown on the table, with closed breaker, voltage is detected by V 52/a sensor, and this means that there is 
continuity in the supervised circuit.

As shown on Figure 5-15: Supervision application with auxiliary contact 52a and a resistor (A6631F3), when the relay is not 
tripped, trip contact H35-H36 remains open. If the breaker is closed, its auxiliary contact 52a is closed. Therefore, a little 
current is flowing, about 2 mA, through terminals H15 and H16 through the voltage detector circuit, which flows through 
52/a and the tripping coil 52TC (TC = tripping coil). Current only circulates when there is continuity in the whole circuit, so 
the complete circuit is monitored, and not only the trip coil. This circuit includes auxiliary 52/a as well as the whole wiring 
between the battery and the relay tripping terminals, and between these and the breaker tripping circuit.

For the second case shown on the table, open breaker, its auxiliary contact 52/a remains open, and current cannot flow 
through it for detecting continuity. In order to correctly monitor the circuit, a resistor must be used, not included in the 
protection, connected in parallel. The value of resistance is selected so that the V 52/a input circuit minimum detection 
current flows, but not as high as to activate the breaker-tripping coil. The figure shows the following equation:

Where: 

Vmin Is the minimum voltage, in Volts, expected in the battery (e.g. 80% of Vn)

R Resistance, in kilo ohms.

2 2 mA of approximate current flowing through input V 52/a

As shown in the second case in the table, with an open breaker, as current flows through R if there is continuity in the 
WHOLE tripping circuit, voltage is detected in input V 52/a.

This works correctly in steady state. However, if the breaker trips, while it is opening, the V 52/a input signal can be 
deactivated without this meaning that the circuit is not correct. This is due to the fact that the tripping relay, terminals H35-
H36, short circuits input V 52/a temporarily.

Therefore, if there is a trip signal, it is permitted that no signal is detected during a period of 1s to allow the breaker to open, 
and reopen the tripping relay H35-H36.

Status of Involved Elements Input to C650 Decision

CIRCUIT
STATUS

OUTPUT
STATUS
(H35-H36)

BREAKER
STATUS

OPERAND
CONT IP_X_CC11
(Va_COIL2)
V 52/a (H15-H16)

OPERAND
CONT IP_X_CC16
(SUP_COIL2)

Healthy Open 52 closed ON ON

Healthy Open 52 open ON ON

Healthy Closed 52 closed OFF ON (if t < 500 ms)
OFF (if t > 500 ms)

Healthy Closed 52 open OFF ON (if t < 500 ms)
OFF (if t > 500 ms)

Faulty Open 52 closed OFF OFF (500 ms delay)

Faulty Open 52 open OFF OFF (500 ms delay)

Faulty Closed 52 closed OFF OFF (500 ms delay)

Faulty Closed 52 open OFF OFF (500 ms delay)
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Figure 5-16: Trip circuit and trip coil supervision, auxiliary contact 52/a (closed breaker only) (A6631F5) shows the possibility 
of monitoring the circuit only when the breaker is closed. In this case resistance R is not used, but it must be observed in 
the element logic that the corresponding signal CONT IP_H_CC16 (SUP_COIL2) is activated showing a failure when the 
breaker is open. Therefore it is required to supervise the continuity failure signaling by the breaker status information.

Figure 5-16: Trip circuit and trip coil supervision, auxiliary contact 52/a (closed breaker only) (A6631F5)
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5.5.5.6  With double voltage supervision

Figure 5-17: Supervision application with auxiliary contacts 52a and 52b (A6631F4)
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Table 5-29: Supervision algorithm with double voltage supervision scheme

There is a possibility to monitor the trip circuit continuity not only via its auxiliary contact 52/a, but also with auxiliary 
contact 52/b. This avoids the need to install a resistance in parallel with auxiliary 52/a. The correct connection is shown on 
Figure 5-17: Supervision application with auxiliary contacts 52a and 52b (A6631F4)

The circuit works in a similar way to the one described in the previous section, but it uses both supervision inputs F/H15-F/
H16 and F/H17-F/H18.

The advantage in this case is that circuit supervision with 52 open is more complete, as input V 52/b is used through 
contact 52/b, (that is closed when the breaker is open).

We must point out that in this scheme, the tripping contact, shown in the example as the C650 trip relay, can be the one in 
the relay (terminals F/H35 and F/H36), or be provided by another protection or by the parallel of several protections. This 
provides high flexibility in the use of this circuit.

The battery voltage can also be monitored, by using one of the standard digital inputs.

Status of Involved Elements Inputs to 650 Decision

CIRCUIT STATUS OUTPUT STATUS
(F/H35-F/H36)

BREAKER STATUS OPERAND
CONT IP_X_CC11
(Va_COIL2)
V 52/a (F/H15-F/H16)

OPERAND
CONT IP_X_CC12 
(Vb_COIL2)
V 52/b (F/H17-F/H18)

OPERAND
CONT IP_X_CC16
(SUP_COIL2)

Healthy Open 52 closed ON OFF ON

Healthy Open 52 open ON ON ON

Healthy Closed 52 closed OFF OFF ON (if t < 500 ms)
OFF (if t > 500 ms)

Healthy Closed 52 open OFF ON ON (if t < 500 ms)
OFF (if t > 500 ms)

Defective Open 52 closed OFF OFF OFF (500 ms delay)

Defective Open 52 open OFF OFF OFF (500 ms delay)

Defective Closed 52 closed OFF OFF OFF (500 ms delay)

Defective Closed 52 open OFF OFF OFF (500 ms delay)
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5.5.5.7  With double voltage supervision and serial resistor in voltage monitors

Figure 5-18: Supervision application, auxiliary contacts 52a and 52b and series resistor in H15-H16shows the supervision 
scheme with an external resistor.

An external series resistor is used with the 52a voltage monitor to prevent CB tripping with a short-circuited voltage 
monitor. With CB open, 52/a is open and 52/b is closed. A shorted 52/a voltage monitor does not cause a trip because 52/
b voltage monitor is current limited to 2mA. With a shorted 52/b voltage monitor, no false trip is performed because 52/a is 
in series limiting current to 2mA.

Figure 5-18: Supervision application, auxiliary contacts 52a and 52b and series resistor in H15-H16
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5.5.6  Analog board specific settings
Hardware and software is provided to receive signals from external transducers and convert these signals into a digital 
format for use as required. The relay accepts inputs in the range of –1 to +20 mA DC, suitable for use with the most 
common transducer output ranges; all inputs are assumed to be linear over the complete range.

The Input Range setting specifies the mA DC range of the transducer connected to the input channel.

• Range: -1 to 0, 0 to 1, -1 to 1, 0 to 5, 0 to 10, 0 to 20, 4 to 20.

The Min and Max Value settings are used to program the span of the transducer in primary units.

• Min Value: -9999.99 to 9999.99

• Max Value: -9999.99 to 9999.99

5.5.7  Virtual inputs
Virtual inputs are signals that can be written directly via communications. Their status can be established as ON (1) and 
OFF (0), through writing by communications using EnerVista 650 Setup.

The change of state of virtual inputs is made according to their type. Latched virtual inputs remain at the set value until it is 
changed by communications. Self-reset virtual inputs are activated by writing, and they remain active during one cycle. 
There are 32 virtual inputs of each type.

5.5.7.1  Virtual inputs writing

Setpoint > Input/Outputs >Virtual Inputs for activating / deactivating signals

To write a virtual input, select the virtual input to activate by clicking on the virtual input checkbox, then click Store and the 
virtual input is written to the relay (see Figure 5-19: Virtual input writing through EnerVista 650 Setup).

For self-reset, the value remains active during one PLC cycle and after that the virtual input value is cleared.

For latched, the value remains active until it is cleared by the user, clicking again in the virtual input checkbox and
clicking Store to clear the value.

Figure 5-19: Virtual input writing through EnerVista 650 Setup
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5.5.7.2  Virtual inputs status monitoring:

Actual > Inputs/Outputs > Virtual Inputs > Virtual Input Latched > Virtual Input Self-Reset

Table 5-30: Virtual input status

Text assignment for virtual input is made at Setpoint > Relay Configuration > Virtual Inputs. It should be taken into 
account that the text assigned for virtual inputs in the relay configuration screen are only for file management, they are 
not sent to the relay.

5.5.8  Virtual outputs
There are 512 virtual outputs that may be assigned via Logic configuration. If not assigned, the output is forced to OFF 
(Logic 0). An ID may be assigned to each virtual output. Virtual outputs are resolved in each pass through the evaluation of 
the logic equations. For more detailed information see chapters 5.8 Relay configuration and 5.9 Logic configuration (PLC 
editor) in this manual.

5.5.9  Virtual outputs latched
There are 16 virtual outputs latched that may be assigned via Logic configuration. If not assigned, the output is forced to 
OFF (Logic 0). Virtual outputs are resolved in each pass through the evaluation of the logic equations. These latched virtual 
outputs can only be assigned as an S/R output, they only are linked to a PLC's S/R output and their values remain after 
switching the unit off and then on.

These virtual output latched may be reset by a PLC setting as it is shown in the following figure

VIRTUAL INPUTS LATCHED VIRTUAL INPUTS SELF-RESET

LATCHED VIRT IP 1 SELF-RST VIRT IP 1

LATCHED VIRT IP 2 SELF-RST VIRT IP 2

… …

LATCHED VIRT IP 32 SELF-RST VIRT IP 32
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5.6  Remote comms
This settings allow configuring the remote comms settings for the IEC61850 protocol regarding GSSE. For more 
information see 7.3 IEC 61850 profile for C650.

SETPOINT > INPUTS/OUTPUTS > REMOTE COMMS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP  RANGE

Remote comms selection Remote Comms NONE N/A [NONE – GSSE – GOOSE]

SETTING DESCRIPTION FOR GSSE

Remote comms selection Remote Comms GSSE N/A [NONE – GSSE – GOOSE]

Device Identification 650 ID C650 N/A

Hold time signal send by the 
transmitting device

Hold Time 10000 1 ms [1000 : 60000]

Snapshot Events Generation Snapshot Events Remote Out DISABLED N/A [DISABLED – ENABLED]

Remote Device Description Remote Device X Remote Device X N/A

Bit Pair Selection Bit Pair X None N/A [DNA-1 to DNA-32 – UserSt-
1 to UserSt-64]

Default Value Selection Default Value X OFF N/A [OFF – ON – LATEST OFF – 
LATEST ON]

SETTING DESCRIPTION FOR GOOSE

Remote comms selection Remote Comms GOOSE N/A [NONE – GSSE – GOOSE]

Default Value Selection Default Value X OFF N/A [OFF – ON – LATEST OFF – 
LATEST ON]

Note: X is the Remote Device index, up to 32
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5.7  Testing

5.7.1  Force IO–input testing
The input testing can only be performed in relay with graphical display, see the human interfaces section in this manual for 
more detailed information.

5.7.2  Force IO–output testing
Output testing can be performed via HMI in models with graphical display and via communications through EnerVista 650 
Setup in all models.

Setpoint > Inputs/Outputs > Force Outputs

This menu allows activating each contact output in the relay, to facilitate maintenance testing. In the screen, the user can 
select the I/O board to be tested, and also select which output is to be forced (operated).

After selecting the desired output, clicking on the checkbox on the left, the user must click Force Output to activate the 
selected output.

In order to refresh the real status of outputs, according to the information received by the relay processor, click Refresh.

The following figure shows the output-testing screen:

Figure 5-20: Force IO
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5.8  Relay configuration

Setpoint > Relay Configuration

This is the relay configuration section in which the relay can be configured (all input/output and LEDs configuration, 
protection elements signals, graphic display configuration, etc.) using internal states or already compiled equation on PLC 
Editor (see section 5.9 Logic configuration (PLC editor)).

5.8.1  Outputs
Configuration of contact output operates and reset signals for all boards available in the device:

To configure any output it is necessary to select the output to be configured, clicking on the checkbox in the select column 
and choose the logic operand in the source column. Simple logics can be performed on this screen, using the “or” and “not” 
columns, for more complex logics go to the logic configuration tool to create the virtual outputs and afterwards select it in 
the source column.

The different options available in this screen are the following:

• Select checkbox enables each output. The output must be enabled before modifying any other setting on that output 

• Name setting for defining identification for the output. Note: nor the Output name, nor the Input name, nor the Virtual
Input name is recorded into the relay.

• Source setting for defining a function, logic, remote input, digital input, etc. that activates the contact.

• OR checkbox for configuring the output operation by activation of any of the indicated signals. The element performs
an OR of the signals, and its output produces operation.

• NOT checkbox for inverting or not the configured logic.

Figure 5-21: Output configuration
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5.8.2  LEDs
C650 has 15 LEDs fully configurable from any logical variable, contact or virtual input. For firmware version below 7.20, the 
first five are latched by hardware, the rest are self reset but can be latched through PLC Configuration. For firmware 
version 7.20 or higher, all these LEDs can be individually configured as latched or self-reset. This new setting is accessible 
from Setpoint > Relay Configuration > LED.

This window displays all relay LEDs with the following setting options for each one:

• Select checkbox enables each LED. The LED must be enabled before modifying any other setting on that LED 

• Name setting for defining identification for the LED

• Source setting defines which function; logic, remote input, digital input, etc. activates the LED. 

• OR checkbox for configuring the LED operation by activation of any of the indicated signals. The element performs an
OR of the signals, and its output produces operation.

• NOT checkbox for inverting or not the configured logic.

For firmware version 7.20 or higher, latched checkboxes are available for configuring the LEDs. If it is selected, LED shall 
work as latched, if it is deselected, LED shall work as self-reset.

From the LED configuration screen, it is possible to print the vertical LED label for the relay. For this purpose, click the 
printer icon. The label obtained is similar to the default factory label, with black background and the LED texts in white. This 
label can replace the original one under the black plastic cover. The label is also provided in word format and can be 
modified by the user (e.g. different color marking)

Figure 5-22: LED configuration
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5.8.3  Operations
This menu option shows the settings for the 24 control operations that can be programmed, as follows:

• Select checkbox enables the desired operation.

• Command Text setting defines the command name.

• Interlocks Type setting defines the desired interlock type (An interlock is a condition that must be fulfilled for an
operation to be performed). The possible options are Logic or None. If the LOGIC option is selected, the program
enables a new window for creating the logic. If the NONE option is selected, then the following setting (Interlocks) is
irrelevant.

• Interlocks setting define the desired interlocks. This setting is enabled selecting the “logic” option in “Interlock type”.
In the “Interlock logic” screen we can set the interlock logic, as shown on Figure 5-23: Operations and interlocks

The settings on this screen allow creating a logic configuration with up to 3 AND gates and 1 OR gate for each of the 
24 operations available in the relay. These settings are:

Select – Enables/disables the selection for the interlock input

Source – Selects a function, digital input, logic, etc. for defining each input of each AND gate. 

NOT – Logic inverter

Figure 5-23: Operations and interlocks

• Final State Type setting: defines whether the operation requires (in addition to the interlock logic) any other conditions
to determine a “success condition”. If so, we must select LOGIC. Otherwise, we must select NONE.

• Final State setting: defines the success condition of a programmed operation, if the previous setting (Final State type)
was set as LOGIC.

• Front Key setting: defines the front pushbutton from which the operation can be executed.

• Contact Input setting: defines whether the operation can be executed by digital input. It defines the digital input to be
used for this purpose.

• Virtual Output setting: defines whether the operation can be executed from a virtual output previously defined at the
logic configuration tool (PLC logic).
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• Time Out setting: defines the period during which the operation command will remain activated waiting for a success
condition. If the success signal is received before this period expires, the command signal will be removed and the
timer reset. If the success condition is not received within this period of time, the operation is considered to be
finished.

• COM1 (REMOTE) setting: defines whether the operation can be executed by communications through the rear port
COM1.

• COM2 (LOCAL) setting: defines whether the operation can be executed by communications through the rear port
COM2. We must note that this local port is the same as the front port. We can establish simultaneous communication
with the relay through ports COM1 and COM2. However, it is not possible to use rear COM2 and the front port
simultaneously.

• ETHER-MASTER setting: defines whether the operation can be executed by communications through the ETHERNET. It
must be taken into account that besides the master selection in the operations screen inside relay configuration, there
is a hardware selection (with the operation pushbutton in the front part of the relay) to switch between local (COM2
and HMI) and remote masters (COM1 and ETHERNET) for operations.The local-remote-off sequence can be also
available through communications selecting the signal to switch in Setpoint > Relay Configuration > Protection
Elements.

The following diagram shows an example of the operations internal logic.

Figure 5-24: Operation logic diagram
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5.8.3.1  Programming an operation

Example of how to program an operation to close a breaker with an operating time of 90 ms (closing), incorporating 52/b 
contacts to indicate the change of position, using an interlock logic to enable the operation if there is synchronism 
condition, and there is no autoreclose in progress. The operation must be commanded from the relay faceplate using one 
of the available operation push buttons.

To configure the related operation, go to Setpoint > Relay Configuration and select Operations tab.

This screen shows all the fields required for the operations configuration in the C650. In order to select an operation, click 
the operation name under the Select column, and all the related parameters are enabled. The chosen name for the 
operation is entered in Command Text. To configure an interlock logic, select the Logic option in Interlocks Type. Once this 
option has been selected, the interlock configuration screen is enabled. To display this screen, click Press for Logic for the 
desired operation on the Interlocks column. On this Interlocks screen, the two conditions that conform the Interlock that 
enables the operation have been selected. To save the interlock, click the disk icon on the toolbar. A Logic Saved displays. 

Once the Interlocks have been defined, the user must define the success conditions for the operation, define Final State 
Type as LOGIC, and a PRESS FOR LOGIC message lights up below Final States. When clicking PRESS FOR LOGIC, the 
success condition screen is displayed, defining there as BREAKER CLOSED.

The front key to be used for executing the Operation can be selected on the Frontal Key column, in this example the Key I 
option is selected on Frontal Key. As none of the other contact input or virtual output options are going to be used they are 
set to None. The success condition time Time out is set to 500 ms, and the operation is only enabled through the relay 
keypad, so only the MMI option is selected, thus disabling the rest of options (COM1, COM2, ETHERNET master are not 
selected). 

All the selections previously related are summarized in the following table:

Table 5-31: Operation settings 

Finally, configure a contact output to be activated with the programmed Operation (Operation1). 

OPERATION COMMAND TEXT SETTINGS VALUE/SOURCE

Operation1 CLOSE BREAKER INTERLOCK (LOGIC) SYNCHK CLOSE PERM

FINAL STATES (LOGIC) BREAKER CLOSED

FRONT KEY I Key

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS MMI
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This is done under Setpoint > Relay Configuration > Output, selecting an output and choosing the internal signal 
OPERATION BIT 1, which corresponds to the bit that is activated when the related operation is executed.

Figure 5-25: Contact output configuration

Note: Operations time out for confirmation

Configurable screen in graphical HMI: In the relay HMI the configurable objects wait one minute for confirmation after 
operation selection. The object is blinking for one minute. After that time, the object is deselected.

Front Keys: In operations performed by front keys, the time out for confirmation is 10 seconds.
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5.8.4  Control elements tab
This tab allows assigning operands (logic signals) as inputs to different control elements. This way, the user assigns which 
operands configure digital counters, etc. In this screen we can also configure a logic signal to perform the LED reset by 
communications.
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5.8.5  Oscillography
This menu is used for selecting the digital channels to be included in oscillography records, and the oscillo trigger signal. As 
for the above-described settings, the trigger selection can be any of the signals provided by the relay or a logic 
combination of these.

settings are described below:

• Select checkbox enables or disables a digital channel and the oscillography trigger.

• Name setting defines the name of the digital channel to be included in oscillography records.

• Source setting defines the source or signal to be recorded in that specific channel, which can be selected among all
the operands available in the signals menu.

• NOT checkbox inverts the enabled digital channel signal.

• OR checkbox to select a group of operands instead of a single one. The relay performs an OR of the signals, and its
output produces operation. 

Figure 5-26: Oscillography configuration

NOTE This screen is used for the configuration of digital channels and oscillography trigger. The rest of parameters, 
such as function enabling/disabling, sampling rate, number of oscillography files, etc. must be set on the 
Setpoint > Product Setup > Oscillography menu.
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5.8.6  Control events
This menu is used for defining the CONTROL EVENTS, up to 128 user programmable events.

A control event is a logic signal associated with an operand or combination of operands which monitories the change of 
status of the logic operand. The relay shows which events are active each time, as well as their date and time of activation.

There are 128 user programmable events and 64 pre-established events for switchgear, which correspond to opening, 
closing, Error00 and Error11 of the 16 programmable switchgear elements. (Refer to section 5.8.8 HMI (human-machine 
interface) for more detailed information).

As for the rest of previous settings, the source selection can be made between:

• An operand, selecting it directly on this screen.

• An OR of several operands, selecting directly the OR column in this same menu.

• A logic combination of operands, by selecting a VIRTUAL OUTPUT as trigger source, and using the logic configuration
available in the relay, graphical PLC, that allows to design logic circuits and to assign their outputs to internal
variables, called VIRTUAL OUTPUT.

Available settings are as follows:

• Select checkbox: enables or disables the generation of each event.

• Name setting: defines the text for each control event.

• Source setting defines the source that triggers the event. The source is chosen from the list that shows all the
operands available in the element. 

• NOT checkbox inverts the selected signal.

• OR checkbox to select a group of operands instead of a single one. The relay performs an OR of the signals, and its
output produces operation. 

• Alarm checkbox: allows treating the event as an alarm and making the event activation to be reported on the alarm
panel.

Figure 5-27: Control events configuration
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The Alarm panel can be displayed in:

HMI screen for models with graphical display.

EnerVista 650 Setup: Actual > Event Recorder > Alarm Panel for all models.

Web Server application: http://xxx. xxx. xxx. xxx /Alarms.htm for all models.

If the event is not selected as an alarm, it can be viewed as an event at:

HMI screen for all models in snapshot event screen (with default text).

EnerVista 650 Setup: Actual > Event Recorder > Control Events for all models.

Web Server application: http://xxx.xxx.xxx.xxx/ControlEvents.htm for all models.

Alarm management in C650:
The relay can manage alarms in from three different masters, local, remote COM1, remote Ethernet. The alarms can be 
active or not active and can be acknowledged or not acknowledged. As shown in the following table:

Table 5-32: Alarm management

ACTIVE status is shown on the display (relay HMI), showing an ON label on the right of the alarm. The PC shows the alarm 
text in red.

ACKNOWLEDGED: Operation acknowledgment can be performed from three independent channels: MMI-COM2 (local), 
COM1 (remote) and ETH_1/ETH2 or ETH_E/ETH_A/ETH_B (Ethernet). Inactive alarms disappear from the HMI when being 
acknowledged.

HMI: Acknowledged status is shown on the HMI with a selection mark on the right of the ON label. 

EnerVista 650 Setup: the acknowledged status is shown by a check mark to the left of the Operation name.

ALARM STATUS MASTER MANAGEMENT

ACTIVE - NOT ACTIVE ALL MASTERS

ACKNOWLEDGED - NOT ACKNOWLEDGED LOCAL REMOTE

COM2 & HMI COM1 ETHERNET
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5.8.7  Switchgear
This menu is used for defining the SWITCHGEAR elements to be controlled by the relay. A switchgear element can be a 
breaker, a line selector switch, a grounding selector switch, a busbar selector switch, etc. It is possible to define up to 16 
switchgear elements. The settings are as follows:

• Select checkbox: enables or disables the control of a new switchgear element

• Contacts setting: allows selecting which type of contact is used for monitoring the status (open/closed) of the
element. The selection can be: 52a (contact type A, showing the same status as the represented element), 52b
(opposite status to the represented element), 52a+52b (both types of contacts are used), NONE (no status monitoring).

• Opening Time setting: defines the maximum opening time of an element. It is used for issuing an opening time failure
signal if the element opening is not produced within this time. 

• Closing Time setting: defines the maximum closing time of an element. It is used for issuing a closing time failure
signal if the element closing is not produced within this time.

• Contact A checkbox: allows selecting which operand or combination of operands activate the type A contact status.
Usually it is an input contact wired to type A contact of the element (Breaker/selector switch). This column and the
next two columns are only active if the selected contact type in the Contacts column is 52a or 52a+52b.

• OR checkbox: selects a group of operands instead of a single one. The relay performs and OR of the signals, and its
output produces operation. 

• NOT checkbox inverts the status of the signal selected in column Contact A.

• Contact B checkbox: allows selecting which operand or combination of operands activates the type B contact status.
Usually it is an input contact wired to type B contact of the element (Breaker/selector switch). This column and the
next two columns are only active if the selected contact type in the Contacts column is 52b or 52a+52b.

•OR checkbox selects a group of operands instead of a single one. The relay performs OR of the signals, and its output
produces operation. 

•NOT checkbox inverts the status of the signal selected in column Contact B.

• Open text setting: allows associating a text to the control event associated with the element opening.

• Close text setting: allows associating a text to the control event associated with the element closing.

• Error 00 text setting: in case of using double contact for the switchgear element status (52a+52b), this setting allows
to associate a text to the Error00 internal status, this means, when both contacts are inactive during a period longer
than the associated with the opening or closing Operation, depending on which Operation is being performed. 

• Error 11 text setting: in case of using double contact for the switchgear element status (52a+52b), this setting allows
to associate a text to the Error11 internal status, this means, when both contacts are active during a period longer
than the associated with the opening or closing Operation, depending on which Operation is being performed. 

• ALARM setting: enables the issue of an alarm in the event of a close, open, 00-type, 11-type error. If it is configured as
an alarm. 

• Opening init setting: this setting selects which operand or combination of operands indicate the initiation of an
opening operation, in order to allow the follow up of the operation and generate the corresponding alarms if the
operation is not successful. The operation bit signal used to launch the opening init must be configured in the
operations tab inside relay configuration.

• Closing init setting: this setting selects which operand or combination of operands indicate the initiation of a closing
operation, in order to allow the follow up of the operation and generate the corresponding alarms if the operation is
not successful. The operation bit signal used to launch the closing init must be configured in the operations tab inside
relay configuration.

• Block Open : allow selecting which operand or combination of operands activates the opening blocks for the
switchgears (XSWI$ST$BlkOpn and XSWI$ST$BlkCls) for operating in 61850.

• Block Close settings: allow selecting which operand or combination of operands activates the closing blocks for the
switchgears (XSWI$ST$BlkOpn and XSWI$ST$BlkCls) for operating in 61850.
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Figure 5-28: Switchgear configuration

Note: when a switchgear device is only monitored (open init and closing init signals are not used), it is not possible to 
distinguish between the fail to open or fail to close time, the time used to give an error 00 or 11 signal is the maximum of 
the opening and closing time configured for that switchgear.
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5.8.8  HMI (human-machine interface)
This menu shows a scenario to draw a simplified one-line diagram of a bay in a feeder, line, transformer, etc. The menu 
includes a library for power elements, metering elements, text and drawings.

To use the drawing toolbar elements, select the desired element and then click the yellow area. The selected element is 
moved to the screen on the selected spot (see Figure 5-29: HMI configuration).

The graphic display can be used to configured switchgear elements, operations, metering values, date and time, etc. The 
configured values is always updated with the real status of the relay.

This functionality is only applicable to C650 elements with graphical display, and not for elements with alphanumerical 
display . Depending on the relay model, the graphical display can show IEC 1082-1 symbols (N option in order code).

Figure 5-29: HMI configuration

On the left side of the window all the available elements to be programmed on the HMI are displayed. Their meaning is 
detailed on the right.

Table 5-33: Active configurable symbols in on-line diagram for graphical HMI

ACTIVE SYMBOLS

ICONS IN SCREEN DESCRIPTION

SWITCHGEAR SYMBOLS STANDARD AND IEC 1082-1 SWITCHGEAR SYMBOLS

STANDARD SWITCHGEAR SYMBOLS M and C selection for graphic display option in the order code

Switchgear elements: breaker (square) and selector switch (rhombus), in 
vertical and horizontal positions.
It is necessary to associate the figure to its corresponding switchgear 
number. The figure is shown filled if the element is closed, and blank if the 
element is open. The symbol on the right represents an unpluggable breaker. 
In this case it is necessary to indicate which operands show whether the 
element is plugged or unplugged. The figure shows also graphically these 
two statuses.

IEC SWITCHGEAR SYMBOLS N and D selection for graphic display option in the order code
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Breakers and breaker trucks in vertical and horizontal positions.
The first fourth symbols are breakers in vertical and horizontal positions for 
left and right options. The last fourth symbols are breaker trucks or 
unpluggable breakers. When the device is connected two arrows can be 
seen, if the device is not connected only one arrow is displayed. When the 
device it is inserted the device can be seen and when it is not inserted only a 
blank space is displayed

Contactors in vertical and horizontal positions

Selector switches in vertical and horizontal positions.

OTHER CONFIGURABLE SYMBOLS Available for both M, N, C and D selection

MULTISTATE VARIABLE SYMBOL

Displays a dialog box on screen that is one variable status function (like a 
switch case) for the following internal states AR STATUS, AR LOCKOUT MODE, 
AR BLOCK MODE and FAULT TYPE.
This type of data allows to visualize the different states of one particular 
value, for example, AR STATUS has several states such as (0) OUT OF SERVICE, 
(1) READY, (2) LOCKOUT, (3) BLOCK, (4) RECLOSE IN PROGRESS. Significant texts 
can be associated with those states.

STATUS SYMBOLS (TEXT AND GRAPHIC MODES):

Bit: Represents the state of an operand by means of a configurable text. It 
allows associating a test to the active status and a different text to the 
inactive status.

Led(O) Performs the same function in a graphical mode. This way, it works as 
a virtual LED. When showing a black circle, it means that the selected 
operand is active, and if the circle is blank, the operand is inactive

ANALOG MAGNITUDE SYMBOL

Used for displaying analog magnitudes (current, voltage, power, etc.) in 
floating point numbers, such as a current value (123.5 A). Both the number of 
decimals and the integer characters can be selected, in order to facilitate the 
reading. Any of the analog magnitudes available in the relay can be 
configured.
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Table 5-34: GRAPHIC AND TEXT EDITION SYMBOLS 

ACTIVE SYMBOLS

ICONS IN SCREEN DESCRIPTION

DATE AND TIME SYMBOL
Display the date and time provided by the device in the HMI.

OPERATIONS SYMBOL
Configure and execute operations on the graphic display.
This symbol can only be selected once the operations have been configured 
in the Operations screen of the Relay Configuration menu. To select an 
Operation, click the element and then the display. A window opens to select 
the operation and the tab order. Once selected, a red border square is shown. 
Place this square on the object to operate. When the object is selected on the 
screen to execute this operation, the object on which it is located blinks. It is 
possible to place several operations on the same object, for example to open 
and close the breaker object. 

Configure and execute operations with the front keys "I" and "O" on the 
graphic display over an object selected.
To select the object, click the element and then the display. A window opens 
to select the required operations "I" and "O" and the tab order. Once selected, 
a blue border square is shown. Place this square on the object to operate. 
When the object is selected on the screen to execute these operations, the 
object on which it is located blinks. Press key "I" or "O" to execute the 
configured operations.

Configure and execute operations with the front keys "I", "O" and "*" on the 
graphic display over an object selected.
To select the object, click the element and then the display. A window opens 
to select the required operations "I", "O" and "*" and the tab order. Once 
selected, a green border square is shown. Place this square on the object to 
operate. When the object is selected on the screen to execute these 
operations, the object on which it is located blinks. Press key "I", "O" or "*" to 
execute the configured operations.
After executing this kind of operation, information about the result of the 
operation is displayed on the HMI..

Configure and execute virtual inputs with the frontal keys "I" and "O" on the 
graphic display over an object selected.
To select the object, click the element and then the display. A window opens 
to select the required virtual operations "I" and "O" and the tab order. Once 
selected, a white border square is shown. Place this square on the object to 
operate. When the object is selected on the screen to execute this virtual 
inputs, the object on which it is located blinks. Press key "I" or "O" to set the 
configured virtual inputs.

GRAPHIC AND TEXT EDITION SYMBOLS

ICONS IN SCREEN DESCRIPTION AVAILABILITY

Ground symbols in different positions. The first two are not available in the 
N model (IEC selection).

Voltage Transformers representation Only for standard model M.

Two and three winding voltage transformers 
representation.

Only for N model (IEC selection)
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EXTENDED GRAPHIC SYMBOLS

For the extended graphic symbols, extraction device must be set to 52a+52b switchgear device.

Table 5-35: GRAPHIC AND TEXT EDITION SYMBOLS

Current transformer representation Only for N model (IEC selection).

Symbols reserved for future uses Both M and N selection

Symbol for capacitor banks. Both M and N selection

Symbol for vertical capacitor banks. Only for N model (IEC selection).

Symbol for wye connection Both M and N selection

Symbol for open delta and delta connection Both M and N selection

Display of a fix text up to 40 ASCII characters Both M and N selection

Auxiliary drawing lines Both M and N selection

EXTENDED 
GRAPHIC AND TEXT EDITION SYMBOLS

ICONS IN 
SCREEN

DESCRIPTION AVAILABILITY

Breaker Only for N model (IEC selection)
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Breaker+Extraction device (Vertical) Only for N model (IEC selection)

Breaker+Extraction device (Horizontal) Only for N model (IEC selection)

Isolator Only for N model (IEC selection)

Isolator Remote controlled Only for N model (IEC selection)

Neutral Reactance Only for N model (IEC selection)

“Encravado” Interlocked Only for N model (IEC selection)

Autorecloser In Service/ Out of Service Only for N model (IEC selection)

“M”/”A” Symbol for Manual/Automatic Only for N model (IEC selection)

“Regime Especial Exploração” Only for N model (IEC selection)

Voltage transformer Only for N model (IEC selection)

Different Text properties (Bold/Vertical/Reverse 
Video)

Only for N model (IEC selection)
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5.8.9  Device display selection

5.8.9.1  Type of graphical display

On offline mode, when creating a new setting file (*.650), when entering on SETPOINT > RELAY CONFIGURATION > HMI, it is 
possible to choose the display type that is wanted to configure from two types of graphical displays depending on the 
order code. Green one for standard models and the black one for “N” model IEC selection.
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5.9  Logic configuration (PLC editor)
Setpoint > Logic Configuration

The logic configuration (or PLC Editor) tool is a graphical design tool that allows the C650 built complex logic diagram in an 
easy way using different logic functions.

The logical configuration is performed using graphical functions based on the IEC 61131-3 standard.

• This standard defines five basic ways of programming:

•Sequential Function Chart (SFC).

•Instruction List (IL).

•Structured Text (ST).

•Ladder Diagram (LD).

•Function Block Diagram (FBD).

Out of these five methods, FBD has been chosen because it allows for graphical configurations that are more 
comprehensive. This method provides the possibility of grouping several basic functions inside a single function (hereon 
called libraries), achieving higher modularity and clarity in the design.

5.9.1  Theory of operation

5.9.1.1  Description

As already mentioned in the introduction, this tool uses FBD mode of IEC 61131-3 standard. For this purpose we have 
defined a series of basic operations with illustrations below.

The basic operations available in the PLC Editor are located in the tool bar of the application and are as follows:

Table 5-36: PLC editor basic operation in C650

The first equation entered in the PLC can never be a timer

PLC EDITOR BASIC OPERATION 

ICONS IN 
SCREEN

DESCRIPTION

INPUT TO LOGIC: Selection of the digital input to the logic. (All available internal status can be used as logic inputs **)

OUTPUT FROM LOGIC: Virtual output built with internal logic. (Up to 512)

LIBRARY: Possibility to build blocks of logic in a simple graphic object. OR and AND from 3 to 8 inputs are provided as 
libraries.

AND of two digital inputs.

OR of two digital inputs.

NOT of a digital input.

NAND of two digital inputs.

XOR of two digital inputs.

SR: Latch (set-reset): reset dominant.

ONS: signal to pulse an logic input to a signal of one scan cycle length.
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For firmware 7.20 or above, analog operands are available. It is possible to use these operands with analog or digital 
values.

The basic operations available in PLC Editor are located in the tool bar of the application and are as follows:

**NOTE1: For firmware version 7.20 or above, two new inputs have been added; PLC_BOOL_ON and PLC_BOOL_OFF. These 
two inputs are set always to PLC_BOOL_ON =1 and PLC_BOOL_OFF =0 and their values are not accessible via protocol and 
cannot be modified.

Example of logic signals in C650 logic configuration:

Table 5-37: Logic signals in C650

TIMER: timer signal with set, reset and mask for timing.

TEXT LABEL: text to customize the logic configuration file.

Flip-Flop D: signal that maintains the actual value frozen during a PLC cycle

MASK: Time mask to be used in timing operations.

PLC EDITOR ANALOG OPERATION

ICONS IN 
SCREEN

DESCRIPTION

GREATER THAN COMPARATOR of two digital or analog inputs. 

EQUAL TO COMPARATOR of two digital or analog inputs

MULTIPLIER of two digital or analog inputs

DIVIDER of two digital or analog inputs

ADDER of two digital or analog inputs

SUBTRACTOR of two digital or analog inputs

LOGIC SIGNALS EXAMPLES

SIGNAL DESCRIPTION TIME DIAGRAM

SET When the input 
signal is set to 1 the 
output signal 
remain fixed to 1 
until a reset signal 
is received.

RESET When the input 
signal is reset to 1 
the output signal 
remain fixed to 0.

  1 

  0 

1 

  0 

   1 

   0 

1 
ut

   0 
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Example of analog operands in C650 logic configuration:

Table 5-38: Analog operands in C650

When this operand is used, Subtraction between two inputs is performed and result is stored into variable assigned to 
subtraction output.

ONS The input signal is 
pulsed. The width of 
the output pulse is 
the same as that of 
the PLC cycle

TIMER With selectable 
time (MASK), one 
SET input and one 
RESET input

ANALOG OPERANDS

Operands Example Description

GREATER THAN Analog Variables:
1.  If Pulse Cntr value 1 > Pulse Cntr value 2 

then Virtual output is set to 1
2.   If Pulse Cntr value 1 = Pulse Cntr value 2 

then Virtual output is set to 0
3.   If Pulse Cntr value 1 < Pulse Cntr value 2 

then Virtual output is set to 0

Digital Variables:
1.   If Latched Virtual input 1 =0 & Latched 

Virtual input 2 =0 then Virtual output is 
set to 0

2.   If Latched Virtual input 1 =1 & Latched 
Virtual input 2 =1 then Virtual output is 
set to 0

3.   If Latched Virtual input 1 =1 & Latched 
Virtual input 2 =0 then Virtual output is 
set to 1

4    If Latched Virtual input 1 =0 & Latched 
Virtual input 2 =1 then Virtual output is 
set to 0

1

   0 

1 
ut

   0

     1 
SET input 

     0 

     1 
RESET input 

     0 

     1 
Output

     0 
       T(ms) T1    T2  T1+T2=T
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EQUAL TO Analog Variables:
4.   If Vb Angle > Vc Angle then Virtual output 

is set to 0
5.   If Vb Angle = Vc Angle then Virtual output 

is set to 1
6.   If Vb Angle < Vc Angle then Virtual 

output is set to 0

Digital Variables:
5.   If Latched Virtual input 1 =0 & Latched 

Virtual input 2 =0 then Virtual output is 
set to 1

6.   If Latched Virtual input 1 =1 & Latched 
Virtual input 2 =1 then Virtual output is 
set to 1

7.   If Latched Virtual input 1 =1 & Latched 
Virtual input 2 =0 then Virtual output is 
set to 0

8.   If Latched Virtual input 1 =0 & Latched 
Virtual input 2 =1 then Virtual output is 
set to 0

MULTIPLIER Result of multiplication of both inputs is 
stored into variable assigned to Multiplier 
output

DIVISION Result of division of both inputs is stored 
into variable assigned to Division output.
If Input 2=0 Then result of division is stored 
as 0.

ADDITTION Result of multiplication of both inputs is 
stored into variable assigned to addition 
output

SUBTRACTION When this operand is used, Subtraction 
between two inputs is performed and result 
is stored into variable assigned to 
subtraction output.
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5.9.1.2  Logic compilation

The C650 configuration is made using the basic operations related before and more complex operations can be developed 
inside libraries.

All the graphical configuration performed in the Logic configuration editor must be read and interpreted by the PLC as the 
C650 engine. The graphical equations must be translated into compiled equations to be understood by the relay. For this 
purpose the logic configuration editor provides a compilation option to compile the whole configuration, creating a series 
of equations that forms the logical configuration of the element.

The next diagram shows the way compiled logic equations are built.

Figure 5-30: Compiled logic equations

A single equation is composed of one or more inputs, one or more operations, and one output. The order of equations is 
determined by the relative position of their outputs.

In the following example is shown the order of compilation for equations determined by their relative position in the 
configuration file:

Figure 5-31: Order of equations

In this case, equation A is the first to be executed. However, in the second case, the first equation to be executed would be 
B, as its output is before the Equation A output.

EQUATIONS 

PLC

PLC

DAT OPERATION

COMPILATION

EQUATION A EQUATION A OUTPUT 

EQUATION B EQUATION B OUTPUT 

EQUATION A EQUATION B OUTPUT 

EQUATION B EQUATION A OUTPUT 
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5.9.2  Main menu
The PLC Editor tool (Setpoint > Logic Configuration) provides a main menu with different submenus (File, Project, Edit, Run, 
View, and Window) that allows the user to built customized logic for the C650 devices. 

File menu

The FILE menu includes the following options:

New Project: Create a new project that includes the logic configuration files.

Open Project: Open an existing project.

Close Project: Close the currently open project.

Get Project from Relay: Retrieve a previously saved project from the relay.

Save Project and Save Project as: Save the open project.

Save Automatic Function &

Save Automatic Function As: Save the file of the active project.

Library: Give access to the library sub-menus, where new libraries can be created and 
existing libraries can be modified and saved.

Print: Print the active configuration file.

Preview: Preview of the document before printing.

Exit: Close all open projects and exit the application.

Project menu

The Project menu includes the following options:

Project Explorer: Display a tree structure showing all files contained in the project.

Insert library: Insert a library in the active automatic function.

Edit menu

The Edit menu includes the following options:

Undo: Undo the last modification in the active function.

Redo: Repeat the last modification.

Cut: Cut one or more logic operations.

Copy: Copy one or more logic operations.

Paste: Paste one or more logic operations.

Find: Search for a logic operation in the project.

Copy as Bitmap: Copy the active automatic function to the clipboard in picture format.

View Clipboard: Launch the clipboard viewer application.

Run menu

The RUN menu includes the following options:

Configuration: Not valid in the current application (for analog operations still not available).

Compile: Compile the configuration functions to generate the equations that are interpreted by 
the 650 PLC.

Send Equations to Relay 
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View menu

The VIEW menu includes the following options:

Log: Display the status name and time stamp of the digital statuses configured in the 
PLC logic (still not available).

Equations: Display the equations resulting from the compilation.

Grid: Show or hide the form grid where the configuration functions are developed. It 
also aligns the different objects to the grid.

Zoom: Allow selection of the percentage of zoom in the application.

Rectangle Zoom (Zoom rectangular): Allow zooming the selected rectangle.

5.9.3  Configuration generation

5.9.3.1  Create new project

Click File > New Project to open a new PLC project for programming the desired automation. An automation can be 
formed by one or more equations.

5.9.3.2  Create equation

A single equation can be formed by one or more inputs, one or more operations, and one output.

The order of equations is determined by the relative position of their respective outputs, this order being downward.

To link the output of an equation with the input of another equation, an internal variable (virtual output) must be used. 

The virtual output is used as an input to the second equation.

5.9.3.3  Add input to automation

Click the button that represents the inputs in the toolbar at the top of the screen. A logic input can be any of the available 
digital internal status provided by the relay. Such as protection status, contact inputs, contact outputs, I/O status, other 
protection status, front keys, LEDs, operation bits, virtual inputs and virtual outputs.

5.9.3.4  Add output to automation

Click the button that represents the outputs in the toolbar at the top of the screen. The logic outputs are virtual outputs (up 
to 512 configurable signals), virtual metering (up to float 32 signals, up to 50 int 32 signals) or virtual output latched (up to 
16 signals).

5.9.3.5  Add digital operation

Click any of the digital operations in the toolbar at the top of the screen, and then click the window background. A box with 
the selected digital operation is displayed and the inputs and outputs must be connected to the logic box as explained 
before.

5.9.3.6  Link inputs, outputs, and operations

The user can link the different graphic objects clicking on an object output and dragging to the input of another graphic 
object. Graphic objects available in the PLC configuration are digital objects.

There is a series of restrictions when performing connections:

It is not possible to auto-link an object; the output of a certain object cannot be linked to its input;

There can only be one input per object input;

RESET and SET outputs must be internal variables or outputs.
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We must take into account that as the timer is a digital operation that operates as an analog, there must only be a single 
internal variable or digital input in the timer input.

5.9.3.7  Add library

Click LIB and select the corresponding file.

Users can build their own libraries and distribute them in their projects in an easy way.

The manufacturer provides default libraries such as ORs, ANDs of 3 up to 8 inputs, besides timers (pickup-dropout) and key 
examples. 

5.9.4  Library generation
Libraries can contain a set of operations grouped in a single graphic object being formed by inputs, outputs and 
operations 

Working with libraries follows the same procedure as working in the main project menu, the only difference is that the 
inputs and outputs to the library must be selected as external inputs and outputs. The rest of variables are internal 
variables used in the logic compilation. 

The name assigned to the inputs and outputs of the library and to the library itself are used to represent the library as an 
object in the main project.

Internal variables inside the libraries are assigned randomly when compiling.

These libraries are saved in the LIB folder in order to be used in further projects

5.9.4.1  Library example

Go to the main menu File > Library > Open Library > New Library

Open a new library or modify an existing one, in this example a timer library is going to be displayed Timer (Pkp-Dpt).lib as 
shown on Figure 5-32: Timer (PKP-DPT).LIB configuratin example

Figure 5-32: Timer (PKP-DPT).LIB configuratin example
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Green and blue signals are internal inputs and outputs used in the library and are not going to be accessible to the user 
when working in the main menu outside the library environment. The white boxes (T_Input, T_Pickup, T_Dropout, T_output) 
are inputs and outputs to the library that are going to be accessible to the user to connect the library in the main 
application to create virtual outputs to be sent to the relay. 

Once the library is created and saved it can be selected in the main application menu in Project > Insert Library. The 
library has the following object:

Figure 5-33: Library object
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5.9.5  Application example
In this section a simple logic application is described step by step, a logic is such that keeping one digital input activated, 
several outputs are activated and deactivated in a time window (outputs remain activated for 200 ms and deactivated for 
5 ms). See the following figure:

Figure 5-34: Logic example

Go to the main menu and select File > New project, create a new project and select an input in the icons toolbar on the 
top of the window.  This input is selected as a digital input among the several options for inputs that can be selected. 
This input is the SET input for the first timer to launch the output activation signal. Click the icon related to the timer  to 
insert the timer on the project. The timer has three inputs (S=set, R=reset and T=timing input)

The reset signal of the first timer is a virtual output called output_deactivation that has been created as an output of 
another second timer. This signal is selected as an output  

The timing signal for the first timer is a mask provided by the application, in which the time in milliseconds must be entered 
in order to configure the timer time delay. 

After creating the first timer, the second one for output deactivation is made. The set signal is the virtual output created as 
an output of the first timer (VO_100_OUTPUT_ACTIVATION), the reset signal is the output of the second timer 
(VO_100_OUTPUT_DEACTIVATION), the time delay is set as 200 ms.

Once the timing logic (timer 1 + timer 2) has been created, the activation signal (VO_100_OUTPUT_ACTIVATION) is linked to 
several virtual outputs. Therefore, virtual outputs (VO_102_OUTPUT_1, VO_103_OUTPUT_2, VO_104_OUTPUT_3, 
VO_105_OUTPUT_4) are activated if the CONT IP_G_CC1(CC1) variable is set to 1. Once the VO_100_OUTPUT_ACTIVATION 
is active, it is deactivated after 200 ms, and remains deactivated for 5 seconds. This process is repeated while the digital 
input is active.

To finish the process the logic must be compiled (Run > Compile) and the equations sent to the relay (Run > Send 
Equations to relay) to start working with the new logic.
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5.10  IEC 61850 configuration
The 61850 Configuration option is only available if the C650 supports this protocol (6 in the order code for protocol 
selection) with firmware versions 3.44 or lower. For firmware versions 3.60 or higher ones, go to section 7.6 IEC 61850 
Configurator.

This menu is located in Setpoint > 61850 Configuration

The user can configure some 61850 parameters in the C650.icd file, and then send this file to the relay. The parameters 
that can be configured are:
Domain name parameters:

· IED Name

· LD Name from the Domain Name

Ethernet parameters:

· IP Address

· Subnet Mask

· Gateway

Figure 5-35: IED name and Ethernet parameter configuration
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Figure 5-36: LD name configuration

MMXU parameters:

The MMXU deadband settings represent the deadband values used to determine when updating the MMXU.mag. and 
.cVal. values from the associated .instmag. and .instcVal. values. 

The .mag. and .cVal. values are used for the IEC 61850 buffered and unbuffered reports. These settings correspond to the 
associated .db data items in the CF functional constraint of the MMXU logical node, as per the IEC 61850 standard. 
According to IEC 61850-7-3, the db values represent the percentage of difference between the maximum and the 
minimum in units of 0.00%. Thus, it is important to know the maximum value for each MMXU measured quantity, since this 
represents the 100.00% value for the deadband. The minimum value for all quantities is 0; the maximum values are as 
follows:

A value of 1000 represent the 1% of the scale.

The minimum and maximum main values (secondary) are:

-For Current 0 to 160 A

-For Voltage 0 to 300 V

-For frequency 0 to 70 Hz

Figure 5-37: MMXU deadband setting configuration
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C650 Bay Controller & Monitoring System

Chapter 6:  Actual values

GE
Grid Solutions

ACTUAL VALUES

6.1  Front panel
The menu bar in the main screen of EnerVista 650 Setup software shows the ACTUAL menu option. This option 
concentrates and displays all status of protection, control elements, metering, counters information, oscillography, events, 
fault locator, etc. This menu is divided in several sub menus that are detailed in the following sections.

6.1.1  LEDs
Operation of the relay front LEDs is shown on the following figure (Actual > Front Panel > LEDs) by the lighting of the 
associated LED in the appropriate color. The Ready LED is green when the relay is in service. LEDs 1 to 5 light up in red 
when active, LEDs 6 to 10 light up in orange, and the last 5 LEDs light up in green. 

The first five LEDs are latched by hardware and can only be reset by a LEDs RESET Command, either pressing the “esc” key 
on the Front of the Relay, or by Communications using the appropriate signal. The rest of the LEDs are not latched, but can 
be latched by logic. 

Table 6-1: Front panel LEDs
LEDS

READY LED

LED 1

LED 2

LED 3

LED 4

LED 5

LED 6

LED 7

LED 8

LED 9

LED 10

LED 11

LED 12

LED 13

LED 14
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6.2  Status

6.2.1  Operation bits status
(Actual > Status > Operation bits)

OPERATION BIT 1...24 These 24 bits are the outputs of each possible Operation modules, programmed in menu 
Setpoint > Relay Configuration > Operations. The light up LED indicates their status 1 
(activation) 

6.2.2  Breaker status
The signals associated with the opened or closed status of the breaker can be monitored at Actual > Status > Breaker

BREAKER OPEN: Open breaker status. In the switchgear selected as breaker, besides providing the usual 
switchgear contact status, the system provides also the open breaker, closed breaker, and 
undefined breaker states.

BREAKER CLOSED: Breaker closed.

BREAKER UNDEFINED: If there are two digital inputs configured for breaker contacts 52/a and 52/b, this status is 
present when both inputs are at 0 or at 1. This status can be caused by a wiring failure, failure of 
auxiliary elements, etc.

LED 15

LOCAL OPERATION MODE

OPERATIONS BLOCKED

ST HMI BACKLIGHT

OPERATION BITS

OPERATION BIT 1

OPERATION BIT 2

…

OPERATION BIT 24

BREAKER STATUS

BREAKER OPEN

BREAKER CLOSED

BREAKER UNDEFINED
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6.2.3  Control element status

6.2.3.1  Synchrocheck

This screen can be accessed at Actual > Status > Control Elements > Synchrocheck, and it includes the following 
signaling LEDs for the synchronism check function:

Table 6-2: Synchrocheck actual values

Synchrocheck BLK INP: Block signal for the synchrocheck unit, configurable at Setpoint > Relay 
Configuration > Protection Elements

Synchrocheck OP: Closing permission signal in live line-live bus conditions with open breaker.

SYNCHK CLOSE PERM: General Closing permission of the Synchronism unit. It contemplates all possible 
situations, live line-live bus conditions, and the closing permission logics (dead line-
dead bus, live line- dead bus, dead line-live bus). Note: in case the Function is disabled, 
the Closing permission signal is activated in order not to interfere with possible logics 
where it is included. If the synchronism unit is enabled, this signal only activates under 
the closing conditions established by setting.

Synchrocheck COND OP: Closing permission according to permission logics (DL-DB, LL-DB, DL-LB).

DL-DB OPERATION: Closing permission in dead line – dead bus condition.

DL-LB OPERATION: Closing permission in dead line – live bus condition.

LL-DB OPERATION: Closing permission in live line – dead bus condition.

SLIP CONDITION: Internal signal indicating frequency slip between the line voltage and bus voltage 
phasors.

BUS FREQ > LINE FREQ: Busbar Frequency higher than line frequency 

BUS FREQ < LINE FREQ: Busbar Frequency lower than line frequency

VOLTAGE DIFFERENCE: Voltage difference between the line and the busbar in volts (secondary values), only 
available if the Synchrocheck element is enabled.

FREQ. DIFFERENCE: Frequency difference between the line and the busbar in Hz, only available if the 
Synchrocheck element is enabled.

SYNCHROCHECK ACTUAL VALUES

Synchrocheck BLK INP

Synchrocheck OP

SYNCHK CLOSE PERM

Synchrocheck COND OP

DL-DB OPERATION

DL-LB OPERATION

LL-DB OPERATION

SLIP CONDITION

BUS FREQ > LINE FREQ

BUS FREQ < LINE FREQ

VOLTAGE DIFFERENCE

FREQUENCY DIFFERENCE
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6.2.3.2  Autoreclose

This screen can be accessed at Actual > Status > Control Elements > Autoreclose, and it includes the following signaling 
LEDs for the Autoreclose function:

Table 6-3: Autoreclose actual values

The AUTORECLOSE INPUTS are signal configurable by the user at Setpoint > Relay Configuration > Protection Elements 
to:

AR LEVEL BLOCK: programmable signal to block the autoreclose unit by level

AR PULSE BLOCK: programmable signal to block the autoreclose unit by pulse

AR PULSE UNBLOCK: programmable signal to unblock the autoreclose unit by pulse

AR INITIATE: programmable signal to initiate the autoreclose.

AR CONDS INPUT: programmable signal to set the conditions to be met before executing a breaker close.

The AUTORECLOSE INTERNAL STATUS are internal signals provided by the autoreclose unit:

AR CLOSE BREAKER: Breaker close command given by the autoreclose

AR OUT OF SERVICE: Autoreclose out of service (Disabled)

AR READY: Autoreclose in service

AR LOCKOUT: Autoreclose in lockout status (finished cycled-definite trip)

AUTORECLOSE INPUTS

AR LEVEL BLOCK

AR PULSE BLOCK

AR PULSE UNBLOCK

AR INITIATE

AR CONDS INPUT

AUTORECLOSE INTERNAL STATUS

AR CLOSE BREAKER

AR OUT OF SERVICE

AR READY

AR LOCKOUT

AR BLOCK

AR RCL IN PROGRESS

AR LCK BY ANOMALY

AR LCK BY FAIL OPEN

AR LCK BY FAIL CLOSE

AR LCK BY USER

AR LCK BY CONDS

AR LCK BY TRIPS

AR LCK BY SHOTS

AR BLK AFTER 1 SHOT

AR BLK AFTER 2 SHOT

AR BLK AFTER 3 SHOT

AR BLK AFTER 4 SHOT

AR BLOCK BY LEVEL

AR BLOCK BY PULSE

AR STATUS

AR LOCKOUT MODE

AR BLOCK MODE

AUTORECST_61850
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AR BLOCK: Autoreclose blocked (by input, logic, others, etc).

AR RCL IN PROGRESS: Cycle in course (autoreclose in progress).

AR LCK BY ANOMALY: Autoreclose in “Lockout” by anomaly.

AR LCK BY FAIL OPEN: Autoreclose in “Lockout” by a failure in opening the breaker.

AR LCK BY FAIL CLOSE: Autoreclose in “Lockout” by a failure in closing the breaker.

AR LCK BY USER: Autoreclose in “Lockout” by manual close.

AR LCK BY CONDS: Autoreclose in “Lockout” by conditions. See input conditions configuration.

AR LCK BY TRIPS: Autoreclose in “Lockout” by maximum number of trips.

AR LCK BY SHOTS: Autoreclose in “Lockout” at the end of cycle – Definite trip.

AR BLK AFTER 1 SHOT: Signal sent by the autoreclose after the 1st shot.

AR BLK AFTER 2 SHOT: Signal sent by the autoreclose after the 2nd shot.

AR BLK AFTER 3 SHOT: Signal sent by the autoreclose after the 3rd shot.

AR BLK AFTER 4 SHOT: Signal sent by the autoreclose after the 4th shot.

AR BLOCK BY LEVEL: Autoreclose blocked by level. See AR block signals configuration

AR BLOCK BY PULSE: Autoreclose blocked by pulse. See AR block signals configuration

AR STATUS: Autoreclose status (in service – out of service)

AR LOCKOUT MODE: Relay “Lockout” status. 

AR BLOCK MODE: Relay “Block” status

AutoRecSt_61850: Autorecloser status sent in IEC 61850. This value represent whether or not the auto reclosing is ready, in 
progress or successful. It is an enumerate type whose values are defined in IEC 61850-7-4 Edition 2.0 standard and it is 
available 

6.2.3.3  Pulse counters

C650 units incorporate eight pulse counters. For each of them there are two magnitudes: the actual value and the freeze 
value.

This screen shows the activation of all pulse counters available in the C650. It can be accessed from the menu:

Actual > Status > Control Elements > Pulse counters, and it includes the following values.

Table 6-4: Pulse counter actual values

PULSE COUNTERS ACTUAL VALUES

CntPulses Value 1

CntPulses Value 2

CntPulses Value 3

CntPulses Value 4

CntPulses Value 5

CntPulses Value 6

CntPulses Value 7

CntPulses Value 8

CntPulses Freeze 1

CntPulses Freeze 2

CntPulses Freeze 3

CntPulses Freeze 4

CntPulses Freeze 5

CntPulses Freeze 6
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6.2.3.4  Analog comparators

C650 units incorporate 20 analog comparators. This screen can be accessed from the menu:

Actual > Status > Control Elements >Analog Comparators and it includes the following signaling LEDs showing the ON/
OFF status of the analog level.

Table 6-5:  Analog comparators actual values

6.2.3.5  Digital counters

This screen can be accessed at Actual > Status > Control Elements > Digital Counters, and it includes 24 LEDs for the 8 
Digital Counters status, indicating which status is activate (HI, LO or EQ).

 

Table 6-6: Digital counter actual values

 

CntPulses Freeze 7

CntPulses Freeze 8

Cnt Pulses Freeze

Cnt Pulses Unfreeze

Cnt Pulses Reset

ANALOG COMPARATORS ACTUAL VALUES

Analog Level 01

Analog Level 02

Analog Level 03

Analog Level 04

Analog Level 05

Analog Level 06

Analog Level 07

Analog Level 08

Analog Level 09

Analog Level 10

Analog Level 11

Analog Level 12

Analog Level 13

Analog Level 14

Analog Level 15

Analog Level 16

Analog Level 17

Analog Level 18

Analog Level 19

Analog Level 20

DIGITAL COUNTERS ACTUAL 
VALUES

DIGCNT 1 HI

DIGCNT 2 HI

DIGCNT 3 HI

DIGCNT 4 HI

DIGCNT 5 HI
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For each of the 8 digital counters, there exist independent and identical groups of actual values:

 

• DIGCNT # HI [OFF: ON]: If this bit is activated, the counter value DIGCNT # VALUE is greater than the setting DigCNt 
#Compare value.

• DIGCNT # EQ [OFF: ON]: If this bit is activated, the counter value DIGCNT # VALUE is equal than the setting DigCNt 
#Compare value.

DIGCNT 6 HI

DIGCNT 7 HI

DIGCNT 8 HI

DIGCNT 1 EQ

DIGCNT 2 EQ

DIGCNT 3 EQ

DIGCNT 4 EQ

DIGCNT 5 EQ

DIGCNT 6 EQ

DIGCNT 7 EQ

DIGCNT 8 EQ

DIGCNT 1 LO

DIGCNT 2 LO

DIGCNT 3 LO

DIGCNT 4 LO

DIGCNT 5 LO

DIGCNT 6 LO

DIGCNT 7 LO

DIGCNT 8 LO

DIGCNT 1 VALUE

DIGCNT 2 VALUE

DIGCNT 3 VALUE

DIGCNT 4 VALUE

DIGCNT 5 VALUE

DIGCNT 6 VALUE

DIGCNT 7 VALUE

DIGCNT 8 VALUE

DIGCNT 1 FROZENVALUE

DIGCNT 2 FROZENVALUE

DIGCNT 3 FROZENVALUE

DIGCNT 4 FROZENVALUE

DIGCNT 5 FROZENVALUE

DIGCNT 6 FROZENVALUE

DIGCNT 7 FROZENVALUE

DIGCNT 8 FROZENVALUE

DIGCNT 1 FROZENDATE

DIGCNT 2 FROZENDATE

DIGCNT 3 FROZENDATE

DIGCNT 4 FROZENDATE

DIGCNT 5 FROZENDATE

DIGCNT 6 FROZENDATE

DIGCNT 7 FROZENDATE

DIGCNT 8 FROZENDATE



6-8 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

6.2 STATUS CHAPTER 6:  ACTUAL VALUES

• DIGCNT # LO [OFF: ON]: If this bit is activated, the counter value DIGCNT # VALUE is lower than the setting DigCNt 
#Compare value.

(These 3 previous states are mutually exclusive: only one can be ON at the same time. If the counter is Disabled, the 3 of 
them are OFF.)

• DIGCNT # VALUE [-2,147,483,648 : 2,147,483,647]: The specified counter current value.

• DIGCNT # FROZENVALUE [-2,147,483,648 : 2,147,483,647]: The specified counter last captured (frozen) value.

• DIGCNT # FROZENDATE [Valid date]: The specified counter last captured (frozen) date.

6.2.4  Protection & control status summary
Actual > Status > Protection Summary 

This screen shows a complete listing of all protection and control elements in the relay, showing their status (enabled or 
not) through the corresponding LED. 

6.2.5  Snapshot event summary
Actual > Status > Snapshot Event Summary

The C650 provides via setting the possibility to enable or disable the snapshot event generation in the different functions 
available in the device. 

This screen shows a complete listing of the snapshot event generation for all the protection, control and inputs/outputs 
elements in the relay, showing their status (enabled or not) through the corresponding LED.

6.2.6  MODBUS user map
The ModBus User Map consists of a selection of the most important 256 records in the complete ModBus Map regarding 
the application. By selecting these records and defining the user map appropriately, it is possible to read all the 
information included by a single ModBus reading operation, optimizing the refresh time.

This screen can be accessed at Actual > Status > ModBus User Map, and it includes all the readings for the previously 
configured records in the ModBus memory map.

Table 6-7:  MODBUS user map actual values
MODBUS USER MAP 

Address 00

Address 01

…

Address 255
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6.2.7  Switchgear status
Actual > Status > Switchgear Status

For a better understanding of the represented statuses in this screen, figure 6.1 shows the available “Switchgear” modules 
to be programmed in the C650. Each of them has a series of inputs/outputs that are the statuses represented on this 
screen. Separate signal for each switchgear device (for 1 to 16).

Each Switchgear module can be programmed at: Setpoint > Relay Configuration > Switchgear, and its statuses are as 
follows:

Table 6-8: Switchgear status

SWITCH X A INPUT The LED lights up when the input associated with switchgear Contact A is activated.

SWITCH X B INPUT The LED lights up when the input associated with switchgear Contact B is activated.

SWITCH X A STATUS Status associated with Switchgear contact A. It is activated once the time required for the 
Switchgear module to acknowledge contact A has expired.

SWITCH X B STATUS Status associated with Switchgear contact B. It is activated once the time required for the 
Switchgear module to acknowledge contact B has expired.

SWITCH X OPEN Lights up when the associated switchgear is open

SWITCH X CLOSED Lights up when the associated switchgear is closed

SWITCH X 00_ERROR Output that represents the Switchgear status 00, considered as abnormal.

SWITCH X 11_ERROR Output that represents the Switchgear status 11, considered as abnormal.

SWITCH X OPEN INIT Programmable input that indicates the initiation of the Opening Operation for the considered 
switchgear.

SWITCH X CLOSE INIT Programmable input that indicates the initiation of the closing Operation for the considered 
switchgear.

SWGR X FAIL TO OPEN Output that represents a failure to open, from the associated external device (opening time 
exceeded) 

SWGR X FAIL TO CLOSE Output that represents a failure to close from the associated external device (closing time 
exceeded) 

SWITCHGEAR 1 STATUS SWITCHGEAR X STATUS SWITCHGEAR 16 STATUS

SWITCH 1 A INPUT … SWITCH X A INPUT … SWITCH 16 A INPUT

SWITCH 1 B INPUT … SWITCH X B INPUT … SWITCH 16 B INPUT

SWITCH 1 A STATUS … SWITCH X A STATUS … SWITCH 16 A STATUS

SWITCH 1 B STATUS … SWITCH X B STATUS … SWITCH 16 B STATUS

SWITCH 1 OPEN … SWITCH X OPEN … SWITCH 16 OPEN

SWITCH 1 CLOSED … SWITCH X CLOSED … SWITCH 16 CLOSED

SWITCH 1 00_ERROR … SWITCH X 00_ERROR … SWITCH 16 00_ERROR

SWITCH 1 11_ERROR … SWITCH X 11_ERROR … SWITCH 16 11_ERROR

SWITCH 1 OPEN INIT … SWITCH X OPEN INIT … SWITCH 16 OPEN INIT

SWITCH 1 CLOSE INIT … SWITCH X CLOSE INIT … SWITCH 16 CLOSE INIT

SWGR 1 FAIL TO OPEN … SWGR X FAIL TO OPEN … SWGR 16 FAIL TO OPEN

SWGR 1 FAIL TO CLOSE … SWGR X FAIL TO CLOSE … SWGR 16 FAIL TO CLOSE
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See the following figure:

Figure 6-1: Switchgear contacts

6.2.8  Calibration status
This screen can be accessed at Actual > Status > Calibration, and it includes the internal calibration status for the relay.

Table 6-9: Calibration status

FACTORY CALIBRATION:   This value is active when the relay calibration settings are the default values (no calibration).

CALIBRATION ERROR: Error shown when there is a problem in the calibration settings (wrong values).

CALIBRATION DATE: This value is showing date when relay was calibrated.

CALIBRATION

FACTORY CALIBRATION

CALIBRATION ERROR

CALIBRATION DATE

SWGR X FAIL TO OPEN 

SWGR X FAIL TO CLOSE 

SWITCH X OPEN 
INIT

SWITCH X CLOSE 
INIT

SWITCH X B 
INPUT 

SWITCH X A STATUS SWITCH X A 
INPUT

SWITCH X B STATUS 

SWITCH X OPEN

SWITCH X 
CLOSED

SWITCH X 
00_ERROR

SWITCH X 
11_ERROR

Switchgear logic 
module
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6.2.9  System info
This screen can be accessed at Actual > Status > System Info. It can monitor the system parameters and the internal status 
of the Relay operating system.

Form firmware version prior to 7.00, System Info pop-up window shows general system information as described in the 
table below:

Table 6-10: System info for firmware versions below 7.00

• E2PROM status: LED associated lights in green if E2PROM is configured and working properly

• DSP comm error: LED associated lights in green if communication error between DSP and main processor.

• Magnetic module error: LED associated lights in green if communication error between DSP and magnetic module.

SYSTEM INFO

E2PROM STATUS

DSP COMM ERROR

MAGNETIC MODULE ERROR

Green Zone

Yellow Zone

Orange Zone

Red Zone

Kswapd Time

mtd2 Time

mtd2 Time

CPU Rtai

CPU Linux

Total RAM

Used DRAM

Free RAM

Shared RAM

Buffer RAM

Chached RAM

Green Counter

Yellow Counter

Orange Counter

Red Counter

Up Time

DSP Counter

ICD Status

MAC Address

Serial Number

Manufacturer date
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• Green/Yellow/Orange/Red Zones and Counters: 
These 4 counters are referred to the total amount of free RAM available in the device. The
usual state should be Green zone and the rest of indicators means that the device can
have or stop some task just in case that they would need to prioritize the protection task.

• Kswapd Time: It should take value always to 0

• Mtd2 Time: Time accessing to this partition with Linux OS

• Mtd3 Time: Time accessing to this partition with Application

• CPU Rtai: Percentage corresponding to protection tasks execution

• CPU Linux: Percentage corresponding to rest of Linux tasks execution

• Total RAM: Total RAM in the device

• Used DRAM: Used RAM in the device

• Free RAM: Available RAM in the device

• Chached RAM: Memory reserved for the Linux OS

• Up Time: Second from the last power-up

• DSP Counter: It shows that DSP is running

• ICD Status: Information about status of ICD file stored in the C650. For detailed information go to
Chapter 7, section 7.3.2.2 IEC 61850 CONFIGURATOR FEATURES FOR CONFIGURATION

• MAC address: MAC address assigned to Ethernet ports, Eth_1 and Eth_2. 

• Serial number: Serial number of the relay that is communicating with EnerVista 650 Setup.

• Manufacturing date: Date when the relay, connected to EnerVista 650 Setup, was assembled.

Table 6-11: System info for firmware versions 7.00 and above

SYSTEM INFO

E2PROM STATUS

DSP COMM ERROR

MAGNETIC MODULE ERROR

PLC ERROR

NET CONF ERROR

ORDER CODE ERROR

Total RAM

Used DRAM

Free RAM

Up Time

DSP Counter

CPU Usage

ICD Status

ICD Status NOTVAL

DSP Status

FLASH Usage

KINETICS Usage

CPU Max Usage

Temp Current Value

Temp Max Value
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• E2PROM Status: LED associated lights in green if E2PROM is configured and working properly

• DSP COMM ERROR: LED associated lights in green if communication error between DSP and main
processor.

• Magnetic module error: LED associated lights in green if communication error between DSP and magnetic
module.

• Plc error: PLC equations sent to the relay have an error or are incorrect.

• Net conf error: Network configuration is incorrect

• Order code error: Order code and hardware configuration do not match

• Total RAM: Total RAM in the device

• Used DRAM: Used RAM in the device

• Free RAM: Available RAM in the device

• UpTime: DSP heartbeat

• DSP Counter: Percentage of CPU in use

• CPU Usage: Percentage of CPU in use

• ICD Status: Information about status of ICD file stored in the C650. For detailed information go to
Chapter 7, section 7.3.2.2 IEC 61850 CONFIGURATOR FEATURES FOR CONFIGURATION

• ICD Status NotVal: Information about validation of new ICD after being sent into the relay. For detailed
information go to Chapter 7, section 7.3.2.2 IEC 61850 CONFIGURATOR FEATURES FOR
CONFIGURATION

• Dsp Status:  Internal status of the DSP

• Flash Usage: FLASH memory in use

• KINETIS Status: Kinetis working mode

• CPU MAX Usage: Maximum measured CPU usage

• Temp Current Value: Current temperature of CPU. This value is displayed in Celsius units.

• Temp Max Value: Maximum temperature reached by CPU during operating mode. This value is reset
This value is taken into account from last reboot.

• Temp Min Value:  Maximum temperature reached by CPU after last reboot.

• Scan Cycle Average: Mean time in nanoseconds that takes a Scan cycle to run

• Scan Cycle Rate: Every milliseconds a Scan cycle is run

• PLC Checksum: Value of CRC of PLC equations. This value is read from the relay.

• Settings checksum: Value of CRC of relay settings. This value is read from the relay.

• MAC address: MAC address assigned to Ethernet port, Eth_E. 

• Serial number: Serial number of the relay that is communicating with EnerVista 650 Setup.

• Manufacturing date: Date when the relay, connected to EnerVista 650 Setup, was assembled.

Temp Min Value

Scan Cycle Average

Scan Cycle Rate

PLC Checksum

Settings Checksum

MAC Address

Serial Number

Manufacturer date
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6.2.10  Record status
This screen shows part of the information related to the different records stored in the Relay, such as:

6.2.10.1  Control events

Actual > Status > Records Status > Control Events

In this screen Actual > Status > Records Status > Control Events, the status of the signals configured to launch the 
control events can be seen, activated or not.

The C650 provides the possibility to configure 128 control events (at Settings > Relay Configuration > Control Events). In 
the Actual > Records > Event Recorder > Control Events it is possible to see and retrieve the recorded control events to a 
file, seeing the text and date and time and status of the preconfigured control event. 

Table 6-12:  Control event status

6.2.10.2  Oscillography

Actual > Status > Records Status > Oscillography

The following figure shows the status of the different digital channels that can be programmed to be included in 
oscillography records. When the signal associated with a specific channel is active, its LED lights up on this screen.

This screen also shows the oscillography trigger status, active or inactive, by lighting up that channel.

Table 6-13: Oscillography status

The last three values shown are as follows: 

NUMBER OF TRIGGERS: This is the number of the last oscillography record obtained in the relay. This value has a range 
of 0 to 999.

CONTROL EVENTS

CONTROL EVENT 1

CONTROL EVENT 2

…

CONTROL EVENT 128

OSCILLOGRAPHY

OSC DIG CHANNEL 1

OSC DIG CHANNEL 2

OSC DIG CHANNEL 3

OSC DIG CHANNEL 4

OSC DIG CHANNEL 5

OSC DIG CHANNEL 6

OSC DIG CHANNEL 7

OSC DIG CHANNEL 8

OSC DIG CHANNEL 9

OSC DIG CHANNEL 10

OSC DIG CHANNEL 11

OSC DIG CHANNEL 12

OSC DIG CHANNEL 13

OSC DIG CHANNEL 14

OSC DIG CHANNEL 15

OSC DIG CHANNEL 16

OSCILLO TRIGGER

NUMBER OF TRIGGERS

CYCLES PER RECORD

AVAILABLE RECORDS
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CYCLES PER RECORD: This is the number of cycles contained in the oscillography record; this value depends on the 
settings adjusted on the oscillography menu at Setpoint > Product Setup > Oscillography.

AVAILABLE RECORDS: This is the number of available oscillography records in the relay.

Values for these last 3 fields are reset every time the oscillography settings are modified.

6.2.10.3  Data logger

Actual > Status > Records Status > Data Logger

Table 6-14:  Data logger status

OLDEST SAMPLE TIME: Date and time of the oldest value stored in the data logger.

NEWEST SAMPLE TIME: Date and time of the most recent value stored in the data logger

DATA LOGGER CHANNELS: Number of channels configured in the data logger

DATA LOGGER DAYS: Time in days during which, samples are stored without overwriting them.

6.2.10.4  Demand

Actual > Status > Records Status > Demand

Table 6-15: Demand status

DEMAND TRIGGER INP: Signal used for triggering the demand in the case of Rolling demand.

DEMAND RESET INP: Signal to reset the demand.

These signals can be configured at Setpoint > Relay Configuration > Protection Elements

6.2.10.5  Energy

Freeze/Unfreeze/Reset Energy: These signals correspond to the relay energy counters statuses of freeze, unfreeze and 
reset.

Actual > Status > Records Status > Energy

Table 6-16: Energy status

FREEZE ENERGY CNT: Signal used to freeze the energy counters for measurement purposes.

UNFREEZE ENERGY CNT: Signal used to unfreeze the energy counters.

RESET ENERGY CNT: Signal to reset the energy measurements and set the values to zero.

These signals can be configured at Setpoint > Relay Configuration > Protection Elements

DATA LOGGER

OLDEST SAMPLE TIME

NEWEST SAMPLE TIME

DATA LOGGER CHANNELS

DATA LOGGER DAYS

DEMAND 

DEMAND TRIGGER INP

DEMAND RESET INP

ENERGY

FREEZE ENERGY CNT

UNFREEZE ENERGY CNT

RESET ENERGY CNT
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6.2.10.6  Breaker maintenance

Actual > Status > Records Status > Breaker Maintenance

This screen shows the breaker status related to breaker maintenance. Other statuses are provided in the different 
switchgear or breaker status signals.

Table 6-17: Breaker maintenance status

The breaker maintenance inputs are signals that can be configured at Setpoint > Relay Configuration > Protection 
Elements:

RESET KI2t COUNTERS Signal to reset and set to zero all the KI2t counters (for all phases)

RESET BKR COUNTERS Signal to reset and set to zero all the breaker counters (number of openings and closings 
and alarms)

KI2t PHASE A ALARM Alarm signal for maximum breaking capacity in phase A exceeded

KI2t PHASE B ALARM Alarm signal for maximum breaking capacity in phase B exceeded

KI2t PHASE C ALARM Alarm signal for maximum breaking capacity in phase C exceeded

BKR OPENINGS ALARM Alarm related to the maximum number of breaker openings

BKR OPEN 1 HOUR ALARM Alarm related to the maximum number of breaker openings in one hour

BREAKER OPENINGS Counter of the total number of openings performed by the breaker 

BREAKER CLOSINGS Counter of the total number of closings performed by the breaker

KI2t PHASE A kI2t phase A counter (total accumulative breaking level – phase A)

KI2t PHASE B kI2t phase B counter (total accumulative breaking level – phase B)

KI2t PHASE C kI2t phase C counter (total accumulative breaking level – phase C)

BKR OPENING TIME Time to set a failure in opening the breaker. 

BKR CLOSING TIME Time to set a failure in closing the breaker.

BKR OPEN TIMING Exact time in opening the breaker

BKR CLOSE TIMING Exact time in closing the breaker

Breaker opening and closing time signals are configured at Setpoint > Relay Configuration > Switchgear for the related 
switchgear device.

BREAKER MAINTENANCE INPUTS

RESET KI2t COUNTERS

RESET BKR COUNTERS

BREAKER MAINTENANCE STATUS

KI2t PHASE A ALARM

KI2t PHASE B ALARM

KI2t PHASE C ALARM

BKR OPENINGS ALARM

BKR OPEN 1 HOUR ALARM

BREAKER OPENINGS

BREAKER CLOSINGS

KI2t PHASE A

KI2t PHASE B

KI2t PHASE C

BKR OPENING TIME

BKR CLOSING TIME

BKR OPEN TIMING

BKR CLOSE TIMING
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6.2.11  IEEE 1588 precision time protocol (PTP)
Actual > Status > IRIG-B PTP 1588

This screen shows the IRIG-B and PRP status. It includes the following signaling LEDs showing the FAILURE of the SNTP and 
IRIG-B and other statuses are provided.

The RTC Sync Source actual value is the time synchronizing source the relay is using at present. Possible sources are: Port 
A PTP Clock, Port B PTP Clock, IRIG B, SNTP and None.

Grandmaster ID is the grandmaster Identity code being received from the present PTP grandmaster if any. When the relay 
is not using any PTP grandmaster, this actual value is zero. The grandmaster Identity code is specified by PTP to be globally 
unique, so one can always know which clock is grandmaster in a system with multiple grandmaster-capable clocks.

PTP Accuracy is the estimated maximum time error at present in the Real Time Clock (RTC), considering the quality 
information embedded in the received time signal, how long the relay has had to lock to the time source, and in the case of 
time signal interruptions, the length of the interruption. The value 999,999,999 indicates that the magnitude of the 
estimated error is one second or more, or that the error cannot be estimated.

Note:

The C650 does not support the end-to-end delay mechanism, so it is not unexpected that changing the device to which the 
C650 is connected to this mode would cause the (NoPDelay) message. When PTP source clock is having "End to End clock 
delay” configured, and if C650 is receiving PTP packets from this clock C650 is getting synchronized and status is showing 
Synch'd (No Pdelay). Note that the relay does not allow manual overwriting of its RTC time if PTP is functional. 

6.2.12  Versions
This screen can be accessed at Actual > Status > Versions. It shows the current versions and dates of the different 
applications.

SNTP - IRIGB - PTP1588 STATUS

SNTP FAILURE

IRIG-B FAILURE

RTC Sync Source

GrandMaster-ID LOW

GrandMaster-ID HIGH

PTP ACCURACY

VERSIONS

HMI Version

DISPLAY TYPE

Boot Version

Boot Date

Kinetis Boot Version

Kinetis Boot Date

Kinetis Loader Ver

Kinetis Loader Date

Kinetis App Version

Kinetis App Date

DSP Version

DSP Date

Firmware Date

FPGA Version

RM PRP HSR Version

RM RSTP Version

RM LLA Version
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HMI Version: Relay display version

DISPLAY TYPE: Relay’s display model (refers to order code, basic or graphic)

1. Basic display

2. Graphic display

Boot Version: Boot version

Boot Date: Boot versions release date

Kinetis Boot Version: Kinetis microprocessor boot version

Kinetis Boot Date: Kinetis boot release date

Kinetis Loader Ver: Kinetis bootloader version

Kinetis Loader Date: Kinetis bootloader release date

Kinetis App Version: Kinetis application version

Kinetis App Date: Kinetis application release date

DSP Version: Digital Signal Processor firmware version

DSP Date: Digital Signal Processor firmware release date

Firmware Date: Firmware application release date

FPGA Version: Current version of the bitstream running in CPU FPGA.

RM PRP HSR Version: Current version of the PRP_HSR bitstream running in the redundancy module FPGA.

RM RSTP Version: Current version of the RSTP-Daisy Chain bitstream running in the redundancy module FPGA.

RM LLA Version: Current version of the LLA bitstream running in the redundancy module FPGA.

RM Bypass Version: Current version of the Bypass bitstream running in the redundancy module FPGA.

CPU Revision: CPU hardware version: 

• Redundant Fiber Optic: 0 or 4

• Redundant Cooper Cable: 1 or 5

• Single Fiber Optic: 2 or 6

• Single Cooper Cable: 3 or 7

RM Bypass Version

CPU Revision
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6.2.13  Redundancy
Actual > Status > Redundancy: This screen shows the port A and B statuses related to PRP, HSR and RSTP protocols.

• PRP_HSR A TX: This is the number of the transmitted messages over port A when PRP or HSR option is
enabled.

• PRP_HSR B TX: This is the number of the transmitted messages over port B when PRP or HSR option is
enabled.

• PRP_HSR A ERR:  This value shows the number of messages received over port A with wrong LAN ID.

• PRP_HSR B ERR: This value shows the number of messages received over port B with wrong LAN ID.

• RSTP PortA State: This is the state of RSTP for port A (Discarding, Learning & Forwarding)

• RSTP PortB State: This is the state of RSTP for port B (Discarding, Learning & Forwarding)

REDUNDANCY

PRP_HSR A tx

PRP_HSR B tx

PRP_HSR A err

PRP_HSR B err

RSTP PortA State

RSTP PortB State
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6.3  Metering

6.3.1  Primary values

6.3.1.1  Current

Actual > Metering > Primary Values > Current

6.3.1.2  Voltage

Actual> Metering > Primary Values > Voltage

Description Units

CT Ratio N/A

CT Ratio Ig N/A

CT Ratio Isg N/A

Ia Angle Deg

Ib Angle Deg

Ic Angle Deg

In Angle Deg

Ig Angle Deg

Isg Angle Deg

Phasor Ia Primary KA

Phasor Ib Primary KA

Phasor Ic Primary KA

Phasor Ig Primary KA

Phasor Isg Primary KA

Phasor In Primary KA

RMS Ia Primary KA

RMS Ib Primary KA

RMS Ic Primary KA

RMS Ig Primary KA

RMS Isg Primary KA

I0 Primary KA

I1 Primary KA

I2 Primary KA

% Load to trip N/A

Description Units

PT Ratio N/A

Va Angle Deg

Vb Angle Deg

Vc Angle Deg

Vn Angle Deg

Vx Angle Deg

Vab Angle Deg

Vbc Angle Deg

Vca Angle Deg

V0 Primary KV

V1 Primary KV

V2 Primary KV
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6.3.1.3  Power

Actual > Metering > Primary Values > Power

NOTE: If voltage inputs are configured in Delta connection and the auxiliary voltage input is set as Vx, measurements of 
single phase power value cannot be duly calculated, and therefore, its value is zero. For the three-phase power value, the 
system uses the ARON method, or two-wattmeters method.

NOTE 2: When currents and neither voltages are not available in the C650, default value for power factor will be indicated 
as zero.

Vab Primary KV

Vbc Primary KV

Vca Primary KV

Va Primary KV

Vb Primary KV

Vc Primary KV

Vn Primary KV

Vx Primary KV

VBB Primary KV

VL Primary KV

Description Units

Phase A Real Pwr MW

Phase A Reactive Pwr MVAr

Phase A Apparent Pwr MVA

Phase B Real Pwr MW

Phase B Reactive Pwr MVAr

Phase B Apparent Pwr MVA

Phase C Real Pwr MW

Phase C Reactive Pwr MVAr

Phase C Apparent Pwr MVA

3 Phase Real Pwr MW

3 Phase Reactive Pwr MVAr

3 Phase Apparent Pwr MVA

Phase A Power Factor N/A

Phase B Power Factor N/A

Phase C Power Factor N/A

3 Phase Power Factor N/A
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6.3.1.4  Energy

Actual > Metering > Primary Values > Energy

Energy is only given in three phase primary values

When the energy counters reach the value (2ˆ 31)/1000 (approximately 2147483 MVArh and MWh) all the values are set to 
zero and starts counting again.

6.3.1.5  Demand

Actual > Metering > Primary Values > Demand

Demand is only given in primary values

Description Units

Positive MWatthour MWh

Negative MWatthour MWh

Positive MVarhour MVArh

Negative MVarhour MVArh

Pos Mwatthour Cnt MWh

Neg Mwatthour Cnt MWh

Pos MVarhour Cnt MVArh

Neg MVarhour Cnt MVArh

Description Units

DEMAND IA KA

DEMAND IA MAX KA

DEMAND IA DATE dd/mm/yy hh:mm:ss:ms

DEMAND IB KA

DEMAND IB MAX KA

DEMAND IB DATE dd/mm/yy hh:mm:ss:ms

DEMAND IC KA

DEMAND IC MAX KA

DEMAND IC DATE dd/mm/yy hh:mm:ss:ms

DEMAND IG KA

DEMAND IG MAX KA

DEMAND IG DATE dd/mm/yy hh:mm:ss:ms

DEMAND ISG KA

DEMAND ISG MAX KA

DEMAND ISG DATE dd/mm/yy hh:mm:ss:ms

DEMAND I2 KA

DEMAND I2 MAX KA

DEMAND I2 DATE dd/mm/yy hh:mm:ss:ms

DEMAND W MW

DEMAND W MAX MW

DEMAND W MIN MW

DEMAND W DATE dd/mm/yy hh:mm:ss:ms

DEMAND VAR PWR MVAr

DEMAND VAR MAX MVAr

DEMAND VAR MIN MVAr

DEMAND VAR DATE dd/mm/yy hh:mm:ss:ms

DEMAND VA PWR MVA

DEMAND VA MAX MVA
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6.3.2  Secondary values

6.3.2.1  Current

Actual > Metering > Secondary Values > Current

6.3.2.2  Voltage

Actual > Metering > Secondary Values > Voltage

DEMAND VA MIN MVA

DEMAND VA DATE dd/mm/yy hh:mm:ss:ms

Description Units

Phasor Ia A

RMS Ia A

Phasor Ib A

RMS Ib A

Phasor Ic A

RMS Ic A

Phasor In A

Phasor Ig A

RMS Ig A

Phasor Isg A

RMS Isg A

Zero seq I0 A

Positive Seq I1 A

Negative Seq I2 A

Description Units

Phasor Vab V

Phasor Vbc V

Phasor Vca V

Phasor Van V

Phasor Vbn V

Phasor Vcn V

Phasor Vn V

Positive Seq V1 V

Negative Seq V2 V

Zero Seq V0 V

Phasor Vx V

Nominal Voltage V

Line Voltage V

Bus Voltage V
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6.3.2.3  Power

Actual > Metering > Secondary Values > Power

NOTE: If voltage inputs are configured in Delta connection and the auxiliary voltage input is set as Vx, measurements of 
single phase power value cannot be duly calculated, and therefore, its value is zero. For the three-phase power value, the 
system uses the ARON method, or two-wattmeters method.

Description Units

Phase A Apparent Pwr VA

Phase B Apparent Pwr VA

Phase C Apparent Pwr VA

Phase A Real Pwr W

Phase B Real Pwr W

Phase C Real Pwr W

Phase A Reactive Pwr VARS

Phase B Reactive Pwr VARS

Phase C Reactive Pwr VARS

3 Phase Apparent Pwr VA

3 Phase Real Pwr W

3 Phase Reactive Pwr VARS

Phase A Power Factor N/A

Phase B Power Factor N/A

Phase C Power Factor N/A

3 Phase Power Factor N/A
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6.3.3  Phasor diagram
Actual > Metering > Phasor Diagram

This window shows the phasors for voltage and current values, phase to phase, phase to ground and sequence values, 
provided by the unit. The angles provided by the unit are counter clockwise, all the angles are positive values, so for a 
system Va (0,0°), Vb (0,-120°), Vc (0,120°) the relay provides the following angles Va (0,0°), Vb (0,240°), Vc (0,120°).

The following figure shows the phasor diagram provided by EnerVista 650 Setup: 

Figure 6-2: Phasor diagram

6.3.4  Frequency
Actual > Metering > Frequency

Description Units

Line Frequency Hz

Bus Frequency Hz

df/dt Hz/s
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6.4  Inputs / outputs
Digital inputs and outputs are located in the same board. Depending on the relay model, the number of inputs and outputs 
varies.

6.4.1  Contact inputs
Actual > Inputs/Outputs > Contact inputs > Board X (being X the corresponding board in each case).

On the inputs screen, the LED associated with the activated input lights in green, if an input is not activated, the LED does 
not light up. The Board X Status LED indicates the status of the board; it is lit up if the board is correct and the 
communication or the Relay model is appropriate.

Table 6-18: Contact input activation signals

6.4.2  Contact output status
Actual > Inputs/Outputs > Contact Output Status > Board X (being X the corresponding board in each case).

The corresponding Outputs screen displays the activation of a contact output by lighting in green the associated LED. 
Boards types 1 and 2 have both 8 outputs, so the representation is the same for both types as shown in the table below.

This screen shows the real status of the contact output, which corresponds to the transformation of the output activation 
signal (Contact output operate), by the logic applied to this output in Setpoint > Inputs/Outputs >Contact I/O > Board X

NOTE: Both in the outputs menu as in the rest of menus available in “Actual”, the user can view several screens at the 
same time to facilitate analysis.

CONTACT INPUTS TYPE 1 CONTACT INPUTS TYPE 2                   CONTACT INPUTS TYPE 4 CONTACT INPUTS TYPE 5

CONT IP_X_CC1 (CC1) CONT IP_X_CC1 (CC1) CONT IP_X_CC1 (CC1) CONT IP_X_CC17 (CC17) CONT IP_X_CC1 (CC1)

CONT IP_X_CC2 (CC2) CONT IP_X_CC2 (CC2) CONT IP_X_CC2 (CC2) CONT IP_X_CC18 (CC18) CONT IP_X_CC2 (CC2)

CONT IP_X_CC3 (CC3) CONT IP_X_CC3 (CC3) CONT IP_X_CC3 (CC3) CONT IP_X_CC19 (CC19) CONT IP_X_CC3 (CC3)

CONT IP_X_CC4 (CC4) CONT IP_X_CC4 (CC4) CONT IP_X_CC4 (CC4) CONT IP_X_CC20 (CC20) CONT IP_X_CC4 (CC4)

CONT IP_X_CC5 (CC5) CONT IP_X_CC5 (CC5) CONT IP_X_CC5 (CC5) CONT IP_X_CC21 (CC21) CONT IP_X_CC5 (CC5)

CONT IP_X_CC6 (CC6) CONT IP_X_CC6 (CC6) CONT IP_X_CC6 (CC6) CONT IP_X_CC22 (CC22) CONT IP_X_CC6 (CC6)

CONT IP_X_CC7 (CC7) CONT IP_X_CC7 (CC7) CONT IP_X_CC7 (CC7) CONT IP_X_CC23 (CC23) CONT IP_X_CC7 (CC7)

CONT IP_X_CC8 (CC8) CONT IP_X_CC8 (CC8) CONT IP_X_CC8 (CC8) CONT IP_X_CC24 (CC24) CONT IP_X_CC8 (CC8)

CONT IP_X_CC9 (Va_COIL1) CONT IP_X_CC9 (CC9) CONT IP_X_CC9 (CC9) CONT IP_X_CC25 (CC25) CONT IP_X_CC9 (CC9)

CONT IP_X_CC10 (Vb_COIL1) CONT IP_X_CC10 (CC10) CONT IP_X_CC10 (CC10) CONT IP_X_CC26 (CC26) CONT IP_X_CC10 (CC10)

CONT IP_X_CC11 (Va_COIL2) CONT IP_X_CC11 (CC11) CONT IP_X_CC11 (CC11) CONT IP_X_CC27 (CC27) CONT IP_X_CC11 (CC11)

CONT IP_X_CC12 (Vb_COIL2) CONT IP_X_CC12 (CC12) CONT IP_X_CC12 (CC12) CONT IP_X_CC28 (CC28) CONT IP_X_CC12 (CC12)

CONT IP_X_CC13 (O7_SEAL) CONT IP_X_CC13 (CC13) CONT IP_X_CC13 (CC13) CONT IP_X_CC29 (CC29) CONT IP_X_CC13 (CC13)

CONT IP_X_CC14 (O8_SEAL) CONT IP_X_CC14 (CC14) CONT IP_X_CC14 (CC14) CONT IP_X_CC30 (CC30) CONT IP_X_CC14 (CC14)

CONT IP_X_CC15 (SUP_COIL1) CONT IP_X_CC15 (CC15) CONT IP_X_CC15 (CC15) CONT IP_X_CC31 (CC31) CONT IP_X_CC15 (CC15)

CONT IP_X_CC16 (SUP_COIL2) CONT IP_X_CC16 (CC16) CONT IP_X_CC16 (CC16) CONT IP_X_CC32 (CC32) CONT IP_X_CC16 (CC16)

BOARD X STATUS BOARD X STATUS BOARD X STATUS BOARD X STATUS

CONTACT OUTPUT STATUS

CONT OP_X_01

CONT OP_X_02

CONT OP_X_03

CONT OP_X_04

CONT OP_X_05

CONT OP_X_06

CONT OP_X_07

CONT OP_X_08

BOARD X STATUS
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6.4.3  Contact output operates
Actual > Inputs/Outputs > Contact Output Operates > Board X (being X the corresponding board in each case).

These screens are available for all boards incorporated in the relay model, which can be F, G, H, and/or J.

This screen shows the activated or deactivated status of those variables used internally to operate a contact output.

Signals shown on this screen are configured in the Outputs screen inside the Setpoint > Relay Configuration menu, either 
directly by selecting the signals provided by the relay, or selecting a signal provided by the logic configured at Setpoint > 
Logic Configuration.

These logic signals (Contact Output Operates), when being transformed by the outputs logic configured at Setpoint > 
Inputs/Outputs >Contact I/O > Board X become Contact Output signals. This output logic can be POSITIVE, NEGATIVE, 
pulse, latched, etc.

Operation example of output contacts:

Figure 6-3: Output contact operation

CONTACT OUTPUT OPERATES

CONT OP OPER_X_01

CONT OP OPER_X_02

CONT OP OPER_X_03

CONT OP OPER_X_04

CONT OP OPER_X_05

CONT OP OPER_X_06

CONT OP OPER_X_07

CONT OP OPER_X_08

BOARD X STATUS
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6.4.4  Contact output resets
Actual > Inputs/Outputs > Contact Output Resets > Board X (being X the corresponding board in each case).

Boards types 1 and 2 have both 8 outputs, so the representation is the same for both types as shown in  

If the reset signal is active, the green LED lights up. Otherwise, it remains unlit.

The last LED in this screen, labeled Board Status, indicates the general board status.

This output reset Command is only be effective if latch has been selected for Output Type on the I/O board, thus the 
contact output has been configured to emulate function 86 (latching relay).

Configuration for the contact output reset signal is set at Setpoint > Relay Configuration > Outputs > Contact Output 
Reset.

6.4.5  I/O board status
Actual > Inputs/Outputs > I/O Board Status

This screen is used for verifying the status of I/O boards. If all the I/O boards, one (F) or both (F and G) depending on the 
relay model, are correctly inserted in their tracks and are in good state and communicating through the internal CAN bus, 
the green LED remains lit.

I/O boards accessible through the external CAN bus are labeled as H and J. In order to start working with the external I/O 
boards is necessary to select the appropriated I/O board type for each slot (H or J for the CIO module) at Setpoint > Inputs/
Outputs > Contact I/O > Board H and J. Otherwise the relay will not start communicating through the external CAN bus to 
the related board.

If one of the boards has been extracted, or the relay model does not match the installed hardware, the corresponding LED 
remains unlit.

For all I/O board screens described above, the last LED provides this same information individually.

CONTACT OUTPUT RESETS

CONT OP RESET_X_01

CONT OP RESET_X_02

CONT OP RESET_X_03

CONT OP RESET_X_04

CONT OP RESET_X_05

CONT OP RESET_X_06

CONT OP RESET_X_07

CONT OP RESET_X_08

BOARD X STATUS

I/O BOARD STATUS

BOARD F STATUS

BOARD G STATUS

BOARD H STATUS

BOARD J STATUS

BOARD 2H STATUS

BOARD 2J STATUS
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6.4.6  Virtual inputs
Actual > Inputs/Outputs > Virtual Inputs > Virtual Input Latched > Virtual Input Self-Reset

“Virtual Inputs” are signals transmitted by communications. The EnerVista 650 Setup provides a tool to set virtual inputs 
through ModBus at Setpoint > Inputs /Outputs / Virtual inputs that is only available in online mode (communicating to 
the relay). There are two available groups of 32 signals each: Latched inputs and Self-reset inputs, and all of them can be 
used internally to perform operations, new logics in the PLC, etc.

In this actual values screen the status of the assigned virtual inputs are shown as below:  

6.4.7  Virtual outputs
Actual > Inputs/Outputs > Virtual Outputs

This screen provides the status of the 512 configurable virtual outputs (internal variables) used in the logic scheme. The 
virtual outputs are set from 000 to 511.

The configuration of the logic associated with the virtual output is in the Setpoint > Logic Configuration tool provided by 
EnerVista 650 Setup program.

6.4.8  Remote outputs
Actual > Inputs/Outputs > Remote Outputs > DNA

This screen provides the status of the 32 DNA remote outputs.

Table 6-19: DNA STATUS

VIRTUAL INPUTS LATCHED VIRTUAL INPUTS SELF-RESET

LATCHED VIRT IP 1 SELF-RST VIRT IP 1

LATCHED VIRT IP 2 SELF-RST VIRT IP 2

… …

LATCHED VIRT IP 32 SELF-RST VIRT IP 32

VIRTUAL OUTPUT STATUS

VIRTUAL OUTPUT 000

VIRTUAL OUTPUT 001

…

VIRTUAL OUTPUT 511

DNA STATUS

DNA 1

DNA 2

DNA 3

...

DNA 32
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Actual > Inputs/Outputs > Remote Outputs > UserSt

This screen provides the status of the 64 UserSt remote outputs.

Table 6-20: USER ST STATUS

Actual > Inputs/Outputs > Remote Outputs > Remote GOOSE Dig Outputs

This screen provides the status of the 32 Remote GOOSE Digital Outputs.

Table 6-21: Remote GOOSE digital output status

6.4.9  Remote inputs
Actual > Inputs/Outputs > Remote Inputs > Remote Input

This screen provides the status of the 32 remote inputs.

Actual > Inputs/Outputs > Remote Inputs > Remote Device

This screen provides the status of the 16 remote devices.

USERst STATUS

UserSt 1

UserSt 2

UserSt 3

...

UserSt 64

REMOTE GOOSE DIG OUTPUTS STATUS

Rem GOOSE Dig Out 1

Rem GOOSE Dig Out 2

Rem GOOSE Dig Out 3

...

Rem GOOSE Dig Out 32

REMOTE INPUTS STATUS

Remote Input 1

Remote Input 2

Remote Input 3

...

Remote Input 32

REMOTE DEVICE STATUS

Remote Device 1

Remote Device 2

Remote Device 3

...

Remote Device 16
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Actual > Inputs/Outputs > Remote Outputs > Remote GOOSE Digital Inputs

This screen provides the status of the 32 Remote GOOSE Digital Inputs.

Actual > Inputs/Outputs > Remote Outputs > Remote GOOSE Analog Inputs

This screen provides the values of the 16 Remote GOOSE Analog Inputs. Eight of them are float type and the other eight are 
integer type.

6.4.10  Analog inputs
Actual > Inputs/Outputs > Analog Inputs > Board X

This screen provides the values of the analog inputs.

6.4.11  Virtual output latched
Actual > Inputs/Outputs > Virtual Output Latched

This screen provides the values of virtual output latched

REMOTE GOOSE DIG INPUTS STATUS

Rem GOOSE Dig Inp 1

Rem GOOSE Dig Inp 2

Rem GOOSE Dig Inp 3

...

Rem GOOSE Dig Inp 32

REMOTE GOOSE ANALOG INPUTS STATUS

Rem Ana Inp FLOAT 1

Rem Ana Inp FLOAT 2

Rem Ana Inp FLOAT 3

...

Rem Ana Inp FLOAT 8

Rem Ana Inp INT 1

Rem Ana Inp INT 2

Rem Ana Inp INT 3

...

Rem Ana Inp INT 8

ANALOG INPUTS VALUES

Analog_Inp_X_01

Analog_Inp_X_02

Analog_Inp_X_03

...

Analog_Inp_X_08

VIRTUAL OUTPUT LATCHED

V.O. Latched 1

V.O. Latched 2

V.O. Latched 3

….

V.O. Latched 16
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6.4.12  RIOs
Actual > Inputs/Outputs > RIOs

This screen provides the values of virtual output analogues, integer and float values

INTEGER VALUES FLOAT VALUES

INT32_000 FLT32_000

INT32_001 FLT32_001

INT32_002 FLT32_002

…. …

INT32_049 FLT32_049
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6.5  Records

6.5.1  Event recorder

6.5.1.1  All snapshot events

Actual > Records > Event Recorder > All Snapshot Events

By selecting this option, the C650 provides a general list of all snapshot events stored in the relay up to the request 
moment:

Figure 6-4: Event recorder - all snapshot events

The different options available on this screen are as follows:

Save: It allows saving the Snapshot events information obtained in the relay in a CSV format file.

Print: It allows printing the viewed data.

View data: It allows to view the information contained in the selected event, such as the event number, date and time, 
cause of the event, as well as the voltage and current values in the moment of the event (see Figure 6-5: 
Snapshot event details).
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There is a “Select” option, which is used for selecting the events that are required to appear when the screen information is 
printed or saved. 

Figure 6-5: Snapshot event details

6.5.1.2  New snapshot events

Actual > Records > Event Recorder > New Snapshot Events

This screen shows new Snapshot events, updated since the last time that this menu was accessed; there are threetwo 
possible ways to access new events; in local mode (COM2-HMI), remote mode (COM1) and via Ethernet (ETH_1/ETH2 or 
ETH_E/ETH_A/ETH_B)

It is the same type of screen as shown on all snapshot event retrieval.

6.5.1.3  Control events

Actual > Records > Event Recorder > Control Events

This screen is identical to the previous ones. The difference is that this screen displays only control events, i.e., those events 
configured in section Setpoint > Relay Configuration > Events. There are a total of 128 configurable events and 64 non-
configurable switchgear events.

In this screen, red or black color for a specific event indicates whether it is activated (to 1) or in standby (to 0)
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Figure 6-6: Control events

6.5.1.4  Alarm panel

The alarm panel can be accessed at Actual > Records > Event Recorder > Alarm Panel.

The following screen provides information about the issued alarms. The screen shows information about their status: 
active not acknowledged, active acknowledged and not active. The user can either acknowledge all alarms at the same 
time, or do it partially by selecting the alarms to be acknowledged.

Figure 6-7: Alarm panel
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6.5.2  Waveform capture
The Actual > Records > Waveform Capture screen displays a list of all oscillography records available in the relay. The 
C650 stores oscillography records from 1 to 999; this is the index of the obtained oscillography record. This screen allows 
selecting the records to be saved among all records available. Download of these records is done through the selected 
connection in the “Communication > Computer” menu, either serial mode or Ethernet.

Figure 6-8: Oscillography record retrieval, EnerVista 650 Setup

The screen shows all the available records in the Relay, and by clicking on each of them, the system displays the heading 
information for that record, allowing downloading the information to a disk. Once the file to be downloaded has been 
selected, the oscillography record can be opened using GE-OSC software.

GE-OSC is GE proprietary software that is not distributed together with EnerVista 650 Setup. This program is a COMTRADE 
viewer and analysis software for oscillography files.

If the user does not have the GE-OSC tool, the oscillography record can be stored and viewed using any other analysis tool 
capable of reproducing COMTRADE.1999 files.

When using GE-OSC software, this program requires the use of a template for each relay. If there is a stored template for 
C650 relays (as shown in the following figure), select the template and click Open Selected Template. The program then 
prepares to view oscillography and digital records using the options in available menus (Waveforms and Digital Flags). 
Otherwise, select the Create New Template option, and the program helps create a new template. See the GE-OSC 
software instruction manual for details.

Figure 6-9: GE-OSC oscillography analysis software

Note that any settings change in the oscillography removes all the information stored up to that moment.
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6.5.3  Data logger
The access menu is Actual > Records > Data Logger. Once open, this menu shows a screen containing the information 
monitored by the relay according to the settings adjusted at Setpoint > Product Setup > Data Logger, where the user can 
select which analog channels are recorded, as well as the sampling rate. 

Note that any settings change in the data logger removes all information stored up to that moment.

The data logger screen diagram shows the time during which the displayed values have been obtained.

The upper part of the window shows the time when the oldest sample was taken, as well as the time when the most recent 
value was taken.

Figure 6-10: Data logger

This screen offers the possibility of storing the data logger record obtained for a further analysis, in COMTRADE format.

Data Logger file retrieval can be performed only via Ethernet communications.

NOTE: Data logger information takes several minutes to be available.
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C650 Bay Controller & Monitoring System

Chapter 7:  IEC 61850 protocol

GE
Grid Solutions

IEC 61850 PROTOCOL

This chapter outlines the IEC 61850 communications protocol. The IEC 61850 protocol applies when ordered with the 
product. (Check the order code to determine whether IEC 61850 is included with your product).

7.1  IEC 61850 Overview
This section contains a description of IEC 61850, an International Electrotechnical Commission (IEC) series of documents 
entitled Communication Networks and Systems for Power Utility Automation. IEC 61850 is a series of international 
standards and technical reports applicable to power utility automation systems (PUAS). It includes semantics, abstract 
communication services, specific communication services, performance specifications, network engineering guidelines, 
configuration description methodologies, and engineering processes. The objective of the standard is to provide a 
framework to achieve interoperability among the intelligent electronic devices (IEDs) from different suppliers, and 
interoperability among software configuration tools from different suppliers. Interoperability in this case is the ability for 
IEDs to operate on the same network or communication path sharing information and commands, and for configuration 
tools to understand each other's configuration files. The standards can be obtained from the IEC (http://www.iec.ch).

650 models with an IEC 61850 option support both the IEC61850 GOOSE and IEC 61850 MMS Server service: 

• 650 Family relays with firmware version below 7.00 firmware: As per IEC 61850 standard Edition 1

• 650 Family relays with firmware version from 7.00 to 7.50: As per IEC 61850 standard Edition 2

• F650- Feeder protection relay for firmware version 7.52 or above: As per IEC 61850 standard Edition 1 or 2 (depending
on the CID file selected and sent to the relay)

• C650-Digital Bay Controller for firmware version 7.50 to below 7.70: As per IEC 61850 standard Edition 2

• C650-Digital Bay Controller for firmware version 7.70 onwards: As per IEC 61850 standard Edition 1 or 2 (depending on
the CID selected and sent to the relay)

• R650 Recloser Controller: As per IEC 61850 standard Edition 2 

The GOOSE messaging service provides the 650 relay unit the ability to Publish/Subscribe Digital Input Status and its 
Quality and Timestamp to and from other IEDs which support the GOOSE messaging service, while the server support 
allows remote a control center, RTU/Gateway, local HMI or other client role devices access to the relay for monitoring and 
control. The configuration of IEC61850 services is accomplished using the 650 IEC61850 configuration software, EnerVista 
650 Setup software. A reboot is required before any changes made in the IEC61850 configuration take effect in the C650 
relay.

These models support also Generic Substation State Events (GSSE). 
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7.2  IEC 61850 generic substation state event (GSSE)

7.2.1  Overview
IEC 61850 specifies two types of peer-to-peer data transfer services: Generic Substation State Events (GSSE) and Generic 
Object Oriented Substation Events (GOOSE). Both GSSE and GOOSE messages are designed to be short, reliable, and high 
priority. 

GSSE services are compatible with UCA 2.0 GOOSE. IEC 61850 GOOSE services provide virtual LAN (VLAN) support, Ethernet 
priority tagging, and Ethertype Application ID configuration. The support for VLANs and priority tagging allows for the 
optimization of Ethernet network traffic. GOOSE messages can be given a higher priority than standard Ethernet traffic, 
and they can be separated onto specific VLANs. Because of the additional features of GOOSE services versus GSSE 
services, it is recommended that GOOSE be used wherever backwards compatibility with GSSE (or UCA 2.0 GOOSE) is not 
required.

Devices that transmit GSSE and/or GOOSE messages also function as servers. Each GSSE publisher contains a "GSSE 
control block" to configure and control the transmission. Each GOOSE publisher contains a "GOOSE control block" to 
configure and control the transmission. The transmission is also controlled via device settings. These settings can be seen 
in the ICD and/or SCD files, or in the device configuration software or files. IEC 61850 recommends a default priority value 
of 4 for GOOSE. Ethernet traffic that does not contain a priority tag has a default priority of 1. More details are specified in 
IEC 61850 part 8-1. IEC 61850 recommends that the Ethertype Application ID number be configured according to the 
GOOSE source. A common number may be used for all GOOSE transmitters in a system. More details are specified in IEC 
61850 part 8-1.

GSSE messages contain a fixed set of digital points. IEC 61850 GOOSE messages can, in general, contain any configurable 
data items. When used by the remote input/output feature, IEC 61850 GOOSE messages contain the same data as GSSE 
messages. The GSSE message structure contains space for 128 bit pairs representing digital point state information. In 
addition to digital point states, GSSE/GOOSE messages identify the originator of the message and provide other 
information required by the communication specification. All devices listen to network messages and capture data only 
from messages that have originated from selected devices

7.2.2  Remote communication
The IEC 61850 specification includes features that are used to cope with the loss of communication between transmitting 
and receiving devices. Each transmitting device sends a GSSE/GOOSE message upon a successful power-up, when the 
state of any included point changes, or after a specified interval, four times the Hold Time setting value, if a change-of-
state has not occurred. 

Receiving devices are constantly monitoring the communications network for the messages they require, as recognized by 
the identification of the originating device carried in the message. If the receiving relay has not received another message 
from the originating device when the specified timeout period elapses, the remote device is declared to be non-
communicating, so it uses the programmed default state for all points from that specific remote device. 

If a message is received from a remote device before the interval of four times the Hold Time expires, all points for that 
device are updated to the states contained in the message. The status of a remote device can be displayed.

Remote inputs and outputs provide a means of exchanging digital state information between Ethernet-networked devices. 
The GSSE facility provides for 32 remote inputs and 64 remote outputs.
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7.2.3  GSSE configuration
GSSE messages contain a number of double point status data items. These items are transmitted in two pre-defined data 
structures named DNA and UserSt. Each DNA and UserSt item is referred to as a 'bit pair'. GSSE messages are transmitted 
in response to state changes in any of the data points contained in the message. GSSE messages always contain the same 
number of DNA and UserSt bit pairs. Depending on the configuration, only some of these bit pairs may have values that are 
of interest to receiving devices.

The relay provides 32 "DNA" bit pairs that represent the state of two pre-defined events and 64 "UserSt" bit pairs, which are 
status bits representing user-definable events.

GSSE service can be configured using the EnerVista 650 Setup program in the menu Setpoint > Input/Outputs > Remote 
Comms.

Remote Comms must be set to "GSSE" to enable GSSE configuration.

650 ID represents the IEC 61850 GSSE application ID name string sent as part of each GSSE message. This string identifies 
the GSSE message to the receiving device.

Hold time is used to calculate the interval, if a change-of-state has not occurred, that the device waits to send GSSE 
message.

Remote Device (1 to 32) is used to select specific remote devices by entering the exact identification (ID) assigned to these 
devices. A maximum of 32 devices can be configured for receiving GSSE messages.

Bit Pair (1 to 32) is used to assign the data from the GSSE message to remote inputs.

Figure 7-1: Remote communication

Default Value (1 to 32) selects the logic state for this point if the local relay has just completed startup or the remote device 
sending the point is declared to be non-communicating. The following choices are available:

• ON value defaults the input to Logic 1.

• OFF value defaults the input to Logic 0.

• Latest OFF freezes the input in case of lost communications. If the latest state is not known, such as after relay power-
up but before the first communication exchange, the input defaults to Logic 0. When communication resumes, the
input becomes fully operational.

• Latest ON freezes the input in case of lost communications. If the latest state is not known, such as after relay power-
up but before the first communication exchange, the input defaults to Logic 1. When communication resumes, the
input becomes fully operational.
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Destination MAC Data (1 to 3): If a valid multicast Ethernet MAC address is entered, this address is used as the destination 
MAC address for GSSE messages. If a valid multicast Ethernet MAC address is not entered (for example, 00 00 00 00 00 00), 
the device uses the source Ethernet MAC address as the destination, with the multicast bit set.

GSSE RemDevice (1 to 24) MAC Data (1 to 3) is used to filter receiving messages.

GSSE PORT sets the network port through messaging will be done. Possible values are "Port A", "Port B" or "Both".

7.2.4  Remote inputs
Remote inputs, which create PLC operands at the receiving relay, are extracted from GSSE messages originating in remote 
devices. The relay provides 32 remote inputs, each of which can be selected from a list consisting of 96 selections: DNA-1 
to DNA-32 and UserSt-1 to UserSt-64. The function of DNA and UserSt bits is in both cases the same so user can assign a 
Remote input either of them through the Bit Pair 1 to 32 field (see figure 1). They can be configured using the EnerVista 650 
Setup program in the menu Setpoint > Input/Outputs > Remote Comms.

Figure 7-2: Remote communication (remote inputs)
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7.2.5  Remote outputs

7.2.5.1  DNA bit pairs

Remote Outputs (1 to 32) are PLC operands inserted into GSSE messages that are transmitted to remote devices on a LAN. 
Each digital point in the message must be programmed to carry the state of a specific PLC operand, except reserved 
points DNA1 and DNA2. The complete operand setting represents a specific DNA function to be transmitted. These states 
are displayed in the C650 relay and in the EnerVista 650 Setup software in the menu Actual Values > Input/Outputs > 
Remote Outputs > DNA.

Each DNA point can only be programmed in the EnerVista 650 Setup software in the menu Setpoint > Relay Configuration 
> Remote Outputs.

Figure 7-3: Remote outputs (DNA)

7.2.5.2  UserSt bit pairs

Remote Outputs 1 to 64 originates GSSE messages to be transmitted to remote devices. Each digital point in the message 
must be programmed to carry the state of a specific PLC operand. The UserSt (User Setpoint) setting is used to select the 
operand which represents a specific UserSt function to be transmitted. These states are displayed in the C650 relay and in 
the EnerVista 650 Setup software in the menu Actual Values > Input/Outputs > Remote Outputs > UserSt.
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Each User Set point can only be programmed and displayed in EnerVista 650 Setup in the menu Setpoint > Relay 
Configuration > Remote Outputs.

Figure 7-4: Remote outputs (UserSt)
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7.3  IEC 61850 profile for C650 

7.3.1  Overview
IEC 61850 is a series of standards describing client/server and peer-to-peer communications, substation design and 
configuration, testing, environmental and project standards. 

The 10 parts of the standard IEC 61850 are as listed in the following tables:

The following parts define how the IED behaves:

These documents can be obtained from the IEC (http://www.iec.ch). It is strongly recommended that all those involved with 
any IEC 61850 implementation obtain this document set.

1.1.1  System Aspects

Part 1: Introduction and Overview

Part 2: Glossary

Part 3: General Requirements

Part 4: System and Project Management

Part 5: Communication Requirements for Functions and Device Models

1.1.2  Configuration

Part 6: Configuration Description Language For Communication In Electrical Substations
Related To IEDs

1.1.3  Testing

Part 10: Conformance Testing

1.1.4  Data Models

Basic Communication Structure for Substations and Feeder Equipment

Part 7-4: Compatible Logical Node Classes and Data Classes

Part 7-3: Common Data Classes

1.1.5  Abstract Communications

Basic Communication Structure for Substations and Feeder Equipment

Part 7-2: Abstract Communication Services Interface (ACSI)

Part 7-1: Principles and Models

1.1.6  Mapping to real Communication Networks (SCSM)

Specific Communication Service Mapping (SCSM)

Part 8-1: Mappings to MMS

(ISO 9506-1 and ISO 9506-2) and to ISO/IEC 8802-3

Part 9-1: Sampled Values Over Serial Unidirectional Multidrop Point to Point Link

Part 9-2: Sampled values over ISO/IEC 8802-3

Mapping on a IEEE 8802-3 based Process Bus
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7.3.1.1  Scope and outline of IEC 61850

Parts 3, 4, and 5 of the standard start by identifying the general and specific functional requirements for communications 
in a substation. These requirements are then used as forcing functions to aid in the identification of the services and data 
models needed, application protocol required, and the underlying transport, network, data link, and physical layers that 
meet the overall requirements. 

The major architectural construct that 61850 adopts is that of "abstracting" the definition of the data items and the 
services, that is, creating data items/objects and services that are independent of any underlying protocols. The abstract 
definitions then allow "mapping" of the data objects and services to any other protocol that can meet the data and service 
requirements. 

The definition of the abstract services is found in part 7.2 of the standard and the abstraction of the data objects (referred 
to as Logical Nodes) is found in part 7.4.

In as much as many of the data objects are made up of common pieces (such as Status, Control, Measurement, 
Substitution), the concept of "Common Data Classes" or "CDC" was developed which defined common building blocks for 
creating the larger data objects. The CDC elements are defined in part 7.3. 

Given the data and services abstract definitions, the final step was one of "mapping" the abstract services into an actual 
protocol. Section 8.1 defines the mapping of the abstract data object and services onto the Manufacturing Messaging 
Specification - MMS2 and sections 9.1 and 9.2 define the mapping of the Sample Measured Values (unidirectional point-to-
point and bi-directional multipoint accordingly) onto an Ethernet data frame. The 9.2 document defines what has become 
known as the Process Bus. 

From a system perspective, there is a significant amount of configuration that is required in order to put all the pieces 
together and have them work. In order to facilitate this process and to eliminate much of the human error component, an 
XML based Substation Configuration Language (SCL) was defined in part 6. It allows the formal description of the relations 

Basic principles Part 1 

Glossary Part 2 

General Requirements Part 3 

System and project management Part 4 

Communication requirements Part 5 

Substation Automation System Configuration Part 6 

Basic Communication Structure (4 sections) Part 7 

1.1 Sampled Measured Values 

Part 9 Part 8 
Mapping to Ethernet 

Mapping to MMS and 
Ethernet 

Conformance testing 
Part 10 
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between the substation automation system and the substation. At the application level, the substation topology itself and 
the relation of the substation structure to the SAS functions (logical nodes) configured on the IEDs can be described. Each 
device must provide an SCL file that describes the configuration of itself. 

Finally, part 10 defines a testing methodology in order to determine "conformance" with the numerous protocol definitions 
and constraints defined in the standard.

7.3.2  Communication profiles
The C650 relay supports IEC61850 server services over TCP/IP. This profile requires the C650 to have an IP address to 
establish communications. It is possible to have up to five simultaneous connections.

7.3.3  TCP connection timing
A built-in TCP/IP connection timeout of 30 seconds is employed by the C650 to detect “dead” connections. If there is no 
data traffic on a TCP connection for greater than 30 seconds, the connection is aborted by the server. Therefore, when 
using IEC61850 reporting, clients should configure report control block items such that an integrity report is issued al least 
every 30 seconds. If other MMS data is being polled on the same connection al least once every 30 seconds, this timeout 
does not apply.

For firmware version 7.20 or higher, TCP connection timeout is configurable from 120 to 1800 seconds and its default value 
is 120 seconds

7.3.4  MMS protocol
IEC 61850 specifies the use of the Manufacturing Message Specification (MMS) at the upper (application) layer for transfer 
of real-time data. This protocol has been in existence for a number of years and provides a set of services suitable for the 
transfer of data within a substation LAN environment. Actual MMS protocol services are mapped to IEC 61850 abstract 
services in IEC 61850-8-1.

The exact structure and values of the supported IEC61850 logical nodes can be seen by connecting to a C650 relay with an 
MMS browser, such as “MMS Object Explorer and AXS4-MMS” DDE/OPC server from Sisco Inc.

7.3.5  Peer-to-peer communication
Peer-to-peer communication of a digital state information (remote inputs/outputs) is supported using the IEC61850 
GOOSE/GSE services. This feature allows digital points to be exchanged between IEC 61850 conforming devices.

7.3.6  File services
MMS file services are supported to allow transfer of oscillography, event record, or other files from a C650 relay.
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7.3.7  IEC 61850 conformance statements
This section describes conformity with IEC 61850.

7.3.7.1  Abbreviations and acronyms

• ASCI     Abstract Communication Service Interface

• SCSM   Specific Communication Service Mapping

• SCL       Substation Configuration Language

• GSE       Generic Substation Events

• GOOSE Generic Object Oriented Substation Events

• GSSE    Generic Substation Status Events

• SVC       Sampled Value Control

• LCB       Log Control Block

• PICS      Protocol Implementation Conformance Statement

• MICS     Model Implementation Conformance Statement

• PIXIT     Protocol Implementation extra Information for Testing

• TICS      Technical Issues Conformance Statement

7.3.7.2  Definitions of the ISO/OSI reference model

Communications are based on the OSI Reference Model (OSI/IEC 7498-1) for a multi-layer communication function, to 
achieve stable data exchange.

The table below shows the ISO Application (A) and Transport (T) profiles. 

• An ISO A profile is a set of specifications and declarations regarding the top three layers of the ISO/OSI reference
model (i.e. the application, presentation, and session layers).

• The T profile is a set of specifications and declarations regarding the lower four layers (i.e. transport, network, data
link, and physical layers).

Table 7-1: OSI reference model and profiles

A and T profiles can be combined in various ways to form different types of services and information items that can be 
exchanged. The services specified in Part 7-2 of the IEC61850 standard are mapped onto four different combinations of 
the profiles. These four combinations are used for

• Client/server services,

• GOOSE/GSE management services,

• GSSE services,

• Time synchronization,

• Services for measured value sampling.

Application layer 

Presentation layer 

Session layer 

A Profile 

Transport layer 

Network layer 

Data link layer 

Physical layer 

T Profile 



CHAPTER 7:  IEC 61850 PROTOCOL 7.3 IEC 61850 PROFILE FOR C650

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 7-11

7.3.7.3  Conformance statements for C650 devices

For C650 relays whose order code contains Rear Ethernet Communication Board 2 "G", "H", "J", "K", "L" or "M" and 
Communication protocol "6", product protocol and model implementation conformance statements are described in the 
following sections:

IEC 61850 Edition 2:

• 7.3.7.3.1 PICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 "H", "G", "K", "J","L",
"M" and IEC 61850 Edition 2 on page 7–12 (PICS for 650 family of relays v1_2 firm7_20)

• 7.3.7.3.3 MICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 option "H", "G", "K",
"J", "L", "M" and IEC 61850 Edition 2 on page 7–29 (MICS for 650 family of relays v1_40 firm7_20)

• 7.3.7.3.5 TICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 option "H", "G", "K",
"J", "L", "M" and IEC 61850 Edition 2 on page 7–88 (TICS for 650 family of relays v1_00 firm7_20)

• 7.3.7.3.7 PIXIT for 650 family of relays whose order code has Rear Ethernet Communication Board 2 option "H", "G", "K",
"J", "L", "M" and IEC 61850 Edition 2 on page 7–93 (PIXIT for 650 family of relays v1_6 firm7_00)

IEC 61850 Edition 1:

• 7.3.7.3.2 PICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 option "H", "G", "K",
"J", "L", "M" and IEC 61850 Edition 1 on page 7–24 (PICS For C650 relay V1_00 firm7_70)

• 7.3.7.3.4 MICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 option "H", "G", "K",
"J", "L", "M" and IEC 61850 Edition 1 on page 7–58 (MICS For C650 relay V1_00 firm7_70)

• 7.3.7.3.6 TICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 option "H", "G", "K",
"J", "L", "M" and IEC 61850 Edition 1 on page 7–91 (TICS For C650 relay V1_00 firm7_70)

• 7.3.7.3.8 PIXIT for 650 family of relays whose order code has Rear Ethernet Communication Board 2 option "H", "G", "K",
"J", "L", "M" and IEC 61850 Edition 1 on page 7–101 (PIXIT For C650 relay V1_00 firm7_70)
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7.3.7.3.1  PICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 
"H", "G", "K", "J","L", "M" and IEC 61850 Edition 2

Reference documentation: PICS for 650 family of relays v1_2 firm7_20.

This document describes the:

• ACSI Conformance Statement

• PICS ("Protocol Implementation Conformance Statement") for 650 family of relays.

1  ACSI Conformance Statement

The following ACSI conformance statements shall be used to provide an overview and details about a device claiming 
conformance with ACSI to specify the communication features mapped to an SCSM:

• ACSI BASIC conformance statement.

• ACSI MODELS conformance statement.

• ACSI SERVICE conformance statement.

The statements specify the communication features mapped to IEC 61850-8-1 First Edition and/or Edition 2.

1.1 Notation

For the following clauses, these definitions apply:

• Y: The item is implemented.

• N: The item is not implemented.

• AA: Application Association.

• TP: Two-party (application association).

• MC: Multicast (application association).

1.2 ASCI basic conformance statement 

The basic conformance statement is defined in Table 7-2: Basic conformance statement

Table 7-2:  Basic conformance statement

Client/
Subscriber

Server/
Publisher

Value/ Comments

Client-Server roles

B11 Server side (of TWO-PARTY-APPLICATION-ASSOCIATION) Y

B12 Client side of (TWO-PARTY-APPLICATION-ASSOCIATION)

SCSMs supported

B21 SCSM: IEC 6185-8-1 used Y

B22 SCSM: IEC 6185-9-1 used Ed2:Deprecated

B23 SCSM: IEC 6185-9-2 used

B24 SCSM: other
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1.3 ACSI models conformance statement 

The ACSI models conformance statement is defined in Table 7-3: ACSI models conformance statement.

Table 7-3: ACSI models conformance statement

Generic substation event model (GSE)

B31 Publisher side Y

B32 Subscriber side Y

Transmission of sampled value model (SVC)

B41 Publisher side

B42 Subscriber side

–
Y = supported
N or empty = not supported

Client /
Subscriber

Server /
Publisher

Value / Comments

If Server or Client side (B11/12) supported

M1 Logical device Y

M2 Logical node Y
M3 Data Y
M4 Data set Y
M5 Substitution N
M6 Setting group control N

Reporting
M7 Buffered report control Y
M7-1 sequence-number Y
M7-2 report-time-stamp Y
M7-3 reason-for-inclusion Y
M7-4 data-set-name Y
M7-5 data-reference Y
M7-6 buffer-overflow Y
M7-7 entryID Y
M7-8 BufTm Y
M7-9 IntgPd Y
M7-10 GI Y
M7-11 conf-revision Y
M8 Unbuffered report control Y
M8-1 sequence-number Y
M8-2 report-time-stamp Y
M8-3 reason-for-inclusion Y
M8-4 data-set-name Y
M8-5 data-reference Y
M8-6 BufTm Y
M8-7 IntgPd Y
M8-8 GI Y
M8-9 conf-revision Y

Logging
M9 Log control
M9-1 IntgPd
M10 Log
M11 Control Y
M17 File Transfer Y
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1.4 ACSI service conformance statement

The ACSI service conformance statement is defined in Table 7-4: ACSI service conformance statement.

Table 7-4: ACSI service conformance statement

M18 Application association Y
M19 GOOSE Control Block Y
M20 Sampled Value Control Block
If GSE (B31/32) is supported

M12 GOOSE Y
M13 GSSE Deprecated
If SVC (B41/B42) is supported

M14 Multicast SVC
M15 Unicast SVC
For all IEDs

M16 Time Y Y
Y = service is supported
N or empty = service is not supported

Ed ACSI Service AA:
TP/MC

Client
Sub(C) 

Server
Pub(S)

Comments

Server 
S1 1,2 GetServerDirectory(LOGICAL-DEVICE) TP Y

Application association 
S2 1,2 Associate TP Y
S3 1,2 Abort TP Y
S4 1,2 Release TP Y

Logical device 
S5 1,2 GetLogicalDeviceDirectory TP Y

Logical node 
S6 1,2 GetLogicalNodeDirectory TP Y
S7 1,2 GetAllDataValues TP Y

Data 
S8 1,2 GetDataValues TP Y
S9 1,2 SetDataValues TP Y
S10 1,2 GetDataDirectory TP Y
S11 1,2 GetDataDefinition TP Y

Data set 
S12 1,2 GetDataSetValues TP Y
S13 1,2 SetDataSetValues TP N
S14 1,2 CreateDataSet TP N
S15 1,2 DeleteDataSet TP N
S16 1,2 GetDataSetDirectory TP Y

Substitution 
S17 1 SetDataValues TP N Ed1 only

Setting group control 
S18 1,2 SelectActiveSG TP Y
S19 1,2 SelectEditSG TP Y
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S20 1,2 SetEditSGValues TP Y
S21 1,2 ConfirmEditSGValues TP Y
S22 1,2 GetEditSGValues TP Y
S23 1,2 GetSGCBValues TP Y

Reporting 
Buffered report control block (BRCB)
S24 1,2 Report TP Y
S24-1 1,2 data-change (dchg) Y
S24-2 1,2 quality-change (qchg) Y
S24-3 1,2 data-update (dupd) N
S25 1,2 GetBRCBValues TP Y
S26 1,2 SetBRCBValues TP Y
Unbuffered report control block (URCB)
S27 1,2 Report TP Y
S27-1 1,2 data-change (dchg) Y
S27-2 1,2 quality-change (qchg) Y
S27-3 1,2 data-update (dupd) N
S28 1,2 GetURCBValues TP Y
S29 1,2 SetURCBValues TP Y

Logging 
Log control
S30 1,2 GetLCBValues TP N
S31 1,2 SetLCBValues TP N
Log
S32 1,2 QueryLogByTime TP N
S33 1,2 QueryLogAfter TP N
S34 1,2 GetLogStatusValues TP N

Generic substation event model (GSE) 
GOOSE
S35 1,2 SendGOOSEMessage MC Y
GOOSE Control Block
S36 1,2 GetGoReference TP
S37 1,2 GetGOOSEElementNumber TP
S38 1,2 GetGoCBValues TP Y
S39 1,2 SetGoCBValues TP Y
GSSE (Ed2:61850-7-2 Annex C)
S40 1,2 SendGSSEMessage MC N Deprecated
GSSE Control Block (Ed2:61850-7-2 Annex C)
S41 1,2 GetGsReference TP N Deprecated
S42 1,2 GetGSSEDataOffset TP N Deprecated
S43 1,2 GetGsCBValues TP N Deprecated
S44 1,2 SetGsCBValues TP N Deprecated

Transmission of sampled value model (SVC) 
Multicast SV
S45 1,2 SendMSVMessage MC N Use for 9-2LE or IEC 61869-9
Multicast Sampled Value Control Block
S46 1,2 GetMSVCBValues TP N
S47 1,2 SetMSVCBValues TP N
Unicast SV
S48 1,2 SendUSVMessage TP N
Unicast Sampled Value Control Block
S49 1,2 GetUSVCBValues TP N
S50 1,2 SetUSVCBValues TP N

Control
S51 1,2 Select TP Y SBO Normal Security
S52 1,2 SelectWithValue TP Y SBO Enhanced Security
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2 PICS (“Protocol Implementation Conformance Statement”)

The tables in sections below appear in the same sequence as in standard IEC 61850-8-1, section 24. 

The tables refer to part 7 of the standard and the corresponding information must be contained in the PICS.

2.1 Notation

For the following clauses, these definitions apply:

• Y: The item is implemented.

• N: The item is not implemented.

• X: Excluded. The implementation shall not implement this item.

• i: Out-of-scope. The implementation of the item is not within the scope of this standard.

• F/S: Functional Standard. Should be applied.

• Base: Shall be applied in any application claiming conformance to this standard.

2.2 Profile conformance

The following tables define the basic conformance statement.

2.2.1 PICS for A-Profile support

S53 1,2 Cancel TP Y
S54 1,2 Operate TP Y
S55 1,2 CommandTermination TP Y
S56 1,2 TimeActivatedOperate TP N

File transfer
S57 1,2 GetFile TP Y
S58 1,2 SetFile TP N
S59 1,2 DeleteFile TP N
S60 1,2 GetFileAttributeValues TP Y
S61 1,2 GetServerDirectory (FILE) TP Y

Time
T1 1,2 Time resolution of internal clock - 2ms nearest negative power of 2 in seconds
T2 2 Time accuracy of internal clock - TL (ms) (low accuracy), T3 < 7) (only Ed2)

1,2 - T0 (ms)  (<= 10 ms), 7 <= T3 < 9)
1,2 - T1 (µs)  (<= 1 ms), 10 <= T3 < 13
1,2 - T2 (µs)  (<= 100 µS), 13 <= T3 < 15
1,2 - T3 (µs) (<=  25 µS), 15 <= T3 < 18
1,2 - T4 (µs) (<=  4 µS), 18 <= T3 < 20
1,2 - Y T5 (µs) (<=  1 µS), T3 >= 20)

T3 1,2 Supported TimeStamp resolution - 1ms nearest negative power of 2 in seconds

A-Profile 
shortcut

Profile description Client Server Value/comment

realized realized

A1 Client/server A-profile N Y

A2 GOOSE/GSE Management A-profile Y Y Only GOOSE not GSE 
management

A3 GSSE A-profile Y Y

A4 Time sync A-profile Y N
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2.2.2 PICS for T-Profile support

Refer to the services of Part 7 to see whether these profiles are supported. No distinction is made between A- and T-
Profiles there because the definition only refers to the application.

2.3 MMS conformance

The following conformance statements are conditional upon the support of the client/server A-Profile (e.g. A1 see profile 
description in Clause 6) being declared.

Except where present, MMS conformance shall be in accordance with ISO/ISP 14226-2.

2.3.1 MMS Initiate conformance

2.3.1.1 MMS InitiateRequest general parameters

2.3.1.2 MMS InitiateResponse general parameters

A-Profile 
shortcut Profile description

Client Server
Value/comment

Realized Realized

T1 TCP/IP T-profile N Y

T2 OSI T-profile N N

T3 GOOSE/GSE T-profile Y Y Only GOOSE not GSE 
management

T4 GSSE T-profile Y Y

T5 TimeSync T-profile Y N

InitiateRequest
Client-CR Server-CR

Realized Value/range Realized Value/range

InitiateRequest

localDetailCalling Y

proposedMaxServOutstandingCalling Y

ProposedMaxServOustandingCalled Y

InitRequestDetail Y

InitiateRequestDetail

proposedVersionNumber Y

proposedParameterCBB Y

servicesSupportedCalling Y

additionalSupportedCalling N

additionalCbbSupportedCalling N

privilegeClassIdentityCalling N

InitiateRequest
Client-CR Server-CR

Realized Value/range Realized Value/range

InitiateResponse

localDetailCalled Y

negotiatedMaxServOutstandingCalling Y 1

negotiatedMaxServOustandingCalled Y 3

initResponseDetail Y

InitiateResponseDetail Y

negotiatedVersionNumber Y

negotiatedParameterCBB Y

servicesSupportedCalled Y

additionalSupportedCalled N

additionalCbbSupportedCalled N

privilegeClassIdentityCalled N
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2.3.2 MMS services supported conformance statement

This table defines the service support requirement, and restrictions, for this standard. Relationship to ACSI services can be 
found in Table 1 of Part 8-1.

MMS service supported CBB
Client-CR Server-CR

Realized Value/range Realized Value/range

status Y

getNameList Y

identify Y

rename N

read Y

write Y

getVariableAccessAttributes Y

defineNamedVariable N

defineScatteredAccess N

getScatteredAccessAttributes N

deleteVariableAccess N

defineNamedVariableList N

getNamedVariableListAttributes Y

deleteNamedVariableList N

defineNamedType N

getNamedTypeAttributes N

deleteNamedType N

Input N

Output N

takeControl N

relinquishControl N

defineSemaphore N

deleteSemaphore N

reportPoolSemaphoreStatus N

reportSemaphoreStatus N

initiateDownloadSequence N

downloadSegment N

terminateDownloadSequence N

initiateUploadSequence N

uploadSegment N

terminateUploadSequence N

requestDomainDownload N

requestDomainUpload N

loadDomainContent N

storeDomainContent N

deleteDomain N

getDomainAttributes Y

createProgramInvocation N

deleteProgramInvocation N

Start N

Stop N

Resume N

Reset N

Kill N

getProgramInvocationAttributes N
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2.3.3 MMS parameter Conformance Building Block (CBB)

obtainFile N

defineEventCondition N

deleteEventCondition N

getEventConditionAttributes N

reportEventConditionStatus N

alterEventConditionMonitoring N

triggerEvent N

defineEventAction N

deleteEventAction N

alterEventEnrollment N

reportEventEnrollmentStatus N

getEventEnrollmentAttributes N

acknowledgeEventNotification N

getAlarmSummary N

getAlarmEnrollmentSummary N

readJournal N

writeJournal N

initializeJournal N

reportJournalStatus N

createJournal N

deleteJournal N

FileOpen Y

FileRead Y

FileClose Y

fileRename N

fileDelete N

fileDirectory Y

unsolicitedStatus N

informationReport Y

eventNotification N

attachToEventCondition N

attachToSemaphore N

Conclude Y

Cancel Y

getDataExchangeAttributes N

exchangeData N

defineAccessControlList N

getAccessControlListAttributes N

reportAccessControlledObjects N

deleteAccessControlList N

alterAccessControl N

reconfigureProgramInvocation N

MMS parameter CBB
Client-CR Server-CR

Realized Value/range Realized Value/range

STR1 Y

STR2 Y

VNAM Y

VALT Y
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2.3.4 GetNameList conformance statement

2.3.5 Variable access conformance statement

2.3.5.1 Supporting productions

2.3.5.1.1 AlternateAccessSelection conformance statement

VADR N

VSCA N

TPY N

VLIS Y

REAL N

CEI N

NEST Y 7

ACO N

SEM N

CSR N

CSNC N

CSPLC N

CSPI N

GetNameList
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

ObjectClass Y

ObjectScope Y

DomainName Y

ContinueAfter Y

Response+

List Of Identifier Y

MoreFollows Y

Response–

Error Type Y

NOTE Object class ‘vmd' (formerly VMDSpecific in MMS V1.0) shall not appear. If a request contains this ObjectClass, an MMS 
Reject shall be issued.

AlternateAccessSelection
Client-CR Server-CR

Realized Value/range Realized Value/range

accessSelection Y

component Y

index N

indexRange N

allElements N

alternateAccess Y

selectAccess Y

component Y

index N

indexRange N

allElements N
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2.3.5.1.2 VariableAccessSpecification conformance statement

2.3.5.1.3 VariableSpecification conformance statement

2.3.5.2 Read conformance statement

2.3.5.3 Write conformance statement

2.3.5.4 InformationReport conformance statement

VariableAccessSpecification
Client-CR Server-CR

Realized Value/range Realized Value/range

listOfVariable Y

variableSpecification Y

alternateAccess Y

variableListName Y

VariableSpecification
Client-CR Server-CR

Realized Value/range Realized Value/range

name Y

address N

variableDescription N

scatteredAccessDescription N

invalidated N

Read
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

specificationWithResult Y

variableAccessSpecification Y

Response

variableAccessSpecification Y

listOfAccessResult Y

Write
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

variableAccessSpecification Y

listOfData Y

Response

failure Y

success Y

InformationReport
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

variableAccessSpecification Y

listOfAccessResult Y
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2.3.5.5 GetVariableAccessAttributes conformance statement

2.3.5.6 GetNamedVariableListAttributes conformance statement

GetVariableAccessAttributes
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

name Y

address N

Response

mmsDeletable Y

address N

typeSpecification Y

GetNamedVariableListAttributes
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

ObjectName Y

Response

mmsDeletable Y

listOfVariable Y

variableSpecification Y

alternateAccess Y



CHAPTER 7:  IEC 61850 PROTOCOL 7.3 IEC 61850 PROFILE FOR C650

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 7-23

2.3.6 File management services

2.3.6.1 FileDirectory conformance statement

2.3.6.2 FileOpen conformance statement

2.3.6.3 FileRead conformance statement

2.3.6.4 FileClose conformance statement

FileDirectory
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

filespecification Y

continueAfter Y

Response+

listOfDirectoryEntry Y

MoreFollows Y

FileOpen
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

filename Y

initialPosition Y

Response+

frsmID Y

fileAttributes Y

FileRead
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

FrsmID Y

Response+

FileData Y

moreFollows Y

FileClose
Client-CR Server-CR

Realized Value/range Realized Value/range

Request

FrsmID Y

Response+ Y
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7.3.7.3.2  PICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 
option "H", "G", "K", "J", "L", "M" and IEC 61850 Edition 1

Reference documentation: PICS For C650 relay V1_00 firm7_70.

This document describes the:

• ACSI Conformance Statement

• PICS ("Protocol Implementation Conformance Statement") for 650 family of relays.

1 General

The following ACSI conformance statements are used to provide an overview and details about C650 bay controller, with 
firmware 7.70 and above:

• ACSI BASIC conformance statement.

• ACSI MODELS conformance statement.

• ACSI SERVICE conformance statement.

The statements specify the communication features mapped to IEC 61850-8-1 First Edition and/or Edition 2.

2 ASCI basic conformance statement 

The basic conformance statement is defined in Table 7-5: Basic conformance statement

Table 7-5:  Basic conformance statement

Client/
Subscriber

Server/
Publisher

Value/Comments

Client-Server roles

B11 Server side (of TWO-PARTY-APPLICATION-ASSOCIATION) Y

B12 Client side of (TWO-PARTY-APPLICATION-ASSOCIATION)

SCSMs supported

B21 SCSM: IEC 6185-8-1 used Y

B22 SCSM: IEC 6185-9-1 used Ed2:Deprecated

B23 SCSM: IEC 6185-9-2 used

B24 SCSM: other

Generic substation event model (GSE)

B31 Publisher side Y

B32 Subscriber side Y

Transmission of sampled value model (SVC)

B41 Publisher side

B42 Subscriber side

–
Y = supported
N or empty = not supported
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3 ACSI models conformance statement 

The ACSI models conformance statement is defined in Table 7-6: ACSI models conformance statement.

Table 7-6: ACSI models conformance statement

Client/
Subscriber

Server/
Publisher

Value/Comments

If Server or Client side (B11/12) supported

M1 Logical device Y

M2 Logical node Y
M3 Data Y
M4 Data set Y
M5 Substitution
M6 Setting group control Y

Reporting
M7 Buffered report control Y
M7-1 sequence-number Y
M7-2 report-time-stamp Y
M7-3 reason-for-inclusion Y
M7-4 data-set-name Y
M7-5 data-reference Y
M7-6 buffer-overflow Y
M7-7 entryID Y
M7-8 BufTm Y
M7-9 IntgPd Y
M7-10 GI Y
M7-11 conf-revision Y
M8 Unbuffered report control Y
M8-1 sequence-number Y
M8-2 report-time-stamp Y
M8-3 reason-for-inclusion Y
M8-4 data-set-name Y
M8-5 data-reference Y
M8-6 BufTm Y
M8-7 IntgPd Y
M8-8 GI Y
M8-9 conf-revision Y

Logging
M9 Log control
M9-1 IntgPd
M10 Log
M11 Control Y
M17 File Transfer Y
M18 Application association Y
M19 GOOSE Control Block Y
M20 Sampled Value Control Block
If GSE (B31/32) is supported

M12 GOOSE Y
M13 GSSE Deprecated
If SVC (B41/B42) is supported

M14 Multicast SVC
M15 Unicast SVC
For all IEDs

M16 Time Y Y
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4 ACSI service conformance statement

The ACSI service conformance statement is defined in Table 7-7: ACSI service conformance statement.

Table 7-7: ACSI service conformance statement

Y = service is supported
N or empty = service is not supported

Ed ACSI Service AA:
TP/MC

Client
Sub(C) 

Server
Pub(S)

Comments

Server 
S1 1,2 GetServerDirectory(LOGICAL-DEVICE) TP Y

Application association 
S2 1,2 Associate TP Y
S3 1,2 Abort TP Y
S4 1,2 Release TP Y

Logical device 
S5 1,2 GetLogicalDeviceDirectory TP Y

Logical node 
S6 1,2 GetLogicalNodeDirectory TP Y
S7 1,2 GetAllDataValues TP Y

Data 
S8 1,2 GetDataValues TP Y
S9 1,2 SetDataValues TP Y
S10 1,2 GetDataDirectory TP Y
S11 1,2 GetDataDefinition TP Y

Data set 
S12 1,2 GetDataSetValues TP Y
S13 1,2 SetDataSetValues TP N
S14 1,2 CreateDataSet TP N
S15 1,2 DeleteDataSet TP N
S16 1,2 GetDataSetDirectory TP Y

Substitution 
S17 1 SetDataValues TP N Ed1 only

Setting group control 
S18 1,2 SelectActiveSG TP Y
S19 1,2 SelectEditSG TP Y
S20 1,2 SetEditSGValues TP Y
S21 1,2 ConfirmEditSGValues TP Y
S22 1,2 GetEditSGValues TP Y
S23 1,2 GetSGCBValues TP Y

Reporting 
Buffered report control block (BRCB)
S24 1,2 Report TP Y
S24-1 1,2 data-change (dchg) Y
S24-2 1,2 quality-change (qchg) Y
S24-3 1,2 data-update (dupd) N
S25 1,2 GetBRCBValues TP Y
S26 1,2 SetBRCBValues TP Y
Unbuffered report control block (URCB)
S27 1,2 Report TP Y
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S27-1 1,2 data-change (dchg) Y
S27-2 1,2 quality-change (qchg) Y
S27-3 1,2 data-update (dupd) N
S28 1,2 GetURCBValues TP Y
S29 1,2 SetURCBValues TP Y

Logging 
Log control
S30 1,2 GetLCBValues TP N
S31 1,2 SetLCBValues TP N
Log
S32 1,2 QueryLogByTime TP N
S33 1,2 QueryLogAfter TP N
S34 1,2 GetLogStatusValues TP N

Generic substation event model (GSE) 
GOOSE
S35 1,2 SendGOOSEMessage MC Y
GOOSE Control Block
S36 1,2 GetGoReference TP
S37 1,2 GetGOOSEElementNumber TP
S38 1,2 GetGoCBValues TP Y
S39 1,2 SetGoCBValues TP Y
GSSE (Ed2:61850-7-2 Annex C)
S40 1,2 SendGSSEMessage MC N Deprecated
GSSE Control Block (Ed2:61850-7-2 Annex C)
S41 1,2 GetGsReference TP N Deprecated
S42 1,2 GetGSSEDataOffset TP N Deprecated
S43 1,2 GetGsCBValues TP N Deprecated
S44 1,2 SetGsCBValues TP N Deprecated

Transmission of sampled value model (SVC) 
Multicast SV
S45 1,2 SendMSVMessage MC N Use for 9-2LE or IEC 61869-9
Multicast Sampled Value Control Block
S46 1,2 GetMSVCBValues TP N
S47 1,2 SetMSVCBValues TP N
Unicast SV
S48 1,2 SendUSVMessage TP N
Unicast Sampled Value Control Block
S49 1,2 GetUSVCBValues TP N
S50 1,2 SetUSVCBValues TP N

Control
S51 1,2 Select TP Y SBO Normal Security
S52 1,2 SelectWithValue TP Y SBO Enhanced Security
S53 1,2 Cancel TP Y
S54 1,2 Operate TP Y
S55 1,2 CommandTermination TP Y
S56 1,2 TimeActivatedOperate TP N

File transfer
S57 1,2 GetFile TP Y
S58 1,2 SetFile TP N
S59 1,2 DeleteFile TP N
S60 1,2 GetFileAttributeValues TP Y
S61 1,2 GetServerDirectory (FILE) TP Y

Time
T1 1,2 Time resolution of internal clock - 2ms nearest negative power of 2 in seconds
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T2 2 Time accuracy of internal clock - TL (ms) (low accuracy), T3 < 7) (only Ed2)
1,2 - T0 (ms)  (<= 10 ms), 7 <= T3 < 10)
1,2 - T1 (µs)  (<= 1 ms), 10 <= T3 < 13
1,2 - T2 (µs)  (<= 100 µS), 13 <= T3 < 15
1,2 - T3 (µs) (<=  25 µS), 15 <= T3 < 18
1,2 - T4 (µs) (<=  4 µS), 18 <= T3 < 20
1,2 - Y T5 (µs) (<=  1 µS), T3 >= 20)

T3 1,2 Supported TimeStamp resolution - 1ms nearest negative power of 2 in seconds
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7.3.7.3.3  MICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 
option "H", "G", "K", "J", "L", "M" and IEC 61850 Edition 2

Reference documentation: MICS for 650 family of relays rev 1.05 firm 7_72.

This document describes the:

• Logical Nodes List

• Logical Nodes and Extensions

• Enum types implementation

1 Logical Node List

IEC61850 profile has been updated for C650 firmware version 7.00. The Firmware version 7.00 and above supports IEC 
61850 Edition 2. Several Logical Nodes have been added and they have been distributed according its functionality in two 
different Logical Devices, one for protection functions and the other for control and measure functions. LGOS (24 
instances), PTRC, RBRF, RFLO and CILO (16 instances) have been included. Other Logical Nodes like XSWI and CSWI have 
increased their instances to 16 for each one. GGIO nodes and the Logical Nodes for protection functions have suffered 
some extensions. 

For firmware 7.20 new logical nodes have been included in the data model such as RDRE, RBDR and PTTR. Other logical 
nodes like PTOF and PTUF have increased their instances to 6 for each one and suffered some extensions, and CSWI logical 
node has also extended its data model.

For firmware 7.72 new logical nodes have been included in the data model: LCCH, LTMS, SGCB, SCBR and vouGGIO.

L: System Logical Nodes

LPHD (Physical device information)

LLN0 (Logical node zero)

LCCH (Physical communication channel supervision)

LGOS (GOOSE subscription)

LTMS (Time master supervision)

GoCB (GOOSE Control Block class definition)

SGCB (Setting Group Control Block class definition)

C: Logical Nodes for control

CILO (Interlocking)

CSWI (Switch controller)

R: Logical nodes for protection related functions

RREC (Autoreclosing)

G: Logical Nodes for generic references

GGIO (Generic process I/O)

M: Logical Nodes for metering and measurement

MMXU (Measurement)

MSQI (Sequence and imbalance)

MMTR (Metering)

X: Logical Nodes for switchgear

XCBR (Circuit breaker)

XSWI (Circuit switch)

S: Logical Nodes for supervision and monitoring

SCBR (Circuit breaker supervision)
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2 Logical Nodes and Extensions

Notation: 

M: Data is mandatory in the IEC-61850-7-4.

O: Data is optional in the IEC-61850-7-4 and is used in the device.

E: Data is an extension to the IEC-61850-7-4.

2.1 System Logical Nodes. LN Group: L

2.1.1 LPHD (Physical device information)

2.1.2.1 LLN0 (geLLNO) Logical node zero --> one instance in Protection LDevice

2.1.2.2 LLN0 (geLLN0_LocSta) Logical node zero --> one instance in Control LDevice

LPHD class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

LPHD Physical device information M
Data
Common Logical Node Information
PhyNam geDPL Physical device name plate M
PhyHealth geHealthENS Physical device health M
Proxy geSPS Indicates if this LN is a proxy M

LLN0 class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

LLN0 Logical node zero
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL_1 Name plate M
Loc geSPS Local control behavior O
OpTmh geINS Operation time O
GoCB (ACSI class GOOSE control block)
GoCB GoCB

LLN0 class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

LLN0 Logical node zero
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL_1 Name plate M
Loc geSPS Local control behavior O
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2.1.3 LCCH (geLCCG) --> Physical communication channel supervision: one instance in Control LDevice

2.1.4 LGOS (LGOS) --> GOOSE subscription information: 24 instances in Control LDevice

For firmware version 7.00 or higher, this LN Logical is used for monitoring GOOSE messages, diagnosing the subscription 
state of a GOOSE message and has 24 instances inside the device.

2.1.5 GoCB (GOOSE control block class definition)

OpTmh geINS Operation time O
LocSta geSPC_2 Switching authority at station level O
GoCB (ACSI class GOOSE control block)
GoCB GoCB

LCCH class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

LCCH Logical node zero
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status Information
ChLiv geSPS Physical channel status M
RedChLiv geSPS Physical channel status of redundant 

channel
O

LGOS class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

LGOS GOOSE Subscription
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL_1 Name plate M
Status Information
St geSPS Status of the subscription M
LastStNum geINS Last status number received O
ConfRevNum geINS Expected conf. revision num. O
Settings
GoCBRef geORG Ref. to the subscribed GOOSE control 

block
O

GoCB class
Attribute Name Attribute Type FC Notes
GoEna BOOLEAN GO Enable (TRUE), disable (FALSE)
GoID VISIBLE STRING65 GO
DatSet Object Reference GO
ConfRev INT32U GO
NdsCom BOOLEAN GO
DstAddress PHYCOMADDR GO
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2.1.6 LTMS (geLTMS) --> Time Synchronization: one instance in Control LDevice

2.1.7 SGCB (Setting Group control block class definition)

2.2 Logical Nodes for control. LN Group: C

2.2.1 CSWI (Switch controller)

a) CSWI (geCSWI)

This logical node class is used for switchgear status and has 16 instances inside the device.

LTMS class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

LTMS Time master supervision
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status Information
TmSrc geVSS Current time source M

SGCB class
Attribute Name Attribute Type FC Notes
NumOfSG INT8U SE/SG Total number of settings group available in the LDevice. 

Fixed as 6
ActSG INT8U SE/SG
EditSG INT8U SE/SG
CnfEdit BOOLEAN SE/SG
LactTm TimeStamp SE/SG

CSWI class
Attribute Name Attribute Type Explanation M/O/E Notes
CSWI Switch controller
Data
Common Logical Node Information
Mod geModENC Mode M Status-only
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Controls
Loc geSPS Local operation M Local/Remote
Pos geDPC_1 Switch position M Breaker open, close
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2.2.2 CILO (Interlocking)

a) CILO (geCILO) --> 16 instance in Control LDevice

2.3 Logical Nodes for protection related functions. LN Group: R

2.3.1 RREC (Autoreclosing)

a) geRREC

This logical node class is used for autorecloser and has 1 instance inside the device.

CILO class
Attribute Name Attribute Type Explanation M/O/E Notes
CILO Switch controller
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status Information
EnaOpn geSPS Enable Open M
EnaCls geSPS Enable Close M

RREC class
Attribute Name Attr. Type Explanation M/O Notes
RREC Autoreclosing Element
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status Information
OpCls geGeneralACT Direction M
AutoRecSt geAutoRecStENS Operate M
AutoRecLo geINS_1 Block O
AutoRecBlk geINS_1 Block Input O
RecCyc INS Actual reclose cycle O
Settings
RRECEna geSPG Function O
MaxNumShot geING_0 Max. Number Shots O
Rec1Tmms1 geING_8 Dead Time 1 O
Rec1Tmms2 geING_8 Dead Time 2 O
Rec1Tmms3 geING_8 Dead Time 3 O
Rec1Tmms4 geING_8 Dead Time 4 O
RclTmms geING_8 Reclaim time
CondEna geSPG Cond. Permission
HoldTmms geFloatASG_1 Hold Time
RsTmms geFloatASG_1 Reset Time
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2.4 Logical Nodes for generic references. LN Group: G

2.4.1 GGIO (Generic process I/O)

a) GGIO (geGGIO) --> 4 instances in Control LDevice

This logical node class is used is used to map digital and analogue inputs of 6 I/O boards F, G, H and J, 2H, 2J.

GGIO class
Attribute Name Attr. Type Explanation M/O Notes
GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
BoardSt geSPS_1 Board status O
Ind1 geSPS Status contact input 1 O
Ind2 geSPS Status contact input 2 O
.. .. .. ..
Ind32 geSPS Status contact input 32 O
Ind33 geSPS Status contact output 1 O
.. .. ..
Ind48 geSPS Status contact output 16 O
Measured and metered values
AnIn1 geFloatMV Analog input 1 O
AnIn2 geFloatMV Analog input 2 O
.. .. ..
AnIn8 geFloatMV Analog input 8 O
Settings
VThrldA geIntASG_1 Voltage threshold A O
VThrldB geIntASG_1 Voltage threshold B O
VThrldC geIntASG_1 Voltage threshold C O
VThrldD geIntASG_1 Voltage threshold D O
DbceTmmsA geING_0 Debounce time A O
DbceTmmsB geING_0 Debounce time B O
DbceTmmsC geING_0 Debounce time C O
DbceTmmsD geING_0 Debounce time D O
InTyp01 geING_0 Type input 1 O
InTyp02 geING_0 Type input 2 O
.. .. .. ..
InTyp32 geING_0 Type input 32 O
DlInTmms01 geING_0 Delay time input 1 O
DlInTmms02 geING_0 Delay time input 2 O
.. .. .. ..
DlInTmms32 geING_0 Delay time input 32 O
OutLogic01 geING_0 Logic output 1 O
OutLogic02 geING_0 Logic output 2 O
.. .. .. ..
OutLogic16 geING_0 Logic output 16 O
OutTyp01 geING_0 Type output 1 O
OutTyp02 geING_0 Type output 2 O
.. .. ..
OutTyp16 geING_0 Type output 16 O
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b) geVirtualGGIO: 1 virtual inputs logical node

c) geEventsGGIO: 1 control events logical node

PlsOutTmms01 geING_0 Pulse time output 1 O
PlsOutTmms02 geING_0 Pulse time output 2 O
.. .. ..
PlsOutTmms16 geING_0 Pulse time output 16 O
Rng01 geING_0 Range analog input 1 O
Rng02 geING_0 Range analog input 2 O
.. .. .. ..
Rng08 geING_0 Range analog input 8 O
OscTmmsA geING_0 Oscillation time A O
OscTmmsB geING_0 Oscillation time B O
OscTmmsC geING_0 Oscillation time C O
OscTmmsD geING_0 Oscillation time D O
NumChgs geING_0 Number of transient changes O
SnpshtEvEna geSPG Snapshot Events enabled O

GGIO class

Attribute Name Attribute Type Explanation M/O/E Notes

GGIO Generic process I/O

Data

Common Logical Node Information

Mod geModENC Mode M

Beh geBehENS Behavior M

Health geHealthENS Health M

NamPlt geLPL Name plate M

Controls

DPCSO01 geSPC Virtual Input 1 O

DPCSO02 geSPC Virtual Input 2 O

.. .. .. ..

DPCSO64 geSPC Virtual Input 64 O

GGIO class

Attribute Name Attribute Type Explanation M/O/E Notes

GGIO Generic process I/O

Data

Common Logical Node Information

Mod geModENC Mode M

Beh geBehENS Behavior M

Health geHealthENS Health M

NamPlt geLPL Name plate M

Status information

Ind1 geSPS Control Event 1 O

Ind2 geSPS Control Event 2 O

......... .......... ............... ..........

Ind192 geSPS Control Event 32 O
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d) geRemoteInputsGGIO: 1 Remote Input logical node

e) geRemoteOutputsGGIO: 1 remote output logical node

GGIO class
Attribute Name Attr. Type Explanation M/O Notes
GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
Ind1 geSPS Remote digital input 1 O
Ind2 geSPS Remote digital input 2 O
.. .. .. ..
Ind64 SgePS Remote digital input 32 O
AnIn1 geFloatMV Remote float input 1 O
AnIn2 geFloatMV Remote float input 2 O
.. .. .. ..
AnIn8 FgeloatMV Remote float input 8 O
AnIn9 geIntMV_1 Remote integer input 1 O
AnIn10 geIntMV_1 Remote integer input 2 O
.. .. .. ..
AnIn16 geIntMV_1 Remote integer input 8 O
Settings
OscTmms geING_0 Oscillation time remote inputs O
NumChgs geING_0 Number of transient changes O
InRef1 ORG_1 Remote digital input 1 O
InRef64 ORG_1 Remote digital input 64 O
InRef65 ORG_1 Remote analog input 1 O
InRef80 ORG_1 Remote analog input 16 O

GGIO class
Attribute Name Attr. Type Explanation M/O Notes
GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
Ind1 geSPS Remote digital output 1 O
Ind2 geSPS Remote digital output 2 O
.. .. .. ..
Ind32 geSPS Remote digital output 32 O
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f) DigitalCountersGGIO: 1 digital counter logical node

GGIO class
Attribute Name Attr. Type Explanation M/O Notes
GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
Cnt1 geBCR_2 Digital counter 1 O
.. .. .. ..
Cnt8 geBCR_2 Digital counter 8 O
CntBlk1 geSPS_1 Digital counter 1 block O
.. .. ..
CntBlk8 geSPS_1 Digital counter 8 block O
CntHi1 geSPS_1 Digital counter 1 high O
.. .. ..
CntHi8 geSPS_1 Digital counter 8 high O
CntEq1 geSPS_1 Digital counter 1 equal O
.. .. ..
CntEq8 geSPS_1 Digital counter 8 equal O
CntLo1 geSPS_1 Digital counter 1 low O
.. .. ..
CntLo8 geSPS_1 Digital counter 8 low O
CntUp1 geSPS_1 Digital counter 1 up O
.. .. ..
CntUp8 geSPS_1 Digital counter 8 up O
CntDwn1 geSPS_1 Digital counter 1 down O
.. .. ..
CntDwn8 geSPS_1 Digital counter 8 down O
CntSetPre1 geSPS_1 Digital counter 1 set preset O
.. .. ..
CntSetPre8 geSPS_1 Digital counter 8 set preset O
CntRst1 geSPS_1 Digital counter 1 reset O
.. .. ..
CntRst8 geSPS_1 Digital counter 8 reset O
CntFrzRst1 geSPS_1 Digital counter 1 FreezeReset O
.. .. ..
CntFrzRst8 geSPS_1 Digital counter 8 FreezeReset O
CntFrzCnt1 geSPS_1 Digital counter 1 FreezeCount O
.. .. ..
CntFrzCnt8 geSPS_1 Digital counter 8 FreezeCount O
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g) vouGGIO (gevouGGIO) --> virtual outputs: 1 instance in Control LDevice

2.5 Logical Nodes for metering and measurement. LN Group: M

2.5.1 MMXU (Measurement)

a) geMMXU: 1 logical node

2.5.2 MSQI (Sequence and imbalance)

a) geMSQI: 1 logical node

GGIO class
Attribute Name Attribute Type Explanation M/O Notes
GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status Information
AnOutInt1 geIntMV_2 Virtual output analog Int32 1 O
... ... ...
AnOutInt50 geIntMV_2 Virtual output analog Int32 50 O
AnOutF1 geFloatMV_5 Virtual output analog Flt32 1 O
... ... ...
AnOutF50 geFloatMV_5 Virtual output analog Flt32 50 O

MMXU class
Attribute Name Attribute Type Explanation M/O/E Notes
MMXU Measurement
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Measured Values
TotW geFloatMV Total active power (P) O
TotVAr geFloatMV Total reactive power (Q) O
TotVA geFloatMV Total apparent power (S) O
TotPF geFloatMV Average power factor (PF) O
Hz geFloatMV Line frequency O
PPV geFloatDEL Phase to phase voltages (VL1L2,...) O
PhV geFloatPhsWYE Phase to ground voltages (VL1ER,...) O
A geFloatWYE Phase currents (IL1,...) O
AuxV geFloatCMV_1 Auxiliary phase voltage O
BusHz geFloatMV_1 Auxiliary phase voltage O

MSQI class
Attribute Name Attribute Type Explanation M/O Notes
MSQI Measurement
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
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2.5.3 MMTR (Metering)

a) geMMTR --> pulse counters (MMTR1) and energy calculation (MMTR2): 2 instances in Control LDevice

2.6 Logical Nodes for switchgear. LN Group: X

2.6.1 XCBR (Circuit Breaker)

geXCBR: 1 circuit breaker

Measured Values
SeqA geFloatSEQ O
SeqV geFloatSEQ O

MMTR class
Attribute Name Attribute Type Explanation M/O Notes
MMTR Measurement
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Measured Values
SupWh geBCR Pulse Counter 1/Real energy supply O
SupVArh geBCR Pulse Counter 2/Reactive energy supply O
DmdWh geBCR Pulse Counter 3/Real energy demand O
DmdVArh geBCR Pulse Counter 4/Reactive energy demand O
CntPsWh geFloatMV_1 Positive Wat Counter O
CntNgWh geFloatMV_1 Negative Wat Counter O
CntPsVArh geFloatMV_1 Positive VAR Counter O
CntNgVArh geFloatMV_1 Negative VAR Counter O

XCBR class
Attribute Name Attr. Type Explanation M/O Notes
XCBR Circuit breaker
Data
Common Logical Node Information
Mod geModENC Mode M
Beh BgeehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
Loc geSPS Local operation M Local / Remote
OpCnt geINS Operation counter M Breaker openings
SumSwARs O
CBOpCap geCBOpCapENS Cicruit breaker operating 

capability
O

Controls 
Pos geDPC_1 Switch position M Breaker open, close
BlkOpn geSPC_1 Block opening M Virtual output
BlkClr geSPC_1 Block closing M Virtual output
Settings
ThAlSwA geFloatASG_1 Maximum KI2t O
SumSwATmms geFloatASG_1 KI2t Integ. Time O
ExNumTr geIntASG_1 Maximum Openings O
ExNumTr1hr geIntASG_1 Max.Openings 1 hour O
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2.6.2 XSWI (Circuit switch)

a) geXSWI: 16 switchgear

2.7 Logical Nodes for supervision and monitoring. LN Group: S

2.7.1 SCBR (Circuit Breaker Supervision)

3. Common Data Class 

3.1 Common Data Class for status information

3.1.1 Single Point Status (SPS)

XSWI class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

XSWI Circuit switch
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
Loc geSPS Local operation M Local/Remote
EEHealth geEEHealthENS Ext. equipment health O
OpCnt INS Operation counter M Breaker openings
Controls 
Pos geDPC_2 Switch position M Breaker open, close
BlkOpn geSPC_1 Block opening M Virtual output
BlkClr geSPC_1 Block closing M Virtual output
SwTyp geSwTypENS Switch type M
SwOpCap geSwOpCapENS Switch operating capability

SCBR class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

SCBR Circuit breaker
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
ColOpn geSPS Open command of trip coil M
AbrAlm geSPS Contact abrasion alarm O
OpTmOpnAlm geSPS_1 Opening time exceed O
OpTmClsAlm geSPS_1 Closing time exceed O
Measured Values
AccAbr geFloatMV_4 Cumulated abrasion O
OpTmOpn geFloatMV_4 Operation time open O
OpTmCls geFloatMV_4 Operation time close O

SPS class (Single point status)
geSPS
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Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Boolean ST dchg M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geSPS_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Boolean ST dchg M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
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3.1.2 Integer Status (INS)

3.1.3 Enumerated Status (ENS)

INS class (Integer status)
geINS
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal INT32 ST dchg M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geINS_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Boolean ST dchg M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M

ENS class (Enumerated status)
geAutoRecStENS (AutoRecSt)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enum ST dchg Ready,InProgress,Successful,.. M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geBehENS (Beh)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enum ST dchg On,blocked,test,test/blocked,Off M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geHealthENS (Health)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enum ST dchg Ok,Warning,Alarm M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geEEHealthENS (EEHealth)
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3.1.4 Protection activation information (ACT)

Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal INT32 ST dchg Ok,Warning,Alarm M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geCBOpCapENS (CBOpCap)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enumerated ST dchg None,Open,Close-Open,… M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geSwOpCapENS (SwOpCap)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enumerated ST dchg None,Open,Close,… M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geSwTypENS (SwTyp)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enumerated ST dchg Load Break,Disconnector,… M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O

ACT class (Protection activation information)
gePhsACT
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
phsA Boolean ST dchg O
phsB Boolean ST dchg O
phsC Boolean ST dchg O
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
gePhsACT_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C
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DataAttribute
control and status
general Boolean ST dchg M
phsA Boolean ST dchg O
phsB Boolean ST dchg O
phsC Boolean ST dchg O
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geNeutACT
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
neut Boolean ST dchg O
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
geNeutACT_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
neut Boolean ST dchg O
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geGeneralACT
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
geGeneralACT_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
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3.1.5 Directional protection activation information (ACD)

ACD class (Directional protection activation information)
gePhsACD
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
phsA Boolean ST Dchg GC_2(1)
dirPhsA Enumerated (Byte) ST dchg unknown | forward | backward GC_2(1)
phsB Boolean ST dchg GC_2(2)
dirPhsB Enumerated (Byte) ST dchg unknown | forward | backward GC_2(2)
phsC Boolean ST dchg GC_2(3)
dirPhsC Enumerated (Byte) ST dchg unknown | forward | backward GC_2(3)
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
gePhsACD_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
phsA Boolean ST Dchg GC_2(1)
dirPhsA Enumerated (Byte) ST dchg unknown | forward | backward GC_2(1)
phsB Boolean ST dchg GC_2(2)
dirPhsB Enumerated (Byte) ST dchg unknown | forward | backward GC_2(2)
phsC Boolean ST dchg GC_2(3)
dirPhsC Enumerated (Byte) ST dchg unknown | forward | backward GC_2(3)
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geNeutACD
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geNeutACD_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geGeneralACD
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
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3.1.6 Binary counter reading (BCR)

3.2 Common data class specifications for measurand information

DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O

BCR class (Binary counter reading)
geBCR
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
actVal Int64 ST Dchg M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
units Unit CF O
pulsQty Float32 CF M
d Vstring255 DC O
geBCR_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
actVal Int64 ST dchg M
frVal Int64 ST dchg GC_2_1
frTm Utctime ST GC_2_1
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
pulsQty Float32 CF M
frEna Boolean CF GC_2_1
strTm Utctime CF GC_2_1
frPd Int32 CF GC_2_1
frRs Boolean CF GC_2_1
d Vstring255 DC O
geBCR_2
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
actVal Int64 ST dchg M
frVal Int64 ST dchg GC_2_1
frTm Utctime ST GC_2_1
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
pulsQty Float32 CF M
frEna Boolean CF GC_2_1
strTm Utctime CF GC_2_1
frPd Int32 CF GC_2_1
frRs Boolean CF GC_2_1
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
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3.2.1 Measured Value (MV) 

MV class (Measured value)
geFloatMV
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instMag
f

FloatAnalogueValue MX ------ O
FLOAT32 GC_1

mag
f

FloatAnalogueValue MX dchg M
FLOAT32 GC_1

range ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
 ENUMERATED(Byte) M
 ENUMERATED(Byte) O

db  INT32U CF O
zeroDb INT32U CF O
rangeC
hhLim
f
hlim
f
lLim
f
llLim
f
min
f
max
f
limDb

RangeConfig CF O
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
INT32U

d Vstring255 DC O
geFloatMV_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instMag
f

FloatAnalogueValue MX ------ O
FLOAT32 GC_1

mag
f

FloatAnalogueValue MX dchg M
FLOAT32 GC_1

range ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

db INT32U CF O
zeroDb INT32U CF O
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rangeC
hhLim
f
hlim
f
lLim
f
llLim
f
min
f
max
f
limDb

RangeConfig CF O
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
INT32U

d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geFloatMV_2
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
mag
f

FloatAnalogueValue MX dchg M
FLOAT32 GC_1

q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geFloatMV_3
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
mag
f

FloatAnalogueValue MX dchg M
FLOAT32 GC_1

q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

d Vstring255 DC O
geIntMV
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instMag
i

IntAnalogueValue MX ------ O
INT32 GC_1

mag
i

IntAnalogueValue MX dchg M
INT32 GC_1

q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

db INT32U CF O
d Vstring255 DC O
geIntMV_1
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3.2.2 Complex Measured Value (CMV)

Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instMag
i

IntAnalogueValue MX ------ O
INT32 GC_1

mag
i

IntAnalogueValue MX dchg M
INT32 GC_1

range ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

db INT32U CF O
zeroDb INT32U CF O
rangeC
hhLim
i
hlim
i
lLim
i
llLim
i
min
i
max
i
limDb

RangeConfig CF O
IntAnalogueValue
INT32U GC_1
IntAnalogueValue
UINT32 GC_1
IntAnalogueValue
INT32U GC_1
IntAnalogueValue
INT32U GC_1
IntAnalogueValue
INT32U GC_1
IntAnalogueValue
INT32U GC_1
INT32U

d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M

CMV class (Complex measured value)
geFloatCMV
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instCVal
mag
f

FloatVector MX ------ O
FloatAnalogueValue
FLOAT32

cVal
mag
f

FloatVector MX dchg M
FloatAnalogueValue
FLOAT32

range ENUMERATED(Byte) MX dchg O
rangeAng ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
configuration, description and extension
units
SIUnit
Multiplier

Unit CF O
Byte M
Byte O

db INT32U CF O
dbAng INT32U CF O
zeroDb INT32U CF O
rangeC RangeConfig CF O
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3.2.3 Phase to ground related measured values of a three phase system (WYE)

rangeAngC RangeConfig CF O
d Vstring255 DC O
geFloatCMV_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instCVal
mag
f

FloatVector MX ------ O
FloatAnalogueValue
FLOAT32

cVal
mag
f

FloatVector MX dchg M
FloatAnalogueValue
FLOAT32

range ENUMERATED(Byte) MX dchg O
rangeAng ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
configuration, description and extension
units
SIUnit
Multiplier

Unit CF O
Byte M
Byte O

db INT32U CF O
dbAng INT32U CF O
zeroDb INT32U CF O
rangeC RangeConfig CF O
rangeAngC RangeConfig CF O
d Vstring255 DC O
dataNs Vstring255 EX M

 WYE class
geFloatPhsWYE
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
Data
phsA CMV_0 GC_1
phsB CMV_0 GC_1
phsC CMV_0 GC_1
neut CMV_0 GC_1
configuration, description and extension
d Vstring255 DC O
geFloatWYE
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

Data
phsA CMV_0 GC_1
phsB CMV_0 GC_1
phsC CMV_0 GC_1
neut CMV_0 GC_1
net CMV_0 GC_1
res CMV_0 GC_1
configuration, description and extension
d Vstring255 DC O
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3.2.4 Phase to phase related measured values of a three phase system (DEL)

3.2.5 Sequence (SEQ)

3.3 Common data class specifications for controllable status information

3.3.1 Controllable single point (SPC).

DEL class (Phase to phase related measured values of a three phase system)
geFloatDEL
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
Data
phsAB CMV_0 GC_1
phsBC CMV_0 GC_1
phsCA CMV_0 GC_1
configuration, description and extension
d Vstring255 DC O

SEQ class ( Sequence )
geFloatSEQ
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

Data
c1 CMV_0 GC_1
c2 CMV_0 GC_1
c3 CMV_0 GC_1
Measured attributes
seqT enumerated MX Pos-neg-zero | dir-quad-zero O
configuration, description and extension
d Vstring255 DC O

SPC class
geSPC
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
stVal Boolean ST FALSE | TRUE AC_ST
q Quality ST AC_ST
t TimeStamp ST AC_ST
control and status
Oper ctlVal Boolean CO AC_CO_M

origin Originator CO AC_CO_M
orCat ENUMERATED M
orIdent OCTECT64 M
ctlNum INT8U CO M
T Btime6 CO M
Test Boolean CO M
Check ENUMERATED CO M

configuration, description and extension
ctlModel ENUMERATED CF ctlModel M
operTimeout INT32U CF AC_CO_O
d Vstring255 DC O
geSPC_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
stVal Boolean ST FALSE | TRUE AC_ST
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3.3.2 Controllable double point (DPC)

Q Quality ST AC_ST
t TimeStamp ST AC_ST
configuration, description and extension
ctlModel ENUMERATED CF ctlModel_1 M
d Vstring255 DC O

DPC class (Controllable double point)
geDPC
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
Oper ctlVal Boolean CO AC_CO_M

origin Originator CO,ST AC_CO_M
orCat ENUMERATED M
orIdent OCTECT64 M
ctlNum INT8U CO,ST M
T Btime6 CO M
Test Boolean CO M
Check ENUMERATED CO M

stVal CODE ENUM ST dchg intermediate-state | off | on | bad-
state

M

q BVstring13 ST qchg AC_ST
t Utctime ST AC_ST
configuration, description and extension
ctlModel ENUMERATED CF M
operTimeout INT32U CF AC_CO_O
d Vstring255 DC O
geDPC_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
Oper ctlVal Boolean CO AC_CO_M

origin Originator CO,ST AC_CO_M
orCat ENUMERATED M
orIdent OCTECT64 M
ctlNum INT8U CO,ST M
T Btime6 CO M
Test Boolean CO M
Check ENUMERATED CO M

Cancel
SBO
SBOw
stVal CODE ENUM ST dchg intermediate-state | off | on | bad-

state
M

q BVstring13 ST qchg AC_ST
t Utctime ST AC_ST
configuration, description and extension
ctlModel ENUMERATED CF M
sboTimeout INT32U CF AC_CO_O
sboClass ENUMERATED CF AC_CO_O
operTimeout INT32U CF AC_CO_O
d Vstring255 DC O
geDPC_2
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
stVal CODE ENUM ST dchg intermediate-state | off | on | bad-

state
M
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3.3.3 Controllable enumerated status (ENC).

3.4 Common data class specifications for status settings

3.4.1 Single point setting (SPG)

3.4.2 Integer status setting (ING)

q BVstring13 ST qchg AC_ST
t Utctime ST AC_ST
configuration, description and extension
ctlModel ENUMERATED CF M
d Vstring255 DC O

ENC class (Controllable integer status)
geModENC (type Mod)
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
 status
stVal Enum ST dcgh M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
ctlModel ENUMERATED CF M
d Vstring255 DC O

SPG class
geSPG
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setVal Boolean SP AC_NSG_M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX O
geSPG_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setVal Boolean SG AC_SG_M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX O

ING class
geING_0
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setVal Boolean SP AC_NSG_M
configuration, description and extension
minVal INT32 CF O
maxVal INT32 CF O
stepSize INT32 CF O
d Vstring255 DC O
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3.4.3 Enumerated status setting (ENG)

3.4.4 Object reference setting

dataNs Vstring255 EX O
geING_0_2
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setVal Boolean SG AC_SG_M
configuration, description and extension
minVal INT32 CF O
maxVal INT32 CF O
stepSize INT32 CF O
d Vstring255 DC O
dataNs Vstring255 EX O
geING_8
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setVal Boolean SP AC_NSG_M
configuration, description and extension
minVal INT32 CF O
maxVal INT32 CF O
stepSize INT32 CF O
d Vstring255 DC O
geING_8_2
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setVal Boolean SG AC_SG_M
configuration, description and extension
minVal INT32 CF O
maxVal INT32 CF O
stepSize INT32 CF O
d Vstring255 DC O

ENG class
geENG
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setVal Enumerated SP PolQty AC_NSG_M
configuration, description and extension
d Vstring255 DC O
geENG_2
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setVal Enumerated SG PolQty AC_SG_M
configuration, description and extension
d Vstring255 DC O

ORG class
geORG
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
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3.5 Common data class specifications for analogue settings

3.5.1 Analog setting (ASG)

setting
setSrcRef ObjectReference SP Object reference M
configuration, description and extension
d Vstring255 DC O

ASG class
geIntASG
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setMag
i

IntAnalogueValue SP AC_NSG_M
INT32 GC_1

configuration, description and extension
units Unit CF
minVal
i

IntAnalogueValue CF O
INT32 GC_1

maxVal
i

IntAnalogueValue CF O
INT32 GC_1

stepSize
i

IntAnalogueValue CF O
INT32 GC_1

d Vstring255 DC O
geIntASG_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setMag
i

IntAnalogueValue SP AC_NSG_M
INT32 GC_1

configuration, description and extension
units Unit CF
minVal
i

IntAnalogueValue CF O
INT32 GC_1

maxVal
i

IntAnalogueValue CF O
INT32 GC_1

stepSize
i

IntAnalogueValue CF O
INT32 GC_1

d Vstring255 DC O
dataNs Vstring255 EX O
geIntASG_3
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setMag
i

IntAnalogueValue SG AC_SG_M
INT32 GC_1

configuration, description and extension
units Unit CF
minVal
i

IntAnalogueValue CF O
INT32 GC_1

maxVal
i

IntAnalogueValue CF O
INT32 GC_1

stepSize
i

IntAnalogueValue CF O
INT32 GC_1

d Vstring255 DC O
geFloatASG
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
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3.6 Common data class specifications for description information

3.6.1 Device name plate (DPL)

setMag
f

FloatAnalogueValue SP AC_NSG_M
FLOAT32 GC_1

configuration, description and extension
Units Unit CF
minVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

maxVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

stepSize
f

FloatAnalogueValue CF O
FLOAT32 GC_1

d Vstring255 DC O
geFloatASG_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setMag
f

FloatAnalogueValue SP AC_NSG_M
FLOAT32 GC_1

configuration, description and extension
Units Unit CF
minVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

maxVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

stepSize
f

FloatAnalogueValue CF O
FLOAT32 GC_1

d Vstring255 DC O
dataNs Vstring255 EX O
geFloatASG_2
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
setting
setMag
f

FloatAnalogueValue SG AC_SG_M
FLOAT32 GC_1

configuration, description and extension
Units Unit CF
minVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

maxVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

stepSize
f

FloatAnalogueValue CF O
FLOAT32 GC_1

d Vstring255 DC O

DPL class (Device name plate)
geDPL
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
vendor Vstring255 DC M
hwRev Vstring255 DC O
swRev Vstring255 DC O
serNum Vstring255 DC O
model Vstring255 DC O
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3.6.2 Logical node name plate (LPL)

LPL class (Logical node name plate)
geLPL
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
control and status
vendor Vstring255 DC M
swRev Vstring255 DC M
d Vstring255 DC M
configRev Vstring255 DC AC_LN0_M
geLPL_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
vendor Vstring255 DC M
swRev Vstring255 DC M
d Vstring255 DC M
configRev Vstring255 DC AC_LN0_M
ldNs Vstring255 EX O
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7.3.7.3.4  MICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 
option "H", "G", "K", "J", "L", "M" and IEC 61850 Edition 1

Reference documentation: MICS For C650 relay V1_00 firm7_70.

This model implementation conformance statement is applicable for C650 Bay Controller, with firmware 7.70 or above.

This MICS document specifies the modeling extensions compared to IEC 61850 edition 1. For the exact details on the 
standardized model please compare the ICD substation configuration file: “<default_C650E_v770_Ed1.cid>”, version <1.0>.

This document describes the:

• Logical Nodes List

• Logical Nodes and Extensions

• Enum types implementation

1 Logical Node List

The following table contains the list of logical nodes implemented in the device:

* Only present in Enhanced models

2 Logical Nodes and Extensions

Notation: 

• M: Data is mandatory in the IEC-61850-7-4.

• O: Data is optional in the IEC-61850-7-4 and is used in the device.

• E: Data is an extension to the IEC-61850-7-4.

L: System Logical Nodes

LPHD (Physical device information)

LLN0 (Logical node zero)

GoCB (GOOSE Control Block Class definition)

R: Logical nodes for protection related functions

RBDR (Disturbance recorder channel binary)

RDRE (Disturbance recorder function)

RREC (Autoreclosing)*

RSYN (Synchrocheck)*

C: Logical Nodes for control

CILO (Interlocking)

CSWI (Switch controller)

G: Logical Nodes for generic references

GGIO (Generic process I/O)

M: Logical Nodes for metering and measurement

MMTR (Metering)

MMXU (Measurement)

MSQI (Sequence and imbalance)

X: Logical Nodes for switchgear

XCBR (Circuit breaker)

XSWI (Circuit switch)
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2.1 System Logical Nodes. LN Group: L

2.1.1 LPHD (Physical device information)

2.1.2 LLN0 (Logical node zero)

2.1.3 GoCB (GOOSE control block class definition)

LPHD class
Attribute
 Name

Attr. 
Type

Explanation M/O Notes

LPHD Physical device information M
Data
Common Logical Node Information
PhyNam geDPL Physical device name plate M
PhyHealth geHealthINS Physical device health M
Proxy geSPS Indicates if this LN is a proxy M

LLN0 class
Attribute
 Name

Attr. 
Type

Explanation M/O Notes

LLN0 Logical node zero
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL_1 Name plate M
Loc geSPS Local control behavior O
OpTmh geINS Operation time O
GoCB (ACSI class GOOSE control block)
GoCB GoCB

GoCB class
Attribute Name Attribute Type FC Notes
GoEna BOOLEAN GO Enable (TRUE), disable (FALSE)
GoID VISIBLE STRINGS GO
DatSet Object Reference GO
ConfRev INT32U GO
NdsCom BOOLEAN GO
DstAddress PHYCOMADDR GO
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2.2 Logical Nodes for protection related functions. LN Group: R

2.2.1 RREC (Autoreclosing)*

2.2.1.1 geRREC

This logical node class is used for autorecloser and has 1 instance inside the device.

*Only present in Enhanced models

2.2.2 RSYN (Synchronism-check)*

2.2.2.1 RSYN

This logical node class is used modeling the synchrocheck function and has 1 instance inside the device

RREC class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

RREC Autoreclosing Element
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Status Information
Op geGeneralACT M
OpCls geGeneralACT Direction M
AutoRecSt geAutoRecStINS Operate M
AutoRecLo geINS_1 Block O
AutoRecBlk geINS_1 Block Input O
Settings
RRECEna geSPG Function O
MaxNumShot geING_0 Max. Number Shots O
Rec1Tmms1 geING_8 Dead Time 1 O
Rec1Tmms2 geING_8 Dead Time 2 O
Rec1Tmms3 geING_8 Dead Time 3 O
Rec1Tmms4 geING_8 Dead Time 4 O
RclTmms geING_8 Reclaim time
CondEna geSPG Cond. Permission
HoldTmms geFloatASG_1 Hold Time
RsTmms geFloatASG_1 Reset Time

RSYN class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

RSYN Synchronism-check
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Status Information
Blk geSPS Block signal O
SynOp geSPS_1 Closing permission signal O
Rel geSPS Release M
SynCondOp geSPS_1 Closing perm. according to logic O
DLDBOp geSPS_1 Closing perm. in DLDB condition O
DLLBOp geSPS_1 Closing perm. in DLLB condition O
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*Only present in Enhanced models

2.2.3 RDRE (Disturbance recorder function)

This logical node class is used modeling the disturbance recording function and has 1 instance inside the device. RBDR and 
RDRE logical nodes make available all attributes needed for the COMTRADE file.

LLDBOp geSPS_1 Closing perm. in LLDB condition O
HzInd geSPS Frequency difference indicator O
BusHzHiLinHz geSPS_1 Busbar frequency > line frequency O
BusHzLoLinHz geSPS_1 Busbar frequency < line frequency O
Measured values
DifVClc geFloatMV Calculated difference in voltage O
DifHzClc geFloatMV Calculated difference in frequency O
DifAngClc geFloatMV Calculated difference in angle O
Settings
RSYNEna geSPG Function O
DeaBusVal geFloatASG Dead bus value O
LivBusVal geFloatASG Live bus value O
DeaLinVal geFloatASG Dead line value O
LivLinVal geFloatASG Live line value O
DifV geFloatASG Difference voltage O
DifAng geFloatASG Difference angle O
DifHz geIntASG Difference frequency O
TotTmms geING_8 Total time of synch. process O
DLDBEna geSPG Dead line - dead bus permission O
LLDBEna geSPG Live line  - dead bus permission O
DLLBEna geSPG Dead line - live bus permission O
EventEna geSPG Snapshot events enabled O

RDRE class
Attribute Name Attribute type Explanation M/O/C/E Notes
RDRE Disturbance recorder
Data
Common Logical Node Information
Mod geModINC Mode M Status-only
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name Plate M
Status information
RcdMade geSPS Recording made M
FltNum geINS Fault number M
CycRcd geINS_1 Cycles per record O
RcdNum geINS_1 Available records O
Controls
RcdTrg geSPC_1 Trigger recorder M
Settings
RDREEna geSPG Oscillography function enable O
TrgPos geINS_0 Trigger position O
SmpCyc geINS_10 Samples per cycle O
MaxNumRcd geINS_8 Maximum number of records O
RcdMod geINS_11 Recorder operation mode O
EventEna geSPG Snapshot events enabled O
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2.2.4 RBDR (Disturbance recorder channel binary):

This logical node class is used for providing the circuit component and phase identification and has 1 instance inside the 
device. RBDR and RDRE logical nodes make available all attributes needed for the COMTRADE file.

2.3 Logical Nodes for control. LN Group: C

2.3.1 CSWI (Switch controller)

2.3.1.1 geCSWI 

In the CF650 there are up to 16 configurable switchgear.

2.3.2 CILO (Interlocking)

2.3.2.1 geCILO --> 16 switchgear

RBDR class
Attribute Name Attribute type Explanation M/O/C/E Notes
RBDR Disturbance recorder channel binary
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name Plate M
Status information
ChTrg geSPS Channel triggered M
FltNum geINS Fault Number M
DigCh01 geSPS_1 Oscillography digital channel 1 O
… … … …
DigCh16 geSPS_1 Oscillography digital channel 16 O

CSWI class
Attribute Name Attribute Type Explanation M/O/E Notes
CSWI Switch controller
Data
Common Logical Node Information
Mod geModINC Mode M Status-only
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Controls
Loc geSPS Local operation M Local/Remote
Pos geDPC_3 Switch position M Switch open, close, undefined

CILO class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

CILO Switch controller
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Status Information
EnaOpn geSPS Enable Open M
EnaCls geSPS Enable Close M
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2.4 Logical Nodes for generic references. LN Group: G

2.4.1 GGIO (Generic process I/O)

2.4.1.1 geBoardGGIO --> 4 instances in Control LDevice

This logical node class is used is used to map digital and analogue inputs of I/O boards F, G, H, J, 2H and 2J. 

GGIO class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Status information
BoardSt geSPS_1 Board status O
Ind1 geSPS Status contact input 1 O
Ind2 geSPS Status contact input 2 O
.. .. .. ..
Ind32 geSPS Status contact input 32 O
Ind33 geSPS Status contact output 1 O
.. .. ..
Ind48 geSPS Status contact output 16 O
Measured and metered values
AnIn1 geFloatMV Analog input 1 O
AnIn2 geFloatMV Analog input 2 O
.. .. ..
AnIn8 geFloatMV Analog input 8 O
Settings
VThrldA geIntASG_1 Voltage threshold A O
VThrldB geIntASG_1 Voltage threshold B O
VThrldC geIntASG_1 Voltage threshold C O
VThrldD geIntASG_1 Voltage threshold D O
DbceTmmsA geING_0 Debounce time A O
DbceTmmsB geING_0 Debounce time B O
DbceTmmsC geING_0 Debounce time C O
DbceTmmsD geING_0 Debounce time D O
InTyp01 geING_0 Type input 1 O
InTyp02 geING_0 Type input 2 O
.. .. .. ..
InTyp32 geING_0 Type input 32 O
DlInTmms01 geING_0 Delay time input 1 O
DlInTmms02 geING_0 Delay time input 2 O
.. .. .. ..
DlInTmms32 geING_0 Delay time input 32 O
OutLogic01 geING_0 Logic output 1 O
OutLogic02 geING_0 Logic output 2 O
.. .. .. ..
OutLogic16 geING_0 Logic output 16 O
OutTyp01 geING_0 Type output 1 O
OutTyp02 geING_0 Type output 2 O
.. .. ..
OutTyp16 geING_0 Type output 16 O
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2.4.1.2 geVirtualGGIO

This logical node class is used is used to map the latched and self reset virtual Inputs.

2.4.1.3 geEventsGGIO

This logical node class is used to map data from the list of any all internal digital states (PLC control events).

PlsOutms01 geING_0 Pulse time output 1 O
PlsOutms02 geING_0 Pulse time output 2 O
.. .. ..
PlsOutms16 geING_0 Pulse time output 16 O
Rng01 geING_0 Range analog input 1 O
Rng02 geING_0 Range analog input 2 O
.. .. .. ..
Rng08 geING_0 Range analog input 8 O
OscTmmsA geING_0 Oscillation time A O
OscTmmsB geING_0 Oscillation time B O
OscTmmsC geING_0 Oscillation time C O
OscTmmsD geING_0 Oscillation time D O
NumChgs geING_0 Number of transient changes O
EventEna geSPG Snapshot Events enabled O

GGIO class

Attribute
 Name

Attribute 
Type

Explanation M/O/E Notes

GGIO Generic process I/O

Data

Common Logical Node Information

Mod geModINC Mode M Status-only

Beh geBehINS Behavior M

Health geHealthINS Health M

NamPlt geLPL Name plate M

Controls

DPCSO01 geSPC Virtual input 1 O

DPCSO01 geSPC Virtual input 2 O

.. .. .. ..

DPCSO64 geSPC Virtual input 32 O

GGIO class

Attribute
Name

Attribute 
Type

Explanation M/O/E Notes

GGIO Generic process I/O

Data

Common Logical Node Information

Mod geModINC Mode M

Beh geBehINS Behavior M

Health geHealthINS Health M

NamPlt geLPL Name plate M

Status information

Ind1 geSPS Control Event 1 O

Ind2 SPS Control Event 2 O

......... .......... ............... ..........

Ind192 SPS Control Event 32 O
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2.4.1.4 geRemoteInputsGGIO

This logical node class is used to map data from incoming GOOSE messages.

2.4.1.5 geRemoteOutputsGGIO

This logical node class is used to map PLC digital states for outgoing GOOSE messages.

GGIO class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
Ind1 geSPS Remote digital input 1 O
Ind2 geSPS Remote digital input 2 O
.. .. .. ..
Ind64 geSPS Remote digital input 32 O
AnIn1 geFloatMV Remote float input 1 O
AnIn2 geFloatMV Remote float input 2 O
.. .. .. ..
AnIn8 geFloatMV Remote float input 8 O
AnIn9 geIntMV_1 Remote integer input 1 O
AnIn10 geIntMV_1 Remote integer input 2 O
.. .. .. ..
AnIn16 geIntMV_1 Remote integer input 8 O
Settings
OscTmms geING_0 Oscillation time remote inputs O
NumChgs geING_0 Number of transient changes O

GGIO class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
Ind1 geSPS Remote digital output 1 O
Ind2 geSPS Remote digital output 2 O
.. .. .. ..
Ind32 SgePS Remote digital output 32 O
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2.4.1.6 geDigitalCountersGGIO

This logical node is used for modeling the eight digital counters of F650 relay.

GGIO class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

GGIO Generic process I/O
Data
Common Logical Node Information
Mod geModENC Mode M
Beh geBehENS Behavior M
Health geHealthENS Health M
NamPlt geLPL Name plate M
Status information
Cnt1 geBCR_2 Digital counter 1 O
.. .. .. ..
Cnt8 geBCR_2 Digital counter 8 O
CntBlk1 geSPS_1 Digital counter 1 block O
.. .. ..
CntBlk8 geSPS_1 Digital counter 8 block O
CntHi1 geSPS_1 Digital counter 1 high O
.. .. ..
CntHi8 geSPS_1 Digital counter 8 high O
CntEq1 geSPS_1 Digital counter 1 equal O
.. .. ..
CntEq8 geSPS_1 Digital counter 8 equal O
CntLo1 geSPS_1 Digital counter 1 low O
.. .. ..
CntLo8 geSPS_1 Digital counter 8 low O
CntUp1 geSPS_1 Digital counter 1 up O
.. .. ..
CntUp8 geSPS_1 Digital counter 8 up O
CntDwn1 geSPS_1 Digital counter 1 down O
.. .. ..
CntDwn8 geSPS_1 Digital counter 8 down O
CntSetPre1 geSPS_1 Digital counter 1 set preset O
.. .. ..
CntSetPre8 geSPS_1 Digital counter 8 set preset O
CntRst1 geSPS_1 Digital counter 1 reset O
.. .. ..
CntRst8 geSPS_1 Digital counter 8 reset O
CntFrzRst1 geSPS_1 Digital counter 1 FreezeReset O
.. .. ..
CntFrzRst8 geSPS_1 Digital counter 8 FreezeReset O
CntFrzCnt1 geSPS_1 Digital counter 1 FreezeCount O
.. .. ..
CntFrzCnt8 geSPS_1 Digital counter 8 FreezeCount O



CHAPTER 7:  IEC 61850 PROTOCOL 7.3 IEC 61850 PROFILE FOR C650

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 7-67

2.5 Logical Nodes for metering and measurement. LN Group: M

2.5.1 MMXU (Measurement)*

2.5.1.1 geMMXU --> measurement analog values: 1 instance in Control LDevice

* Only present in Enhanced models

2.5.2 MSQI (Sequence and imbalance)*

2.5.2.1 MSQI (geMSQI) --> sequence and imbalance analog values: 1 instance in Control LDevice

* Only present in Enhanced models

MMXU class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

MMXU Measurement
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Measured values
TotW geFloatMV Total active power (P) O
TotVAr geFloatMV Total reactive power (Q) O
TotVA geFloatMV Total apparent power (S) O
TotPF geFloatMV Average power factor (PF) O
Hz geFloatMV Line Frequency O
PPV geFloatDEL Phase to phase voltages (VL1L2,...) O
PhV geFloatPhsWYE Phase to ground voltages (VL1ER, ...) O
A geFloatWYE Phase currents (IL1, ...) O
AuxV geFloatCMV_1 Auxiliary Phase Voltage O
BusHz geFloatMV_1 Bus Frequency O
MaxDmdTotW geFloatMV_1 Demand W Max O
MinDmdTotW geFloatMV_1 Demand W Min O
MaxDmdTotVAr geFloatMV_1 Demand VAr Max O
MinDmdTotVAr geFloatMV_1 Demand VAr Min O
MaxDmdTotVA geFloatMV_1 Demand VA Max O
MinDmdTotVA geFloatMV_1 Demand VA Min O

MSQI class
Attribute
 Name

Attr. 
Type

Explanation M/O Notes

MSQI Measurement
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Measured values
SeqA geFloatSEQ O
SeqV geFloatSEQ O



7-68 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

7.3 IEC 61850 PROFILE FOR C650 CHAPTER 7:  IEC 61850 PROTOCOL

2.6.3 MMTR (Metering)*

2.6.3.1 geMMTR

* Only present in Enhanced models

2.6 Logical Nodes for switchgear. LN Group: X

2.6.1 XCBR (Circuit Breaker)

2.6.1.1 geXCBR --> 1 circuit breaker: 1 instance in Control LDevice

MMTR class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

MMTR Measurement

Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Measured values
SupWh geBCR O
SupVArh geBCR O
DmdWh geBCR O
DmdVArh geBCR O
CntPsWh geFloatMV_1 O
CntNgWh geFloatMV_1 O
CntPsVArh geFloatMV_1 O
CntNgVArh geFloatMV_1 O

XCBR class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

XCBR Circuit breaker
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Descriptions
EEname geDPL External equipment name 

plate
M

Status information
Loc geSPS Local operation M Local / Remote
OpCnt geINS Operation counter M Breaker openings
SumSwARs O
CBOpCap geCBOpCapENS Circuit breaker operating 

capability
O

Controls 
Pos geDPC_1 Switch position M Breaker open, close
BlkOpn geSPC_1 Block opening M Virtual output
BlkClr geSPC_1 Block closing M Virtual output
Settings
ThAlSwA geFloatASG_1 Maximum KI2t O
SumSwATmms geFloatASG_1 KI2t Integ. Time O
ExNumTr geIntASG_1 Maximum Openings O
ExNumTr1hr geIntASG_1 Max.Openings 1 hour O
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2.6.2 XSWI (Circuit switch)

2.6.2.1 geXSWI

In the C650 there are up to 16 configurable switchgear.

3. Common Data Class 

3.1 Common Data Class for status information

3.1.1 Single Point Status (SPS)

XSWI class
Attribute
Name

Attr. 
Type

Explanation M/O Notes

XSWI Circuit switch
Data
Common Logical Node Information
Mod geModINC Mode M
Beh geBehINS Behavior M
Health geHealthINS Health M
NamPlt geLPL Name plate M
Descriptions
EEName DPL External equipment name 

plate
M

Status information
Loc geSPS Local operation M Local / Remote
EEHealth geEEHealthENS Ext. equipment health O
OpCnt geINS Operation counter M Breaker openings
Controls 
Pos geDPC_3 Switch position M Breaker open, close
BlkOpn geSPC_1 Block opening M Virtual output
BlkCls geSPC_1 Block closing M Virtual output
SwTyp geSwTypENS Switch type M
SwOpCap geSwOpCapENS Switch operating capability

SPS class (Single point status)
gsSPS
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Boolean ST dchg M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geSPS_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Boolean ST dchg M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
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3.1.2 Integer Status (INS)

3.1.3 Enumerated Status (ENS)

INS class (Integer status)
geINS
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal INT32 ST dchg M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geINS_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Boolean ST dchg M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M

ENS class (Enumerated status)
geAutoRecStINS (AutoRecSt)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enum ST dchg Ready,InProgress,Successful,.. M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geBehINS (Beh)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enum ST dchg On,blocked,test,test/blocked,Off M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geHealthINS (Health)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enum ST dchg Ok,Warning,Alarm M
q BVstring13 ST qchg M
t Utctime ST M
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3.1.4 Protection activation information (ACT)

configuration, description and extension
d Vstring255 DC O
geCBOpCapINS (CBOpCap)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enumerated ST dchg None,Open,Close-Open,… M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geSwOpCapINS (SwOpCap)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enumerated ST dchg None,Open,Close,… M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geSwTypINS (SwTyp)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
status
stVal Enumerated ST dchg Load Break, Disconnector,… M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O

ACT class (Protection activation information)
gePhsACT
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
phsA Boolean ST dchg O
phsB Boolean ST dchg O
phsC Boolean ST dchg O
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
cdcNs Vstring255 EX O
cdcName Vstring255 EX O
gePhsACT_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
phsA Boolean ST dchg O
phsB Boolean ST dchg O
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phsC Boolean ST dchg O
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
cdcNs Vstring255 EX O
cdcName Vstring255 EX O
dataNs Vstring255 EX AC_DLN_M
geNeutACT
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
neut Boolean ST dchg O
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
cdcNs Vstring255 EX O
cdcName Vstring255 EX O
geNeutACT_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
neut Boolean ST dchg O
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
cdcNs Vstring255 EX O
cdcName Vstring255 EX O
dataNs Vstring255 EX AC_DLN_M
geGeneralACT
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
q Bvstring13 ST qchg M
t Utctime ST M
originSrc Struct ST O
configuration, description and extension
d Vstring255 DC O
geGeneralACT_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST dchg M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
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3.1.5 Directional protection activation information (ACD)

ACD class (Directional protection activation information)
gePhsACD
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
phsA Boolean ST Dchg GC_2(1)
dirPhsA Enumerated (Byte) ST dchg unknown | forward | backward GC_2(1)
phsB Boolean ST dchg GC_2(2)
dirPhsB Enumerated (Byte) ST dchg unknown | forward | backward GC_2(2)
phsC Boolean ST dchg GC_2(3)
dirPhsC Enumerated (Byte) ST dchg unknown | forward | backward GC_2(3)
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
gePhsACD_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
phsA Boolean ST Dchg GC_2(1)
dirPhsA Enumerated (Byte) ST dchg unknown | forward | backward GC_2(1)
phsB Boolean ST dchg GC_2(2)
dirPhsB Enumerated (Byte) ST dchg unknown | forward | backward GC_2(2)
phsC Boolean ST dchg GC_2(3)
dirPhsC Enumerated (Byte) ST dchg unknown | forward | backward GC_2(3)
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geNeutACD
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
geNeutACD_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O
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3.1.6 Binary counter reading (BCR)

dataNs Vstring255 EX AC_DLN_M
geGeneralACD
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
general Boolean ST Dchg M
dirGeneral Enumerated (Byte) ST Dchg unknown | forward | backward | both M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
d Vstring255 DC O

BCR class (Binary counter reading)
geBCR
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
actVal Int64 ST Dchg M
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
units Unit CF O
pulsQty Float32 CF M
d Vstring255 DC O
geBCR_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
actVal Int64 ST dchg M
frVal Int64 ST dchg GC_2_1
frTm Utctime ST GC_2_1
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
pulsQty Float32 CF M
frEna Boolean CF GC_2_1
strTm Utctime CF GC_2_1
frPd Int32 CF GC_2_1
frRs Boolean CF GC_2_1
d Vstring255 DC O
geBCR_2
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
actVal Int64 ST dchg M
frVal Int64 ST dchg GC_2_1
frTm Utctime ST GC_2_1
q Bvstring13 ST qchg M
t Utctime ST M
configuration, description and extension
pulsQty Float32 CF M
frEna Boolean CF GC_2_1
strTm Utctime CF GC_2_1
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3.2 Common data class specifications for measurand information

3.2.1 Measured Value (MV) 

frPd Int32 CF GC_2_1
frRs Boolean CF GC_2_1
d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M

MV class (Measured value)
geFloatMV
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instMag
f

FloatAnalogueValue MX ------ O
FLOAT32 GC_1

mag
f

FloatAnalogueValue MX dchg M
FLOAT32 GC_1

range ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
 ENUMERATED(Byte) M
 ENUMERATED(Byte) O

db  INT32U CF O
zeroDb  INT32U CF O
rangeC
hhLim
f
hlim
f
lLim
f
llLim
f
min
f
max
f
limDb

RangeConfig CF O
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
INT32U

d Vstring255 DC O
geFloatMV_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instMag
f

FloatAnalogueValue MX ------ O
FLOAT32 GC_1

mag
f

FloatAnalogueValue MX dchg M
FLOAT32 GC_1

range ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

db INT32U CF O
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zeroDb INT32U CF O
rangeC
hhLim
f
hlim
f
lLim
f
llLim
f
min
f
max
f
limDb

RangeConfig CF O
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
FloatAnalogueValue
FLOAT32 GC_1
INT32U

d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geFloatMV_2
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
mag
f

FloatAnalogueValue MX dchg M
FLOAT32 GC_1

q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M
geFloatMV_3
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
mag
f

FloatAnalogueValue MX dchg M
FLOAT32 GC_1

q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

d Vstring255 DC O
geIntMV
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instMag
i

IntAnalogueValue MX ------ O
INT32 GC_1

mag
i

IntAnalogueValue MX dchg M
INT32 GC_1

q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

db INT32U CF O
d Vstring255 DC O
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3.2.2 Complex Measured Value (CMV)

geIntMV_1
Attribute Name Attribute Type FC TrgOp Value/Value Range M/O/C
DataAttribute
measured attributes
instMag
i

IntAnalogueValue MX ------ O
INT32 GC_1

mag
i

IntAnalogueValue MX dchg M
INT32 GC_1

range ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
Configuration, description and extension
units
      SIUnit
      Multiplier

Unit CF O
ENUMERATED(Byte) M
ENUMERATED(Byte) O

db INT32U CF O
zeroDb INT32U CF O
rangeC
hhLim
i
hlim
i
lLim
i
llLim
i
min
i
max
i
limDb

RangeConfig CF O
IntAnalogueValue
INT32U GC_1
IntAnalogueValue
UINT32 GC_1
IntAnalogueValue
INT32U GC_1
IntAnalogueValue
INT32U GC_1
IntAnalogueValue
INT32U GC_1
IntAnalogueValue
INT32U GC_1
INT32U

d Vstring255 DC O
dataNs Vstring255 EX AC_DLN_M

CMV class (Complex measured value)
geFloatCMV
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
measured attributes
instCVal
mag
f

FloatVector MX ------ O
FloatAnalogueValue
FLOAT32

cVal
mag
f

FloatVector MX dchg M
FloatAnalogueValue
FLOAT32

range ENUMERATED(Byte) MX dchg O
rangeAng ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
configuration, description and extension
units
SIUnit
Multiplier

Unit CF O
Byte M
Byte O

db INT32U CF O
dbAng INT32U CF O
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3.2.3 Phase to ground related measured values of a three phase system ( WYE )

zeroDb INT32U CF O
rangeC RangeConfig CF O
rangeAngC RangeConfig CF O
d Vstring255 DC O
geFloatCMV_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
measured attributes
instCVal
mag
f

FloatVector MX ------ O
FloatAnalogueValue
FLOAT32

cVal
mag
f

FloatVector MX dchg M
FloatAnalogueValue
FLOAT32

range ENUMERATED(Byte) MX dchg O
rangeAng ENUMERATED(Byte) MX dchg O
q BVstring13 MX qchg M
t Utctime MX M
configuration, description and extension
units
SIUnit
Multiplier

Unit CF O
Byte M
Byte O

db INT32U CF O
dbAng INT32U CF O
zeroDb INT32U CF O
rangeC RangeConfig CF O
rangeAngC RangeConfig CF O
d Vstring255 DC O
dataNs Vstring255 EX M

 WYE class
geFloatPhsWYE
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

Data
phsA CMV_0 GC_1
phsB CMV_0 GC_1
phsC CMV_0 GC_1
neut CMV_0 GC_1
configuration, description and extension
d Vstring255 DC O
geFloatWYE
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

Data
phsA CMV_0 GC_1
phsB CMV_0 GC_1
phsC CMV_0 GC_1
neut CMV_0 GC_1
net CMV_0 GC_1
res CMV_0 GC_1
configuration, description and extension
d Vstring255 DC O
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3.2.4 Phase to phase related measured values of a three phase system (DEL)

3.2.5 Sequence (SEQ)

3.3 Common data class specifications for controllable status  information

3.3.1 Controllable single point (SPC).

DEL class (Phase to phase related measured values of a three phase system)
geFloatDEL
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

Data
phsAB CMV_0 GC_1
phsBC CMV_0 GC_1
phsCA CMV_0 GC_1
configuration, description and extension
d Vstring255 DC O

SEQ class ( Sequence )
geFloatSEQ
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

Data
c1 CMV_0 GC_1
c2 CMV_0 GC_1
c3 CMV_0 GC_1
Measured attributes
seqT enumerated MX Pos-neg-zero | dir-quad-zero O
configuration, description and extension
d Vstring255 DC O

SPC class
geSPC
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
stVal Boolean ST FALSE | TRUE AC_ST
q Quality ST AC_ST
t TimeStamp ST AC_ST
Oper ctlVal Boolean CO AC_CO_M

origin Originator CO AC_CO_M
orCat ENUMERATED M
orIdent OCTECT64 M
ctlNum INT8U CO M
T Btime6 CO M
Test Boolean CO M
Check ENUMERATED CO M

configuration, description and extension
ctlModel ENUMERATED CF ctlModel M
operTimeout INT32U CF AC_CO_O
d Vstring255 DC O
cdcNs Vstring255 EX
cdcName Vstring255 EX
geSPC_1
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3.3.2 Controllable double point (DPC)

Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
stVal Boolean ST FALSE | TRUE AC_ST
Q Quality ST AC_ST
t TimeStamp ST AC_ST
configuration, description and extension
ctlModel ENUMERATED CF ctlModel_1 M
d Vstring255 DC O

DPC class (Controllable double point)
geDPC
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
Oper ctlVal Boolean CO AC_CO_M

origin Originator CO,ST AC_CO_M
orCat ENUMERATED M
orIdent OCTECT64 M
ctlNum INT8U CO,ST M
T Btime6 CO M
Test Boolean CO M
Check ENUMERATED CO M

stVal CODE ENUM ST dchg intermediate-state | off | on | bad-
state

M

q BVstring13 ST qchg AC_ST
t Utctime ST AC_ST
configuration, description and extension
ctlModel ENUMERATED CF M
operTimeout INT32U CF AC_CO_O
d Vstring255 DC O
cdcNs Vstring255 EX
cdcName Vstring255 EX
geDPC_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
Oper ctlVal Boolean CO AC_CO_M

origin Originator CO,ST AC_CO_M
orCat ENUMERATED M
orIdent OCTECT64 M
ctlNum INT8U CO,ST M
T Btime6 CO M
Test Boolean CO M
Check ENUMERATED CO M

Cancel
SBO
SBOw
stVal CODE ENUM ST dchg intermediate-state | off | on | bad-

state
M

q BVstring13 ST qchg AC_ST
t Utctime ST AC_ST
configuration, description and extension
ctlModel ENUMERATED CF M
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3.3.3 Controllable enumerated status (ENC)

3.4 Common data class specifications for status settings

3.4.1 Single point setting (SPG)

sboTimeout INT32U CF AC_CO_O
sboClass ENUMERATED CF AC_CO_O
operTimeout INT32U CF AC_CO_O
d Vstring255 DC O
cdcNs Vstring255 EX
cdcName Vstring255 EX
geDPC_2
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
stVal CODE ENUM ST dchg intermediate-state | off | on | bad-

state
M

q BVstring13 ST qchg AC_ST
t Utctime ST AC_ST
configuration, description and extension
ctlModel ENUMERATED CF M
d Vstring255 DC O

ENC class (Controllable integer status)
geModINC (type Mod)
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
 status
stVal Enum ST dcgh M
q BVstring13 ST qchg M
t Utctime ST M
configuration, description and extension
ctlModel ENUMERATED CF M
d Vstring255 DC O

SPG class
geSPG
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Boolean SP AC_NSG_M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX O
geSPG_2
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Boolean SG AC_SG_M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX O
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3.4.2 Integer status setting (ING)

ING class
geING_0
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Boolean SP AC_NSG_M
configuration, description and extension
minVal INT32 CF O
maxVal INT32 CF O
stepSize INT32 CF O
d Vstring255 DC O
dataNs Vstring255 EX O
geING_0_2
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Boolean SG AC_SG_M
configuration, description and extension
minVal INT32 CF O
maxVal INT32 CF O
stepSize INT32 CF O
d Vstring255 DC O
dataNs Vstring255 EX O
geING_8
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Boolean SP AC_NSG_M
configuration, description and extension
minVal INT32 CF O
maxVal INT32 CF O
stepSize INT32 CF O
d Vstring255 DC O
geING_8_2
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Boolean SG AC_SG_M
configuration, description and extension
minVal INT32 CF O
maxVal INT32 CF O
stepSize INT32 CF O
d Vstring255 DC O
geING_9
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Boolean SG AC_SG_M
configuration, description and extension
d Vstring255 DC O
geING_10
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
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3.4.3 Enumerated status setting (ENG)

3.4.4 Object reference setting

setting
setVal Boolean SG AC_SG_M
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX
geING_11
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Boolean SP
configuration, description and extension
d Vstring255 DC O
dataNs Vstring255 EX

ENG class
geENG
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Enumerated SP PolQty AC_NSG_M
configuration, description and extension
d Vstring255 DC O
geENG_2
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setVal Enumerated SG PolQty AC_SG_M
configuration, description and extension
d Vstring255 DC O

ORG class
geORG
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setSrcRef ObjectReference SP Object reference M
configuration, description and extension
d Vstring255 DC O
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3.5 Common data class specifications for analogue settings

3.5.1 Analog setting (ASG)

ASG class
geIntASG
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setMag
i

IntAnalogueValue SP AC_NSG_M
INT32 GC_1

configuration, description and extension
units Unit CF
minVal
i

IntAnalogueValue CF O
INT32 GC_1

maxVal
i

IntAnalogueValue CF O
INT32 GC_1

stepSize
i

IntAnalogueValue CF O
INT32 GC_1

d Vstring255 DC O
geIntASG_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setMag
i

IntAnalogueValue SP AC_NSG_M
INT32 GC_1

configuration, description and extension
units Unit CF
minVal
i

IntAnalogueValue CF O
INT32 GC_1

maxVal
i

IntAnalogueValue CF O
INT32 GC_1

stepSize
i

IntAnalogueValue CF O
INT32 GC_1

d Vstring255 DC O
dataNs Vstring255 EX O
geIntASG_2
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setMag
i

IntAnalogueValue SG AC_NSG_M
INT32 GC_1

configuration, description and extension
units Unit CF
minVal
i

IntAnalogueValue CF O
INT32 GC_1

maxVal
i

IntAnalogueValue CF O
INT32 GC_1

stepSize
i

IntAnalogueValue CF O
INT32 GC_1

d Vstring255 DC O
dataNs Vstring255 EX O
geIntASG_3
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
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setMag
i

IntAnalogueValue SG AC_SG_M
INT32 GC_1

configuration, description and extension
units Unit CF
minVal
i

IntAnalogueValue CF O
INT32 GC_1

maxVal
i

IntAnalogueValue CF O
INT32 GC_1

stepSize
i

IntAnalogueValue CF O
INT32 GC_1

d Vstring255 DC O
geFloatASG
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setMag
f

FloatAnalogueValue SP AC_NSG_M
FLOAT32 GC_1

configuration, description and extension
Units Unit CF
minVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

maxVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

stepSize
f

FloatAnalogueValue CF O
FLOAT32 GC_1

d Vstring255 DC O
geFloatASG_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setMag
f

FloatAnalogueValue SP AC_NSG_M
FLOAT32 GC_1

configuration, description and extension
Units Unit CF
minVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

maxVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

stepSize
f

FloatAnalogueValue CF O
FLOAT32 GC_1

d Vstring255 DC O
dataNs Vstring255 EX O
geFloatASG_1_2
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setMag
f

FloatAnalogueValue SG AC_NSG_M
FLOAT32 GC_1

configuration, description and extension
Units Unit CF
minVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

maxVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

stepSize
f

FloatAnalogueValue CF O
FLOAT32 GC_1

d Vstring255 DC O
dataNs Vstring255 EX O
geFloatASG_2
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3.5.2 Setting curve (CURVE)

3.6 Common data class specifications for description information

3.6.1 Device name plate (DPL)

Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setMag
f

FloatAnalogueValue SG AC_SG_M
FLOAT32 GC_1

configuration, description and extension
Units Unit CF
minVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

maxVal
f

FloatAnalogueValue CF O
FLOAT32 GC_1

stepSize
f

FloatAnalogueValue CF O
FLOAT32 GC_1

d Vstring255 DC O

geCURVE_3
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setCharact ENUMERATED SG O
d Vstring255 DC O
geCURVE_4
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
setting
setCharact ENUMERATED SG O
d Vstring255 DC O

DPL class (Device name plate)
geDPL
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
vendor Vstring255 DC M
hwRev Vstring255 DC O
swRev Vstring255 DC O
serNum Vstring255 DC O
model Vstring255 DC O
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3.6.2 Logical node name plate (LPL)

4. Enum Types 

4.2 New Enum Types

4.2.1 setCharact_2

4.2.2 SamplesCycle

LPL class (Logical node name plate)
geLPL
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
vendor Vstring255 DC M
swRev Vstring255 DC M
d Vstring255 DC M
configRev Vstring255 DC AC_LN0_M
geLPL_1
Attribute
Name

Attribute Type FC TrgOp Value/Value Range M/O/C

DataAttribute
control and status
vendor Vstring255 DC M
swRev Vstring255 DC M
d Vstring255 DC M
configRev Vstring255 DC AC_LN0_M
ldNs Vstring255 EX O

Value Description Remarks
0 Definite Time
1 Inverse Time

Value Description Remarks
0 64 samples/cycle
1 32 samples/cycle
2 16 samples/cycle
3 8 samples/cycle
4 4 samples/cycle
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7.3.7.3.5  TICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 
option "H", "G", "K", "J", "L", "M" and IEC 61850 Edition 2

Reference documentation: TICS for 650 family of relays v1_00 firm7_20.

This document describes the:

• Introduction

• TICS Template

1 Introduction

This document provides a template for the tissues conformance statement (TICS). According to the UCA QAP the TICS is 
required to perform a conformance test and is referenced on the final certificate.

In this TICS template only tissues with a "green" status are considered since they become mandatory and thus must be 
included in the UCA Device conformance test procedures.

"Green" Tissues listed in this document represent the current status of all Tissues for a date of the document creation. As 
for some of the remaining tissues, they are not yet included in the test procedures, either because they are just a 
recommendation or optional within the IEC 61850 documents, or because their respective proposals are not defined in 
such detail to be implemented or tested, or because they are simply not applicable, just editorial, with no change for 
implementation and testing.

The supported ("Sup") column indicates:

• Y: yes, the tissue is implemented in the device.

• N: no, the tissue is not implemented in the device.

• N.A.: not applicable, the tissue is not applicable for the device.

2 TICS Template

Tissue No. Description Supported?
(Y / N / N/A)

IEC 61850 Part 6 

658 Tracking related features N/A

663 FCDA element cannot be a "functionally constrained logical 
node"

Y

668 Autotransformer modeling N/A

687 SGCB ResvTms N/A

719 ConfDataSet - maxAttributes definition is confusing Y

721 Log element name N/A

768 bType VisString65 is missing Y

770 Goose ID max. length is 129 characters Y

779 object references Y

788 SICS S56 from optional to mandatory N/A

789 ConfLdName as services applies to both server and client Y

804 valKind and IED versus System configuration N/A

806 Max length of log name inconsistent between -6 and -7-2 N/A

807 Need a way to indicate if "Owner" present in RCB N/A

822 Extension of IED capabilities N/A

823 ValKind for structured data attributes N/A

824 Short addresses on structured data attributes N/A

825 Floating point value N/A

845 SGCB ResvTms N/A
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853 SBO and ProtNs N/A

855 Recursive SubFunction N/A

856 VoltageLevel frequency and phases N/A

857 Function/SubFunction for ConductingEquipment N/A

886 Missing 8-1 P-types N/A

901 tServices as AP or as IED element N/A

936 SupSubscription parameter usage is difficult N/A

1168 doName and daName of ExtRef; doName may have one 
dot (DO.SDO)

N/A

1175 IPv6 address lowercase only N/A

IEC 61850 Part 7-1 

828 Data model namespace revision IEC 61850-7-4:2007[A] Y

1151 simulated GOOSE disappears after 1st appearance when 
LPHD.Sim = TRUE

N/A

1196 Extensions to standardized LN classes made by third 
parties

N/A

IEC 61850 Part 7-2

778 AddCause values - add value not-supported Y

780 What are unsupported trigger option at a control block? Y

783 TimOper Resp- ; add Authorization check N/A

786 AddCause values 26 and 27 are switched Y

820 Mandatory ACSI services (use for PICS template) N/A

858 typo in enumeration ServiceType N/A

861 dchg of ConfRev attribute N/A

876 GenLogiclNodeClass and SGCB, GoCB, MsvCB, UsvCB N/A

1038 Loss of Info Detection After Resynch N/A

1050 GTS Phycomaddr definition in SCL N/A

1062 Entrytime not used in CDC N/A

1071 Length of DO name Y

1091 The sentence "The initial value of EditSG shall be 0", has to 
be stated in part 7.2 not in 8.1

N/A

1127 Missing owner attribute in BTS and UTS N/A

1163 Old report in URCB N/A

1202 GI not optional Y

IEC 61850 Part 7-3

697 persistent command / PulseConfig N/A

698 Wrong case is BAC.dB attribute N/A

722 Units for 'h' and 'min' not in UnitKind enumeration. N/A

919 Presence Condition for sVC N/A

925 Presence of i or f attribute - Problem with writing N/A

926 Presence Conditions within RangeConfig Y

IEC 61850 Part 7-4 

671 mistake in definition of Mod & Beh N/A

674 CDC of ZRRC.LocSta is wrong N/A

675 SIML LN N/A

676 Same data object name used with different CDC N/A

677 MotStr is used with different CDC in PMMS and SOPM LN 
classes

N/A

679 Remove CycTrMod Enum N/A

680 SI unit for MHYD.Cndct N/A

681 Enum PIDAlg N/A

Tissue No. Description Supported?
(Y / N / N/A)
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Note: Tissues 675, 735, 772, 775, 776, 878 are not relevant for conformance testing 

Compare the TISSUE database for more details: www.tissues.iec61850.com

682 ANCR.ParColMod N/A

683 Enum QVVR.IntrDetMth N/A

685 Enum ParTraMod N/A

686 New annex H - enums types in XML N/A

694 Data object CmdBlk N/A

696 LSVS.St (Status of subscription) N/A

712 interpretation of quality operatorBlocked N/A

713 DO Naming of time constants in FFIL N/A

724 ANCR.Auto N/A

725 Loc in LN A-group N/A

734 LLN0.OpTmh vs. LPHD.OpTmh N/A

735 ISAF.Alm and ISAF.AlmReset N/A

736 PFSign N/A

742 GAPC.Str, GAPC.Op and GAPC.StrVal N/A

743 CCGR.PmpCtl and CCGR.FanCtl N/A

744 LN STMP, EEHealth and EEName N/A

772 LPHD.PwrUp/PwrDn shall be transient N/A

773 Loc, LocKey and LocSta YPSH and YLTC N/A

774 ITCI.LocKey N/A

775 KVLV.ClsLim and OpnLim N/A

776 LPHD.OutOv/InOv and LCCH.OutOv/InOv N/A

800 Misspelling in CSYN N/A

802 CCGR and Harmonized control authority N/A

808 Presence condition of ZMOT.DExt and new DOs N/A

831 Setting of ConfRevNum in LGOS N/A

838 Testing in Beh=Blocked N/A

844 MFLK.PhPiMax, MFLK.PhPiLoFil, MFLK.PhPiRoot DEL->WYE N/A

849 Presence conditions re-assessing in case of derived 
statistical calculation

N/A

877 QVUB -settings should be optional N/A

909 Remove ANCR.ColOpR and ColOpL N/A

920 Resettable Counter is NOT resettable N/A

932 Rename AVCO.SptVol to AVCO.VolSpt N/A

939 Change CDC for ANCR.FixCol N/A

991 LGOS: GoCBRef (as well as LSVS.SvCBRef) should be 
mandatory

N/A

1007 PTRC as fault indicator - Update of description required Y

1044 TapChg in AVCO N/A

1077 Rename DOnames within LTIM N/A

IEC 61850    Part 8-1 

784 Tracking of control (CTS) N/A

817 Fixed-length GOOSE float encoding N/A

834 File dir name length 64 Y

951 Encoding of Owner attribute N/A

1040 More associate error codes N/A

1178 Select Response+ is non-null value Y

Tissue No. Description Supported?
(Y / N / N/A)
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7.3.7.3.6  TICS for 650 family of relays whose order code has Rear Ethernet Communication Board 2 
option "H", "G", "K", "J", "L", "M" and IEC 61850 Edition 1

Reference documentation: TICS For C650 relay V1_00 firm7_70

Mandatory IntOp Tissues

During the October 2006 meeting, IEC TC57 working group 10 decided that:

• green Tissues with the category "IntOp" are mandatory for IEC 61850 edition 1

• Tissues with the category "Ed.2" Tissues should not be implemented. 

The table below gives an overview of the implemented IntOp Tissues. 

Part Tissue 
No.

Description Implemented 
Y / N/A

8-1 116
165
183
246
545

GetNameList with empty response?
Improper Error Response for GetDataSetValues
GetNameList error handling
Control negative response (SBOns) with LastApplError
Skip file directories with no files

Y
N/A
N/A
N/A
N/A

7-4 252 AlmThm should have CDC SPS         Y

7-3 28
54
55
63
65
219
270
1199

Definition of APC
Point def xVal, not cVal
Ineut = Ires ?
mag in CDC CMV
Deadband calculation of a Vector and trigger option
operTm in ACT
WYE and DEL rms values
BCR

N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
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Note: Tissue 49, 190, 191, 275 and 278 are part of tissue #453, all other technical tissues in the table are mandatory if 
applicable. 

Note: Editorial tissues are marked as "N/A". 

7-2 30
31
32
35
36
37
39
40
41
42
43
44
45 
46 
47
49 
50
51
52 
53
151
166
185
189
190 
191 
278
297
298
305
322
329
333
335
348
349
453
1281 

control parameter T
Typo
Typo in syntax
Typo Syntax Control time
Syntax parameter DSet-Ref missing
Syntax GOOSE "T" type
Add DstAddr to GoCB
GOOSE Message "AppID" to "GoID"
GsCB "AppID" to "GsID"
SV timestamp: "EntryTime" to "TimeStamp"
Control "T" semantic
AddCause - Object not sel
Missing AddCauses
Synchro check cancel
"." in LD Name?
BRCB TimeOfEntry (part of #453)
LNName start with number?
ARRAY [0..num] missing
Ambiguity GOOSE SqNum
Add DstAddr to GsCB, SV
Name constraint for control blocks etc.
DataRef attribute in Log
Logging - Integrity periode
SV Format
BRCB: EntryId and TimeOfEntry (part of #453)
BRCB: Integrity and buffering reports (part of #453)
EntryId not valid for a server (part of #453)
Sequence number
Type of SqNum
Reporting with BufTm = 0
Write Configuration attribute of BRCBs
Reporting and BufOvl
Enabling of an incomplete GoCB
Clearing of BufOvfl
URCB class and report
BRCB TimeOfEntry has two definitions
Combination of all reporting and logging tissues
Trigger option GI is by default

N/A
N/A
N/A
Y
N/A
N/A
N/A
N/A
Y
N/A
N/A
N/A
N/A
N/A
N/A
-
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
-
-
-
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A

Part 6 1
5
8
10
17
169
245
529

Syntax
tExtensionAttributeNameEnum is restricted
SIUnit enumeration for W
Base type for bitstring usage
DAI/SDI elements syntax
Ordering of enum differs from 7-3
Attribute RptId in SCL
Replace sev - Unknown by unknown

N/A
Y
Y
Y
Y
N/A
N/A
N/A
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7.3.7.3.7  PIXIT for 650 family of relays whose order code has Rear Ethernet Communication Board 2 
option "H", "G", "K", "J", "L", "M" and IEC 61850 Edition 2

Reference documentation: PIXIT for 650 family of relays v1_6 firm7_00.

This document describes the:

• PIXIT for Association Model

• PIXIT for Server model

• PIXIT for Dataset model

• PIXIT for Reporting model

• PIXIT for Generic substation events model

• PIXIT for Control model

• PIXIT for Time and time synchronization model

• PIXIT for File transfer model

This document specifies the protocol implementation extra information for testing (PIXIT) of the IEC 61850 interface in 650 
family of relays. 

Together with the PICS and the MICS the PIXIT forms the basis for a conformance test according to IEC 61850-10. 

Contents of this document: Each chapter specifies the PIXIT for each applicable ACSI service model as structured in IEC 
61850-10.

1 PIXIT For Association Model

ID Ed Description Value / Clarification

As1 1 Maximum number of clients that can set-up an association 
simultaneously

5

As2 1,2 TCP_KEEPALIVE value. The recommended range is 1..20s 5 seconds but if no application message is 
detected within the As3 value, the device 
closes the connection.

As3 1,2 Lost connection detection time 120 seconds (Configurable)

As4 - Authentication is not supported yet

As5 1,2 What association parameters are necessary for successful 
association

Transport selector      Y
Session selector          Y
Presentation selector Y
AP Title                          N
AE Qualifier                  N

As6 1,2 If association parameters are necessary for association, describe 
the correct values e.g.

Transport selector      0001
Session selector          0001
Presentation selector 00000001
AP Title                          N/A
AE Qualifier                   N/A

As7 1,2 What is the maximum and minimum MMS PDU size Max MMS PDU size     120000
Min MMS PDU size       32000

As8 1,2 What is the maximum start up time after a power supply interrupt 90 seconds
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2 PIXIT for Server model

3 PIXIT for Dataset model

ID Ed Description Value / Clarification

Sr1 1, 2 Which analogue value (MX) quality bits are supported (can be set 
by server)

Validity: 
Y Good, 
Y Invalid, 
N Reserved, 
Y Questionable
N Overflow 
Y OutofRange 
Y BadReference
N Oscillatory
Y Failure
N OldData
N Inconsistent
N Inaccurate 
Source: 
N Process
NSubstituted
N Test 
N OperatorBlocked 

Sr2 1, 2 Which status value (ST) quality bits are supported (can be set by 
server)

Validity: 
Y Good
Y Invalid 
N Reserved 
Y Questionable 
N BadReference
Y Oscillatory
Y Failure
N OldData
N Inconsistent
N Inaccurate 
Source: 
Y Process
Y Substituted
Y Test 
N OperatorBlocked

Sr3 - What is the maximum number of data object references in one 
GetDataValues request

Deprecated

Sr4 - What is the maximum number of data object references in one 
SetDataValues request

Deprecated

Sr5 1 Which Mode values are supported 1

1.  IEC 61850-6:2009 clause 9.5.6 states that if only a sub-range of the enumeration value set is supported, this 
shall be indicated within an ICD file by an enumeration type, where the unsupported values are missing.

Y OnY
N [On-]Blocked
N Test
N Test/Blocked
N Off

ID Ed Description Value / Clarification

Ds1 1 What is the maximum number of data elements in one data set 
(compare ICD setting)

576

Ds2 1 How many persistent data sets can be created by one or more 
clients
(this number includes predefined datasets)

NOT SUPPORTED

Ds3 1 How many non-persistent data sets can be created by one or 
more clients

Not Supported
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4 PIXIT for Substitution model

5 PIXIT for Setting group control model

6 PIXIT for Reporting model

ID Ed Description Value / Clarification

Sb1 1 Are substituted values stored in volatile memory Not Supported

ID Ed Description Value / Clarification

Sg1 1 What is the number of supported setting groups for each logical 
device

Not Supported

Sg2 1, 2 What is the effect of when and how the non-volatile storage is 
updated
(compare IEC 61850-8-1 $16.2.4)

Not Supported

Sg3 1 Can multiple clients edit the same setting group Not Supported

Sg4 1 What happens if the association is lost while editing a setting 
group

Not Supported

Sg5 1 Is EditSG value 0 allowed Not Supported

Sg6 2 When ResvTms is not present how long is an edit setting group 
locked

Not Supported

ID Ed Description Value / Clarification

Rp1 1 The supported trigger conditions are
(compare PICS)

Y Integrity
Y Data change
Y Quality change
N Data update
Y General interrogation

Rp2 1 The supported optional fields are Y Sequence-number
Y Report-time-stamp 
Y Reason-for-inclusion 
Y Data-set-name 
Y Data-reference 
Y Buffer-overflow 
Y EntryID
Y Conf-rev
Y Segmentation

Rp3 1, 2 Can the server send segmented reports Y

Rp4 1, 2 Mechanism on second internal data change notification of the 
same analogue data value within buffer period (Compare IEC 
61850-7-2 $14.2.2.9)

Send report immediately

Rp5 1 Multi client URCB approach 
(compare IEC 61850-7-2:2003 $14.2.1)

Each URCB is visible to all clients

Rp6 - What is the format of EntryID Deprecated

Rp7 1, 2 What is the buffer size for each BRCB or how many reports can 
be buffered

Buffer size = 50000 Bytes

Rp8 - Pre-configured RCB attributes that are dynamic, compare SCL 
report settings

Deprecated

Rp9 1 May the reported data set contain: 
- structured data objects
- data attributes

Y
Y (timestamp attributes are not supported)
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7 PIXIT for Logging model

8 PIXIT for GOOSE publish model

Rp10 1, 2 What is the scan cycle for binary events
Is this fixed, configurable

Event Driven
Fixed

Rp11 1 Does the device support to pre-assign a RCB to a specific client 
in the SCL

N

Rp12 2 After restart of the server is the value of ConfRev restored from 
the original configuration or retained prior to restart

Restored from original configuration 

ID Ed Description Value / Clarification

Lg1 1, 2 What is the default value of LogEna 
(Compare IEC 61850-8-1 $17.3.3.2.1, the default value should be 
FALSE)

NOT SUPPORTED

Lg2 - What is the format of EntryID Deprecated

Lg3 1, 2 Are there are multiple Log Control Blocks that specify the 
Journaling of the same MMS NamedVariable and TrgOps and 
the Event Condition 
(Compare IEC 61850-8-1 $17.3.3.3.2)

NOT SUPPORTED

Lg4 1 Pre-configured LCB attributes that cannot be changed online NOT SUPPORTED

ID Ed Description Value / Clarification

Gp1 1, 2 Can the test (Ed1) / simulation (Ed2) flag in the published GOOSE 
be set

N

Gp2 1 What is the behavior when the GOOSE publish configuration is 
incorrect 

DUT keeps GoEna=F.
Configuration tool does not allow wrong 
configuration to be uploaded into device. E.g.: 
empty dataset.

Gp3 1, 2 Published FCD supported common data classes are SPS, INS, ENS, ACT, ACD, MV, CMV, SAV, WYE, 
DEL, SEQ, INC, ENC, SPC, DPC, INC, ENC. (Only 
the elements with FC=ST or MX are published).

Gp4 1, 2 What is the slow retransmission time
Is it fixed or configurable

Configured by SCL or GoCB MaxTime 

Gp5 1, 2 What is the fastest retransmission time 
Is it fixed or configurable

Fixed. MinTime = 5 ms

Gp6 - Can the GOOSE publish be turned on / off by using 
SetGoCBValues(GoEna)

Y

Gp7 1, 2 What is the initial GOOSE sqNum after restart sqNum = 1

Gp8 1 May the GOOSE data set contain: 
- structured data objects (FCD)
- timestamp data attributes

Y
Y (timestamp attributes are not supported)

Gp9 2 How is the retransmission curve after a change. sqNum = 0   New change
sqNum = 1 -> 5ms later with TAL = 1000
sqNum = 2 -> 10ms later with TAL = 1000
sqNum = 3 -> 15ms later with TAL = 4000
sqNum = 4 -> 1000ms later with TAL = Update 
time* multipled by 4
sqNum = 5 -> Update time* later with TAL = 
Update time* multipled by 4
sqNum = 6-> Update time* later with TAL = 
Update time* multipled by 4
sqNum = 7 ……..
………...
………….
*Update time is configured in the ICT
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9 PIXIT for GOOSE subscribe model

10 PIXIT for Control model

ID Ed Description Value / Clarification

Gs1 1, 2 What elements of a subscribed GOOSE header are checked to 
decide the message is valid and the allData values are 
accepted? If yes, describe the conditions. 
Notes: 
the VLAN tag may be removed by a ethernet switch and shall 
not be checked
the simulation flag shall always be checked (Ed2)
the ndsCom shall always be checked (Ed2)

Y Ddestination MAC address
Y APPID
N gocbRef
Y timeAllowedtoLive
N datSet
Y goID
N t
N stNum
N sqNum
Y simulation / test
N confRev
Y ndsCom
Y numDatSetEntries

Gs2 1, 2 When is a subscribed GOOSE marked as lost
(TAL = time allowed to live value from the last received GOOSE 
message)

Message does not arrive after TAL

Gs3 1, 2 What is the behavior when one or more subscribed GOOSE 
messages isn’t received or syntactically incorrect (missing 
GOOSE)

Message is ignored, but when the next correct 
message is received, it proceeds as normal.

Gs4 1, 2 What is the behavior when a subscribed GOOSE message is out-
of-order

Message proceeds

Gs5 1, 2 What is the behavior when a subscribed GOOSE message is 
duplicated

Message is ignored

Gs6 1 Does the device subscribe to GOOSE messages with/without the 
VLAN tag

Y, with the VLAN tag
Y, without the VLAN tag

Gs7 1 May the GOOSE data set contain: 
- structured data objects (FCD)
- timestamp data attributes

Y
N

Gs8 1, 2 Subscribed FCD supported common data classes are DUT can receive all kinds of data but only 
digitals can be mapped.

Gs9 1, 2 Are subscribed GOOSE with test=T (Ed1) / simulation=T (Ed2) 
accepted in test/simulation mode

N

Gs10 2 What is the behavior when a subscribed GOOSE message with 
TAL = 0 is received by the subscriber.

The message is ignored. The mechanism 
applies where the new GOOSE message is not 
received within a TAL.

Gs11 2 What is the behavior when a subscribed GOOSE message hasn’t 
the expected data structure.

The message is ignored. The mechanism 
applies where the new GOOSE message is not 
received within a TAL.

ID Ed Description Value / Clarification

Ct1 - What control models are supported
(compare PICS)

Deprecated

Ct2 1, 2 Is the control model fixed, configurable and/or dynamic Configurable & Dynamic

Ct3 - Is TimeActivatedOperate supported (compare PICS or SCL) Deprecated

Ct4 - Is “operate-many” supported (compare sboClass) Deprecated

Ct5 1, 2 Will the DUT activate the control output when the test attribute is set 
in the SelectWithValue and/or Operate request (when N test 
procedure Ctl2 is applicable)

N

Ct6 - What are the conditions for the time (T) attribute in the 
SelectWithValue and/or Operate request

Deprecated
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Ct7 - Is pulse configuration supported (compare pulseConfig) Deprecated

Ct8 1, 2 What is the behavior of the DUT when the check conditions are set

Is this behavior fixed, configurable, online changeable

N synchrocheck
N interlock-check
DUT ignores the check value and always 
perform the check

Ct9 1, 2 Which additional cause diagnosis are supported Y Unknown
Y Not-supported
Y Blocked-by-switching-hierarchy
N Select-failed
Y Invalid-position
Y Position-reached
N Step-limit
Y Blocked-by-Mode
N Blocked-by-process
N Blocked-by-interlocking
N Blocked-by-synchrocheck
Y Command-already-in-execution
N Blocked-by-health
N 1-of-n-control
N Abortion-by-cancel
Y Time-limit-over
N Abortion-by-trip
Y Object-not-selected
Edition 1 specific values:
N Parameter-change-in-
execution
Edition 2 specific values:
Y Object-already-selected
N No-access-authority
N Ended-with-overshoot
N Abortion-due-to-deviation
N Abortion-by-communication-loss
N Blocked-by-command
N None
Y Inconsistent-parameters
Y Locked-by-other-client
N Parameter-change-in-
execution

Ct10 1, 2 How to force a “test-not-ok” respond with SelectWithValue request Device in local mode

Ct11 1, 2 How to force a “test-not-ok” respond with Select request

Ct12 1, 2 How to force a “test-not-ok” respond with Operate request DOns: Sending T=1
SBOns: Sending T=1
DOes:Sending T=1
SBOes: Sending T=1

Ct13 1, 2 Which origin categories are supported / accepted N bay-control
Y station-control
Y remote-control
N automatic-bay
Y automatic-station
Y automatic-remote
N maintenance
N process

Ct14 1, 2 What happens if the orCat value is not supported or invalid DOns: control is rejected (Oper- 
ObjectAccessDenied).
SBOns: control is rejected (Oper- 
ObjectAccessDenied).
DOes:control is rejected (Oper- 
ServiceError, ObjectAccessDenied).
SBOes: control is rejected (SBOw- 
ServiceError, ObjectAccessDenied).
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11 PIXIT for Time synchronization model

Ct15 1, 2 Does the IED accept a SelectWithValue /  Operate with the same 
control value as the current status value

Is this behavior configurable

N DOns
N SBOns
N DOes
N SBOes
N Configurable

Ct16 1, 2 Does the IED accept a select/operate on the same control object from 
2 different clients at the same time

N DOns
N SBOns
N DOes:
N SBOes

Ct17 1 Does the IED accept a Select/SelectWithValue from the same client 
when the control object is already selected (Tissue #334)

N SBOns
N SBOes

Ct18 1, 2 Is for SBOes the internal validation performed during the 
SelectWithValue and/or Operate step

SelectWithValue and Operate

Ct19 - Can a control operation be blocked by Mod=Off or [On-]Blocked 
(Compare PIXIT-Sr5)

Deprecated

Ct20 1, 2 Does the IED support local / remote operation Y (Only for XCBR)

Ct21 1, 2 Does the IED send an InformationReport with LastApplError as part of 
the Operate response- for control with normal security

N SBOns
N DOns:

Ct22 2 How to force a “parameter-change-in-execution” N/A SBOns
N/A SBOes

ID Ed Description Value / Clarification

Tm1 1, 2 What time quality bits are supported (may be set by the IED) Y LeapSecondsKnown
N ClockFailure 
Y ClockNotSynchronized.

Tm2 1, 2 Describe the behavior when the time server(s) ceases to 
respond

What is the time server lost detection time

On one time server: An event is generated
On all time servers: An event is generated
60 seconds

Tm3 1, 2 How long does it take to take over the new time from time 
server

2 seconds

Tm4 1, 2 When is the time quality bit “ClockFailure” set Never

Tm5 1, 2 When is the time quality bit “Clock not Synchronized” set 60 seconds after the time server(s) ceases to 
respond.

Tm6 - Is the timestamp of a binary event adjusted to the configured 
scan cycle

Deprecated

Tm7 1 Does the device support time zone and daylight saving Y

Tm8 1, 2 Which attributes of the SNTP response packet are validated Y Leap indicator not equal to 3
Y Mode is equal to SERVER
N OriginateTimestamp is equal to value sent by 
the SNTP client as Transmit Timestamp
Y RX/TX timestamp fields are checked for 
reasonableness
Y SNTP version 3 and/or 4
N other (describe)

Tm9 1, 2 Do the COMTRADE files have local time or UTC time and is this 
configurable

Local
N
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12 PIXIT for File transfer model

13 PIXIT for Service tracking model

Description Value / Clarification

1, 2 What is structure of files and directories

Where are the COMTRADE files stored 

Are comtrade files zipped and what files are included in each 
zip file

/COMTRADE

N

1, 2 Directory names are separated from the file name by “/”

1, 2 The maximum file name size including path (recommended 64 
chars)

255 chars

1, 2 Are directory/file name case sensitive Case sensitive

1, 2 Maximum file size for SetFile

1, 2 Is the requested file path included in the MMS fileDirectory 
respond file name

Y

1, 2 Is the wild char supported MMS fileDirectory request No

1, 2 Is it allowed that 2 clients get a file at the same time Y same file
Y different files

1, 2 Which files can be deleted

ID Ed Description Value / Clarification

Tr1 1, 2 Which ACSI services are tracked by LTRK.GenTrk Not Applicable
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7.3.7.3.8  PIXIT for 650 family of relays whose order code has Rear Ethernet Communication Board 2 
option "H", "G", "K", "J", "L", "M" and IEC 61850 Edition 1

Reference documentation: PIXIT For C650 relay V1_00 firm7_70.

This document specifies the protocol implementation extra information for testing (PIXIT) of the IEC 61850 interface in:

C650 Bay Controller with firmware version 7.70 and above.

Together with the PICS and the MICS the PIXIT forms the basis for a conformance test according to IEC 61850-10. The PIXIT 
entries contain information which is not available in the PICS, MICS, TICS documents or SCL file.

Each table specifies the PIXIT for applicable ACSI service model as structured in IEC 61850-10. The "Ed" column indicates if 
the entry is applicable for IEC 61850 Edition 1 and/or Edition 2. 

1 PIXIT For Association Model

ID Ed Description Value / Clarification

As1 1 Maximum number of clients that can set-up an association 
simultaneously

5

As2 1, 2 TCP_KEEPALIVE value. The recommended range is 1..20s 5 seconds but if no application message is 
detected within the As3 value, the device 
closes the connection.

As3 1, 2 Lost connection detection time 120 seconds (Configurable)

As4 - Authentication is not supported yet

As5 1, 2 What association parameters are necessary for successful 
association

Y Transport selector
Y Session selector
Y Presentation selector
N AP Title
N AE Qualifier

As6 1, 2 If association parameters are necessary for association, describe 
the correct values e.g.

Transport selector 0001
Session selector 0001
Presentation selector 00000001
AP Title N/A
AE Qualifier N/A

As7 1, 2 What is the maximum and minimum MMS PDU size Max MMS PDU size120000
Min MMS PDU size7000.

As8 1, 2 What is the maximum start up time after a power supply interrupt 90 seconds
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2 PIXIT for Server model

3 PIXIT for Dataset model

ID Ed Description Value / Clarification

Sr1 1, 2 Which analogue value (MX) quality bits are supported (can be set 
by server)

Validity: 
Y Good, 
Y Invalid 
N Reserved 
Y Questionable
N Overflow 
Y OutofRange 
Y BadReference
N Oscillatory
Y Failure
N OldData
N Inconsistent
N Inaccurate 
Source: 
N Process
N Substituted
N Test 
N OperatorBlocked 

Sr2 1, 2 Which status value (ST) quality bits are supported (can be set by 
server)

Validity: 
Y Good
Y Invalid 
N Reserved 
Y Questionable 
N BadReference
Y Oscillatory
Y Failure
N OldData
N Inconsistent
N Inaccurate 
Source: 
Y Process
Y Substituted
Y Test 
N OperatorBlocked

Sr3 - What is the maximum number of data object references in one 
GetDataValues request

Deprecated

Sr4 - What is the maximum number of data object references in one 
SetDataValues request

Deprecated

Sr5 1 Which Mode values are supported 1

1.  IEC 61850-6:2009 clause 9.5.6 states that if only a sub-range of the enumeration value set is supported, this shall 
be indicated within an ICD file by an enumeration type, where the unsupported values are missing.

Y On
N [On-]Blocked
N Test
N Test/Blocked
N Off

ID Ed Description Value / Clarification

Ds1 1 What is the maximum number of data elements in one data set 
(compare ICD setting)

576

Ds2 1 How many persistent data sets can be created by one or more 
clients
(this number includes predefined datasets)

NOT SUPPORTED

Ds3 1 How many non-persistent data sets can be created by one or 
more clients

NOT SUPPORTED
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4 PIXIT for Substitution model

5 PIXIT for Setting group control model

6 PIXIT for Reporting model

ID Ed Description Value / Clarification

Sb1 1 Are substituted values stored in volatile memory Not Supported

ID Ed Description Value / Clarification

Sg1 What is the number of supported setting groups for each logical 
device

6 groups for “PRO” logical device 3

Sg2 What is the effect of when and how the non-volatile storage is 
updated
(compare IEC 61850-8-1 $16.2.4)

The server saves to non-volatile storage 25 
seconds after confirmation.

Sg3 Can multiple clients edit the same setting group No

Sg4 What happens if the association is lost while editing a setting 
group

Lost Permission and EditSG = 0

Sg5 Is EditSG value 0 allowed Yes

Sg6 When ResvTms is not present how long is an edit setting group 
locked

While EditSG > 0

ID Ed Description Value / Clarification

Rp1 1 The supported trigger conditions are
(compare PICS)

Y Integrity
Y Data change
Y Quality change
N Data update
Y General interrogation

Rp2 1 The supported optional fields are Y Sequence-number
Y Report-time-stamp
Y Reason-for-inclusion
Y Data-set-name
Y Data-reference
Y Buffer-overflow
Y EntryID
Y Conf-rev
Y Segmentation

Rp3 1, 2 Can the server send segmented reports Y

Rp4 1, 2 Mechanism on second internal data change notification of the 
same analogue data value within buffer period (Compare IEC 
61850-7-2 $14.2.2.9)

Send report immediately

Rp5 1 Multi client URCB approach 
(compare IEC 61850-7-2:2003 $14.2.1)

Each URCB is visible to all clients

Rp6 - What is the format of EntryID Deprecated

Rp7 1, 2 What is the buffer size for each BRCB or how many reports can 
be buffered

Buffer size = 50000 Bytes

Rp8 - Pre-configured RCB attributes that are dynamic, compare SCL 
report settings

Deprecated

Rp9 1 May the reported data set contain: 
- structured data objects
- data attributes

Y
Y (timestamp attributes are not supported)
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7 PIXIT for Logging model

8 PIXIT for GOOSE publish model

Rp10 1, 2 What is the scan cycle for binary events
Is this fixed, configurable

Event Driven
Fixed

Rp11 1 Does the device support to pre-assign a RCB to a specific client 
in the SCL

N

Rp12 2 After restart of the server is the value of ConfRev restored from 
the original configuration or retained prior to restart

Restored from original configuration 

ID Ed Description Value / Clarification

Lg1 1, 2 What is the default value of LogEna 
(Compare IEC 61850-8-1 $17.3.3.2.1, the default value should be 
FALSE)

NOT SUPPORTED

Lg2 - What is the format of EntryID Deprecated

Lg3 1, 2 Are there are multiple Log Control Blocks that specify the 
Journaling of the same MMS NamedVariable and TrgOps and 
the Event Condition 
(Compare IEC 61850-8-1 $17.3.3.3.2)

NOT SUPPORTED

Lg4 1 Pre-configured LCB attributes that cannot be changed online NOT SUPPORTED

ID Ed Description Value / Clarification

Gp1 1, 2 Can the test (Ed1) / simulation (Ed2) flag in the published GOOSE 
be set

N

Gp2 1 What is the behavior when the GOOSE publish configuration is 
incorrect 

DUT keeps GoEna=F.
Configuration tool does not allow wrong 
configuration to be uploaded into device. E.g.: 
empty dataset.

Gp3 1, 2 Published FCD supported common data classes are SPS, INS, ENS, ACT, ACD, MV, CMV, SAV, WYE, 
DEL, SEQ, INC, ENC, SPC, DPC, INC, ENC. (Only 
the elements with FC=ST or MX are published).

Gp4 1, 2 What is the slow retransmission time
Is it fixed or configurable

Configured by SCL or GoCB MaxTime 

Gp5 1, 2 What is the fastest retransmission time 
Is it fixed or configurable

Fixed. MinTime = 5 ms

Gp6 - Can the GOOSE publish be turned on / off by using 
SetGoCBValues(GoEna)

Y

Gp7 1, 2 What is the initial GOOSE sqNum after restart sqNum = 1

Gp8 1 May the GOOSE data set contain: 
- structured data objects (FCD)
- timestamp data attributes

Y
Y (timestamp attributes are not supported)

Gp9 How is the retransmission curve after a change. sqNum = 0   New change
sqNum = 1 -> 5ms later with TAL = 1000
sqNum = 2 -> 10ms later with TAL = 1000
sqNum = 3 -> 15ms later with TAL = 4000
sqNum = 4 -> 1000ms later with TAL = Update 
time* multipled by 4
sqNum = 5 -> Update time* later with TAL = 
Update time* multipled by 4
sqNum = 6-> Update time* later with TAL = 
Update time* multipled by 4
sqNum = 7 ……..
………...
………….
*Update time is configured in the ICT
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9 PIXIT for GOOSE subscribe model

10 PIXIT for Control model

ID Ed Description Value / Clarification

Gs1 1, 2 What elements of a subscribed GOOSE header are checked to 
decide the message is valid and the allData values are 
accepted? If yes, describe the conditions. 
Notes: 
the VLAN tag may be removed by a ethernet switch and shall 
not be checked
the simulation flag shall always be checked (Ed2)
the ndsCom shall always be checked  (Ed2)

Y Destination MAC address
Y APPID
N gocbRef
Y timeAllowedtoLive
N datSet
Y goID
N t
N stNum
N sqNum
Y simulation / test
N confRev
Y ndsCom
Y numDatSetEntries

Gs2 1, 2 When is a subscribed GOOSE marked as lost
(TAL = time allowed to live value from the last received GOOSE 
message)

message does not arrive after TAL

Gs3 1, 2 What is the behavior when one or more subscribed GOOSE 
messages isn’t received or syntactically incorrect (missing 
GOOSE)

Message is ignored, but when the next correct 
message is received, it proceeds as normal.

Gs4 1, 2 What is the behavior when a subscribed GOOSE message is out-
of-order

Message proceeds

Gs5 1, 2 What is the behavior when a subscribed GOOSE message is 
duplicated

Message is ignored

Gs6 1 Does the device subscribe to GOOSE messages with/without the 
VLAN tag

Y, with the VLAN tag
Y, without the VLAN tag

Gs7 1 May the GOOSE data set contain: 
- structured data objects (FCD)
- timestamp data attributes

Y
N

Gs8 1, 2 Subscribed FCD supported common data classes are DUT can receive all kinds of data but only 
digitals can be mapped.

Gs9 1, 2 Are subscribed GOOSE with test=T (Ed1) / simulation=T (Ed2) 
accepted in test/simulation mode

N

Gs10 2 What is the behavior when a subscribed GOOSE message with 
TAL = 0 is received by the subscriber.

The message is ignored. The mechanism 
applies where the new GOOSE message is not 
received within a TAL.

Gs11 2 What is the behavior when a subscribed GOOSE message hasn’t 
the expected data structure.

The message is ignored. The mechanism 
applies where the new GOOSE message is not 
received within a TAL.

ID Ed Description Value / Clarification

Ct1 - What control models are supported
(compare PICS)

Deprecated

Ct2 1, 2 Is the control model fixed, configurable and/or dynamic Configurable & Dynamic

Ct3 - Is TimeActivatedOperate supported (compare PICS or SCL) Deprecated

Ct4 - Is “operate-many” supported (compare sboClass) Deprecated

Ct5 1 Will the DUT activate the control output when the test attribute is set 
in the SelectWithValue and/or Operate request (when N test 
procedure Ctl2 is applicable)

N

Ct6 - What are the conditions for the time (T) attribute in the 
SelectWithValue and/or Operate request

Deprecated
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Ct7 - Is pulse configuration supported (compare pulseConfig) Deprecated

Ct8 1, 2 What is the behavior of the DUT when the check conditions are set

Is this behavior fixed, configurable, online changeable

N synchrocheck
N interlock-check
DUT ignores the check value and always 
perform the check

Ct9 1, 2 Which additional cause diagnosis are supported Y Unknown
Y Not-supported
Y Blocked-by-switching-hierarchy
N Select-failed
Y Invalid-position
Y Position-reached
N Step-limit
N Blocked-by-Mode
N Blocked-by-process
N Blocked-by-interlocking
N Blocked-by-synchrocheck
Y Command-already-in-execution
N Blocked-by-health
N 1-of-n-control
N Abortion-by-cancel
Y Time-limit-over
N Abortion-by-trip
Y Object-not-selected
Edition 1 specific values:
N Parameter-change-in-execution
Edition 2 specific values:
Y Object-already-selected
N No-access-authority
N Ended-with-overshoot
N Abortion-due-to-deviation
N Abortion-by-communication-loss
N Blocked-by-command
N None
Y Inconsistent-parameters
Y Locked-by-other-client
N Parameter-change-in-execution

Ct10 1, 2 How to force a “test-not-ok” respond with SelectWithValue request Device in local mode

Ct11 1, 2 How to force a “test-not-ok” respond with Select request

Ct12 1, 2 How to force a “test-not-ok” respond with Operate request DOns: Sending T=1
SBOns: Sending T=1
DOes: Sending T=1
SBOes: Sending T=1

Ct13 1, 2 Which origin categories are supported / accepted N bay-control
Y station-control
Y remote-control
N automatic-bay
Y automatic-station
Y automatic-remote
N maintenance
N process

Ct14 1, 2 What happens if the orCat value is not supported or invalid DOns: control is rejected (Oper- 
ObjectAccessDenied).
SBOns: control is rejected (Oper- 
ObjectAccessDenied).
DOes: control is rejected (Oper- 
ServiceError, ObjectAccessDenied).
SBOes: control is rejected (SBOw- 
ServiceError, ObjectAccessDenied).

Ct15 1, 2 Does the IED accept a SelectWithValue / Operate with the same 
control value as the current status value

Is this behavior configurable

N DOns
N SBOns
N DOes
N SBOes
N Configurable
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11 PIXIT for Time synchronization model

Ct16 1, 2 Does the IED accept a select/operate on the same control object from 
2 different clients at the same time

N DOns
N SBOns
N DOes
N SBOes

Ct17 1 Does the IED accept a Select/SelectWithValue from the same client 
when the control object is already selected (Tissue #334)

N SBOns
N SBOes

Ct18 1, 2 Is for SBOes the internal validation performed during the 
SelectWithValue and/or Operate step

SelectWithValue and Operate

Ct19 - Can a control operation be blocked by Mod=Off or [On-]Blocked 
(Compare PIXIT-Sr5)

Deprecated

Ct20 1, 2 Does the IED support local / remote operation Y (Only for XCBR)

Ct21 1, 2 Does the IED send an InformationReport with LastApplError as part of 
the Operate response- for control with normal security

N DOns
N SBOns

Ct22 2 How to force a “parameter-change-in-execution” N/A SBOns
N/A SBOes

Ct23 1, 2 How many SBOns / SBOes control objects be selected at the same 
time?

SBOns:    n = "1"
DOns:      n = "1"

Ct24 1, 2 Does the DUT support any operate timeout >0 Y

Ct25 1, 2 When CDC=DPC is supported, is it possible to have DPC (Controllable 
Double Point) go to the intermediate state? (00)

N

ID Ed Description Value / Clarification
Tm1 1, 2 What time quality bits are supported (may be set by the IED) Y LeapSecondsKnown

N ClockFailure 
Y ClockNotSynchronized.

Tm2 1, 2 Describe the behavior when the time server(s) ceases to 
respond

What is the time server lost detection time

On one time server: An event is generated
On all time servers: An event is generated
180 seconds

Tm3 1, 2 How long does it take to take over the new time from time 
server

2 seconds

Tm4 1, 2 When is the time quality bit “ClockFailure” set Never
Tm5 1, 2 When is the time quality bit “Clock not Synchronized” set 60 seconds after the time server(s) ceases to 

respond.
Tm6 - Is the timestamp of a binary event adjusted to the configured 

scan cycle
Deprecated

Tm7 1 Does the device support time zone and daylight saving Y
Tm8 1, 2 Which attributes of the SNTP response packet are validated Y Leap indicator not equal to 3

Y Mode is equal to SERVER
N OriginateTimestamp is equal to value sent by 
the SNTP client as Transmit Timestamp
Y RX/TX timestamp fields are checked for 
reasonableness
Y SNTP version 3 and/or 4
N Other (describe)

Tm9 1, 2 Do the COMTRADE files have local time or UTC time and is this 
configurable

Local
N
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12 PIXIT for File transfer model

13 PIXIT for Service tracking model

ID Ed Description Value / Clarification

Ft1 1 What is structure of files and directories

Where are the COMTRADE files stored 

Are comtrade files zipped and what files are included in each 
zip file

/COMTRADE

N

Ft2 1, 2 Directory names are separated from the file name by “/”

Ft3 1 The maximum file name size including path (recommended 64 
chars)

255 chars

Ft4 1, 2 Are directory/file name case sensitive Case sensitive

Ft5 1, 2 Maximum file size for SetFile Not applicable

Ft6 1 Is the requested file path included in the MMS fileDirectory 
respond file name

Y

Ft7 1 Is the wild char supported MMS fileDirectory request No

Ft8 1, 2 Is it allowed that 2 clients get a file at the same time Y same file
Y different files

Ft9 1, 2 Which files can be deleted Not applicable

ID Ed Description Value / Clarification

Tr1 2 Which ACSI services are tracked by LTRK.GenTrk Not Applicable
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7.4  IEC 61850 FUNCTIONALITY

7.4.1  Client Connections
The 650 Family relay supports up to five IEC61850 concurrent client connections, i.e a maximum of 5 different IEC 61850 
clients can connect to it.

The “UseLocSta” setting, which enables/disables usage of LLN0.LocSta, has been implemented in 61850 configurator, in 
order to verify the origin of the 61850 command. This setting has been added into the CID file, and is configurable using 
EnerVista IEC61850 version 8.14 or above. In order to access “UseLocSta”, a .cid file must be opened in the IEC61850 
Configurator menu and it can then be found using the path GE_F650 > Server Configuration > UseLocSta. If TRUE, it takes 
into consideration the LLN0.LocSta values during IEC61850 command execution and if FALSE, LLN0.LocSta values are 
ignored. If UseLocSta is not implemented, the operation over Logical Nodes XCBR/CSWI/XSWI/vinGGIO will not take LocSta 
status into consideration.

To activate the use of LocSta, set the value of “UseLocSta” to TRUE using EnerVista IEC61850 Configurator, save the CID file, 
download it to the relay and reboot it.

The data object “Loc” shows the control behavior of the logical node. In the datamodel of 650 relays, it appears in LLN0/
XCBR/XSWI/CSWI Logical Nodes and it is internally mapped to the Local/Remote status of the device.

Note: The saving process is updated in ICD FILE STATUS in System Info and it is recommended that the relay is not rebooted 
until the process finishes (OK WITHOUT DAIS or OK), otherwise the last value of “LocSta” could be lost.

7.4.2  GOOSES
650 relays support transmission and reception of configurable IEC 61850 Generic Object Oriented Substation Event 
(GOOSE). To enable GOOSES communications, remote comms must be set to GOOSE in the EnerVista 650 Setup software at 
Setpoint > Input/Output > Remote Comms.

Configurable GOOSE is recommended for implementations that require GOOSE data transfer between 650 relays and 
devices from other manufacturers. 

7.4.2.1  TRANSMISSION GOOSES 

A maximum of four different transmission GOOSE applications are supported. Data Sets for transmissions GOOSES can 
have a maximum of 128 elements and can be leaf elements (Data Attributes), or complex structures (Data Objects).

7.4.2.2  RECEPTION GOOSES 

650 relays can be subscribed up to 24 different remote devices. A maximum of 32 Remote Inputs (digital signals), 32 
Remote Goose Digital inputs and 16 Remote Goose Analog Inputs can be configured to be subscribed to.

The elements of Data Sets for reception GOOSEs can be of any types supported in IEC 61850 standard and can be both leaf 
elements (Data Attributes) and complex structures (Data Objects). However C650 relay can map to its internal variables 
incoming data of type Boolean, Float, Integer and any of the bits from Bitstring data type.

7.4.3  IEC 61850 Server
The IEC 61850 Server (i.e., 650 relay) reports data to the IEC 61850 Client, such as Local HMI, RTU and Gateway with the 
information of logical device, data sets, data control block, logical nodes and their data attributes.

7.4.3.1  LOGICAL DEVICES AND REPORTS 

Supported buffered and un-buffered report, the report triggers are shown in the following Supported Triggers list.

Supported Triggers List:

• Data-Change
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• Quality-Change

• Integrity

• General Interrogation

Supported buffered and un-buffered report option fields are shown in the following Field list.

Field List:

• Sequence number 

• Report time stamp 

• Reason-for-inclusion 

• Dataset-name

• Data-reference

• Buffer-overflow (Buffered reports only)

• Entry id (Buffered reports only)

• Conf- revision 

Report control block configuration settings are modified from IEC61850 configurator writing directly in a CID file. There is 
no Modbus register assigned to those. The datasets for reports are fully configurable with CDCs from any Logical Node. 
The Description field in the LN is fixed text and it cannot be updated from the Modbus settings

By default, 

• if Unbuffered report is selected, 5 Unbuffered Report Control Blocks are created. This figure can be modified from 1 to
5.

• If Buffered report is selected, 1 Unbuffered Report Control Block is created. This figure can be modified from 1 to 5.
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7.5  IEC 61850 Status

7.5.1  GOOSE Status
Different status information related with GOOSE transmission/reception process that can be checked through EnerVista 
650 Setup:

In Actual > Inputs/Outputs > Remote Inputs > Remote GOOSE Digital Inputs:

Rem GOOSE Dig Inp X - Provides status of Remote Goose Digital input X that relay is subscribed to. The green LED lights up 
if Remote GOOSE Digital Input was set to 1 last time it was received and it turns off if the last Remote GOOSE Digital Input 
was set to 0.

There is a maximum of 32 Remote GOOSE Digital Inputs that the relay can be subscribed to.

In Actual > Inputs/Outputs > Remote Inputs > Remote Inputs:

Remote Input X - Provides status of Remote input X that relay is subscribed to. The green LED lights up if Remote Input was 
set to 1 last time it was received and it turns off if the last Remote Input was set to 0

There is a maximum of 32 Remote Inputs that relay can be subscribed to. These remote inputs are digital signals.

In Actual > Inputs/Outputs > Remote Inputs > Remote GOOSE Analog Inputs:

Rem GOOSE Ana Inp X- This is the last analog value received in the Remote GOOSE Analog Input configured. 

The relay can be subscribed to up to maximum of 8 different float remote GOOSE analog values and 8 different integer 
remote GOOSE analog values.

In Actual > Inputs/Outputs > Remote Inputs > Remote Devices:

Remote Device X - Provides information about status of device that is transmitting GOOSES, that the relay is subscribed to. 
The green LED lights up if remote device is transmitting GOOSES and it turns off if GOOSE communication is lost with this 
remote device.

A maximum of 24 different Remote devices can be configured in CID

ALL REM DEV ONLINE - Provides status of Remote Devices that are transmitting GOOSES that the relay is subscribed to. If 
GOOSE communication with all configured Remote Devices is active, the green LED lights up. If GOOSE communication is 
lost with any of configured remote devices, it turns off.

In Actual > Inputs/Outputs > Remote Outputs > Remote GOOSE Digital Outputs:

Rem GOOSE Dig Out X - Provides status of Remote Goose Digital outputs that are configured to be transmitted by the 
relay. The green LED lights up if Remote GOOSE Digital Output is set to 1 and it turns off if Remote GOOSE Digital Output is 
set to 0

7.5.2  IEC 61850 CID Status
Internal Status of CID and its validation can be checked in EnerVista in the following path:

Actual Values > Status > System Info

ICD Edition: 

This field shows which IEC 61850 Edition if CID that relays is working with. For C650. See 7.1 IEC 61850 Overview on page 7–
1.
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ICD FILE STATUS:

This field provides status of CID that is running in the relay.

ICD STATUS NOTVAL:

This field provides information about the NotValidated folder, which is the folder where CIDs that are sent to the relay are 
stored prior to be validated and marked "Valid". 

ICD FILE STATUS

UNKNOWN: When the relay has not the IEC61850 protocol in 
the relay model the ICD status is unknown to the unit.

ICD ERROR: There is an error in the ICD file and the relay ICD 
is not operative. To solve this issue it is necessary to send a 
correct ICD to the relay using the IEC61850 configurator 
tool. When the ICD error is raised the IEC 61850 is not 
operative (the IEC 61850 client, reports and gooses do not 
work). It is advisable to include the ICD ERROR in the main 
error signal configured for specific applications.
MODIFIED: The settings have been changed in the icd but they 

are still not written in the icd file in the relay
IN PROGRESS: The icd setting are being written to the file in 
the relay.
OK WITHOUT DAIS: The relay has not got the "Use DOI &DAI" 
setting enabled (true) and it is working properly with the ICD file.
OK: The relay has got the "Use DOI &DAI" setting enabled 
(true) and it is working properly with the ICD file. When that 
setting is set to true the icd setting prevails over the relay 
settings
DEFAULT: There is no CID file in notvalidated neither in 
validated and default CID has been loaded. After a reboot, 
default CID file is considered as a normal CID file.
ERROR HEADER CID: there is a discrepancy in the 
information about product model or firmware version 
between the firmware of the relay and the CID file. If this 
message is displayed, relay shall not be able to 
communicate by using IEC 61850 until this discrepancy is 
solved. CID version and firmware version must match in 
order to get complete functional relay.
ERROR SG CID is displayed if the relay has the Setting Group 
function disabled but the managed CID file has the Settings 
Groups available or the relay has the Setting Group function 
enabled but the managed CID file has the Settings Groups 
not available.

ICD STATUS NOTVAL

UNKNOWN: No 61850 protocol
ERROR: The CID file in notvalidated is not valid
NOTVALIDATED EMPTY: There is no CID file in notvalidated
IN PROGRESS: The icd setting are being written to the file in 
the relay.
PASSED TO VALIDATED: New valid CID file in notvalidated y 
and passed to validated
ERROR HEADER CID: There is a discrepancy in the 
information about product model or firmware version 
between the firmware of the relay and the CID file. If this 
message is displayed, relay shall not be able to 
communicate by using IEC 61850 until this discrepancy is 
solved. CID version and firmware version must match in 
order to get complete functional relay.
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1. WATCH OUT! If the ICD status is "MODIFIED" or "IN PROGRESS" it is not advisable to switch off the 
unit because the latest settings would not be stored in the unit.

2. In the case that ERROR SG CID is displayed in the ICD Status, ensure that the managed CID has 
Setting Group enabled if the Setting Groups function is enabled, or ensure that the managed CID has 
Setting Group disabled if the Setting Groups function is disabled. 

For firmware versions 7.20 and 7.21:

– default_F650SG_v7XX.cid: CID file with setting group option enabled

– default_F650_v7XX.cid: CID file with setting group option disabled

For firmware versions below 7.20 above 7.21:

– default_F650_v7XX.cid: CID file with setting group option disabled/enabled

3. Take into in account that if ERROR HEADER CID value is displayed in the ICD STATUS or ICD STATUS 
NOT VAL section in Actual Values > Status > System info, the relay cannot communicate using 
IEC 61850 until this discrepancy is resolved. CID version and firmware version must match for a fully 
functional relay.
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7.6  IEC 61850 Configurator

7.6.1  Overview
The 650 family relays support the IEC 61850 protocol which is identified by order code option "6" or "7" (Communication 
protocol option). This configuration tool can be used with 650 family relays supporting IEC 61850 communication protocol 
and with firmware version 3.60 or above.

The "IEC 61850 Configurator" tool is located in the top-level menu in EnerVista 650 Setup and it can be used to browse and 
edit 650 relay's CID/IEC files:

• ICD/CID Settings 

• Reports 

• GOOSE Reception 

• GOOSE Transmission

Figure 7-5: IEC61850 configurator menu location

Important Notes:

For firmware versions below 3.60, basic IEC 61850 configuration is located in Setpoint > 61850 Configuration (Domain 
name parameters, Ethernet parameters, MMXU parameters). With this tool some 61850 parameters can be configured in 
the *650.icd file, and then the .icd file can be uploaded to the relay. 

7.6.2  Online/Offline operation modes
Two different working modes can be distinguished in the IEC 61850 Configurator: Offline mode and Online mode. 

Offline Operation Mode: When user is not communicating with 650 Family relay, IEC 61850 Configurator tool can be used 
to work offline mode. In this case, if IEC 61850 Configurator menu is clicked at the menu toolbar in EnerVista, the following 
windows prompts to allow selection of the IED version to be configured.

Figure 7-6: IED version verification

• Click Yes to browse and edit CID/ICD files for firmware versions above 7.XX

• Click No to browse and edit IEC files for firmware versions below 7.XX

Online Operation Mode: When communicating with an C650 using the EnerVista 650 Setup software, the IEC61850 
Configurator tool allows access to the CID/IEC of the connected device, or to send a previously configured file.
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Figure 7-7: IEC 61850 Configurator main screen 

7.6.3  IEC 61850 configurator details
The IEC61850 Configurator allows editing in all sections of the IEC61850 CID file. Other operations cannot be performed in 
the EnerVista 650 Setup software if the IEC 61850 Configurator is open. Close the IEC61850 session to perform other 
operations.

In the following sections, detailed information about CID configuration for firmware version 8.00 is described. These same 
steps apply to CID configuration for all 650 family firmware versions 7.00 and above.

7.6.3.1  IEC 61850 configurator interface.

Four different areas can be identified in IEC 61850 configurator interface, as shown in the figure that follows: 

• "Menu toolbar

• Quick menu toolbar

• IEC 61850 IED Explorer window

• Configuration area
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Figure 7-8:  IEC 61850 Configurator interface

7.6.3.1.1  Menu toolbar

Two menus available in this area:

File Menu: 

Open *.cid file 

Save *cid file 

Received *cid file from device

Send *cid file to the relay

See 7.6.3.1.2 Quick Menu Toolbar for detailed information

Tools Menu: (CID conversion tools)

A CID file converter menu option is available in the IEC 61850 Configurator menu: Tools > ConvertCIDFiles. The CID file 
converter enables CID file conversion, allowing for conversion of CID files in parallel with relay firmware updates. The main 
parts of the CID file that are maintained are the configurable fields at the Communication and IED levels, the public and 
private Settings, Datasets, Report Control Blocks, GOOSE Transmission Control Blocks and GOOSE Reception.
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To convert a CID file, follow these steps:

1. In the IEC61850 Configurator, select Tool > ConvertCIDFiles.

Figure 7-9: ConvertCIDFiles option

2. Select a CID file to convert in the CID file (*.cid) field.

Figure 7-10: Main window in IEC61850 CID files conversion tool
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3. If no CID file is selected, an error message is displayed.

4. The CID file Converter fills in the firmware version of the selected CID file under Source Version. Select the new 
firmware version for the CID file under Destination Version.

Figure 7-11: Selection of CID files versions 

5. If no Destination Version is selected, an error message is displayed.
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Note: For successful conversion, the default CID file templates installed with the EnerVista 650 Setup must be in the
installed folder location with their original names, as shown.

Figure 7-12: Requirements for CID conversion 

6. Click Convert to start the conversion process. When the conversion is finished, a successful conversion message is 
displayed, followed by a message confirming the name and location of the converted file.

Figure 7-13: Successful CID conversion 
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Figure 7-14: CID file created and saved to disk 

7.6.3.1.2  Open IEC61850 file from disk / open *CID file

For firmware below 7.XX, the "Open IEC 61850 file from disk" menu allows the user to work in offline mode to configure IEC 
61850 protocol in 650 devices. The tool works with files of *.iec extension which contain the icd file from the devices and 
proprietary files needed for the whole configuration. 

In the EnerVista 650 Setup default files you will find the "F650_Vxxx.iec" corresponding to the firmware version related to 
the EnerVista installation.

For firmware version 7.XX or above, the "Open *CID file" menu allows the user to work in offline mode to configure IEC 
61850 protocol in 650 devices. In that occasion, the tool shall work with *.cid file extension which contain the icd file from 
the device.

In the EnerVista 650 Setup default files, user will find the "default_F650_vXXX.cid" corresponding to the firmware version 
related to EnerVista installation.

For firmware version 7.XX or above, consider the following notes:

For firmware versions from 7.20 and below 7.50, two different *.cid files are available for each version:

– default_F650_vXXX.cid": Default IEC61850 CID file for F650 if Setting group option is disabled.

– default_F650SG_vXXX.cid": Default IEC61850 CID file for F650 if Setting group option is enabled.

For firmware version 7.52 or above, F650 will work with IEC 61850 Edition 1 or Edition 2 depending on which *.cid is
configured and sent to the device. Consider your firmware version when choosing a default CID file from the files
provided with 7.52 EnerVista 650 Setup. For a default installation, these files are located at: 
C:\GE Power Management\650PC\IEC61850\F650

For firmware version 7.52 or above, two different *.cid files are available for each version:

– default_F650_vXXX_Ed1.cid”: Default IEC61850 CID Edition 1 file for F650

– default_F650_vXXX_Ed2.cid”: Default IEC61850 CID Edition 2 file for F650

To determine whether the relay is working with CID Edition 1 or Edition 2, download the active CID file from the relay:

1. Open the EnerVista Setup software, and click IEC 61850 Configurator on the menu bar.

2. Select File > Receive CID file from device, or click the download button.

3. Connect to the relay as prompted if you are not already connected.
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    Once the download completes, a message displays indicating a successful download. The CID file can then be 
    viewed and edited in the IEC 61850 Configurator.

4. Check the title bar of the CID file to determine the IEC 61850 version, as shown in the figure below.

Figure 7-15: Information about the IEC 61850 Edition

For all scenarios, after opening the file all ICD data is displayed in the ICD/CID tab and the user can start configuring the IEC 
61850 protocol in 650 devices.

7.6.3.1.3  IEC 61850 IED Explorer Window

After opening a CID file, the IED Explorer "tree" will be displayed in this area. Six different items are available in this menu:

• Access Point Addressing

• Server Configuration

• Settings

• DataSets

• Reports

• GOOSE

To Modify the Parameters 

1. Select a parameter in the ICD Explorer window to open the Attributes window in the right part of the screen. 

2. In the Configuration area, double click in the parameter column of the table and enter the new value for that setting. 
To confirm changes, double-click out of parameter field. 
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Access Point Addressing

Following settings can be configured in this section.

• IP, IP-SUBNET, IP-GATEWAY: The parameters are the configured ETH_A IP details configured in the device through
EnerVista: Setpoints > Product Setup > Communications > Network

• OSI-AP-Title, OSI-AE-Qualifier, OSI-PSEL, OSI-SSEL, OSI-TSEL: The parameters must be configured according to the IEC
61850 standard

• GOOSE-port: Three different options are available in this drop-box depending which port wants to be selected for
GOOSE transmission (ETHA-ETHB-Both) the user to change the GOOSE port number for GOOSE communication.

• MMS-Port: The range of the setting is 1 to 65535, in steps of 1. The setting allows the user to change the TCP port
number for MMS connections. 

• MMS- Connection-Timeout: The setting is useful for detecting "fail" IEC 61850 connections. The timer must be
application specific for IEC 61850. If there is no data traffic on an established connection for more than this setting
time, the connection is disconnected from the server

Server Configuration

• IED NAME: Up to 64 alphanumeric characters. The IED Name represents the MMS domain name (IEC 61850 logical
device) where all IEC/MMS logical nodes are located. Valid characters for these values are upper and lowercase
letters, numbers, and the underscore (_) character, and the first character in the string must be a letter. This conforms
to the IEC 61850 standard. Default value is "GEDevice"

• UseDoiDai:

– If this setting is set to false: the relay works only with the settings located in the relay's memory and the changes
performed on the ICD in settings related with the protection and control functions are only stored on the ICD file
but not updated in the relay.

– If this setting is set to true, you are selecting the ICD file settings to prevail over the relay settings. This means that
after changing settings in the ICD and powering the relay off and on the unit works with the settings included in
the ICD.

All setting changes performed through the HMI or EnerVista 650 Setup are automatically updated over the ICD file,
likewise if there is any change in the ICD file these changes are updated in the relay settings. The relay starts working
with the new ICD file after sending the file to the unit and powering the relay off and on. 

• Power Max and Min Automatic Calculation *: 

– If set to True, Max and Min values used for Power reporting are automatically calculated based on the CT Ratio
and VT Ratio setpoints.

– If set to False, Max and Min values used for Power reporting are configurable in the Settings / Max and Min tab.

*This setting is only available for Firmware version 7.70 and above.
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• PRO functional IdName: ID name of logical device where all protection logical nodes are available. The logical device
name is used to identify the IEC 61850 logical device that exists within the C650 and this name is composed of two
parts: the IED NAME and the PRO/CON functional IdName. Default name for PRO functional IdName is PRO

• CON functional IdName: ID name of logical device where all control logical nodes are available. Default name for CON
functional IdName is CON

Settings

Four different levels are available under setting section:

• Deadbands 

• Commands 

• Timeouts 

• Oscillation

• Max and Min

DEADBANDS   

Figure 7-16: Configuration of deadbands for MMXU

Range: 1 to 100.000 % 

The MMXU deadband settings represent the deadband values used to determine when to update the MMXU "mag" and 
"cVal" values from the associated "instmag" and "instcVal" values. The "mag" and "cVal" values are used for the IEC 61850 
buffered and unbuffered reports. The settings correspond to the associated "db" data items in the CF functional constraint 
of the MMXU logical node, as per the IEC 61850 standard. According to IEC 61850-7-3, the db value "shall represent the 
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percentage of difference between the maximum and minimum in units of 0.001%". Thus, it is important to know the 
maximum range for each MMXU measured quantity, since this represents the 100.00% value for the deadband and 
therefore A value of 1000 represents the 1% of the scale.

The equations to calculate minimum (min) and maximum (max) values that will be used to calculate deadbands in the 
MMXU nodes of C650 are as follows:

MMXU Node Value To Calculate Min/Max for F650/C650

TotW , TotVar
(MW, MVAr)

For firmware below 7.70:
max = (Phase CT Ratio *160) * (Phase VT Ratio * 300)/1000000
min = -max

For firmware 7.70 or above:

If Power Max and Min Automatic Calculation setting is set to false:
max = configurable value (Value is referred to primary values)
min = configurable value (Value is referred to primary values)

If Power Max and Min Automatic Calculation Setting is set to true:
max value will be the same as for firmware below 7.70
min value will be the same as for firmware below 7.70

Note: When max/min values are configurable, setting these values below accuracy levels 
could result in unpredictable behavior.

TotVA
(MVA)

For firmware below 7.70:
max = (Phase CT Ratio *160) * (Phase VT Ratio * 300)/1000000
min = 0

For firmware 7.70 or above:

If Power Max and Min Automatic Calculation setting is set to false:
max = configurable value
min = configurable positive value

If Power Max and Min Automatic Calculation Setting is set to true:
max value will be the same as for firmware below 7.70
min = 0

Note: When max/min values are configurable, setting these values below accuracy levels 
could result in unpredictable behavior.

Hz dbAng angle dB = (DB percentage* 
360)

max = 70 
min = 0

Hz Rte max = 15 
min = -15

PPV/PhV/Seq
(measurement in kV)

max= VT Ratio /1000 * 300;
min = 0

A$phsA, phsB, phsC, A$neut, A$res
(kA)
SeqA$c1, c2 ,c3

max=((Phase or Ground CT Ratio) /1000)*160;
min = 0
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Once maximum and minimum values are known, the maximum range can be calculated. This maximum range represents 
100% of the deadband (100000). The deadband to be configured for expected variations will be calculated based on 
maximum range.

MAX AND MIN

 Max and min values for analog inputs and power* reporting are configurable on this tab.

*Max and min values for Power reporting are only available when the Power Max and Min Automatic Calculation setting is 
set to false (See Server Configuration on page 7–122)

dbAng angle dB = (DB percentage* 360)

For firmware versions below 5.00:
There is one common deadband used both for angles and magnitudes in the corresponding 
phasor measurement (current or voltage). Take this into account when using reports with data 
change, because in some cases the angle value can trigger reports quite often due to the 
difficulty in calculating a common deadband for both values (angle and magnitude). In these 
cases it is advisable to use the integrity report in firmware versions lower than 5.00.

For firmware versions qbove 5.00:
The 650 family of relays implements separate deadbands for magnitude and angle for 
phasors (voltages and currents). Thus, for example, the phase A current attribute in the 650 
relay includes two deadbands, one for phase A current magnitude and the other for phase A 
current angle. The deadband for magnitude is the db parameter while the deadband for angle 
is the dbAng parameter

In addition to the MMXU logical node,  MSQI and Remote Input GGIO (default name rinGGIO1) 
also have attributes that are analogue values and contain db parameters to establish 
deadbands.

For firmware version below 7.00, deadbands are available in ICD/CID tab.

MMXU Node Value To Calculate Min/Max for F650/C650
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Figure 7-17: Max and Min

COMMANDS

In the C650 relay IEC 61850 controllable data exist in logical nodes vinGGIO, XCBR and CSWI:

• vinGGIO maps to Virtual Inputs of C650.

• XCBR represents the circuit breaker

• CSWI logical nodes represent switchgear of C650 relay.
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Figure 7-18: Commands

vinGGIO

Controllable data in vinGGIO logical node are SPCSO1 - SPCSO64 and DPCSO1 - DPCSO16. Signals SPCSO1 - SPCSO32
map to 32 Virtual Inputs Latched in C650 relay and signals SPCSO33 - SPCSO64 map to Virtual Inputs Self-Reset.
DPCSO1 - DPCSO16 are double control points and operate on pairs of Virtual Inputs Latched. Thus DPCSO1 - DPCSO16
map to 32 Virtual Inputs Latched and an operation of one attribute DPCSO always operate on two Virtual Inputs
Latched, one Virtual Input of the pair is set to "1" and the other Virtual Input of the pair is set to "0". In vinGGIO logical
node only control mode "direct control with normal security" can be used.

         XCBR, CSWI, recPhXCSWI

Controllable data in these logical nodes are Pos (position) objects. These are operations used to change state of
breaker, switch or recloser.

C650 relays supports all four IEC 61850 control modes (ctlModel), which are:

– Direct control with normal security (direct-with-normal-security)

– SBO control with normal security (sbo-with-normal-security)

– Direct control with enhanced security   (direct-with-enhanced-security)

– SBO control with enhanced security (sbo-with-enhanced-security)
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TIMEOUTS

Figure 7-19: Timeouts

There is a configurable timeout for SBO control modes and for operation in logical nodes listed above. The value range for 
SBO timeout is 500 ms - 60 seconds. 

The sboClass attribute can only have value "operate-once", "operate-many" pattern is not supported in IEC 61850 SBO 
controls in 650 relay.

OSCILLATION

There are two settings used for the detection of the digital inputs of I/O boards and rinGGIO LN oscillation, OscTmms and 
NumChgs.

·OscTmms: time between two changes in the same direction (from 0 to 1 or from 1 to 0) to consider that a signal is 
oscillating. There are four settings for each GGIO (OscTmmsA, OscTmmsB, OscTmmsC and OscTmmsD), one for each group 
of inputs, and one in rinGGIO logical node.

·NumChgs: number of changes that have to be produced in an oscillatory signal to be consider as invalid and not to 
continue sending changes of the signal, sending the value of the signal when it was consider as oscillatory.
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DataSet

Two different sections will be differentiated under this section:

• Summary

• DataSetXX

SUMMARY

In this screen, user can find a list with information about where a configured DataSetXX has been used (Report and/or 
GOOSE). 

If a DataSetXX is shared by more than one Report/GOOSE, all elements will be listed in DataSetXX Parameter field, 
separated by commas.
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Figure 7-20: DataSetXX summary view

DataSetXX:

In this section, configure up to 20 different DataSets as follows: 

DataSetXX name: It must be assigned initially. The first character of this attribute must be a letter (upper or lower
case). The rest must be a number, a letter (upper or lower case or a "_". The number of characters allowed in 32

If this name is not configured, the following message will prompt when trying to drag any new element:

 

Figure 7-21: DataSet name not configured.



CHAPTER 7:  IEC 61850 PROTOCOL 7.6 IEC 61850 CONFIGURATOR

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 7-131

DataSetXX MemberX: After DataSet name is defined, members can be adding by dragging and dropping elements
from the complete data model of the IED displayed below to the Data Set. 

Figure 7-22: Adding attributes to a DataSet

There is a counter in the right-up corner of configuration area where users can visualize how many basic attributes have 
been added to a DataSetXX. This counter will increase automatically when basic attributes are dragged and dropped.
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For example id CON.MMXU1.MX.A.net.cVal is dragged and dropped into DataSet, counter will be increased in two as there 
are two basic attributes in it (CON.MMXU1.MX.A.net.cVal.mag and CON.MMXU1.MX.A.net.cVal .ang)

Figure 7-23: Basic attributes counter

To change the Order of the configured DataSet:

1. Select DataSet Member to be moved.

2. Click on Shift and up/down key. 

To delete a Dataset Member:

1. Click on DataMember.

2. Press SUPR key.

To remove a DataSetXX:

1. Select DataSetXX in the IEC 61850 IED Explorer window.

2. Click right-button and select Delete DataSet as shown:

Figure 7-24: Delete DataSet
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Reports

The 650 family relay supports both IEC 61850 buffered and unbuffered reporting. The device has configurable reports, 
which include user-defined Data Sets and Report Control Blocks.Reporting is based on Data Sets, which are collections of 
Data that can be included in Reports. The Report Control Block is a group of parameters which permit IEC 61850 
customization of the reports being sent by the IEC 61850 server. For example, the IntgPd parameter of the Report Control 
Block contains the value in milliseconds of the interval between Integrity Reports sent by IEC 61850 servers.

A 650 family relay can have up to 20 different reports and up to 20 different Data Sets linked (only one DataSet can be 
linked to one Report). In the reports, each Dataset can be configured with a maximum of 576 Dataset Members. 

All settings/datasets assigned to different reports can configured as described in this section. Up to 20 different reports 
can be configured.

ReportX Name: 

The first character in the value of this attribute must be a letter (upper or lower case). The rest of the characters must
be a number, a letter (upper or lower case) or a "_". The maximum number of characters allowed in IEC61850
Configurator is 30 and IEC61850 MMS Library adds 2 more characters indicating the number of the instance of the
RCB depending on the number of IEC61850 clients configured

ReportX RptID:

The attribute RptID is the client-specified report identifier of the RCB that has caused the generation of the report.

ReportX DatSet:

This dropbox lists only DataSets configured in DataSet section with less than 576 DataSet Members. Select the
Dataset that is going to be assigned to Report X,

ReportX ConfRev:

It represents the configuration revision number of the control block

ReportX OptFlds:

Different options for report triggers are listed in this drop-box list. One or more options the report triggers are shown in
the Supported Triggers list:

– Data-Change

– Quality-Change

– Integrity

– General Interrogation

ReportX BufTm:

This setting is only considered if ReportX Buffer setting is set to true. In case of an event that causes a report the server
will wait for BufTm ms for other events. All data that is to be reported because of events in this time span is sent in a
single report. If connection with client is lost, events will be logged during BufTm and they will be sent when client
connects again.

ReportX IntgPd

Only working if general interrogation is configured in trigger options. The integrity period specifies an interval in ms for
the periodic sending of integrity reports.
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ReportX Buffered: 

The standard distinguishes between two types of reporting: buffered reporting and unbuffered reporting. With
buffered reporting reports are buffered by the server in case a connection to the client is interrupted. This way reports
can be sent after the client has connected again. Buffered reporting is configured through buffered report control
blocks (BRCB). Unbuffered reporting is configured through unbuffered report control blocks (URCB).

If it set to true, report will be configured as buffered report control block (BRCB). If set to false, report will be configured
as unbuffered report control block (URCB)

ReportX Max Clients: 

Number of clients that can be connected to a report control block. Up to 5 different clients can be configured

GOOSE

TxGOOSE

In this section, configure four different transmission GOOSE: TXGOOSEX. 

Figure 7-25: Transmitted GOOSE settings

TxGOOSEX Name:

The first character in the value of this attribute must be a letter (upper or lower case). The rest of the characters must
be a number, a letter (upper or lower case) or a "_". The maximum number of characters allowed is 32. 

TxGOOSEX Desc:

The maximum number of characters allowed is 32.

TxGOOSEX GoID: 

The maximum number of characters allowed is 129 

TxGOOSEX DataSet:

Select DataSet to be transmitted in this TxGOOSE. Only DataSets configured with 128 elements or less will be
displayed in this drop-box.

TxGOOSEX CONFREV:

It can be used to indicate GOOSE configuration revision

TxGOOSEX Enabled:

To enable/disable transmission GOOSE

TxGOOSEX DST MAC: 

The standard MAC address limit. 6 pairs of letters (from A to F, upper case or lower case) or numbers separated by
colons.

Make sure to configure the MAC with the least significant bit in the most significant byte, set to 1. Example: 01: 0C: CD:
00: 00: 04

TxGOOSEX VLAN PRIORITY:

A number from 0 to 7 can be configured. IEC 61850 recommends a default priority value of 4 for GOOSE. Ethernet
traffic that does not contain a priority tag has a default priority of 1. More details are specified in IEC 61850 part 8-1.
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TxGOOSEX VLAN ID:

The maximum number of characters allowed is 3. IEC61850 Configurator allows characters limited to 0 to 9, A to F and
it saves in the CID file the hexadecimal value (max FFF). 

TxGOOSEX ETYPE APPID:

All characters must be numerical. The maximum number of characters allowed is 4. IEC61850 Configurator allows
characters limited to 0 to 9, A to F and it saves in the CID file the hexadecimal value (max FFFF).

IEC 61850 recommends that the Ethertype Application ID number be configured according to the GOOSE source. In
the C650, the transmitted GOOSE Application ID number must match the configured receive Application ID number in
the receiver. A common number may be used for all GOOSE transmitters in a system. More details are specified in IEC
61850 part 8-1. 

TxGOOSEX MAX TIME:

Time allowed to live. The maximum time packet remains alive after transmission. It must be configured in ms

Mapping TxGOOSES

For transmission GOOSE you can create Data Sets with drag-and-drop selecting the desired data attributes in the data 
model tree and dragging them to the DataSet panel. Data Sets can be directly formed by attributes of all Logical Nodes. 
For example they can contains status of protection functions as: 

• PTOC1.ST.Op.phsA- "Time Overcurrent Function 1 Operate Phase A"

• PTUF2.ST.Str.general- "Underfrequency Function 2 Trip General"

• XCBR1.ST.Pos.stVal- "Circuit Breaker Position"

• etc.

There is also a dedicated logical node in C650 which can be used for mapping of internal signals to be transmitted via 
GOOSE. This logical node is rouGGIO1. It contains 32 digital indications with associated quality flags and timestamps. 
rouGGIO1 permits flexible mapping of any of relay's digital signals to outgoing GOOSE messages. This can be useful when 
transmission via GOOSE of internal signals that are not mapped to any IEC 61850 logical node in the C650 is required. An 
example of such signals are "Virtual Outputs" which are internal variables of C650 derived from PLC logic equations.

Mapping of signals to rouGGIO1 indications is performed in EnerVista 650 Setup software in menu Setpoint > Relay 
Configuration > Remote Outputs. rouGGIO1 indications are called Rem GOOSE Dig Out 1, Rem GOOSE Dig Out 2, etc. in 
this menu, and are listed after the DNA and UserSt bits.

 

Figure 7-26: Example of rouGGIO mapping in Dataset
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Figure 7-27: Example of rouGGIO mapping in Setpoint > Relay configuration

RxGOOSE

650 relays can subscribe to up to 24 different remote devices. A maximum of 32 Remote Inputs (digital signals), 32 Remote 
Goose Digital Inputs, and 16 Remote Goose Analog Inputs can be configured as subscriptions.

Mapping RxGOOSES

In order to configure reception of configurable GOOSE in a 650 relay, it is necessary to have the ICD/CID file of the sending 
IED. This means that the first transmission GOOSE must be configured in the sender, and then the ICD/CID file must be 
imported using the IEC 61850 Configurator tool in the EnerVista 650 Setup software.

To import a CID file from a remote IED:

1. In the IED list panel, select LGOS X, right-click and select Add IED to add a new IED for GOOSE reception. Up to 24 
different CIDs can be imported.

 

Figure 7-28: Import CID file
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2. A pop-up window allows selection of the CID file to import, with transmission GOOSES previously configured.

 

Figure 7-29: CID file selection

3. After selecting the CID file, all configured transmission GOOSES are imported and all GOOSE FCDAs are displayed as 
shown:

 

Figure 7-30: Imported CID file

4. If any imported transmission GOOSE needs to be deleted, updated, moved up/down or the header needs to be edited, 
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right-click on the imported GOOSE in the IED panel list 

Figure 7-31: Transmission GOOSE menu

If a new CID is imported and it contains a GOOSE ID that it is already present in the IED panel list, the following message 
displays and no transmission GOOSES from the imported CID are added to IED panel list.

Figure 7-32: Warning message: Same GOOSE ID detected

Up to 32 Remote Inputs and 32 Goose Digital Inputs can be configured in a reception goose (RXGOOSE). The configuration 
section shows a list with 64 different rows. The first 32 values are shown on the Remote Goose Digital Inputs screen and 
the remaining 32 values are on the Remote Inputs screen.

To configure RxGOOSE Boolean Inputs follow these steps:

1. Boolean signals can be dragged and dropped from an imported remote IED transmission GOOSE into the 
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Configuration section.

Figure 7-33: RXGOOSE Boolean Input

2. When a boolean signal is dragged and dropped into any IndX element, four columns show the following information:

– IED: IED name configured in imported CID

– GOOSE ID: Goose ID configured in imported CID

– SETTING: FCDA of boolean signal from imported CID that has been dragged and dropped into the configuration
area.

– DEFAULT STATE: Value that signal shows when status has not been updated from the remote device.

Removing Boolean inputs:

• To remove a configured boolean signal, right-click on it and select Remove Input.

Figure 7-34: RXGOOSE Boolean input - Remove Input
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To configure quality bits, follow these steps

1. Quality bits of Boolean signals can be dragged and dropped from an imported remote IED transmission GOOSE into 
the Configuration section. When a quality bit is dragged and dropped, a pop-up window opens to allow the selection 
of one of the thirteen quality bits available.

Figure 7-35: RXGOOSE Boolean input - Quality bit selection

2. Once a quality bit is selected, click OK, and the selected quality bit is shown in the Setting column of the Configuration 
area. 

Figure 7-36: RXGOOSE Boolean input - Selected quality bits shown
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To configure RxGOOSE Analog Inputs, follow these steps:

Up to 8 float analog inputs (AnInX.mag.f) and 8 integer analog inputs (AnInX.mag.i) can configured in RXGOOSE Analog 
Inputs, as shown:

Figure 7-37: RXGOOSE Analog Inputs

1. Add both float and Integer analog inputs by dragging and dropping values from the transmission GOOSES imported in 
the IED Panel list into AnInX.mag.X rows in the Configuration section.

2. When an analog signal is dragged and dropped into any element, three columns show the following information:

– IED: IED name configured in imported CID

– GOOSE ID: Goose ID configured in imported CID

– SETTING: FCDA of Analog signal from imported CID that it has been dragged and dropped into configuration
area.

If the analog signal being dragged and dropped has been previously added from the IED panel list, the following
warning message pops up: 

Figure 7-38: Warning message - Duplicate item

When all 8 Analog Inputs of one type (such as float) have been mapped, and an additional float analog value is
dragged a dropped into the Configuration area, an error message is shown

:

In order to replace an Analog Input, first remove the existing Analog Input.
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Removing Analog inputs:

• To remove a configured analog signal, right-click it and select Remove Input.

Figure 7-39: RXGOOSE Analog input- Removing inputs 

7.6.3.2  Configuration of setting groups

The Logical Nodes affected by the implementation of the setting groups are:

• For firmware version below 7.50: LLN0, PIOC, PTOC, PTOF, PTOV, PTUV, PTUF and RDIR.

• For firmware version 7.50 or above: LLN0, PIOC, PTOC, PTOF, PTOV, PTUV, PTUF, RDIR, PTTR, PFRC, PDIS, PDOP, PRTR

The definition of the Logical Node LLN0 is shown in 7.2.7.3.3 or 7.2.7.3.4. The rest of the mentioned Logical Nodes are 
affected in the way that the setting data contained in those Logical Nodes have as many values as setting groups are 
defined:

• For firmware version below 7.50: 3 setting group for F650 relay

• For firmware version 7.50 or above: 6 setting group for F650 relay

Each setting data contained in those Logical Nodes has a type derived from one of the following common data classes 
defined in the standard IEC 61850-7-3: ING, SPG, ASG and CURVE. The setting data attributes of these common data 
classes have functional constraints SG (setting group) and SE (setting group editable) when the setting group function is 
enabled and SP (setpoint) when it is not.

When the setting group function is enabled the F650 relay has the following instances of the Logical Nodes mentioned 
before:

PIOC

• Phase instantaneous overcurrent: SGphHiPIOC1 and SGphLoPIOC1*/ phHiPIOC1 and phLoPIOC1

• Neutral instantaneous overcurrent: SGndPIOC1*/ ndPIOC1

• Ground instantaneous overcurrent: SGgndPIOC1*/ gndPIOC1

• Sensitive ground instantaneous overcurrent: SGhsePIOC1*/ hsePIOC1

• Isolated ground instantaneous overcurrent: IsoGndPIOC**

• Broken conductor: BknCndPIOC** 
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PTOC

• Phase time overcurrent: SGphHiPTOC1 and SGphLoPTOC1*/ phHiPTOC1 and phLoPTOC1

• Neutral time overcurrent: SGndPTOC1*/ ndPTOC1

• Ground time overcurrent: SGgndPTOC1*/ gndPTOC1

• Sensitive ground time overcurrent: SGhsePTOC1*/ hsePTOC1

• Sensitive ground time overcurrent: hsePTOC**

• Negative sequence time overcurrent: NgSeqPTOC**

PTOF

• Overfrequency: SGPTOF1*/ PTOF1

PTOV

• Phase overvoltage: SGphsPTOV1*/ phsPTOV1

• Auxiliary overvoltage: SGauxPTOV1*/ auxPTOV1

• Neutral overvoltage: SGneuHiPTOV1 and SGneuLoPTOV1*/ neuHiPTOV1 and neuLoPTOV1

PTUV

• Phase undervoltage: SGphsPTUV1*/ phsPTUV1

• Auxiliary undervoltage: SGauxPTUV1*/ auxPTUV1

PTUF

• Underfrequency: SGPTUF1*/ PTUF1

RDIR

• Phase directional element: SGphsRDIR1*/ phsRDIR1

• Neutral directional element: SGndRDIR1*/ ndRDIR1

• Ground directional element: SGgndRDIR1*/ gndRDIR1

• Sensitive ground directional element: SGhseRDIR1*/ hseRDIR1

PDOP

• Forward overpower: FwdPDOP **

• Directional overpower: DirPDOP**

• Wattmeter ground overpower: WattPDOP**

PFRC

• Frequency rate of change: PFRC**

PDIS

• Load encroachment: LodEncPDIS**

PRTR

• Locked Rotor: LockedPRTR**

*These logical nodes model the corresponding protection function for setting groups in firmware version from 7.20 to 
below 7.50

**These functions have been included from firmware version 7.50.

If “Use Setting Group” is set to true for firmware version from 7.20 to below 7.50, the new instances of the Logical Nodes 
are accessible with the IEC 61850 Configurator as is shown in the following figure.
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Firmware versions from 7.20 to below 7.50

Firmware versions 7.50 and above

Figure 7-40: IEC 61850 Configurator
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The setting grouping permission can be enabled or disabled using the relay HMI or using menu path Setpoint > Control 
Elements > Setting Group in the EnerVista 650 Setup program as shown in the figure.

For versions below 7.50 it can be enabled or disabled in the IEC61850 Configurator by setting Use Setting Group to true or 
false.

Figure 7-41: Control elements - setting group

The next figure is a capture of an MMS browser where SGCB class attributes are shown and configured, setting ActSG with 
the value 1 that corresponds with the first setting group in the F650 relay and EditSG with the value 2 that corresponds 
with the second setting group.

Figure 7-42: MMS object explorer
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Firmware versions from 7.20 to below 7.50

The settings for the groups 1 and 2 of high level of Phase Time Overcurrent protection function are shown in the next 
figures.
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As it is shown in the figure, the values of the settings of the setting group indicated with the ActSg are the ones with the FC 
= SG in Logical Node SGphHiPTOC1, therefore the ones used by the high level of Phase Time Overcurrent protection 
function in the relay.

On the other hand, as it is shown in the figure, the values of the settings of the setting group indicated with the EditSg are 
the ones with the FC = SE in Logical Node SGphHiPTOC1.
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Firmware versions 7.50 and above

The settings for the high level Phase Time Overcurrent protection function (Phase TOC High 1, 2 and 3) on setting groups 1 
(ActSG) and 2 (EditSG) are shown in the next figures.
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As it is shown in the figure, the values of the settings of the setting group indicated with the ActSg are the ones with the FC 
= SG in Logical Nodes phPTOC1, phPTOC2 and phPTOC3. Therefore the ones used by the high level of Phase Time 
Overcurrent protection function in the relay.

On the other hand, as it is shown in the figure, the values of the settings of the setting group indicated with the EditSg are 
the ones with the FC = SE in Logical Nodes phPTOC1, phPTOC2 and phPTOC3.
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C650 Bay Controller & Monitoring System

Chapter 8:  Security

GE
Grid Solutions

SECURITY

8.1  Adding users

New users can only be added by users that have Administrator Access (or Admin Rights). The Enable Security check box 
located in the Security > User Management window must be enabled.

Remember: (In order to add new users and assign user rights ) 

• must be logged in with Administrator Permission 

• and Enable Security checkbox must be enabled   

8.1.1  User rights
NOTE: Only Administrators have access to the User Management dialog box.

The following is a list of all of the User Rights Options available to be granted to users, and their functions. 

Table 8-1: User rights and functions

By default, Administrator and Service users are created with "password" as default password.

RIGHT FUNCTION

Delete Entry If this box is checked when the Administrator exits the User Management dialog box, the program asks to 
confirm the delete before the selected user is permanently deleted from the list. 

Admin. WARNING: When this box is checked, the user becomes an EnerVista 650 Setup Administrator, receiving all 
Administrative rights.

Actual Values When this box is checked, the user is able to view Actual Values and all records excluding event recorder.

Settings When this box is checked, the user is able to view and modify Settings (Protection, control, inputs/outputs and 
calibration).

Commands When this box is checked, the user is able to use Commands.

Event Recorder When this box is checked, the user is able to use Event Recorder.

Force IO When this box is checked, the user is able to use Force IO application.

Logic Configuration When this box is checked, the user is able to view and modify  Relay Configuration and Logic Configuration. 

Upgrade When this box is checked, the user is able to upgrade firmware, bootware and to upload and download info 
files to/from relay. 
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8.2  Changing passwords
Users are prompted to change their password after the first successful log in or through clicking Security from the toolbar, 
and choose Change Password.

Figure 8-1: Change security

When the operator enters a new password for the first time, he/she should also enter a personal question that only they 
can answer. There is a limit of 50 characters available to enter the personal question. One example, as in the above 
diagram, would be "What is my mother's maiden name?". This question is posed to the user if the user forgets their 
password and would like to know what their password was.
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8.3  Enabling security
EnerVista 650 Setup Security Control is disabled by default. Users don't have to log in through user name and password 
after installation and are granted access as Administrator. 

Security Control can be enabled through Security from the tool bar when logged on as an Administrator. Click 
User Management: 

Figure 8-2: Enabling security

Security Control is enabled by checking the ENABLE SECURITY check box. The first time the enable security option is 
selected it is necessary to close and reopen the EnerVista 650 Setup software to start working under security 
management.
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8.4  Logging into EnerVista 650 Setup
Users have to log on in order to use EnerVista 650 Setup program after Security Control has been enabled. After the start 
up of EnerVista 650 Setup, a dialog prompts for user name and password. 

Figure 8-3: Login user

The user name field displays the last log in user name as default, in this example, TestUser. For the first log in session of any 
user name, the default password is "password". The user is prompt to change the password to something else after the 
first successfully log in. 

Log on can also be done by clicking Security from the toolbar and choose Login New User. The user is prompted with the 
same log in dialog box for a different user name and password combination. 

In case a user has forgotten their log in password, the Forgot Password function can be used to retrieve the password. 

Figure 8-4: Forgot your password?

A question, which is pre-set by the user, is asked. The password is retrieved for entering the right answer.
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C650 Bay Controller & Monitoring System

Chapter 9:  Bootcode and firmware upgrade

GE
Grid Solutions

BOOTCODE AND FIRMWARE UPGRADE

9.1  Firmware upgrade versions below 7.00.

This section explains how to upgrade the C650 boot code and firmware for version below 7.00. 

The boot code and firmware versions can be seen in the relay main screen: The relay firmware version appears after the 
text “C650“(5.70 in Figure 9-1: Main screen) with the boot program version (6.00 in Figure 9-1: Main screen) followed by 
“GENERAL ELECTRIC”, the relay model and the default front RS232/USB port communication parameters. 

Figure 9-1: Main screen

BEFORE PERFORMING THE UPGRADE PROCEDURE CHECK THAT BOOT AND FIRMWARE VERSION 
MATCH.

C650 7.00 (7.00)
General Electric

C650MZKF2G1HI6E
19200N81: MODBUS: 254
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BOOT CODE RELEASE NOTES

It is mandatory to maintain version compatibility between firmware and boot code in the upgrade procedure, otherwise 
the relay does not start after upgrading.

FIRMWARE BOOTWARE AND 650 PC PROGRAM VERSIONS COMPATIBILITY

FIRMWARE CODE BOOT CODE ENERVISTA 650 PC

5.72 6.00 7.20

5.70 6.00 7.20

5.68 6.00 7.20

5.64 5.60 7.20

5.40 5.44-5.40 7.20

5.00 5.44-5.40 7.20

4.00 5.44-5.40-5.00-4.10 7.20

3.71 5.44-5.40-5.00-4.10 7.20

3.70 5.44-5.40-5.00-4.10 7.20

2.20 5.40-5.00, 4.10, 4.00 7.20

A STEP LIST SUMMARY that allows the user to control the upgrading process is included at the end of this section. It is 
necessary to read paragraphs 1 to 4 of chapter 9 of manual GEK-106310 before accomplishing the C650 UPGRADE 
PROCEDURE.

Be aware that boot program and firmware upgrades erase all data contained in the relay, thus it is advisable to save all 
data, oscillography, events, settings and configuration files before proceeding.

RELAYS WITH FIBER OPTIC ETHERNET

The upgrade of the boot program (BOOTCODE) must be performed by crossed Ethernet copper cable connected to the

PC. It is not necessary to change the internal switch from fiber to RJ45, because the upgrade is made at 10Mb/s.

This does not apply to the firmware upgrade, which can be done either via Ethernet Fiber connection, or through the

RJ45 cable connection.

For upgrading firmware versions lower than 3.20 or upgrading bootware, be aware to calibrate the unit offset, after 
upgrading it, in Communication > Calibration > Offset Calibration. No analog currents nor analog voltages must be 
injected in the unit during this process.



CHAPTER 9:  BOOTCODE AND FIRMWARE UPGRADE 9.1 FIRMWARE UPGRADE VERSIONS BELOW 7.00.

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 9-3

9.1.1  Communication parameters
1. Ethernet Connection/Type - Both boot code and firmware upgrade processes require Ethernet communications. It is 

strongly recommended to use a direct connection between the PC and the relay using a Cross-Over RJ45 Ethernet 
cable, instead a direct connection through a hub or switch. Upgrading through Local Area Network (LAN) must be 
avoided.

Serial RS232 Communication - Serial communication is necessary only to perform the bootware upgrade for versions
previous to 7.00.

2. Relay IP Address - An IP address must be assigned to the relay in the Ethernet parameters via HMI at Product Setup > 
Communication > Ethernet > Ethernet1 menu, or via EnerVista 650 Setup software at Setpoint > Product Setup > 
Communication Settings > Network (Ethernet) 1 as shown in the table below:

Table 9-1: Ethernet parameters

3. PC IP Address - In case the boot code has been previously updated to the relay (section 9.2), the IP address and other 
parameters already assigned in the process are:

IP Address:192.168.37.177

Netmask:255.255.255.0

Gateway:192.168.37.10

Then the PC settings should be the same pattern as follows:

IP Address:192.168.37.xxx

Netmask:255.255.255.0

Gateway:192.168.37.10 (if desired)

Where XXX is a number between 0 and 255 that is not assigned to any other device to avoid collisions.

4. Other Network, Communications and Data Flow checks 

• According to the model number of the relay, to enable the 10/100 BASE TX-CABLE option in the relay communication
board, a specific jumper in this board must be changed. See detailed instructions in paragraph 3.4.3 of Instruction
Manual GEK-106310AE.

• IP address, netmask, gateway are correct and match the parameters used in the computer to perform the procedure.
See table 9.1 (on this chapter) of Manual GEK-106310AE COMMUNICATION PARAMETERS.

Product Setup > Communication Settings > Network (Ethernet) 1

Name Value Units Range

IP Address Oct1 192 [0 : 255]

IP Address Oct2 168 [0 : 255]

IP Address Oct3 37 [0 : 255]

IP Address Oct4 177 [0 : 255]

Netmask Oct1 255 [0 : 255]

Netmask Oct2 255 [0 : 255]

Netmask Oct3 255 [0 : 255]

Netmask Oct4 0 [0 : 255]

Gateway IP Oct1 192 [0 : 255]

Gateway IP Oct2 168 [0 : 255]

Gateway IP Oct3 37 [0 : 255]

Gateway IP Oct4 10 [0 : 255]
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9.1.2  Bootware version upgrade

Boot code upgrade is performed using EnerVista 650 Setup, and the most recent version of EnerVista 650 setup software 
should be used. It is required that no active communication is currently established between the program and the relay, 
and that no configuration files are open.

During the boot code upgrading process, all the data stored in the relay is lost. Save all calibration, settings, oscillography, 
etc. from the relay before starting the upgrade.

9.1.2.1  Bootware upgrade

1. Windows XP, Windows 7 and Windows 8 Operating Systems must be used for installation and the reliable operation of 
EnerVista 650 Setup program and bootware/firmware relay upgrade.

2. To upgrade the boot code, it is required to connect an RS232 cable to the front of the relay, and an Ethernet cable to 
the rear port (ETH_1/ETH_2 or ETH_E/ETH_A/ETH_B).

3. If it is being used a USB-to-Serial RS232 Cable Converter, it must be a RS-232C standard compliant, powered by the 
User computer's USB bus and with DB9 male connector. To ensure the correct state of communication between the 
computer and the relay along the whole upgrading process, all other USB devices must be unplugged. Due to the 
extended variety of USB-to-Serial Cable Converters existing nowadays in the market, with different characteristics, 
even different charge imposed to the USB bus of the PC, it is strongly recommended to use the GE USB-to-Serial RS232 
Cable Converter, part number GE0100-0001.

4. When using USB-to-Serial RS232 cable it is necessary first to determine the COM Port number the Laptop uses 
through the USB device. Depending in the actual C650 upgrade task under operation, the procedure is as follows:

4.1 Firmware upgrade: It is not necessary to use a serial cable

4.2 Bootware and firmware upgrade being the relay fully operative with the actual F/W version: The COM port number
must be determined by using the 650 Setup program. With USB device disconnected from the Laptop and from the
relay, start the 650 Setup program. At the top menu bar choose Communication > Computer > Communication Port
menu and check the allowable serial ports displayed.Return to the main 650 Setup screen and connect the USB device
to PC and select Communication > Computer > Communication Port to display the allowed serial ports. The new one
port number shown is the USB port number to be used for the upgrade process.

4.3 Bootware and firmware upgrade being the relay blocked at startup (no preliminary communication PC-Relay
allowable): Repeat the process described above in 4.2 to determine the COM PORT number and continue with upgrade
process.

5. Once the COM PORT number is determined, set it in Communication > Computer together with and the Baud Rate 
and Parity parameters. Click Store.

6. Start the EnerVista 650 Setup program and select Communication > Upgrade Relay.

 

Figure 9-1: Upgrade device
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7. Select Device Boot Upgrade. FW version<7.00 and click the […] button. The next new window requires the bootware 
file retrieved from http://www.gegridsolutions.com/index.htm and previously stored in the PC.

 

Figure 9-2: Boot code file selection

8. Choose the bootware file and click Open button:

  

Figure 9-3: Upgrade selected BOOT file

9. Click Upgrade. A warning messages is shown:

 

If calibration files were saved click Yes, otherwise click No to cancel the upgrade process and save first the calibration files 
according to section 4.1.11.
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Figure 9-4: Warning message to save setting and configuration files

10. Parameters already set in step 5 are operative during serial communications. If they have not been previously set a 
pop up window prompts for the serial COM port to be used during upgrading.

11. During the upgrade, the system shows the following message indicating the procedure to be followed.

The serial and ethernet warning message is a generic message, the serial connection for C650 models is through a
USB-serial cable. RS232 is used in other 650 devices.

If you click Yes, the next window allows you to choose the Network adapter for your Ethernet connection to the relay.
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12. After selecting the Network adapter, a window to choose a temporary IP address is shown. It is advisable to set the 
same IP address that is going to be used later in the relay for Ethernet connection.

Figure 9-5: setting address

13. After entering the temporary IP Address, the next new window requires the bootware file retrieved from 
http://www.gegridsolutions.com/index.htm and previously stored someplace in the PC. 
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Figure 9-6:  Boot code file selection

14. Choose the bootware file and click Open button.

Figure 9-7: Loading boot code file

15. Then the program shows a message requiring switch OFF and ON the relay while the progress bar is in course, to start 
the upgrading process.

Figure 9-8: Relay switch off-on message
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16. It is important to switch the Relay OFF and ON again during the time shown by the progress bar; in case this time 
expires, the program offers the option to continue with the process or to postpone, verify the correct RS232 
connections and try again later. Notice that the serial COM PORT used in the boot upgrade procedure is the one 
selected in step 4 above.

Figure 9-9: loading update file error message 

If the relay gets stuck during the upgrading process after switching OFF and ON the relay, giving error message shown, it is 
due to no serial communication via the front RS232 port. Check the serial cable and serial settings connection. At this point 
the relay will not be upgraded. 

After switching it OFF and ON it will continue working with the former firmware and bootware versions.

17. After switching the relay OFF and ON, if the serial communication between EnerVista 650 Setup and the relay is 
correct the program shows the following message:

Then it requires the confirmation to proceed to upgrade:
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18. Click Yes to start the process, beginning with the relay flash memory deletion.

At this point all the information stored in the relay is lost. Until now, no important change has been made to the relay,
the boot memory upgrading process has just been prepared. 

This process can take several minutes, during which a progress bar is displayed.

19. If the process is successful, continue to step 20.

If the process is unsuccessful and the relay gets stuck at “Sending file imagen_kernel…” (see figure below) 

This error may be due to no communication via the Ethernet port. At this point serial communications work properly,
the relay flash memory has been erased, and the upgrade procedure must be completed to start working with the
unit. If the procedure is not completed, the HMI shows the message "OS Loading..." and the relay does not start up. 

In this case refer to step 4 above

If all points from step 4 are correct but the problem persists: 

Disable and Enable the Ethernet connection while the files are being sent (during the “Sending file...” message -
previous figure). To do this, in Windows OS go to Startup > Control Panel > Network Connection > Local Network,
right-click and select Disable. Now the Local Network status Icon is shown as Disabled. In the same screen, right-click
Local Network, select Enable, and wait until Enabled status is shown.

20. Once the memory has been erased and the files upgraded in the relay, the parameters for the Ethernet 
communications must be set. The requested values are the IP address and the gateway. 
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Figure 9-10: IP address setpoint window

These values should match the LAN structure where the relay will be connected.

 The relay IP address should have the first three octets corresponding with the gateway and the last octet must be a
free IP address reserved to the relay to avoid possible collisions with other devices.

 The gateway must be the one used in the LAN structure connecting the relay

21. After assigning the Ethernet parameters, the upgrade of the boot code is complete and successful.

22. A window is displayed with the message: Setting Default IP address, followed by:

Figure 9-11: BOOTware upgrade successful process

After boot code upgrade, the equipment firmware must also be upgraded.
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9.1.3  Firmware version upgrade 

9.1.3.1  Introduction

1. Save relay settings and configuration to a file before proceeding, as they will be lost during upgrade.

2. Save calibration settings to a file for firmware revisions lower than 1.50, before upgrading the C650 to a new firmware 
version.

3. For firmware revision higher than 1.50 when only upgrading the firmware (no bootware upgrade), the calibration files 
are not modified and do not need to be saved.

4. Special care should be taken when the boot code has been previously upgraded: all data (including calibration 
settings) is lost.

5. In case of errors during the firmware upgrade process, repeat the entire process as many times as necessary. This is 
possible thanks to an independent boot memory (bootcode).

6. A pure firmware upgrade process should use the EnerVista 650 Setup software and Ethernet connection (Port ETH_1 
or ETH2) via a Cross-Over RJ45 Ethernet cable.

Note: Downgrading firmware versions can cause errors in measurements.

9.1.3.2  Firmware upgrade

1. Once communication with the relay through the Ethernet connection has been verified, enter the EnerVista 650 Setup 
program and select Communication > Upgrade Relay.

Figure 9-1: Upgrade device

2. Select Device FW Upgrade FW version <7.00 and click [...]. to browse for the new firmware file.



CHAPTER 9:  BOOTCODE AND FIRMWARE UPGRADE 9.1 FIRMWARE UPGRADE VERSIONS BELOW 7.00.

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM 9-13

Figure 9-2: Select firmware file

3. Once the new firmware file has been selected, click Upgrade to continue.

Figure 9-3: Upgrade firmware selected file

4. Fill in the device IP address, serial number, and order code as needed. (The order code is not required for firmware 
versions below 1.70).
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Figure 9-4: Relay serial number

5. If the relay is not an enhanced model or one with control functionality, click Upgrade Firmware to continue the 
process (see the following figure).

At this point, proceeding with the upgrade erases all data stored in the equipment, including the calibration settings in
firmware versions below 1.50. It is necessary to save all settings to a file now if you have not already done so.

The Firmware-boot version compatibility warning message is a generic message, 

For C650 models the first firmware version is 3.42 with boot 4.10
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Click Yes to continue. A message is displayed indicating that a local network reboot is necessary (see following figure).
Proceed as follows:

• In the Windows Control Panel (Start > Control Panel), navigate to Network Connection > Local Network. Right-click
and select Disable. Confirm that the Local Network status is now Disabled. Restart the local network in the same
screen (right-click and select Enable). Wait until the local network status is Enabled before continuing.

• Click Upgrade Firmware to continue the process (as shown).
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Figure 9-5: Advisory for local network reboot

6. When upgrading models with Enhanced protection or control functionality (see model selection), the upgrade 
program requires a password to continue (as shown).

Figure 9-6: Relay upgrade password
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For a model with specialized functionality and a password requirement, contact GE Multilin.

The following parameters must be clearly indicated in the order:

• Unit serial number

• Current model option (before memory upgrade)

• Desired model option (after memory upgrade)

• Unit MAC address (available in the identification label)

7. Once the upgrade parameters have been entered, click OK. When communication has been established, the program 
shows a message requesting a reboot of the 650 (turn the relay off and then back on) to continue with the upgrade 
process.

8. Once the relay has been rebooted, you are prompted to select the new firmware upgrade file (update.txt).

The upgrade files, including update.txt, can be obtained online (http://www.gegridsolutions.com/index.htm) or from
the Technical Service Dept. at any GE Multilin facility. Save the files in a directory in the root drive or the PC desktop.
Extract any zipped files.

Browse to the "update.txt" file and click Open.
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Figure 9-7: Firmware file selection

9. A voltage range selection window appears (see following figure). This voltage range is closely related to the serial 
number of the relay. For relays manufactured with firmware version 5.70 or higher (from May 2015 onwards), the 
EnerVista 650 Setup program automatically selects the appropriate voltage range for the unit based on the serial 
number, showing the selection with a step line square over the proper option. Click OK. 

In case an incorrect option is selected, metering errors may arise during normal operation (current and voltage values 
incorrectly displayed). In order to correct this behavior, the firmware upgrade process must be repeated and the 
correct option must be selected. 

Figure 9-8: AC voltage range selection - extended V range (version 2)

10. Click Yes.

11. The Upgrade Firmware button is now enabled (figure below). Click to start the upgrade.
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Figure 9-9: Initiate upgrade

During the upgrade process, the program displays the files that are being upgraded. 

Figure 9-10: Firmware file selection
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12. When the file transfer is finished, a message is displayed indicating that it is necessary to wait before resetting the 
unit, in order to start working with the new firmware version in the relay (figure below). 

13. When the whole process has finished a message is displayed asking to switch the C650 on and off (figure below).

Figure 9-11: Firmware file selection

14. Click OK (Aceptar). At this point, the firmware upgrade is finished and the relay can be powered OFF and ON to check 
that the firmware has been upgraded properly. 

15. User settings and logic files downloading

When upgrading the firmware the entire settings and relay configuration are reset to factory default values. Then the 
User is committed to download the settings, configuration and logic files to the relay in order to get it fully operative. 

Calibration settings and configuration must be reloaded to the relay the relay.

To recover and download the different files to the relay go to EnerVista 650 Setup and at the top menu bar choose:

• Communication > Calibration > Set Calibration Files: to restore calibration settings, if necessary.

• File > Config File (*.650) Converter: to convert the setting and configuration file *.650 for the relay (if it was in a
previous version format).

• File > Send Info to Relay: to send the new settings and configuration file to the unit.
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9.1.4  Summary of main steps

9.1.4.1  Boot code upgrade (*)

1. Install the proper version of the EnerVista 650 Setup software.

2. Connect a USB-SERIAL cable to the front port relay and connect an Ethernet cable to the rear Ethernet port (crossover 
cable for back-to-back connection or straight-through Ethernet cable for hub or switch).

3. Save all calibration settings to a file.

4. Save all data from the relay (settings, oscillography, events).

5. In the EnerVista 650 Setup software, select Communication > Upgrade Relay.

6. Follow the upgrade instructions, and select the boot program bin file.

7. Reboot the relay as required by the upgrade program.

8. Continue with the upgrade instructions, setting the IP address and gateway when prompted.

9.1.4.2  Firmware upgrade(*)

1. Install the proper version of the EnerVista 650 Setup software.

2. Connect an Ethernet cable to the rear Ethernet port (a cross-over cable for back-to-back connection and straight-
through cable for hub or switch).

3. Set the appropriate IP address in the relay.

4. Set the appropriate IP address in the PC.

5. In the EnerVista 650 Setup software, select Communication > Upgrade Relay.

6. Enter the IP address, serial number, ad order code of the relay as prompted.

7. Reboot the relay as required by the upgrade program.

8. Locate the upgrade.txt file for the correct relay model.

9. Click Upgrade Firmware to initiate the upgrade process.

10. Reboot the relay as required by the upgrade program to complete the upgrade process.

11. Set calibration settings (from the PC to the relay) for versions lower than 1.50.

12. All settinga and configuration are now set to the factory default.

13. Send new settings and configuration files to the relay if needed.

 (*) The boot code upgrade must be performed using a crossed copper cable (RJ45) connected to the PC. It is not necessary 
to modify the internal fiber/cable switch, as the upgrade is carried out at 10 Mb/s, and thus there is no cable/fiber 
conflict.This does not apply to the firmware upgrade, which can be performed either with the Ethernet fiber connection, or 
with the cable connection.

Note: See chapter 13 C650 TROUBLESHOOTING GUIDE if there is any problem during the upgrade process.
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9.2  Firmware upgrade version 7.00 or above

This section explains how to upgrade the C650 firmware code for version V7.00 or higher.

BOOT CODE RELEASE NOTES

It is mandatory to maintain version compatibility between firmware and boot code in the upgrade procedure, otherwise 
the relay will not start after upgrading.

BEFORE PERFORMING THE UPGRADE PROCEDURE CHECK THAT BOOT AND FIRMWARE VERSION MATCH.

9.2.1  Communication parameters
1. Ethernet Connection/Type - Firmware upgrade processes require Ethernet communications. It is strongly recommended 
to use a direct connection between the PC and the relay using a Cross-Over RJ45 Ethernet cable, instead a direct 
connection through a hub or switch. 

2. Relay IP Address - The relay must be assigned a IP address in the Ethernet parameters, via HMI at Product Setup > 
Communication > Ethernet > Ethernet E, A or B menu or via the Enervista 650 Setup software at Setpoint > Product 
Setup > Communication Settings > Network (Ethernet) E, A or B as shown in the Table below.

Table 9-2: Ethernet parameters

Firmware Bootware EnerVista

7.12 7.12 Latest EnerVista version available

7.20 7.12 Latest EnerVista version available

7.21 7.12 Latest EnerVista version available

7.50 7.12 Latest EnerVista version available

7.52 7.12 Latest EnerVista version available

7.60 7.60 Latest EnerVista version available

7.70 7.70 Latest EnerVista version available

7.71 7.71 Latest EnerVista version available

PRODUCT SETUP > COMMUNICATION SETTINGS > NETWORK (ETHERNET) 

NAME EVALUE UNITS RANGE

IP Address Oct1 192 [0 : 255]

IP Address Oct2 168 [0 : 255]

IP Address Oct3 37 [0 : 255]

IP Address Oct4 177 [0 : 255]

Netmask Oct1 255 [0 : 255]

Netmask Oct2 255 [0 : 255]

Netmask Oct3 255 [0 : 255]

Netmask Oct4 0 [0 : 255]

PRODUCT SETUP > COMMUNICATION SETTINGS > ROUTING 

NAME EVALUE UNITS RANGE

Default RT GWY Oct1 192 [0 : 255]

Default RT GWY Oct2 168 [0 : 255]

Default RT GWY Oct3 37 [0 : 255]

Default RT GWY Oct4 10 [0 : 255]
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3. Example of IP Address Configuration:

The IP address and other parameters already assigned in the process are:
IP Address:192.168.37.177
Netmask:255.255.255.0
Gateway:192.168.37.10

Note: To assure that the configuration is correctly setup it is possible to perform a ping command from the PC.

Then the PC settings should be the same pattern as follows:

IP Address:192.168.37.xxx

Netmask:255.255.255.0

Gateway:192.168.37.10 (if desired)

Where XXX is a number between 0 and 255 that is not assigned to any other device to avoid collisions.

9.2.2  Firmware version upgrade

9.2.2.1  Introduction

1. The relay settings and configuration will be lost, so it is advisable to save them to a file.

2. In case of error during the firmware upgrading process, the user can repeat the whole process as many times as 
necessary.

3. Firmware upgrading process should be done using the EnerVista 650 Setup software and Ethernet connection (Port 
ETH_E, A or B) via Cross-Over RJ45 Ethernet cable or Fiber Optic cable (depending on order code option).
Note that ETH_A and ETH_B ports cannot be used if PRP configuration is selected.
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9.2.2.2  Firmware upgrade

1. Once the communication with the relay through Ethernet connection has been verified, enter the EnerVista 650 Setup 
program, select Communication and the Upgrade Relay option on the top menu bar.

2. Select Device Upgrade FW&Boot>=7.00 and click […] to browse for the file. The appropriate *.SFD file should be 
obtained from, http://www.gegridsolutions.com/index.htm or from The Technical Service Dept. at any GE Multilin 
facility. The file must be saved in the root drive or in the desktop of the PC. Choose the corresponding firmware file for 
upgrading the device.

3. Enter communication parameters for the relay being upgraded and click Upgrade.

Figure 9-1:  Relay communication parameters
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If the IP address is incorrect one, the following message is shown:

4. If the IP address is correctly set, then the message "*.SFD Sending file" is displayed. A sending file status bar shows the 
progress of the upgrade.

5. If the file is not sent successfully, the following message box is displayed.
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6. After sending the file successfully, the upgrade process starts:

7. When the flashing upgrade process finishes, a message is displayed requesting a relay reboot.

8. User settings and logic files downloading

When upgrading the firmware the entire settings and relay configuration are reset to factory default values. Then the User 
is committed to download the settings, configuration and logic files to the relay in order to get it fully operative.

Calibration settings and configuration must be loaded to the relay once the upgrade process has finished.

To recover and download the different files to the relay use Enervista 650 Setup and at the top menu bar choose:

• Communication > Calibration > Set Calibration Files: to restore in the relay the calibration settings if necessary.

• File > Config File (*.650) Converter: to convert the setting and configuration file *.650 for the relay (if it was in a
previous version format).

• File > Send Info to Relay: to send the new settings and configuration file to the unit.

9.2.2.3  Order code upgrade process

In the case of a relay model with specialized functionality (or a new order code requirement) with password requirement 
(see model selection), the program requests a password to continue. 
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1. To reach the window where the password is requested, the user must be communicating with the relay (ONLINE 
MODE). On the File menu the following submenu is available (for firmware versions above 7.00):

Figure 9-1: Order code submenu

2. Click Order Code on the menu and the following window is displayed:

Figure 9-2: Set order code

3. This window only allows changing the last digit, which refers to supported communications protocols options. Click 
Send:
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Figure 9-3: Password requirement (special models)

4. The users must contact GE Multilin and provide the following parameters in their order:

–  Unit serial number

–  Current model option (before memory upgrade)

–  Desired model option (after memory upgrade)

–  Unit MAC address (available in the identification label)
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5. Once the password is obtained, enter it when prompted.Tthe following messages appear if the password is correct.:

Figure 9-4: Executed successfully

6. After the successful operation, the SEND button is disabled. It is not allowed to make another change from here, so it 
can be seen what changes have been made. The new order code appears on the status bar.

Figure 9-5: New order code
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9.2.3  Summary of main firmware upgrade steps
1. Install the proper version of the EnerVista 650 Setup software.

2. Connect an Ethernet cable to the rear Ethernet port (a cross-over cable for back-to-back connection and straight-
through cable for hub or switch).

3. Set the appropriate IP address in the relay.

4. Set the appropriate IP address in the PC.

5. In the EnerVista 650 Setup software, select Communication > Upgrade Relay.

6. Select the appropriate file (DCL000CAXXX.SDF) for the upgrade.

7. Enter the IP address, serial number, and unit identifier of the relay as prompted.

8. Click Upgrade File to initiate the upgrade process.

9. Reboot the relay as required by the upgrade program to complete the upgrade process.

10. All setting and configuration are now set to the factory default.

11. Send new settings and configuration files to the relay if needed.

See chapter 13 C650 trouble shooting guide, if there is any problem during the upgrading 
process.
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C650 Bay Controller & Monitoring System

Chapter 10:  Commissioning

GE
Grid Solutions

COMMISSIONING

10.1  Visual inspection

Verify that the relay has not suffered any damage during transportation, and that all screws are correctly fixed, and all 
relay terminal boards are in good condition.

Verify that the information shown on the relay front plate corresponds to the data shown on the display, and to the 
requested relay model.

Display information:

Firmware version 

Kernel version 
F X.XX(K.KK)
GENERAL ELECTRIC
C650XXXXXXXXX
19200N81 MODBUS:254

Model
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10.2  Out of service setting

The Relay Out Of Service setting is configured in Setpoint > System Setup > Miscellaneous. The unit also has an Out of 
Service status that is configured in Relay configuration > Protection elements. When active, these states stop all 
changes to PLC equations and functions, including changes to the input/output boards, so if there is a change in any input 
or output the unit will not show this change until it has returned to ready mode. For example if an output is closed and the 
unit goes to the Out of Service state, the output is kept closed even if the state that closed it changes and would otherwise 
open the output. When the unit goes out of the Out of Service state, the output is then opened.

When the Out of Service status goes to ON, or the setting has been changed to Enabled, the ready LED also changes to 
red. Be careful if ready LED is linked to an output, because the output will not change its state. To set outputs to ready state 
see factory default Logic & Configuration in the detailed manual. Take notice that, in the default configuration, the general 
setting out of service is enabled, so it is necessary to change to disabled to start working with the unit

The following figure shows the flow chart of these states
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10.3  General considerations, power supply network
All devices running on AC current are affected by frequency. As a non-sine wave is the result of a fundamental wave plus a 
series of harmonics from this fundamental wave, we can infer that devices running on AC current are influenced by the 
applied waveform.

For a correct testing of relays running on AC current, it is fundamental to use a current and/or voltage senoidal waveform. 
The pureness of a senoidal wave (lack of harmonics) cannot be expressed specifically for a specific relay. However, any 
relay incorporating sintonized circuits, R-L and R-C circuits, is affected by non-senoidal waveforms, as in the case of C650. 

These relays respond to the voltage waveform in a different way to the majority of AC current voltmeters. If the power 
supply network used for the testing contains wide harmonics, the voltmeter and relay responses are different.

Relays have been calibrated in factory using a Network of 50 or 60 Hz with a minimum harmonic content. When the relay 
is tested, a power supply network with no harmonics in its waveform must be used.

The ammeters and chronometers used for testing the pickup current and relay operation time must be calibrated and their 
accuracy must be better than the relay’s. The power supply used in the tests must remain stable, mainly in the levels near 
the operation thresholds.

It is important to point out that the accuracy with which the test is performed depends on the network and on the 
instruments used. Functional tests performed with unsuitable power supply network and instruments are useful to check 
that the relay operates properly and therefore its operating characteristics are verified in an approximate manner. 
However, if the relay would be calibrated in these conditions, its operational characteristics would be outside the tolerance 
range values.

The following sections detail the list of tests for verifying the complete relay functionality.
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10.4  Isolation tests
During all tests, the screw located on the rear of the relay must be grounded.

For verifying isolation, independent groups are created, and voltage is applied as follows: 

2200 RMS volts will be applied progressively among all terminals in a group, short-circuited between them and the
case, during one second.

2200 RMS volts will be applied progressively between groups, during one second.

WARNING: No communication circuit shall be tested for isolation.

Groups to be created depend on the type of modules included in C650, selectable according to the model.

The following table shows the different groups depending on the module type:

SOURCE 1:
G1: H10, H18

G2: H13, H14, H15

SOURCE 2:
G1: H1, H9

G2: H4, H5, H6

MAGNETIC MODULE.
G1: A5..A12

G2: B1..B12

I/O F1 (MIXED)

G1 (Inp. 1): F1..9

G2 (Inp. 2): F10..18

G3 (Out.): F19..36

I/O F2 (SUPERVISION)

G1 (Spv 1): F1..4

G2 (Inp. 1): F5..9

G3 (Inp. 2): F10..14

G4 (Spv 2): F15..18

G5 (Out.): F19..30

G6 (Out.): F31.36

I/O G1 (MIXED)

G1 (Inp. 1): G1..9

G2 (Inp. 2): G10..18

G3 (Out.): G19..36

I/O G4 (32DI)

G1 (Inp. 1): G1..9

G2 (Inp. 2): G10..18

G3 (Inp. 3): G19..28

G4 (Inp. 3): G29..36

I/O G5 (analog)
G1 (Inp. 1): G1..9

G2 (Inp. 2): G10..18
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10.5  Indicators
Feed the relay and verify that when commanding a LED reset operation, all LED indicators light up and they are turned off 
when pressing the ESC key for more than 3 seconds.

10.6  Power supply testing

Feed the relay with the minimum and maximum voltage. For each voltage value, verify that the alarm relay is activated 
when there is voltage, and it is deactivated when there is no feed. If the power supply source incorporates AC feed, this test 
is also performed for VAC.

If the relay incorporates a redundant power supply, these tests shall be performed on both power supplies.

Voltage values to be applied are the ones indicated below according to the relay model:

NOTE: Codes HIR and LOR correspond to a redundant power supply

10.7  Communications

Verify that available communication ports allow communication with the relay.

Ports to be checked are as follows:

Front: USB-SERIAL

Rear:2 x RS485, 2 x Fiber Optic - Serial, 2 x Fiber Optic - Ethernet, 2 x RJ45 - Ethernet, 1 x RS485, 1 x CAN port.

A computer with EnerVista 650 Setup software and an appropriate connector must be used.

SUPPLY V min. V max.

HI/HIR
110-250 Vdc
120-230 Vac

88 Vdc
96 Vac

300 Vdc
250 Vac

LO/LOR
24-48 Vdc 19.2 Vdc 57.6 Vdc
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10.8  Verification of measurement
Set the relay as follows

NOTE:

ALL ANGLES INDICATED ARE LAGGING ANGLES 

ALL VALUES OBTAINED IN THIS TEST MUST BE THE ONES CORRESPONDING TO THE PHASOR ONES

10.8.1  Voltages
Apply the following voltage and frequency values to the relay:

Verify that the relay measures the values with an error of ±1 % of the applied value from 10V to 208V.

10.8.2  Active, reactive power, and COSJ metering
Equations to be applied for powers in a wye connection are as follows:

Apply the following current and voltage values:

GENERAL SETTINGS

NAME VALUE UNITS RANGE

PHASE CT RATIO 1.0 0.1 1.0-6000.0

GROUND CT RATIO 1.0 0.1 1.0-6000.0

STV GROUND CT RATIO 1.0 0.1 1.0-6000.0

PHASE VT RATIO 1.0 0.1 1.0-6000.0

PHASE VT CONNECTION WYE N/A WYE – DELTA

NOMINAL VOLTAGE 100 V 0.1 1-2250 V

NOMINAL FREQUENCY 50 Hz 1 Hz 50-60 Hz

PHASE ROTATION ABC N/A ABC – ACB

FREQUENCY REFERENCE VI N/A VI-VII-VIII

AUXILIARY VOLTAGE VX N/A VX – VN

CHANNEL ANGLE FREQUENCY

50 Hz 60 Hz 50 Hz 60 Hz 50 Hz 60 Hz

VI 0º 0 5 50 100 150 200

VII 120º 0 5 50 100 150 200

VIII 240º 0 5 50 100 150 200

VX 0º 0 5 50 100 150 200

Power per phase Three-phase power

P=V*I*Cosϕ P=Pa+Pb+Pc

Q=V*I*Senϕ Q=Qa+Qb+Qc

APPLIED VOLTAGE AND CURRENT VALUES PER PHASE

Phase a Phase b Phase c V-I Angles

VI = 50 V, 0º VII = 50 V , 120º VIII = 50V, 240º ϕ=45º

Ia = 10∠45º Ib= 10∠165º Ic = 10∠285º Cosϕ= 0.707
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With the indicated voltage and current values, verify that the power measure corresponds to expected values indicated in 
the following table:

Maximum admissible error is ± 1% of the test value for P and Q, and 0.02 for cosj.

10.8.3  Frequency
Frequency measure on channel VII (terminals A7-A8):

Apply 50 Vac at 50 Hz on channel VII. Maximum admissible error:± 10 mHz.

Apply 50 Vac at 60 Hz on channel VII. Maximum admissible error: ± 12 mHz.

Frequency measure on channel Vx (terminals A11-A12):

Apply 50 Vac at 50 Hz on channel Vx. Maximum admissible error:± 10 mHz.

Apply 50 Vac at 60 Hz on channel Vx. Maximum admissible error: ± 12 mHz.

Results:

10.9  Inputs and outputs
During all tests, the screw on the rear of the relay must be grounded.

10.9.1  Digital inputs
During this test, the user determines the activation/deactivation points for every input in the relay for the set voltage value 
of 30 Volts.

Verify that the error does not exceed ± 10% (+10% on activation, -10% on deactivation) or 5 volts, whichever is greater.

Default board settings for the input test can be modified in EnerVista 650 Setup software in:

Setpoint > Inputs/Outputs > Contact I/O > Board X

X, is substituted by the corresponding board:

F for board in first slot

G for board in second slot

H for board in first slot of CIO module

J for board in second slot of CIO module

EXPECTED POWER VALUES

Phase a Phase b Phase c Three-phase

Pa = 353.55 W Pb = 353.55 W Pc = 353.55 W P = 1060.66 W

Qa = 353.55 VAr Qb = 353.55 VAr Qc = 353.55 VAr Q = 1060.66 VAr

CHANNEL Voltage (V) Set Frequency (Hz) Measured Frequency (Hz)

VII 50 50 Hz

60 Hz

VX 50 50 Hz

60 Hz
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Test settings for mixed board (type 1:16 inputs and 8 outputs):

The inputs test is completed by groups of 8 inputs, as this type of board has 2 groups of 8 inputs with the same common. 
For the first 8 inputs, the voltage threshold setting is determined by Voltage Threshold A. For the next 8 inputs, the setting is 
Voltage Threshold B. Inputs (or contact converters, CC1 – CC16) must also be set to POSITIVE.

Test settings for mixed board (type 2: 8 digital inputs, 4 blocks for supervision and 8 outputs):

The inputs test is completed by groups of 4 inputs, as this type of board has 2 groups of 4 inputs with the same common. 
For the first 4 inputs, the voltage threshold setting is determined by Voltage Threshold A. For the next 4 inputs, the setting is 
Voltage Threshold B. Inputs (or contact converters, CC1 – CC8) must also be set to POSITIVE.

If the relay incorporates more input modules, these tests must also be applied to them.

10.9.2  Contact outputs
The correct activation of every output to be verified.

For every output, activation command of a single contact must be given, and then verify that only that contact is activated. 
Go to EnerVista 650 Setup Software (Setpoint > Inputs/Outputs > Force Outputs).

For switched contacts, the change of state of both contacts shall be verified.

10.9.3  Circuit continuity supervision inputs 
This test applies to the board type 2 if located in the CIO module, or in C650 in 19" models.

Supervision inputs are tested as normal inputs, revising the voltage level that is 19 Volts.

Coil 1:

Apply 19 Vdc to both 52/a (terminals H1-H2) and 52/b (terminals H3-H4)”Coil 1” circuit supervision inputs and verify
that they are activated.

Apply -19 Vdc to both 52/a (terminals H1-H2) and 52/b (terminals H3-H4)”Coil 1” circuit supervision inputs and verify
that they are activated.

Remove voltage from both inputs and verify that it takes them 500 ms to change state (deactivate).

I/O Board Type 1 (MIXED)

Voltage Threshold A_X 30 V

Voltage Threshold B_X 40 V

Debounce Time A_X 5 ms

Debounce Time B_X 5 ms

Input Type_X_CC1 (CC1) POSITIVE

... ...

Input Type_X_CC16 (CC16) POSITIVE

I/O Board Type 2 (SUPERVISION)

Voltage Threshold A_X 30 V

Voltage Threshold B_X 40 V

Debounce Time A_X 5 ms

Debounce Time B_X 5 ms

Input Type_X_CC1 (CC1) POSITIVE

... ...

Input Type_X_CC8 (CC8) POSITIVE
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Coil 2:

Apply 19 Vdc to both 52/a (terminals H15-H16) and 52/b (terminals H17-H18)”Coil 2” circuit supervision inputs and
verify that they are activated.

Apply -19 Vdc to both 52/a (terminals H15-H16) and 52/b (terminals H17-H18)”Coil 2”  circuit supervision inputs and
verify that they are activated.

Remove voltage from both inputs and verify that it takes them 500 ms to change state (deactivate).

10.9.4  Latching circuits
This test applies to the board type 2 if located in the CIO module, or in C650 in 19" models.

Send a closing command to the latched contact (H31-H33).

Make circulate a current of 500 mA through the contact in series with the sensing terminal.

Send an opening command and verify that the contact does not open.

Interrupt current and check that the contact is released.

Repeat the test for the other latched contact (FH34-FH36).

I
500
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10.10   Connections for testing protection elements
Connect current sources to the relay according to the wiring diagram. Current and voltage input terminals are as follows:

10.11   Recloser (79)
Set protection element 79 as follows:

Set the relay to trip by 50PH, and configure the signals necessary to test the 79 element:

Configure one output as AR RECLOSE

Configure the AR INITIATE signal with the 50PH trip

Configure the AR LEVEL BLOCK signal with a digital input

Configure the AR CONDS INPUT with the digital signal desired

Phase Connections

Current

IA B1-B2

IB B3-B4

IC B5-B6

IG B9-B10

ISG B11-B12

Voltage

VI A5-A6

VII A7-A8

VIII A9-A10

VX A11-A12

RECLOSER

Function ENABLED

Max Number Shots 4

Dead Time 1 2.10 sec

Dead Time 2 4.10 sec

Dead Time 3 6.10 sec

Dead Time 4 8.10 sec

Reclaim Time 3.00 sec

Cond. Permission ENABLED

Hold Time 7.00 sec

Reset Time 5.00 sec

50PH Settings

Function ENABLED

Input RMS

Pickup Level 3 A

Trip Delay 0.00 s

Reset Delay 0.00 s
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10.11.1  Reclosing cycle
Connect a latching relay simulating the breaker managed by the C650 unit.

Once the relay is set, close the breaker and wait for 5 seconds.

After this time, the recloser is ready to initiate the reclosing cycle.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 2.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 4.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 6.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 8.1 seconds.

Command a 50PH trip and verify that the breaker opens and the recloser passes to Lockout.

Verify the correct operation of programmed outputs

Tripping times must be within the following values:

10.11.2  Recloser status
BLOCK

Activate the block input and verify that the recloser is in BLOCK status.

Close the breaker and wait for 5 seconds.

Command a trip and verify that the breaker opens but there is no reclose.

INHIBITION BY RECLOSING CONDITIONS

Close the breaker and wait for 5 seconds.

Command a trip, verify that the breaker opens and wait for the first shot.

Activate the inhibition input and command a new trip.

Verify that the breaker opens, wait for 8 seconds and verify that the relay does not reclose.

10.11.3  External reclose initiation
Close the breaker and wait for 5 seconds.

Activate the reclose initiation input and open the breaker, verify that the relay executes the first shot

Reclosing Cycle

Nº shot  Expected time Admissible time

1 2.1 sec [1.8 – 2.3]

2 4.1 sec [3.8 – 4.3]

3 6.1 sec [5.8 – 6.3]

4 8.1 sec [7.8 – 8.3]
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APPLICATION EXAMPLES

11.1  Example: Set an operation

11.1.1  Description
This simple operation describes how to program and set an operation command on the C650 relay. In the present case the 
operation is:

To configure some C650 output contact to be operated since the front of the relay.

To set some LED to show the operation of the output contact (while being closed).

To close a C650 output contact using a front key pushbutton.

To reset the output contact and LED using another front key pushbutton.

11.1.2  Procedure
Set the following values:

Under

SETPOINT  CONTROL ELEMENTS Þ INPUTS/OUTPUTS  BOARD F

* This setting is non-relevant since it applies only when “pulse” type is chosen

Under

SETPOINT  RELAY CONFIGURATION  OUTPUTS

Name Value

Output Logic_00_00 Positive

Output Type_00_00 Latch

Pulse Output Time 10000ms *
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Under

SETPOINT  RELAY CONFIGURATION  LEDS

Select Name Source

 Contact Output Operate 00 (Board F) C_Output Oper_00_00 Operation_bit000

  Contact Output Reset 00 (Board F) C_Output Reset_00_00 Operation_bit001

Select Name Source

Led 14 Close Contact_00_00 C_Output_00_00
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Under

SETPOINT  RELAY CONFIGURATION  OPERATIONS

Select  Operation 0

Command Text Close C_Output_00_00

Interlock Type None

Interlocks ---

Final State Type None

Final States ---

Frontal Key F2

Contact Input None

Virtual Output None

Time Out 500 (default)

MMI ---

Com1 ---

Com 2 ---

ETH-Master 1 ---

ETH Master 2 ---

ETH Master 3 ---

ETH Mastef 4 ---

In the same window (next rows)

Select  Operation 1

Command Text Reset C_Output_00_00

Interlock Type None

Interlocks ---

Final State Type None

Final States ---

Frontal Key F1

Contact Input None

Virtual Output None

Time Out 500 (default)

MMI ---

Com1 ---

Com 2 ---

ETH-Master 1 ---

ETH Master 2 ---

ETH Master 3 ---

ETH Mastef 4 ---
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11.1.3  Test
In the main front screen press F2 key.

A message showing “Press Enter to Confirm Key ®F2¬” is displayed.

Press Enter.

Check that contact_00_00 (board F) has been closed.

Check that the front LED 14th is lit.

In the main front screen press F1 key.

A message showing “Press Enter to Confirm Key ®F1¬” is displayed.

Press Enter.

Check that contact_00_00 (board F) has been opened.

Check that the front LED 14th has been switched off
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FREQUENTLY ASKED QUESTIONS

12.1  Communications

Q1. Does the C650 support DNP and ModBus over the Ethernet port?

A1. C650 units support both protocols over both the asynchronous serial ports and the Ethernet LAN synchronous port using
TCP/IP and UDP/IP layers over the Ethernet. 

Q2. Does this equipment support dual IP access?

A2. Yes, it supports two independent IP addresses in aliasing mode. Those address go in the communications settings
Network0 and Network1.

Q3. Is the protocol IEC 870-103 supported by the C650?

A3. Yes, IEC 870-103 is supported by the C650 in firmware version 5.00 and higher.

Q4. Can the C650 be used as a DNP master station?

A4. Not at this moment. It works as a slave IED station for all protocols.

Q5. How many communication ports are included in the C650?

A5. The equipment has 2 different boards, one for asynchronous serial ports and another for a high-speed synchronous
Ethernet port. The first board has 2 comm ports, COM1 and COM2. COM2 is multiplexed with the front serial RS232 port,
whereas the COM1 port is completely independent from COM2. The synchronous LAN port is ETH_1/ETH2 or ETH_E/
ETH_A/ETH_B (Depending on model. 

Q6. Are there one or two Ethernet ports?

A6. The equipment has only 1 Ethernet port. For redundant fiber optic versions, redundancy is done at the physical level (fiber
optic) but there is just one port. 
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Q7. How many different communication Ethernet sessions can be opened through the LAN port?

A7. ModBus TCP/IP:4 sockets. DNP TCP/IP:3 sessions (from version 1.72 onwards). 

Q8. May I use the cooper 10/100 BaseTX connection included in the basic model with all protocols?

A8. Yes, it may be used with all protocols. In noisy substation environments and/or long distances, it is recommended to use
fiber optic options due to much better EMC performance and immunity. For fiber optic models, it is necessary to adjust an
internal jumper to use the copper port.

Q9. Remote I/O CAN bus. Does it support DeviceNet protocol?

A9. No it does not support DeviceNet.

Q10. Which functions are available in the relay web server? 

A10. Currently, it includes several functions for viewing measures and retrieving information.

Q11. Q11 May I use URPC to program the relay? 

A11. Only oscillography records may be viewed with URPC once downloaded to a file using the ENERVISTA 650 Setup software.

Q12. May I connect URs and C650s to the same Ethernet?

A12. Yes, either in cable as in fiber, or even mix them. 

Q13. How do I connect with fiber 10-BASE-FL UR relays with 100-BASE-FX C650 relays?

A13. Take into account that an UR is never connected directly to a C650 (neither two UR nor two C650 with each other) but they
are always connected through a hub or switch. The hub or switch where the URs are connected must be 10-BASE-FL and
the hub or switch for the C650 must be 100-BASE-FX.

Q14. How do I connect with cable 10_BASE-T UR relays with 10/100-BASE-TX C650 relays?

A14. The answer to this question is as described before but also in this case there is an advantage added, because the hub 10-
BASE-TX port is able to understand a 10-BASE-T port. This means that a hub 10-BASE-T port may be connected to an UR
or a C650, and a hub 10/100-BASE-TX port may be connected either to an UR or C650.

Q15. What happens with fiber optic connectors compatibility, because the hub that I have has a different connector to the
one of the C650, although both are 100-BASE-FX?

A15. Just buy fiber cables with the appropriate male connectors. For the UR and C650 side we need the same connectors, ST
type, for the hub side, the correspondent ones. And in what concerns to the fiber type, it is used the same for 10 as for 100,
it is the 50/125 or 62.5/125 multimode, this last one allows longer distances.

Q16. What is the difference between a hub and a switch?

A16. In a repeater type hub (shared hub), one unit talks and the rest listen. If all the units are talking at the same time there may
be collisions in the messages, what may produce certain communication delays. The switch (switched hub) has very
powerful processors and a lot of memory and it is much more expensive than the hub. It directs messages to the proper
destination avoiding collisions and allowing a much more efficient communication.
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Q17. Why do we have 10/100 compatibility for cable but not for fiber?

A17. The cable has some advantages that the fiber does not have, and it is that the signal attenuation in short and medium
distances, is worthless and this is truth for low and high frequency signals. By the contrary, the light in one fiber optic is
highly attenuated, being much worse in case of high frequencies than in the low ones. The 10-BASE-FL fiber transmission
is performed in a wavelength of 850nm, what allows a less expensive electronic than the 1300 nm used in 100-BASE-FX
fiber transmission. Using, in both cases, the same glass multimode fiber type, the attenuation to 1300 nm is lower than the
850 nm ones, this way the greater attenuation of the 100 Mbits is compensated. There is another fiber standard, the 100-
BASE-SX, which uses 850 nm to 100 Mbits, being compatible with the 10-BASE-FL one, although it sacrifices the maximum
distance to 300 m. Nowadays, this standard has not had success among Ethernet equipment manufacturers and
suppliers.

12.2  Protection
Q1. Does the C650 support IRIG-B signals? Which type and accuracy? How many units may be connected to the same

source?

A1. Yes, the C650 includes an IRIG-B input for all models, including the basic ones. It uses DC level format B. Formats used are
B0000, B0002 and B0003. Actual accuracy is 1 millisecond. Internal sampling rate allows true 1 ms accuracy time tagging.
The input burden is very low. The maximum number of units that may be connected to a generator depends on its output
driving capability. Up to 60 units have been successfully connected with equipments commonly used in the market.

Q2. Does the equipment work with dry inputs in both AC and DC?

A2. The equipment works only with DC inputs. Inputs should be driven with externally generated DC current. No special 48 Vdc
or other outputs are included in the equipment to drive these inputs; therefore, contacts connected to the equipment
should be connected to a DC source.

Q3. Is it oscillography programmable?

A3. Yes, the sampling rate is programmable (4, 8, 16, 32 or 64 samples per input). The depth depends on the sampling rate.

Q4. Do I have to select a different model for 1 or 5 A?

A4. No. The same model is able to work with either /1 A or /5 A rated secondary currents. There are high accuracy sensing
transformers that allow the use of any current input through the same terminals to reduce the spares and simplify wiring.

Q5. In my installation, several digital inputs become active when I energize the transformer. How can I reduce sensitivity?

A5. By selecting debounce time and/or voltage threshold, the relay may adapt its sensitivity to different applications. Select
the maximum voltage threshold and debounce time (recommended 15 ms) to minimize AC coupling effects.
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12.3  Control & HMI
Q1. What is the difference between Get/Send info from/to relay and Upload/Download info files to/from relay?

A1. Get/Send are used for settings and configuration storage that although both are in a unique file, are sent separately in two
times. Upload/Download are used for project or PLC files group storage. These files are the setting_configuration file
source. To operate, the C650 does not need the source files; the Upload/Download tool is destined to serve as historic file.

Q2. Can I program interlocks?

A2. Yes, via ENERVISTA 650 Setup interlocks may be programmed from very simple to advanced schemes.

Q3. Can we rotate the display 90 degrees to show feeders vertically?

A3. No. The product has been designed to view it in horizontal mode (landscape) due to the following reasons:

It is easier to read the LCD display because it has been designed for horizontal positions.
Compatibility between text display (4x20 characters) and LCD display (16x40 characters or 128x240 pixels).
Refresh speed is better in horizontal than vertical format.

Q4. Do I need a laptop or handheld to program the unit?

A4. No, all main operations can easily be performed with just the incorporated HMI. Handheld or laptops may be required to
download large quantities of information (such as oscillograms, etc.) but they are not mandatory for a conventional user
that just needs to change settings, view measurements, states, etc.

Q5. Is there password security for protection and control?

A5. Yes, there are two passwords. An independent password for protection changes and control operations is available since
version 1.44

Q6. Is it possible to have a remote HMI installed in the front of the panel with the rest of the relay in the rear side?

A6. Not in the present version.

Q7. Is it possible to program a default screen for the HMI?

A7. In graphic display versions the user may program a custom screen with the single-line diagram, measurements, etc. In
text display models, there is a choice of logo, measurements, or scrolling both screens.

Q8. May I force inputs and outputs to ease commissioning and testing?

A8. Yes.

Q9. How can I disable the rotary knob buzzer?

A9. Press ESC key for more than 3 seconds and then press the knob during a short pulse.
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Q10. How can I disable/enable beep sound HMI keypad in models with Enhanced HMI?

A10. To disable: Press ESC push-button more than 3 seconds and then press ENTER push-button while keeping ESC push button
pressed.

To enable: Press ESC push-button more than 3 seconds. After this time, press the ENTER push-button and then Up/down
key while keeping ESC push-button pressed.

Q11. Why do appear strange texts on the display when switching on the relay?

A11. You have pressed any button and the HMI has entered test mode. 

The display messages are updated after a few minutes, once the relay has completed the starting sequence.

12.4  Relay configuration
Q1. Does the "Service" contact on the Power Supply board cover all possible failures or do I have to create an output on

the I/O board that includes all the internal errors I can access in the logic?

A1. The power supply ready contact only monitor hardware failures in the power supply, to monitor the internal error of the
unit it is necessary to configure a virtual output to and the assign it to the device desired (contact output, LED, etc.).

Q2. I set an output contact as "Latched". If I do not set a "reset" condition, will it reset from the "ESC" key?

A2. No, you have to configure the contact output reset signal (in Setpoint > Relay Configuration > Outputs). 
The ESC key only reset the LED indicators.

12.5  Common FAQs
Q1. Remote I/O CAN bus: Does it support DeviceNet protocol?

Q1. No it does not support DeviceNet

Q2. Does the equipment work with dry inputs in both AC and DC?

A2. The equipment works only with DC inputs.
Inputs should be driven with externally generated DC current. No special 48 Vdc or other outputs are included in the
equipment to drive these inputs; therefore, contacts connected to the equipment should be connected to a DC source.

Q3. Can I program interlocks?

A3. Yes, via ENERVISTA 650 Setup interlocks may be programmed from very simple to advanced schemes.

Q4. Does the "Service" contact on the Power Supply board cover all possible failures or do I have to create an output on
the I/O board that includes all the internal errors I can access in the logic?

A4. The power supply ready contact only monitor hardware failures in the power supply, to monitor the internal error of the
unit it is necessary to configure a virtual output to and the assign it to the device desired (contact output, LED, etc.).

Q5. I set an output contact as "Latched". If I do not set a "reset" condition, will it reset ?

A5. No, you have to configure the contact output reset signal (in Setpoint > Relay Configuration > Outputs). 
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C650 TROUBLESHOOTING GUIDE

13.1  Symptoms and recommended actions

C650 units have been designed and verified using the most advanced and reliable equipment. Mounting and testing 
automation ensure a high consistency of the final product. Before sending a unit back to the factory, we strongly 
suggest you follow the recommendations below. These actions may solve the problem, and if not they will help define 
the problem for quicker repair.

To send a unit back to the factory for repair, use the appropriate RETURN MATERIAL AUTHORIZATION process, and follow 
the shipping instructions provided by our Service Department, especially in the case of international shipments. This will 
lead to a faster and more efficient solution to your problem.
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Category Symptom Possible cause Recommended action

Control The relay does not trip -Function not permitted

- Function blocked

- Output not assigned

- The unit is not set to ready

-Set the function permission to 
ENABLED

-Check Control units block screen

-Program the output to the desired 
function using EnerVista 650 Setup 
logic configuration

- Verify that the general setting is set 
to disabled and the out of service 
state is not active

General When feeding the 
unit, no indicator is lit 
up

-Insufficient power supply

- Wrong versions

- Fuse failure

- Loose fuse

-Incorrect wiring

-Verify the voltage level using a 
multimeter in the power supply 
terminals, and check that it is within 
the model range

-Check relay and EnerVista 650 Setup 
versions are the same

-Remove power supply, dismount the 
power supply module and replace the 
fuse

-Same as above with same fuse

-Make sure that terminals labeled + 
and – are connected to the 9-pin 
connector corresponding to the 
power source

Communication The relay does not 
communicate via the 
front port

-Incorrect cable

-Damaged cable

-Relay or PC not grounded

-Incorrect baud rate, port, address, 
etc. 

-Make sure you are using a straight 
cable

-Replace the cable

-Ensure ground connection

-Test other ports, other baud rates, 
etc. Make sure that the 
communication parameters in the 
computer match the ones in the relay.

General After Updating the 
firmware the relay 
does not start up and 
always shows the 
message:
 “Os Loading…”.

Check that the bootware version 
matches the firmware version

-If there is an incompatibility between 
boot and firmware version, update to 
the corresponding boot and after that 
update the firmware version

-If the boot and firmware versions are 
correct, perform the firmware update 
procedure again.
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Category Symptom Possible cause Recommended action

Communications Cannot see the web 
server properly in 
C650 with Windows 
XP. 

Some windows are in 
grey with a red cross 
mark.

1.- Disabled Java options in Advanced 
Internet Explorer properties or high 
level of security

2.- No Java Virtual Machine installed.

1.1- Go to Advanced in Internet 
options for Internet explorer and 
select the three selections in Microsoft 
VM (Java Virtual Machine) and 
deselect any other virtual machine not 
Microsoft, for example SUN.
In case a Microsoft VM is not installed 
in the computer, the user must install 
it
using the Microsoft VM installation
program msjavx86.exe
(For internet explorer 6.0 or higher it is
not included by default.)

1.2.- Try to set a lower level of security 
in internet explorer options.

1.3.-Delete temporary internet files in
"General" screen in internet explorer
options.
Communication EnerVista 650 Setup
does not retrieve osc and Data Logger 
files
Bad communication in TFTP using
Windows 2000
Disable and Enable the Ethernet
connection on Control Panel inside
Windows 2000. Try again.

2.1- Install either Microsoft or Sun 
Java Virtual Machine
 

Communication EnerVista 650 Setup 
does not retrieve osc 
and Data Logger files

Bad communication in TFTP using 
Windows 2000

Disable and Enable the Ethernet 
connection on Control Panel inside 
Windows 2000. Try again to retrieve 
files from relay

Firmware and bootware upgrade

Bootware The relay gets stuck 
during the upgrading 
process after 
switching off and on 
the relay, giving the 
following error 
message: 
“ERROR Setting relay 
in configuration mode. 
Retry?"

- The relay does not communicate via 
the front port

To perform the bootware upgrading 
process it is necessary to connect the 
unit thought the front RS232 port. 
check:
• Serial cable correct (straight   
   through) and undamaged.
• Settings selection in EnerVista 650
   Setup: Communication > Computer 
   Settings”:
   o Com port selected must be the one
      that is being used to perform this
      procedure
 o  Parity set to NONE
 o  Baud rate set to 19200 
 o Control type: No control type
 o Modbus slave number: any
Note: if the bootware upgrade 
procedure got stuck at this point the 
relay will not be upgraded. After 
reboot the relay will continue 
working with the former firmware 
and bootware versions.
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Category Symptom Possible cause Recommended action

Bootware The relay gets stuck at 
“Sending file 
imagen_kernel...”

-The Ethernet connection does not 
work properly.

Serial communications work properly 
and the flash memory has been 
erased but Ethernet communication 
does not work properly, check:
•  RJ45 cable used (crossover cable for 
back-to-back connection and straight 
through Ethernet cable for hub or 
switch)
•  IP address and netmask, gateway 
are correct and correspond to the 
ones used in the computer performing 
the procedure. See chapter 5.2.1 
Communication settings
•  Ethernet board parameters 
selection, check that:
 o 802.1p QOS is Enabled
 o Flow control is Auto
 o Speed & Duplex is Auto (or 
       10 Mb Full)
•  If the above points are correct but 
the problem persists: 
 o Force the Speed & Duplex to
       10 Mb Full
 o  Disable and enable the Ethernet
       connection while the files are
       being sent (during the “sending
       file...” message
Note: if the bootware upgrade 
procedure is stuck at this point, the 
relay flash memory has been erased 
and the upgrade procedure must be 
completed to start working with the 
unit. If the procedure is not 
completed, the HMI shows the 
message “Os Loading...” and the 
relay does not start up.

Firmware The procedure cannot 
start due to Ethernet 
problems

-The Ethernet connection does not 
work properly.

• Check the same as in the point 
above for bootware.
Note: if the firmware upgrade 
procedure is stuck at this point the 
relay will not be upgraded. After 
switching it off and on it will 
continue working with the former 
firmware and bootware versions.

Firmware Program messages
“file” do not exist in 
local drive

- File path is too long
- File has no file attributes

•  Check the path length, copy the files 
in a shorter path and restart the 
upgrade procedure.
•  Check the unzip process to see if the 
file properties are properly set to “File”.
Note: if the firmware upgrade 
procedure is stuck after having been 
started, the former firmware has 
been erased and the upgrade 
procedure must be completed to 
start working with the unit. If the 
procedure is not completed, the HMI 
shows the message “Os Loading...” 
and the relay does not start up.
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Category Symptom Possible cause Recommended action

Firmware It is not possible to 
upgrade models 
without IEC 61850 to 
models with IEC 61850 
automatically

- IEC 61850 upgrade from standard 
models is password protected.

• To upgrade from a standard model 
to a 6 model, ask the factory for an 
upgrade package, depending on the 
hardware the existing unit has. If it is 
hardware 00 a hardware and 
firmware change is required 
(password protected), if it is hardware 
01 or above only a firmware change is 
required (password protected).

Firmware During the upgrading 
process for models 
with IEC 61850 
sometimes it ask for 
password and 
sometimes not.

- Communication problems during the 
upgrade procedure.
-The upgrade procedure has been not 
performed in a continuous way.

• EnerVista 650 Setup program does 
not ask for a password if the relay 
model is IEC61850 and the procedure 
is completed.
•  If during the process there is any 
problem and it has to be restarted, 
this second time the program will ask 
to confirm the IEC password.
•  If the EnerVista 650 Setup program 
is closed and started again during the 
bootware and firmware upgrade 
process, the program will ask to 
confirm the IEC password.

Firmware Password for 
IEC61850 incorrect

- Model change
- Incorrect mac or serial number

•  The password is tied to the model, 
MAC Address and serial number, so a 
change in any of these requires a 
password change.
•  If the model has been modified to 
add or replace any boards or 
communication protocol, the IEC 
61850 passwords needs to be 
updated (contact the factory).

EnerVista 650 Setup InstallShield Setup 
Initialization Error 
6001

A previous installation of any product 
using InstallShield for installation may 
have corrupted some of the 
InstallShield files used in the EnerVista 
650 Setup installation

Delete (or rename) the 0701 folder 
located in  "C:\Program Files\Common 
Files\InstallShield\Professional\RunTi
me\" and retry installation
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C650 Bay Controller & Monitoring System

Appendix A:  Logic Operands

GE
Grid Solutions

LOGIC OPERANDS

A.1  Logic Operands

OPERANDS - C650 - MODEL FX - GX

Internal System Status

AUTOCHECK INTERNAL STATES (CRITICAL)

DSP Internal States (Critical to metering and 
protection)

DSP COMM ERROR
DSP Communication Error: (0) Right communications 
between DSP and main processor; (1) Communication 
Error between DSP and main processor

MAGNETIC MODULE 
ERROR

Magnetic Module Error: (0) Right Communication 
between DSP and magnetic module processor; (1) 
Communication Error between DSP and magnetic 
module processor

CALIBRATION ERROR
Calibration Error: (0) Right calibration values stored; (1) 
The calibration values stored are out of the calibration 
limits.

Flash Internal States (Critical to Relay configuration 
and stored data) E2PROM STATUS E2prom status: (0) Not configured or problems during 

writing process; (1) Configured and OK
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IO Board States (Critical to operation and 
protection)

BOARD F STATUS
Board F status: (0) Inactive - There is no communication 
with the board (1) Active - There is communication with 
the board. 

BOARD G STATUS
Board G status: (0) Inactive - There is no communication 
with the board (1) Active - There is communication with 
the board. 

BOARD H STATUS
Board H status: (0) Inactive - There is no communication 
with the board (1) Active - There is communication with 
the board. 

BOARD J STATUS
Board J status: (0) Inactive - There is no communication 
with the board (1) Active - There is communication with 
the board. 

BOARD 2H STATUS
Board 2H status: (0) Inactive - There is no 
communication with the board (1) Active - There is 
communication with the board. 

BOARD 2J STATUS
Board 2J status: (0) Inactive - There is no 
communication with the board (1) Active - There is 
communication with the board. 

IEC61850 INTERNAL STATES (NON CRITICAL)

IEC61850 Internal States ICD STATUS UNKNOWN: when the relay has not the IEC61850 
protocol in the relay model the ICD status is unknown to 
the unit

ICD ERROR: There is an error in the ICD file and the relay 
ICD is not operative. To solve this issue it is necessary to 
send a correct ICD to the relay using the IEC61850 
configurator tool. When the ICD error is raised the IEC 
61850 will not be operative (the IEC 61850 client, reports 
and gooses will not work). It is advisable to include the 
ICD ERROR in the main error signal configured for 
specific applications.

MODIFIED: The settings have been changed in the icd 
but they are still not written in the icd file in the relay

IN PROGRESS: The icd setting are being written to the 
file in the relay

OK WITHOUT DAIS: The relay has not got the "Use DOI 
&DAI" setting enabled (true) and it is working properly 
with the ICD file.

OK: The relay has got the "Use DOI &DAI" setting 
enabled (true) and it is working properly with the ICD file. 
When that setting is set to true the icd setting prevails 
over the relay settings.

OTHER INTERNAL STATES (NON CRITICAL)

Other internal states

USER MAP STATUS User map status:  (0) Not configured ; (1) Configured

FACTORY CALIBRATION Calibration status (0) Relay calibrated; (1) Not calibrated

FLEXCURVE A STATUS User curve A: (0) Not configured (1) Configured

FLEXCURVE B STATUS User curve B: (0) Not configured (1) Configured

FLEXCURVE C STATUS User curve C: (0) Not configured (1) Configured

FLEXCURVE D STATUS User curve D: (0) Not configured (1) Configured

Green Zone Memory internal status

Yellow Zone Memory internal status

Orange Zone Memory internal status

Red Zone Memory internal status

UpTime System Time

OPERANDS - C650 - MODEL FX - GX
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Autocheck Internal States (Not available)

TIMER STATUS Real time clock autocheck (not available)

GRAPHIC STATUS Graphic display status (not available)

ALARM TEXT ARRAY Text display status (not available)

Note: It is advisable to use the critical alarms to raise an event or to light a warning LED for maintenance purposes. See 
the example below, the Board X Status depends on the relay model.

Figure A–1: Protection Alarm Signal

Configurable Logic Outputs (512 elements) 

VIRTUAL OUTPUT 000 Configurable logic output 000

VIRTUAL OUTPUT 001 Configurable logic output 001

... ...

VIRTUAL OUTPUT 511 Configurable logic output 511

OPERANDS - C650 - MODEL FX - GX

Internal System Status



A-4 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

A.1 LOGIC OPERANDS APPENDIX A:  LOGIC OPERANDS

Operation Bits (24 elements)

OPERATION BIT 1
Operation bit 001: (0) the configured time expires or 
when success conditions are met;(1) operation 1 is 
executed and interlocks are fulfilled. 

OPERATION BIT 2
Operation bit 002: (0) the configured time expires or 
when success conditions are met;(1) operation 2 is 
executed and interlocks are fulfilled. 

... ...

OPERATION BIT 24
Operation bit 024: (0) the configured time expires or 
when success conditions are met;(1) operation 24 is 
executed and interlocks are fulfilled. 

Control Event Bits (128 elements)

CONTROL EVENT 1 Control Event 1 Activation Bit

CONTROL EVENT 2 Control Event 2 Activation Bit

... ...

CONTROL EVENT 128 Control Event 128 Activation Bit

Latched Virtual Inputs (32 elements)

LATCHED VIRT IP 1 Latched virtual input 1

LATCHED VIRT IP 2 Latched virtual input 2

... ...

LATCHED VIRT IP 32 Latched virtual input 32

Self Reset Virtual Inputs (32 elements)

SELF-RST VIRT IP 1 Self reset virtual input 1

SELF-RST VIRT IP 2 Self reset virtual input 2

... ...

SELF-RST VIRT IP 32 Self reset virtual input 32

Contact Inputs Type 1Board

CONT IP_X_CC1 Input 1 (CC1) in Board X

CONT IP_X_CC2 Input 2 (CC2) in Board X

... ...

CONT IP_X_CC16 Input 16 (CC16) in Board X

OPERANDS - C650 - MODEL FX - GX

Internal System Status



APPENDIX A:  LOGIC OPERANDS A.1 LOGIC OPERANDS

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM A-5

Contact Inputs Type 2 Board

CONT IP_X_CC1 Input 1 (CC1) in Board X

CONT IP_X_CC2 Input 2 (CC2) in Board X

... ...

CONT IP_X_CC8 Input 8 (CC8) in Board X

CONT IP_X_CC9 
(Va_COIL1)

Contact Input 09 (Va_COIL1) for slot X. Input voltage (Va) 
detected, Circuit 1. Complete circuit supervised

CONT IP_X_CC10 
(Vb_COIL1)

Contact Input 10 (Vb_COIL1) for slot X. Input voltage (Vb) 
detected, Circuit 1. Complete circuit supervised

CONT IP_X_CC11 
(Va_COIL2)

Contact Input 11 (Va_COIL2) for slot X. Input voltage (Va) 
detected, Circuit 1. Complete circuit supervised

CONT IP_X_CC12 
(Vb_COIL2)

Contact Input 12 (Vb_COIL2) for slot X. Input voltage (Vb) 
detected, Circuit 2. Complete circuit supervised

CONT IP_X_CC13 
(O7_SEAL)

Contact Input 13 (07_SEAL) for slot X. Current detected. 
Contact output associated with current flow > 100 mA 
latched 

CONT IP_X_CC14 
(O8_SEAL)

Contact Input 14 (08_SEAL) for slot X. Current detected. 
Contact output associated with current flow > 100 mA 
latched

CONT IP_X_CC15 
(SUP_COIL1)

Contact Input 15 (SUP_COIL1) for slot X. Output for 
circuit 1 supervision element 

CONT IP_X_CC16 
(SUP_COIL2)

Contact Input 16 (SUP_COIL2) for slot X. Output for 
circuit 2 supervision element

Contact Inputs Type 4 Board

CONT IP_X_CC1 Input 1 (CC1) in Board X

CONT IP_X_CC2 Input 2 (CC2) in Board X

... ...

CONT IP_X_CC32 Input 32 (CC32) in Board X

Contact Inputs Type 5 Board (Digital Values)

CONT IP_X_CC1 Input 1 (CC1) in Board X

CONT IP_X_CC2 Input 2 (CC2) in Board X

... ...

CONT IP_X_CC16 Input 16 (CC16) in Board X

Contact Inputs Type 5 Board (Analog Values)

ANALOG_INP_X_01 Analog Input 01 in Board X

ANALOG_INP_X_02 Analog Input 02 in Board X

ANALOG_INP_X_03 Analog Input 03 in Board X

... ...

ANALOG_INP_X_08 Analog Input 08 in Board X

Contact Outputs Type 1 & 2 Board  Activation 
signals

CONT OP OPER_X_01 Logic signal for Output 1 activation. Board X

CONT OP OPER_X_02 Logic signal for Output 2 activation. Board X

... ...

CONT OP OPER_X_08 Logic signal for Output 8 activation. Board X

Contact Outputs Type 1 & 2 Board  Reset signals

CONT  RESET_X_01 board X, 01 latched output reset

CONT  RESET_X_02 board X, 02 latched output reset

... ...

CONT  RESET_X_08 board X, 08 latched output reset

OPERANDS - C650 - MODEL FX - GX
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Contact Outputs Type 1 & 2 Board Status

CONT OP_X_01 Contact output 1 Board X operation

CONT OP_X_02 Contact output 2 Board X operation

... ...

CONT OP_X_8 Contact output 8 Board X operation

Board Status BOARD X STATUS
Board X status: (0) Inactive - There is no communication 
with the board  (1) Active - There is communication with 
the board

Switchgear status (16 elements)

SWITCH 1 A INPUT Contact input type A to switchgear Function 1

SWITCH 1 B INPUT Contact input type B to switchgear Function 1

SWITCH 2 A INPUT Contact input type A to switchgear Function 2

SWITCH 2 B INPUT Contact input type B to switchgear Function 2

... ...

SWITCH 16 A INPUT Contact input type A to switchgear Function 16

SWITCH 16 B INPUT Contact input type B to switchgear Function 16

Switchgear outputs (16 elements)

SWITCH 1 A STATUS Contact logic output type A from switchgear Function 1 

SWITCH 1 B STATUS Contact logic output type B from switchgear Function 1 

SWITCH 2 A STATUS Contact logic output type A from switchgear Function 2 

SWITCH 2 B STATUS Contact logic output type B from switchgear Function 2 

... ...

SWITCH 16 A STATUS Contact logic output type A from switchgear Function 
16 

SWITCH 16 B STATUS Contact logic output type B from switchgear Function 
16 

Switchgear states (16 elements)

SWITCH 1 OPEN switchgear 1 open

SWITCH 1 CLOSED switchgear 1 closed

SWITCH 1 00_ERROR Error 00 switchgear 1 (contact A = 0, contact B = 0)

SWITCH 1 11_ERROR Error 11 switchgear 1 (contact A = 1, contact B = 1)

SWITCH 2 OPEN Switchgear 2 open

SWITCH 2 CLOSED Switchgear 2 closed

SWITCH 2 00_ERROR Error 00 switchgear 2 (contact A = 0, contact B = 0)

SWITCH 2 11_ERROR Error 11 switchgear 2 (contact A = 1, contact B = 1)

... ...

SWITCH 16 OPEN Switchgear 16 open

SWITCH 16 CLOSED Switchgear 16 closed

SWITCH 16 00_ERROR Error 00 switchgear 16 (contact A = 0, contact B = 0)

SWITCH 16 11_ERROR Error 11 switchgear 16 (contact A = 1, contact B = 1)

Switchgear Open-Close Initializing States

SWITCH 1 OPEN INIT Switchgear 1 opening initiation

SWITCH 1 CLOSE INIT Switchgear 1 closing initiation

SWITCH 2 OPEN INIT Switchgear 2 opening initiation

SWITCH 2 CLOSE INIT Switchgear 2 closing initiation

... ...

SWITCH 16 OPEN INIT Switchgear 16 opening initiation

SWITCH 16 CLOSE INIT Switchgear 16 closing initiation

OPERANDS - C650 - MODEL FX - GX
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Switchgear Fail States

SWGR 1 FAIL TO OPEN Failure to open Switchgear 1

SWGR 2 FAIL TO OPEN Failure to open Switchgear 2

... ...

SWGR 16 FAIL TO OPEN Failure to open Switchgear 16

SWGR 1 FAIL TO CLOSE Failure to close Switchgear 1

SWGR 2 FAIL TO CLOSE Failure to close Switchgear 2

... ...

SWGR 16 FAIL TO CLOSE Failure to close Switchgear 16

OPERANDS - C650 - MODEL FX - GX
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LEDS HMI (16 Elements)

READY LED Ready LED: (0-Red) Relay out of service, protection OUT 
OF ORDER (1-Green) Relay in service; protection READY

LED 1
Programmable LED 1 status: Red color.Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 2
Programmable LED 2 status: Red color. Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 3
Programmable LED 3 status: Red color.Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 4
Programmable LED 4 status: Red color. Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 5
Programmable LED 5 status: Red color. Latched by 
hardware. Reset by hardware (ESC)  and programmable 
(LED RESET INPUT)

LED 6
Programmable LED 6 status: Orange color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC)  
and programmable (LED RESET INPUT)

LED 7
Programmable LED 7 status: Orange color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LED 8
Programmable LED 8 status: Orange color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LED 9
Programmable LED 9 status: Orange color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LED 10
Programmable LED 10 status: Orange color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LED 11
Programmable LED 11 status: Green color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LED 12
Programmable LED 12 status: Green color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LED 13
Programmable LED 13 status: Green color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LED 14
Programmable LED 14 status: Green color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LED 15
Programmable LED 15 status: Green color. Not latched. 
Latching possibility via PLC. Reset by hardware (ESC) 
and programmable (LED RESET INPUT)

LEDs reset input (programmable) LED RESET INPUT Programmable input for remote LED reset
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Programmable Keypad Status (HMI)

I Key I key operation (Programmable signal via PLC)

O Key O key operation (Programmable signal via PLC)

*/F3 Key */F3 key operation (Programmable signal via PLC).

F1 Key F1 key operation (Programmable signal via PLC)

F2 Key F2 key operation (Programmable signal via PLC)

LOCAL/REMOTE Operation status LEDs

LOCAL/REMOTE 
OPERATION MODE

Local/remote status for operations 1 = Local, 0 = 
Remote. Selectable through the front pushbutton 
(Hardware) and also through communications 
(software).

OPERATIONS BLOCKED

Operations OFF status (1) Command execution block 
(operations blocked both in local and remote 
mode).Selectable through the front pushbutton 
(Hardware) and also through communications 
(software). 

LOCAL/REMOTE/OFF Selection

CHANGE LOCAL-REMOTE Changing local-remote status by communications

CHANGE OP BLOCKED Operations Block-Unblock signal

HMI Backlight

HMI BACKLIGHT ON "Switching on backlight" signal (the display is switched 
on by communications

HMI BACKLIGHT OFF "Switching off backlight" signal (the display is switched 
off by communications

Internal System Status (cont.)

Oscillography States

OSC DIG CHANNEL 1 Oscillography Digital channel 1 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 2 Oscillography Digital channel 2 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 3 Oscillography Digital channel 3 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 4 Oscillography Digital channel 4 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 5 Oscillography Digital channel 5 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 6 Oscillography Digital channel 6 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 7 Oscillography Digital channel 7 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 8 Oscillography Digital channel 8 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 9 Oscillography Digital channel 9 : (1) Active ; (0) Not Active

OSC DIG CHANNEL 10 Oscillography Digital channel 10: (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 11 Oscillography Digital channel 11 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 12 Oscillography Digital channel 12 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 13 Oscillography Digital channel 13 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 14 Oscillography Digital channel 14 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 15 Oscillography Digital channel 15 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 16 Oscillography Digital channel 16 : (1) Active ; (0) Not 
Active

OSCILLO TRIGGER Oscillo trigger activation (1) Active ; (0) Not active

Energy Counters

FREEZE ENERGY CNT Energy counter freeze

UNFREEZE ENERGY CNT Energy counter unfreeze

RESET ENERGY CNT Energy counter reset

OPERANDS - C650 - MODEL FX - GX
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Demand Inputs
DEMAND TRIGGER INP Demand trigger (for Block interval algorithm)

DEMAND RESET INP Demand reset

GROUP 1 ACT ON Group 1 activation, and deactivation of groups 2 & 3 

KI2t PHASE A ALARM K·I2t phase A Alarm

KI2t PHASE B ALARM K·I2t phase B Alarm

KI2t PHASE C ALARM K·I2t phase C Alarm

Breaker Maintenance BKR OPENINGS ALARM Maximum Breaker openings alarm

BKR OPEN 1 HOUR ALRM Maximum Breaker openings in one hour alarm 

RESET KI2t COUNTERS KI2t Breaker ageing counter reset 

RESET BKR COUNTERS Breaker openings and closings counters reset 

 Breaker Status

BREAKER OPEN Breaker Opened

BREAKER CLOSED Breaker closed

BREAKER UNDEFINED Breaker undefined (52a and 52b have the same status) 

Synchrocheck

Synchrocheck BLK INP Synchronism element block

Synchrocheck OP Synchronism condition (Dv, Dj and Df are within the set 
range)

SYNCHK CLOSE PERM Closing permission for the synchronism element: 
(SYNCHK OP) OR (SYNCHK CON OP)

Synchrocheck COND OP Active if when it is set, any of the three following 
conditions is met:

DL-DB OPERATION Dead line – dead bus condition

DL-LB OPERATION Dead line – live bus condition

LL-DB OPERATION Live line – dead bus condition

SLIP CONDITION Slip conditions are met

BUS FREQ > LINE FREQ Bus Frequency higher than line frequency 

BUS FREQ < LINE FREQ Bus Frequency lower than line frequency

OPERANDS - C650 - MODEL FX - GX
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Autorecloser

AR LEVEL BLOCK Recloser element block by level 

AR PULSE BLOCK Recloser element block by pulse

AR PULSE UNBLOCK Recloser element unblock by pulse

AR INITIATE Reclose initiate

AR CONDS INPUT Reclose permission condition in input to Function 1 = 
there are conditions 

AR CLOSE BREAKER Closing permission for the recloser 

AR OUT OF SERVICE Recloser out of service

AR READY Recloser READY

AR LOCKOUT Recloser in LOCKOUT

AR BLOCK Recloser BLOCKED

AR RCL IN PROGRESS Recloser – Cycle in progress

AR LCK BY ANOMALY Recloser – LOCKOUT by anomaly (reclosing command 
during cycle in progress)

AR LCK BY FAIL OPEN Recloser – LOCKOUT by failure to open

AR LCK BY FAIL CLOSE Recloser – LOCKOUT by failure to close

AR LCK BY USER Recloser – LOCKOUT by external operation (e.g.: manual 
opening with cycle in progress)

AR LCK BY CONDS Recloser – LOCKOUT by lack of reclosing conditions 

AR LCK BY TRIPS Recloser – LOCKOUT by number of trips

AR LCK BY SHOTS Recloser – LOCKOUT by number of shots

AR BLK AFTER 1 SHOT Recloser – Block after first shot

AR BLK AFTER 2 SHOT Recloser – Block after second shot

AR BLK AFTER 3 SHOT Recloser – Block after third shot

AR BLK AFTER 4 SHOT Recloser – Block after fourth shot

Autorecloser
AR BLOCK BY LEVEL Recloser – Block by level

AR BLOCK BY PULSE Recloser – Block by command (pulse)

Pulse Counters

PulseCntr Value 1 Pulse counter element value Group 1

PulseCntr Value 2 Pulse counter element value Group 2

... ...

PulseCntr Value 8 Pulse counter element value Group 8

PulseCntr Freeze 1 Pulse counter element freeze value Group 1

PulseCntr Freeze 2 Pulse counter element freeze value Group 2

... ...

PulseCntr Freeze 8 Pulse counter element freeze value Group 8

Analog comparators

Analog Level 01 Analog comparator element level Group 1

Analog Level 02 Analog comparator element level Group 2

... ...

Analog Level 20 Analog comparator element level Group 20
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Remote Outputs

DNA 1 1 output on. Remote Output DNA 1 Operation (GSSE/
GOOSE)

DNA 2 1 output on. Remote Output DNA 2 Operation (GSSE/
GOOSE)

... ...

DNA 32 1 output on. Remote Output DNA 32 Operation (GSSE/
GOOSE)

User St 1 1 output on. Remote Output UserSt 1 Operation (GSSE/
GOOSE)

User St  2 1 output on. Remote Output UserSt 2 Operation (GSSE/
GOOSE)

... ...

User St 64 1 output on. Remote Output UserSt 64 Operation (GSSE/
GOOSE)

Rem GOOSE Dig Out 1 1 output on. Remote Output GOOSE 1 Operation 
(GOOSE)

Rem GOOSE Dig Out 2 1 output on. Remote Output GOOSE 2 Operation 
(GOOSE)

... ...

Rem GOOSE Dig Out 32 1 output on. Remote Output GOOSE 32 Operation 
(GOOSE)

Remote Inputs

Remote Input 1 Flag is set, logic =1 

Remote Input 2 Flag is set, logic =1 

... ...

Remote Input 32 Flag is set, logic =1 

Remote Devices

Remote Device 1 Flag is set, logic =1 

Remote Device 2 Flag is set, logic =1 

... ...

Remote Device 16 Flag is set, logic =1 

GOOSE DIG INPUTS

Rem GOOSE Dig Input 1 Flag is set, logic = 1

Rem GOOSE Dig Input 2 Flag is set, logic =1 

... ...

Rem GOOSE Dig Input 32 Flag is set, logic =1 

GOOSE Analog Inputs (FLOAT AND INTEGER)

Rem Ana Inp FLOAT 1 Analog Input 1 (Float type)

Rem Ana Inp FLOAT 2 Analog Input 2 (Float type)

... ...

Rem Ana Inp FLOAT 8 Analog Input 8 (Float type)

Rem Ana Inp INT 1 Analog Input 1 (Integer type)

Rem Ana Inp INT 2 Analog Input 2 (Integer type)

... ...

Rem Ana Inp INT 8 Analog Input 8 (Integer type)

OPERANDS - C650 - MODEL FX - GX

Internal System Status
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C650 Bay Controller & Monitoring System

Appendix B:  MODBUS protocol

GE
Grid Solutions

MODBUS PROTOCOL

B.1   Introduction

This section describes the MODBUS memory map and how to read and write data from and to the C650 relay using 
MODBUS protocol. The MODBUS protocol is an industrial communications protocol based on a master/slave architecture 
(RTU-Serial) or a client/server architecture (TCP/IP). Refer to http://www.modbus.org/ for more information about this 
protocol.

A generic memory map has been created, compatible between versions, with all possible items that an C650 may have, 
independent of type or configuration to prevent an existing integration from being affected by version changes. This 
memory map describes each item including the data type, length, memory position, object version, etc. Moreover, the 
memory map groups the different objects into subgroups, such as status and settings groups. 

Each object has a unique memory position for the whole family. Only after reading the objects of a particular relay model, 
it is possible to elaborate its own MODBUS memory map. This map is only valid for that particular relay and memory 
version. From one version to another the memory positions of existing objects remain fixed, and new objects are assigned 
new addresses, which again remain the same for following versions. 

View the Memory Map using EnerVista 650 Setup software, menu:

View > MODBUS Memory map
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B.2  MODBUS C650

B.2.1  Implemented MODBUS functionality

The implemented protocol is standard MODBUS, so any SCADA or PLC can easily communicate with C650 units.

The C650 unit always works as a slave/server, and thus never initiates communication; it is always the master/client 
(EnerVista 650 Software or PLC, i.e.) that initiates communication.

Only two MODBUS codes are implemented in all firmware versions: 

• Read function 3 (03h) and 4 (04h)

• Write function 16 (10h)

Starting from firmware version 7.50 and above, two custom MODBUS functions have also been implemented:

• Read function 66 (42h)

• Write function 67 (43h)

The two new custom function codes allow the master/server to read/write settings of protection functions affected by the 
setting groups. If these MODBUS function codes are used, the master/server has access to read/write protection element 
settings that belong to any setting group. In contrast, if read function 3 or Write function 4 is used, only protection 
elements settings in the active setting group can be accessed/modified.

B.2.2  Physical layer
MODBUS protocol is independent of hardware. The physical layer may be in different hardware configurations: USB, RS485, 
fiber optic or Ethernet. 

C650 units incorporate a front USB and can mount up to two rear RS485 or fiber optic ports, and a 1mixture of 10/100Base 
TX and 10/100Base FX ports, depending on the specific order code of each C650 unit. The data flow in any of these 
configurations is “half-duplex”. 

B.2.2.1  Serial layer

The port baud rate and the parity are independent and programmable for each communication port. Any port may be 
programmed to baud rates of: 1200, 2400, 4800, 9600, 19200, 38400, 57600 or 115200. Parity may be even, odd, or none. 

The master must know the slave address with which it is going to communicate. No unit operates after a master request if 
the message address is not its own, unless the address is 0, which is the broadcast address. In this case the relay operates, 
but won’t send a reply.

B.2.2.2  B.2.2.2 TCP/IP layer

The rear ethernet or fiber optic ports are used for this connection layer.

The settings for this type of connection are gathered from the Ethernet and MODBUS protocol setpoint menus, where the 
IP addresses and TCP port are configured, among other settings.

B.2.3  Data link layer
Communication is performed in strings, with data groups sent asynchronously. The master/client transmits a string to the 
slave/server and the slave/server responds with another string (except for the case of broadcast communication). For the 
MODBUS serial connection, a timeout or a pause in communication marks the end of a string. The length of this timeout is 
equal to 3 characters, thus it varies depending on the baud rate. 
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The following table shows the generic string format, valid for transmission and reception. However, each function has its 
own particularities, as described later in this manual.

B.2.4  Generic reading
MASTER/CLIENT                                                                                                 SLAVE/SERVER

Request

                                                                                                                             

Reading function 3 or 4: 

+[A]+ +[B]+ +[C]--------------+ +[D]--+ 

    01       04      01 09       00 01         XX XX 

             Data addr. Regs.

Reading function 66: 

+[A]+ +[B]+ +[B1]++[C]--------------+ +[D]--+ 

    01       42         00  01 09    00 01            XX XX 

MODBUS FORMAT

CLIENT ADDRESS
[A]

1 byte Each device in a communications bus must have a unique address to prevent two 
units from responding at the same time to the same request. All relay ports use this 
address, which can be programmed to any value between 1 and 254.
When the master transmits a string with the slave address 0, this indicates that it is a 
Broadcast. Every slave in the communication bus performs the requested action, but 
none of them responds to the master. Broadcast is only accepted for writing since no 
unit responds. 

FUNCTION CODE
[B]

1 byte This is one of the function codes supported by the equipment. The generic function 
codes are 3 and 4 for reading and 16 for writing. Special read function 66 and write 
function 67 are available only for firmware version 7.50 or above.
When the slave responds with an exception to any of these strings, it places to 1 the 
most important bit of the corresponding function. For example, an exception to 
function 3 is indicated with an 83 as function code, and an exception to function 16 
or 0x10 in hexadecimal, is indicated with a 0x90. 

SETTING GROUP SELECTED
[B1]

1byte This part of string format only applies to read function 66 and write function 67 (fw 
7.50 or above).This byte indicates the setting group being read or written. Values 
should are as follow:
0 [Decimal] Setting Group 1
1 [Decimal] Setting Group 2
…
5 [Decimal] Setting Group 6

DATA
[C]

N bytes This section includes a variable number of bytes, depending on the function code. It 
may include: addresses, data length, settings, commands or exception codes sent by 
the client. 

CRC
[D]

2 bytes Two-byte control code. ModBus/RTU includes a 16-bit CRC in each string for error 
detection. If the slave detects a string with errors, based on an incorrect CRC, it 
neither performs an action, nor responds to the master. The CRC order is LSB-MSB.

TIME OUT Required time to 
transmit 3.5 Bytes

A string is finished when nothing is received during a period of 3.5 bytes, with the 
actual time varying depending on baud rate: 
15 ms at 2400 bps 
2 ms at 19200 bps 
300 μs at 115200 bps 
etc.
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                SG       Data addr. Regs.

OK Response

Reading function 3 or 4: 

+[A]+ +[B]+ +[C]------------------------+ +[D]--+ 

  01       04       02    00 08               XX XX 

                         Bytes...Data .....

Reading function 66: 

+[A]+ +[B]+ +[C]------------------------+ +[D]--+

  01       42       02   00 08               XX XX 

                         Bytes...Data ..........

Error Response

R
e

Reading function 3 or 4: 

+[A]+ +[B]+ +[C]------------------------+ +[D]--+ 

  01       84      03        XX XX 

                       Error code...........

Reading function 66: 

+[A]+ +[B]+ +[C]------------------------+ +[D]--+

  01       C2      03           XX XX 

B.2.5  Generic writing
MASTER/CLIENT                                                                                                 SLAVE/SERVER

Request

                                                                                                                             

Writing function 16: 

+[A]+ +[B]+ +[C]--------------------------------+ +[D]--+ 

 01          10        00 87      00 02       04    00 0A 01 02 XX XX

                        Data addr. Regs.     Bytes .......Data.......
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Writing function 67: 

+[A]+ +[B]+ +[B1]++[C]--------------+ +[D]--+ 

    01       43         00  09 C1       00 01     02       00 03           XX XX 

                SG       Data addr. Regs.    Bytes   Data

OK Response

Writing function 16: 

+[A]+ +[B]+ +[C]------------------------------+ +[D]--+ 

  01       10          00 87          00    02          XX XX 

                         Data Addr…....Regs .....

Writing function 67: 

+[A]+ +[B]+ +[C]---------------------------------+ +[D]--+

  01       43           09   C1       00   01               XX XX 

                         Data Addr…....Regs .....

Error Response

Writing function 16: 

+[A]+ +[B]+ +[C]------------------------+ +[D]--+ 

  01       90     07                               XX XX                        

        Error code...........

Writing function 67: 

+[A]+ +[B]+ +[C]------------------------+ -+ +[D]--+

  01       C3      03           XX XX 
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B.2.6  Function codes 

B.2.7  Exception and error responses
The following table shows error codes defined in ModBus protocol:

CODE MODBUS NAME C650 DEFINITION COMMENT
HEX DEC

03 3 Read Holding 
Registers

Reading of any 
value

These functions allow the master to read one or more consecutive relay 
addresses. Registers are always 16-bits long, with the most important byte first. 
The maximum number of registers that can be read in a single package is 125, 
equivalent to 250 bytes. 

04 4 Read Input 
Registers

Reading of any 
value

42 66 Setting Group 
Read

Reading of values 
affected by 
setting groups

This function allows the master to read any setting/actual value that belongs to 
any setting groups, active or not, in one or more consecutive relay addresses. 
Registers are always 16-bits long, with the most important byte first. The 
maximum number of registers that can be read in a single package is 125, 
equivalent to 250 bytes.

10 16 Preset Multiple 
Registers

Writing This function allows the master to write one or more registers, representing one or 
more settings. Registers are 2-byte long values, transmitted with the most 
important byte first. The maximum number of registers that can be written in a 
single package is 125, equivalent to 250 bytes.

43 67 Setting Group 
Write

Writing of values 
affected by 
setting

This function allows the master to write any setting that belongs to any setting 
group, active or not, in one or more consecutive relay addresses. Registers are 
always 16-bits long, with the most important byte first. The maximum number of 
registers that can be written in a single package is 125, equivalent to 250 bytes.

01 ILLEGAL FUNCTION Slave does not support the function code received. 

02 ILLEGAL DATA ADDRESS Master is using an incorrect address. 

03 ILLEGAL DATA VALUE Slave has detected an invalid value. 

04 ILLEGAL RESPONSE LENGTH Response to the master’s request exceeds the maximum size for that function code. 

05 ACKNOWLEDGE Generic acknowledgment.

06 SLAVE DEVICE BUSY Slave is busy and cannot perform the requested operation. 

07 NEGATIVE ACKNOWLEDGE Negative acknowledgment.
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B.3  Data type

TYPE LENGTH DESCRIPTIÓN

F1 1 Boolean data type.
As it is a bit, for evaluating it we need a memory address and a bit. For example: Value 0x1A41-0001101001000001b
Bit 150
Bit 140
Bit 130
Bit 121
Bit 111
Bit 100
Bit 091
Bit 080
Bit 070
Bit 061
Bit 050
Bit 040
Bit 030
Bit 020
Bit 010
Bit 001

F2 2 Integer with 4 bytes sign.
Must be scaled, by multiplying the sent value by 1000, or dividing the received value by 1000. For example, if a value 
of 34509 is received, the converted value is 34.509. To write the value 334, the value 334000 is sent. 
This prevents the loss of accuracy involved in using float values. 
Example: 12312d=0x00003018. 
Real Value = 12312/1000=12.312

F3 2 4-byte Floating
Example: 1240.556 = 0x449B11CB

F4 1 Integer with 2 bytes sign.
Example: 123 = 0x007B

F5 2 Integer without 4 bytes sign.
Example: 12312 = 0x00003018

F6 4 8 bytes Float
Example: 123.324 = 0x405ED4BC6A7EF9DB

F7 1 Characters without sign. As it needs to be sent in a register, i.e. in two bytes, the character goes below.
Example: ‘β’ = 0x00E1

F8 1 Characters with sign As it needs to be sent in a register, i.e. in two bytes, the character goes below.
Example: ‘A’ = 0x0041

F9 16 String. Chain of characters with a fixed length (32 bytes). The end of the string is marked with “\0”.
Example: “ABC” = 0x41x42x43x00....

F10 1 This is a 16-bit integer without sign. Each value that can be taken by this integer has a correspondence in the 
database Auxiliary Table. In this table we can find the corresponding chain, which must be shown for each value. In 
memory, only an integer value is received. 
Example: 0, 1Correspond to CLOSE, OPEN

F11 3 Milliseconds passed since January/1/2000 at 00:00:00.000.

F12 1 Unsigned int 16 bit (enumerated), example: In MODBUS address Ox0EBE is the FAULT TYPE
0=GROUND
1=PHASE
2=3 PH
3=AG
4=ABG
5=AB
6=BG
7=BCG
8=BC
9=CG
10=CAG
11=CA
12=NAF
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B.4  MODBUS data

B.4.1  Data management
The data managed in ModBus differs in size and functionality. Depending on the functionality and importance of certain 
data, the use of ModBus is optimized in time for real time processes, as in the case of events. 

Although some configuration settings, such as GRAPHIC, PLC equations, TEXTS, and ALARM and LED configuration can be 
read and written using ModBus protocol, formats are not shown because they are subject to change. Use the EnerVista 
650 Setup program to manage and format configuration settings.

B.4.2  Writing settings
The process for changing protection functionality usually involves the modification of a group of settings that belong to a 
particular protection function. This guarantees protection functionality and offers versatility for possible legacy programs. 

Writing settings must be performed in two consecutive steps: Writing and Confirmation.

In order to perform this process, the MODBUS master must write the selected settings and then confirm the operation by 
writing a register in the last position of this group. For safety reasons, there is a set time window within which the confirm 
settings modification must be completed. The time window between the last settings being written to confirmation cannot 
exceed 15 seconds.

B.4.3  Snapshot events
In the C650, the NEW EVENTS concept has been extended, providing additional functionality. These are the events created 
after the last request. 

Firmware version 1.60 added reading snapshot events in binary format. Before this version, the relay sent information only 
in ASCII format. 

SNAPSHOT EVENT READING IN ASCII FORMAT

1.  Write a message to the ‘0xfe00’ address, including the file name to open:

“EVE .TXT”:          to read all events.

“NEW_EVE.TXT": to read events created from the last request of this same file.

“EVE0234 .TXT “: to read events starting, for example, from event number 234.

2. Subsequent messages read the 0xff00 address, in blocks of 250 bytes (4 bytes that indicate the point value to the 
file, 2 bytes that indicate the number of data bytes sent, and 244 data bytes). If the number of data bytes sent is lower 
than 244, this indicates that it is the last message.

If during this process there is an error response, the request can be repeated in address 0xff02 reading 246 bytes (2
bytes that indicate the number of bytes sent, and 244 data bytes).

In the second step, many BUSY responses may be produced, because an ASCII file is being created internally. 

SNAPSHOT EVENT READING IN BINARY FORMAT:

1.  Write a message to the ‘0xfe00’ address, including the file name to open:

“EVE .BIN”:          to read all events.

“NEW_EVE.BIN": to read events created from the last request of this same file.

“EVE0234 .BIN “: to read events starting, for example, from event number 234.

2. Subsequent messages read the 0xff00 address, in blocks of 250 bytes (4 bytes that indicate the point value to the 
file, 2 bytes that indicate the number of data bytes sent, and 244 data bytes). If the number of data bytes sent is lower 
than 244, this indicates that it is the last message.
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If during this process there is an error response, the request can be repeated in address 0xff02 reading 246 bytes (2
bytes that indicate the number of bytes sent, and 244 data bytes).

Each Snapshot event includes:

1st byte: Event format code.

N bytes: Event information structured depending on the code

There is only one format type with code 0. Its structure is as follows:

• UINT16: Event handle.

• 8 bytes: Event date and time.

• 29 bytes: Event cause. (string end in null).

• UINT32: Phasor Ia (scaled to 1000).

• UINT32: Phasor Ib (scaled to 1000). 

• UINT32: Phasor Ic (scaled to 1000).  

• UINT32: Line Frequency (scaled to 1000). 

• UINT32: Phasor Ig (scaled to 1000). 

• UINT32: Phasor Isg (scaled to 1000). 

• UINT32: Zero seq I0 (scaled to 1000). 

• UINT32: Positive seq I1 (scaled to 1000). 

• UINT32: Negative seq I2 (scaled to 1000). 

• UINT32: Phasor Van (scaled to 1000). 

• UINT32: Phasor Vbn (scaled to 1000). 

• UINT32: Phasor Vcn (scaled to 1000). 

• UINT32: Positive Seq V1 (scaled to 1000). 

• UINT32: Negative Seq V2 (scaled to 1000). 

• UINT32: Zero Seq V0 (scaled to 1000). 

• UINT32: 3 Phase Power Factor (scaled to 1000). 

For C650 models, the analog data is set to zero. The structure remains the same as other 650 devices but with no data as 
the C650 units do not have a magnetic module option.

Example:

1st step:

 [0xFE 0x10 0xFE 0x00 0x00 0x06 0x0C 0x4E 0x45 0x57 0x5F 0x45 0x56 0x45 0x2E 0x54 0x58 0x54 0x00 0x16 0xB0] -------
-> RELAY

PC <--------- [0xFE 0x10 0xFE 0x00 0x00 0x06 0x65 0xEC]

2nd step:

[0xFE 0x03 0xFF 0x00 0x00 0x7D 0xA1 0xF0] --------> RELAY

The relay responds with “SLAVE DEVICE BUSY”:

PC <--------- 0xFE 0x83 0x06 0xF1 0x02]    

The request is repeated:

 [0xFE 0x03 0xFF 0x00 0x00 0x7D 0xA1 0xF0] --------> RELAY

Now the relay sends the events format:

[A] Position within file (Unsigned 32 bits)

[B] Block size (Unsigned 16 bits)
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PC --------- [0xFE 0x03 0xFA 0x00 0x00 0x00 0x00 0x00 0xF4 0x46 0x4F 0x52 0x4D 0x41 

                                                   .............[A]..............  .....[B]......    F      O      R      M       A

0x54 0x2C 0x45 0x56 0x45 0x4E 0x54 0x5F 0x46 0x36 0x35 0x30 0x5F 0x56 0x30 

  T      ,         E       V      E      N       T      _       F       6      5       0       _       V      0    

0x30 0x2C 0x45 0x76 0x65 0x6E 0x74 0x20 0x4E 0x75 0x6D 0x2C 0x44 0x61 0x74 

  0       ,        E       v       e       n        t                 N       u      m      ,         D      a        t 

0x65 0x2F 0x54 0x69 0x6D 0x65 0x3C 0x48 0x65 0x78 0x3E 0x2C 0x43 0x61 0x75 

  e        /       T       i        m       e     . . . etc . . .

0x73 0x65 0x2C 0x50 0x68 0x61 0x73 0x6F 0x72 0x20 0x49 0x61 0x2C 0x50 0x68 0x61 0x73 0x6F 0x72 0x20 0x49 0x62 
0x2C 0x50 0x68 0x61 0x73 0x6F 0x72 0x20 0x49 0x63 0x2C 0x4C 0x69 0x6E 0x65 0x20 0x46 0x72 0x65 0x71 0x75 0x65 
0x6E 0x63 0x79 0x2C 0x50 0x68 0x61 0x73 0x6F 0x72 0x20 0x49 0x67 0x2C 0x50 0x68 0x61 0x73 0x6F 0x72 0x20 0x49 
0x73 0x67 0x2C 0x5A 0x65 0x72 0x6F 0x20 0x73 0x65 0x71 0x20 0x49 0x30 0x2C 0x50 0x6F 0x73 0x69 0x74 0x69 0x76 
0x65 0x20 0x53 0x65 0x71 0x20 0x49 0x31 0x2C 0x4E 0x65 0x67 0x61 0x74 0x69 0x76 0x65 0x20 0x53 0x65 0x71 0x20 
0x49 0x32 0x2C 0x50 0x68 0x61 0x73 0x6F 0x72 0x20 0x56 0x61 0x6E 0x2C 0x50 0x68 0x61 0x73 0x6F 0x72 0x20 0x56 
0x62 0x6E 0x2C 0x50 0x68 0x61 0x73 0x6F 0x72 0x20 0x56 0x63 0x6E 0x2C 0x50 0x6F 0x73 0x69 0x74 0x69 0x76 0x65 
0x20 0x53 0x65 0x71 0x20 0x56 0x31 0x2C 0x4E 0x65 0x67 0x61 0x74 0x69 0x76 0x65 0x20 0x53 0x65 0x71 0x20 0x56 
0x32 0x2C 0x5A 0x65 0x72 0x6F 0x20 0x53 0x65 0x71 0x20 0x56 0x30 0x2C 0x33 0x20 0x50 0x68 0x4C 0xF3]

[0xFE 0x03 0xFF 0x00 0x00 0x7D 0xA1 0xF0] ---------> RELAY

PC <--------- [0xFE 0x03 0xFA 0x00 0x00 0x00 0xF4 0x00 0xF4 0x61 0x73 0x65 0x20 0x50 0x6F                                                     

0x77 0x65 0x72 0x20 0x46 0x61 0x63 0x74 0x6F 0x72 0x0D 0x0A 

                                                                                          CR     LF      (here the format ends)

 0x45 0x56 0x45 0x4E 0x54 0x5F 0x46 0x36 0x35 0x30 0x5F 0x56 0x30 0x30 0x2C 0x35 0x36 0x35

   E      V       E     N       T       _       F      6       5      0        _        V     0        0       ,         5       6       5

0 x37 0x2C 0x30 0x30 0x30 0x30 0x30 0x30 0x31 0x36 0x66 0x63 0x39 0x38 0x66 

   7        ,        0         0         0    0       0       0       1      6        f        3      9        8      f

0x34 0x33 0x39 0x2C 0x4C 0x6F 0x63 0x61 0x6C 0x20 0x6D 0x6F 0x64 0x65 0x2C 

  4       3       9      ,         l        o       c      a       l                 m       o      d       e        ,

0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 

....

0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 
0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x32 
0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x32 0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 
0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x31 0x2E 0x30 0x30 0x30 0x0D 0x0A

 CR     LF  (a line ends)

 0x45 0x56 0x45 0x4E 0x54 0x5F 0x46 0x36 0x35 0x30 0x5F 0x56 0x30 0x30 0x2C 0x35 0x36 0x35 0x38 0x2C 0x30 0x30 
0x30 0x30 0x30 0x30 0x31 0x36 0x66 0x63 0x39 0x38 0x66 0x34 0x33 0x39 0x2C 0x28 0x31 0x29 0x56 0x69 0x72 0x74 
0x75 0x61 0x6C 0x20 0x4F 0x75 0x74 0x38 0x39 0x36 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x31 
0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x34 0x24]

 [0xFE 0x03 0xFF 0x00 0x00 0x7D 0xA1 0xF0] ---------> RELAY

PC <---------[0xFE 0x03 0xFA 0x00 0x00 0x01 0xE8 0x00 0x47 0x30  0x0047 => last string
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0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 
0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x32 0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x32 
0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x31 0x2E 0x30 
0x30 0x30 0x0D 0x0A

                                                                         CR     LF  (a line ends)

0x00 0x00 0x30 0x0D 0x0A 0x45 0x56 0x45 0x4E 0x54 0x5F 0x46 0x36 0x35 0x30 0x5F 0x56 0x30 0x30 0x2C 0x33 0x30 
0x39 0x38 0x2C 0x30 0x30 0x30 0x30 0x30 0x30 0x31 0x36 0x65 0x62 0x61 0x33 0x33 0x62 0x62 0x38 0x2C 0x43 0x6F 
0x6E 0x74 0x61 0x63 0x74 0x20 0x4F 0x75 0x74 0x70 0x75 0x74 0x5F 0x30 0x30 0x5F 0x30 0x30 0x20 0x4F 0x4E 0x2C 
0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 
0x30 0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 
0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 0x32 0x2C 
0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x30 0x2C 0x30 0x2E 0x30 0x30 0x31 0x2C 0x30 0x2E 0x30 0x30 
0x30 0x2C 0x31 0x2E 0x30 0x30 0x30 0x0D 0x0A 0x45 0x56 0x45 0x4E 0x54 0x5F 0x46 0x36 0x35 0x30 0xDB 0xB4]

B.4.4  Operations
To execute an operation, write the bit corresponding to that operation. For this purpose, there are two memory records 
with bits representing operations. These records are 0xAFFE and 0xAFFF.

Each operation is assigned one bit in the register:

Operation 1: bit 0  ‘0xaffe’

Operation 2: bit 1‘0xaffe’

...

Operation 16: bit 15‘0xaffe’

Operation 17: bit 0‘0xafff’

...

Operation 24: bit 7‘0xafff’

The register format is Big Endian; this means that the first byte arriving is the one with more weight. Operations commands 
are affected depending on the physical communication channel they use: serial port, ethernet ports, mmi, etc.

Refer to section 4.2.3.1 Command push button on page  4–42.

The operations channels are: 

0 - MMI

1 - OPER REMOTE     

2 - COM 1- COMMUNICATION

3 - COM 2- COMMUNICATION

4 - RED 1- COMMUNICATION

5 - RED 2- COMMUNICATION

6 - RED 3- COMMUNICATION

7 - RED 4- COMMUNICATION

Example, operation 1 is going to perform:

 [0xFE 0x10 0xAF 0xFE 0x00 0x01 0x02 0x00 0x01 0x68 0xB0] ---------> RELAY

PC <--------- [0xFE 0x10 0xAF 0xFE 0x00 0x01 0x55 0x22]   (ACK (acknowledge) the operation)
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B.4.5  Force outputs of IO boards

To ease and test IO boards' outputs physical wiring, each IO boards' contact outputs can be forced to actuate with this 
MODBUS command. Proceed as with a file access (open, write, and close).

For example, to write to a mixed board (16 inputs and 8 outputs):

1 - OPEN OUTPUT FILE: write to 0xFE20, 3 registers with the name OUTPUT

2 - WRITE TO FILE: write to 0xFF20, 5 REGISTERS, the first one is the board slot (F=0, G=1, H=2, J=3 and so on) and the
restraint ones are the bytes of bits (bits are grouped byte to byte).

3 - CLOSE OUTPUT FILE: write msg to 0xFE 28 of 3 registers with the name OUTPUT

Example, activate the two lower relays to board ‘0’:

1 Open:

 [0xFE 0x10 0xFE 0x20 0x00 0x03 0x06 0x4F 0x55 0x54 0x50 0x55 0x54 0xA8 0x42] ---------> RELAY

O      U       T      P      U       T
PC <---------[0xFE 0x10 0xFE 0x20 0x00 0x03 0xA4 0x25]

2 Write:

[0xFE 0x10 0xFF 0x20 0x00 0x05 0x0A 0x00 0x00 0x03 0x00 0x00 0x00 0x00 0x00 0x00 0x00

                                                                   0x0000      0x03

0xAE 0x8D] ---------> RELAY

PC <--------- [0xFE 0x10 0xFF 0x20 0x00 0x05 0x25 0xDB]

3 Close:
 [0xFE 0x10 0xFE 0x28 0x00 0x03 0x06 0x4F 0x55 0x54 0x50 0x55 0x54 0x29 0xA8] ---------> RELAY
PC <--------- [0xFE 0x10 0xFE 0x28 0x00 0x03 0x25 0xE7]

B.4.6  Control events
This section explains control events, not to be confused with the snapshot events. A control event is the value change from 
0 to 1 or from 1 to 0 of one bit, and is associated with a time label showing when the change occurred.

In the C650, any status or combination of status may generate an event. The C650 has 192 control events available. The 
first 128 control events are user-configurable through a table from the EnerVista 650 Setup menu: Setpoint > Relay 
configuration. The remaining 64 control events are associated with the 16 possible switchgear, each one generating 4 
status bits: 

- Open (52B ON, 52A OFF)

- Close (52A ON, 52B OFF)

- Error 00 (52A&52B OFF)

- Error 11 (52A&52B ON)

Internally the events buffer is a circular FIFO of 255 events. The addresses for managing this FIFO are:

- 0x03FF: Number of the next event

- 0xFCFF: Access to the oldest event

- 0xFD00 to 0xFDFF: Access to any stored event (circular queue)



APPENDIX B:  MODBUS PROTOCOL B.4 MODBUS DATA

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM B-13

The address 0x03FF stores the number of the next event. For example, if the number 7677 is stored, the last event stored is 
number 7676. This value is initially 0, and it is increases from 0 to 2^12 + 1 carry bit as events are generated.

The carry bit indicates whether the C650 has been started, since when the relay starts, whether due to lack of power 
supply or a configuration change, the carry bit is set to 0. When events are generated, the event number is increased up to 
a maximum value of 0x1FFF; in the next event the number is 0x1000, thus the carry bit is always 1, until the C650 is 
restarted. This is shown in the following figure:

B.4.6.1  Event structure

Each event has 14 bytes, with the following format:

- Short (2 bytes): event number (0 - 2^12 + carry bit)

- Short (2 bytes): event bit number (from 0 to 191).

- Short (2 bytes): the 0 bit indicates the event value (0 or 1) and the 15 bit indicates whether this is a
valid event (all events are initially set to 0)

- Double unsigned (8 bytes): milliseconds from 1 January 2000

The 0xFCFF address is useful when reading all the available events in the C650, as is done following a master start up.

WARNING! Unlike a standard ModBus address, these addresses consist of 14 bytes each one, instead of the 2 used in 
ModBus. This way, each event, which has a structure of 14 bytes, is contained in one address, as shown on the table below:

For example, the events buffer could contain the following information:

105 registers: 15 events * 7 registers.

NOTE: In this example the 0x03FF address has event number 7677 because 7676 was the last event number used.

0xFD00 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte
............
0xFDFF 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte 1byte

Event 
Number

7424 7425 .......... 7675 7676 7421 7422 7423

Address 0xFD00 0xFD01 0xFDFB 0xFDFC 0xFDFD 0xFDFE 0xFDFF
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B.4.6.2  Event collection process 

ALL EVENTS

When reading all events, there are two possible approaches:

First option: start from the oldest event, in address 0xFCFF, and read the events 15 by 15. The initial request frame sent to 
the relay is as follows:

Within this frame the buffer pointer is set to the oldest event, or number 7421 in the example. 15 events are returned, 
ending with number 7435.

In order to read the following 15 events, numbered from 7436 to 7450, calculate the initial address and send another 
request frame:

Hex(7436)= 0x1D0C

0x1D0C AND 0x00FF= 0xOC

0xFD00+0x0C= 0xFD0C: initial address

[0xFE 0x03 0xFD 0x0C 0x00 0x69 0x60 0x44] ---------> RELAY

Either continue until the relay responds with a 0 event, or stop at the last recorded event by reading the number of the next 
upcoming event from address 0x03FF and comparing against the last event read.

Second option: read the circular event queue directly, from address 0xFD00 to 0xFDFF, and then rearrange the retrieved 
events by event number.

Once all events have been read, subsequent queries should only request new events.

NEW EVENTS

The 0x03FF address contains the number of the next event to be written. Based on this, the number of events recorded 
since the last query can be determined.For example, if the relay indicates that the next event to be generated is number 
7677 and events up to number 7674 have already been read, there are two new events. A frame must be sent to read the 
two new events, 7675 and 7676, and the corresponding 28 bytes.

NOTE: In this example the 0x03FF address has event number 7677 because 7676 was the last event number used.

Hex(7675)=0x1DFB

0x1DFB AND 0xFF=0xFB

0xFD00+0xFB=0xFDFB: reading address (*)

[0xFE 0x03 0xFD 0xFB 0x00 0x0E 0x90 0x5C] ---------> RELAY

Event 
Number

7424 7425 .......... 7675 7676 7421 7422 7423

Address 0xFD00 0xFD01 0xFDFB 0xFDFC 0xFDFD 0xFDFE 0xFDFF



APPENDIX B:  MODBUS PROTOCOL B.4 MODBUS DATA

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM B-15

B.4.6.3  Control events from the command line 

Starting EnerVista 650 Setup from the command line allows the transfer of control events to a file. For this purpose, we 
need to indicate the event number from which event controls are to be retrieved, and the file where they are to be stored.

Communication can be established via serial communication by specifying the port and access baud rate, or via Ethernet 
through the IP address and communication port. The relay number from which events are to be retrieved must also be 
indicated.

For executing this Operation, 6 parameters must be written, for both cases, serial communication or Ethernet.

SERIAL COMUNICATION

EnerVista 650 Setup –e event number " File name" –com port: baud_rate relay_number

E.g.: EnerVista 650 Setup –e 6 “C:\GE Power Management\EnerVista 650 Setup\files\Events\eventos.txt” –com 1:19200 254

ETHERNET COMMUNICATION

EnerVista 650 Setup –e event number " File name" –ip “IP address”: port relay_number

E.g.: EnerVista 650 Setup –e 6 “C:\GE Power Management\EnerVista 650 Setup\files\Events \eventos.txt” –ip 
192.168.37.240:502 254

The created file format looks as follows:

#Event Number, Event Id,Event Text,Event Data Time,Event Value(0,1)#

6,1,Local,09-Sep-2003 17:42:40.782,1

7,1,Local,09-Sep-2003 17:42:43.236,0

8,2,Remote,09-Sep-2003 17:42:43.236,1

B.4.6.4  Event status request (alarms)

To retrieve events that have been configured as alarms, see the following addresses:

0xF000: 24 registers, the first 12 indicate the status active/inactive and the last 12 indicate the status of
acknowledged/not acknowledged.

0xF018: 12 event alarm status (active - not active, acknowledged – not acknowledged) registers.

0xF024: date and hour of the event bits starts (groups of 16 dates and hour must be asked for).

To obtain an instantaneous snapshot of all events and alarms states, do the following:

1. Read the head of events FIFO (0x03FF).

2. Read the addresses above.

3. Finally, read the head again to confirm that it has not changed. If it had changed, restart the procedure.

NOTE: The message must request the address and the quantity of bytes indicated in each zone. If another quantity is 
needed, it will not respond with the requested data.

B.4.6.5  Acknowledging alarms

For acknowledging the alarms we must simply write message to the 0xf324 address with 12 data registers. Each bit 
means an event, if we want to acknowledge an alarm, its corresponding bit must be set to ‘1’ (in order within the 192 bits). 

NOTE: it must be borne in mind the independence of the acknowledgement condition, for its reading and its change, 
depending on the communication channel 

There are 6 channels:

LOCAL: by MMI or COM-2 (front and rear accessible port).
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REMOTE: by COM-1

NET 1: nowadays by any net communication

NET 2: (it does not exist in version 1.4x and lower)

NET 3: (it does not exist in version 1.4x and lower)

NET 4: (it does not exist in version 1.4x and lower)

B.4.7  Write virtual inputs
For forcing Virtual Inputs, a message with 4 indivisible records must be written at address 0xF430, so that each bit 
corresponds to a Virtual Input. Values are not correct if the first 4 records are not written in the same message. The first 32 
are LATCHED (internally stored in flash memory), and the last 32 are SELF-RST (activated to 1 and deactivated in the next 
pass by the PLC).

For reading the status of Virtual Inputs, it is necessary to start with address 0x0083(bit 0x004) up to 0x0087 (bit 0x0200).

B.4.8  User map
C650 units incorporate a powerful feature called ModBus User Map, that allows to read 256 non-consecutive data records 
(settings and statuses). It is often required for a master computer to interrogate repeatedly several connected slave relays. 
If those values are dispersed along the memory map, reading them may require several petitions, and this may cause a 
communications overload. The User Map can be programmed to get several memory addresses together in a block of 
consecutive addresses of the User Map, so that they can be accessible with a single reading operation.

The User Map has two sections:

A record index area (addresses 0x3384 to 0x3483), containing 256 statuses and/or setting record addresses.

A record area (addresses 0xF330 to 0xF42F), containing the values for addresses indicated in the index area.

Data records that are separated in the rest of the memory map can be remapped to an address of an adjacent record in 
the User Map area. For programming the map this way, addresses for the required records must be written in the index 
area. This avoids the need for several reading operations, thus improving data transmission yield.

For instance, if Contact Outputs from Board F (address 0x008B) and Board G (address 0x00B0) values are required, these 
addresses must be mapped as follows:

In address 0x3384, write 0x008B.

In address 0x3385 XXX write 0x00B0.

The reading of records 0xF330 and 0xF331, applying the corresponding bit masks, provides the required information about 
the two boards Contact Outputs. 

NOTE: Only single data can be set in the map, i.e. data that are in the memory map and can be read. This feature is not 
valid for events, waveform records, etc. that are not located in a map address.

B.4.9  Retrieve oscillography
For firmware versions below 7.xx, in case of not using the quickest download method by TFTP, ModBus can be used for 
downloading oscillography, in the same way that events (snap-shots). First of all, open file with writing message in 0xfe40, 
where desired file to open is indicated, it can be: 

OSC01.DAT (COMTRADE data file in binary)

OSC02.CFG (COMTRADE configuration file)

OSC01.HDR (COMTRADE header file)

OSC02.DAT

OSC02.HDR

...
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For reading the oscillography in several strings, several reading requests must be sent to 0xff40 address. For reading the 
previous message a reading petition must be sent to 0xff42 address. The maximum number of bytes to be read in each 
part is 244. 

Note: For firmware versions 7.xx and above, this feature is not available.

B.4.10  Time synchronization
Time synchronization consists of setting the relay date and time. 

This is similar to other settings group entries, with some unique characteristics: 

- The data type is specific to time.

- Once the data is changed, varies with time, it is a changing setting that can be read. 

- It shares the time change with IRIG-B (this has more priority) and with a possible modification from MMI or another
protocols. 

- When the relay is disconnected from its auxiliary power supply for extended periods (days) the time remains in a
chip, fed by a capacitor (it does not need maintenance). 

- And last, there are synchronism between the real time chip and the microprocessor time. 

Time synchronization is made by a reading message over 0xfff0 address, either with the address of a single relay, if a 
writing confirmation is desired, or in broadcast, to synchronize several relays simultaneously.

Date/time format is stored in 4 MODBUS registers (8 bytes, Big Endian format), which indicates elapsed milliseconds from 
the 1st of January 2000 at 00:00:00.000.

Reading example:

 [0xFE 0x03 0xFF 0xF0 0x00 0x04 0x60 0x21] ---------> RELAY

PC <---------- [0xFE 0x03 0x08 0x00 0x00 0x00 0x17 0x05 0xFA 0xD5 0xBA 0x2D 0x1D]

Synchronism example:

 [0xFE 0x10 0xFF 0xF0 0x00 0x04 0x08 0x00 0x00 0x00 0x17 0x9B 0x53 0x3F 0x60 0xA4 0x2B] ---------> RELAY

PC <---------- [0xFE 0x10 0xFF 0xF0 0x00 0x04 0xE5 0xE2]

B.4.11  Queuing messages 
In ModBus protocol, as in other protocols, exists an internal procedure in message reception and transmission. 

When a relay gets a string, determined by a silence of 3 or 4 characters, it is queued in a FIFO queue, for a later processing 
in its own protocol. When the protocol is free of execution, it searches in the queue for strings to respond of the FIFO. If 
there is such string, it processes it and then it is responded. 

Several criteria have been adopted for real time operation:

- Each reading or writing is answered as soon as possible.

- This implies that when settings are changed and answered, a writing request recognition is indicated and then, the
modification of internal settings is performed, and finally, after confirmation is sent, settings are stored in a non-
volatile memory device. 

NOTE: As the relay is internally a modular system, it is possible that the response of some processes is slower than what is 
expected by the external program, considering the message as missed and sending again another request. If so, there will 
be 2 queued messages and therefore, 2 message responses. For this reason, response message ‘ACK’ must be verified 
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with its request, and special attention must be paid to setting confirmation writings, especially with reference to time-out. 
EnerVista 650 Setup software is recommended to do the configuration modifications, as this software takes into account 
all these details. 

B.4.12  Traces and troubleshooting
The tracer is a debugging tool to view the strings in any writing or reading process in ModBus. This tracer is activated in the 
menu from EnerVista 650 Setup: View, Traces.

With this option enabled, request and response strings are shown. If, for instance, the request and response strings view is 
desired, between C650 and the relay, do the following: 

1 - Activate traces, from View > Traces, and a new window opens at the bottom of the main window.

2 - Open the general settings menu: Setpoint > System Setup > General Settings

The screen displays the group settings, and on the left side bottom the relay read request is shown:

<0001><06/18/03 12:14:15>[0xFE 0x03 0x21 0x8A 0x00 0x16 0xFB 0xDD]

On the right the settings response is shown: 

0001><06/18/03 12:14:15>[0xFE 0x03 0x2C 0x3F 0x80 0x00 0x00 0x3F 0x80 0x00 0x00 0x3F 0x80 0x00 0x00 0x3F
0x80 0x00 0x00 0x00 0x00 0x42 0xC8 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x01 0x00 0xFE
0x00 0xFE 0x00 0x06 0x00 0x06 0x00 0x00 0x01 0xF6 0xAC 0xB5]

This way, any request or mechanism to obtain information from the relay can be viewed string by string.

There is another tool for tracing the relay memory: in the EnerVista 650 Setup menu: Communication > Troubleshooting, 
any read of any address can be requested, and the PC forms the request string together with the check-sum register. 

B.4.13  MODBUS CRC generation function
This section describes the C programming language implementation to calculate the CRC of the message string check in 
ModBus, in a Big-Endian format.

The implemented function in the C650 called here fn_035c_cr16 returns an unsigned 16 bit type (2 bytes) with the CRC of 
the message defined in the function parameters as:

p = pointer to the MODBUS message string to calculate the CRC

us = length in bytes of the MODBUS message (header + data) minus 2 bytes (the CRC of the message itself)

USHORT fn_035c_cr16(UCHAR *p, UNSIGNED us)

{    
const UCHAR hi[] = {
0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,0X1,0Xc0,
0X80,0X41,0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,
0X0,0Xc1,0X81,0X40,0X0,0Xc1,0X81,0X40,0X1,0Xc0,
0X80,0X41,0X1,0Xc0,0X80,0X41,0X0,0Xc1,0X81,0X40,
0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,0X0,0Xc1,
0X81,0X40,0X1,0Xc0,0X80,0X41,0X1,0Xc0,0X80,0X41,
0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,0X0,0Xc1,
0X81,0X40,0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,
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0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,0X1,0Xc0,
0X80,0X41,0X0,0Xc1,0X81,0X40,0X0,0Xc1,0X81,0X40,
0X1,0Xc0,0X80,0X41,0X1,0Xc0,0X80,0X41,0X0,0Xc1,
0X81,0X40,0X1,0Xc0,0X80,0X41,0X0,0Xc1,0X81,0X40,
0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,0X1,0Xc0,
0X80,0X41,0X0,0Xc1,0X81,0X40,0X0,0Xc1,0X81,0X40,
0X1,0Xc0,0X80,0X41,0X0,0Xc1,0X81,0X40,0X1,0Xc0,
0X80,0X41,0X1,0Xc0,0X80,0X41,0X0,0Xc1,0X81,0X40,
0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,0X1,0Xc0,
0X80,0X41,0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,
0X0,0Xc1,0X81,0X40,0X0,0Xc1,0X81,0X40,0X1,0Xc0,
0X80,0X41,0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,
0X1,0Xc0,0X80,0X41,0X0,0Xc1,0X81,0X40,0X1,0Xc0,
0X80,0X41,0X0,0Xc1,0X81,0X40,0X0,0Xc1,0X81,0X40,
0X1,0Xc0,0X80,0X41,0X1,0Xc0,0X80,0X41,0X0,0Xc1,
0X81,0X40,0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,
0X0,0Xc1,0X81,0X40,0X1,0Xc0,0X80,0X41,0X1,0Xc0,
0X80,0X41,0X0,0Xc1,0X81,0X40};

const UCHAR lo[] = {
0X0,0Xc0,0Xc1,0X1,0Xc3,0X3,0X2,0Xc2,0Xc6,0X6,
0X7,0Xc7,0X5,0Xc5,0Xc4,0X4,0Xcc,0Xc,0Xd,0Xcd,
0Xf,0Xcf,0Xce,0Xe,0Xa,0Xca,0Xcb,0Xb,0Xc9,0X9,
0X8,0Xc8,0Xd8,0X18,0X19,0Xd9,0X1b,0Xdb,0Xda,0X1a,
0X1e,0Xde,0Xdf,0X1f,0Xdd,0X1d,0X1c,0Xdc,0X14,0Xd4,
0Xd5,0X15,0Xd7,0X17,0X16,0Xd6,0Xd2,0X12,0X13,0Xd3,
0X11,0Xd1,0Xd0,0X10,0Xf0,0X30,0X31,0Xf1,0X33,0Xf3,
0Xf2,0X32,0X36,0Xf6,0Xf7,0X37,0Xf5,0X35,0X34,0Xf4,
0X3c,0Xfc,0Xfd,0X3d,0Xff,0X3f,0X3e,0Xfe,0Xfa,0X3a,
0X3b,0Xfb,0X39,0Xf9,0Xf8,0X38,0X28,0Xe8,0Xe9,0X29,
0Xeb,0X2b,0X2a,0Xea,0Xee,0X2e,0X2f,0Xef,0X2d,0Xed,
0Xec,0X2c,0Xe4,0X24,0X25,0Xe5,0X27,0Xe7,0Xe6,0X26,
0X22,0Xe2,0Xe3,0X23,0Xe1,0X21,0X20,0Xe0,0Xa0,0X60,
0X61,0Xa1,0X63,0Xa3,0Xa2,0X62,0X66,0Xa6,0Xa7,0X67,
0Xa5,0X65,0X64,0Xa4,0X6c,0Xac,0Xad,0X6d,0Xaf,0X6f,
0X6e,0Xae,0Xaa,0X6a,0X6b,0Xab,0X69,0Xa9,0Xa8,0X68,
0X78,0Xb8,0Xb9,0X79,0Xbb,0X7b,0X7a,0Xba,0Xbe,0X7e,
0X7f,0Xbf,0X7d,0Xbd,0Xbc,0X7c,0Xb4,0X74,0X75,0Xb5,
0X77,0Xb7,0Xb6,0X76,0X72,0Xb2,0Xb3,0X73,0Xb1,0X71,
0X70,0Xb0,0X50,0X90,0X91,0X51,0X93,0X53,0X52,0X92,
0X96,0X56,0X57,0X97,0X55,0X95,0X94,0X54,0X9c,0X5c,
0X5d,0X9d,0X5f,0X9f,0X9e,0X5e,0X5a,0X9a,0X9b,0X5b,
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0X99,0X59,0X58,0X98,0X88,0X48,0X49,0X89,0X4b,0X8b,
0X8a,0X4a,0X4e,0X8e,0X8f,0X4f,0X8d,0X4d,0X4c,0X8c,
0X44,0X84,0X85,0X45,0X87,0X47,0X46,0X86,0X82,0X42,
0X43,0X83,0X41,0X81,0X80,0X40 };

    UCHAR chi; 
    UCHAR clo; 
    USHORT ui;

    chi = 0xff; 
    clo = 0xff;
    while(us--)
    {   ui = chi ^ *p++;
    chi = clo ^ hi[ui];
    clo = lo[ui];
    }   
    ui = chi; 
    ui = ui << 8; 
    ui = ui | clo;      // Big-Endian format
    
    return(ui);
}
If it is Little-Endian format the returned bytes must be interchanged: each unsigned 16 bit type's bytes need to be 
swapped.
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B.5  Memory map

The Memory map can be obtained from EnerVista 650 Setup software, menu:

View > ModBus Memory map
ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS

Estado CPU - CPU Status

0x0003 0x0100 TIMER STATUS F001  R 1  

0x0003 0x0200 E2PROM STATUS F001  R 1  

Salidas Virtuales (512 elementos) - Virtual Outputs

0x0005 0x0400 VIRTUAL OUTPUT 000 F001  R 1  

0x0005 0x0800 VIRTUAL OUTPUT 001 F001  R 1  

... ... ... ... ... ... ... ...

0x0025 0x0200 VIRTUAL OUTPUT 511 F001  R 1  

Salidas virtuales analógicas- Virtual Output Analog

0x07D0 INT32_000 F005 1.000 R 2

0x07D2 INT32_001 F005 1.000 R 2

0x07D4 INT32_002 F005 1.000 R 2

0x07D6 INT32_003 F005 1.000 R 2

0x07D8 INT32_004 F005 1.000 R 2

0x07DA INT32_005 F005 1.000 R 2

0x07DC INT32_006 F005 1.000 R 2

0x07DE INT32_007 F005 1.000 R 2

0x07E0 INT32_008 F005 1.000 R 2

0x07E2 INT32_009 F005 1.000 R 2

0x07E4 INT32_010 F005 1.000 R 2

0x07E6 INT32_011 F005 1.000 R 2

0x07E8 INT32_012 F005 1.000 R 2

0x07EA INT32_013 F005 1.000 R 2

0x07EC INT32_014 F005 1.000 R 2

0x07EE INT32_015 F005 1.000 R 2

0x07F0 INT32_016 F005 1.000 R 2

0x07F2 INT32_017 F005 1.000 R 2

0x07F4 INT32_018 F005 1.000 R 2

0x07F6 INT32_019 F005 1.000 R 2

0x07F8 INT32_020 F005 1.000 R 2

0x07FA INT32_021 F005 1.000 R 2

0x07FC INT32_022 F005 1.000 R 2

0x07FE INT32_023 F005 1.000 R 2

0x0800 INT32_024 F005 1.000 R 2

0x0802 INT32_025 F005 1.000 R 2

0x0804 INT32_026 F005 1.000 R 2

0x0806 INT32_027 F005 1.000 R 2

0x0808 INT32_028 F005 1.000 R 2

0x080A INT32_029 F005 1.000 R 2

0x080C INT32_030 F005 1.000 R 2

0x080E INT32_031 F005 1.000 R 2

0x0810 INT32_032 F005 1.000 R 2

0x0812 INT32_033 F005 1.000 R 2
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0x0814 INT32_034 F005 1.000 R 2

0x0816 INT32_035 F005 1.000 R 2

0x0818 INT32_036 F005 1.000 R 2

0x081A INT32_037 F005 1.000 R 2

0x081C INT32_038 F005 1.000 R 2

0x081E INT32_039 F005 1.000 R 2

0x0820 INT32_040 F005 1.000 R 2

0x0822 INT32_041 F005 1.000 R 2

0x0824 INT32_042 F005 1.000 R 2

0x0826 INT32_043 F005 1.000 R 2

0x0828 INT32_044 F005 1.000 R 2

0x082A INT32_045 F005 1.000 R 2

0x082C INT32_046 F005 1.000 R 2

0x082E INT32_047 F005 1.000 R 2

0x0830 INT32_048 F005 1.000 R 2

0x0832 INT32_049 F005 1.000 R 2

0x0834 FLT32_000 F003 1.000 R 2

0x0836 FLT32_001 F003 1.000 R 2

0x0838 FLT32_002 F003 1.000 R 2

0x083A FLT32_003 F003 1.000 R 2

0x083C FLT32_004 F003 1.000 R 2

0x083E FLT32_005 F003 1.000 R 2

0x0840 FLT32_006 F003 1.000 R 2

0x0842 FLT32_007 F003 1.000 R 2

0x0844 FLT32_008 F003 1.000 R 2

0x0846 FLT32_009 F003 1.000 R 2

0x0848 FLT32_010 F003 1.000 R 2

0x084A FLT32_011 F003 1.000 R 2

0x084C FLT32_012 F003 1.000 R 2

0x084E FLT32_013 F003 1.000 R 2

0x0850 FLT32_014 F003 1.000 R 2

0x0852 FLT32_015 F003 1.000 R 2

0x0854 FLT32_016 F003 1.000 R 2

0x0856 FLT32_017 F003 1.000 R 2

0x0858 FLT32_018 F003 1.000 R 2

0x085A FLT32_019 F003 1.000 R 2

0x085C FLT32_020 F003 1.000 R 2

0x085E FLT32_021 F003 1.000 R 2

0x0860 FLT32_022 F003 1.000 R 2

0x0862 FLT32_023 F003 1.000 R 2

0x0864 FLT32_024 F003 1.000 R 2

0x0866 FLT32_025 F003 1.000 R 2

0x0868 FLT32_026 F003 1.000 R 2

0x086A FLT32_027 F003 1.000 R 2

0x086C FLT32_028 F003 1.000 R 2

0x086E FLT32_029 F003 1.000 R 2

0x0870 FLT32_030 F003 1.000 R 2

0x0872 FLT32_031 F003 1.000 R 2

0x0874 FLT32_032 F003 1.000 R 2

0x0876 FLT32_033 F003 1.000 R 2

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS



APPENDIX B:  MODBUS PROTOCOL B.5 MEMORY MAP

1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM B-23

0x0878 FLT32_034 F003 1.000 R 2

0x087A FLT32_035 F003 1.000 R 2

0x087C FLT32_036 F003 1.000 R 2

0x087E FLT32_037 F003 1.000 R 2

0x0880 FLT32_038 F003 1.000 R 2

0x0882 FLT32_039 F003 1.000 R 2

0x0884 FLT32_040 F003 1.000 R 2

0x0886 FLT32_041 F003 1.000 R 2

0x0888 FLT32_042 F003 1.000 R 2

0x088A FLT32_043 F003 1.000 R 2

0x088C FLT32_044 F003 1.000 R 2

0x088E FLT32_045 F003 1.000 R 2

0x0890 FLT32_046 F003 1.000 R 2

0x0892 FLT32_047 F003 1.000 R 2

0x0894 FLT32_048 F003 1.000 R 2

0x0896 FLT32_049 F003 1.000 R 2

Maniobras (24 elementos) - Operations

0x0025 0x0400 OPERATION BIT 1 F001  R 1  

0x0025 0x0800 OPERATION BIT 2 F001  R 1  

... ... ... ... ... ... ... ..

0x0026 0x0002 OPERATION BIT 24 F001  R 1  

Eventos de control (128 elementos) - Control Events

0x003D 0x0400 CONTROL EVENT 1 F001  R 1  

0x003D 0x0800 CONTROL EVENT 2 F001  R 1  

... ... ... ... ... ... ... ...

0x0045 0x0200 CONTROL EVENT 128 F001  R 1  

Salidas Virtuales Latcheadas (16 elementos) - Latched virtual outputs

0x0045 0x0400 V.O. Latched 1 F001 R 1

--- --- --- --- --- --- --- ---

0x0045 0x1000 V.O. Latched 3 F001 R 1

0x0046 0x0200 V.O. Latched 16 F001 R 1

Reset Salidas Virtuales Latcheadas - Reset Latched virtual outputs

0x0046 0x0400 Reset V.O. Latched F001 R 1

Entradas Virtuales con sellado (32 elementos) - Virtual Input Latched

0x0083 0x0400 LATCHED VIRT IP 1 F001  R 1  

0x0083 0x0800 LATCHED VIRT IP 2 F001  R 1  

... ... ... ... ... ... ... ...

0x0085 0x0200 LATCHED VIRT IP 32 F001  R 1  

Entradas Virtuales Autoresetables (32 elementos) - Virtual Input Self Reset

0x0085 0x0400 SELF-RST VIRT IP 1 F001  R 1  

0x0085 0x0800 SELF-RST VIRT IP 2 F001  R 1  

... ... ... ... ... ... ... ...

0x0087 0x0200 SELF-RST VIRT IP 32 F001  R 1  

Estado Entradas Tarjeta F (32 elementos) - Board F: Contact Input Status

0x0087 0x1000 CONT IP_F_CC1 F001  R 1  

0x0087 0x2000 CONT IP_F_CC2 F001  R 1  

... ... ... ... .... ... ... ...

0x0089 0x0800 CONT IP_F_CC32 F001  R 1  

Estado Señales Activación salidas Tarjeta F (16 elementos) - Board F: Contact Output Operate -logical status-

0x0089 0x1000 CONT OP OPER_F_01 F001  R 1  

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x0089 0x2000 CONT OP OPER_F_02 F001  R 1  

... ... ... ... ... ... ... ...

0x008A 0x0800 CONT OP OPER_F_16 F001  R 1  

Estado Señales Reposición de Salidas Tarjeta F  (16 elementos) - Board F: Contact Output Resets

0x008A 0x1000 CONT OP RESET_F_1 F001  R 1  

0x008A 0x2000 CONT OP RESET_F_2 F001  R 1  

... ... ... ... ... ... ... ...

0x008B 0x0800 CONT OP RESET_F_16 F001  R 1  

Estado Salidas Tarjeta F (16 elementos) - Board F: Contact Outputs -physical status-

0x008B 0x1000 CONT OP_F_01 F001  R 1  

0x008B 0x2000 CONT OP_F_02 F001  R 1  

... ... ... ... ... ... ... ...

0x008C 0x0800 CONT OP_F_16 F001  R 1  

Estado Tarjeta F - Board F Status

0x008C 0x1000 BOARD F STATUS F001  R 1  

Estado Entradas Tarjeta G (32 elementos) - Board G: Contact Input Status

0x00AC 0x2000 CONT IP_G_CC1 F001  R 1  

0x00AC 0x4000 CONT IP_G_CC2 F001  R 1  

... ... ... ... ... ... ... ...

0x00AE 0x1000 CONT IP_G_CC32 F001  R 1  

Estado Señales Activación salidas Tarjeta G (16 elementos) - Board G: Contact Output Operate -logical status-

0x00AE 0x2000 CONT OP OPER_G_01 F001  R 1  

0x00AE 0x4000 CONT OP OPER_G_02 F001  R 1  

... ... ... ... ... ... ... ...

0x00AF 0x1000 CONT OP OPER_G_16 F001  R 1  

Estado Señales Reposición de Salidas Tarjeta G  (16 elementos) - Board G: Contact Output Resets

0x00AF 0x2000 CONT OP RESET_G_01 F001  R 1  

0x00AF 0x4000 CONT OP RESET_G_02 F001  R 1  

... ... ... ... ... ... ... ...

0x00B0 0x1000 CONT OP RESET_G_16 F001  R 1  

Estado Salidas Tarjeta G (16 elementos) - Board G: Contact Outputs -physical status-

0x00B0 0x2000 CONT OP_G_01 F001  R 1  

0x00B0 0x4000 CONT OP_G_02 F001  R 1  

... ... ... ... ... ... ... ...

0x00B1 0x1000 CONT OP_G_16 F001  R 1  

Estado Tarjeta G - Board G Status

0x00B1 0x2000 BOARD G STATUS F001  R 1  

LEDS HMI (16 elementos) - HMI Leds

0x00D1 0x4000 READY LED F001  R 1  

0x00D1 0x8000 LED 1 F001  R 1  

0x00D1 0x0001 LED 2 F001  R 1  

0x00D1 0x0002 LED 3 F001  R 1  

0x00D1 0x0004 LED 4 F001  R 1  

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x00D1 0x0008 LED 5 F001  R 1  

0x00D1 0x0010 LED 6 F001  R 1  

0x00D1 0x0020 LED 7 F001  R 1  

0x00D1 0x0040 LED 8 F001  R 1  

0x00D1 0x0080 LED 9 F001  R 1  

0x00D2 0x0100 LED 10 F001  R 1  

0x00D2 0x0200 LED 11 F001  R 1  

0x00D2 0x0400 LED 12 F001  R 1  

0x00D2 0x0800 LED 13 F001  R 1  

0x00D2 0x1000 LED 14 F001  R 1  

0x00D2 0x2000 LED 15 F001  R 1  

Teclas HMI - HMI Keys

0x00D2 0x4000 I Key F001  R 1  

0x00D2 0x8000 O Key F001  R 1  

0x00D2 0x0001 * Key F001  R 1  

Señales estado LOCAL/REMOTO para maniobras - LOCAL/REMOTE Operation status signals

0x00D2 0x0002 F1 Key F001  R 1  

0x00D2 0x0004 F2 Key F001  R 1  

0x00D2 0x0008 LOCAL OPERATION MODE F001  R 1  

0x00D2 0x0010 OPERATIONS BLOCKED F001  R 1  

Estados Internos - Internal States

0x00D2 0x0020 DSP COMM ERROR F001  R 1  

0x00D2 0x0040 MAGNETIC MODULE ERROR F001  R 1  

Entrada Reset Leds (configurable) -Led reset Input

0x00D2 0x0080 LED RESET INPUT F001  R 1  

Entradas Cambio Estado Local-Remoto-OFF (configurable) - Local-Remote-Off Input selection

0x00D3 0x0100 CHANGE LOCAL-REMOTE F001  R 1  

0x00D3 0x0200 CHANGE OP BLOCKED F001  R 1  

Entradas Cambio Estado iluminación pantalla (configurable) - Backlight status selection

0x00D3 0x1000 HMI BACKLIGHT ON F001  R 1  

0x00D3 0x2000 HMI BACKLIGHT OFF F001  R 1  

Estado PLC Fuera de Servicio - Out of Service PLC Status

0x00D4 0x4000 OUT OF SERVICE F001 R 1

0x00D4 0x8000 PLC ERROR F001 R 1

0x00D4 0x0001 General Trip F001 R 1

0x00D4 0x0002 NET CONF ERROR F001 R 1

0x00D4 0x0004 ST HMI BACKLIGHT F001 R 1

0x00D4 0x0008 ORDERCODE ERROR F001 R 1

0x00D4 0x0010 LINK STATUS PORT E F001 R 1

0x00D4 0x0020 LINK STATUS PORT A F001 R 1

0x00D4 0x0040 LINK STATUS PORT B F001 R 1

Estados Unidad de Sincronismo - Synchrocheck States

0x01F0 0x0200 Synchrocheck BLK INP F001  R 1  

0x01F0 0x0400 Synchrocheck OP F001  R 1  

0x01F0 0x0800 SYNCHK CLOSE PERM F001  R 1  

0x01F0 0x1000 Synchrocheck COND OP F001  R 1  

0x01F0 0x2000 DL-DB OPERATION F001  R 1  

0x01F0 0x4000 DL-LB OPERATION F001  R 1  

0x01F0 0x8000 LL-DB OPERATION F001  R 1  

0x01F0 0x0001 SLIP CONDITION F001  R 1  

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x01F0 0x0002 BUS FREQ > LINE FREQ F001  R 1  

0x01F0 0x0004 BUS FREQ < LINE FREQ F001  R 1  

Estados Reenganchador (bit) - Autorecloser  States

0x01F5 0x0008 AR LEVEL BLOCK F001  R 1  

0x01F5 0x0010 AR PULSE BLOCK F001  R 1  

0x01F5 0x0020 AR PULSE UNBLOCK F001  R 1  

0x01F5 0x0080 AR INITIATE F001  R 1  

0x01F6 0x0100 AR CONDS INPUT F001  R 1  

0x01F6 0x0200 AR CLOSE BREAKER F001  R 1  

0x01F6 0x0400 AR OUT OF SERVICE F001  R 1  

0x01F6 0x0800 AR READY F001  R 1  

0x01F6 0x1000 AR LOCKOUT F001  R 1  

0x01F6 0x2000 AR BLOCK F001  R 1  

0x01F6 0x4000 AR RCL IN PROGRESS F001  R 1  

0x01F6 0x8000 AR LCK BY ANOMALY F001  R 1  

0x01F6 0x0001 AR LCK BY FAIL OPEN F001  R 1  

0x01F6 0x0002 AR LCK BY FAIL CLOSE F001  R 1  

0x01F6 0x0004 AR LCK BY USER F001  R 1  

0x01F6 0x0008 AR LCK BY CONDS F001  R 1  

0x01F6 0x0010 AR LCK BY TRIPS F001  R 1  

0x01F6 0x0020 AR LCK BY SHOTS F001  R 1  

0x01F6 0x0040 AR BLK AFTER 1 SHOT F001  R 1  

0x01F6 0x0080 AR BLK AFTER 2 SHOT F001  R 1  

0x01F7 0x0100 AR BLK AFTER 3 SHOT F001  R 1  

0x01F7 0x0200 AR BLK AFTER 4 SHOT F001  R 1  

0x01F7 0x0400 AR BLOCK BY LEVEL F001  R 1  

0x01F7 0x0800 AR BLOCK BY PULSE F001  R 1  

Estados Calibración - Calibration States

0x0279 0x0040 FACTORY CALIBRATION F001  R 1  

0x0279 0x0080 CALIBRATION ERROR F001  R 1  

Estados Oscilografía - Oscillography States

0x027A 0x0100 OSC DIG CHANNEL 1 F001  R 1  

0x027A 0x0200 OSC DIG CHANNEL 2 F001  R 1  

0x027A 0x0400 OSC DIG CHANNEL 3 F001  R 1  

0x027A 0x0800 OSC DIG CHANNEL 4 F001  R 1  

0x027A 0x1000 OSC DIG CHANNEL 5 F001  R 1  

0x027A 0x2000 OSC DIG CHANNEL 6 F001  R 1  

0x027A 0x4000 OSC DIG CHANNEL 7 F001  R 1  

0x027A 0x8000 OSC DIG CHANNEL 8 F001  R 1  

0x027A 0x0001 OSC DIG CHANNEL 9 F001  R 1  

0x027A 0x0002 OSC DIG CHANNEL 10 F001  R 1  

0x027A 0x0004 OSC DIG CHANNEL 11 F001  R 1  

0x027A 0x0008 OSC DIG CHANNEL 12 F001  R 1  

0x027A 0x0010 OSC DIG CHANNEL 13 F001  R 1  

0x027A 0x0020 OSC DIG CHANNEL 14 F001  R 1  

0x027A 0x0040 OSC DIG CHANNEL 15 F001  R 1  

0x027A 0x0080 OSC DIG CHANNEL 16 F001  R 1  

0x027B 0x0100 OSCILLO TRIGGER F001  R 1  

Canal por defecto - Default Channel (not used)

0x0294 0x0002 Default Channel F001  R 1  
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Estados Energía - Energy States

0x02A4 0x0800 FREEZE ENERGY CNT F001  R 1  

0x02A4 0x1000 UNFREEZE ENERGY CNT F001  R 1  

0x02A4 0x2000 RESET ENERGY CNT F001  R 1  

Entradas Demanda - Demand Inputs

0x0305 0x8000 DEMAND TRIGGER INP F001  R 1  

0x0305 0x0001 DEMAND RESET INP F001  R 1  

Estado Entradas Tarjeta H (32 elementos) - Board H: Contact Input  States

0x0319 0x0002 CONT IP_H_CC1 F001  R 1  

0x0319 0x0004 CONT IP_H_CC2 F001  R 1  

... ... ... ... ... ... ... ...

0x031B 0x0001 CONT IP_H_CC32 F001  R 1  

Estado Señales Activación salidas Tarjeta H (16 elementos) - Board H: Contact Output Operate -logical  States-

0x031B 0x0002 CONT OP OPER_H_01 F001  R 1  

0x031B 0x0004 CONT OP OPER_H_02 F001  R 1  

... ... ... ... ... ... ... ...

0x031C 0x0001 CONT OP OPER_H_16 F001  R 1  

Estado Señales Reposición de Salidas Tarjeta H  (16 elementos) - Board H: Contact Output Resets

0x031C 0x0002 CONT OP RESET_H_01 F001  R 1  

0x031C 0x0004 CONT OP RESET_H_02 F001  R 1  

... ... ... ... ... ... ... ...

0x031D 0x0001 CONT OP RESET_H_16 F001  R 1  

Estado Salidas Tarjeta H (16 elementos) - Board H: Contact Outputs -physical  States-

0x031D 0x0002 CONT OP_H_01 F001  R 1  

0x031D 0x0004 CONT OP_H_02 F001  R 1  

... ... ... ... ... ... ... ...

0x031E 0x0001 CONT OP_H_16 F001  R 1  

Estado Tarjeta H - Board H Status

0x031E 0x0002 BOARD H STATUS F001  R 1  

Estado Entradas Tarjeta J (32 elementos) - Board J: Contact Input  States

0x033E 0x0004 CONT IP_J_CC1 F001  R 1  

0x033E 0x0008 CONT IP_J_CC2 F001  R 1  

... ... ... ... ... ... ... ...

0x0340 0x0002 CONT IP_J_CC32 F001  R 1  

Estado Señales Activación salidas Tarjeta J (16 elementos) - Board J: Contact Output Operate -logical  States-

0x0340 0x0004 CONT OP OPER_J_01 F001  R 1  

0x0340 0x0008 CONT OP OPER_J_02 F001  R 1  

... ... ... ... ... ... ... ...

0x0341 0x0002 CONT OP OPER_J_16 F001  R 1  

Estado Señales Reposición de Salidas Tarjeta J  (16 elementos) - Board J: Contact Output Resets

0x0341 0x0004 CONT OP RESET_J_01 F001  R 1  

0x0341 0x0008 CONT OP RESET_J_02 F001  R 1  

... ... ... ... ... ... ... ...

0x0342 0x0002 CONT OP RESET_J_16 F001  R 1  

Estado Salidas Tarjeta J (16 elementos) - Board J: Contact Outputs -physical  states-

0x0342 0x0004 CONT OP_J_01 F001  R 1  

0x0342 0x0008 CONT OP_J_02 F001  R 1  

... ... ... ... ... ... ... ...

0x0343 0x0002 CONT OP_J_16 F001  R 1  

Estado Tarjeta J - Board J Status

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x0343 0x0004 BOARD J STATUS F001  R 1  

Estado Entradas Tarjeta 2H (32 elementos) - Board 2H: Contact Input  States

0x045A 0x8000 CONT IP_2H_CC1 F001 R 1

0x045A 0x0001 CONT IP_2H_CC2 F001 R 1

... ... ... ... ... ... ... ...

0x045C 0x4000 CONT IP_2H_CC32 F001 R 1

Estado Señales Activación salidas Tarjeta 2H (16 elementos) - Board 2H: Contact Output Operate -logical  States-

0x045C 0x8000 CONT OP OPER_2H_01 F001 R 1

0x045C 0x0001 CONT OP OPER_2H_02 F001 R 1

... ... ... ... ... ... ... ...

0x045D 0x4000 CONT OP OPER_2H_16 F001 R 1

Estado Señales Reposición de Salidas Tarjeta 2H  (16 elementos) - Board 2H: Contact Output Resets

0x045D 0x8000 CONT OP RESET_2H_01 F001 R 1

0x045D 0x0001 CONT OP RESET_2H_02 F001 R 1

... ... ... ... ... ... ... ...

0x045E 0x4000 CONT OP RESET_2H_16 F001 R 1

Estado Salidas Tarjeta 2H (16 elementos) - Board 2H: Contact Outputs -physical  states-

0x045E 0x8000 CONT OP_2H_01 F001 R 1

0x045E 0x0001 CONT OP_2H_02 F001 R 1

... ... ... ... ... ... ... ...

0x045F 0x4000 CONT OP_2H_16 F001 R 1

Estado Tarjeta J - Board 2H Status

0x045F 0x8000 BOARD 2H STATUS F001 R 1

Estado Entradas Tarjeta 2J (32 elementos) - Board 2J: Contact Input  States

0x047F 0x0001 CONT IP_2J_CC1 F001 R 1

0x047F 0x0002 CONT IP_2J_CC2 F001 R 1

... ... ... ... ... ... ... ...

0x0481 0x8000 CONT IP_2J_CC32 F001 R 1

Estado Señales Activación salidas Tarjeta 2J(16 elementos) - Board 2J: Contact Output Operate -logical  States-

0x0481 0x0001 CONT OP OPER_2J_01 F001 R 1

0x0481 0x0002 CONT OP OPER_2J_02 F001 R 1

... ... ... ... ... ... ... ...

0x0482 0x8000 CONT OP OPER_2J_16 F001 R 1

Estado Señales Reposición de Salidas Tarjeta 2J  (16 elementos) - Board 2J: Contact Output Resets

0x0482 0x0001 CONT OP RESET_2J_01 F001 R 1

0x0482 0x0002 CONT OP RESET_2J_02 F001 R 1

... ... ... ... ... ... ... ...

0x0483 0x8000 CONT OP RESET_2J_16 F001 R 1

Estado Salidas Tarjeta 2J (16 elementos) - Board 2J: Contact Outputs -physical  states-

0x0483 0x0001 CONT OP_2J_01 F001 R 1

0x0483 0x0002 CONT OP_2J_02 F001 R 1

... ... ... ... ... ... ... ...

0x0484 0x8000 CONT OP_2J_16 F001 R 1

Estado Tarjeta J - Board 2J Status

0x0484 0x0001 BOARD 2J STATUS F001 R 1

Estados Contactos Configuración Aparamenta (16 elementos) - Switchgear Contact Configuration States

0x0374 0x0010 SWITCH 1 A INPUT F001  R 1  

0x0374 0x0020 SWITCH 1 B INPUT F001  R 1  

0x0374 0x0040 SWITCH 2 A INPUT F001  R 1  

0x0374 0x0080 SWITCH 2 B INPUT F001  R 1  
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... ... ... ... ... ... ... ...

0x0376 0x0004 SWITCH 16 A INPUT F001  R 1  

0x0376 0x0008 SWITCH 16 B INPUT F001  R 1  

Estados Contactos Aparamenta (16 elementos) - Switchgear Contact States

0x0376 0x0010 SWITCH 1 A STATUS F001  R 1  

0x0376 0x0020 SWITCH 1 B STATUS F001  R 1  

0x0376 0x0040 SWITCH 2 A STATUS F001  R 1  

0x0376 0x0080 SWITCH 2 B STATUS F001  R 1  

... ... ... ... ... ... ... ...

0x0378 0x0004 SWITCH 16 A STATUS F001  R 1  

0x0378 0x0008 SWITCH 16 B STATUS F001  R 1  

Estados Aparamenta (16 elementos) - Switchgear States

0x0378 0x0010 SWITCH 1 OPEN F001  R 1  

0x0378 0x0020 SWITCH 1 CLOSED F001  R 1  

0x0378 0x0040 SWITCH 1 00_ERROR F001  R 1  

0x0378 0x0080 SWITCH 1 11_ERROR F001  R 1  

0x0379 0x0100 SWITCH 2 OPEN F001  R 1  

0x0379 0x0200 SWITCH 2 CLOSED F001  R 1  

0x0379 0x0400 SWITCH 2 00_ERROR F001  R 1  

0x0379 0x0800 SWITCH 2 11_ERROR F001  R 1  

... ... ... ... ... ... ... ...

0x037C 0x0001 SWITCH 16 OPEN F001  R 1  

0x037C 0x0002 SWITCH 16 CLOSED F001  R 1  

0x037C 0x0004 SWITCH 16 00_ERROR F001  R 1  

0x037C 0x0008 SWITCH 16 11_ERROR F001  R 1  

Estados Inicio Apertura y Cierre Aparamenta - Switchgear Open-Close Initializing States

0x037C 0x0010 SWITCH 1 OPEN INIT F001  R 1  

0x037C 0x0020 SWITCH 1 CLOSE INIT F001  R 1  

0x037C 0x0040 SWITCH 2 OPEN INIT F001  R 1  

0x037C 0x0080 SWITCH 2 CLOSE INIT F001  R 1  

... ... ... ... ... ... ... ...

0x037E 0x0004 SWITCH 16 OPEN INIT F001  R 1  

0x037E 0x0008 SWITCH 16 CLOSE INIT F001  R 1  

Estados Fallo Apertura y Cierre Aparamenta - Switchgear Fail States

0x037E 0x0010 SWGR 1 FAIL TO OPEN F001  R 1  

0x037E 0x0020 SWGR 2 FAIL TO OPEN F001  R 1  

... ... ... ... ... ... ... ...

0x037F 0x0008 SWGR 16 FAIL TO OPEN F001  R 1  

0x037F 0x0010 SWGR 1 FAIL TO CLOSE F001  R 1  

0x037F 0x0020 SWGR 2 FAIL TO CLOSE F001  R 1  

... ... ... ... ... ... ... ...

0x0380 0x0008 SWGR 16 FAIL TO CLOSE F001  R 1  

0x0380 0x0010 SWGR 1 BLOCK OPENING F001 R 1  

0x0380 0x0020 SWGR 2 BLOCK OPENING F001 R 1  

0x0380 0x0040 SWGR 3 BLOCK OPENING F001 R 1  

0x0380 0x0080 SWGR 4 BLOCK OPENING F001 R 1  

0x0381 0x0100 SWGR 5 BLOCK OPENING F001 R 1  

0x0381 0x0200 SWGR 6 BLOCK OPENING F001 R 1  

0x0381 0x0400 SWGR 7 BLOCK OPENING F001 R 1  

0x0381 0x0800 SWGR 8 BLOCK OPENING F001 R 1  
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0x0381 0x1000 SWGR 9 BLOCK OPENING F001 R 1  

0x0381 0x2000 SWGR 10 BLOCK OPENING F001 R 1  

0x0381 0x4000 SWGR 11 BLOCK OPENING F001 R 1  

0x0381 0x8000 SWGR 12 BLOCK OPENING F001 R 1  

0x0381 0x0001 SWGR 13 BLOCK OPENING F001 R 1  

0x0381 0x0002 SWGR 14 BLOCK OPENING F001 R 1  

0x0381 0x0004 SWGR 15 BLOCK OPENING F001 R 1  

0x0381 0x0008 SWGR 16 BLOCK OPENING F001 R 1  

0x0381 0x0010 SWGR 1 BLOCK CLOSING F001 R 1  

0x0381 0x0020 SWGR 2 BLOCK CLOSING F001 R 1  

0x0381 0x0040 SWGR 3 BLOCK CLOSING F001 R 1  

0x0381 0x0080 SWGR 4 BLOCK CLOSING F001 R 1  

0x0382 0x0100 SWGR 5 BLOCK CLOSING F001 R 1  

0x0382 0x0200 SWGR 6 BLOCK CLOSING F001 R 1  

0x0382 0x0400 SWGR 7 BLOCK CLOSING F001 R 1  

0x0382 0x0800 SWGR 8 BLOCK CLOSING F001 R 1  

0x0382 0x1000 SWGR 9 BLOCK CLOSING F001 R 1  

0x0382 0x2000 SWGR 10 BLOCK CLOSING F001 R 1  

0x0382 0x4000 SWGR 11 BLOCK CLOSING F001 R 1  

0x0382 0x8000 SWGR 12 BLOCK CLOSING F001 R 1  

0x0382 0x0001 SWGR 13 BLOCK CLOSING F001 R 1  

0x0382 0x0002 SWGR 14 BLOCK CLOSING F001 R 1  

0x0382 0x0004 SWGR 15 BLOCK CLOSING F001 R 1  

0x0382 0x0008 SWGR 16 BLOCK CLOSING F001 R 1  

Estados Interruptor - Breaker States

0x0390 0x0010 KI2t PHASE A ALARM F001  R 1  

0x0390 0x0020 KI2t PHASE B ALARM F001  R 1  

0x0390 0x0040 KI2t PHASE C ALARM F001  R 1  

0x0390 0x0080 BKR OPENINGS ALARM F001  R 1  

0x0391 0x0100 BKR OPEN 1 HOUR ALRM F001  R 1  

0x0391 0x0200 BREAKER OPEN F001  R 1

0x0391 0x0400 BREAKER CLOSED F001  R 1

0x0391 0x0800 BREAKER UNDEFINED F001  R 1

0x0391 0x1000 RESET KI2t COUNTERS F001  R 1  

0x0391 0x2000 RESET BKR COUNTERS F001  R 1  

Estado Mapa Usuario - User Map State

0x039B 0x4000 USER MAP STATUS F001  R 1  

Estados Salidas Remotas DNA - DNA Remote Output Status

0x03E5 0x0008 DNA 1 F001  R 1  

0x03E5 0x0010 DNA 2 F001  R 1  

... ... ... ... ... ... ... ...

0x03E7 0x0004 DNA 32 F001  R 1  

Estados Salidas Remotas Usuario - UserSt Remote Output Status

0x03E7 0x0008 UserSt 1 F001  R 1  

0x03E5 0x0010 UserSt 2 F001  R 1  

... ... ... ... ... ... ... ...

0x03EB 0x0004 UserSt 64 F001  R 1  

Estados Entradas Remotas - Remote Inputs Status

0x03EB 0x0008 Remote Input 1 F001  R 1  

0x03EB 0x0010 Remote Input 2 F001  R 1  
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... ... ... ... ... ... ... ...

0x03ED 0x0004 Remote Input 32 F001  R 1  

Estados Dispositivos Remotos - Remote Devices Status

0x03ED 0x0008 Remote Device 1 F001  R 1  

0x03ED 0x0010 Remote Device 2 F001  R 1  

... ... ... ... ... ... ... ...

0x03EF 0x0400 Remote Device 24 F001  R 1  

Estados Sicronizacion Remota - SNTP/IRIG B Status

0x03F2 0x0008 SNTP FAILURE F001  R 1  

0x03F2 0x0010 IRIGB FAILURE F001  R 1  

0x03F3 0x0001 CNT PULSES FREEZE F001 R 1

0x03F3 0x0002 CNT PULSES UNFREEZE F001 R 1

0x03F3 0x0004 CNT PULSES RESET F001 R 1

Comparadores analógicos-Analog Comparators

0x03F8 0x0020 Analog Level 01 F001 R 1

0x03F8 0x0040 Analog Level 02 F001 R 1

0x03F8 0x0080 Analog Level 03 F001 R 1

0x03F9 0x0100 Analog Level 04 F001 R 1

0x03F9 0x0200 Analog Level 05 F001 R 1

0x03F9 0x0400 Analog Level 06 F001 R 1

0x03F9 0x0800 Analog Level 07 F001 R 1

0x03F9 0x1000 Analog Level 08 F001 R 1

0x03F9 0x2000 Analog Level 09 F001 R 1

0x03F9 0x4000 Analog Level 10 F001 R 1

0x03F9 0x8000 Analog Level 11 F001 R 1

0x03F9 0x0001 Analog Level 12 F001 R 1

0x03F9 0x0002 Analog Level 13 F001 R 1

0x03F9 0x0004 Analog Level 14 F001 R 1

0x03F9 0x0008 Analog Level 15 F001 R 1

0x03F9 0x0010 Analog Level 16 F001 R 1

0x03F9 0x0020 Analog Level 17 F001 R 1

0x03F9 0x0040 Analog Level 18 F001 R 1

0x03F9 0x0080 Analog Level 19 F001 R 1

0x03FA 0x0100 Analog Level 20 F001 R 1

Entradas digitales GOOSE-Rem GOOSE digital Inputs

0x0421 0x2000 Rem GOOSE Dig Inp 1 F001 R 1

0x0421 0x4000 Rem GOOSE Dig Inp 2 F001 R 1

0x0421 0x8000 Rem GOOSE Dig Inp 3 F001 R 1

0x0421 0x0001 Rem GOOSE Dig Inp 4 F001 R 1

0x0421 0x0002 Rem GOOSE Dig Inp 5 F001 R 1

0x0421 0x0004 Rem GOOSE Dig Inp 6 F001 R 1

0x0421 0x0008 Rem GOOSE Dig Inp 7 F001 R 1

0x0421 0x0010 Rem GOOSE Dig Inp 8 F001 R 1

0x0421 0x0020 Rem GOOSE Dig Inp 9 F001 R 1

0x0421 0x0040 Rem GOOSE Dig Inp 10 F001 R 1

0x0421 0x0080 Rem GOOSE Dig Inp 11 F001 R 1

0x0422 0x0100 Rem GOOSE Dig Inp 12 F001 R 1

0x0422 0x0200 Rem GOOSE Dig Inp 13 F001 R 1

0x0422 0x0400 Rem GOOSE Dig Inp 14 F001 R 1
0x0422 0x0800 Rem GOOSE Dig Inp 15 F001 R 1
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0x0422 0x1000 Rem GOOSE Dig Inp 16 F001 R 1

0x0422 0x2000 Rem GOOSE Dig Inp 17 F001 R 1

0x0422 0x4000 Rem GOOSE Dig Inp 18 F001 R 1

0x0422 0x8000 Rem GOOSE Dig Inp 19 F001 R 1

0x0422 0x0001 Rem GOOSE Dig Inp 20 F001 R 1

0x0422 0x0002 Rem GOOSE Dig Inp 21 F001 R 1

0x0422 0x0004 Rem GOOSE Dig Inp 22 F001 R 1

0x0422 0x0008 Rem GOOSE Dig Inp 23 F001 R 1

0x0422 0x0010 Rem GOOSE Dig Inp 24 F001 R 1

0x0422 0x0020 Rem GOOSE Dig Inp 25 F001 R 1

0x0422 0x0040 Rem GOOSE Dig Inp 26 F001 R 1

0x0422 0x0080 Rem GOOSE Dig Inp 27 F001 R 1

0x0423 0x0100 Rem GOOSE Dig Inp 28 F001 R 1

0x0423 0x0200 Rem GOOSE Dig Inp 29 F001 R 1

0x0423 0x0400 Rem GOOSE Dig Inp 30 F001 R 1

0x0423 0x0800 Rem GOOSE Dig Inp 31 F001 R 1

0x0423 0x1000 Rem GOOSE Dig Inp 32 F001 R 1

Salidas digitales GOOSE-Remote GOOSE digital Outputs

0x0423 0x2000 Rem GOOSE Dig Out 1 F001 R 1

0x0423 0x4000 Rem GOOSE Dig Out 2 F001 R 1

0x0423 0x8000 Rem GOOSE Dig Out 3 F001 R 1

0x0423 0x0001 Rem GOOSE Dig Out 4 F001 R 1

0x0423 0x0002 Rem GOOSE Dig Out 5 F001 R 1

0x0423 0x0004 Rem GOOSE Dig Out 6 F001 R 1

0x0423 0x0008 Rem GOOSE Dig Out 7 F001 R 1

0x0423 0x0010 Rem GOOSE Dig Out 8 F001 R 1

0x0423 0x0020 Rem GOOSE Dig Out 9 F001 R 1

0x0423 0x0040 Rem GOOSE Dig Out 10 F001 R 1

0x0423 0x0080 Rem GOOSE Dig Out 11 F001 R 1

0x0424 0x0100 Rem GOOSE Dig Out 12 F001 R 1

0x0424 0x0200 Rem GOOSE Dig Out 13 F001 R 1

0x0424 0x0400 Rem GOOSE Dig Out 14 F001 R 1

0x0424 0x0800 Rem GOOSE Dig Out 15 F001 R 1

0x0424 0x1000 Rem GOOSE Dig Out 16 F001 R 1

0x0424 0x2000 Rem GOOSE Dig Out 17 F001 R 1

0x0424 0x4000 Rem GOOSE Dig Out 18 F001 R 1

0x0424 0x8000 Rem GOOSE Dig Out 19 F001 R 1

0x0424 0x0001 Rem GOOSE Dig Out 20 F001 R 1

0x0424 0x0002 Rem GOOSE Dig Out 21 F001 R 1

0x0424 0x0004 Rem GOOSE Dig Out 22 F001 R 1

0x0424 0x0008 Rem GOOSE Dig Out 23 F001 R 1

0x0424 0x0010 Rem GOOSE Dig Out 24 F001 R 1

0x0424 0x0020 Rem GOOSE Dig Out 25 F001 R 1

0x0424 0x0040 Rem GOOSE Dig Out 26 F001 R 1

0x0424 0x0080 Rem GOOSE Dig Out 27 F001 R 1

0x0425 0x0100 Rem GOOSE Dig Out 28 F001 R 1

0x0425 0x0200 Rem GOOSE Dig Out 29 F001 R 1

0x0425 0x0400 Rem GOOSE Dig Out 30 F001 R 1

0x0425 0x0800 Rem GOOSE Dig Out 31 F001 R 1
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0x0425 0x1000 Rem GOOSE Dig Out 32 F001 R 1

Digital Counters actual values

0x04A4 0x0002 DIGCNT 1 BLOCK F001 R 1

0x04A4 0x0004 DIGCNT 2 BLOCK F001 R 1

0x04A4 0x0008 DIGCNT 3 BLOCK F001 R 1

0x04A4 0x0010 DIGCNT 4 BLOCK F001 R 1

0x04A4 0x0020 DIGCNT 5 BLOCK F001 R 1

0x04A4 0x0040 DIGCNT 6 BLOCK F001 R 1

0x04A4 0x0080 DIGCNT 7 BLOCK F001 R 1

0x04A5 0x0100 DIGCNT 8 BLOCK F001 R 1

0x04A5 0x0200 DIGCNT 1 HI F001 R 1

0x04A5 0x0400 DIGCNT 2 HI F001 R 1

0x04A5 0x0800 DIGCNT 3 HI F001 R 1

0x04A5 0x1000 DIGCNT 4 HI F001 R 1

0x04A5 0x2000 DIGCNT 5 HI F001 R 1

0x04A5 0x4000 DIGCNT 6 HI F001 R 1

0x04A5 0x8000 DIGCNT 7 HI F001 R 1

0x04A5 0x0001 DIGCNT 8 HI F001 R 1

0x04A5 0x0002 DIGCNT 1 EQ F001 R 1

0x04A5 0x0004 DIGCNT 2 EQ F001 R 1

0x04A5 0x0008 DIGCNT 3 EQ F001 R 1

0x04A5 0x0010 DIGCNT 4 EQ F001 R 1

0x04A5 0x0020 DIGCNT 5 EQ F001 R 1

0x04A5 0x0040 DIGCNT 6 EQ F001 R 1

0x04A5 0x0080 DIGCNT 7 EQ F001 R 1

0x04A6 0x0100 DIGCNT 8 EQ F001 R 1

0x04A6 0x0200 DIGCNT 1 LO F001 R 1

0x04A6 0x0400 DIGCNT 2 LO F001 R 1

0x04A6 0x0800 DIGCNT 3 LO F001 R 1

0x04A6 0x1000 DIGCNT 4 LO F001 R 1

0x04A6 0x2000 DIGCNT 5 LO F001 R 1

0x04A6 0x4000 DIGCNT 6 LO F001 R 1

0x04A6 0x8000 DIGCNT 7 LO F001 R 1

0x04A6 0x0001 DIGCNT 8 LO F001 R 1

0x04A6 0x0002 DIGCNT 1 UP F001 R 1

0x04A6 0x0004 DIGCNT 2 UP F001 R 1

0x04A6 0x0008 DIGCNT 3 UP F001 R 1

0x04A6 0x0010 DIGCNT 4 UP F001 R 1

0x04A6 0x0020 DIGCNT 5 UP F001 R 1

0x04A6 0x0040 DIGCNT 6 UP F001 R 1

0x04A6 0x0080 DIGCNT 7 UP F001 R 1

0x04A7 0x0100 DIGCNT 8 UP F001 R 1

0x04A7 0x0200 DIGCNT 1 DOWN F001 R 1

0x04A7 0x0400 DIGCNT 2 DOWN F001 R 1

0x04A7 0x0800 DIGCNT 3 DOWN F001 R 1

0x04A7 0x1000 DIGCNT 4 DOWN F001 R 1

0x04A7 0x2000 DIGCNT 5 DOWN F001 R 1

0x04A7 0x4000 DIGCNT 6 DOWN F001 R 1

0x04A7 0x8000 DIGCNT 7 DOWN F001 R 1

0x04A7 0x0001 DIGCNT 8 DOWN F001 R 1
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0x04A7 0x0002 DIGCNT 1 SETPRESET F001 R 1

0x04A7 0x0004 DIGCNT 2 SETPRESET F001 R 1

0x04A7 0x0008 DIGCNT 3 SETPRESET F001 R 1

0x04A7 0x0010 DIGCNT 4 SETPRESET F001 R 1

0x04A7 0x0020 DIGCNT 5 SETPRESET F001 R 1

0x04A7 0x0040 DIGCNT 6 SETPRESET F001 R 1

0x04A7 0x0080 DIGCNT 7 SETPRESET F001 R 1

0x04A8 0x0100 DIGCNT 8 SETPRESET F001 R 1

0x04A8 0x0200 DIGCNT 1 RESET F001 R 1

0x04A8 0x0400 DIGCNT 2 RESET F001 R 1

0x04A8 0x0800 DIGCNT 3 RESET F001 R 1

0x04A8 0x1000 DIGCNT 4 RESET F001 R 1

0x04A8 0x2000 DIGCNT 5 RESET F001 R 1

0x04A8 0x4000 DIGCNT 6 RESET F001 R 1

0x04A8 0x8000 DIGCNT 7 RESET F001 R 1

0x04A8 0x0001 DIGCNT 8 RESET F001 R 1

0x04A8 0x0002 DIGCNT 1 FREEZERESET F001 R 1

0x04A8 0x0004 DIGCNT 2 FREEZERESET F001 R 1

0x04A8 0x0008 DIGCNT 3 FREEZERESET F001 R 1

0x04A8 0x0010 DIGCNT 4 FREEZERESET F001 R 1

0x04A8 0x0020 DIGCNT 5 FREEZERESET F001 R 1

0x04A8 0x0040 DIGCNT 6 FREEZERESET F001 R 1

0x04A8 0x0080 DIGCNT 7 FREEZERESET F001 R 1

0x04A9 0x0100 DIGCNT 8 FREEZERESET F001 R 1

0x04A9 0x0200 DIGCNT 1 FREEZECOUNT F001 R 1

0x04A9 0x0400 DIGCNT 2 FREEZECOUNT F001 R 1

0x04A9 0x0800 DIGCNT 3 FREEZECOUNT F001 R 1

0x04A9 0x1000 DIGCNT 4 FREEZECOUNT F001 R 1

0x04A9 0x2000 DIGCNT 5 FREEZECOUNT F001 R 1

0x04A9 0x4000 DIGCNT 6 FREEZECOUNT F001 R 1

0x04A9 0x8000 DIGCNT 7 FREEZECOUNT F001 R 1

0x04A9 0x0001 DIGCNT 8 FREEZECOUNT F001 R 1
Entradas Analógicas (Tarjetas F y G)- Analog Inputs (F and G boards)
0x0B06  ANALOG_INP_F_01 F002 1000 R 2  

0x0B08  ANALOG_INP_F_02 F002 1000 R 2  

...  ... ... ... ... ... ...

0x0B14  ANALOG_INP_F_08 F002 1000 R 2  

0x0B86  ANALOG_INP_G_01 F002 1000 R 2  

0x0B88  ANALOG_INP_G_02 F002 1000 R 2  

...  ... ... ... ... ... ...

0x0B94  ANALOG_INP_G_08 F002 1000 R 2  

Medidas en Valores Secundarios - Analog measures in Secondary Values

0x0C00  Phasor Ia F002 1000 R 2  

0x0C02  RMS Ia F002 1000 R 2  

0x0C04  Ia Real F002 1000 R 2  

0x0C06  Ia Imag F002 1000 R 2  

0x0C08  Phasor Ib F002 1000 R 2  

0x0C0A  RMS Ib F002 1000 R 2  

0x0C0C  Ib Real F002 1000 R 2  

0x0C0E  Ib Imag F002 1000 R 2  
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0x0C10  Phasor Ic F002 1000 R 2  

0x0C12  RMS Ic F002 1000 R 2  

0x0C14  Ic Real F002 1000 R 2  

0x0C16  Ic Imag F002 1000 R 2  

0x0C18  Phasor In F002 1000 R 2  

0x0C1A  In Real F002 1000 R 2  

0x0C1C  In Imag F002 1000 R 2  

0x0C1E  Phasor Ig F002 1000 R 2  

0x0C20  RMS Ig F002 1000 R 2  

0x0C22  Ig Real F002 1000 R 2  

0x0C24  Ig Imag F002 1000 R 2  

0x0C26  Phasor Isg F002 1000 R 2  

0x0C28  RMS Isg F002 1000 R 2  

0x0C2A  Isg Real F002 1000 R 2  

0x0C2C  Isg Imag F002 1000 R 2  

0x0C2E  Zero seq I0 F002 1000 R 2  

0x0C30  I0 Real F002 1000 R 2  

0x0C32  I0 Imag F002 1000 R 2  

0x0C34  Positive Seq I1 F002 1000 R 2  

0x0C36  I1 Real F002 1000 R 2  

0x0C38  I1 Imag F002 1000 R 2  

0x0C3A  Negative Seq I2 F002 1000 R 2  

0x0C3C  I2 Real F002 1000 R 2  

0x0C3E  I2 Imag F002 1000 R 2  

0x0C40  Phasor Vab F002 1000 R 2  

0x0C42  Vab Real F002 1000 R 2  

0x0C44  Vab Imag F002 1000 R 2  

0x0C46  Phasor Vbc F002 1000 R 2  

0x0C48  Vbc Real F002 1000 R 2  

0x0C4A  Vbc Imag F002 1000 R 2  

0x0C4C  Phasor Vca F002 1000 R 2  

0x0C4E  Vca Real F002 1000 R 2  

0x0C50  Vca Imag F002 1000 R 2  

0x0C52  Phasor Van F002 1000 R 2  

0x0C54  Va Real F002 1000 R 2  

0x0C56  Va Imag F002 1000 R 2  

0x0C58  Phasor Vbn F002 1000 R 2  

0x0C5A  Vb Real F002 1000 R 2  

0x0C5C  Vb Imag F002 1000 R 2  

0x0C5E  Phasor Vcn F002 1000 R 2  

0x0C60  Vc Real F002 1000 R 2  

0x0C62  Vc Imag F002 1000 R 2  

0x0C64  Phasor Vn F002 1000 R 2  

0x0C66  Vn Real F002 1000 R 2  

0x0C68  Vn Imag F002 1000 R 2  

0x0C6A  Positive Seq V1 F002 1000 R 2  

0x0C6C  V1 Real F002 1000 R 2  

0x0C6E  V1 Imag F002 1000 R 2  

0x0C70  Negative Seq V2 F002 1000 R 2  

0x0C72  V2 Real F002 1000 R 2  
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0x0C74  V2 Imag F002 1000 R 2  

0x0C76  Zero Seq V0 F002 1000 R 2  

0x0C78  V0 Real F002 1000 R 2  

0x0C7A  V0 Imag F002 1000 R 2  

0x0C7C  Phasor Vx F002 1000 R 2  

0x0C7E  Vx Real F002 1000 R 2  

0x0C80  Vx Imag F002 1000 R 2  

0x0C82  Nominal Voltage F002 1000 R 2  

0x0C84  VL Real F002 1000 R 2  

0x0C86  VL Imag F002 1000 R 2  

0x0C88  VBB Real F002 1000 R 2  

0x0C8A  VBB Imag F002 1000 R 2  

0x0C8C  Line Voltage F002 1000 R 2  

0x0C8E  Bus Voltage F002 1000 R 2  

0x0C90  Line Frequency F002 1000 R 2  

0x0C92  Bus Frequency F002 1000 R 2  

0x0C94  Phase A Apparent Pwr F002 1000 R 2  

0x0C96  Phase B Apparent Pwr F002 1000 R 2  

0x0C98  Phase C Apparent Pwr F002 1000 R 2  

0x0C9A  Phase A Real Pwr F002 1000 R 2  

0x0C9C  Phase B Real Pwr F002 1000 R 2  

0x0C9E  Phase C Real Pwr F002 1000 R 2  

0x0CA0  Phase A Reactive Pwr F002 1000 R 2  

0x0CA2  Phase B Reactive Pwr F002 1000 R 2  

0x0CA4  Phase C Reactive Pwr F002 1000 R 2  

0x0CA6  3 Phase Apparent Pwr F002 1000 R 2  

0x0CA8  3 Phase Real Pwr F002 1000 R 2  

0x0CAA  3 Phase Reactive Pwr F002 1000 R 2  

0x0CAC  Phase A Power Factor F002 1000 R 2  

0x0CAE  Phase B Power Factor F002 1000 R 2  

0x0CB0  Phase C Power Factor F002 1000 R 2  

0x0CB2  3 Phase Power Factor F002 1000 R 2  

Ratios corriente y tensión - Current and Voltage Ratios

0x0CB4  CT Ratio F002 1000 R 2  

0x0CB6  CT Ratio Ig F002 1000 R 2  

0x0CB8  CT Ratio Isg F002 1000 R 2  

0x0CBA  PT Ratio F002 1000 R 2  

Angulos - Angles

0x0CBC  Ia Angle F002 1000 R 2  

0x0CBE  Ib Angle F002 1000 R 2  

0x0CC0  Ic Angle F002 1000 R 2  

0x0CC2  In Angle F002 1000 R 2  

0x0CC4  Ig Angle F002 1000 R 2  

0x0CC6  Isg Angle F002 1000 R 2  

0x0CC8  Va Angle F002 1000 R 2  

0x0CCA  Vb Angle F002 1000 R 2  

0x0CCC  Vc Angle F002 1000 R 2  

0x0CCE  Vn Angle F002 1000 R 2  

0x0CD0  Vx Angle F002 1000 R 2  

0x0CD2  Vab Angle F002 1000 R 2  
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0x0CD4  Vbc Angle F002 1000 R 2  

0x0CD6  Vca Angle F002 1000 R 2  

Frequency rate of change value

0x0CD8  df/dt F002 1000
0

R 2  

Versión del HMI - HMI Version

0x0CE2  HMI Version F004 1000 R 1  

0x0CE3 DISPLAY TYPE F004 1000 R 1

Angle Difference for synchrocheck unit

0x0E2F  ANGLE DIFFERENCE F002 1,000,
000

R 2  

Diferencia de tensión para la función de sincronismo-Voltage Difference for synchrocheck unit

0x0E31  VOLTAGE DIFFERENCE F002 1000
0

R 2  

Diferencia de Frecuencia para la función de sincronismo-Frequency Difference for synchrocheck unit

0x0E33  FREQ. DIFFERENCE F002 1000
0

R 2  

Estados Reenganchador (Enumerado) - Autorecloser Status

0x0E36  AR STATUS F012  R 1 0=OUT OF SERVICE

       1=READY

       2=LOCKOUT

       3=BLOCK

       4=RECLOSE IN PROGRESS

0x0E37  AR LOCKOUT MODE F012  R 1 0=NONE

       1=ANOMALY

       2=FAIL TO OPEN

       3=FAIL TO CLOSE

       4=MANUAL

       5=NO CONDITIONS

       6=MAX NUMBER OF TRIPS

       7=LAST SHOT

0x0E38  AR BLOCK MODE F012  R 1 0=NONE

       1=LEVEL

       2=PULSE

       3=LEVEL+PULSE

Estados Oscilografía - Oscillography States

0x0EB6  NUMBER OF TRIGGERS F004 1 R 1  

0x0EB7  CYCLES PER RECORD F004 1 R 1  

0x0EB8  AVAILABLE RECORDS F004 1 R 1  

Medidas en Valores Primarios - Analog measures in Primary Values

0x0EE2  Phasor Ia Primary F002 1000 R 2  

0x0EE4  Phasor Ib Primary F002 1000 R 2  

0x0EE6  Phasor Ic Primary F002 1000 R 2  

0x0EE8  Phasor Ig Primary F002 1000 R 2  

0x0EEA  Phasor Isg Primary F002 1000 R 2  

0x0EEC  Phasor In Primary F002 1000 R 2  

0x0EEE  RMS Ia Primary F002 1000 R 2  

0x0EF0  RMS Ib Primary F002 1000 R 2  

0x0EF2  RMS Ic Primary F002 1000 R 2  

0x0EF4  RMS Ig Primary F002 1000 R 2  

0x0EF6  RMS Isg Primary F002 1000 R 2  
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0x0EF8  I0 Primary F002 1000 R 2  

0x0EFA  I1 Primary F002 1000 R 2  

0x0EFC  I2 Primary F002 1000 R 2  

0x0EFE  V0 Primary F002 1000 R 2  

0x0F00  V1 Primary F002 1000 R 2  

0x0F02  V2 Primary F002 1000 R 2  

0x0F04  Vab Primary F002 1000 R 2  

0x0F06  Vbc Primary F002 1000 R 2  

0x0F08  Vca Primary F002 1000 R 2  

0x0F0A  Va Primary F002 1000 R 2  

0x0F0C  Vb Primary F002 1000 R 2  

0x0F0E  Vc Primary F002 1000 R 2  

0x0F10  Vn Primary F002 1000 R 2  

0x0F12  Vx Primary F002 1000 R 2  

0x0F14  VBB Primary F002 1000 R 2  

0x0F16  VL Primary F002 1000 R 2  

0x0F18  Phase A Real Pwr F002 1000 R 2  

0x0F1A  Phase A Reactive Pwr F002 1000 R 2  

0x0F1C  Phase A Apparent Pwr F002 1000 R 2  

0x0F1E  Phase B Real Pwr F002 1000 R 2  

0x0F20  Phase B Reactive Pwr F002 1000 R 2  

0x0F22  Phase B Apparent Pwr F002 1000 R 2  

0x0F24  Phase C Real Pwr F002 1000 R 2  

0x0F26  Phase C Reactive Pwr F002 1000 R 2  

0x0F28  Phase C Apparent Pwr F002 1000 R 2  

0x0F2A  3 Phase Real Pwr F002 1000 R 2  

0x0F2C  3 Phase Reactive Pwr F002 1000 R 2  

0x0F2E  3 Phase Apparent Pwr F002 1000 R 2  

0x0F30  Phase A Power Factor F002 1000 R 2  

0x0F32  Phase B Power Factor F002 1000 R 2  

0x0F34  Phase C Power Factor F002 1000 R 2  

0x0F36  3 Phase Power Factor F002 1000 R 2  

0x0F38  Line Frequency F002 1000 R 2  

0x0F3A  Bus Frequency F002 1000 R 2  

0x0F3C  Positive MWatthour F002 1000 R 2  

0x0F3E  Negative MWatthour F002 1000 R 2  

0x0F40  Positive MVarhour F002 1000 R 2  

0x0F42  Negative MVarhour F002 1000 R 2  

0x0F44  Pos MWatthour Cnt F002 1000 R 2  

0x0F46  Neg MWatthour Cnt F002 1000 R 2  

0x0F48  Pos MVarhour Cnt F002 1000 R 2  

0x0F4A  Neg MVarhour Cnt F002 1000 R 2  

0x0F4C % of Load-To-Trip F002 1000 R 2

Medidas Demanda - Demand measures

0x0FAB  DEMAND IA F002 1000 R 2  

0x0FAD  DEMAND IA MAX F002 1000 R 2  

0x0FAF  DEMAND IA DATE F011  R 3  

0x0FB2  DEMAND IB F002 1000 R 2  

0x0FB4  DEMAND IB MAX F002 1000 R 2  

0x0FB6  DEMAND IB DATE F011  R 3  
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0x0FB9  DEMAND IC F002 1000 R 2  

0x0FBB  DEMAND IC MAX F002 1000 R 2  

0x0FBD  DEMAND IC DATE F011  R 3  

0x0FC0  DEMAND IG F002 1000 R 2  

0x0FC2  DEMAND IG MAX F002 1000 R 2  

0x0FC4  DEMAND IG DATE F011  R 3  

0x0FC7  DEMAND ISG F002 1000 R 2  

0x0FC9  DEMAND ISG MAX F002 1000 R 2  

0x0FCB  DEMAND ISG DATE F011  R 3  

0x0FCE  DEMAND I2 F002 1000 R 2  

0x0FD0  DEMAND I2 MAX F002 1000 R 2  

0x0FD2  DEMAND I2 DATE F011  R 3  

0x0FD5  DEMAND W F002 1000 R 2  

0x0FD7  DEMAND W MAX F002 1000 R 2  

0x0FEA  DEMAND W MIN F002 1000 R 2  

0x0FD9  DEMAND W DATE F011  R 3  

0x0FDC  DEMAND VAR PWR F002 1000 R 2  

0x0FDE  DEMAND VAR MAX F002 1000 R 2  

0x0FEC  DEMAND VAR MIN F002 1000 R 2  

0x0FE0  DEMAND VAR DATE F011  R 3  

0x0FE3  DEMAND VA PWR F002 1000 R 2  

0x0FE5  DEMAND VA MAX F002 1000 R 2  

0x0FEE  DEMAND VA MIN F002 1000 R 2  

0x0FE7  DEMAND VA DATE F011  R 3  

Entradas Analógicas (Tarjetas J y H)- Analog Inputs (J and H boards)

0x0FFE  ANALOG_INP_H_01 F002 1000 R 2  

0x1000  ANALOG_INP_H_02 F002 1000 R 2  

...  ... ... ... ... ... ...

0x100C  ANALOG_INP_H_08 F002 1000 R 2  

0x107E  ANALOG_INP_J_01 F002 1000 R 2  

0x1080  ANALOG_INP_J_02 F002 1000 R 2  

...  ... ... ... ... ... ...

0x108C  ANALOG_INP_J_08 F002 1000 R 2  

Contadores de Interruptor - Breaker Counters

0x111D  BREAKER OPENINGS F005 1 R 2  

0x111F  BREAKER CLOSINGS F005 1 R 2  

0x1121  KI2t PHASE A F003 1 R 2  

0x1123  KI2t PHASE B F003 1 R 2  

0x1125  KI2t PHASE C F003 1 R 2  

0x1127  BKR OPENING TIME F003 1 R 2  

0x1129  BKR CLOSING TIME F003 1 R 2  

0x112B BKR OPEN TIMING F003 1 R 2

0x112D BKR CLOSE TIMING F003 1 R 2

Registrador de Datos - Data Logger

0x1153  OLDEST SAMPLE TIME F011  R 3  

0x1156  NEWEST SAMPLE TIME F011  R 3  

0x1159  DATA LOGGER CHANNELS F004 1 R 1  

0x115A  DATA LOGGER DAYS F003 1 R 2  

Estados Internos Sistema - Internal System States

0x1160  Kswapd Time ** F005 1 R 2  
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0x1162  mtd2 Time ** F005 1 R 2  

0x1164  mtd3 Time ** F005 1 R 2  

0x1166  CPU Rtai ** F005 1 R 2  

0x1168  CPU Linux ** F005 1 R 2  

0x116A  Total RAM F005 1024 R 2  

0x116C  Used DRAM F005 1024 R 2  

0x116E  Free RAM ** F005 1024 R 2  

0x1170  Shared RAM ** F005 1024 R 2  

0x1172  Buffer RAM ** F005 1024 R 2  

0x1174  Cached RAM ** F005 1024 R 2  

0x1176  Green Counter ** F005 1 R 2  

0x1178  Yellow Counter ** F005 1 R 2  

0x117A  Orange Counter ** F005 1 R 2  

0x117C  Red Counter ** F005 1 R 2  

0x117E  UpTime F005 1 R 2  

0x1180 DSP Counter F005 1000 R 2

0x1182 CPU Usage F004 1000 R 1

0x120E ICD STATUS F012 R 1 0=UNKNOWN

1=ICD ERROR

2=MODIFIED

3=IN PROGRESS

4=OK WITHOUT DAIS

5=OK

6=NotValidated Empty

7=Passed to Validated

8=Default

9=ERROR HEADER CID

10=ERROR SG CID

0x120F ICD STATUS NOTVAL F012 R 1 0=UNKNOWN

1=ICD ERROR

2=MODIFIED

3=IN PROGRESS

4=OK WITHOUT DAIS

5=OK

6=NotValidated Empty

7=Passed to Validated

8=Default

9=ERROR HEADER CID

10=ERROR SG CID

** For version previous to 7.00
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Valor del Contador de Pulsos-Pulse Counter Value

0x121B PulseCntr Value 1 F002 1000
000

R 2

0x121D PulseCntr Value 2 F002 1000
000

R 2

0x121F PulseCntr Value 3 F002 1000
000

R 2

0x1221 PulseCntr Value 4 F002 1000
000

R 2

0x1223 PulseCntr Value 5 F002 1000
000

R 2

0x1225 PulseCntr Value 6 F002 1000
000

R 2

0x1227 PulseCntr Value 7 F002 1000
000

R 2

0x1229 PulseCntr Value 8 F002 1000
000

R 2

Valor del Contador de Pulsos Congelado-Freeze Pulse Counter Value

0x122B PulseCntr Freeze 1 F002 1000
000

R 2

0x122D PulseCntr Freeze 2 F002 1000
000

R 2

0x122F PulseCntr Freeze 3 F002 1000
000

R 2

0x1231 PulseCntr Freeze 4 F002 1000
000

R 2

0x1233 PulseCntr Freeze 5 F002 1000
000

R 2

0x1235 PulseCntr Freeze 6 F002 1000
000

R 2

0x1237 PulseCntr Freeze 7 F002 1000
000

R 2

0x1239 PulseCntr Freeze 8 F002 1000
000

R 2

0x1263 GLOBAL STARTS CNT F005 1000 R 2

0x1265 BLOCK LOCKOUT TIME F005 1000 R 2

Entradas analógicas remotas tipo float- Float Remote Analog Input

0x126D Rem Ana Inp FLOAT 1 F003 1000 R 2

0x126F Rem Ana Inp FLOAT 2 F003 1000 R 2

0x1271 Rem Ana Inp FLOAT 3 F003 1000 R 2

0x1273 Rem Ana Inp FLOAT 4 F003 1000 R 2

0x1275 Rem Ana Inp FLOAT 5 F003 1000 R 2

0x1277 Rem Ana Inp FLOAT 6 F003 1000 R 2

0x1279 Rem Ana Inp FLOAT 7 F003 1000 R 2

0x127B Rem Ana Inp FLOAT 8 F003 1000 R 2

Entradas analogicas remotas tipo entero- Integer Remote Analog Input

0x127D Rem Ana Inp INT 1 F005 1000 R 2

0x127F Rem Ana Inp INT 2 F005 1000 R 2

0x1281 Rem Ana Inp INT 3 F005 1000 R 2

0x1283 Rem Ana Inp INT 4 F005 1000 R 2

0x1285 Rem Ana Inp INT 5 F005 1000 R 2

0x1287 Rem Ana Inp INT 6 F005 1000 R 2

0x1289 Rem Ana Inp INT 7 F005 1000 R 2

0x128B Rem Ana Inp INT 8 F005 1000 R 2
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Entradas Analógicas (Tarjetas 2J y 2H)- Analog Inputs (2J and 2H boards)

0x137D  ANALOG_INP_2H_01 F002 1000 R 2  

0x137F  ANALOG_INP_2H_02 F002 1000 R 2  

...  ... ... ... ... ... ...

0x138B  ANALOG_INP_2H_08 F002 1000 R 2  

0x13FD  ANALOG_INP_2J_01 F002 1000 R 2  

0x13FF  ANALOG_INP_2J_02 F002 1000 R 2  

...  ... ... ... ... ... ...

0x140B  ANALOG_INP_2J_08 F002 1000 R 2  

Digital Counters Status

0x147D DIGCNT 1 VALUE F005 1000 R 2

0x147F DIGCNT 2 VALUE F005 1000 R 2

0x1481 DIGCNT 3 VALUE F005 1000 R 2

0x1483 DIGCNT 4 VALUE F005 1000 R 2

0x1485 DIGCNT 5 VALUE F005 1000 R 2

0x1487 DIGCNT 6 VALUE F005 1000 R 2

0x1489 DIGCNT 7 VALUE F005 1000 R 2

0x148B DIGCNT 8 VALUE F005 1000 R 2

0x148D DIGCNT 1 FROZENVALUE F005 1000 R 2

0x148F DIGCNT 2 FROZENVALUE F005 1000 R 2

0x1491 DIGCNT 3 FROZENVALUE F005 1000 R 2

0x1493 DIGCNT 4 FROZENVALUE F005 1000 R 2

0x1495 DIGCNT 5 FROZENVALUE F005 1000 R 2

0x1497 DIGCNT 6 FROZENVALUE F005 1000 R 2

0x1499 DIGCNT 7 FROZENVALUE F005 1000 R 2

0x149B DIGCNT 8 FROZENVALUE F005 1000 R 2

0x149D DIGCNT 1 FROZENDATE F011 R 3

0x14A0 DIGCNT 2 FROZENDATE F011 R 3

0x14A3 DIGCNT 3 FROZENDATE F011 R 3

0x14A6 DIGCNT 4 FROZENDATE F011 R 3

0x14A9 DIGCNT 5 FROZENDATE F011 R 3

0x14AC DIGCNT 6 FROZENDATE F011 R 3

0x14AF DIGCNT 7 FROZENDATE F011 R 3

0x14B2 DIGCNT 8 FROZENDATE F011 R 3

PTP 1588 Status

0x14E5 RTC Sync Source F012 1000 R 1 0=INTERNAL

1=PTP-PORT

2=SNTP

3=IRIG-B

4=SNTP2

0x14E6 GrandMaster-ID LOW F009 1000 R 4

0x14EA GrandMaster-ID HIGH F009 1000 R 4

0x14EE PTP ACCURACY F005 1000 R 2

0x14F0 PTP PORT A STATE F012 1000 R 1 0=DISABLED

1=NO SIGNAL

2=CALIBRATING

3=SYNCHD_NO_PDELAY

4=SYNCHRONIZED

0x14F1 PTP PORT B STATE F012 1000 R 1 0=DISABLED

1=NO SIGNAL
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2=CALIBRATING

3=SYNCHD_NO_PDELAY

4=SYNCHRONIZED

Application Versions (Part II)

0x14F3 Boot Version F004 1000 R 1

0x14F4 Boot Date F009 R 10

0x14FE Kinetis Boot Version F004 1000 R 1

0x14FF Kinetis Boot Date F009 R 10

0x1509 Kinetis Loader Ver F004 1000 R 1

0x150A Kinetis Loader Date F009 R 10

0x1514 Kinetis App Version F004 1000 R 1

0x1515 Kinetis App Date F009 R 10

0x151F DSP Version F004 1000 R 1

0x1520 DSP Date F009 R 16

Internal System States (Part II)

0x1530 DSP Status F005 1000 R 2

0x1532 Calibration Date F011 1000 R 3

Application Versions (Part III)

0x1535 Firmware Date F009 R 10

0x153F FPGA Version F009 1000 R 4

Internal System States (Part III)

0x1543 FLASH Usage F004 1000 R 1

0x1544 KINETIS Status F012 R 1 0=ERROR

1=BOOT_MODE

2=APP_MODE

0x1545 CPU MAX Usage F004 1000 R 1

Application Versions (Part IV)

0x1546 RM PRP HSR Version F009 1000 R 4

0x154A RM RSTP Version F009 1000 R 4

0x154E RM LLA Version F009 1000 R 4

0x1552 RM Bypass Version F009 1000 R 4

Internal System States (Part IV)

0x1556 Temp Current Value F004 1000 R 1

0x1557 Temp Max Value F004 1000 R 1

0x1558 Temp Min Value F004 1000 R 1

0x1559 Scan Cycle Average F004 1000 R 1

0x155A Scan Cycle Rate F004 1000 R 1

0x155C PLC Checksum F005 1000 R 2

0x155E Settings Checksum F005 1000 R 2

Application Versions (Part V)

0x1560 CPU Revision F004 1000 R 1

0x1561 ICD Edition F004 1000 R 1

Redundancy status

0x157C PRP_HSR A tx F005 1000 R 2

0x157E PRP_HSR B tx F005 1000 R 2

0x1580 PRP_HSR A err F005 1000 R 2

0x1582 PRP_HSR B err F005 1000 R 2

0x1584 RSTP PortA State F012 R 1 0=DISCARDING

1=LEARNING

2=FORWARDING
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0x1585 RSTP PortB State F012 R 1 0=DISCARDING

1=LEARNING

2=FORWARDING

Textos Maniobras - Commands text

0x1C00  OPERATION 1 F009 1 R/W 16  

0x1C10  OPERATION 2 F009 1 R/W 16  

... ... ... ... ... ... ... ...

0x1DF0  OPERATION24 F009 1 R/W 16  

0x1E00  Confirmation address   W 1  

PLC Timer Masks
0x1E01 TIMER MASK 01 F005 1 R/W 2 [0 , 86400000] ms

0x1E03 TIMER MASK 02 F005 1 R/W 2 [0 , 86400000] ms

0x1E05 TIMER MASK 03 F005 1 R/W 2 [0 , 86400000] ms

0x1E07 TIMER MASK 04 F005 1 R/W 2 [0 , 86400000] ms

0x1E09 TIMER MASK 05 F005 1 R/W 2 [0 , 86400000] ms

0x1E0B TIMER MASK 06 F005 1 R/W 2 [0 , 86400000] ms

0x1E0D TIMER MASK 07 F005 1 R/W 2 [0 , 86400000] ms

0x1E0F TIMER MASK 08 F005 1 R/W 2 [0 , 86400000] ms

0x1E11 TIMER MASK 09 F005 1 R/W 2 [0 , 86400000] ms

0x1E13 TIMER MASK 10 F005 1 R/W 2 [0 , 86400000] ms

0x1E15 TIMER MASK 11 F005 1 R/W 2 [0 , 86400000] ms

0x1E17 TIMER MASK 12 F005 1 R/W 2 [0 , 86400000] ms

0x1E19 TIMER MASK 13 F005 1 R/W 2 [0 , 86400000] ms

0x1E1B TIMER MASK 14 F005 1 R/W 2 [0 , 86400000] ms

0x1E1D TIMER MASK 15 F005 1 R/W 2 [0 , 86400000] ms

0x1E1F TIMER MASK 16 F005 1 R/W 2 [0 , 86400000] ms

0x1E3F Confirmation address W 1

Ajustes Tarjeta F - Board  F Settings

Ajustes de Tensión Tarjeta F - Board  F Voltage Settings

0x1E41  Voltage Threshold A_F F004 1 R/W 1 [10 , 230] V

0x1E42  Voltage Threshold B_F F004 1 R/W 1 [10 , 230] V

0x1EE6 Voltage Threshold C_F F004 1 R/W 1 [10 , 230] V

0x1EE7 Voltage Threshold D_F F004 1 R/W 1 [10 , 230] V

Ajustes Tiempo Antirrebotes Tarjeta F -  Board  F Debounce Time Settings

0x1E43  Debounce Time A_F F004 1 R/W 1 [1 , 50] ms

0x1E44  Debounce Time B_F F004 1 R/W 1 [1 , 50] ms

0x1EE8  Debounce Time C_F F004 1 R/W 1 [1 , 50] ms

0x1EE9  Debounce Time D_F F004 1 R/W 1 [1 , 50] ms

Ajuste Tipo de Entrada Tarjeta F (32 elementos) - Board  F Input Type Setting (32 items)

0x1E45  Input Type_F_CC1 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

0x1E46  Input Type_F_CC2 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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... ... ... ... ... ... ... ...

0x1E64  Input Type_F_CC32 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

Ajuste Tiempo Retardo Entradas Tarjeta F (32 elementos) - Board  F Delay Input Time Setting (32 items)

0x1E65  Delay Input Time_F_CC1 F005 1 R/W 2 [0 , 60000] ms

0x1E67  Delay Input Time_F_CC2 F005 1 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x1EA3  Delay Input Time_F_CC32 F005 1 R/W 2 [0 , 60000] ms

Ajuste Lógica de Salidas Tarjeta F (16 elementos) - Board  F Output Logic Settings (16 items)

0x1EA5  Output Logic_F_01 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

0x1EA6  Output Logic_F_02 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

... ... ... ... ... ... ... ...

0x1EB4  Output Logic_F_16 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

Ajuste Tipo de Salidas Tarjeta F (16 elementos) - Board  F Output Type  Settings (16 items)

0x1EB5  Output Type_F_01 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

0x1EB6  Output Type_F_02 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

... ... ... ... ... ... ... ...

0x1EC4  Output Type_F_16 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

Tiempo Pulso de Salida Tarjeta F - Board  F Pulse Output Time  Settings (16 items)

0x1EC5  Pulse Output Time_F_01 F005 1 R/W 2 [0 , 60000] ms

0x1EC7  Pulse Output Time_F_02 F005 1 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x1EE3  Pulse Output Time_F_16 F005 1 R/W 2 [0 , 60000] ms

0x1EE5  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

Ajuste Rango de Entrada Analogica F (8 elementos) - Board F Analog Input Range Settings (8 items)

0x1EEA Range_F_01 F012 1 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA

5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

0x1EEB Range_F_02 F012 1 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

... ... ... ... ... ... ... ...

0x1EF1 Range_F_08 F012 1 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA

5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

Ajuste Rango de Medida de Entrada Analógica F (8 elementos) - Board F Analog Input Measurement Range (8 items)

0x1EF2 Min Value_F_01 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1EF4 Min Value_F_02 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1EF6 Min Value_F_03 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1EF8 Min Value_F_04 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1EFA Min Value_F_05 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1EFC Min Value_F_06 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1EFE Min Value_F_07 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F00 Min Value_F_08 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F02 Max Value_F_01 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F04 Max Value_F_02 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F06 Max Value_F_03 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F08 Max Value_F_04 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F0A Max Value_F_05 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F0C Max Value_F_06 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F0E Max Value_F_07 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F10 Max Value_F_08 F003 1 R/W 2 [-9999.99 , 9999.99]  

0x1F12 Channelx1a_F_01 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F14 Channelx1a_F_02 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F16 Channelx1a_F_03 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F18 Channelx1a_F_04 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F1A Channelx1a_F_05 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F1C Channelx1a_F_06 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F1E Channelx1a_F_07 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F20 Channelx1a_F_08 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F22 Channelx1b_F_01 F004 1000 R/W 1 [-1000 , 1000]  

0x1F23 Channelx1b_F_02 F004 1000 R/W 1 [-1000 , 1000]  

0x1F24 Channelx1b_F_03 F004 1000 R/W 1 [-1000 , 1000]  

0x1F25 Channelx1b_F_04 F004 1000 R/W 1 [-1000 , 1000]  

0x1F26 Channelx1b_F_05 F004 1000 R/W 1 [-1000 , 1000]  

0x1F27 Channelx1b_F_06 F004 1000 R/W 1 [-1000 , 1000]  

0x1F28 Channelx1b_F_07 F004 1000 R/W 1 [-1000 , 1000]  

0x1F29 Channelx1b_F_08 F004 1000 R/W 1 [-1000 , 1000]  

0x1F2A Channelx10a_F_01 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F2C Channelx10a_F_02 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F2E Channelx10a_F_03 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F30 Channelx10a_F_04 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F32 Channelx10a_F_05 F003 1000 R/W 2 [0,950 , 1,050]  

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x1F34 Channelx10a_F_06 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F36 Channelx10a_F_07 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F38 Channelx10a_F_08 F003 1000 R/W 2 [0,950 , 1,050]  

0x1F3A Channelx10b_F_01 F004 1000 R/W 1 [-1000 , 1000]  

0x1F3B Channelx10b_F_02 F004 1000 R/W 1 [-1000 , 1000]  

0x1F3C Channelx10b_F_03 F004 1000 R/W 1 [-1000 , 1000]  

0x1F3D Channelx10b_F_04 F004 1000 R/W 1 [-1000 , 1000]  

0x1F3E Channelx10b_F_05 F004 1000 R/W 1 [-1000 , 1000]  

0x1F3F Channelx10b_F_06 F004 1000 R/W 1 [-1000 , 1000]  

0x1F40 Channelx10b_F_07 F004 1000 R/W 1 [-1000 , 1000]  

0x1F41 Channelx10b_F_08 F004 1000 R/W 1 [-1000 , 1000]  

0x1F42 Calibration Type_F F012 1000 R/W 1 0=NONE

1=OFFSET

2=CALIBRATION

3=GET CALIBRATION

0x1FE4  Confirmation address   W 1  

Ajustes Tarjeta G - Board  G Settings

Ajustes de Tensión Tarjeta G - Board  G Voltage Settings

0x1FE6  Voltage Threshold A_G F004 1 R/W 1 [10 , 230] V

0x1FE7  Voltage Threshold B_G F004 1 R/W 1 [10 , 230] V

0x208B  Voltage Threshold C_G F004 1 R/W 1 [10 , 230] V

0x208C  Voltage Threshold D_G F004 1 R/W 1 [10 , 230] V

Tiempo Antirrebotes Tarjeta G -  Board  G Debounce Time Settings 

0x1FE8  Debounce Time A_G F004 1 R/W 1 [1 , 50] ms

0x1FE9  Debounce Time B_G F004 1 R/W 1 [1 , 50] ms

0x208D  Debounce Time C_G F004 1 R/W 1 [1 , 50] ms

0x208E  Debounce Time D_G F004 1 R/W 1 [1 , 50] ms

Ajuste Tipo de Entrada Tarjeta G (32 elementos) - Board  G Input Type  Settings (32 items)

0x1FEA  Input Type_G_CC1 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

0x1FEB  Input Type_G_CC2 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

... ... ... ... ... ... ... ...

0x2009  Input Type_G_CC32 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

Ajustes Tiempo Retardo Entradas Tarjeta G (32 elementos) - Board  G Delay Input Time  Settings (32 items)

0x200A  Delay Input Time_G_CC1 F005 1 R/W 2 [0 , 60000] ms

0x200C  Delay Input Time_G_CC2 F005 1 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x2048  Delay Input Time_G_CC32 F005 1 R/W 2 [0 , 60000] ms

Ajustes Lógica de Salidas Tarjeta G (16 elementos) - Board  G Output Logic  Settings (16 items)

0x204A  Output Logic_G_01 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

0x204B  Output Logic_G_02 F012 1 R/W 1 0=POSITIVE

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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       1=NEGATIVE

... ... ... ... ... ... ... ...

0x2059  Output Logic_G_16 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

Ajustes Tipo de Salidas Tarjeta G (16 elementos) - Board  G Output Type  Settings (16 items)

0x205A  Output Type_G_01 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

0x205B  Output Type_G_02 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

... ... ... ... ... ... ... ...

0x2069  Output Type_G_16 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

Ajustes Tiempo Pulso de Salida Tarjeta G - Board  G Pulse Output Time  Settings (16 items)

0x206A  Pulse Output Time_G_01 F005 1 R/W 2 [0 , 60000] ms

0x206C  Pulse Output Time_G_02 F005 1 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x2088  Pulse Output Time_G_16 F005 1 R/W 2 [0 , 60000] ms

0x208A  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

Ajuste Rango de Entrada Analogica G (8 elementos) - Board  G Analog Input Range  Settings (8 items)

0x208F  Range_G_01 F012 1 R/W 1 0=NONE

       1=-1 to 0 mA

       2= 0 to 1mA

       3=-1 to 1mA

       4= 0 to 5 mA

       5= 0 to 10mA

       6= 0 to 20mA

       7= 4 to 20mA

... ... ... ... ... ... ... ...

0x2096  Range_G_08 F012 1 R/W 1 0=NONE

       1=-1 to 0 mA

       2= 0 to 1mA

       3=-1 to 1mA

       4= 0 to 5 mA

       5= 0 to 10mA

       6= 0 to 20mA

       7= 4 to 20mA

Ajustes Rango de Medida de Entrada Analógica G (8 elementos) - Board G Analog Input Measurement Range  Settings (8 items)

0x2097  Min Value_G_01 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x2099  Min Value_G_02 F003 1 R/W 2 [-9999.99 , 9999.99] 

... ... ... ... ... ... ... ...

0x20A5  Min Value_G_08 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x20A7  Max Value_G_01 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x20A9  Max Value_G_02 F003 1 R/W 2 [-9999.99 , 9999.99] 

... ... ... ... ... ... ... ...

0x20B5  Max Value_G_08 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x20B7 Channelx1a_G_01 F003 1000 R/W 2 [0,950 , 1,050]  
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0x20B9 Channelx1a_G_02 F003 1000 R/W 2 [0,950 , 1,050]  

0x20BB Channelx1a_G_03 F003 1000 R/W 2 [0,950 , 1,050]  

0x20BD Channelx1a_G_04 F003 1000 R/W 2 [0,950 , 1,050]  

0x20BF Channelx1a_G_05 F003 1000 R/W 2 [0,950 , 1,050]  

0x20C1 Channelx1a_G_06 F003 1000 R/W 2 [0,950 , 1,050]  

0x20C3 Channelx1a_G_07 F003 1000 R/W 2 [0,950 , 1,050]  

0x20C5 Channelx1a_G_08 F003 1000 R/W 2 [0,950 , 1,050]  

0x20C7 Channelx1b_G_01 F004 1000 R/W 1 [-1000 , 1000]  

0x20C8 Channelx1b_G_02 F004 1000 R/W 1 [-1000 , 1000]  

0x20C9 Channelx1b_G_03 F004 1000 R/W 1 [-1000 , 1000]  

0x20CA Channelx1b_G_04 F004 1000 R/W 1 [-1000 , 1000]  

0x20CB Channelx1b_G_05 F004 1000 R/W 1 [-1000 , 1000]  

0x20CC Channelx1b_G_06 F004 1000 R/W 1 [-1000 , 1000]  

0x20CD Channelx1b_G_07 F004 1000 R/W 1 [-1000 , 1000]  

0x20CE Channelx1b_G_08 F004 1000 R/W 1 [-1000 , 1000]  

0x20CF Channelx10a_G_01 F003 1000 R/W 2 [0,950 , 1,050]  

0x20D1 Channelx10a_G_02 F003 1000 R/W 2 [0,950 , 1,050]  

0x20D3 Channelx10a_G_03 F003 1000 R/W 2 [0,950 , 1,050]  

0x20D5 Channelx10a_G_04 F003 1000 R/W 2 [0,950 , 1,050]  

0x20D7 Channelx10a_G_05 F003 1000 R/W 2 [0,950 , 1,050]  

0x20D9 Channelx10a_G_06 F003 1000 R/W 2 [0,950 , 1,050]  

0x20DB Channelx10a_G_07 F003 1000 R/W 2 [0,950 , 1,050]  

0x20DD Channelx10a_G_08 F003 1000 R/W 2 [0,950 , 1,050]  

0x20DF Channelx10b_G_01 F004 1000 R/W 1 [-1000 , 1000]  

0x20E0 Channelx10b_G_02 F004 1000 R/W 1 [-1000 , 1000]  

0x20E1 Channelx10b_G_03 F004 1000 R/W 1 [-1000 , 1000]  

0x20E2 Channelx10b_G_04 F004 1000 R/W 1 [-1000 , 1000]  

0x20E3 Channelx10b_G_05 F004 1000 R/W 1 [-1000 , 1000]  

0x20E4 Channelx10b_G_06 F004 1000 R/W 1 [-1000 , 1000]  

0x20E5 Channelx10b_G_07 F004 1000 R/W 1 [-1000 , 1000]  

0x20E6 Channelx10b_G_08 F004 1000 R/W 1 [-1000 , 1000]  

0x20E7 Calibration Type_G F012 1000 R/W 1 0=NONE

1=OFFSET

2=CALIBRATION

3=GET CALIBRATION

0x2189  Confirmation address   W 1  

Ajustes Tarjeta H (MODULO CIO) - Board  H Settings (CIO MODULE)

Ajustes Tipo Tarjeta H - Board  H Board Type Settings

0x2F5B  I/O Board Type_H F012 1 R/W 1 0=NONE

       1=16INP + 8OUT

       2=8INP + 8OUT + SUPV

       4=32INP

       5=16INP + 8ANA

Ajustes de Tensión Tarjeta H - Board  H Voltage Settings

0x2F5C  Voltage Threshold A_H F004 1 R/W 1 [10 , 230] V

0x2F5D  Voltage Threshold B_H F004 1 R/W 1 [10 , 230] V

0x3001  Voltage Threshold C_H F004 1 R/W 1 [10 , 230] V

0x3002  Voltage Threshold D_H F004 1 R/W 1 [10 , 230] V

Tiempo Antirrebotes Tarjeta H -  Board  H Debounce Time Settings

0x2F5E  Debounce Time A_H F004 1 R/W 1 [1 , 50] ms
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B-50 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

B.5 MEMORY MAP APPENDIX B:  MODBUS PROTOCOL

0x2F5F  Debounce Time B_H F004 1 R/W 1 [1 , 50] ms

0x3003  Debounce Time C_H F004 1 R/W 1 [1 , 50] ms

0x3004  Debounce Time D_H F004 1 R/W 1 [1 , 50] ms

Ajuste Tipo de Entrada Tarjeta H (32 elementos) - Board  H Input Type  Settings (32 items)

0x2F60  Input Type_H_CC1 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

0x2F61  Input Type_H_CC2 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

... ... ... ... ... ... ... ...

0x2F7F  Input Type_H_CC32 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

Ajuste Tiempo Retardo Entradas Tarjeta H (32 elementos) - Board  H Delay Input Time Settings (32 items)

0x2F80  Delay Input Time_H_CC1 F005 1 R/W 2 [0 , 60000] ms

0x2F82  Delay Input Time_H_CC2 F005 1 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x2FBE  Delay Input Time_H_CC32 F005 1 R/W 2 [0 , 60000] ms

Ajuste Lógica de Salidas Tarjeta H (16 elementos) - Board  H Output Logic Settings (16 items)

0x2FC0  Output Logic_H_01 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

0x2FC1  Output Logic_H_02 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

... ... ... ... ... ... ... ...

0x2FCF  Output Logic_H_16 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

Ajuste Tipo de Salidas Tarjeta H (16 elementos) - Board  H Output Type Settings (16 items)

0x2FD0  Output Type_H_01 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

0x2FD1  Output Type_H_02 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

... ... ... ... ... ... ... ...

0x2FDF  Output Type_H_16 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

Ajuste Tiempo Pulso de Salida Tarjeta H - Board  H Pulse Output Time Settings (16 items)

0x2FE0  Pulse Output Time_H_01 F005 1 R/W 2 [0 , 60000] ms

0x2FE2  Pulse Output Time_H_02 F005 1 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x2FFE  Pulse Output Time_H_16 F005 1 R/W 2 [0 , 60000] ms

0x3000  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

Ajuste Rango de Entrada Analogica H (8 elementos) - Board  H Analog Input Range Settings (8 items)

0x3005  Range_H_01 F012 1 R/W 1 0=NONE
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       1=-1 to 0 mA

       2= 0 to 1mA

       3=-1 to 1mA

       4= 0 to 5 mA

       5= 0 to 10mA

       6= 0 to 20mA

       7= 4 to 20mA

... ... ... ... ... ... ... ...

0x300C  Range_H_08 F012 1 R/W 1 0=NONE

       1=-1 to 0 mA

       2= 0 to 1mA

       3=-1 to 1mA

       4= 0 to 5 mA

       5= 0 to 10mA

       6= 0 to 20mA

       7= 4 to 20mA

Ajuste Rango de Medida de Entrada Analógica H (8 elementos) - Board H: Analog Input Measurement Range (8 items)

0x300D  Min Value_H_01 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x300F  Min Value_H_02 F003 1 R/W 2 [-9999.99 , 9999.99] 

... ... ... ... ... ... ... ...

0x301B  Min Value_H_08 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x301D  Max Value_H_01 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x301F  Max Value_H_02 F003 1 R/W 2 [-9999.99 , 9999.99] 

... ... ... ... ... ... ... ...

0x302B  Max Value_H_08 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x302D Channelx1a_H_01 F003 1000 R/W 2 [0,950 , 1,050]  

0x302F Channelx1a_H_02 F003 1000 R/W 2 [0,950 , 1,050]  

0x3031 Channelx1a_H_03 F003 1000 R/W 2 [0,950 , 1,050]  

0x3033 Channelx1a_H_04 F003 1000 R/W 2 [0,950 , 1,050]  

0x3035 Channelx1a_H_05 F003 1000 R/W 2 [0,950 , 1,050]  

0x3037 Channelx1a_H_06 F003 1000 R/W 2 [0,950 , 1,050]  

0x3039 Channelx1a_H_07 F003 1000 R/W 2 [0,950 , 1,050]  

0x303B Channelx1a_H_08 F003 1000 R/W 2 [0,950 , 1,050]  

0x303D Channelx1b_H_01 F004 1000 R/W 1 [-1000 , 1000]  

0x303E Channelx1b_H_02 F004 1000 R/W 1 [-1000 , 1000]  

0x303F Channelx1b_H_03 F004 1000 R/W 1 [-1000 , 1000]  

0x3040 Channelx1b_H_04 F004 1000 R/W 1 [-1000 , 1000]  

0x3041 Channelx1b_H_05 F004 1000 R/W 1 [-1000 , 1000]  

0x3042 Channelx1b_H_06 F004 1000 R/W 1 [-1000 , 1000]  

0x3043 Channelx1b_H_07 F004 1000 R/W 1 [-1000 , 1000]  

0x3044 Channelx1b_H_08 F004 1000 R/W 1 [-1000 , 1000]  

0x3045 Channelx10a_H_01 F003 1000 R/W 2 [0,950 , 1,050]  

0x3047 Channelx10a_H_02 F003 1000 R/W 2 [0,950 , 1,050]  

0x3049 Channelx10a_H_03 F003 1000 R/W 2 [0,950 , 1,050]  

0x304B Channelx10a_H_04 F003 1000 R/W 2 [0,950 , 1,050]  

0x304D Channelx10a_H_05 F003 1000 R/W 2 [0,950 , 1,050]  

0x304F Channelx10a_H_06 F003 1000 R/W 2 [0,950 , 1,050]  

0x3051 Channelx10a_H_07 F003 1000 R/W 2 [0,950 , 1,050]  

0x3053 Channelx10a_H_08 F003 1000 R/W 2 [0,950 , 1,050]  

0x3055 Channelx10b_H_01 F004 1000 R/W 1 [-1000 , 1000]  
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0x3056 Channelx10b_H_02 F004 1000 R/W 1 [-1000 , 1000]  

0x3057 Channelx10b_H_03 F004 1000 R/W 1 [-1000 , 1000]  

0x3058 Channelx10b_H_04 F004 1000 R/W 1 [-1000 , 1000]  

0x3059 Channelx10b_H_05 F004 1000 R/W 1 [-1000 , 1000]  

0x305A Channelx10b_H_06 F004 1000 R/W 1 [-1000 , 1000]  

0x305B Channelx10b_H_07 F004 1000 R/W 1 [-1000 , 1000]  

0x305C Channelx10b_H_08 F004 1000 R/W 1 [-1000 , 1000]  

0x305D Calibration Type_H F012 1000 R/W 1 0=NONE

1=OFFSET

2=CALIBRATION

3=GET CALIBRATION

0x30FF  Confirmation address   W 1  

Ajustes Tarjeta J (MODULO CIO) - Board J Settings (CIO MODULE)

Ajustes Tipo Tarjeta J - Board J Board Type Settings

0x3100  I/O Board Type_J F012 1 R/W 1 0=NONE

       1=16INP + 8OUT

       2=8INP + 8OUT + SUPV

       4=32INP

       5=16INP + 8ANA

Ajustes de Tensión Tarjeta J - Board J Voltage Settings

0x3101  Voltage Threshold A_J F004 1 R/W 1 [10 , 230] V

0x3102  Voltage Threshold B_J F004 1 R/W 1 [10 , 230] V

0x31A6  Voltage Threshold C_J F004 1 R/W 1 [10 , 230] V

0x31A7  Voltage Threshold D_J F004 1 R/W 1 [10 , 230] V

Ajustes Tiempo Antirrebotes Tarjeta J -  Board J Debounce Time Settings

0x3103  Debounce Time A_J F004 1 R/W 1 [1 , 50] ms

0x3104  Debounce Time B_J F004 1 R/W 1 [1 , 50] ms

0x31A8  Debounce Time C_J F004 1 R/W 1 [1 , 50] ms

0x31A9  Debounce Time D_J F004 1 R/W 1 [1 , 50] ms

Ajuste Tipo de Entrada Tarjeta J (32 elementos) - Board J Input Type Settings (32 items)

0x3105  Input Type_J_CC1 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

0x3106  Input Type_J_CC2 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

... ... ... ... ... ... ... ...

0x3124  Input Type_J_CC32 F012 1 R/W 1 0=POSITIVE-EDGE

       1=NEGATIVE-EDGE

       2=POSITIVE

       3=NEGATIVE

Ajustes Tiempo Retardo Entradas Tarjeta J (32 elementos) - Board  J Delay Input Time Settings (32 items)

0x3125  Delay Input Time_J_CC1 F005 1 R/W 2 [0 , 60000] ms

0x3127  Delay Input Time_J_CC2 F005 1 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x3163  Delay Input Time_J_CC32 F005 1 R/W 2 [0 , 60000] ms

Ajustes Lógica de Salidas Tarjeta J (16 elementos) - Board  J Output Logic Settings (16 items)

0x3165  Output Logic_J_01 F012 1 R/W 1 0=POSITIVE
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       1=NEGATIVE

0x3166  Output Logic_J_02 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

... ... ... ... ... ... ... ...

0x3174  Output Logic_J_16 F012 1 R/W 1 0=POSITIVE

       1=NEGATIVE

Ajustes Tipo de Salidas Tarjeta J (16 elementos) - Board  J Output Type Settings (16 items)

0x3175  Output Type_J_01 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

0x3176  Output Type_J_02 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

... ... ... ... ... ... ... ...

0x3184  Output Type_J_16 F012 1 R/W 1 0=NORMAL

       1=PULSE

       2=LATCH

Ajustes Tiempo Pulso de Salida Tarjeta J - Board  J Pulse Output Time Settings (16 items)

0x3185  Pulse Output Time_J_01 F005 1 R/W 2 [0 , 60000] ms

0x3187  Pulse Output Time_J_02 F005 1 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x31A3  Pulse Output Time_J_16 F005 1 R/W 2 [0 , 60000] ms

0x31A5  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

Ajuste Rango de Entrada Analogica J (8 elementos) - Board  J Analog Input Range Settings (8 items)

0x31AA  Range_J_01 F012 1 R/W 1 0=NONE

       1=-1 to 0 mA

       2= 0 to 1mA

       3=-1 to 1mA

       4= 0 to 5 mA

       5= 0 to 10mA

       6= 0 to 20mA

       7= 4 to 20mA

... ... ... ... ... ... ... ...

0x31B1  Range_J_08 F012 1 R/W 1 0=NONE

       1=-1 to 0 mA

       2= 0 to 1mA

       3=-1 to 1mA

       4= 0 to 5 mA

       5= 0 to 10mA

       6= 0 to 20mA

       7= 4 to 20mA

Ajustes Rango de Medida de Entrada Analógica J (8 elementos) - Board J Analog Input Measurement Range Settings (8 items)

0x31B2  Min Value_J_01 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x31B4  Min Value_J_02 F003 1 R/W 2 [-9999.99 , 9999.99] 

... ... ... ... ... ... ... ...

0x31C0  Min Value_J_08 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x31C2  Max Value_J_01 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x31C4  Max Value_J_02 F003 1 R/W 2 [-9999.99 , 9999.99] 

... ... ... ... ... ... ... ...
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0x31D0  Max Value_J_08 F003 1 R/W 2 [-9999.99 , 9999.99] 

0x31D2 Channelx1a_J_01 F003 1000 R/W 2 [0,950 , 1,050]  

0x31D4 Channelx1a_J_02 F003 1000 R/W 2 [0,950 , 1,050]  

0x31D6 Channelx1a_J_03 F003 1000 R/W 2 [0,950 , 1,050]  

0x31D8 Channelx1a_J_04 F003 1000 R/W 2 [0,950 , 1,050]  

0x31DA Channelx1a_J_05 F003 1000 R/W 2 [0,950 , 1,050]  

0x31DC Channelx1a_J_06 F003 1000 R/W 2 [0,950 , 1,050]  

0x31DE Channelx1a_J_07 F003 1000 R/W 2 [0,950 , 1,050]  

0x31E0 Channelx1a_J_08 F003 1000 R/W 2 [0,950 , 1,050]  

0x31E2 Channelx1b_J_01 F004 1000 R/W 1 [-1000 , 1000]  

0x31E3 Channelx1b_J_02 F004 1000 R/W 1 [-1000 , 1000]  

0x31E4 Channelx1b_J_03 F004 1000 R/W 1 [-1000 , 1000]  

0x31E5 Channelx1b_J_04 F004 1000 R/W 1 [-1000 , 1000]  

0x31E6 Channelx1b_J_05 F004 1000 R/W 1 [-1000 , 1000]  

0x31E7 Channelx1b_J_06 F004 1000 R/W 1 [-1000 , 1000]  

0x31E8 Channelx1b_J_07 F004 1000 R/W 1 [-1000 , 1000]  

0x31E9 Channelx1b_J_08 F004 1000 R/W 1 [-1000 , 1000]  

0x31EA Channelx10a_J_01 F003 1000 R/W 2 [0,950 , 1,050]  

0x31EC Channelx10a_J_02 F003 1000 R/W 2 [0,950 , 1,050]  

0x31EE Channelx10a_J_03 F003 1000 R/W 2 [0,950 , 1,050]  

0x31F0 Channelx10a_J_04 F003 1000 R/W 2 [0,950 , 1,050]  

0x31F2 Channelx10a_J_05 F003 1000 R/W 2 [0,950 , 1,050]  

0x31F4 Channelx10a_J_06 F003 1000 R/W 2 [0,950 , 1,050]  

0x31F6 Channelx10a_J_07 F003 1000 R/W 2 [0,950 , 1,050]  

0x31F8 Channelx10a_J_08 F003 1000 R/W 2 [0,950 , 1,050]  

0x31FA Channelx10b_J_01 F004 1000 R/W 1 [-1000 , 1000]  

0x31FB Channelx10b_J_02 F004 1000 R/W 1 [-1000 , 1000]  

0x31FC Channelx10b_J_03 F004 1000 R/W 1 [-1000 , 1000]  

0x31FD Channelx10b_J_04 F004 1000 R/W 1 [-1000 , 1000]  

0x31FE Channelx10b_J_05 F004 1000 R/W 1 [-1000 , 1000]  

0x31FF Channelx10b_J_06 F004 1000 R/W 1 [-1000 , 1000]  

0x3200 Channelx10b_J_07 F004 1000 R/W 1 [-1000 , 1000]  

0x3201 Channelx10b_J_08 F004 1000 R/W 1 [-1000 , 1000]  

0x3202 Calibration Type_J F012 1000 R/W 1 0=NONE

1=OFFSET

2=CALIBRATION

3=GET CALIBRATION

0x32A4  Confirmation address   W 1  

Ajustes Generales - General Settings

0x218A  Phase CT Ratio F003 1 R/W 2 [1.0 , 6000.0]  

0x218C  Ground CT Ratio F003 1 R/W 2 [1.0 , 6000.0]  

0x218E  Stv Ground CT Ratio F003 1 R/W 2 [1.0 , 6000.0]  

0x2190  Phase VT Ratio F003 1 R/W 2 [1.0 , 6000.0]  

0x2192  Phase VT Connection F012 1 R/W 1 0=WYE

       1=DELTA

0x2193  Nominal Voltage F003 1 R/W 2 [1.0 , 250.0] V

0x2195  Nominal Frequency F012 1 R/W 1 0=50 Hz

       1=60 Hz

0x2196  Phase Rotation F012 1 R/W 1 0=ABC

       1=ACB
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0x2197  Frequency Reference F012 1 R/W 1 0=VI

       1=VII

       2=VIII

0x2198  Auxiliary Voltage F012 1 R/W 1 0=VX

       1=VN

0x2199  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x219B Primary Meter Units F012 1 R/W 1 0=KA_KV

1=A_V

0x219C Device Name F009 1 R/W 8

0x2203  Confirmation address   W 1  

Ajustes Sincronismo - Synchrocheck Settings

0x2731  Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2732  Dead Bus Level F003 1 R/W 2 [0.00 , 300.00] V

0x2734  Live Bus Level F003 1 R/W 2 [0.00 , 300.00] V

0x2736  Dead Line Level F003 1 R/W 2 [0.00 , 300.00] V

0x2738  Live Line Level F003 1 R/W 2 [0.00 , 300.00] V

0x273A  Max Volt Difference F003 1 R/W 2 [2.00 , 300.00] V

0x273C  Max Angle Difference F003 1 R/W 2 [2.0 , 80.0] Deg

0x273E  Max Freq Difference F003 1 R/W 2 [10 , 5000] mHz

0x2740  Time F003 1 R/W 2 [0.01 , 600.00] s

0x2742  DL-DB Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2743  LL-DB Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2744  DL-LB Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2745  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2762  Confirmation address   W 1  

Ajustes Reenganchador - Recloser Settings

0x2763  Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2764  Max Number Shots F004 1 R/W 1 [1 , 4]  

0x2765  Dead Time 1 F003 1 R/W 2 [0.00 , 900.00] s

0x2767  Dead Time 2 F003 1 R/W 2 [0.00 , 900.00] s

0x2769  Dead Time 3 F003 1 R/W 2 [0.00 , 900.00] s

0x276B  Dead Time 4 F003 1 R/W 2 [0.00 , 900.00] s

0x276D  Reclaim Time F003 1 R/W 2 [0.00 , 900.00] s

0x276F  Cond. Permission F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2770  Hold Time F003 1 R/W 2 [0.00 , 900.00] s

0x2772  Reset Time F003 1 R/W 2 [0.00 , 900.00] s

0x2774  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x278B  Confirmation address   W 1  

Ajustes Oscilografía - Oscillography Settings

0x2A7C  Function F012 1 R/W 1 0=DISABLED

       1=ENABLED
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0x2A7D  Trigger Position F004 1 R/W 1 [5 , 95] %

0x2A7E  Samples/Cycle F012 1 R/W 1 0=64

       1=32

       2=16

       3=8

       4=4

0x2A7F  Max. Number Osc. F004 1 R/W 1 [1 , 20]  

0x2A80  Automatic Overwrite F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2A81  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2A92  Confirmation address   W 1  

Textos Canales Digitales - Osc digital channels text

0x2AC8  Channel 1 Txt F009 1 R/W 16  

0x2AD8  Channel 2 Txt F009 1 R/W 16  

0x2AE8  Channel 3 Txt F009 1 R/W 16  

0x2AF8  Channel 4 Txt F009 1 R/W 16  

0x2B08  Channel 5 Txt F009 1 R/W 16  

0x2B18  Channel 6 Txt F009 1 R/W 16  

0x2B28  Channel 7 Txt F009 1 R/W 16  

0x2B38  Channel 8 Txt F009 1 R/W 16  

0x2B48  Channel 9 Txt F009 1 R/W 16  

0x2B58  Channel 10 Txt F009 1 R/W 16  

0x2B68  Channel 11 Txt F009 1 R/W 16  

0x2B78  Channel 12 Txt F009 1 R/W 16  

0x2B88  Channel 13 Txt F009 1 R/W 16  

0x2B98  Channel 14 Txt F009 1 R/W 16  

0x2BA8  Channel 15 Txt F009 1 R/W 16  

0x2BB8  Channel 16 Txt F009 1 R/W 16  

0x2C07  Confirmation address   W 1  

Ajustes Ethernet 1 (or “A”)- ETHERNET 1 (or “A”) Settings

0x2C53  IP Address Oct1 F004 1 R/W 1 [0 , 255]  

0x2C54  IP Address Oct2 F004 1 R/W 1 [0 , 255]  

0x2C55  IP Address Oct3 F004 1 R/W 1 [0 , 255]  

0x2C56  IP Address Oct4 F004 1 R/W 1 [0 , 255]  

0x2C57  Netmask Oct1 F004 1 R/W 1 [0 , 255]  

0x2C58  Netmask Oct2 F004 1 R/W 1 [0 , 255]  

0x2C59  Netmask Oct3 F004 1 R/W 1 [0 , 255]  

0x2C5A  Netmask Oct4 F004 1 R/W 1 [0 , 255]  

0x2C5B  Gateway IP Oct1 F004 1 R/W 1 [0 , 255]  

0x2C5C  Gateway IP Oct2 F004 1 R/W 1 [0 , 255]  

0x2C5D  Gateway IP Oct3 F004 1 R/W 1 [0 , 255]  

0x2C5E  Gateway IP Oct4 F004 1 R/W 1 [0 , 255]  

0x2C86  Confirmation address   W 1  

Ajustes Ethernet 2 (or “B”) - ETHERNET 2 (or “B”) Settings

0x2C87  IP Address Oct1 F004 1 R/W 1 [0 , 255]  

0x2C88  IP Address Oct2 F004 1 R/W 1 [0 , 255]  

0x2C89  IP Address Oct3 F004 1 R/W 1 [0 , 255]  

0x2C8A  IP Address Oct4 F004 1 R/W 1 [0 , 255]  

0x2C8B  Netmask Oct1 F004 1 R/W 1 [0 , 255]  
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0x2C8C  Netmask Oct2 F004 1 R/W 1 [0 , 255]  

0x2C8D  Netmask Oct3 F004 1 R/W 1 [0 , 255]  

0x2C8E  Netmask Oct4 F004 1 R/W 1 [0 , 255]  

0x2C8F  Gateway IP Oct1 F004 1 R/W 1 [0 , 255]  

0x2C90  Gateway IP Oct2 F004 1 R/W 1 [0 , 255]  

0x2C91  Gateway IP Oct3 F004 1 R/W 1 [0 , 255]  

0x2C92  Gateway IP Oct4 F004 1 R/W 1 [0 , 255]  

0x2CBA  Confirmation address   W 1  

Ajustes DNP 3.0 Esclavo 1 - DNP 3.0  Slave 1 Settings

0x2CBB  Physical Port F012 1 R/W 1 0=NONE

       1=COM1

       2=COM2

       3=NETWORK

0x2CBC  Address F005 1 R/W 2 [0 , 65534]  

0x2CBE  IP Addr Client1 Oct1 F004 1 R/W 1 [0 , 255]  

0x2CBF  IP Addr Client1 Oct2 F004 1 R/W 1 [0 , 255]  

0x2CC0  IP Addr Client1 Oct3 F004 1 R/W 1 [0 , 255]  

0x2CC1  IP Addr Client1 Oct4 F004 1 R/W 1 [0 , 255]  

0x2CC2  IP Addr Client2 Oct1 F004 1 R/W 1 [0 , 255]  

0x2CC3  IP Addr Client2 Oct2 F004 1 R/W 1 [0 , 255]  

0x2CC4  IP Addr Client2 Oct3 F004 1 R/W 1 [0 , 255]  

0x2CC5  IP Addr Client2 Oct4 F004 1 R/W 1 [0 , 255]  

0x2CC6  IP Addr Client3 Oct1 F004 1 R/W 1 [0 , 255]  

0x2CC7  IP Addr Client3 Oct2 F004 1 R/W 1 [0 , 255]  

0x2CC8  IP Addr Client3 Oct3 F004 1 R/W 1 [0 , 255]  

0x2CC9  IP Addr Client3 Oct4 F004 1 R/W 1 [0 , 255]  

0x2CCA  IP Addr Client4 Oct1 F004 1 R/W 1 [0 , 255]  

0x2CCB  IP Addr Client4 Oct2 F004 1 R/W 1 [0 , 255]  

0x2CCC  IP Addr Client4 Oct3 F004 1 R/W 1 [0 , 255]  

0x2CCD  IP Addr Client4 Oct4 F004 1 R/W 1 [0 , 255]  

0x2CCE  IP Addr Client5 Oct1 F004 1 R/W 1 [0 , 255]  

0x2CCF  IP Addr Client5 Oct2 F004 1 R/W 1 [0 , 255]  

0x2CD0  IP Addr Client5 Oct3 F004 1 R/W 1 [0 , 255]  

0x2CD1  IP Addr Client5 Oct4 F004 1 R/W 1 [0 , 255]  

0x2CD2  TCP/UDP Port F005 1 R/W 2 [0 , 65535]  

0x2CD4  Unsol Resp Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2CD5  Unsol Resp TimeOut F005 1 R/W 2 [0 , 60] s

0x2CD7  Unsol Resp Max Ret F004 1 R/W 1 [0 , 255]  

0x2CD8  Unsol Resp Dest Adr F005 1 R/W 2 [0 , 65519]  

0x2CDA  Current Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2CDB  Voltage Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001
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       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2CDC  Power Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2CDD  Energy Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2CDE  Other Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2CDF  Current Deadband F005 1 R/W 2 [0 , 65535]  

0x2CE1  Voltage Deadband F005 1 R/W 2 [0 , 65535]  

0x2CE3  Power Deadband F005 1 R/W 2 [0 , 65535]  

0x2CE5  Energy Deadband F005 1 R/W 2 [0 , 65535]  

0x2CE7  Other Deadband F005 1 R/W 2 [0 , 65535]  

0x2CE9  Msg Fragment Size F005 1 R/W 2 [30 , 2048]  

0x2CEB  Binary Input Block 1 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80
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       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2CEC  Binary Input Block 2 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2CED  Binary Input Block 3 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16
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18=BOARD J 17-32
0x2CEE  Binary Input Block 4 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2CEF  Binary Input Block 5 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2CF0  Binary Input Block 6 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

      9=SWITCHGEAR 1-8

      10=SWITCHGEAR 9-16
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11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2CF1  Binary Input Block 7 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2CF2  Binary Input Block 8 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2CF3  Binary Input Block 9 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48
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       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2CF4  Binary Input Block 10 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

Ajustes DNP3.0 Esclavo 1 - DNP 3.0 Slave 2 Settings

17=BOARD J 1-16

18=BOARD J 17-32

0x2CF5 Default Analog Map F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x2CF6 Analog Input Point 0 F004 1000 R/W 1 [0 , 32767]  

0x2CF7 Analog Input Point 1 F004 1000 R/W 1 [0 , 32767]  

0x2CF8 Analog Input Point 2 F004 1000 R/W 1 [0 , 32767]  

0x2CF9 Analog Input Point 3 F004 1000 R/W 1 [0 , 32767]  

0x2CFA Analog Input Point 4 F004 1000 R/W 1 [0 , 32767]  

0x2CFB Analog Input Point 5 F004 1000 R/W 1 [0 , 32767]  

0x2CFC Analog Input Point 6 F004 1000 R/W 1 [0 , 32767]  

0x2CFD Analog Input Point 7 F004 1000 R/W 1 [0 , 32767]  

0x2CFE Analog Input Point 8 F004 1000 R/W 1 [0 , 32767]  

0x2CFF Analog Input Point 9 F004 1000 R/W 1 [0 , 32767]  

0x2D00 Analog Input Point 10 F004 1000 R/W 1 [0 , 32767]  

0x2D01 Analog Input Point 11 F004 1000 R/W 1 [0 , 32767]  

0x2D02 Analog Input Point 12 F004 1000 R/W 1 [0 , 32767]  

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x2D03 Analog Input Point 13 F004 1000 R/W 1 [0 , 32767]  

0x2D04 Analog Input Point 14 F004 1000 R/W 1 [0 , 32767]  

0x2D05 Analog Input Point 15 F004 1000 R/W 1 [0 , 32767]  

0x2D06 Analog Input Point 16 F004 1000 R/W 1 [0 , 32767]  

0x2D07 Analog Input Point 17 F004 1000 R/W 1 [0 , 32767]  

0x2D08 Analog Input Point 18 F004 1000 R/W 1 [0 , 32767]  

0x2D09 Analog Input Point 19 F004 1000 R/W 1 [0 , 32767]  

0x2D0A Analog Input Point 20 F004 1000 R/W 1 [0 , 32767]  

0x2D0B Analog Input Point 21 F004 1000 R/W 1 [0 , 32767]  

0x2D0C Analog Input Point 22 F004 1000 R/W 1 [0 , 32767]  

0x2D0D Analog Input Point 23 F004 1000 R/W 1 [0 , 32767]  

0x2D0E Analog Input Point 24 F004 1000 R/W 1 [0 , 32767]  

0x2D0F Analog Input Point 25 F004 1000 R/W 1 [0 , 32767]  

0x2D10 Analog Input Point 26 F004 1000 R/W 1 [0 , 32767]  

0x2D11 Analog Input Point 27 F004 1000 R/W 1 [0 , 32767]  

0x2D12 Analog Input Point 28 F004 1000 R/W 1 [0 , 32767]  

0x2D13 Analog Input Point 29 F004 1000 R/W 1 [0 , 32767]  

0x2D14 Analog Input Point 30 F004 1000 R/W 1 [0 , 32767]  

0x2D15 Analog Input Point 31 F004 1000 R/W 1 [0 , 32767]  

0x2D16  PF Deadband F004 1000 R/W 1 [0 , 32767]  

0x2D17  PF Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2D1C  Confirmation address   W 1  

Ajustes DNP3.0 Esclavo 2 - DNP 3.0 Slave 2 Settings

0x2D1D  Physical Port F012 1 R/W 1 0=NONE

       1=COM1

       2=COM2

       3=NETWORK

0x2D1E  Address F005 1 R/W 2 [0 , 65534]  

0x2D20  IP Addr Client1 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D21  IP Addr Client1 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D22  IP Addr Client1 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D23  IP Addr Client1 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D24  IP Addr Client2 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D25  IP Addr Client2 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D26  IP Addr Client2 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D27  IP Addr Client2 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D28  IP Addr Client3 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D29  IP Addr Client3 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D2A  IP Addr Client3 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D2B  IP Addr Client3 Oct4 F004 1 R/W 1 [0 , 255]  
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0x2D2C  IP Addr Client4 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D2D  IP Addr Client4 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D2E  IP Addr Client4 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D2F  IP Addr Client4 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D30  IP Addr Client5 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D31  IP Addr Client5 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D32  IP Addr Client5 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D33  IP Addr Client5 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D34  TCP/UDP Port F005 1 R/W 2 [0 , 65535]  

0x2D36  Unsol Resp Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2D37  Unsol Resp TimeOut F005 1 R/W 2 [0 , 60] s

0x2D39  Unsol Resp Max Ret F004 1 R/W 1 [0 , 255]  

0x2D3A  Unsol Resp Dest Adr F005 1 R/W 2 [0 , 65519]  

0x2D3C  Current Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2D3D  Voltage Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2D3E  Power Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2D3F  Energy Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1
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       6=10

       7=100

       8=1000

       9=10000

0x2D40  Other Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2D41  Current Deadband F005 1 R/W 2 [0 , 65535]  

0x2D43  Voltage Deadband F005 1 R/W 2 [0 , 65535]  

0x2D45  Power Deadband F005 1 R/W 2 [0 , 65535]  

0x2D47  Energy Deadband F005 1 R/W 2 [0 , 65535]  

0x2D49  Other Deadband F005 1 R/W 2 [0 , 65535]  

0x2D4B  Msg Fragment Size F005 1 R/W 2 [30 , 2048]  

0x2D4D  Binary Input Block 1 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

0x2D4E  Binary Input Block 2 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x2D4F  Binary Input Block 3 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2D50  Binary Input Block 4 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2D51  Binary Input Block 5 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16
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12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2D52  Binary Input Block 6 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2D53  Binary Input Block 7 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2D54  Binary Input Block 8 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64
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       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2D55  Binary Input Block 9 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2D56  Binary Input Block 10 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32
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17=BOARD J 1-16

18=BOARD J 17-32

0x2D57 Default Analog Map F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x2D58 Analog Input Point 0 F004 1000 R/W 1 [0 , 32767]  

0x2D59 Analog Input Point 1 F004 1000 R/W 1 [0 , 32767]  

0x2D5A Analog Input Point 2 F004 1000 R/W 1 [0 , 32767]  

0x2D5B Analog Input Point 3 F004 1000 R/W 1 [0 , 32767]  

0x2D5C Analog Input Point 4 F004 1000 R/W 1 [0 , 32767]  

0x2D5D Analog Input Point 5 F004 1000 R/W 1 [0 , 32767]  

0x2D5E Analog Input Point 6 F004 1000 R/W 1 [0 , 32767]  

0x2D5F Analog Input Point 7 F004 1000 R/W 1 [0 , 32767]  

0x2D60 Analog Input Point 8 F004 1000 R/W 1 [0 , 32767]  

0x2D61 Analog Input Point 9 F004 1000 R/W 1 [0 , 32767]  

0x2D62 Analog Input Point 10 F004 1000 R/W 1 [0 , 32767]  

0x2D63 Analog Input Point 11 F004 1000 R/W 1 [0 , 32767]  

0x2D64 Analog Input Point 12 F004 1000 R/W 1 [0 , 32767]  

0x2D65 Analog Input Point 13 F004 1000 R/W 1 [0 , 32767]  

0x2D66 Analog Input Point 14 F004 1000 R/W 1 [0 , 32767]  

0x2D67 Analog Input Point 15 F004 1000 R/W 1 [0 , 32767]  

0x2D68 Analog Input Point 16 F004 1000 R/W 1 [0 , 32767]  

0x2D69 Analog Input Point 17 F004 1000 R/W 1 [0 , 32767]  

0x2D6A Analog Input Point 18 F004 1000 R/W 1 [0 , 32767]  

0x2D6B Analog Input Point 19 F004 1000 R/W 1 [0 , 32767]  

0x2D6C Analog Input Point 20 F004 1000 R/W 1 [0 , 32767]  

0x2D6D Analog Input Point 21 F004 1000 R/W 1 [0 , 32767]  

0x2D6E Analog Input Point 22 F004 1000 R/W 1 [0 , 32767]  

0x2D6F Analog Input Point 23 F004 1000 R/W 1 [0 , 32767]  

0x2D70 Analog Input Point 24 F004 1000 R/W 1 [0 , 32767]  

0x2D71 Analog Input Point 25 F004 1000 R/W 1 [0 , 32767]  

0x2D72 Analog Input Point 26 F004 1000 R/W 1 [0 , 32767]  

0x2D73 Analog Input Point 27 F004 1000 R/W 1 [0 , 32767]  

0x2D74 Analog Input Point 28 F004 1000 R/W 1 [0 , 32767]  

0x2D75 Analog Input Point 29 F004 1000 R/W 1 [0 , 32767]  

0x2D76 Analog Input Point 30 F004 1000 R/W 1 [0 , 32767]  

0x2D77 Analog Input Point 31 F004 1000 R/W 1 [0 , 32767]  

0x2D78  PF Deadband F004 1000 R/W 1 [0 , 32767]  

0x2D79  PF Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100
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       8=1000

       9=10000

0x2D7E  Confirmation address   W 1  

Ajustes DNP 3.0 Esclavo 3 - DNP 3.0 Slave 3

0x2D7F  Physical Port F012 1 R/W 1 0=NONE

       1=COM1

       2=COM2

       3=NETWORK

0x2D80  Address F005 1 R/W 2 [0 , 65534]  

0x2D82  IP Addr Client1 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D83  IP Addr Client1 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D84  IP Addr Client1 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D85  IP Addr Client1 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D86  IP Addr Client2 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D87  IP Addr Client2 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D88  IP Addr Client2 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D89  IP Addr Client2 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D8A  IP Addr Client3 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D8B  IP Addr Client3 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D8C  IP Addr Client3 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D8D  IP Addr Client3 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D8E  IP Addr Client4 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D8F  IP Addr Client4 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D90  IP Addr Client4 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D91  IP Addr Client4 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D92  IP Addr Client5 Oct1 F004 1 R/W 1 [0 , 255]  

0x2D93  IP Addr Client5 Oct2 F004 1 R/W 1 [0 , 255]  

0x2D94  IP Addr Client5 Oct3 F004 1 R/W 1 [0 , 255]  

0x2D95  IP Addr Client5 Oct4 F004 1 R/W 1 [0 , 255]  

0x2D96  TCP/UDP Port F005 1 R/W 2 [0 , 65535]  

0x2D98  Unsol Resp Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2D99  Unsol Resp TimeOut F005 1 R/W 2 [0 , 60] s

0x2D9B  Unsol Resp Max Ret F004 1 R/W 1 [0 , 255]  

0x2D9C  Unsol Resp Dest Adr F005 1 R/W 2 [0 , 65519]  

0x2D9E  Current Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2D9F  Voltage Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1
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       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2DA0  Power Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2DA1  Energy Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2DA2  Other Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2DA3  Current Deadband F005 1 R/W 2 [0 , 65535]  

0x2DA5  Voltage Deadband F005 1 R/W 2 [0 , 65535]  

0x2DA7  Power Deadband F005 1 R/W 2 [0 , 65535]  

0x2DA9  Energy Deadband F005 1 R/W 2 [0 , 65535]  

0x2DAB  Other Deadband F005 1 R/W 2 [0 , 65535]  

0x2DAD  Msg Fragment Size F005 1 R/W 2 [30 , 2048]  

0x2DAF  Binary Input Block 1 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96
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       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB0  Binary Input Block 2 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB1  Binary Input Block 3 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16
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18=BOARD J 17-32

0x2DB2  Binary Input Block 4 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB3  Binary Input Block 5 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB4  Binary Input Block 6 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16
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11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB5  Binary Input Block 7 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB6  Binary Input Block 8 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB7  Binary Input Block 9 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48
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       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB8  Binary Input Block 10 F012 1 R/W 1 0=NOT USED

       1=CTL EVENTS 1-16

       2=CTL EVENTS 17-32

       3=CTL EVENTS 33-48

       4=CTL EVENTS 49-64

       5=CTL EVENTS 65-80

       6=CTL EVENTS 81-96

       7=CTL EVENTS 97-112

       8=CTL EVENTS 113-128

       9=SWITCHGEAR 1-8

       10=SWITCHGEAR 9-16

11=BOARD F 1-16

12=BOARD F 17-32

13=BOARD G 1-16

14=BOARD G 17-32

15=BOARD H 1-16

16=BOARD H 17-32

17=BOARD J 1-16

18=BOARD J 17-32

0x2DB9 Default Analog Map F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x2DBA Analog Input Point 0 F004 1000 R/W 1 [0 , 32767]  

0x2DBB Analog Input Point 1 F004 1000 R/W 1 [0 , 32767]  

0x2DBC Analog Input Point 2 F004 1000 R/W 1 [0 , 32767]  

0x2DBD Analog Input Point 3 F004 1000 R/W 1 [0 , 32767]  

0x2DBE Analog Input Point 4 F004 1000 R/W 1 [0 , 32767]  

0x2DBF Analog Input Point 5 F004 1000 R/W 1 [0 , 32767]  

0x2DC0 Analog Input Point 6 F004 1000 R/W 1 [0 , 32767]  

0x2DC1 Analog Input Point 7 F004 1000 R/W 1 [0 , 32767]  

0x2DC2 Analog Input Point 8 F004 1000 R/W 1 [0 , 32767]  

0x2DC3 Analog Input Point 9 F004 1000 R/W 1 [0 , 32767]  

0x2DC4 Analog Input Point 10 F004 1000 R/W 1 [0 , 32767]  

0x2DC5 Analog Input Point 11 F004 1000 R/W 1 [0 , 32767]  

0x2DC6 Analog Input Point 12 F004 1000 R/W 1 [0 , 32767]  

0x2DC7 Analog Input Point 13 F004 1000 R/W 1 [0 , 32767]  
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0x2DC8 Analog Input Point 14 F004 1000 R/W 1 [0 , 32767]  

0x2DC9 Analog Input Point 15 F004 1000 R/W 1 [0 , 32767]  

0x2DCA Analog Input Point 16 F004 1000 R/W 1 [0 , 32767]  

0x2DCB Analog Input Point 17 F004 1000 R/W 1 [0 , 32767]  

0x2DCC Analog Input Point 18 F004 1000 R/W 1 [0 , 32767]  

0x2DCD Analog Input Point 19 F004 1000 R/W 1 [0 , 32767]  

0x2DCE Analog Input Point 20 F004 1000 R/W 1 [0 , 32767]  

0x2DCF Analog Input Point 21 F004 1000 R/W 1 [0 , 32767]  

0x2DD0 Analog Input Point 22 F004 1000 R/W 1 [0 , 32767]  

0x2DD1 Analog Input Point 23 F004 1000 R/W 1 [0 , 32767]  

0x2DD2 Analog Input Point 24 F004 1000 R/W 1 [0 , 32767]  

0x2DD3 Analog Input Point 25 F004 1000 R/W 1 [0 , 32767]  

0x2DD4 Analog Input Point 26 F004 1000 R/W 1 [0 , 32767]  

0x2DD5 Analog Input Point 27 F004 1000 R/W 1 [0 , 32767]  

0x2DD6 Analog Input Point 28 F004 1000 R/W 1 [0 , 32767]  

0x2DD7 Analog Input Point 29 F004 1000 R/W 1 [0 , 32767]  

0x2DD8 Analog Input Point 30 F004 1000 R/W 1 [0 , 32767]  

0x2DD9 Analog Input Point 31 F004 1000 R/W 1 [0 , 32767]  

0x2DDA  PF Deadband F004 1000 R/W 1 [0 , 32767]  

0x2DDB  PF Scale Factor F012 1 R/W 1 0=0.00001

       1=0.0001

       2=0.001

       3=0.01

       4=0.1

       5=1

       6=10

       7=100

       8=1000

       9=10000

0x2DE0  Confirmation address   W 1  

Miscellaneous Settings

0x2DE2 Relay Out Of Service F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x2DE3 Local/Remote Blocked F012 1000 R/W 1 0=OFF

1=ON

0x2DE4 Active Language F004 1000 R/W 1 [0 , 1]  

0x2DF5 Confirmation address W 1

Ajustes Demanda - Demand Settings

0x2F07  Demand Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2F08  CRNT Demand Method F012 1 R/W 1 0=THERMAL EXPONENTIAL

       1=BLOCK INTERVAL

       2=ROLLING DEMAND

0x2F09  POWER Demand Method F012 1 R/W 1 0=THERMAL EXPONENTIAL

       1=BLOCK INTERVAL

       2=ROLLING DEMAND

0x2F0A  Demand Interval F012 1 R/W 1 0=5 Minutes

       1=10 Minutes

       2=15 Minutes

       3=20 Minutes
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       4=30 Minutes

       5=60 Minutes

0x2F0B  Trigger Enabled F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2F0C  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2F1F  Confirmation address   W 1  

Ajustes Protocolo IEC 870-5-104 Settings

0x2F20  Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x2F21  TCP Port F005 1 R/W 2 [0 , 65535]  

0x2F23  Common Addr of ASDU F005 1 R/W 2 [0 , 65535]  

0x2F25  Cyclic Meter Period F005 1 R/W 2 [0 , 3600]  

0x2F27  Synchronization Event F005 1 R/W 2 [0 , 3600]  

0x2F29 104 Net1 CLI1 Octet1 F004 1,000 R/W 1 [0 , 255]  

0x2F2A 104 Net1 CLI1 Octet2 F004 1,000 R/W 1 [0 , 255]  

0x2F2B 104 Net1 CLI1 Octet3 F004 1,000 R/W 1 [0 , 255]  

0x2F2C 104 Net1 CLI1 Octet4 F004 1,000 R/W 1 [0 , 255]  

0x2F2D 104 Net1 CLI2 Octet1 F004 1,000 R/W 1 [0 , 255]  

0x2F2E 104 Net1 CLI2 Octet2 F004 1,000 R/W 1 [0 , 255]  

0x2F2F 104 Net1 CLI2 Octet3 F004 1,000 R/W 1 [0 , 255]  

0x2F30 104 Net1 CLI2 Octet4 F004 1,000 R/W 1 [0 , 255]  

0x2F31 Function 2 F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x2F32 TCP Port 2 F005 1,000 R/W 2 [0 , 65535]  

0x2F34 Common Addr of ASDU 2 F005 1,000 R/W 2 [0 , 65535]  

0x2F36 104 Net2 CLI1 Octet1 F004 1,000 R/W 1 [0 , 255]  

0x2F37 104 Net2 CLI1 Octet2 F004 1,000 R/W 1 [0 , 255]  

0x2F38 104 Net2 CLI1 Octet3 F004 1,000 R/W 1 [0 , 255]  

0x2F39 104 Net2 CLI1 Octet4 F004 1,000 R/W 1 [0 , 255]  

0x2F3A 104 Net2 CLI2 Octet1 F004 1,000 R/W 1 [0 , 255]  

0x2F3B 104 Net2 CLI2 Octet2 F004 1,000 R/W 1 [0 , 255]  

0x2F3C 104 Net2 CLI2 Octet3 F004 1,000 R/W 1 [0 , 255]  

0x2F3D 104 Net2 CLI2 Octet4 F004 1,000 R/W 1 [0 , 255]  

0x2F3E Current Scale Factor F012 1,000 R/W 1 0=0.00001

1=0.0001

2=0.001

3=0.01

4=0.1

5=1

6=10

7=100

8=1000

9=10000

0x2F3F Voltage Scale Factor F012 1,000 R/W 1 0=0.00001

1=0.0001

2=0.001

3=0.01

4=0.1

5=1
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6=10

7=100

8=1000

9=10000

0x2F40 Power Scale Factor F012 1,000 R/W 1 0=0.00001

1=0.0001

2=0.001

3=0.01

4=0.1

5=1

6=10

7=100

8=1000

9=10000

0x2F41 Energy Scale Factor F012 1,000 R/W 1 0=0.00001

1=0.0001

2=0.001

3=0.01

4=0.1

5=1

6=10

7=100

8=1000

9=10000

0x2F42 Other Scale Factor F012 1,000 R/W 1 0=0.00001

1=0.0001

2=0.001

3=0.01

4=0.1

5=1

6=10

7=100

8=1000

9=10000

0x2F43 Current Deadband F005 1,000 R/W 2 [0 , 65535]  

0x2F45 Voltage Deadband F005 1,000 R/W 2 [0 , 65535]  

0x2F47 Power Deadband F005 1,000 R/W 2 [0 , 65535]  

0x2F49 Energy Deadband F005 1,000 R/W 2 [0 , 65535]  

0x2F4B Other Deadband F005 1,000 R/W 2 [0 , 65535]  

0x2F4D IOA Binaries F013 1,000 R/W 1 [0 , 65535]  

0x2F4E IOA Double Points F013 1,000 R/W 1 [0 , 65535]  

0x2F4F IOA Analogs F013 1,000 R/W 1 [0 , 65535]  

0x2F50 IOA Counters F013 1,000 R/W 1 [0 , 65535]  

0x2F51 IOA Commands F013 1,000 R/W 1 [0 , 65535]  

0x2F52 IOA Analog Param F013 1,000 R/W 1 [0 , 65535]  

0x2F53 PF Deadband F004 1,000 R/W 1 [0 , 32767]  

0x2F54 PF Scale Factor F012 1,000 R/W 1 0=0.00001

1=0.0001

2=0.001

3=0.01
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4=0.1

5=1

6=10

7=100

8=1000

9=10000

0x2F5A  Confirmation address   W 1  

Ajustes Aparamenta (16 elementos) - Switchgear Settings (16 items)

0x32FC  CONTACTS TYPE_01 F012 1 R/W 1 0=52a + 52b

       1=52a

       2=52b

       3=NONE

0x32FD  CONTACTS TYPE_02 F012 1 R/W 1 0=52a + 52b

       1=52a

       2=52b

       3=NONE

... ... ... ... ... ... ... ...

0x330B  CONTACTS TYPE_16 F012 1 R/W 1 0=52a + 52b

       1=52a

       2=52b

       3=NONE

0x330C  FAIL TO OPEN 01 t F004 1 R/W 1 [0 , 30000] ms

0x330D  FAIL TO OPEN 02 t F004 1 R/W 1 [0 , 30000] ms

... ... ... ... ... ... ... ...

0x331B  FAIL TO OPEN 16 t F004 1 R/W 1 [0 , 30000] ms

0x331C  FAIL TO CLOSE 01 t F004 1 R/W 1 [0 , 30000] ms

0x331D  FAIL TO CLOSE 02 t F004 1 R/W 1 [0 , 30000] ms

... ... ... ... ... ... ... ...

0x332B  FAIL TO CLOSE 16 t F004 1 R/W 1 [0 , 30000] ms

0x332C  Snapshot Events SWGR 1 F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x332D  Snapshot Events SWGR 2 F012 1 R/W 1 0=DISABLED

       1=ENABLED

... ... ... ... ... ... ... ...

0x333B  Snapshot Events SWGR 16 F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x334C  Confirmation address   W 1  

Ajustes Interruptor - Breaker Settings

0x334D  Number of Switchgear F004 1 R/W 1 [1 , 16]  

0x334E  Maximum KI2t F003 1 R/W 2 [0.00 , 9999.99] (KA)2 s

0x3350  KI2t Integ. Time F003 1 R/W 2 [0.03 , 0.25] s

0x3352  Maximum Openings F004 1 R/W 1 [0 , 9999]  

0x3353  Max.Openings 1 hour F004 1 R/W 1 [1 , 60]  

0x3354  Snapshot Events F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x3367  Confirmation address   W 1  

Ajustes Contadores Interruptor - Breaker Maintenance Settings

0x3368  KI2t BKR Ph A Cnt F003 1 R/W 2 [0.00 , 9999.99] (KA)2 s

0x336A  KI2t BKR Ph B Cnt F003 1 R/W 2 [0.00 , 9999.99] (KA)2 s

0x336C  KI2t BKR Ph C Cnt F003 1 R/W 2 [0.00 , 9999.99] (KA)2 s
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0x336E  BKR Openings Cnt F004 1 R/W 1 [0 , 9999]  

0x336F  BKR Closings Cnt F004 1 R/W 1 [0 , 9999]  

0x3383  Confirmation address   W 1  

Ajustes Mapa Usuario Modbus - Modbus User Map Settings

0x3384  Address  00 F004 1 R/W 1 [0 , 65535]  

0x3385  Address  01 F004 1 R/W 1 [0 , 65535]  

... ... ... ... ... ... ... ...

0x3483  Address  255 F004 1 R/W 1 [0 , 65535]  

0x3494  Confirmation address   W 1  

Ajustes Protocolo Modbus - MODBUS Settings

0x38A5  Modbus Address COM1 F004 1 R/W 1 [1 , 255]  

0x38A6  Modbus Address COM2 F004 1 R/W 1 [1 , 255]  

0x38A7  Modbus Port Number F005 1 R/W 2 [0 , 65535]  

0x38BC  Confirmation address   W 1  

Ajustes Puertos Serie - SERIAL PORTS Settings

0x38BD  COM1 Baud Rate F012 1 R/W 1 0=300

       1=600

       2=1200

       3=2400

       4=4800

       5=9600

       6=19200

       7=38400

       8=57600

       9=115200

0x38BE  COM2 Baud Rate F012 1 R/W 1 0=300

       1=600

       2=1200

       3=2400

       4=4800

       5=9600

       6=19200

       7=38400

       8=57600

       9=115200

0x38BF  COM1 Parity F012 1000 R/W 1 0=NONE

       1=ODD

       2=EVEN

0x38C0  COM2 Parity F012 1000 R/W 1 0=NONE

       1=ODD

       2=EVEN

0x38D3  Confirmation address   W 1  

Ajustes Registrador de Datos - Data Logger Settings

0x38D4  Function F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x38D5  Data Logger Rate F012 1 R/W 1 0=1 s

       1=5 Minutes

       2=10 Minutes

       3=15 Minutes

       4=20 Minutes
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       5=30 Minutes

       6=60 Minutes

0x38D6  Data Logger Chnl 1 F004 1 R/W 1 [0 , 32767]  

0x38D7  Data Logger Chnl 2 F004 1 R/W 1 [0 , 32767]  

0x38D8  Data Logger Chnl 3 F004 1 R/W 1 [0 , 32767]  

0x38D9  Data Logger Chnl 4 F004 1 R/W 1 [0 , 32767]  

0x38DA  Data Logger Chnl 5 F004 1 R/W 1 [0 , 32767]  

0x38DB  Data Logger Chnl 6 F004 1 R/W 1 [0 , 32767]  

0x38DC  Data Logger Chnl 7 F004 1 R/W 1 [0 , 32767]  

0x38DD  Data Logger Chnl 8 F004 1 R/W 1 [0 , 32767]  

0x38DE  Data Logger Chnl 9 F004 1 R/W 1 [0 , 32767]  

0x38DF  Data Logger Chnl 10 F004 1 R/W 1 [0 , 32767]  

0x38E0  Data Logger Chnl 11 F004 1 R/W 1 [0 , 32767]  

0x38E1  Data Logger Chnl 12 F004 1 R/W 1 [0 , 32767]  

0x38E2  Data Logger Chnl 13 F004 1 R/W 1 [0 , 32767]  

0x38E3  Data Logger Chnl 14 F004 1 R/W 1 [0 , 32767]  

0x38E4  Data Logger Chnl 15 F004 1 R/W 1 [0 , 32767]  

0x38E5  Data Logger Chnl 16 F004 1 R/W 1 [0 , 32767]  

0x38F9  Confirmation address   W 1  

Ajustes Comunicaciones Remotas - Remote Communications Settings

 0x3A76  Remote Comms F012 1 R/W 1 0=DISABLED

 1=GSSE

       2=GOOSE

0x3A77  C650 ID F009 1 R/W 33  

0x3A98  Hold Time F005 1 R/W 2 [1000 , 60000] ms

0x3A9A  Events Remote Out F012 1 R/W 1 0=DISABLED

       1=ENABLED

Ajustes Entradas Remotas (32 elementos) - Remote Inputs Settings (32 items) [Only Configurable for GSSE]

0x3A9B  Remote Device 1 F009 1 R/W 33  

0x3ABC  Bit Pair 1 F012 1 R/W 1 0=NONE

       1=DNA-1

       2=DNA-2

       --------

       32=DNA-32

       33=UserSt-1

       34=UserSt-2

       --------

       96=UserSt-64

0x3ABD  Default Value 1 F012 1 R/W 1 0=OFF

       1=ON

       2=Latest OFF

       3=Latest ON

0x3ABE  Remote Device 2 F009 1 R/W 33  

0x3ADF  Bit Pair 2 F012 1 R/W 1 0=NONE

       1=DNA-1

       2=DNA-2

       --------

       32=DNA-32

       33=UserSt-1

       34=UserSt-2
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       --------

       96=UserSt-64

0x3AE0  Default Value 2 F012 1 R/W 1 0=OFF

       1=ON

       2=Latest OFF

       3=Latest ON

... ... ... ... ... ... ... ...

... ... ... ... ... ... ... ...

... ... ... ... ... ... ... ...

0x3ED8  Remote Device 32 F009 1 R/W 33  

0x3EF9  Bit Pair 32 F012 1 R/W 1 0=NONE

       1=DNA-1

       2=DNA-2

       --------

       32=DNA-32

       33=UserSt-1

       34=UserSt-2

       --------

       96=UserSt-64

0x3EFA  Default Value 32 F012 1 R/W 1 0=OFF

       1=ON

2=Latest OFF

3=Latest ON

0x3EFB  Events Remote Inp F012 1 R/W 1 0=DISABLED

       1=ENABLED

0x3EFC Destination MAC Data1 F004 1000 R/W 1

0x3EFD Destination MAC Data2 F004 1000 R/W 1

0x3EFE Destination MAC Data3 F004 1000 R/W 1

0x3EFF GSSE RemDevice01 MAC Data1 F004 1000 R/W 1

0x3F00 GSSE RemDevice01 MAC Data2 F004 1000 R/W 1

0x3F01 GSSE RemDevice01 MAC Data3 F004 1000 R/W 1

0x3F02 GSSE RemDevice02 MAC Data1 F004 1000 R/W 1

0x3F03 GSSE RemDevice02 MAC Data2 F004 1000 R/W 1

0x3F04 GSSE RemDevice02 MAC Data3 F004 1000 R/W 1

0x3F05 GSSE RemDevice03 MAC Data1 F004 1000 R/W 1

0x3F06 GSSE RemDevice03 MAC Data2 F004 1000 R/W 1

0x3F07 GSSE RemDevice03 MAC Data3 F004 1000 R/W 1

0x3F08 GSSE RemDevice04 MAC Data1 F004 1000 R/W 1

0x3F09 GSSE RemDevice04 MAC Data2 F004 1000 R/W 1

0x3F0A GSSE RemDevice04 MAC Data3 F004 1000 R/W 1

0x3F0B GSSE RemDevice05 MAC Data1 F004 1000 R/W 1

0x3F0C GSSE RemDevice05 MAC Data2 F004 1000 R/W 1

0x3F0D GSSE RemDevice05 MAC Data3 F004 1000 R/W 1

0x3F0E GSSE RemDevice06 MAC Data1 F004 1000 R/W 1

0x3F0F GSSE RemDevice06 MAC Data2 F004 1000 R/W 1

0x3F10 GSSE RemDevice06 MAC Data3 F004 1000 R/W 1

0x3F11 GSSE RemDevice07 MAC Data1 F004 1000 R/W 1

0x3F12 GSSE RemDevice07 MAC Data2 F004 1000 R/W 1

0x3F13 GSSE RemDevice07 MAC Data3 F004 1000 R/W 1

0x3F14 GSSE RemDevice08 MAC Data1 F004 1000 R/W 1
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0x3F15 GSSE RemDevice08 MAC Data2 F004 1000 R/W 1

0x3F16 GSSE RemDevice08 MAC Data3 F004 1000 R/W 1

0x3F17 GSSE RemDevice09 MAC Data1 F004 1000 R/W 1

0x3F18 GSSE RemDevice09 MAC Data2 F004 1000 R/W 1

0x3F19 GSSE RemDevice09 MAC Data3 F004 1000 R/W 1

0x3F1A GSSE RemDevice10 MAC Data1 F004 1000 R/W 1

0x3F1B GSSE RemDevice10 MAC Data2 F004 1000 R/W 1

0x3F1C GSSE RemDevice10 MAC Data3 F004 1000 R/W 1

0x3F1D GSSE RemDevice11 MAC Data1 F004 1000 R/W 1

0x3F1E GSSE RemDevice11 MAC Data2 F004 1000 R/W 1

0x3F1F GSSE RemDevice11 MAC Data3 F004 1000 R/W 1

0x3F20 GSSE RemDevice12 MAC Data1 F004 1000 R/W 1

0x3F21 GSSE RemDevice12 MAC Data2 F004 1000 R/W 1

0x3F22 GSSE RemDevice12 MAC Data3 F004 1000 R/W 1

0x3F23 GSSE RemDevice13 MAC Data1 F004 1000 R/W 1

0x3F24 GSSE RemDevice13 MAC Data2 F004 1000 R/W 1

0x3F25 GSSE RemDevice13 MAC Data3 F004 1000 R/W 1

0x3F26 GSSE RemDevice14 MAC Data1 F004 1000 R/W 1

0x3F27 GSSE RemDevice14 MAC Data2 F004 1000 R/W 1

0x3F28 GSSE RemDevice14 MAC Data3 F004 1000 R/W 1

0x3F29 GSSE RemDevice15 MAC Data1 F004 1000 R/W 1

0x3F2A GSSE RemDevice15 MAC Data2 F004 1000 R/W 1

0x3F2B GSSE RemDevice15 MAC Data3 F004 1000 R/W 1

0x3F2C GSSE RemDevice16 MAC Data1 F004 1000 R/W 1

0x3F2D GSSE RemDevice16 MAC Data2 F004 1000 R/W 1

0x3F2E GSSE RemDevice16 MAC Data3 F004 1000 R/W 1

0x3F2F GSSE RemDevice17 MAC Data1 F004 1000 R/W 1

0x3F30 GSSE RemDevice17 MAC Data2 F004 1000 R/W 1

0x3F31 GSSE RemDevice17 MAC Data3 F004 1000 R/W 1

0x3F32 GSSE RemDevice18 MAC Data1 F004 1000 R/W 1

0x3F33 GSSE RemDevice18 MAC Data2 F004 1000 R/W 1

0x3F34 GSSE RemDevice18 MAC Data3 F004 1000 R/W 1

0x3F35 GSSE RemDevice19 MAC Data1 F004 1000 R/W 1

0x3F36 GSSE RemDevice19 MAC Data2 F004 1000 R/W 1

0x3F37 GSSE RemDevice19 MAC Data3 F004 1000 R/W 1

0x3F38 GSSE RemDevice20 MAC Data1 F004 1000 R/W 1

0x3F39 GSSE RemDevice20 MAC Data2 F004 1000 R/W 1

0x3F3A GSSE RemDevice20 MAC Data3 F004 1000 R/W 1

0x3F3B GSSE RemDevice21 MAC Data1 F004 1000 R/W 1

0x3F3C GSSE RemDevice21 MAC Data2 F004 1000 R/W 1

0x3F3D GSSE RemDevice21 MAC Data3 F004 1000 R/W 1

0x3F3E GSSE RemDevice22 MAC Data1 F004 1000 R/W 1

0x3F3F GSSE RemDevice22 MAC Data2 F004 1000 R/W 1

0x3F40 GSSE RemDevice22 MAC Data3 F004 1000 R/W 1

0x3F41 GSSE RemDevice23 MAC Data1 F004 1000 R/W 1

0x3F42 GSSE RemDevice23 MAC Data2 F004 1000 R/W 1

0x3F43 GSSE RemDevice23 MAC Data3 F004 1000 R/W 1

0x3F44 GSSE RemDevice24 MAC Data1 F004 1000 R/W 1

0x3F45 GSSE RemDevice24 MAC Data2 F004 1000 R/W 1

0x3F46 GSSE RemDevice24 MAC Data3 F004 1000 R/W 1
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0x3F47 GSSE PORT F012 1000 R/W 1 0=PORT A
1=PORT B
2=BOTH

0x3F5B  Confirmation address      

Ajustes Sincronizacion SNTP - SNTP synchronization Settings 

  SNTP      

0x3F5C  Function F012 1 R/W 1 0=DISABLED

       1=UNICAST

       2=BROADCAST

       3=ANYCAST

0x3F5D  UDP Port F005 1 R/W 2 [1 , 65535]

0x3F5F  Server IP Oct 1 F004 1 R/W 1 [0 , 255]

0x3F60  Server IP Oct 2 F004 1 R/W 1 [0 , 255]

0x3F61  Server IP Oct 3 F004 1 R/W 1 [0 , 255]

0x3F62  Server IP Oct 4 F004 1 R/W 1 [0 , 255]

0x3F66  Confirmation address      

0x3F67  Server2 UDP Port F004 1 R/W 1 [0 , 255]

0x3F69 Server2 IP Oct 1 F004 1 R/W 1 [0 , 255]

0x3F6A Server2 IP Oct 2 F004 1 R/W 1 [0 , 255]

0x3F6B Server2 IP Oct 3 F004 1 R/W 1 [0 , 255]

0x3F6C Server2 IP Oct 4 F004 1 R/W 1 [0 , 255]

0x3F87 Confirmation address W 1

Contador de Pulsos-Pulse Counters
0x3F88 PulseCntr Enabled 1 F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x3F89 PulseCntr Name 1 F009 1,000 R/W 16

0x3F99 PulseCntr Factor 1 F003 1,000 R/W 2 [0.000 , 65000.000]  

0x3F9B PulseCntr Overflow 1 F005 1,000 R/W 2 [0 , 1000000]  

0x3F9D PulseCntr Board Origin 1 F012 1,000 R/W 1 0=F

1=G

2=H

3=J

0x3F9E PulseCntr Input Origin 1 F004 1,000 R/W 1 [1 , 32]  

0x3F9F PulseCntr Enabled 2 F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x3FA0 PulseCntr Name 2 F009 1,000 R/W 16

0x3FB0 PulseCntr Factor 2 F003 1,000 R/W 2 [0.000 , 65000.000]  

0x3FB2 PulseCntr Overflow 2 F005 1,000 R/W 2 [0 , 1000000]  

0x3FB4 PulseCntr Board Origin 2 F012 1,000 R/W 1 0=F

1=G

2=H

3=J

0x3FB5 PulseCntr Input Origin 2 F004 1,000 R/W 1 [1 , 32]  

0x3FB6 PulseCntr Enabled 3 F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x3FB7 PulseCntr Name 3 F009 1,000 R/W 16
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0x3FC7 PulseCntr Factor 3 F003 1,000 R/W 2 [0.000 , 65000.000]  

0x3FC9 PulseCntr Overflow 3 F005 1,000 R/W 2 [0 , 1000000]  

0x3FCB PulseCntr Board Origin 3 F012 1,000 R/W 1 0=F

1=G

2=H

3=J

0x3FCC PulseCntr Input Origin 3 F004 1,000 R/W 1 [1 , 32]  

0x3FCD PulseCntr Enabled 4 F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x3FCE PulseCntr Name 4 F009 1,000 R/W 16

0x3FDE PulseCntr Factor 4 F003 1,000 R/W 2 [0.000 , 65000.000]  

0x3FE0 PulseCntr Overflow 4 F005 1,000 R/W 2 [0 , 1000000]  

0x3FE2 PulseCntr Board Origin 4 F012 1,000 R/W 1 0=F

1=G

2=H

3=J

0x3FE3 PulseCntr Input Origin 4 F004 1,000 R/W 1 [1 , 32]  

0x3FE4 PulseCntr Enabled 5 F012 1,000 R/W 1 0=DISABLED

1=ENABLED
0x3FE5 PulseCntr Name 5 F009 1,000 R/W 16

0x3FF5 PulseCntr Factor 5 F003 1,000 R/W 2 [0.000 , 65000.000]  

0x3FF7 PulseCntr Overflow 5 F005 1,000 R/W 2 [0 , 1000000]  

0x3FF9 PulseCntr Board Origin 5 F012 1,000 R/W 1 0=F

1=G

2=H

3=J

0x3FFA PulseCntr Input Origin 5 F004 1,000 R/W 1 [1 , 32]  

0x3FFB PulseCntr Enabled 6 F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x3FFC PulseCntr Name 6 F009 1,000 R/W 16

0x400C PulseCntr Factor 6 F003 1,000 R/W 2 [0.000 , 65000.000]  

0x400E PulseCntr Overflow 6 F005 1,000 R/W 2 [0 , 1000000]  

0x4010 PulseCntr Board Origin 6 F012 1,000 R/W 1 0=F

1=G

2=H

3=J

0x4011 PulseCntr Input Origin 6 F004 1,000 R/W 1 [1 , 32]  

0x4012 PulseCntr Enabled 7 F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x4013 PulseCntr Name 7 F009 1,000 R/W 16

0x4023 PulseCntr Factor 7 F003 1,000 R/W 2 [0.000 , 65000.000]  

0x4025 PulseCntr Overflow 7 F005 1,000 R/W 2 [0 , 1000000]  
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0x4027 PulseCntr Board Origin 7 F012 1,000 R/W 1 0=F

1=G

2=H

3=J

0x4028 PulseCntr Input Origin 7 F004 1,000 R/W 1 [1 , 32]  

0x4029 PulseCntr Enabled 8 F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x402A PulseCntr Name 8 F009 1,000 R/W 16

0x403A PulseCntr Factor 8 F003 1,000 R/W 2 [0.000 , 65000.000]  

0x403C PulseCntr Overflow 8 F005 1,000 R/W 2 [0 , 1000000]  

0x403E PulseCntr Board Origin 8 F012 1,000 R/W 1 0=F

1=G

2=H

3=J

0x403F PulseCntr Input Origin 8 F004 1,000 R/W 1 [1 , 32]  

0x4052 Confirmation address W 1

Comparadores Analógicos-Analog comparators
0x4053 Analog Function F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x4054 Analog Snapshot Events F012 1,000 R/W 1 0=DISABLED

1=ENABLED

0x4055 Analog Input 01 F004 1,000 R/W 1

0x4056 Analog Maximum 01 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4058 Analog Minimum 01 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x405A Analog Delay 01 F003 1,000 R/W 2 [0.00 , 900.00] s

0x405C Analog Hysteresis 01 F003 1,000 R/W 2 [0.0 , 50.0]  

0x405E Analog Direction 01 F012 1,000 R/W 1 0=OUT

1=IN

0x405F Analog Input 02 F004 1,000 R/W 1

0x4060 Analog Maximum 02 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4062 Analog Minimum 02 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4064 Analog Delay 02 F003 1,000 R/W 2 [0.00 , 900.00] s

0x4066 Analog Hysteresis 02 F003 1,000 R/W 2 [0.0 , 50.0]  

0x4068 Analog Direction 02 F012 1,000 R/W 1 0=OUT

1=IN

0x4069 Analog Input 03 F004 1,000 R/W 1

0x406A Analog Maximum 03 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x406C Analog Minimum 03 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x406E Analog Delay 03 F003 1,000 R/W 2 [0.00 , 900.00] s

0x4070 Analog Hysteresis 03 F003 1,000 R/W 2 [0.0 , 50.0]  

0x4072 Analog Direction 03 F012 1,000 R/W 1 0=OUT

1=IN
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0x4073 Analog Input 04 F004 1,000 R/W 1

0x4074 Analog Maximum 04 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4076 Analog Minimum 04 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4078 Analog Delay 04 F003 1,000 R/W 2 [0.00 , 900.00] s

0x407A Analog Hysteresis 04 F003 1,000 R/W 2 [0.0 , 50.0]  

0x407C Analog Direction 04 F012 1,000 R/W 1 0=OUT

1=IN

0x407D Analog Input 05 F004 1,000 R/W 1

0x407E Analog Maximum 05 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4080 Analog Minimum 05 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4082 Analog Delay 05 F003 1,000 R/W 2 [0.00 , 900.00] s

0x4084 Analog Hysteresis 05 F003 1,000 R/W 2 [0.0 , 50.0]  

0x4086 Analog Direction 05 F012 1,000 R/W 1 0=OUT

1=IN

0x4087 Analog Input 06 F004 1,000 R/W 1

0x4088 Analog Maximum 06 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x408A Analog Minimum 06 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x408C Analog Delay 06 F003 1,000 R/W 2 [0.00 , 900.00] s

0x408E Analog Hysteresis 06 F003 1,000 R/W 2 [0.0 , 50.0]  

0x4090 Analog Direction 06 F012 1,000 R/W 1 0=OUT

1=IN

0x4091 Analog Input 07 F004 1,000 R/W 1

0x4092 Analog Maximum 07 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4094 Analog Minimum 07 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4096 Analog Delay 07 F003 1,000 R/W 2 [0.00 , 900.00] s

0x4098 Analog Hysteresis 07 F003 1,000 R/W 2 [0.0 , 50.0]  

0x409A Analog Direction 07 F012 1,000 R/W 1 0=OUT

1=IN

0x409B Analog Input 08 F004 1,000 R/W 1

0x409C Analog Maximum 08 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x409E Analog Minimum 08 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40A0 Analog Delay 08 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40A2 Analog Hysteresis 08 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40A4 Analog Direction 08 F012 1,000 R/W 1 0=OUT

1=IN

0x40A5 Analog Input 09 F004 1,000 R/W 1

0x40A6 Analog Maximum 09 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40A8 Analog Minimum 09 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40AA Analog Delay 09 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40AC Analog Hysteresis 09 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40AE Analog Direction 09 F012 1,000 R/W 1 0=OUT

1=IN
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0x40AF Analog Input 10 F004 1,000 R/W 1

0x40B0 Analog Maximum 10 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40B2 Analog Minimum 10 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40B4 Analog Delay 10 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40B6 Analog Hysteresis 10 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40B8 Analog Direction 10 F012 1,000 R/W 1 0=OUT

1=IN

0x40B9 Analog Input 11 F004 1,000 R/W 1

0x40BA Analog Maximum 11 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40BC Analog Minimum 11 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40BE Analog Delay 11 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40C0 Analog Hysteresis 11 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40C2 Analog Direction 11 F012 1,000 R/W 1 0=OUT

1=IN

0x40C3 Analog Input 12 F004 1,000 R/W 1

0x40C4 Analog Maximum 12 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40C6 Analog Minimum 12 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40C8 Analog Delay 12 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40CA Analog Hysteresis 12 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40CC Analog Direction 12 F012 1,000 R/W 1 0=OUT

1=IN

0x40CD Analog Input 13 F004 1,000 R/W 1

0x40CE Analog Maximum 13 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40D0 Analog Minimum 13 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40D2 Analog Delay 13 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40D4 Analog Hysteresis 13 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40D6 Analog Direction 13 F012 1,000 R/W 1 0=OUT

1=IN

0x40D7 Analog Input 14 F004 1,000 R/W 1

0x40D8 Analog Maximum 14 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40DA Analog Minimum 14 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40DC Analog Delay 14 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40DE Analog Hysteresis 14 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40E0 Analog Direction 14 F012 1,000 R/W 1 0=OUT

1=IN

0x40E1 Analog Input 15 F004 1,000 R/W 1

0x40E2 Analog Maximum 15 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40E4 Analog Minimum 15 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40E6 Analog Delay 15 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40E8 Analog Hysteresis 15 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40EA Analog Direction 15 F012 1,000 R/W 1 0=OUT

1=IN
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0x40EB Analog Input 16 F004 1,000 R/W 1

0x40EC Analog Maximum 16 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40EE Analog Minimum 16 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40F0 Analog Delay 16 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40F2 Analog Hysteresis 16 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40F4 Analog Direction 16 F012 1,000 R/W 1 0=OUT

1=IN

0x40F5 Analog Input 17 F004 1,000 R/W 1

0x40F6 Analog Maximum 17 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40F8 Analog Minimum 17 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x40FA Analog Delay 17 F003 1,000 R/W 2 [0.00 , 900.00] s

0x40FC Analog Hysteresis 17 F003 1,000 R/W 2 [0.0 , 50.0]  

0x40FE Analog Direction 17 F012 1,000 R/W 1 0=OUT

1=IN

0x40FF Analog Input 18 F004 1,000 R/W 1

0x4100 Analog Maximum 18 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4102 Analog Minimum 18 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4104 Analog Delay 18 F003 1,000 R/W 2 [0.00 , 900.00] s

0x4106 Analog Hysteresis 18 F003 1,000 R/W 2 [0.0 , 50.0]  

0x4108 Analog Direction 18 F012 1,000 R/W 1 0=OUT

1=IN

0x4109 Analog Input 19 F004 1,000 R/W 1

0x410A Analog Maximum 19 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x410C Analog Minimum 19 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x410E Analog Delay 19 F003 1,000 R/W 2 [0.00 , 900.00] s

0x4110 Analog Hysteresis 19 F003 1,000 R/W 2 [0.0 , 50.0]  

0x4112 Analog Direction 19 F012 1,000 R/W 1 0=OUT

1=IN

0x4113 Analog Input 20 F004 1,000 R/W 1

0x4114 Analog Maximum 20 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4116 Analog Minimum 20 F003 1,000 R/W 2 [-100000.000 , 100000.000]  

0x4118 Analog Delay 20 F003 1,000 R/W 2 [0.00 , 900.00] s

0x411A Analog Hysteresis 20 F003 1,000 R/W 2 [0.0 , 50.0]  

0x411C Analog Direction 20 F012 1,000 R/W 1 0=OUT

1=IN

0x412F Confirmation address W 1

Ajustes de Fecha y Hora - Time Settings

0x454F LOC TIME OFFS. UTC F003 1 R/W 2 [-24.0 , 24.0]

0x4551 DAYLIG. SAVINGS TIME F012 1 R/W 1 0=DISABLED

1=ENABLED

0x4552 DST START MONTH F012 1 R/W 1 0=JAN

1=FEB

2=MAR
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3=APR

4=MAY

5=JUN

6=JUL

7=AUG

8=SEP

9=OCT

10=NOV

11=DEC

0x4553 DST START WEEKDAY F012 1 R/W 1 0=Monday

1=Tuesday

2=Wednesday

3=Thursday

4=Friday

5=Saturday

6=Sunday

0x4554 DST START DAY INST F012 1 R/W 1 0=First

1=Second

2=Third

3=Fourth

4=Last

0x4555 DST START HOUR F004 1 R/W 1 [0 , 23]

0x4556 DST STOP MONTH F012 1 R/W 1 0=JAN

1=FEB

2=MAR

3=APR

4=MAY

5=JUN

6=JUL

7=AUG

8=SEP

9=OCT

10=NOV

11=DEC

0x4557 DST STOP WEEKDAY F012 1 R/W 1 0=Monday

1=Tuesday

2=Wednesday

3=Thursday

4=Friday

5=Saturday

6=Sunday

0x4558 DST STOP DAY INST F012 1 R/W 1 0=First

1=Second

2=Third

3=Fourth

4=Last

0x4559 DST STOP HOUR F004 1 R/W 1 [0 , 23]

0x455A IRIG-B LOCAL TIME F012 1 R/W 1 0=OFF

1=ON

0x455B IRIGB Function F012 1000 R/W 1 0=DISABLED
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1=ENABLED

0x455C PTP IRIGB Priority F012 1000 R/W 1 0=PTP-1588

1=IRIG-B

0x4564 Confirmation address W 1

Ajustes Tarjeta 2H (MODULO CIO) - Board 2H Settings (CIO MODULE)

Ajustes Tipo Tarjeta 2H - Board 2H Board Type Settings

0x4565 I/O Board Type_2H F012 1,000 R/W 1 0=NONE

1=16INP + 8OUT

2=8INP + 8OUT + SUPV

3=16OUT

4=32INP

5=16INP + 8ANA

Ajustes de Tensión Tarjeta 2H - Board 2H Voltage Settings

0x4566 Voltage Threshold A_2H F004 1,000 R/W 1 [10 , 230] V

0x4567 Voltage Threshold B_2H F004 1,000 R/W 1 [10 , 230] V

0x460B Voltage Threshold C_2H F004 1,000 R/W 1 [10 , 230] V

0x460C Voltage Threshold D_2H F004 1,000 R/W 1 [10 , 230] V

Ajustes Tiempo Antirrebotes Tarjeta 2H -  Board 2H Debounce Time Settings

0x4568 Debounce Time A_2H F004 1,000 R/W 1 [1 , 50] ms

0x4569 Debounce Time B_2H F004 1,000 R/W 1 [1 , 50] ms

0x460D Debounce Time C_2H F004 1,000 R/W 1 [1 , 50] ms

0x460E Debounce Time D_2H F004 1,000 R/W 1 [1 , 50] ms

Ajuste Tipo de Entrada Tarjeta 2H (32 elementos) - Board 2H Input Type Settings (32 items)

0x456A Input Type_2H_CC1 F012 1,000 R/W 1 0=POSITIVE-EDGE

1=NEGATIVE-EDGE

2=POSITIVE

3=NEGATIVE

0x456B Input Type_2H_CC2 F012 1,000 R/W 1 0=POSITIVE-EDGE

1=NEGATIVE-EDGE

2=POSITIVE

3=NEGATIVE

... ... ... ... ... ... ... ...

0x4589 Input Type_2H_CC32 F012 1,000 R/W 1 0=POSITIVE-EDGE

1=NEGATIVE-EDGE

2=POSITIVE

3=NEGATIVE

Ajustes Tiempo Retardo Entradas Tarjeta 2H (32 elementos) - Board 2H Delay Input Time Settings (32 items)

0x458A Delay Input Time_2H_CC1 F005 1,000 R/W 2 [0 , 60000] ms

0x458C Delay Input Time_2H_CC2 F005 1,000 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x45C8 Delay Input Time_2H_CC32 F005 1,000 R/W 2 [0 , 60000] ms

Ajustes Lógica de Salidas Tarjeta 2H (16 elementos) - Board  2H Output Logic Settings (16 items)

0x45CA Output Logic_2H_01 F012 1,000 R/W 1 0=POSITIVE

1=NEGATIVE

0x45CB Output Logic_2H_02 F012 1,000 R/W 1 0=POSITIVE

1=NEGATIVE

... ... ... ... ... ... ... ...

0x45D9 Output Logic_2H_16 F012 1,000 R/W 1 0=POSITIVE

1=NEGATIVE

Ajustes Tipo de Salidas Tarjeta 2H (16 elementos) - Board  2H Output Type Settings (16 items)
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0x45DA Output Type_2H_01 F012 1,000 R/W 1 0=NORMAL

1=PULSE

2=LATCH

0x45DB Output Type_2H_02 F012 1,000 R/W 1 0=NORMAL

1=PULSE

2=LATCH

... ... ... ... ... ... ... ...

0x45E9 Output Type_2H_16 F012 1,000 R/W 1 0=NORMAL

1=PULSE

2=LATCH

Ajustes Tiempo Pulso de Salida Tarjeta J - Board  J Pulse Output Time Settings (16 items)

0x45EA Pulse Output Time_2H_01 F005 1,000 R/W 2 [0 , 60000] ms

0x45EC Pulse Output Time_2H_02 F005 1,000 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x4608 Pulse Output Time_2H_16 F005 1,000 R/W 2 [0 , 60000] ms

0x460A Snapshot Events F012 1,000 R/W 1 0=DISABLED

1=ENABLED

Ajuste Rango de Entrada Analogica J (8 elementos) - Board  J Analog Input Range Settings (8 items)

0x460F Range_2H_01 F012 1,000 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA

5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

0x4610 Range_2H_02 F012 1,000 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA

5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

... ... ... ... ... ... ... ...

0x4616 Range_2H_08 F012 1,000 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA

5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

Ajustes Rango de Medida de Entrada Analógica J (8 elementos) - Board J Analog Input Measurement Range Settings (8 items)

0x4617 Min Value_2H_01 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

0x4619 Min Value_2H_02 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

... ... ... ... ... ... ... ...

0x4625 Min Value_2H_08 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

0x4627 Max Value_2H_01 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

0x4629 Max Value_2H_02 F003 1,000 R/W 2 [-9999,99 , 9999,99]  
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... ... ... ... ... ... ... ...

0x4635 Max Value_2H_08 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

0x4637 Channelx1a_2H_01 F003 1,000 R/W 2 [0,950 , 1,050]  

0x4639 Channelx1a_2H_02 F003 1,000 R/W 2 [0,950 , 1,050]  

... ... ... ... ... ... ... ...

0x4645 Channelx1a_2H_08 F003 1,000 R/W 2 [0,950 , 1,050]  

0x4647 Channelx1b_2H_01 F004 1,000 R/W 1 [-1000 , 1000]  

0x4648 Channelx1b_2H_02 F004 1,000 R/W 1 [-1000 , 1000]  

... ... ... ... ... ... ... ...

0x464E Channelx1b_2H_08 F004 1,000 R/W 1 [-1000 , 1000]  

0x464F Channelx10a_2H_01 F003 1,000 R/W 2 [0,950 , 1,050]  

0x4651 Channelx10a_2H_02 F003 1,000 R/W 2 [0,950 , 1,050]  

... ... ... ... ... ... ... ...

0x465D Channelx10a_2H_08 F003 1,000 R/W 2 [0,950 , 1,050]  

0x465F Channelx10b_2H_01 F004 1,000 R/W 1 [-1000 , 1000]  

0x4660 Channelx10b_2H_02 F004 1,000 R/W 1 [-1000 , 1000]  

... ... ... ... ... ... ... ...

0x4666 Channelx10b_2H_08 F004 1,000 R/W 1 [-1000 , 1000]  

0x4667 Calibration Type_2H F012 1,000 R/W 1 0=NONE

1=OFFSET

2=CALIBRATION

3=GET CALIBRATION

0x46F9 Confirmation address W 1

Ajustes Tarjeta 2J (MODULO CIO) - Board 2J Settings (CIO MODULE)

Ajustes Tipo Tarjeta 2J - Board 2J Board Type Settings

0x46FA I/O Board Type_2J F012 1,000 R/W 1 0=NONE

1=16INP + 8OUT

2=8INP + 8OUT + SUPV

3=16OUT

4=32INP

5=16INP + 8ANA

Ajustes de Tensión Tarjeta 2J - Board 2J Voltage Settings

0x46FB Voltage Threshold A_2J F004 1,000 R/W 1 [10 , 230] V

0x46FC Voltage Threshold B_2J F004 1,000 R/W 1 [10 , 230] V

0x47A0 Voltage Threshold C_2J F004 1,000 R/W 1 [10 , 230] V

0x47A1 Voltage Threshold D_2J F004 1,000 R/W 1 [10 , 230] V

Ajustes Tiempo Antirrebotes Tarjeta 2J -  Board 2J Debounce Time Settings

0x46FD Debounce Time A_2J F004 1,000 R/W 1 [1 , 50] ms

0x46FE Debounce Time B_2J F004 1,000 R/W 1 [1 , 50] ms

0x47A2 Debounce Time C_2J F004 1,000 R/W 1 [1 , 50] ms

0x47A3 Debounce Time D_2J F004 1,000 R/W 1 [1 , 50] ms

Ajuste Tipo de Entrada Tarjeta 2J (32 elementos) - Board 2J Input Type Settings (32 items)

0x46FF Input Type_2J_CC1 F012 1,000 R/W 1 0=POSITIVE-EDGE

1=NEGATIVE-EDGE

2=POSITIVE

3=NEGATIVE

0x4700 Input Type_2J_CC2 F012 1,000 R/W 1 0=POSITIVE-EDGE

1=NEGATIVE-EDGE

2=POSITIVE

3=NEGATIVE
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... ... ... ... ... ... ... ...

0x471E Input Type_2J_CC32 F012 1,000 R/W 1 0=POSITIVE-EDGE

1=NEGATIVE-EDGE

2=POSITIVE

3=NEGATIVE

Ajustes Tiempo Retardo Entradas Tarjeta 2J (32 elementos) - Board 2J Delay Input Time Settings (32 items)

0x471F Delay Input Time_2J_CC1 F005 1,000 R/W 2 [0 , 60000] ms

0x4721 Delay Input Time_2J_CC2 F005 1,000 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x475D Delay Input Time_2J_CC32 F005 1,000 R/W 2 [0 , 60000] ms

Ajustes Lógica de Salidas Tarjeta 2J (16 elementos) - Board  2J Output Logic Settings (16 items)

0x475F Output Logic_2J_01 F012 1,000 R/W 1 0=POSITIVE

1=NEGATIVE

0x4760 Output Logic_2J_02 F012 1,000 R/W 1 0=POSITIVE

1=NEGATIVE

... ... ... ... ... ... ... ...

0x476E Output Logic_2J_16 F012 1,000 R/W 1 0=POSITIVE

1=NEGATIVE

Ajustes Tipo de Salidas Tarjeta 2J (16 elementos) - Board  2J Output Type Settings (16 items)

0x476F Output Type_2J_01 F012 1,000 R/W 1 0=NORMAL

1=PULSE

2=LATCH

0x4770 Output Type_2J_02 F012 1,000 R/W 1 0=NORMAL

1=PULSE

2=LATCH

... ... ... ... ... ... ... ...

0x477E Output Type_2J_16 F012 1,000 R/W 1 0=NORMAL

1=PULSE

2=LATCH

Ajustes Tiempo Pulso de Salida Tarjeta J - Board  J Pulse Output Time Settings (16 items)

0x477F Pulse Output Time_2J_01 F005 1,000 R/W 2 [0 , 60000] ms

0x4781 Pulse Output Time_2J_02 F005 1,000 R/W 2 [0 , 60000] ms

... ... ... ... ... ... ... ...

0x479D Pulse Output Time_2J_16 F005 1,000 R/W 2 [0 , 60000] ms

0x479F Snapshot Events F012 1,000 R/W 1 0=DISABLED

1=ENABLED

Ajuste Rango de Entrada Analogica J (8 elementos) - Board  J Analog Input Range Settings (8 items)

0x47A4 Range_2J_01 F012 1,000 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA

5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

0x47A5 Range_2J_02 F012 1,000 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA
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5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

... ... ... ... ... ... ... ...

0x47AB Range_2J_08 F012 1,000 R/W 1 0=NONE

1=-1 to 0 mA

2=0 to 1 mA

3=-1 to 1 mA

4=0 to 5 mA

5=0 to 10 mA

6=0 to 20 mA

7=4 to 20 mA

Ajustes Rango de Medida de Entrada Analógica J (8 elementos) - Board J Analog Input Measurement Range Settings (8 items)

0x47AC Min Value_2J_01 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

0x47AE Min Value_2J_02 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

... ... ... ... ... ... ... ...

0x47BA Min Value_2J_08 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

0x47BC Max Value_2J_01 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

0x47BE Max Value_2J_02 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

... ... ... ... ... ... ... ...

0x47CA Max Value_2J_08 F003 1,000 R/W 2 [-9999,99 , 9999,99]  

0x47CC Channelx1a_2J_01 F003 1,000 R/W 2 [0,950 , 1,050]  

0x47CE Channelx1a_2J_02 F003 1,000 R/W 2 [0,950 , 1,050]  

... ... ... ... ... ... ... ...

0x47DA Channelx1a_2J_08 F003 1,000 R/W 2 [0,950 , 1,050]  

0x47DC Channelx1b_2J_01 F004 1,000 R/W 1 [-1000 , 1000]  

0x47DD Channelx1b_2J_02 F004 1,000 R/W 1 [-1000 , 1000]  

... ... ... ... ... ... ... ...

0x47E3 Channelx1b_2J_08 F004 1,000 R/W 1 [-1000 , 1000]  

0x47E4 Channelx10a_2J_01 F003 1,000 R/W 2 [0,950 , 1,050]  

0x47E6 Channelx10a_2J_02 F003 1,000 R/W 2 [0,950 , 1,050]  

... ... ... ... ... ... ... ...

0x47F2 Channelx10a_2J_08 F003 1,000 R/W 2 [0,950 , 1,050]  

0x47F4 Channelx10b_2J_01 F004 1,000 R/W 1 [-1000 , 1000]  

0x47F5 Channelx10b_2J_02 F004 1,000 R/W 1 [-1000 , 1000]  

... ... ... ... ... ... ... ...

0x47FB Channelx10b_2J_08 F004 1,000 R/W 1 [-1000 , 1000]  

0x47FC Calibration Type_2J F012 1,000 R/W 1 0=NONE

1=OFFSET

2=CALIBRATION

3=GET CALIBRATION

0x488E Confirmation address W 1

Digital Counters

0x48B8 DigCnt 1 Function F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x48B9 DigCnt 1 Name F009 1000 R/W 16

0x48C9 DigCnt 1 Preset F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x48CB DigCnt 1 Compare F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x48CD DigCnt 2 Function F012 1000 R/W 1 0=DISABLED

1=ENABLED
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0x48CE DigCnt 2 Name F009 1000 R/W 16

0x48DE DigCnt 2 Preset F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x48E0 DigCnt 2 Compare F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x48E2 DigCnt 3 Function F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x48E3 DigCnt 3 Name F009 1000 R/W 16

0x48F3 DigCnt 3 Preset F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x48F5 DigCnt 3 Compare F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x48F7 DigCnt 4 Function F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x48F8 DigCnt 4 Name F009 1000 R/W 16

0x4908 DigCnt 4 Preset F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x490A DigCnt 4 Compare F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x490C DigCnt 5 Function F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x490D DigCnt 5 Name F009 1000 R/W 16

0x491D DigCnt 5 Preset F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x491F DigCnt 5 Compare F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x4921 DigCnt 6 Function F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x4922 DigCnt 6 Name F009 1000 R/W 16

0x4932 DigCnt 6 Preset F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x4934 DigCnt 6 Compare F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x4936 DigCnt 7 Function F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x4937 DigCnt 7 Name F009 1000 R/W 16

0x4947 DigCnt 7 Preset F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x4949 DigCnt 7 Compare F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x494B DigCnt 8 Function F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x494C DigCnt 8 Name F009 1000 R/W 16

0x495C DigCnt 8 Preset F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x495E DigCnt 8 Compare F005 1000 R/W 2 [-2147483648 , 2147483647]  

0x4960 Snapshot Events F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x496A Confirmation address W 1

PTP 1588

0x4975 PTP FUNCTION F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x4976 PORTA DELAY ADDER F005 1000 R/W 2 [0 , 60000] ns

0x4978 PORTA DELAY ASYM F004 1000 R/W 1 [-1000 , 1000] ns

0x497A PORTB DELAY ADDER F005 1000 R/W 2 [0 , 60000] ns

0x497C PORTB DELAY ASYM F004 1000 R/W 1 [-1000 , 1000] ns

0x497D STRICT POWER PROFILE F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x497E PTP DOMAIN NUMBER F004 1000 R/W 1 [0 , 255]  

0x497F PTP VLAN PRIORITY F004 1000 R/W 1 [0 , 7]  

0x4980 PTP VLAN ID F004 1000 R/W 1 [0 , 4095]  

0x4981 PTP EPOCH F012 1000 R/W 1 0=UTC_SINCE_2000

1=UTC_SINCE_1900
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2=UTC_SINCE_1970

0x4988 Confirmation address W 1

Routing

0x4989 Default RT GWY Oct1 F004 1000 R/W 1 [0 , 255]  

0x498A Default RT GWY Oct2 F004 1000 R/W 1 [0 , 255]  

0x498B Default RT GWY Oct3 F004 1000 R/W 1 [0 , 255]  

0x498C Default RT GWY Oct4 F004 1000 R/W 1 [0 , 255]  

0x498D Static RT1 IP Oct1 F004 1000 R/W 1 [0 , 255]  

0x498E Static RT1 IP Oct2 F004 1000 R/W 1 [0 , 255]  

0x498F Static RT1 IP Oct3 F004 1000 R/W 1 [0 , 255]  

0x4990 Static RT1 IP Oct4 F004 1000 R/W 1 [0 , 255]  

0x4991 Static RT1 Mask Oct1 F004 1000 R/W 1 [0 , 255]  

0x4992 Static RT1 Mask Oct2 F004 1000 R/W 1 [0 , 255]  

0x4993 Static RT1 Mask Oct3 F004 1000 R/W 1 [0 , 255]  

0x4994 Static RT1 Mask Oct4 F004 1000 R/W 1 [0 , 255]  

0x4995 Static RT1 GWY Oct1 F004 1000 R/W 1 [0 , 255]  

0x4996 Static RT1 GWY Oct2 F004 1000 R/W 1 [0 , 255]  

0x4997 Static RT1 GWY Oct3 F004 1000 R/W 1 [0 , 255]  

0x4998 Static RT1 GWY Oct4 F004 1000 R/W 1 [0 , 255]  

0x4999 Static RT2 IP Oct1 F004 1000 R/W 1 [0 , 255]  

0x499A Static RT2 IP Oct2 F004 1000 R/W 1 [0 , 255]  

0x499B Static RT2 IP Oct3 F004 1000 R/W 1 [0 , 255]  

0x499C Static RT2 IP Oct4 F004 1000 R/W 1 [0 , 255]  

0x499D Static RT2 Mask Oct1 F004 1000 R/W 1 [0 , 255]  

0x499E Static RT2 Mask Oct2 F004 1000 R/W 1 [0 , 255]  

0x499F Static RT2 Mask Oct3 F004 1000 R/W 1 [0 , 255]  

0x49A0 Static RT2 Mask Oct4 F004 1000 R/W 1 [0 , 255]  

0x49A1 Static RT2 GWY Oct1 F004 1000 R/W 1 [0 , 255]  

0x49A2 Static RT2 GWY Oct2 F004 1000 R/W 1 [0 , 255]  

0x49A3 Static RT2 GWY Oct3 F004 1000 R/W 1 [0 , 255]  

0x49A4 Static RT2 GWY Oct4 F004 1000 R/W 1 [0 , 255]  

0x49A5 Static RT3 IP Oct1 F004 1000 R/W 1 [0 , 255]  

0x49A6 Static RT3 IP Oct2 F004 1000 R/W 1 [0 , 255]  

0x49A7 Static RT3 IP Oct3 F004 1000 R/W 1 [0 , 255]  

0x49A8 Static RT3 IP Oct4 F004 1000 R/W 1 [0 , 255]  

0x49A9 Static RT3 Mask Oct1 F004 1000 R/W 1 [0 , 255]  

0x49AA Static RT3 Mask Oct2 F004 1000 R/W 1 [0 , 255]  

0x49AB Static RT3 Mask Oct3 F004 1000 R/W 1 [0 , 255]  

0x49AC Static RT3 Mask Oct4 F004 1000 R/W 1 [0 , 255]  

0x49AD Static RT3 GWY Oct1 F004 1000 R/W 1 [0 , 255]  

0x49AE Static RT3 GWY Oct2 F004 1000 R/W 1 [0 , 255]  

0x49AF Static RT3 GWY Oct3 F004 1000 R/W 1 [0 , 255]  

0x49B0 Static RT3 GWY Oct4 F004 1000 R/W 1 [0 , 255]  

0x49B1 Static RT4 IP Oct1 F004 1000 R/W 1 [0 , 255]  

0x49B2 Static RT4 IP Oct2 F004 1000 R/W 1 [0 , 255]  

0x49B3 Static RT4 IP Oct3 F004 1000 R/W 1 [0 , 255]  

0x49B4 Static RT4 IP Oct4 F004 1000 R/W 1 [0 , 255]  

0x49B5 Static RT4 Mask Oct1 F004 1000 R/W 1 [0 , 255]  

0x49B6 Static RT4 Mask Oct2 F004 1000 R/W 1 [0 , 255]  

0x49B7 Static RT4 Mask Oct3 F004 1000 R/W 1 [0 , 255]  

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x49B8 Static RT4 Mask Oct4 F004 1000 R/W 1 [0 , 255]  

0x49B9 Static RT4 GWY Oct1 F004 1000 R/W 1 [0 , 255]  

0x49BA Static RT4 GWY Oct2 F004 1000 R/W 1 [0 , 255]  

0x49BB Static RT4 GWY Oct3 F004 1000 R/W 1 [0 , 255]  

0x49BC Static RT4 GWY Oct4 F004 1000 R/W 1 [0 , 255]  

0x49BD Static RT5 IP Oct1 F004 1000 R/W 1 [0 , 255]  

0x49BE Static RT5 IP Oct2 F004 1000 R/W 1 [0 , 255]  

0x49BF Static RT5 IP Oct3 F004 1000 R/W 1 [0 , 255]  

0x49C0 Static RT5 IP Oct4 F004 1000 R/W 1 [0 , 255]  

0x49C1 Static RT5 Mask Oct1 F004 1000 R/W 1 [0 , 255]  

0x49C2 Static RT5 Mask Oct2 F004 1000 R/W 1 [0 , 255]  

0x49C3 Static RT5 Mask Oct3 F004 1000 R/W 1 [0 , 255]  

0x49C4 Static RT5 Mask Oct4 F004 1000 R/W 1 [0 , 255]  

0x49C5 Static RT5 GWY Oct1 F004 1000 R/W 1 [0 , 255]  

0x49C6 Static RT5 GWY Oct2 F004 1000 R/W 1 [0 , 255]  

0x49C7 Static RT5 GWY Oct3 F004 1000 R/W 1 [0 , 255]  

0x49C8 Static RT5 GWY Oct4 F004 1000 R/W 1 [0 , 255]  

0x49C9 Static RT6 IP Oct1 F004 1000 R/W 1 [0 , 255]  

0x49CA Static RT6 IP Oct2 F004 1000 R/W 1 [0 , 255]  

0x49CB Static RT6 IP Oct3 F004 1000 R/W 1 [0 , 255]  

0x49CC Static RT6 IP Oct4 F004 1000 R/W 1 [0 , 255]  

0x49CD Static RT6 Mask Oct1 F004 1000 R/W 1 [0 , 255]  

0x49CE Static RT6 Mask Oct2 F004 1000 R/W 1 [0 , 255]  

0x49CF Static RT6 Mask Oct3 F004 1000 R/W 1 [0 , 255]  

0x49D0 Static RT6 Mask Oct4 F004 1000 R/W 1 [0 , 255]  

0x49D1 Static RT6 GWY Oct1 F004 1000 R/W 1 [0 , 255]  

0x49D2 Static RT6 GWY Oct2 F004 1000 R/W 1 [0 , 255]  

0x49D3 Static RT6 GWY Oct3 F004 1000 R/W 1 [0 , 255]  

0x49D4 Static RT6 GWY Oct4 F004 1000 R/W 1 [0 , 255]  

0x49EC Confirmation address W 1

Network(Ethernet) E Settings

0x49ED IP Address Oct1 F004 1000 R/W 1 [0 , 255]  

0x49EE IP Address Oct2 F004 1000 R/W 1 [0 , 255]  

0x49EF IP Address Oct3 F004 1000 R/W 1 [0 , 255]  

0x49F0 IP Address Oct4 F004 1000 R/W 1 [0 , 255]  

0x49F1 Netmask Oct1 F004 1000 R/W 1 [0 , 255]  

0x49F2 Netmask Oct2 F004 1000 R/W 1 [0 , 255]  

0x49F3 Netmask Oct3 F004 1000 R/W 1 [0 , 255]  

0x49F4 Netmask Oct4 F004 1000 R/W 1 [0 , 255]  

0x4A05 Confirmation address W 1

Redundancy settings

0x4A06 REDUNDANCY MODE F012 1000 R/W 1 0=INDEPENDENT

1=LLA
2=PRP  
3=HSR  
4=RSTP  
5=DAISY_CHAIN  

0x4A07 LLA Priority F012 1000 R/W 1 0=DISABLED

1=ENABLED

0x4A08 LLA Timeout F005 1000 R/W 2 [0 , 600000] ms

0x4A0A RSTP BRIDGE PRIORITY F005 1000 R/W 2 [0 , 61440]  

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0x4A0C RSTP PORTA PRIORITY F005 1000 R/W 2 [0 , 240]  

0x4A0E RSTP PORTA PATHCOST F005 1000 R/W 2 [0 , 2000000]  

0x4A10 RSTP PORTB PRIORITY F005 1000 R/W 2 [0 , 240]  

0x4A12 RSTP PORTB PATHCOST F005 1000 R/W 2 [0 , 2000000]  

0x4A1E Confirmation address W 1

Bits de Maniobra (24 bits) - Commands

0xAFFE 0x0001 Operation 1 F001  W 1  

0xAFFE 0x0002 Operation 2 F001  W 1  

0xAFFE 0x0004 Operation 3 F001  W 1  

0xAFFE 0x0008 Operation 4 F001  W 1  

0xAFFE 0x0010 Operation 5 F001  W 1  

0xAFFE 0x0020 Operation 6 F001  W 1  

0xAFFE 0x0040 Operation 7 F001  W 1  

0xAFFE 0x0080 Operation 8 F001  W 1  

0xAFFE 0x0100 Operation 9 F001  W 1  

0xAFFE 0x0200 Operation 10 F001  W 1  

0xAFFE 0x0400 Operation 11 F001  W 1  

0xAFFE 0x0800 Operation 12 F001  W 1  

0xAFFE 0x1000 Operation 13 F001  W 1  

0xAFFE 0x2000 Operation 14 F001  W 1  

0xAFFE 0x4000 Operation 15 F001  W 1  

0xAFFE 0x8000 Operation 16 F001  W 1  

0xAFFF 0x0001 Operation 17 F001  W 1  

0xAFFF 0x0002 Operation 18 F001  W 1  

0xAFFF 0x0004 Operation 19 F001  W 1  

0xAFFF 0x0008 Operation 20 F001  W 1  

0xAFFF 0x0010 Operation 21 F001  W 1  

0xAFFF 0x0020 Operation 22 F001  W 1  

0xAFFF 0x0040 Operation 23 F001  W 1  

0xAFFF 0x0080 Operation 24 F001  W 1  

Identificación del Equipo - Relay Identification

0xB000  Relay model F009  R 8  

0xB008  Firmware version F009  R 2  

0xB018  Year(0=2000,1=2001,...) and part 
of firmware compilation

F001  R 1  

0xB019  Day and month of firmware 
compilation

F001  R 1  

0xB020  Address of PLC equations F005  R 2  

0xB022  Address of LCD configuration F005  R 2  

Eventos de Control y Panel de Alarmas - Control Events & Alarm Panel

0xF000  Status and acknowledge of the 
192 control events

F001  R 24 Status = 24 first bytes

       1st byte: 1st eight control events (First 
event=bit less significant)

       2nd byte: 2nd eight control events (Ninth 
event=bit less significant)

       . . .

       Ack = 24 second bytes

       25th byte: 1st eight control events (First 
event=bit less significant)

26th byte: 2nd eight control events (Ninth 
event=bit less significant)

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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. . .

0xF018  Indicate which control events are 
configurated as alarm

F001  R 12 1st byte: 1st eight control events (First 
event=bit less significant)

       2nd byte: 2nd eight control events (Ninth 
event=bit less significant)

       . . .

0xF024  Date/Time of the 1-16 alarms F011  R 64  

0xF064  Date/Time of the 17-32 alarms F011  R 64  

0xF0A4  Date/Time of the 33-48 alarms F011  R 64  

0xF0E4  Date/Time of the 49-64 alarms F011  R 64  

0xF124  Date/Time of the 65-80 alarms F011  R 64  

0xF164  Date/Time of the 81-96 alarms F011  R 64  

0xF1A4  Date/Time of the 97-112 alarms F011  R 64  

0xF1E4  Date/Time of the 113-128 
alarms

F011  R 64  

0xF224  Date/Time of the 129-144 
alarms

F011  R 64  

0xF264  Date/Time of the 145-160 
alarms

F011  R 64  

0xF2A4  Date/Time of the 161-176 
alarms

F011  R 64  

0xF2E4  Date/Time of the 177-192 
alarms

F011  R 64  

Entradas Virtuales - Virtual Inputs

0xF430  64 Virtual Inputs (32 Latched + 
32 Self Reset)

F001  R/W 4 2nd byte: 1st eight virtual inputs (First 
virtual input=bit less significant)

       1st byte: 2nd eight virtual inputs (Ninth 
virtual input=bit less significant)

       . . .

Nombre Fichero de Eventos - Events File Name

0xFE00  Name of the events file to read F009  W  EVE.TXT: all snapshot-events are sent in 
ASCII format

       NEW_EVE.TXT: the new snapshot-events 
are sent in ASCII format

       EVE.BIN: all snapshot-events are sent in 
BINARY format

       NEW_EVE.BIN: the new snapshot-events 
are sent in BINARY format

Forzado de Salidas por Comunicaciones - Forcing Outputs

0xFE20  Opening force output file F004  W 3 Write "OUTPUT"

0xFE28  Closing force output file F004  W 3 Write "OUTPUT"

0xFF20  Forcing outputs F004  W 5 First word = Board number;

Ficheros Oscilografía y Reporte de Faltas - Oscillography and Fault Report Files

0xFE40 Name of the oscillography/fault 
report file to read

F009 W OSCXXX.DAT, OSCXXX.CFG, OSCXXX.HDR

FLTXXX.TXT (where XXX=001 to 999)

Sucesos - Snapshot events

0xFF00  Character position of current 
block within events file

F005  R 2  

0xFF02  Size of currently-available data 
block of events file

F004  R 1  

0xFF03  Block of data requested events 
file (122 items)

F004  R 1  

Ficheros Oscilografía y Reporte de Faltas - Oscillography and Fault Report Files

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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0xFF40  Character position of current 
block within osc file

F005  R 2  

0xFF42  Size of currently-available data 
block of osc file

F004  R 1  

0xFF43  Block of data requested osc file 
(122 items)

F004  R 1  

Sincronización Horaria - Synchronization

0xFFF0  Synchronization (milliseconds 
from 01/01/2000)

F011  R/W 4  

 DESCRIPCIÓN FORMATO DE DATOS - FORMATS DESCRIPTION

 F001 UNSIGNED INT 16 BIT (BITMASK)      

 F002 SIGNED INT 32 BIT      

 F003 FLOAT 32 BIT      

 F004 SIGNED INT 16 BIT      

 F005 SIGNED INT 32 BIT      

 F006 DOUBLE 64 BIT      

 F007 UNSIGNED INT 8 BIT      

 F008 SIGNED INT 8 BIT      

 F009 STRING      

 F011 UNSIGNED INT 64 BIT 
(MILLISECONDS FROM 01/01/
2000)

     

 F012 UNSIGNED INT 16 BIT 
(ENUMERATED)

     

ADDRESS BIT NAME FORMAT STEP MODE LENGTH MISCELLANEOUS
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C650 Bay Controller & Monitoring System

Appendix C:  DNP 3.0 protocol for C650

GE
Grid Solutions

DNP 3.0 PROTOCOL FOR C650

C.1  DNP 3.0 protocol settings
C650 units enable the programming of certain parameters related to DNP3 protocol. These parameters are called DNP3 
protocol settings and can be modified from the front panel or from the Level 2 software. The C650 relay supports 
communication with multiple masters (3) and maintains three separate groups of DNP3 settings. Each group of DNP3 
settings is related to a single logical DNP3 slave device. The C650 relay is able to communicate simultaneously with up to 
three different DNP3 master stations. Each master communicates with a different logical DNP3 slave, these logical slaves 
appearing as separate physical DNP3 slaves. This is achieved by keeping separate set of settings, event queues and set of 
states for each logical device. 

Notice that it is necessary to set different DNP Address and TCP/UDP Port for each logical DNP3 slave device.

Time synchronization through DNP protocol is available from all three DNP masters that can communicate with C650. 
However the date & time are taken from only one master at the same moment. It is recommended to use only one master 
to do time sync through DNP.

Setting No. Setting Name Default Value Range

1 Physical Port NONE NONE, COM1, COM2, NETWORK

2 Address 255 0 to 65534, step 1

3 IP Addr Client1 Oct1 0 0 to 255 step 1

4 IP Addr Client1 Oct2 0 0 to 255 step 1

5 IP Addr Client1 Oct3 0 0 to 255 step 1

6 IP Addr Client1 Oct4 0 0 to 255 step 1

7 IP Addr Client2 Oct1 0 0 to 255 step 1

8 IP Addr Client2 Oct2 0 0 to 255 step 1

9 IP Addr Client2 Oct3 0 0 to 255 step 1

10 IP Addr Client2 Oct4 0 0 to 255 step 1

11 IP Addr Client3 Oct1 0 0 to 255 step 1

12 IP Addr Client3 Oct2 0 0 to 255 step 1

13 IP Addr Client3 Oct3 0 0 to 255 step 1

14 IP Addr Client3 Oct4 0 0 to 255 step 1

15 IP Addr Client4 Oct1 0 0 to 255 step 1

16 IP Addr Client4 Oct2 0 0 to 255 step 1
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17 IP Addr Client4 Oct3 0 0 to 255 step 1

18 IP Addr Client4 Oct4 0 0 to 255 step 1

19 IP Addr Client5 Oct1 0 0 to 255 step 1

20 IP Addr Client5 Oct2 0 0 to 255 step 1

21 IP Addr Client5 Oct3 0 0 to 255 step 1

22 IP Addr Client5 Oct4 0 0 to 255 step 1

23 TCP/UDP Port 20000 1 to 65535, step 1

24 Unsol Resp Function DISABLED DISABLED, ENABLED

25 Unsol Resp TimeOut 5 s 0 to 60 sec, step 1

26 Unsol Resp Max Ret 10 1 to 255, step 1 

27 Unsol Resp Dest Adr 200 0 to 65519, step 1

28 Current Scale Factor 1 0.00001, 0.0001, 0.001, 0.01, 0.1, 1, 10, 100, 1000, 10000

29 Voltage Scale Factor 1 0.00001, 0.0001, 0.001, 0.01, 0.1, 1, 10, 100, 1000, 10000

30 Power Scale Factor 1 0.00001, 0.0001, 0.001, 0.01, 0.1, 1, 10, 100, 1000, 10000

31 Energy Scale Factor 1 0.00001, 0.0001, 0.001, 0.01, 0.1, 1, 10, 100, 1000, 10000

32 Other Scale Factor 1 0.00001, 0.0001, 0.001, 0.01, 0.1, 1, 10, 100, 1000, 10000

33 Current Deadband 30000 0 to 65535, step 1

34 Voltage Deadband 30000 0 to 65535, step 1

35 Power Deadband 30000 0 to 65535, step 1

36 Energy Deadband 30000 0 to 65535, step 1

37 Other Deadband 30000 0 to 65535, step 1

38 Msg Fragment Size 240 30 to 2048, step 1 

39 Binary Input Block1 CTL EVENTS 1-16 See the explanation below

40 Binary Input Block2 CTL EVENTS 17-32 See the explanation below

41 Binary Input Block3 CTL EVENTS 33-48 See the explanation below

42 Binary Input Block4 CTL EVENTS 49-64 See the explanation below

43 Binary Input Block5 CTL EVENTS 65-80 See the explanation below

44 Binary Input Block6 CTL EVENTS 81-96 See the explanation below

45 Binary Input Block7 CTL EVENTS 97-112 See the explanation below

46 Binary Input Block8 CTL EVENTS 113-128 See the explanation below

47 Binary Input Block9 SWITCHGEAR 1-8 See the explanation below

48 Binary Input Block10 SWITCHGEAR 9-16 See the explanation below

49 Default analog Map Disabled See the explanation below

50 Analog Input Point 0  End Of List See the explanation below

51 Analog Input Point 1  End Of List See the explanation below

52 Analog Input Point 2  End Of List See the explanation below

53 Analog Input Point 3  End Of List See the explanation below

54 Analog Input Point 4  End Of List See the explanation below

55 Analog Input Point 5  End Of List See the explanation below

56 Analog Input Point 6  End Of List See the explanation below

57 Analog Input Point 7  End Of List See the explanation below

58 Analog Input Point 8  End Of List See the explanation below

59 Analog Input Point 9  End Of List See the explanation below

60 Analog Input Point 10  End Of List See the explanation below

61 Analog Input Point 11  End Of List See the explanation below

62 Analog Input Point 12  End Of List See the explanation below

63 Analog Input Point 13  End Of List See the explanation below

64 Analog Input Point 14  End Of List See the explanation below

65 Analog Input Point 15  End Of List See the explanation below

66 Analog Input Point 16  End Of List See the explanation below

Setting No. Setting Name Default Value Range
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1. Physical Port: The C650 supports the Distributed Network Protocol (DNP) version 3.0. The C650 can be used as a 
DNP slave device connected up to three DNP masters (usually RTUs or SCADA master stations). The Physical Port 
setting is used to select the communications port assigned to the DNP protocol for a specific logical DNP slave 
device of C650. When this setting is set to NETWORK, the DNP protocol can be used over either TCP/IP or UDP/IP. 

2. Address: This setting is the DNP slave address. This number identifies de C650 on a DNP communications link. Each 
logical DNP slave should be assigned a unique address.

3-22. IP Addr Client x Oct x: this setting is one of four octets of an IP address. The C650 relay can respond to a maximum 
of 5 specific DNP masters (not in the same time). To set the IP address of DNP master it is necessary to set four 
octets (e.g. to set the IP address of the first DNP master to 192.168.48.125, you should set IP Addr Client1 Oct1 = 
192, IP Addr Client1 Oct2 = 168, IP Addr Client1 Oct3 = 48, IP Addr Client1 Oct4 = 125).

23. TCP/UDP Port: TCP/UDP port number for the case of DNP3 communication being performed through the Ethernet.

24. Unsol Resp Function: ENABLED, if unsolicited responses are allowed, and DISABLED otherwise.

25. Unsol Resp TimeOut: sets the time the C650 waits for a DNP master to confirm an unsolicited response.

26. Unsol Resp Max Ret: This setting determines the number of times the C650 retransmits an unsolicited response 
without receiving a confirmation from the master. Once this limit has been exceeded, the unsolicited response is 
sent at a larger interval. This interval is called the unsolicited offline interval and is fixed at 10 minutes.

27. Unsol Resp Dest Adr: This setting is DNP address to which all unsolicited responses are sent. The IP address to 
which unsolicited responses are sent is determined by the C650 from either the current DNP TCP connection or the 
most recent UDP message.

28-32. Scale Factor: These settings are numbers used to scale Analog Input point values. These settings group the C650 
Analog Input data into types: current, voltage, power, energy, and other. Each setting represents the scale factor 
for all Analog Input points of that type. For example, if the Voltage Scale Factor is set to a value of 1000, all DNP 
Analog Input points that are voltages are returned with the values 1000 times smaller (e.g. a value 72000 V on the 
C650 is returned as 72). These settings are useful when Analog Input values must be adjusted to fit within certain 
ranges in DNP masters. Note that a scale factor of 0.1 is equivalent to a multiplier of 10 (i.e. the value is 10 times 
larger).

33-37. Deadband: These settings are the values used by the C650 to determine when to trigger unsolicited responses 
containing Analog Input data. These settings group the C650 Analog Input data into types: current, voltage, power, 
energy, and other. Each setting represents the default deadband value for all Analog Input points of that type. For 
example, in order to trigger unsolicited responses from the C650 when any current values change by 15 A, the 
Current Deadband setting should be set to 15. Note that these settings are the default values of the deadbands. 
DNP object 34 points can be used to change deadband values, from the default, for each individual DNP Analog 
Input point. Whenever power is removed and re-applied to the C650, the default deadbands are in effect.

67 Analog Input Point 17  End Of List See the explanation below

68 Analog Input Point 18  End Of List See the explanation below

69 Analog Input Point 19  End Of List See the explanation below

70 Analog Input Point 20  End Of List See the explanation below

71 Analog Input Point 21  End Of List See the explanation below

72 Analog Input Point 22  End Of List See the explanation below

73 Analog Input Point 23  End Of List See the explanation below

74 Analog Input Point 24  End Of List See the explanation below

75 Analog Input Point 25  End Of List See the explanation below

76 Analog Input Point 26  End Of List See the explanation below

77 Analog Input Point 27  End Of List See the explanation below

78 Analog Input Point 28  End Of List See the explanation below

79 Analog Input Point 29  End Of List See the explanation below

80 Analog Input Point 30  End Of List See the explanation below

81 Analog Input Point 31  End Of List See the explanation below

Setting No. Setting Name Default Value Range
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38. Msg Fragment Size: This setting determines the size, in bytes, at which message fragmentation occurs. Large 
fragment sizes allow for more efficient throughput; smaller fragment sizes cause more application layer 
confirmations to be necessary which can provide for more robust data transfer over noisy communication 
channels 

39-48. Binary Input Block x: These settings allow customization and change of the size of DNP Binary Inputs point list. The 
default Binary Inputs point list contains 160 points representing binary states that are configured using Setpoint > 
Relay Configuration in the EnerVista 650 Setup program. These 160 binary states are grouped in 10 blocks of 16 
points each. There are 128 bits (8 blocks of 16) called Control Events and 32 bits (2 blocks of 16) corresponding to 
the states of 16 switchgears available in C650 relay. If not all of the 160 points are required in the DNP master, a 
custom Binary Inputs point list can be created by selecting up to 10 blocks of 16 points. Each block represents 16 
Binary Input points. Block 1 represents Binary Input points 0-15, block 2 represents Binary Input points 16- 31, block 
3 represents Binary Input points 32-47, etc. The minimum number of Binary Input points that can be selected is 16 
(1 block). If all of the Binary Input Block x settings are set to “NOT USED”, the default list of 160 points is in effect. 
The C650 forms the Binary Inputs points list from the Binary Input Block x settings up to the first occurrence of a 
setting value “NOT USED”. Permitted values for these settings are: NOT USED, CTL EVENTS 1-16, CTL EVENTS 17-32, 
CTL EVENTS 33-48, CTL EVENTS 49-64, CTL EVENTS 65-80, CTL EVENTS 81-96, CTL EVENTS 97-112, CTL EVENTS 113-
128, SWITCHGEAR 1-8, SWITCHGEAR 9-16,BOARD F 1-16,BOARD F 17-32, BOARD G 1-16, BOARD G 17-32,BOARD H 
1-16, BOARD H 17-32, BOARD J 1-16,BOARD J 17-32.

49-81. Default analog Map: This setting allows selection between predefined Analog Input Points or choosing preferred 
Analog Input Points (from 50 to 81).
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C.2  DNP 3.0 device profile document 
The following table provides a “Device Profile Document” in the standard format defined in the DNP 3.0 Subset Definitions 
Document.

DNP V3.00 DEVICE PROFILE DOCUMENT (Sheet 1 of 3)
(Also see the IMPLEMENTATION TABLE in the following section)
Vendor Name: General Electric Multilin
Device Name: C650 Relay
Highest DNP Level Supported:

For Requests: Level 2

For Responses: Level 2

Device Function:

 Master

 Slave
Notable objects, functions, and/or qualifiers supported in addition to the Highest DNP Levels Supported (the complete 
list is described in the attached table):

Binary Inputs (Object 1)

Binary Inputs Changes (Object 2)

Binary Outputs (Object 10)

Binary Counters (Object 20)

Frozen Counters (21)

Binary Counters Change (Object 22)

Frozen Counter Change (23) 

Analog Inputs (Object 30)

Analog Input Changes (Object 32)

Analog Deadbands (Object 34)
Maximum Data Link String Size (octets):

Transmitted: 292

Received: 292

Maximum Application Fragment Size (octets):

Transmitted: Configurable up to 2048

Received: 2048
Maximum Data Link Re-tries:

 None

 Fixed at 2

 Configurable

Maximum Application Layer Re-tries:

 None

 Configurable

Requires Data Link Layer Confirmation:

 Never

 Always

 Sometimes

 Configurable
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DNP V3.00 DEVICE PROFILE DOCUMENT (Sheet 2 of 3)

Requires Application Layer Confirmation:

 Never

 Always

 When reporting Event Data

 When sending multi-fragment responses

 Sometimes

 Configurable
Timeouts while waiting for:
Data Link Confirm:

Complete Appl. Fragment:

Application Confirm:

Complete Appl. Response

  None

 None

  None

 None

 Fixed at 3 s

 Fixed at 

 Fixed at 4 s

 Fixed at

 Variable

 Variable

 Variable

 Variable

 Configurable

 Configurable

 Configurable

 Configurable
Others:

Transmission Delay:

Need Time Delay:

Select/Operate Arm Timeout:

Binary Input change scanning period:

Packed binary change process period:

Analog Input change scanning period:

Unsolicited response notification delay:

Unsolicited response retry delay:

Unsolicited offline interval:

No intentional delay

10 min.

10 s

1 ms

1 s

500 ms

500 ms

Configurable 0 to 60 s

10 min.
Sends/Executes Control Operations:
WRITE Binary Outputs

SELECT/OPERATE

DIRECT OPERATE

DIRECT OPERATE – NO ACK

 Never

 Never

 Never

 Never

 Always

 Always

 Always

 Always

 Sometimes

 Sometimes

 Sometimes

 Sometimes

 Configurable

 Configurable

 Configurable

 Configurable
Count > 1

Pulse On

Pulse Off

Latch On

Latch Off

 Never

 Never

 Never

 Never

 Never

 Always

 Always

 Always

 Always

 Always

 Sometimes

 Sometimes

 Sometimes

 Sometimes

 Sometimes

 Configurable

 Configurable

 Configurable

 Configurable

 Configurable
Queue 

Clear Queue

 Never

 Never

 Always

 Always

 Sometimes

 Sometimes

 Configurable

 Configurable
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DNP V3.00 DEVICE PROFILE DOCUMENT (Sheet 3 of 3)

Reports Binary Input Change Events when no specific 
variation requested:

 Never

 Only time-tagged

 Only non-time-tagged

 Configurable

Reports time-tagged Binary Input Change Events when no 
specific variation requested:

 Never

 Binary Input Change With Time

 Binary Input Change With Relative Time

 Configurable (attach explanation)
Sends Unsolicited Responses:

 Never

 Configurable

 Only certain objects

 Sometimes (attach explanation)

 ENABLE/DISABLE unsolicited Function codes 
supported

Sends Static Data in Unsolicited Responses:

 Never

 When Device Restarts

 When Status Flag Change

No other options permitted

Explanation of ‘Sometimes’: It will be disabled for RS-
485 applications, since there is no collision avoidance 
mechanism. For ethernet communication it will be 
available and it can be disabled or enabled with the 
proper function code.
Default CounterObject/Variation:

 No Counters Reported

 Configurable (attach explanation)

 Default Object: 20.

        Default Variation: 1

 Point-by-point list attached

Counters Roll Over at:

 No Counters Reported

 Configurable (attach explanation)

 16 Bits 

 32 Bits

 Other Value: ______

 Point-by-point list attached
Sends Multi-Fragment Responses:

 Yes

 No
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C.3  Implementation table

The following table shows objects, variations, function codes and qualifiers supported by C650 units, both in requests and 
responses for DNP3 protocol. For static (non-change-event) objects, requests sent with qualifiers 00, 01, 06, 07 or 08, are 
responded to with qualifiers 00 or 01. Static object requests sent with qualifiers 17 or 28 are responded to with qualifiers 17 
or 28. For change-event objects, qualifiers 17 or 28 are always responded.

Text in bold and italic indicates functionality higher than DNP3 implementation level 2.

IMPLEMENTATION TABLE (Sheet 1 out of 3)

Note 1: A default variation refers to the variation responded when variation 0 is requested and/or in class 0, 1, 2, or 3 scans.
Note 2: For static (non-change-event) objects, qualifiers 17 or 28 are only responded when a request is sent with qualifiers 17 or 28, 

respectively. Otherwise, static object requests sent with qualifiers 00, 01, 06, 07, or 08, are responded to with qualifiers 00 or 01 (for 
change-event objects, qualifiers 17 or 28 are always responded).

Note 3: Cold restarts are implemented the same as warm restarts – The C650 is not restarted, but the DNP process is restarted.

OBJECT REQUEST RESPONSE

Object 
No.

Variation 
No.

Description Function Codes 
(dec)

Qualifier Codes 
(hex)

Function Codes Qualifier Codes 
(hex)

1 0 Binary Input  (Variation 0 is used to 
request default variation)

1 (read)
22 (assign class)

06 (no range, or all)
00,01 (start-stop)
07,08 (limited qty)
17,28 (index)

1 1 Binary Input 1 (read)
22 (assign class)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)
00, 01 (start-stop)
17,28 (index)
See Note 2

1 2 Binary Input with Status
(default – see Note 1)

1 (read)
22 (assign class)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)
00, 01 (start-stop)
17,28 (index)
See Note 2

2 0 Binary Input Change - All Variations
See Note 1 1 (read) 06 (no range, or all)

07,08 (limited qty)

2 1 Binary Input Change without Time 1 (read) 06 (no range, or all)
07,08 (limited qty)

129 (response) 
130 (unsol. resp.) 17, 28 (index)

2 2 Binary Input Change with Time 1 (read) 06 (no range, or all)
07,08 (limited qty)

129 (response) 
130 (unsol. resp.) 17, 28 (index)

10 0 Binary Output - All Variations 1 (read)

06 (no range, or all)
00,01 (start-stop)
07,08 (limited qty)
17,28 (index)

10 2 Binary Output Status 
See Note 1 1 read

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)
00, 01 (start-stop)
17,28 (index)
See Note 2

12 1 Control Relay Output Block

3 (select)
4 (operate)
5 (direct op)
6 (dir.op, noack)

00,01 (start-stop)
07,08 (limited qty)
17, 28 (index)

129 (response) echo of request

20 0 Binary Counter - All Variations

1 (select)
7 (freeze)
8 (freeze noack)
9 (freeze clear)
10 (frz.cl. noack)

06 (no range, or all)
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IMPLEMENTATION TABLE (Sheet 2 out of 3)

Note 1: A default variation refers to the variation responded when variation 0 is requested and/or in class 0, 1, 2, or 3 scans.
Note 2: For static (non-change-event) objects, qualifiers 17 or 28 are only responded when a request is sent with qualifiers 17 or 28, 

respectively. Otherwise, static object requests sent with qualifiers 00, 01, 06, 07, or 08, are responded to with qualifiers 00 or 01 (for 
change-event objects, qualifiers 17 or 28 are always responded).

Note 3: Cold restarts are implemented the same as warm restarts – The C650 is not restarted, but the DNP process is restarted.

OBJECT REQUEST RESPONSE

Object 
No.

Variation 
No.

Description Function Codes 
(dec)

Qualifier Codes 
(hex)

Function Codes Qualifier Codes 
(hex)

21 0 Frozen Counter - All Variations 1 (read) 06 (no range, or all)

22 0 Counter Change Event - All 
Variations 1 (read) 06 (no range, or all)

07,08 (limited qty)

23 0 Frozen Counter Change Event 1 (read) 06 (no range, or all)
07,08 (limited qty)

30 0 Analog Input - All Variations 1 (read)
22 (assign class)

06 (no range, or all)
00,01 (start-stop)
07,08 (limited qty)
17,28 (index)

30 1 32-Bit Analog Input 
See Note 1

1 (read)
22 (assign class)

000,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)

00, 01 (start-
stop)
17,28 (index)
See Note 2

30 2 16-Bit Analog Input
1 (read)
22 (assign class)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)

00, 01 (start-
stop)
17,28 (index)
See Note 2

30 3 32-Bit Analog Input without Flag 1 (read)
22 (assign class)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)

00, 01 (start-
stop)
17,28 (index)
See Note 2

30 4 16-Bit Analog Input without Flag 1 (read)
22 (assign class)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)

00, 01 (start-
stop)
17,28 (index)
See Note 2

30 5 Analog Short Float 1 (read)
22 (assign class)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)

00, 01 (start-
stop)
17,28 (index)
See Note 2

32 0 Analog Change Event - All Variations 1 (read) 06 (no range, or all)
07,08 (limited qty)

32 1
32-Bit Analog Change Event without 
Time 
See Note 1

1 (read) 06 (no range, or all)
07,08 (limited qty)

129 (response)
130 (unsol.resp) 17, 28 (index)

32 2 16-Bit Analog Change Event without 
Time 1 (read) 06 (no range, or all)

07,08 (limited qty)
129 (response)
130 (unsol.resp) 17, 28 (index)

32 3 32-Bit Analog Change Event with 
Time 1 (read) 06 (no range, or all)

07,08 (limited qty)
129 (response)
130 (unsol.resp) 17,28 (index)

32 4 16-Bit Analog Change Event with 
Time 1 (read) 06 (no range, or all)

07,08 (limited qty)
129 (response)
130 (unsol.resp) 17,28 (index)

32 5 Analogs (Short-float) without time 1 (read) 06 (no range, or all)
07,08 (limited qty)

129 (response)
130 (unsol.resp) 17,28 (index)

32 7 Analogs (Short-float) with time 1 (read) 06 (no range, or all)
07,08 (limited qty)

129 (response)
130 (unsol.resp) 17,28 (index)

34 0 Analog Input Reporting Deadband 1 (read)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

34 1
16-Bit Analog Input Reporting 
Deadband 
See Note 1

1 (read)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)

00,01 (start-
stop)
17,28 (index)
See Note 2
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IMPLEMENTATION TABLE (Sheet 3 out of 3)

Note 1: A default variation refers to the variation responded when variation 0 is requested and/or in class 0, 1, 2, or 3 
scans.

Note 2: For static (non-change-event) objects, qualifiers 17 or 28 are only responded when a request is sent with qualifiers 
17 or 28, respectively. Otherwise, static object requests sent with qualifiers 00, 01, 06, 07, or 08, are responded to with 
qualifiers 00 or 01 (for change-event objects, qualifiers 17 or 28 are always responded).

Note 3: Cold restarts are implemented the same as warm restarts – The C650 is not restarted, but the DNP process is 
restarted.

OBJECT REQUEST RESPONSE

Object 
No.

Variation 
No.

Description Function Codes 
(dec)

Qualifier Codes 
(hex)

Function Codes Qualifier Codes 
(hex)

34 2
32-Bit Analog Input Reporting 
Deadband 
See Note 1

2 (write)
00,01 (start-stop)
07,08 (limited qty)
17,28 (index)

50 0 Time and Date - All Variations 1 (read)

00,01 (start-stop)
06 (no range, or all)
07,08 (limited qty)
17,28 (index)

129 (response)

00,01 (start-
stop)
17,28 (index)
See Note 2

50 1 Time and Date 
See Note 1

1 (read)
2 (write)

00,01 (start-stop)
06 (no range, or all)
07 (limited qty=1)
08 (limited qty)
17,28 (index)

129 (response)

00,01 (start-
stop)
17,28 (index)
See Note 2

52 2 Time Delay Fine 
1 (read)
2 (write)  129 (response) 07 (limited qty) 

quantity=1 

60 0 Class 0, 1, 2, and 3 Data

1 (read)
20 (enable unsol)
21 (disable unsol)
22 (assign class)

06 (no range, or all)

60 1 Class 0 Data 06 (no range, or all)

60 2 Class 1 Data

1 (read)
20 (enable unsol)
21 (disable unsol)
22 (assign class)

06 (no range, or all)
07,08 (limited qty)

60 3 Class 2 Data

1 (read)
20 (enable unsol)
21 (disable unsol)
22 (assign class)

06 (no range, or all)
07,08 (limited qty)

60 4 Class 3 Data

1 (read)
20 (enable unsol)
21 (disable unsol)
22 (assign class)

06 (no range, or all)
07,08 (limited qty)

80 1 Internal Indications 2 (write) 00 (start-stop)
(index must =7)

No Object (function code only)
See Note 3 13 (cold restart)

No Object (function code only) 14 (warm restart)

No Object (function code only) 23 (delay meas.)
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C.4  Binary input points
The C650 relay has a configurable Map of DNP Binary Input points. This map can be formed by up to 10 blocks of 16 binary 
states that are configured using Setpoint > Relay Configuration in the EnerVista 650 Setup program. The minimum 
number of DNP Binary Input points is 16 and the maximum number is 160. Within these 160 DNP points, 128 bits (8 blocks 
of 16) are mapped to Control Events (Setpoint > Relay Configuration > Control Events) and 32 bits (2 block of 16) are 
mapped to contacts A, B of 16 Switchgears (Setpoint > Relay Configuration > Switchgear). Each Switchgear in C650 is 
mapped into two DNP Binary Input points. Lets say the setting Binary Input Block1 has been set the value Switchgear 1-8, 
it means that DNP Binary Input point 0 = Switchgear 1Contact A, DNP Binary Input point 1 = Switchgear 1 Contact B, DNP 
Binary Input point 2 = Switchgear 2 Contact A, etc.

To each Control Event or Switchgear Contact, assign any of the binary states of the C650 relay. These states are contact 
inputs and outputs, virtual outputs, protection element states, PLC states, etc. DNP Points that correspond to Control 
Events or Switchgear Contacts that are not configured have a zero value in the response.

Using the PLC-Editor, through the EnerVista 650 Setup program select Setpoint > Logic Configuration to implement 
complex logic, more than simple OR and NOT previous functions. To accomplish this, under Setpoint > Relay 
Configuration > Control Events, assign a Virtual Output to a selected point, and then implement wished logic with the 
PLC-Editor.

DEFAULT BINARY INPUT POINTS MAP

BINARY INPUT POINTS

Static (Steady-State) Object Number: 1

Change Event Object Number: 2

Request Function Codes supported: 1 (read), 22 (assign class)

Static Variation Reported when variation 0 requested: 2 (Binary Input Change with status)

Change Event Variation reported when variation 0 requested: 2 (Binary Input Change with Time)

Default Class for all points: 1

POINT 
INDEX

NAME/DESCRIPTION POINT 
INDEX

NAME/DESCRIPTION

0-127 Control Events 1-128 143 Switchgear 8 Contact B

128 Switchgear 1 Contact A 144 Switchgear 9 Contact A

129 Switchgear 1 Contact B 145 Switchgear 9 Contact B

130 Switchgear 2 Contact A 146 Switchgear 10 Contact A

131 Switchgear 2 Contact B 147 Switchgear 10 Contact B

132 Switchgear 3 Contact A 148 Switchgear 11 Contact A

133 Switchgear 3 Contact B 149 Switchgear 11 Contact B

134 Switchgear 4 Contact A 150 Switchgear 12 Contact A

135 Switchgear 4 Contact B 151 Switchgear 12 Contact B

136 Switchgear 5 Contact A 152 Switchgear 13 Contact A

137 Switchgear 5 Contact B 153 Switchgear 13 Contact B

138 Switchgear 6 Contact A 154 Switchgear 14 Contact A

139 Switchgear 6 Contact B 155 Switchgear 14 Contact B

140 Switchgear 7 Contact A 156 Switchgear 15 Contact A

141 Switchgear 7 Contact B 157 Switchgear 15 Contact B

142 Switchgear 8 Contact A 158 Switchgear 16 Contact A

159 Switchgear 16 Contact B
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C.5  DNP configuration examples

C.5.1  Configuring DNP user map
For example, consider configuring DNP Binary Inputs Map with 8 Contact Inputs, 8 Protection states, 8 Contact Outputs 
and 2 Switchgears. This configuration can be done in two steps. In first step, select Setpoint > Relay Configuration from 
the EnerVista 650 Setup program and then configure the Control Events bits and Switchgear bits. This is shown in figures 
9.1 and 9.2. In the second step, select Setpoint > System Setup > Communication settings > DNP in order to change the 
DNP Binary Input Block settings. Set the values of the first three Binary Input blocks, Binary Input Block1 = CTL EVENTS 1-16, 
Binary Input Block2 = CTL EVENTS 17-32, Binary Input Block3 = SWITCHGEAR 1-8. This is shown in Figure C-1: Configuration 
of Control Events bits 13-1

Figure C-1: Configuration of Control Events bits
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Figure C-2: CONFIGURATION OF SWITCHGEAR

Figure C-3: CONFIGURATION OF DNP BINARY INPUT BLOCKS

In the example presented in this chapter the C650 relay has 48 Binary Input points, as shown in the table below.
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C.5.2  Example of custom binary input points map

POINT 
INDEX

NAME/DESCRIPTION POINT 
INDEX

NAME/DESCRIPTION

0 CONT_IP_F_CC1(CC1) 24 Not Configured

1 CONT_IP_F_CC2(CC2) 25 Not Configured

2 CONT_IP_F_CC3(CC3) 26 Not Configured

3 CONT_IP_F_CC4(CC4) 27 Not Configured

4 CONT_IP_F_CC5(CC5) 28 Not Configured

5 CONT_IP_F_CC6(CC6) 29 Not Configured

6 CONT_IP_F_CC7(CC7) 30 Not Configured

7 CONT_IP_F_CC8(CC8) 31 Not Configured

8 PH IOC1 HIGH A PKP 32 CONT_IP_F_CC13 (CC13)

9 PH IOC1 HIGH B PKP 33 CONT_IP_F_CC14(CC14)

10 PH IOC1 HIGH C PKP 34 CONT_IP_F_CC15(CC15)

11 PH IOC1 LOW A PKP 35 CONT_IP_F_CC16(CC16)

12 PH IOC1 LOW B PKP 36 Not Configured

13 PH IOC1 LOW C PKP 37 Not Configured

14 GROUND IOC1 PKP 38 Not Configured

15 NEUTRAL IOC1 PKP 39 Not Configured

16 CONT OP_F_01 40 Not Configured

17 CONT OP_F_02 41 Not Configured

18 CONT OP_F_03 42 Not Configured

19 CONT OP_F_04 43 Not Configured

20 CONT OP_F_05 44 Not Configured

21 CONT OP_F_06 45 Not Configured

22 CONT OP_F_07 46 Not Configured

23 CONT OP_F_08 47 Not Configured
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C.5.3  Multiple DNP 3.0 masters communication with C650
Typical architecture of multi-master communication using DNP 3.0.

Figure C-4: Multiple DNP3.0 masters communicating with C650

Figure C-5: Settings for DNP3.0 multi-master communications with C650
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C.6  Binary output and control relay output
Supported Control Relay Output Block fields: Pulse On.

The C650 relay provides 24 DNP Binary/Control Output points. These outputs are mapped to the first 24 commands 
configured in the C650. Executing a command is equal to activate the PLC equation that was attached to this command. 
Thus all of the 24 DNP Binary/Control Output points are pulsed points. It means that only Pulse On flag is accepted in DNP 
control operations on those points. All commands have configurable names. Changing the command’s name can be done 
using the EnerVista 650 Setup program.

BINARY OUTPUT STATUS POINTS

Object Number: 10

Request Function Codes supported: 1 (read)

Default Variation Reported when variation 0 requested: 2 (Binary Output Status)

CONTROL RELAY OUTPUT BLOCKS

Object Number: 12

Request Function Codes supported: 3 (select), 4 (operate), 5 (direct operate), 6 (direct operate, no ack)

BINARY/CONTROL OUTPUT POINTS BINARY/CONTROL OUTPUT POINTS 

POINT 
INDEX

NAME/DESCRIPTION POINT 
INDEX

NAME/DESCRIPTION

0 OPERATION1 59 VI Self Reset 7-8

1 OPERATION2 60 VI Self Reset 9-10

2 OPERATION3 61 VI Self Reset 11-12

3 OPERATION4 62 VI Self Reset 13-14

4 OPERATION5 63 VI Self Reset 15-16

5 OPERATION6 64 VI Self Reset 17-18

6 OPERATION7 65 VI Self Reset 19-20

7 OPERATION8 66 VI Self Reset 21-22

8 OPERATION9 67 VI Self Reset 23-24

9 OPERATION10 68 VI Self Reset 25-26

10 OPERATION11 69 VI Self Reset 27-28

11 OPERATION12 70 VI Self Reset 29-30

12 OPERATION13 71 VI Self Reset 31-32

13 OPERATION14

14 OPERATION15

15 OPERATION16

16 OPERATION17

17 OPERATION18

18 OPERATION19

19 OPERATION20

20 OPERATION21

21 OPERATION22

22 OPERATION23

23 OPERATION24

24-55 VI latched 1-32

56 VI Self Reset 1-2

57 VI Self Reset 3-4

58 VI Self Reset 5-6
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C.7  Binary counters

The following table lists both Binary Counters (Object 20) and Frozen Counters (Object 21). When a freeze function is 
performed on a Binary Counter point, the frozen value is available in the corresponding Frozen Counter point. Digital 
Counter values are represented as 32-bit integers. The DNP 3.0 protocol defines counters to be unsigned integers. Care 
should be taken when interpreting negative counter values.

BINARY COUNTERS

Static (Steady-State) Object Number: 20
Change Event Object Number: 22
Request Function Codes supported: 1 (read), 7 (freeze), 8 (freeze no ack), 9 (freeze and clear),
10 (freeze and clear, no ack), 22 (assign class)
Static Variation reported when variation 0 requested: 1 (32-Bit Binary Counter with Flag)
Change Event Variation reported when variation 0 requested: 1 (32-Bit Counter Change Event without time)
Default Class for all points: 3

FROZEN COUNTERS

Static (Steady-State) Object Number: 21
Change Event Object Number: 23
Request Function Codes supported: 1 (read)
Static Variation reported when variation 0 requested: 1 (32-Bit Frozen Counter with Flag)
Change Event Variation reported when variation 0 requested: 1 (32-Bit Frozen Counter Event without time)
Default Class for all points: 3

BINARY AND FROZEN COUNTERS POINT INDEX NAME/DESCRIPTION:

0 Pulse Counter 1 16 Pos MWatthour

1 Pulse Counter 2 17 Neg MWatthour

2 Pulse Counter 3 18 Pos MVatthour

3 Pulse Counter 4 19 Neg MVatthour

4 Pulse Counter 5

5 Pulse Counter 6

6 Pulse Counter 7

7 Pulse Counter 8

8 Digital Counter 1

9 Digital Counter 2

10 Digital Counter 3

11 Digital Counter 4

12 Digital Counter 5

13 Digital Counter 6

14 Digital Counter 7

15 Digital Counter 8
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C.8  Analog inputs
It is important to note that 16-bit and 32-bit variations of Analog Inputs are transmitted through DNP as signed numbers. 
Even for analog input points that are not valid as negative values, the maximum positive representation is 32767. This is a 
DNP requirement. 

The deadbands for all Analog Input points are in the same units as the Analog Input quantity. For example, an Analog Input 
quantity measured in volts has a corresponding deadband in units of volts. This is in conformance with DNP Technical 
Bulletin 9809-001 Analog Input Reporting Deadband. The scale factors apply also to deadbands. For example if Current 
Scale Factor is set to 0.001, and it is desired that a specific Analog Input point (that is of type current) trigger an event when 
its value changes by 1 kA, then the deadband for this point should be set to 1000. Relay settings are available to set default 
deadband values according to data type. Deadbands for individual Analog Input Points can be set using DNP Object 34.

Units for Analog Input points are as follows:

Current: kA/A Apparent Power: MVA/KVA

Voltage: kV/V Energy: MWh, MVArh/ kWh, kVArh

Real Power: MW/KV Frequency: Hz

Reactive Power: MVAr/kVAr Angle: degrees

ANALOG INPUT POINTS

ANALOG INPUT POINTS

Static (Steady-State) Object Number: 30

Change Event Object Number: 32

Request Function Codes supported: 1 (read), 2 (write, deadbands only), 22 (assign class)

Static Variation Reported when variation 0 requested: 1 (32-Bit Analog Input)

Change Event Variation reported when variation 0 requested: 1 (Analog Change event without Time)

Change Event Scan Rate: defaults to 500ms.

Default Class for all points: 1

POINT DESCRIPTION UNIT

0 Phasor Ia Primary kA / A

1 Phasor Ib Primary kA / A

2 Phasor Ic Primary kA / A

3 Phasor Ig Primary kA / A

4 Phasor Isg Primary kA / A

5 Phasor In Primary kA / A

6 RMS Ia Primary kA / A

7 RMS Ib Primary kA / A

8 RMS Ic Primary kA / A

9 RMS Ig Primary kA / A

10 RMS Isg Primary kA / A

11 I0 Primary kA / A

12 I1 Primary kA / A
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13 I2 Primary kA / A

14 V0 Primary kV / V

15 V1 Primary kV / V

16 V2 Primary kV / V

17 Vab Primary kV / V

18 Vbc Primary kV / V

19 Vca Primary kV / V

20 Vn Primary kV / V

21 Va Primary kV / V

22 Vb Primary kV / V

23 Vc Primary kV / V

24 VL Primary kV / V

25 VBB Primary kV / V

26 Phase A Reactive Pwr MVAr / kVAr

27 Phase A Apparent Pwr MVA / kVA

28 Phase A Real Pwr MW / kW

29 Phase B Reactive Pwr MVAr / kVAr

30 Phase B Apparent Pwr MVA / kVA

31 Phase B Real Pwr MW / kW

32 Phase C Reactive Pwr MVAr / kVAr

33 Phase C Apparent Pwr MVA / kVA

34 Phase C Real Pwr MW / kW

35 3 Phase Reactive Pwr MVAr / kVAr

36 3 Phase Apparent Pwr MVA / kVA

37 3 Phase Real Pwr MW / kW

38 Phase A Power Factor  

39 Phase B Power Factor  

40 Phase C Power Factor  

41 3 Phase Power Factor  

42 Line Frequency Primary Hz

43 Bus Frequency Primary Hz

44 Vx Primary kV / V

45 Pos MVarhour Freeze MVArh / kVArh

46 Neg MVarhour Freeze MVArh / kVArh

47 Pos MWatthour Freeze MWh / kWh

48 Pos MWatthour Freeze MWh / kWh

49 Positive MVarhour MVArh / kVArh

50 Negative MVarhour MVArh / kVArh

51 Positive MWatthour MWh / kWh

52 Negative MWatthour MWh / kWh

53 Fault 1 Prefault Phase A Current Magnitude kA / A

54 Fault 1 Prefault Phase A Current Angle degrees

55 Fault 1 Prefault Phase B Current Magnitude kA / A

56 Fault 1 Prefault Phase B Current Angle degrees

57 Fault 1 Prefault Phase C Current Magnitude kA / A

58 Fault 1 Prefault Phase C Current Angle degrees

59 Fault 1 Prefault Phase AB Voltage Magnitude kV / V

60 Fault 1 Prefault Phase AB Voltage Angle degrees

61 Fault 1 Prefault Phase BC Voltage Magnitude kV / V

62 Fault 1 Prefault Phase BC Voltage Angle degrees

POINT DESCRIPTION UNIT
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63 Fault 1 Prefault Phase CA Voltage Magnitude kV / V

64 Fault 1 Prefault Phase CA Voltage Angle degrees

65 Fault 1 Postfault Phase A Current Magnitude kA / A

66 Fault 1 Postfault Phase A Current Angle degrees

67 Fault 1 Postfault Phase B Current Magnitude kA / A

68 Fault 1 Postfault Phase B Current Angle degrees

69 Fault 1 Postfault Phase C Current Magnitude kA / A

70 Fault 1 Postfault Phase C Current Angle degrees

71 Fault 1 Postfault Phase AB Voltage Magnitude kV / V

72 Fault 1 Postfault Phase AB Voltage Angle degrees

73 Fault 1 Postfault Phase BC Voltage Magnitude kV / V

74 Fault 1 Postfault Phase BC Voltage Angle degrees

75 Fault 1 Postfault Phase CA Voltage Magnitude kV / V

76 Fault 1 Postfault Phase CA Voltage Angle degrees

77 Fault 1 Type Enum

78 Fault 1 Location km

79 Fault 1 Prefault Ground Current Magnitude kA / A

80 Fault 1 Prefault Ground Current Angle degrees

81 Fault 1 Prefault Sensitive Ground Current Magnitude kA / A

82 Fault 1 Prefault Sensitive Ground Current Angle degrees

83 Fault 1 Postfault Ground Current Magnitude kA / A

84 Fault 1 Postfault Ground Current Angle degrees

85 Fault 1 Postfault Sensitive Ground Current Magnitude kA / A

86 Fault 1 Postfault Sensitive Ground Current Angle degrees

87 % of Load to Trip %

88 Board F - Analog 1

89 Board F - Analog 2

90 Board F - Analog 3

91 Board F - Analog 4

92 Board F - Analog 5

93 Board F - Analog 6

94 Board F - Analog 7

95 Board F - Analog 8

96 Board G - Analog 1

97 Board G - Analog 2

98 Board G - Analog 3

99 Board G - Analog 4

100 Board G - Analog 5

101 Board G - Analog 6

102 Board G - Analog 7

103 Board G - Analog 8

104 Board H - Analog 1

105 Board H - Analog 2

106 Board H - Analog 3

107 Board H - Analog 4

108 Board H - Analog 5

109 Board H - Analog 6

110 Board H - Analog 7

111 Board H - Analog 8

112 Board J - Analog 1

POINT DESCRIPTION UNIT
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The "Fault Type" is represented by enumeration value. The table below shows values with DNP3 setting "Other Scale Factor 
= 1". 

If the DNP3 setting "Other Scale Factor" has a value different from "1" then "Enum Value" is scaled by the adjusted factor. 
For example if "Other Scale Factor = 0.001", then the value corresponding to "TRIPH" fault type is 2000.

NAF indicates that the type of fault has not been calculated.

113 Board J - Analog 2

114 Board J - Analog 3

115 Board J - Analog 4

116 Board J - Analog 5

117 Board J - Analog 6

118 Board J - Analog 7

119 Board J - Analog 8

ENUM VALUE FAULT TYPE

0 GROUND

1 PHASE

2 TRIPH

3 AG

4 ABG

5 AB

6 BG

7 BCG

8 BC

9 CG

10 CAG

11 CA

12 NAF

POINT DESCRIPTION UNIT



C-22 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

C.8 ANALOG INPUTS APPENDIX C:  DNP 3.0 PROTOCOL FOR C650



1601-0801-A2 C650 BAY CONTROLLER & MONITORING SYSTEM D-1

C650 Bay Controller & Monitoring System

Appendix D:  IEC 60870-5-104 protocol

GE
Grid Solutions

IEC 60870-5-104 PROTOCOL

D.1  Introduction

The C650 implements functionality of an IEC 60870-5-104 server. The devices responds to client requests or can send 
spontaneous transmissions. C650 implementation of 60870-5-104 provides analog metering and states.

The IEC 60870-5-104 communications protocol is supported on Ethernet ports A and B only.

D.2  Technical description

ASDU is the information unit used for data transmission. An ASDU may have data inside or not. The ASDU is encapsulated 
in another package of the link layer. ASDU address takes up 2 bytes.

Communication frames can be control or data frames. Control strings do not have ASDU inside.

A frame is consisting of 3 parts. (2 of them are not always present):

Link data + [ASDU header+ [ASDU data]]

The data between brackets can be omitted.

In IEC104 communication is made by TCP/IP protocols. Actually, it is a TCP communication. The default port is the 2404.

The C650 is listening as a server and supports up to two different IEC60870-5-104 masters simultaneously.
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D.3  Basic application functions

Cyclic data transmission

Cyclic data transmission is used to send measured values to the IEC 60870-5-104 master.

Spontaneous Transmission:

Information objects may be transmitted without a specific request from the IEC 60870-5-104 master.

The data that can be sent spontaneously are:

• Measured values when a deadband overflow takes place.

• Single points in the time the event is produced.

• Double points in the time the event is produced.

• Integrated Totals

Clock synchronization

C650 supports clock synchronization from IEC 60870-5-104 master. 

If IRIG-B, PTP-1588 or SNTP is being used for time synchronization, the IEC 60870-5-104 clock synchronization command 
does not set the C650 real time clock. 

Command transmission

C650 is allowed to accept single commands and double commands.
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D.4  IEC 104 settings

The Communication settings for IEC 60870-5-104 protocol are the following:

Product Setup > Communication Settings > IEC 870-5-104

Name Value Units Range

Function DISABLED

TCP Port 2404 [0:65535]

Common Addr of ASDU 255 [0:65535]

Cyclic Meter Period 0 Seconds [0:3600]

Synchronization Event 0 Minutes [0:1400]

IEC104 NET1 CLI1 OCTET1 0 [0 : 255]

IEC104 NET1 CLI1 OCTET2 0 [0 : 255]

IEC104 NET1 CLI1 OCTET3 0 [0 : 255]

IEC104 NET1 CLI1 OCTET4 0 [0 : 255]

IEC104 NET1 CLI2 OCTET1 0 [0 : 255]

IEC104 NET1 CLI2 OCTET2 0 [0 : 255]

IEC104 NET1 CLI2 OCTET3 0 [0 : 255]

IEC104 NET1 CLI2 OCTET4 0 [0 : 255]

Function 2 DISABLED

TCP Port 2 2404 [0:65535]

Common Addr of ASDU 2 255 [0:65535]

IEC104 NET2 CLI1 OCTET1 0 0 : 255]

IEC104 NET2 CLI1 OCTET2 0 0 : 255]

IEC104 NET2 CLI1 OCTET3 0 0 : 255]

IEC104 NET2 CLI1 OCTET4 0 0 : 255]

IEC104 NET2 CLI2 OCTET1 0 0 : 255]

IEC104 NET2 CLI2 OCTET2 0 0 : 255]

IEC104 NET2 CLI2 OCTET3 0 0 : 255]

IEC104 NET2 CLI2 OCTET4 0 0 : 255]

IEC104 SCALE CURRENT 1

IEC104 SCALE VOLTAGE 1

IEC104 SCALE POWER 1

IEC104 SCALE ENERGY 1

IEC104 SCALE OTHER 1

IEC104 DEADBAND CURRENT 30000 [0:65535]

IEC104 DEADBAND VOLTAGE 30000 [0:65535]

IEC104 DEADBAND POWER 30000 [0:65535]

IEC104 DEADBAND ENERGY 30000 [0:65535]

IEC104 DEADBAND OTHER 30000 [0:65535]

IEC104 IOA BINARIES 1000 [0:65535]

IEC104 IOA DOUBLE POINTS 1500 [0:65535]

IEC104 IOA ANALOGS 2000 [0:65535]

IEC104 IOA COUNTERS 4000 [0:65535]

IEC104 IOA COMMANDS 3000 [0:65535]

IEC104 IOA ANALOG 
PARAMETERS

5000 [0:65535]
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Function: Enable or disable the protocol operation for the first IEC 60870-5-104 
connection.

TCP Port: Listening TCP port in the relay. Default value is 2404.

Common Addr of ASDU: Address in the ASDU header. Default value is 255.

Cyclic Meter Period: Number of seconds for cyclical data sending, 0 means no spontaneous 
metering.

Synchronization event: Period of time (in minutes) for which timestamps are considered valid after 
receiving a clock synchronization command.

IEC104 NET1 CLI1 OCTET1 to 4: These four octets define the IP address of the first client that is accepted in 
the first connection. The C650 relay can respond to a maximum of 2 IEC 
60870-5-104 masters (not at the same time) in this connection.

EC104 NET1 CLI2 OCTET1 to 4: These four octets define the IP address of the second client that is accepted 
in the first connection. The C650 relay can respond to a maximum of 2 IEC 
60870-5-104 masters (not at the same time) in this connection.

Function 2: Enable or disable the protocol operation for the second connection.

TCP Port 2: Listening TCP port in the relay. Default value is 2404.

Common Addr of ASDU2: Address in the ASDU header. Default value is 255.

IEC104 NET2 CLI1 OCTET1 to 4: These four octets define the IP address of the first client that is accepted in 
the second connection. The C650 relay can respond to a maximum of 2 IEC 
60870-5-104 masters (not at the same time) in this connection.

IEC104 NET2 CLI2 OCTET1 to 4: These four octets define the IP address of the second client that is accepted 
in the second connection. The C650 relay can respond to a maximum of 2 
IEC 60870-5-104 masters (not at the same time) in this connection.

IEC104 SCALE CURRENT, VOLTAGE, 

POWER, ENERGY, OTHER: These settings are numbers used to scale Analog Input point values. These 
settings group the C650 Analog Input data into types: current, voltage, 
power, energy, and other. Each setting represents the scale factor for all 
Analog Input points of that type. For example, if the IEC104 SCALE VOLTAGE 
is set to a value of 1000, all IEC104 Analog Input points that are voltages are 
returned with the values 1000 times smaller (e.g. a value 72000 V on the 
C650 is returned as 72). These settings are useful when Analog Input values 
must be adjusted to fit within certain ranges in IEC 60870-5-104 masters. 
Note that a scale factor of 0.1 is equivalent to a multiplier of 10 (i.e. the value 
is 10 times larger).

IEC104 DEADBAND CURRENT, 

VOLTAGE, POWER, ENERGY, OTHER: These settings are the values used by the C650 to determine when to trigger 
spontaneous responses containing Analog Input data. 

These settings group the C650 Analog Input data into types: current, 
voltage, power, energy, and other. Each setting represents the default 
deadband value for all Analog Input points of that type. For example, in 
order to trigger spontaneous responses from the C650 when any current 
values change by 15 A, the IEC104 DEADBAND CURRENT setting should be 
set to 15. Note that these settings are the default values of the deadbands. 
Parameter of measured value ASDU can be used to change deadband 
values, from the default, for each individual IEC104 Analog Input point. 
Whenever power is removed and re-applied to the C650, the default 
deadbands are in effect.
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IEC104 IOA BINARIES: Starting Information Object Address for Single Points.

IEC104 IOA DOUBLE POINTS: Starting Information Object Address for Double Points.

IEC104 IOA ANALOGS: Starting Information Object Address for Analog Inputs.

IEC104 IOA COUNTERS: Starting Information Object Address for Counters.

IEC104 IOA COMMANDS: Starting Information Object Address for Single or Double Commands.

IEC104 IOA ANALOG PARAMETERS: Starting Information Object Address for Parameter of measured value. Each

Measured value has a Parameter of measured value associated with its 

threshold.

The C650 relay has a custom Binary Inputs points list, called User Map; it is common for any protocol. In the case of IEC 104 
Protocol, those points are GROUP1 and GROUP2.

The IEC 104 User Map can be configured using the EnerVista 650 Setup software in Setpoint > Relay Configuration > 
Control Events.

The User Map contains 128 Binary Inputs. To each point of the User Map, assign any of the binary states of the C650 relay. 
It is also possible to combine those states using OR and NOT functions. These states are: contact inputs and outputs, virtual 
outputs, protection element states, PLC states, etc. The User Map always has a size of 128 Binary Inputs. Points in the User 
Map that are not configured have a zero value in the answer.

It is possible to implement more complex logic than simple OR and NOT using the PLC Editor tool in EnerVista 650 Setup in 
the menu Setpoint > Logic Configuration. These complex signals (Virtual Outputs) can be assigned to the binary points in 
the Control Events configuration for the IEC 104 user map. 

Groups of Data

The data is organized into groups in order to provide values when the controlling station requests them by a general or 
group interrogation. 

Group 1, 2 & 4 are set by the 256 Single Points (M_SP_NA_1).

Group 3 is set by the 16 Double Points (M_DP_NA_1).

Group 5 and 6 are set by the120 Analog Inputs, short floating-point (M_ME_NC_1).

Group 7 is set by the 120 Parameter of measured value, short floating-point (P_ME_NC_1).

These 256 Single Points, 16 Double points and 120 Measured Values are also sent as a response to a General Interrogation.

The 20 Integrated Totals (M_IT_NA_1) has its own Counter Group and it is sent as a response to a General Request Counter.

Group 1 Status

POINT DESCRIPTION

M_SP_NA_1

1000-1063 CONTROL EVENTS 1-64

Group 2 Status

POINT DESCRIPTION

M_SP_NA_1

1064-1127 CONTROL EVENTS 65-128



D-6 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

D.4 IEC 104 SETTINGS APPENDIX D:  IEC 60870-5-104 PROTOCOL

Group 3 Status

POINT DESCRIPTION

M_DP_NA_1

1500-1515 SWITCHGEAR EVENTS

Group 4 Status

POINT DESCRIPTION

M_SP_NA_1

1128-1255 BOARD F 1-32, G 1-32, H 1-32, J 1-32

Group 5 Single Point

POINT DESCRIPTION

M_ME_NC_1

2000 Phasor Ia Primary

2001 Phasor Ib Primary

2002 Phasor Ic Primary

2003 Phasor Ig Primary

2004 Phasor Isg Primary

2005 Phasor In Primary

2006 RMS Ia Primary

2007 RMS Ib Primary

2008 RMS Ic Primary

2009 RMS Ig Primary

2010 RMS Isg Primary

2011 I0 Primary

2012 I1 Primary

2013 I2 Primary

2014 V0 Primary

2015 V1 Primary

2016 V2 Primary

2017 Vab Primary

2018 Vbc Primary

2019 Vca Primary

2020 Vn Primary

2021 Va Primary

2022 Vb Primary

2023 Vc Primary

2024 VL Primary

2025 VBB Primary

2026 Phase A Reactive Pwr

2027 Phase A Apparent Pwr

2028 Phase A Real Pwr

2029 Phase B Reactive Pwr

2030 Phase B Apparent Pwr

2031 Phase B Real Pwr

2032 Phase C Reactive Pwr

2033 Phase C Apparent Pwr

2034 Phase C Real Pwr

2035 3 Phase Reactive Pwr

2036 3 Phase Apparent Pwr
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2037 3 Phase Real Pwr

2038 Phase A Power Factor

2039 Phase B Power Factor

2040 Phase C Power Factor

2041 3 Phase Power Factor

2042 Line Frequency Primary

2043 Bus Frequency Primary

2044 Vx Primary

2045 Pos Mvarhour Freeze

2046 Neg Mvarhour Freeze

2047 Pos MWatthour Freeze

2048 Neg MWatthour Freeze

2049 Positive MVarhour

2050 Negative MVarhour

2051 Positive MWatthour

2052 Negative MWatthour

2053 Fault 1 Prefault Phase A Current Magnitude

2054 Fault 1 Prefault Phase A Current Angle

2055 Fault 1 Prefault Phase B Current Magnitude

2056 Fault 1 Prefault Phase B Current Angle

2057 Fault 1 Prefault Phase C Current Magnitude

2058 Fault 1 Prefault Phase C Current Angle

2059 Fault 1 Prefault Phase AB Voltage Magnitude

Group 6 Metering

POINT DESCRIPTION

M_ME_NC_1

2060 Fault 1 Prefault Phase AB Voltage Angle

2061 Fault 1 Prefault Phase BC Voltage Magnitude

2062 Fault 1 Prefault Phase BC Voltage Angle

2063 Fault 1 Prefault Phase CA Voltage Magnitude

2064 Fault 1 Prefault Phase CA Voltage Angle

2065 Fault 1 Postfault Phase A Current Magnitude

2066 Fault 1 Postfault Phase A Current Angle

2067 Fault 1 Postfault Phase B Current Magnitude

2068 Fault 1 Postfault Phase B Current Angle

2069 Fault 1 Postfault Phase C Current Magnitude

2070 Fault 1 Postfault Phase C Current Angle

2071 Fault 1 Postfault Phase AB Voltage Magnitude

2072 Fault 1 Postfault Phase AB Voltage Angle

2073 Fault 1 Postfault Phase BC Voltage Magnitude

2074 Fault 1 Postfault Phase BC Voltage Angle

2075 Fault 1 Postfault Phase CA Voltage Magnitude

2076 Fault 1 Postfault Phase CA Voltage Angle

2077 Fault 1 Type

2078 Fault 1 Location

2079 Fault 1 Prefault Ground Current Magnitude

2080 Fault 1 Prefault Ground Current Angle

2081 Fault 1 Prefault Sensitive Ground Current Magnitude

Group 5 Single Point
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2082 Fault 1 Prefault Sensitive Ground Current Angle

2083 Fault 1 Postfault Ground Current Magnitude

2084 Fault 1 Postfault Ground Current Angle

2085 Fault 1 Postfault Sensitive Ground Current Magnitude

2086 Fault 1 Postfault Sensitive Ground Current Angle

2087 % of Load to Trip

2088 Board F – Analog 1

2089 Board F – Analog 2

2090 Board F – Analog 3

2091 Board F – Analog 4

2092 Board F – Analog 5

2093 Board F – Analog 6

2094 Board F – Analog 7

2095 Board F – Analog 8

2096 Board G – Analog 1

2097 Board G – Analog 2

2098 Board G – Analog 3

2099 Board G – Analog 4

2100 Board G – Analog 5

2101 Board G – Analog 6

2102 Board G – Analog 7

2103 Board G – Analog 8

2104 Board H – Analog 1

2105 Board H – Analog 2

2106 Board H – Analog 3

2107 Board H – Analog 4

2108 Board H – Analog 5

2109 Board H – Analog 6

2110 Board H – Analog 7

2111 Board H – Analog 8

2112 Board J – Analog 1

2113 Board J – Analog 2

2114 Board J – Analog 3

2115 Board J – Analog 4

2116 Board J – Analog 5

2117 Board J – Analog 6

2118 Board J – Analog 7

2119 Board J – Analog 8

Group 7 Deadband

POINT DESCRIPTION

P_ME_NC_1

5000-5119 Analog Input Deadbands 2000-2119

Integrated Totals

POINT DESCRIPTION

M_IT_NA_1

4000-4007 Pulse Counter 1-8

4008-4015 Digital Counters 1-8

4016-4019 Energy Counters

Group 6 Metering
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D.5  IEC 60870-5-104 point list
OPERATIONS IN IEC 60870-5-104 FOR C650

The two standard procedures for command transmission are accepted, Direct command or Select and Execute command.
The following table determines how a command can be executed in C650.

There are 24 available operation in C650 device; they must be configured using EnerVista 650 Setup in Setting
> Relay Configuration > Operations.

ASDU address must start with 3000; the addresses for operation are from 3000 to 3011. The operations go from 0 to 23.

Commands

POINT DESCRIPTION COMMAND MODE

3000 Operation 1 (ON) + Operation 2(OFF) Select and Execute Double Command

--- --- ---

3005 Operation 11 (ON) + Operation 12(OFF) Select and Execute Double Command

3006 Operation 13 (ON) + Operation 14(OFF) Direct Double Command

--- --- ---

3011 Operation 23 (ON) + Operation 24(OFF) Direct Double Command

3012 Virtual Self Reset 1 (ON) + Virtual Self Reset 2(OFF) Direct Double Command

--- --- ---

3027 Virtual Self Reset 31 (ON) + Virtual Self Reset 32(OFF) Direct Double Command

3028-3059 Virtual Latched 1-32 Direct Single Command



D-10 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

D.6 IEC 60870-5-104 INTEROPERABILITY APPENDIX D:  IEC 60870-5-104 PROTOCOL

D.6  IEC 60870-5-104 Interoperability
This companion standard presents sets of parameters and alternatives from which subsets must be selected to implement 
particular telecontrol systems. Certain parameter values, such as the choice of "structured" or "unstructured" fields of the 
INFORMATION OBJECT ADDRESS of ASDUs represent mutually exclusive alternatives. This means that only one value of the 
defined parameters is admitted per system. Other parameters, such as the listed set of different process information in 
command and in monitor direction allow the specification of the complete set or subsets, as appropriate for given 
applications. This clause summarizes the parameters of the previous clauses to facilitate a suitable selection for a specific 
application. If a system is composed of equipment stemming from different manufacturers, it is necessary that all partners 
agree on the selected parameters.

The interoperability list is defined as in IEC 60870-5-101 and extended with parameters used in this standard. The text 
descriptions of parameters which are not applicable to this companion standard are strike-through (corresponding check 
box is marked black). 

NOTE: In addition, the full specification of a system may require individual selection of certain parameters for certain parts 
of the system, such as the individual selection of scaling factors for individually addressable measured values.

The selected parameters should be marked in the white boxes as follows

The possible selection (blank, X, R, or B) is specified for each specific clause or parameter.

A black check box indicates that the option cannot be selected in this companion standard.

System or device

System-specific parameter. Indicate definition of a system or a device by marking one of the following with “X”:

Network configuration

Network-specific parameter. All configurations that are used are to be marked "X":

Function or ASDU is not used

X Function or ASDU is used as standardized (default)

R Function or ASDU is used in reverse mode

B Function or ASDU is used in standard and reverse mode

System definition

X Controlling station definition (Master)

R Controlled station definition (Slave)
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Physical layer

Network-specific parameter, all interfaces and data rates that are used are to be marked "X".

Transmission speed (control direction)

Unbalanced interchange Unbalanced interchange Balanced interchange

Circuit V.24/V.28 Circuit V.24/V.28 Circuit X.24/X.27

StandardRecommended if >1 200 bit/s

Transmission speed (monitor direction)

Unbalanced interchange Unbalanced interchange Balanced interchange

Circuit V.24/V.28 Circuit V.24/V.28 Circuit X.24/X.27

StandardRecommended if >1 200 bit/s

Link layer
Network-specific parameter. All options that are used are to be marked “X”. Specify the maximum frame length. If a non-
standard assignment of class 2 messages is implemented for unbalanced transmission, indicate the Type ID and COT of all 
messages assigned to class 2.

Frame format FT 1.2, single character 1 and the fixed time out interval are used exclusively in this companion 
standard.
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When using an unbalanced link layer, the following ASDU types are returned in class 2 messages (low priority) 
with the indicated causes of transmission:

Note: (In response to a class 2 poll, a controlled station may respond with class 1 data when there is no class 
2 data available).

APPLICATION LAYER

Transmission mode for application data

Mode 1 (Least significant octet first), as defined in 4.10 of IEC 60870-5-4, is used exclusively in this companion standard.

Common address of ASDU

System-specific parameter. All configurations that are used are to be marked "X".

Link transmission Address field of the link

Frame length

Type identification Cause of transmission
9, 11, 13, 21 <1>

Type identification Cause of transmission
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Information object address

System-specific parameter. All configurations that are used are to be marked "X".

Cause of transmission

System-specific parameter. All configurations that are used are to be marked "X".

Length of APDU

System-specific parameter. Specify the maximum length of the APDU per system.

The maximum length of APDU for both directions is 253. It is a fixed system parameter.

SELECTION OF STANDARD ASDUS

Process information in monitor direction

Station-specific parameter. Mark each Type ID “X” if it is only used in the standard direction, "R" if only used in the reverse 
direction, and “B” if used in both directions.
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In this companion standard only the use of the set <30> – <40> for ASDUs with time tag is permitted.

Process information in control direction

Station-specific parameter. Mark each Type ID “X” if it is only used in the standard direction, "R" if only used in 
the reverse direction, and “B” if used in both directions.
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Either the ASDUs of the set <45> – <51> or of the set <58> – <64> are used.

System information in monitor direction

Station-specific parameter. Mark with an “X” if it is only used in the standard direction, “R” if only used in the reverse 
direction, and “B” if used in both directions.

System information in control direction

Station-specific parameter. Mark each Type ID "X" if it is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.
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Parameter in control direction

Station-specific parameter. Mark each Type ID "X" if it is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

File transfer

Station-specific parameter. Mark each Type ID "X" if it is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

Type identifier and cause of transmission assignments

Station-specific parameters.

Shaded boxes: option not required. 

Black boxes: option not permitted in this companion standard

Blank: functions or ASDU not used.

Mark Type Identification/Cause of transmission combinations:

"X" if only used in the standard direction; 

"R" if only used in the reverse direction;

"B" if used in both directions.

Type identification Cause of transmission
1 2 3 4 5 6 7 8 9 10 11 12 13 20

to

36

37

to

41

44 45 46 47

<1> M_SP_NA_1 X X
<2> M_SP_TA_1

<3> M_DP_NA_1 X X
<4> M_DP_TA_1

<5> M_ST_NA_1
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<6> M_ST_TA_1

<7> M_BO_NA_1

<8> M_BO_TA_1

<9> M_ME_NA_1

<10> M_ME_TA_1

<11> M_ME_NB_1

<12> M_ME_TB_1

<13> M_ME_NC_1 X X X
<14> M_ME_TC_1

<15> M_IT_NA_1 X
<16> M_IT_TA_1

<17> M_EP_TA_1

<18> M_EP_TB_1

<19> M_EP_TC_1

<20> M_PS_NA_1

<21> M_ME_ND_1

<30> M_SP_TB_1 X
<31> M_DP_TB_1

<32> M_ST_TB_1

<33> M_BO_TB_1

<34> M_ME_TD_1

<35> M_ME_TE_1

<36> M_ME_TF_1 X
<37> M_IT_TB_1 X
<38> M_EP_TD_1

<39> M_EP_TE_1

<40> M_EP_TF_1

<45> C_SC_NA_1 X X X X X
<46> C_DC_NA_1 X X X X X
<47> C_RC_NA_1

<48> C_SE_NA_1

<49> C_SE_NB_1

<50> C_SE_NC_1

<51> C_BO_NA_1

<58> C_SC_TA_1 X X X X X
<59> C_DC_TA_1 X X X X X
<60> C_RC_TA_1

Type identification Cause of transmission
1 2 3 4 5 6 7 8 9 10 11 12 13 20

to

36

37

to

41

44 45 46 47

<61> C_SE_TA_1

<62> C_SE_TB_1

<63> C_SE_TC_1

<64> C_BO_TA_1

<70>  M_EI_NA_1* X
<100> C_IC_NA_1 X X X X X
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BASIC APPLICATION FUNCTIONS

Station initialization

Station-specific parameter, mark "X" if function is used.

Cyclic data transmission

Station-specific parameter. Mark “X” if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

Read procedure

Station-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

<101> C_CI_NA_1 X X X
<102> C_RD_NA_1 X
<103> C_CS_NA_1 X X
<104> C_TS_NA_1

<105> C_RP_NA_1 X X
<106> C_CD_NA_1

<107> C_TS_TA_1

<110> P_ME_NA_1

<111> P_ME_NB_1

<112> P_ME_NC_1 X X X
<113> P_AC_NA_1

<120> F_FR_NA_1

<121> F_SR_NA_1

<122> F_SC_NA_1

<123> F_LS_NA_1

<124> F_AF_NA_1

<125> F_SG_NA_1

<126> F_DR_TA_1*

<127> F_SC_NB_1*

* Blank or X only

X Remote initialization

X Cyclic data transmission

X Read procedure
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Spontaneous transmission

Station-specific parameter. Mark “X” if function is only used in the standard direction, "R" if only used in the reverse 
direction, and “B” if used in both directions.

Double transmission of information objects with cause of transmission spontaneous

Station-specific parameter. Mark each information type "X" where both a Type ID without time and corresponding 
Type ID with time are issued in response to a single spontaneous change of a monitored object.

The following type identifications may be transmitted in succession caused by a single status change of an information 
object. The particular information object addresses, for which double transmission is enabled, are defined in a project-
specific list.

Station interrogation 

Station-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

Clock synchronization 

Station-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

X Spontaneous transmission

X Spontaneous transmission

Day of week used

RES1, GEN (time tag substituted/ not substituted) used
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optional, see 7.6

Command transmission 

Object-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

Transmission of integrated totals 

Station- or object-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the 
reverse direction, and "B" if used in both directions.

SU-bit (summertime) used

X Direct command transmission

Direct set point command transmission

X Select and execute command

Select and execute set point command

X C_SE ACTTERM used

X No additional definition

X Short-pulse duration (duration determined by a system parameter in the outstation)

X Long-pulse duration (duration determined by a system parameter in the outstation)

X Persistent output

X Supervision of maximum delay in command direction of commands and set point commands

10s Maximum allowable delay of commands and set point commands

X Mode A: Local freeze with spontaneous transmission

X Mode B: Local freeze with counter interrogation

X Mode C: Freeze and transmit by counter-interrogation commands

X Mode D: Freeze by counter-interrogation command, frozen values reported 

X Counter read

X Counter freeze without reset

X Counter freeze with reset

X Counter freeze with reset

X General request counter
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Parameter loading 

Object-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and “B” if used in both directions.

Parameter activation 

Object-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

Test procedure

Station-specific parameter, mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

File transfer

Station-specific parameter, mark “X” if function is used.

File transfer in monitor direction:

File transfer in control direction:

X Request counter group 1

X Request counter group 2

X Request counter group 3

Request counter group 4

X Threshold value

Smoothing factor

Low limit for transmission of measured values

Low limit for transmission of measured values

Act/deact of persistent cyclic or periodic transmission of the addressed object

Test procedure

Transparent file 

Transmission of disturbance data of protection equipment

Transmission of sequences of events

Transmission of sequences of recorded analogue values

Transparent file
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Background scan 

Station-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

Acquisition of transmission delay 

Station-specific parameter. Mark "X" if function is only used in the standard direction, "R" if only used in the reverse 
direction, and "B" if used in both directions.

Definition of time outs

Maximum range for timeouts t0 to t2: 1 s to 255 s, accuracy 1 s.
Recommended range for timeout t3: 1 s to 48 h, resolution 1 s.
Long timeouts for t3 may be needed in special cases where satellite links or dial-up connections are used (for instance to 
establish connection and collect values only once per day or week).

Maximum number of outstanding I format APDUs k and latest acknowledge APDUs (w)

Maximum range of values k: 1 to 32767 (215–1) APDUs, accuracy 1 APDU

Maximum range of values w: 1 to 32767 APDUs, accuracy 1 APDU (Recommendation: w should not exceed two-thirds of k).

Portnumber

Redundant connections

Background scan

Acquisition of transmission delay

Parameter Default value Remarks Selected value

t0 30 s Time-out of connection establishment N/A

t1 15 s Time-out of send or test APDUs 15 s

t2 10 s Time-out for acknowledges in case of no data 
messages t2 < t1

10 s

t3 20 s Time-out for sending test frames in case of a long 
idle state

20 s

Parameter Default value Remarks Selected value

k 12 APDUs Maximum difference receive sequence number to 
send state variable

12 APDUs

w 8 APDUs Latest acknowledge after receiving w I format 
APDUs

8 APDUs

Parameter Value Remarks

Portnumber 2404 In all cases

Number N of redundancy group connections used
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RFC 2200 suite

RFC 2200 is an official Internet Standard which describes the state of standardization of protocols used in the Internet as 
determined by the Internet Architecture Board (IAB). It offers a broad spectrum of actual standards used in the Internet. 
The suitable selection of documents from RFC 2200 defined in this standard for a given projects has to be chosen by the 
user of this standard. 

List of valid documents from RFC 2200

1..............................................................

2..............................................................

3..............................................................

4..............................................................

5..............................................................

6..............................................................

7. etc.

X Ethernet 802.3

Serial X.21 interface

Other selection from RFC 2200:
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C650 Bay Controller & Monitoring System

Appendix E:  Redundancy protocol

GE
Grid Solutions

REDUNDANCY PROTOCOL

E.1  PRP and HSR Ethernet protocols

Industrial real-time Ethernets typically demand much higher availability and uninterrupted operation than office Ethernet 
solutions can provide. Even a short loss of connectivity can result in loss of functionality, as for example in some 
automation, vehicular, power generation, and power distribution systems.
To recover from a network failure, different standard redundancy schemes are applied such as Parallel Redundancy 
Protocol (PRP), High-availability Seamless Redundancy (HSR) and others.
The basic concept of both protocols, PRP and HSR, is to send practically identical frames over different paths and discard 
one of the copies in reception, at best. If an error occurs or one of the paths is down, the frame traveling through that path 
does not reach the destination, but its copy does.
If the node to be attached to a redundant network has not the capability to do it (e.g. has only one port), it can be 
connected through a Redundancy Box (RedBox). This type of node allows single attached nodes connect transparently to a 
redundant network. An example can be seen in Figures 1.
PRP operates on two independent networks. Each frame is replicated on the sending node and transmitted over both 
networks. The receiving node processes the frame arriving first and discards the subsequent copy. The PRP layer is 
responsible for this replicate/discard function and hides the two networks from the upper layers. This scheme works 
without explicit reconfiguration and switchover and therefore does not show a period of unavailability.
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Figure E-1: Example of PRP with two LANs (LAN A and LAN B)

The two LANs, named LAN_A and LAN_B, are identical in protocol at the MAC level, but they can differ in performance and 
topology. Transmission delays can also be different. The LANs have no direct connection among them and they are 
assumed to be fail independent.
In some applications, only availability-critical nodes need a double attachment, while others do not. In order to meet the 
specific requirements, PRP defines different kinds of end nodes.
• The Dual Attached Node (DAN) is connected to both LANs.

• Uncritical nodes can be attached to only one LAN and are therefore called Single Attached Nodes (SAN). SANs that
need to communicate with each other are on the same LAN.

• The Redundancy Box (RedBox) is used when a single interface node has to be attached to both networks. Such a node
can communicate with all other nodes. Since a node behind a RedBox appears for other nodes like a DAN, it is called
Virtual DANs (VDAN). The RedBox itself is a DAN and acts as a proxy on behalf of its VDANs. The RedBox has its own IP
address for management purposes

Similarly to PRP, HSR is based in the duplication of every frame sent, but in a ring topology. Each copy of the frame is 
injected in a different direction of the ring. If any of the links between nodes is down, all nodes are still reachable. This 
topology forces every node in the net to be HSR aware because they have to forward every message until it reaches its 
destination. With that purpose, the redundancy information is located at the beginning of the frame allowing a faster 
forwarding, see next figure.
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Figure E-2: Example of HSR with HSR ring

Definitions:

• PRP – Parallel Redundancy Protocol - redundancy protocol for high availability in substation automation networks
based on IEC 62439-3 Clause 4 and applicable to networks based on Ethernet technology (ISO/IEC 8802-3).

• OSI - Open Systems Interconnection - model defined by the International Organization for Standardization (ISO) for
standardizing the functions of a communication system in terms of abstraction layers. Similar communication
functions are grouped into logical layers. A layer serves the layer above it and is served by the layer below it. There are
7 layers: physical, data link, network, transport, session, presentation, application.

• DANP – Doubly Attached Node running PRP – a node that has two ports which operate in parallel and are attached to
the upper layers of the OSI communications stack through a Link Redundancy Entity module.

• DANH – Doubly Attached Node with HSR protocol.

• LRE - Link Redundancy Entity – module operating at the link layer of the OSI stack and responsible for handling
duplicates and managing redundancy.

• SAN – Singly Attached Node – regular nodes with non-redundant network adapters

• RedBox – device attaching singly attached nodes (SANs) to a redundant network.

• RCT – Redundancy Check Trailer – PRP trailer added to frames and consisting of the following fields:

– 16-bit sequence number (SeqNr);

– 4-bit LAN identifier (LanId);

– 12 bit frame size (LSDUsize)

– 16-bit suffix (PRPsuffix).
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E.1.1  PRP
PRP defines a redundancy protocol for high availability in substation automation networks. It is applicable to networks 
based on Ethernet technology (ISO/IEC 8802-3).

PRP is designed to provide seamless recovery in case of a single failure in the network, by using a combination of LAN 
duplication and frame duplication technique. Identical frames are sent on two completely independent networks that 
connect source and destination, see the following figure:

Figure E-3: Example of PRP Redundant Network

Under normal circumstances both frames reach their destination and one of them is sent up the OSI stack to the 
destination application, while the second one is discarded. If an error occurs in one of the networks and traffic is prevented 
from flowing on that path, connectivity is still be provided through the other network to ensure continuous communication. 
However, care must be taken when designing the two LANs, so that no single point of failure (such as a common power 
supply) is encountered, as such scenarios can bring down both LANs simultaneously.

PRP uses specialized nodes called doubly attached nodes (DANPs) for handling the duplicated frames. DANPs devices have 
an additional module at the link layer level, called the Link Redundancy Entity (LRE). LRE is responsible for duplicating 
frames and adding the specific PRP trailer when sending the frames out on the LAN, as well as making decisions on 
received frames as to which one is sent up the OSI stack to the application layer and which one is discarded. In essence 
LRE is responsible for making PRP transparent to the higher layers of the stack. There is a second type of specialized device 
used in PRP networks, called RedBox, with the role of connecting Single Attached Nodes (SANs) to a redundant network.

C650 relays implement only the DANP functionality. The RedBox functionality is not implemented.

The original standard IEC 62439-3 (2010) was amended to align PRP with the High availability Seamless Redundancy (HSR) 
protocol. To achieve this, the original PRP was modified at the cost of losing compatibility with the PRP 2010 version. The 
revised standard IEC 62439-3 (2012) is commonly referred to as PRP-1, while the original standard is PRP-0. The C650 
relays support only PRP-1.

PRP can be enabled in configuration through a setting available on the network configuration menu (Product Setup? 
Communication Settings? Network (Ethernet), REDUNDANCY, which already has the capability of enabling Failover 
redundancy. When REDUNDANCY is set to PRP, the ports dedicated for PRP operate in redundant mode.

The rights associated with configuring PRP follow the security requirements for network configuration.

PRP management through SNMP MIB is not supported, as C650 doesn’t currently support SNMP for configuration. Settings 
and actual values are only available through the front panel and through EnerVista.
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The PRP solution to implement must ensure that performance requirements stated in IEC 61850-5 Clause 13 are still met. It 
is specified under Clause 13 (Message performance requirements) that messages of type 1A must meet the performance 
class P2/3, which is 3ms (See 3.7.1.1).

E.1.2  HSR
HSR defines a redundancy protocol for high availability in substation automation networks, based on PRP principles, 
provides the property of zero recovery time, typically used in ring topology but applicable to any topology.

In the C650 relay, HSR is implemented in devices with communication option number K (for Fiber; 100 Base Fx) and M (for 
cooper; Base 100 Tx). A frame is sent over both ports. A destination should receive, in the fault-free state, two identical 
frames within a certain time skew, forward the first frame to the application and discard the second frame when (and if) it 
comes. A sequence number is used to recognize such duplicates.

In contrast to PRP (IEC 62439-3- Clause 4), with which it shares the operating principle, HSR nodes are arranged into a ring, 
which allows the network to operate without dedicated switches, since every node is able to forward frames from port to 
port. HSR originally meant "High-availability Seamless Ring", but HSR is not limited to a simple ring topology. 

Redundant connections to other HSR rings and to PRP networks are possible.
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E.2  RSTP (IEEE 802.1D-2004) and daisy chain

E.2.1  RSTP description
The Rapid Spanning Tree Protocol (RTSP), like STP, was designed to avoid loops in an Ethernet network. Rapid Spanning 
Tree Protocol (RSTP) (IEEE 802.1w) is an evolution of the Spanning Tree Protocol (STP) (802.1d standard) and provides for 
faster spanning tree convergence after a topology change.

E.2.2  RSTP concepts
The IEEE 802.1d Spanning Tree Protocol (STP) was developed to allow the construction of robust networks that incorporate 
redundancy while pruning the active topology of the network to prevent loops. While STP is effective, it requires that frame 
transfer must halt after a link outage until all bridges in the network are sure to be aware of the new topology.

Using STP (IEEE 802.1d) recommended values, this period lasts 30 seconds. The Rapid Spanning Tree Protocol (IEEE 802.1w) 
is a further evolution of the 802.1d Spanning Tree Protocol. It replaces the settling period with an active handshake 
between switches (bridges) that guarantees topology information to be rapidly propagated through the network. RSTP 
converges in less than one second. RSTP also offers a number of other significant innovations. These include:

• Topology changes in STP must be passed to the root bridge before they can be propagated to the network. Topology
changes in RSTP can be originated from and acted upon by any designated switch (bridge), leading to more rapid
propagation of address information

• STP recognizes one state - blocking for ports that should not forward any data or information. RSTP explicitly
recognizes two states or blocking roles - alternate and backup port including them in computations of when to learn
and forward and when to block 

• STP relays configuration messages received on the root port going out of its designated ports. If an STP switch (bridge)
fails to receive a message from its neighbor it cannot be sure where along the path to the root a failure occurred. RSTP
switches (bridges) generate their own configuration messages, even if they fail to receive one from the root bridge.
This leads to quicker failure detection

• RSTP offers edge port recognition, allowing ports at the edge of the network to forward frames immediately after
activation while at the same time protecting them against loops

• An improvement in RSTP allows configuration messages to age more quickly preventing them from “going around in
circles” in the event of a loop RSTP has three states. They are discarding, learning and forwarding.

The discarding state is entered when the port is first taken into service. The port does not learn addresses in this state and 
does not participate in frame transfer. The port looks for STP traffic in order to determine its role in the network. When it is 
determined that the port plays an active part in the network, the state changes to learning. The learning state is entered 
when the port is preparing to play an active member of the network. The port learns addresses in this state but does not 
participate in frame transfer. In a network of RSTP switches (bridges) the time spent in this state is usually quite short. RSTP 
switches (bridges) operating in STP compatibility mode spend between 6 to 40 seconds in this state. After 'learning' the 
bridge places the port in the forwarding state. While in this state the port both learn addresses and participates in frame 
transfer while in this state. The result of these enhanced states is that the IEEE 802.1d version of spanning tree (STP) can 
take a fairly long time to resolve all the possible paths and to select the most efficient path through the network. The IEEE 
802.1w Rapid reconfiguration of Spanning Tree significantly reduces the amount of time it takes to establish the network 
path. The result is reduced network downtime and improved network robustness. In addition to faster network 
reconfiguration, RSTP also implements greater ranges for port path costs to accommodate the higher connection speeds 
that are being implemented.
Proper implementations of RSTP (by switch vendors) is designed to be compatible with IEEE 802.1d STP. GE recommends 
that you employ RSTP or STP in your network. 
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E.2.3  Use in meshed networks
One great strength of RSTP is its support for all kinds of meshed topologies. The resulting flexibility regarding the 
installation is a clear advantage over the stringent restrictions that are imposed by ring protocols such as MRP and ring 
installations. However, this flexibility harbors one great disadvantage, namely the reconfiguration time, which for an 
interconnected network depends – among other things – on the complexity of the network topology and the location in the 
network at which the failure occurred. Since RSTP is a decentralized protocol, it may also provoke highly unpredictable 
race conditions in the establishment of new communications paths, particularly when choosing a new root bridge. This 
gives rise to network reconfiguration times that can be estimated only very roughly, and this does restrict the use of RSTP, 
particularly in meshed networks. In the case of meshed networks with very little complexity (such as ring networks with 
two or three additional loops or sub-rings), a detailed analysis can make it possible to determine upper limits, but these 
always need to be worked out individually. Unlike with the protocols MRP, HSR and PRP, it is not possible to make a general 
statement. 

E.2.4  Daisy chain
A daisy chain is an interconnection of devices where each device is connected in series to the next.

With an Ethernet daisy-chain redundancy selected, the C650 has two Ethernet ports and it is working as an Ethernet 
unmanaged switch. The two Ethernet ports are used for connecting each device to the ports of its two neighboring 
devices.

Each device in the daisy chain forwards the message until it reaches the destination.

Ports A and B use the same MAC (physical device) address and operate by chaining one device with the next one. 

Note: It is important not to create a loop in this topology. Both ends of the chain can be connected to different networks. 
The device operates only with one IP address through these 2 ports.
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E.3  Link loss alert (LLA)

E.3.1  LLA 
(Link Loss Alert) operation: The operation of ports A and B are as follows: 

Ports A and B use port A’s MAC and IP address settings while port B is in standby mode in that it does not actively 
communicate on the Ethernet network but monitors its link. 

E.3.2  LLA priority
If this setting is set to enabled, the port A has the priority. If PORT A’s LLA detects a problem with the link, communications 
is switched to Port B. Port B is, in effect, acting as a redundant or backup link to the network for port A. 

E.3.3  LLA timeout
This setting is active only when the LLA PRIORITY is set to ENABLED. When the link on primary port is detected again after it 
fails, there is LLA TIMEOUT (ms) monitoring time for the health of the network. During this time, the secondary port remains 
active. If primary network is healthy for more than LLA TOIMEOUT value, the switch over to primary port is automatic.

If the setting LLA PRIORITY is enabled:

• The primary port is port A while secondary (redundant) port is port B.

• The primary port is always used if available.

• If the link on primary port is lost switch over to secondary port occurs immediately. 

• When the link on primary port is detected again, there is a monitoring timeout (LLA TIMEOUT) for the health of the
network. After that period the communication switch over to primary port automatically.

If the setting LLA PRIORITY is disabled:

• There is no priority, therefore there is no primary port. The communication switch over from one Port to the other
occurs when the link fails. 

• In this case the LLA TIMEOUT setting does not act.
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C650 Bay Controller & Monitoring System

Appendix G:  Factory default configuration

GE
Grid Solutions

FACTORY DEFAULT CONFIGURATION

G.1   Factory default settings

Product Setup > Communication Settings > Serial Ports

Setting Description Name Default Value Step Range User 
Value

Baud rate for COM1 COM1 Baud Rate 19200 N/A [300 : 115200]

Baud rate for COM2 COM2 Baud Rate 19200 N/A [300 : 115200]

Parity for COM1 COM1 Parity NONE N/A [NONE:ODD:EVEN]

Parity for COM2 COM2 Parity NONE N/A [NONE:ODD:EVEN]

Product Setup > Communication Settings > Network (Ethernet)

Network (Ethernet)1 > Network (Ethernet)2

Setting Description Name Default Value Step Range User 
Value

1st octet of IP address IP Address Oct1 0 N/A [0 : 255]

2nd octet of IP address IP Address Oct2 0 N/A [0 : 255]

3rd octet of IP address IP Address Oct3 0 N/A [0 : 255]

4th octet of IP address IP Address Oct4 0 N/A [0 : 255]

1st octet of Netmask Netmask Oct1 0 N/A [0 : 255]

2nd octet of Netmask Netmask Oct2 0 N/A [0 : 255]

3rd octet of Netmask Netmask Oct3 0 N/A [0 : 255]

4th octet of Netmask Netmask Oct4 0 N/A [0 : 255]

1st octet of Gateway Gateway IP Oct1 0 N/A [0 : 255]

2nd octet of Gateway Gateway IP Oct2 0 N/A [0 : 255]

3rd octet of Gateway Gateway IP Oct3 0 N/A [0 : 255]

4th octet of Gateway Gateway IP Oct4 0 N/A [0 : 255]

**For firmware versions 7.10 or higher;  the Network settings are the ethernet communication parameters are as follow
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Product Setup > Communication Settings > Network (Ethernet)

Network (Ethernet)1 > Network (Ethernet)

Setting Description Name Default Value Step Range User 
Value

1st octet of IP address IP Address Oct1 0 N/A [0 : 255]

2nd octet of IP address IP Address Oct2 0 N/A [0 : 255]

3rd octet of IP address IP Address Oct3 0 N/A [0 : 255]

4th octet of IP address IP Address Oct4 0 N/A [0 : 255]

1st octet of Netmask Netmask Oct1 0 N/A [0 : 255]

2nd octet of Netmask Netmask Oct2 0 N/A [0 : 255]

3rd octet of Netmask Netmask Oct3 0 N/A [0 : 255]

4th octet of Netmask Netmask Oct4 0 N/A [0 : 255]

**For firmware versions 7.10 or higher; on the Network settings are also located the settings for Redundancy.

Setting Description Name Default Value Step Range User 
Value

Function permission REDUNDANCY MODE INDEPENDENT N/A [INDEPENDENT; LLA; PRP; 
HSR; RSTP; DAISY_CHAIN]

Establish priority for Port A LLA Priority DISABLED N/A [ENABLED; DISABLED]

Switch over time from port B to port A LLA Timeout 5000 N/A [0 : 600000]

Switch (bridge) priority value RSTP BRIDGE PRIORITY 32768 N/A [0 : 61440]

determine which ports are used for 
forwarding

RSTP PORT A PRIORITY 128 N/A [0 : 240]

assigned port cost value used for the 
switch

RSTP PORT A 
PATHCOST

200000 N/A [0 : 2000000]

Determine which ports are used for 
forwarding

RSTP PORT B PRIORITY 128 N/A [0 : 240]

Assigned port cost value used for the 
switch

RSTP PORT B 
PATHCOST

200000 N/A [0 : 2000000]

Product Setup > Communication Settings > Modbus Protocol

Setting Description Name Default Value Step Range User 
Value

Slave address for COM1 Modbus Address 
COM1

254 N/A [1 : 255]

Slave address for COM2 Modbus Address 
COM2

254 N/A [1 : 255]

Modbus port number for Modbus TCP/
IP

Modbus Port Number 502 N/A [0 : 65535]

Product Setup > Communication Settings >DNP3 Slave

DNP3 Slave 1 > DNP3 Slave 2 > DNP3 Slave 3

Setting Description Name Default Value Step Range User 
Value

Communications port assigned to the 
DNP protocol

Physical Port NONE N/A [COM1:COM2:NETWORK]

DNP slave address Address 255 N/A [0 : 65534]

1st Octect of IP address of DNP 
master 1

IP Addr Client1 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 1

IP Addr Client1 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 1

IP Addr Client1 Oct3 0 N/A [0 : 255]
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4th Octect of IP address of DNP 
master 1

IP Addr Client1 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 2

IP Addr Client2 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 2

IP Addr Client2 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 2

IP Addr Client2 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 2

IP Addr Client2 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 3

IP Addr Client3 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 3

IP Addr Client3 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 3

IP Addr Client3 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 3

IP Addr Client3 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 4

IP Addr Client4 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 4

IP Addr Client4 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 4

IP Addr Client4 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 4

IP Addr Client4 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 4

IP Addr Client5 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 4

IP Addr Client5 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 4

IP Addr Client5 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 4

IP Addr Client5 Oct4 0 N/A [0 : 255]

TCP/UDP port number for DNP over 
Ethernet

TCP/UDP Port 20000 N/A [0 : 65535]

Unsolicited responses permission Unsol Resp Function DISABLED N/A [DISABLED – ENABLED]

Time out to confirm an unsolicited 
response

Unsol Resp TimeOut 5 1 s [0 : 60]

Number of retransmissions of an 
unsol resp w/o confirmation

Unsol Resp Max Ret 10 N/A [0 : 255]

Address to which all unsolicited 
responses are sent

Unsol Resp Dest Adr 200 N/A [0 : 65519]

Scale for currents Current Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Scale for voltages Voltage Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]
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Product Setup > Communication Settings > DNP3 Slave (CONT.)

DNP3 Slave 1 > DNP3 Slave 2 > DNP3 Slave 3

Setting Description Name Default Value Step Range User 
Value

Scale for power Power Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Scale for energy Energy Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Other Scale factor Other Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Default deadband for Current Analog 
Input points to trigger unsolicited 
responses

Current Deadband 30000 N/A [0 : 65535]

Default deadband for Voltage Analog 
Input points to trigger unsolicited 
responses

Voltage Deadband 30000 N/A [0 : 65535]

Default deadband for Power Analog 
Input points to trigger unsolicited 
responses

Power Deadband 30000 N/A [0 : 65535]

Default deadband for Energy Analog 
Input points to trigger unsolicited 
responses

Energy Deadband 30000 N/A [0 : 65535]

Default deadband for Other Analog 
Input points to trigger unsolicited 
responses

Other Deadband 30000 N/A [0 : 65535]

Size (in bytes) for message 
fragmentation

Msg Fragment Size 240 1 byte [30 : 2048]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 1 CTL EVENTS 1-16 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 2 CTL EVENTS 17-32 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 3 CTL EVENTS 33-48 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 4 CTL EVENTS 49-64 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 5 CTL EVENTS 65-80 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 6 CTL EVENTS 81-96 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 7 CTL EVENTS 97-112 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 8 CTL EVENTS 113-
128

N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 9 SWITCHGEAR 1-8 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list

Binary Input Block 10 SWITCHGEAR 9-16 N/A [See DNP note2]

Default Analog Map permission Default Analog Map ENABLED N/A [ENABLED; DISABLE]

DNP Analog Input Points point list Analog Input Point 0 End of list N/A

DNP Analog Input Points point list Analog Input Point 1 End of list N/A

DNP Analog Input Points point list Analog Input Point 2 End of list N/A

DNP Analog Input Points point list Analog Input Point 3 End of list N/A

DNP Analog Input Points point list Analog Input Point 4 End of list N/A
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DNP Analog Input Points point list Analog Input Point 5 End of list N/A

DNP Analog Input Points point list Analog Input Point 6 End of list N/A

DNP Analog Input Points point list Analog Input Point 7 End of list N/A

DNP Analog Input Points point list Analog Input Point 8 End of list N/A

DNP Analog Input Points point list Analog Input Point 9 End of list N/A

DNP Analog Input Points point list Analog Input Point 10 End of list N/A

DNP Analog Input Points point list Analog Input Point 11 End of list N/A

DNP Analog Input Points point list Analog Input Point 12 End of list N/A

DNP Analog Input Points point list Analog Input Point 13 End of list N/A

DNP Analog Input Points point list Analog Input Point 14 End of list N/A

DNP Analog Input Points point list Analog Input Point 15 End of list N/A

DNP Analog Input Points point list Analog Input Point 16 End of list N/A

DNP Analog Input Points point list Analog Input Point 17 End of list N/A

DNP Analog Input Points point list Analog Input Point 18 End of list N/A

DNP Analog Input Points point list Analog Input Point 19 End of list N/A

DNP Analog Input Points point list Analog Input Point 20 End of list N/A

DNP Analog Input Points point list Analog Input Point 21 End of list N/A

DNP Analog Input Points point list Analog Input Point 22 End of list N/A

DNP Analog Input Points point list Analog Input Point 23 End of list N/A

DNP Analog Input Points point list Analog Input Point 24 End of list N/A

DNP Analog Input Points point list Analog Input Point 25 End of list N/A

DNP Analog Input Points point list Analog Input Point 26 End of list N/A

DNP Analog Input Points point list Analog Input Point 27 End of list N/A

DNP Analog Input Points point list Analog Input Point 28 End of list N/A

DNP Analog Input Points point list Analog Input Point 29 End of list N/A

DNP Analog Input Points point list Analog Input Point 30 End of list N/A

DNP Analog Input Points point list Analog Input Point 31 End of list N/A

DNP Notes

Note 1: Scale Factor Note that a scale factor of 0.1 is equivalent to a multiplier of 10 (i.e. the value will be 10 

Note 2: Binary Input Block Selection: [NOT USED, CTL EVENTS 1-16, CTL EVENTS 17-32, CTL EVENTS 33-48,CTL EVENTS 49-64, CTL 
EVENTS 65-80, CTL EVENTS 81-96, CTL EVENTS 97-112, CTL EVENTS 113-128, SWITCHGEAR 

Product Setup > Communication Settings > IEC 870-5-104

Setting Description Name Default Value Step Range User 
Value

Enable or disable the protocol 
operation

Function DISABLED N/A [DISABLED – ENABLED]

Listening TCP port in the relay TCP Port 2404 N/A [0 : 65535]

Address in the ASDU header Common Addr of 
ASDU

255 N/A [0 : 65535]

Number of seconds for instantaneous 
metering

Cyclic Meter Period 0 1 s [0 : 3600]

Synchronization Event  Synchronization Event 0 0 N/A [0 : 3600]

1st Octect of IP address of 104 master 
1

IEC104 NET1 CLI1 
OCTET1

0 N/A [0 : 255]

2nd Octect of IP address of 104 
master 1

IEC104 NET1 CLI1 
OCTET2

0 N/A [0 : 255]
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Product Setup > Communication Settings > IEC 870-5-104 (CONT.)

Setting Description Name Default Value Step Range User 
Value

3nd Octect of IP address of 104 
master 1

IEC104 NET1 CLI1 
OCTET3

0 N/A [0 : 255]

4th Octect of IP address of 104 master 
1

IEC104 NET1 CLI1 
OCTET4

0 N/A [0 : 255]

1st Octect of IP address of 104 master 
2

IEC104 NET1 CLI2 
OCTET1

0 N/A [0 : 255]

2nd Octect of IP address of 104 
master 2

IEC104 NET1 CLI2 
OCTET2

0 N/A [0 : 255]

3nd Octect of IP address of 104 
master 2

IEC104 NET1 CLI2 
OCTET3

0 N/A [0 : 255]

4th Octect of IP address of 104 master 
2

IEC104 NET1 CLI2 
OCTET4

0 N/A [0 : 255]

Enable or disable the protocol 
operation

Function 2 DISABLED N/A

Listening TCP port in the relay TCP Port 2 2404 N/A [0 : 65535]

Address in the ASDU header Common Addr of 
ASDU 2

255 N/A [0 : 65535]

1st Octect of IP address of 104 master 
1

IEC104 NET2 CLI1 
OCTET1

0 N/A [0 : 255]

2nd Octect of IP address of 104 
master 1

IEC104 NET2 CLI1 
OCTET2

0 N/A [0 : 255]

3nd Octect of IP address of 104 
master 1

IEC104 NET2 CLI1 
OCTET3

0 N/A [0 : 255]

4th Octect of IP address of 104 master 
1

IEC104 NET2 CLI1 
OCTET4

0 N/A [0 : 255]

1st Octect of IP address of 104 master 
2

IEC104 NET2 CLI2 
OCTET1

0 N/A [0 : 255]

2nd Octect of IP address of 104 
master 2

IEC104 NET2 CLI2 
OCTET2

0 N/A [0 : 255]

3nd Octect of IP address of 104 
master 2

IEC104 NET2 CLI2 
OCTET3

0 N/A [0 : 255]

4th Octect of IP address of 104 master 
2

IEC104 NET2 CLI2 
OCTET4

0 N/A [0 : 255]

IEC104 SCALE CURRENT IEC104 SCALE 
CURRENT

1 [0,00001; 0,0001; 0,001; 
0,01; 0,1; 1; 10; 100; 1000; 
10000]

IEC104 SCALE VOLTAGE IEC104 SCALE 
VOLTAGE

1

IEC104 SCALE POWER IEC104 SCALE POWER 1

IEC104 SCALE ENERGY IEC104 SCALE ENERGY 1

IEC104 SCALE OTHER IEC104 SCALE OTHER 1

IEC104 DEADBAND CURRENT IEC104 DEADBAND 
CURRENT

30000 [0 : 65535]

IEC104 DEADBAND VOLTAGE IEC104 DEADBAND 
VOLTAGE

30000 [0 : 65535]

IEC104 DEADBAND POWER IEC104 DEADBAND 
POWER

30000 [0 : 65535]
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Product Setup > Communication Settings > IEC 870-5-104 (CONT.)

Setting Description Name Default Value Step Range User 
Value

IEC104 DEADBAND ENERGY IEC104 DEADBAND 
ENERGY

30000 [0 : 65535]

IEC104 DEADBAND OTHER IEC104 DEADBAND 
OTHER

30000 [0 : 65535]

IEC104 IOA BINARIES IEC104 IOA BINARIES 1000 [0 : 65535]

IEC104 IOA DOUBLE POINTS IEC104 IOA DOUBLE 
POINTS

1500 [0 : 65535]

IEC104 IOA ANALOGS IEC104 IOA ANALOGS 2000 [0 : 65535]

IEC104 IOA COUNTERS IEC104 IOA COUNTERS 4000 [0 : 65535]

IEC104 IOA COMMANDS IEC104 IOA 
COMMANDS

3000 [0 : 65535]

IEC104 IOA ANALOG PARAMETERS IEC104 IOA ANALOG 
PARAMETERS

5000 [0 : 65535]

IEC 870-5-104 Notes

Note 1: Cyclic Meter Period 0 value means no spontaneous metering

Product Setup > Communication Settings > SNTP

Setting Description Name Default Value Step Range User 
Value

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Port used UDP port 123 1 [1 : 65535]

IP Address OCT 1 Server IP Oct 1 0 1 [1 : 255]

IP Address OCT 2 Server IP Oct 2 0 1 [1 : 255]

IP Address OCT 3 Server IP Oct 3 0 1 [1 : 255]

IP Address OCT 4 Server IP Oct 4 0 1 [1 : 255]

Product Setup > Communication Settings > PTP 1588

Setting Description Name Default Value Step Range User 
Value

Function permission PTP FUNCTION DISABLE [DISABLE; ENABLE]

Port A, B Path Delay Adder PORTA DELAY ADDER 0 ns [0 : 60000]

Port A Path Delay Asymmetry PORTA DELAY ASYM 0 ns [-1000 : 1000]

Port B Path Delay Adder PORTB DELAY ADDER 0 ns [0 : 60000]

Port B Path Delay Asymmetry PORTB DELAY ASYM 0 ns [-1000 : 1000]

Strict Power Profile STRICT POWER 
PROFILE

DISABLED DISABLED/ENABLED

PTP domain number PTP DOMAIN NUMBER 0 [0 : 255]

PTP VLAN Priority PTP VLAN PRIORITY 4 [0 : 7]

PTP VLAN Identification PTP VLAN ID 0 [0 : 4095]

Reference time defining the origin of a 
time scale is termed the epoch.

PTP EPOCH UTC SINCE 2000 UTC SINCE 2000; UTC SINCE 
1970; UTC SINCE 1900



G-8 C650 BAY CONTROLLER & MONITORING SYSTEM 1601-0801-A2

G.1 FACTORY DEFAULT SETTINGS APPENDIX G:  FACTORY DEFAULT CONFIGURATION

Product Setup > Communication Settings > Routing

Setting Description Name Default Value Step Range User 
Value

1st octet of Gateway Default RT GWY Oct1 0  1 [0 : 255]

2nd octet of Gateway Default RT GWY Oct2 0  1 [0 : 255]

3nd octet of Gateway Default RT GWY Oct3 0  1 [0 : 255]

4th octet of Gateway Default RT GWY Oct4 0  1 [0 : 255]

sets the destination IPv4 route Static RT1 IP Oct1 0  1 [0 : 255]

sets the destination IPv4 route Static RT1 IP Oct2 0  1 [0 : 255]

sets the destination IPv4 route Static RT1 IP Oct3 0  1 [0 : 255]

sets the destination IPv4 route Static RT1 IP Oct4 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT1 Mask Oct1 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT1 Mask Oct2 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT1 Mask Oct3 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT1 Mask Oct4 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT1 GWY Oct1 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT1 GWY Oct2 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT1 GWY Oct3 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT1 GWY Oct4 0  1 [0 : 255]

sets the destination IPv4 route Static RT2 IP Oct1 0  1 [0 : 255]

sets the destination IPv4 route Static RT2 IP Oct2 0  1 [0 : 255]

sets the destination IPv4 route Static RT2 IP Oct3 0  1 [0 : 255]

sets the destination IPv4 route Static RT2 IP Oct4 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT2 Mask Oct1 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT2 Mask Oct2 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT2 Mask Oct3 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT2 Mask Oct4 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT2 GWY Oct1 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT2 GWY Oct2 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT2 GWY Oct3 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT2 GWY Oct4 0  1 [0 : 255]

sets the destination IPv4 route Static RT3 IP Oct1 0  1 [0 : 255]

sets the destination IPv4 route Static RT3 IP Oct2 0  1 [0 : 255]

sets the destination IPv4 route Static RT3 IP Oct3 0  1 [0 : 255]

sets the destination IPv4 route Static RT3 IP Oct4 0  1 [0 : 255]
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sets the IP mask associated with the 
route

Static RT3 Mask Oct1 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT3 Mask Oct2 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT3 Mask Oct3 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT3 Mask Oct4 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT3 GWY Oct1 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT3 GWY Oct2 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT3 GWY Oct3 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT3 GWY Oct4 0  1 [0 : 255]

sets the destination IPv4 route Static RT4 IP Oct1 0  1 [0 : 255]

sets the destination IPv4 route Static RT4 IP Oct2 0  1 [0 : 255]

sets the destination IPv4 route Static RT4 IP Oct3 0  1 [0 : 255]

sets the destination IPv4 route Static RT4 IP Oct4 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT4 Mask Oct1 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT4 Mask Oct2 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT4 Mask Oct3 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT4 Mask Oct4 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT4 GWY Oct1 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT4 GWY Oct2 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT4 GWY Oct3 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT4 GWY Oct4 0  1 [0 : 255]

sets the destination IPv4 route Static RT5 IP Oct1 0  1 [0 : 255]

sets the destination IPv4 route Static RT5 IP Oct2 0  1 [0 : 255]

sets the destination IPv4 route Static RT5 IP Oct3 0  1 [0 : 255]

sets the destination IPv4 route Static RT5 IP Oct4 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT5 Mask Oct1 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT5 Mask Oct2 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT5 Mask Oct3 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT5 Mask Oct4 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT5 GWY Oct1 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT5 GWY Oct2 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT5 GWY Oct3 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT5 GWY Oct4 0  1 [0 : 255]
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sets the destination IPv4 route Static RT6 IP Oct1 0  1 [0 : 255]

sets the destination IPv4 route Static RT6 IP Oct2 0  1 [0 : 255]

sets the destination IPv4 route Static RT6 IP Oct3 0  1 [0 : 255]

sets the destination IPv4 route Static RT6 IP Oct4 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT6 Mask Oct1 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT6 Mask Oct2 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT6 Mask Oct3 0  1 [0 : 255]

sets the IP mask associated with the 
route

Static RT6 Mask Oct4 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT6 GWY Oct1 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT6 GWY Oct2 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT6 GWY Oct3 0  1 [0 : 255]

sets the gateway to reach the 
destination IP route

Static RT6 GWY Oct4 0  1 [0 : 255]

Setpoint > Product Setup > Modbus User Map

Setting Description Name Default Value Step Range User 
Value

Address 00 for Modbus user map Address 00 0 N/A [0000 : FFFF]

Address 01 for Modbus user map Address 01 0 N/A [0000 : FFFF]

... ... ...

Address 254 for Modbus user map Address 254 0 N/A [0000 : FFFF]

Address 255 for Modbus user map Address 255 0 N/A [0000 : FFFF]

Setpoint > Product Setup > Oscillography

Setting Description Name Default Value Step Range User 
Value

Function Permission Function ENABLED N/A [DISABLED – ENABLED]

Prefault Trigger Position 30 1% [5 : 95]

Samples per cycle Samples/Cycle 64 N/A [4 – 8 – 16 –32 – 64]

Maximum number of oscillos Max. Number Osc. 4 1 oscillo [1 : 20]

Automatic oscillography overwrite Automatic Overwrite DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

Setpoint > Product Setup > Data Logger

Setting Description Name Default Value Step Range User 
Value

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Data logger Rate Data Logger Rate 1 s N/A [1 s, 5 min, 10 min, 15 min, 
20 min, 30 min, 60 min.]

Data Logger analog channels X Data Logger Chnl X None N/A [1 to 16]

Setpoint > Product Setup > Demand

Setting Description Name Default Value Step Range User 
Value

Function permission Demand Function DISABLED N/A [DISABLED – ENABLED]
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Demand method for current values CRNT Demand 
Method

THERMAL 
EXPONENTIAL

N/A [BLOCK INTERVAL -

ROLLING DEMAND -

THERMAL EXPONENTIAL]

Demand method for Power values POWER Demand 
Method

THERMAL 
EXPONENTIAL

N/A [BLOCK INTERVAL -

ROLLING DEMAND -

THERMAL EXPONENTIAL]

Demand interval Demand Interval 5 Minutes N/A [5 – 10 – 15 – 20– 30–60]

Trigger Enabled Trigger Enabled DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

Setpoint > Product Setup > Time Settings

Setting Description Name Default Value Step Range User 
Value

Local time zone offset Universal 
Coordinated Time

LOC. TIME OFFS. UTC 0  1 [-24,0 : 24,0]

To follow DST rules DAYLIG. SAVINGS TIME DISABLED  NA [DISBLED; ENABLED]

Set the start month of the DST DST START MONTH MAR  MONTH January to December

Set the start weekday of the DST DST START WEEKDAY SUNDAY  DAY Monday to Sunday

Set the start day instance DST START DAY INST LAST  NA First; Second; Third; Fourth; 
Last

Set the starting hour of the DST DST START HOUR 2  1 [0 : 23]

Set the Stop month of the DST DST STOP MONTH OCT  Month January to December

Set the stop weekday of the DST DST STOP WEEKDAY SUNDAY  Day Monday to Sunday

Set the stop day instance DST STOP DAY INST LAST  NA First; Second; Third; Fourth; 
Last

Set the stop hour of the DST DST STOP HOUR 2  1 [0 : 23]

IRIG-B local time IRIG-B LOCAL TIME OFF  NA [ON; OFF]

Function permission IRIGB Function DISABLED NA ENABLLED; DISABLED

Establish the sync priority PTP IRIGB Priority PTP-1588  NA PTP-1588; IRIG_B
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Setpoint > System Setup > General Settings

Setting Description Name Default Value Step Range User 
Value

Phase CT ratio Phase CT Ratio 1.0 0.1 [1.0 : 6000.0]

Ground CT ratio Ground CT Ratio 1.0 0.1 [1.0 : 6000.0]

Sensitive ground CT ratio Stv Ground CT Ratio 1.0 0.1 [1.0 : 6000.0]

Phase VT ratio Phase VT Ratio 1.0 0.1 [1.0 : 6000.0]

Phase VT connection Phase VT Connection WYE N/A [WYE – DELTA]

Rated voltage Nominal Voltage 100.0 0.1 [1.0 : 250.0]

Rated Frequency Nominal Frequency 50 Hz Hz [50-60]

Phase rotation Phase Rotation ABC N/A [ABC – ACB]

Frequency reference Frequency Reference VI N/A [VI-VII-VIII]

Auxiliary Voltage Auxiliary Voltage VX N/A [VX – VN]

Snapshot Event generation Snapshot Events DISABLED N/A [DISABLED – ENABLED]

Primary meter units Primary meter units kA_kV NA A_V; kA_kV

Device name Device name NA NA NA

Setpoint > System Setup > Flex Curves

Flex Curves A > Flex Curves B> Flex Curves C > Flex Curves D

Setting Description Name Default Value Step Range User 
Value

Values for reset points 0.00 pkp Time 0.00xPKP [RST] 0.000 0.001 s [0.000 : 65.535]

Values for reset points 0.05 pkp Time 0.05xPKP [RST] 0.000 0.001 s [0.000 : 65.535]

… … … 0.001 s [0.000 : 65.535]

Values for reset points 0.97 pkp Time 0.97xPKP [RST] 0.000 0.001 s [0.000 : 65.535]

Values for reset points 0.98 pkp Time 0.98xPKP [RST] 0.000 0.001 s [0.000 : 65.535]

Values for operation points 1.03 pkp Time 1.03xPKP [OP] 0.000 0.001 s [0.000 : 65.535]

Values for operation points 1.05 pkp Time 1.05xPKP [OP] 0.000 0.001 s [0.000 : 65.535]

… … … 0.001 s [0.000 : 65.535]

Values for operation points 19.50 pkp Time 19.50xPKP [OP] 0.000 0.001 s [0.000 : 65.535]

Values for operation points 20.00 pkp Time 20.00xPKP [OP] 0.000 0.001 s [0.000 : 65.535]

Setpoint > System Setup > Breaker > Breaker Settings

Setting Description Name Default Value Step Range User 
Value

Number of Switchgear selected as 
breaker

Number of Switchgear 1 1 [1 : 16]

Maximum value of KI2t Maximum KI2t 9999.99 0.01(KA)2 s [0.00 : 9999.99]

KI2t integration time KI2t Integ. Time 0.03 0.01s [0.03 : 0.25]

Maximum number of openings Maximum Openings 9999 1 [0 : 9999]

Maximum Openings in one hour Max.Openings 1 hour 40 1 [1 : 60]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

Setpoint > System Setup > Breaker > Breaker Maintenance

Setting Description Name Default Value Step Range User 
Value

KI2t Counter Phase A KI2t BKR Ph A Cnt 0.00 0.01 (KA)2 s [0.00 : 9999.99]

KI2t Counter Phase B KI2t BKR Ph B Cnt 0.00 0.01 (KA)2 s [0.00 : 9999.99]

KI2t Counter Phase C KI2t BKR Ph C Cnt 0.00 0.01 (KA)2 s [0.00 : 9999.99]

Openings counter BKR Openings Cnt 0 1 [0 : 9999]

Closings counter BKR Closings Cnt 0 1 [0 : 9999]
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Setpoint > System Setup > Switchgear

Setting Description Name Default Value Step Range User 
Value

Snapshot Event generation for 
switchgear #1

Snapshot Events 
SWGR 1

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #2

Snapshot Events 
SWGR 2

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #3

Snapshot Events 
SWGR 3

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #4

Snapshot Events 
SWGR 4

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #5

Snapshot Events 
SWGR 5

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #6

Snapshot Events 
SWGR 6

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #7

Snapshot Events 
SWGR 7

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #8

Snapshot Events 
SWGR 8

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #9

Snapshot Events 
SWGR 9

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #10

Snapshot Events 
SWGR 10

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #11

Snapshot Events 
SWGR 11

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #12

Snapshot Events 
SWGR 12

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #13

Snapshot Events 
SWGR 13

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #14

Snapshot Events 
SWGR 14

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #15

Snapshot Events 
SWGR 15

DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #16

Snapshot Events 
SWGR 16

DISABLED N/A [DISABLED – ENABLED]

Setpoint > System Setup > Miscellaneous

Setting Description Name Default Value Step Range User 
Value

Relay out of service status Relay Out Of Service ENABLED N/A [DISABLED – ENABLED]

Set to local or remote Local/Remote Blocked OFF N/A ON; OFF

Active language on the relay Active Language 0 N/A [0 : 1]

Setpoint > Control Elements > Synchrocheck
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Setting Description Name Default Value Step Range User 
Value

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Dead bus voltage level Dead Bus Level 10.00 0.01 V [0.00 : 300.00]

Live bus voltage level Live Bus Level 50.00 0.01 V [0.00 : 300.00]

Dead line voltage level Dead Line Level 10.00 0.01 V [0.00 : 300.00]

Live line voltage level Live Line Level 50.00 0.01 V [0.00 : 300.00]

Voltage Difference Max Volt Difference 10.00 0.01 V [2.00 : 300.00]

Angle Difference Max Angle Difference 10.0 0.1 Deg [2.0 : 80.0]

Frequency Slip Max Freq Difference 20 10 mHz [10 : 5000]

Breaker Closing time Time 0.50 0.01 s [0.01 : 600.00]

Dead Line – Dead Bus Function 
permission

DL-DB Function DISABLED N/A [DISABLED – ENABLED]

Live Line – Dead Bus Function 
permission

LL-DB Function DISABLED N/A [DISABLED – ENABLED]

Dead Line – Live Bus Function 
permission

DL-LB Function DISABLED N/A [DISABLED – ENABLED]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

Setpoint > Control Elements > Autoreclose

Setting Description Name Default Value Step Range User 
Value

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Maximum Number of shots Max Number Shots 1 N/A [1 : 4]

Dead time 1 Dead Time 1 0.00 0.01 s [0.00 : 900.00]

Dead time 2 Dead Time 2 0.00 0.01 s [0.00 : 900.00]

Dead time 3 Dead Time 3 0.00 0.01 s [0.00 : 900.00]

Dead time 4 Dead Time 4 0.00 0.01 s [0.00 : 900.00]

Reclaim time or reset lockout delay Reclaim Time 0.00 0.01 s [0.00 : 900.00]

Reclose conditions permission Cond. Permission DISABLED N/A [DISABLED – ENABLED]

Hold time Hold Time 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Time 0.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

Setpoint > Control Elements > Breaker Failure

Setting Description Name Default Value Step Range User 
Value

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Supervision (retrip) pickup level Supervision Pickup 1.00 0.01 A [0.05 : 160.00]

Hiset pickup level Hiset Pickup 5.00 0.01 A [0.05 : 160.00]

Lowset pickup level Lowset Pickup 2.00 0.01 A [0.05 : 160.00]

Internal arc pickup level Internal Arc Pickup 0.10 0.01 A [0.05 : 160.00]

Internal arc time delay Internal Arc Delay 10.00 0.01 s [0.00 : 900.00]

Retrip time delay Supervision Delay 10.00 0.01 s [0.00 : 900.00]

Hiset time delay HiSet Delay 10.00 0.01 s [0.00 : 900.00]

Lowset time delay LowSet Delay 10.00 0.01 s [0.00 : 900.00]

Second stage time delay 2nd Step Delay 10.00 0.01 s [0.00 : 900.00]

WITHOUT current element time delay No Current Delay 10.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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Setpoint > Control Elements > Pulse Counters
Setting Description Name Default Value Step  Range User 

Value

Pulse counter enabling setting CntPulses Enabled X DISABLED N/A [DISABLED – ENABLED]

Name of the pulse counter CntPulses Name X Pulse Counter 1 N/A N/A

Multiplier factor for the pulse counter CntPulses Factor X 1.000 0.001 [0.000 : 65000.000]

Overflow value for the pulse counter CntPulses Overflow X 65535 1 [0 : 1000000]

Board selection for the pulse counter CntPulses Board 
Origin X

F N/A [F,G,H,I]

Input index inside the selected board CntPulses Input Origin 
X

1 1 [1 : 32]

Note: X is the pulse counter index, up to 8. 

Setpoint > Control Elements > Analog Comparators

Setting Description Name Default Value Step  Range User 
Value

Generic Analog Function Permission Analog Function DISABLED N/A [DISABLED – ENABLED]

Generic Snapshot Events Generation Analog Snapshot 
Events

DISABLED N/A [DISABLED – ENABLED]

Analog Input Value Selection Analog Input X None N/A [All available analog values]

Analog Maximum Threshold Value Analog Maximum X 1.000 0.001 [-100000.000 : 100000.000]

Analog Minimum Threshold Value Analog Minimum X 1.000 0.001 [-100000.000 : 100000.000]

Analog Delay for Activation Signal Analog Delay X 0.00 0.01 s [0.00 : 900.00]

Analog Hysteresis for the Deadband Analog Hysteresis X 1.0 0.1 [0.0 : 50.0]

Analog Direction for Activation Inside 
or Outside the Deadband

Analog Direction X OUT N/A [IN-OUT]

Note: X is the analog comparator index, up to 20

Setpoint > Control Elements > Digital Counters

Setting Description Name Default Value Step  Range User 
Value

Function permission DigCnt 1 Function DISABLED  NA

Digital Counter 1 name DigCnt 1 Name  NA

Digital counter 1 Preset DigCnt 1 Preset 0  1 [-2147483648 : 
2147483647]

Digital counter 1 Compare DigCnt 1 Compare 0  1 [-2147483648 : 
2147483647]

Function permission DigCnt 2 Function DISABLED  NA

Digital Counter 2 name DigCnt 2 Name  NA

Digital counter 2 Preset DigCnt 2 Preset 0  1 [-2147483648 : 
2147483647]

Digital counter 2 Compare DigCnt 2 Compare 0  1 [-2147483648 : 
2147483647]

Function permission DigCnt 3 Function DISABLED  NA

Digital Counter 3 name DigCnt 3 Name  NA

Digital counter 3 Preset DigCnt 3 Preset 0  1 [-2147483648 : 
2147483647]

Digital counter 3 Compare DigCnt 3 Compare 0  1 [-2147483648 : 
2147483647]

Function permission DigCnt 4 Function DISABLED  NA

Digital Counter 4 name DigCnt 4 Name  NA

Digital counter 4 Preset DigCnt 4 Preset 0  1 [-2147483648 : 
2147483647]
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Digital counter 4 Compare DigCnt 4 Compare 0  1 [-2147483648 : 
2147483647]

Function permission DigCnt 5 Function DISABLED  NA

Digital Counter 5 name DigCnt 5 Name  NA

Digital counter 5 Preset DigCnt 5 Preset 0  1 [-2147483648 : 
2147483647]

Digital counter 5 Compare DigCnt 5 Compare 0  1 [-2147483648 : 
2147483647]

Function permission DigCnt 6 Function DISABLED  NA

Digital Counter 6 name DigCnt 6 Name  NA

Digital counter 6 Preset DigCnt 6 Preset 0  1 [-2147483648 : 
2147483647]

Digital counter 6 Compare DigCnt 6 Compare 0  1 [-2147483648 : 
2147483647]

Function permission DigCnt 7 Function DISABLED  NA

Digital Counter 7 name DigCnt 7 Name  NA

Digital counter 7 Preset DigCnt 7 Preset 0  1 [-2147483648 : 
2147483647]

Digital counter 7 Compare DigCnt 7 Compare 0  1 [-2147483648 : 
2147483647]

Function permission DigCnt 8 Function DISABLED  NA

Digital Counter 8 name DigCnt 8 Name  NA

Digital counter 8 Preset DigCnt 8 Preset 0  1 [-2147483648 : 
2147483647]

Digital counter 8 Compare DigCnt 8 Compare 0  1 [-2147483648 : 
2147483647]

Snapshot Event Generation Snapshot Events ENABLED  NA [ENABLED; DISABLED]
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Setpoint > Inputs/Outputs > Contact I/O >

Board F > Board G > Board H > Board J >Board 2h > Board 2j

Setting Description Name Default Value Step Range User 
Value

I/O board type (available only for CIO 
modules)

I/O Board Type_X NONE N/A [NONE,
16 INP + 8OUT,
8 INP + 8OUT + SUPV
32 INP
16 INP + 8 ANA]

Input activation voltage threshold 
Group A

Voltage Threshold A_X 80 1 V [10 : 230]

Input activation voltage threshold 
Group B

Voltage Threshold B_X 80 1 V [10 : 230]

Input activation voltage threshold 
Group C

Voltage Threshold C_X 80 1 V [10 : 230]

Input activation voltage threshold 
Group D

Voltage Threshold D_X 80 1 V [10 : 230]

Debounce time for Group A Debounce Time A_X 15 1 ms [1 : 50]

Debounce time for Group B Debounce Time B_X 15 1 ms [1 : 50]

Debounce time for Group C Debounce Time C_X 15 1 ms [1 : 50]

Debounce time for Group D Debounce Time D_X 15 1 ms [1 : 50]

Input type Input Type_X_CCY 
(CCY)

POSITIVE N/A [POSITIVE-EDGE,
NEGATIVE-EDGE,
POSITIVE,
NEGATIVE]

Input signal time delay Delay Input 
Time_X_CCY (CCY)

0 1 ms [0 : 60000]

Output logic type Output Logic_X_0Z POSITIVE N/A [POSITIVE,
NEGATIVE]

Output type Output Type_X_0Z NORMAL N/A [NORMAL,
PULSE,
LATCH]

Output pulse length Pulse Output 
Time_X_0Z

10000 1 ms [0 : 60000]

Analog Inputs Range Range_X_0Z NONE N/A [NONE,
-1 to 0mA,
0 to 1 mA,
-1 to 1 mA,
0 to 5 mA,
0 to 10 mA]

Minimum Value Min_Value_X_0Z 0.00 0.01 [ -9999.99 : 9999.99]

Maximum Value Max_Value_X_0Z 0.00 0.01 [ -9999.99 : 9999.99]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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Note 2: Description of X, Y and Z in input/output boards

X F,  G, H, J, 2H, or 2J the I/O board name, depending on the Relay model.

F and G are internal Relay boards, and H, J, 2H, and 2J are additional boards available in CIO 
modules (remote Bus CAN I/O module). 

For the I/O board selection in the relay 
model:

I/O BOARD TYPE

ASSOCIATED DIGIT ENERVISTA 650 
SETUP BOARD 
SETTINGS

BOARD TYPE

0 NONE None

1 16 INP+ 8 OUT Mixed

2 8 INP +8 OUT +SUPV Supervision

4 32 INP 32 digital inputs

5 16 INP + 8 ANA 16 digital inputs + 8 analog inputs

CCY Is the name used for inputs in I/O boards

Mixed, 16 digital inputs: CC1….CC16

Supervision: 8 digital inputs: CC1,..., CC8

32 INP: 32 digital inputs; CC1,...,CC32

0Z Is the name used for the different outputs in I/O boards, 8 outputs available for any of the two 
types of board (01,…., 08)

Setpoint > Inputs/Outputs > Remote Comms
Setting Description Name Default Value Step Range User 

Value

Remote comms selection Remote Comms NONE N/A [NONE – GSSE – GOOSE]

SETTING DESCRIPTION FOR GSSE

Remote comms selection Remote Comms GSSE N/A [NONE – GSSE – GOOSE]

Device Identification 650 ID C650 N/A

Hold time signal send by the 
transmitting device

Hold Time 10000 1 ms [1000 : 60000]

Snapshot Events Generation Snapshot Events 
Remote Out

DISABLED N/A [DISABLED – ENABLED]

Remote Device Description Remote Device X Remote Device X N/A

Bit Pair Selection Bit Pair X None N/A [DNA-1 to DNA-32 – 
UserSt-1 to UserSt-64]

Default Value Selection Default Value X OFF N/A [OFF –  ON – LATEST OFF – 
LATEST ON]

SETTING DESCRIPTION FOR GOOSE

Remote comms selection Remote Comms GOOSE N/A [NONE – GSSE – GOOSE]

Default Value Selection Default Value X OFF N/A [OFF – ON – LATEST OFF – 
LATEST ON]

Note: X is the Remote Device index, up to 32
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G.2  Factory default configuration
Note:

SOURCE COLUMN

This column allows the user to select the simple or complex (OR signal/virtual output) operand that activates the selected 
elements for configuration of the relay.

If more than one operand is selected, the relay performs an OR gate to activate the selected element.

SIGNAL LOGIC COLUMN

This refers to each individual signal selected on its left. NOT legend means that the signal is inverted.

SOURCE LOGIC COLUMN

This refers to the whole SOURCE signal selected on its left. NOT legend means that the signal is inverted. If more than one 
operand is selected, the OR gate output is inverted.

  
SETPOINT > RELAY CONFIGURATION > OUTPUTS

OUTPUT ID OUTPUT NAME SOURCE SIGNAL LOGIC SOURCE LOGIC

CONT OP OPER_F_01 CONT OP OPER_F_01 VO_000_PROTECTION_ALARM

CONT OP OPER_F_02 Not Configured

CONT OP OPER_F_03 Not Configured

CONT OP OPER_F_04 Not Configured

CONT OP OPER_F_05 Not Configured

CONT OP OPER_F_06 Not Configured

CONT OP OPER_F_07 Not Configured

CONT OP OPER_F_08 Not Configured

CONT OP OPER_G_01 Not Configured

CONT OP OPER_G_02 Not Configured

CONT OP OPER_G_03 Not Configured

CONT OP OPER_G_04 Not Configured

CONT OP OPER_G_05 Not Configured

CONT OP OPER_G_06 Not Configured

CONT OP OPER_G_07 Not Configured

CONT OP OPER_G_08 Not Configured

CONT OP RESET_F_01 Not Configured

CONT OP RESET_F_02 Not Configured

CONT OP RESET_F_03 Not Configured

CONT OP RESET_F_04 Not Configured

CONT OP RESET_F_05 Not Configured

CONT OP RESET_F_06 Not Configured

CONT OP RESET_F_07 Not Configured

CONT OP RESET_F_08 Not Configured

CONT OP RESET_G_01 Not Configured

CONT OP RESET_G_02 Not Configured

CONT OP RESET_G_03 Not Configured
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CONT OP RESET_G_04 Not Configured

CONT OP RESET_G_05 Not Configured

CONT OP RESET_G_06 Not Configured

CONT OP RESET_G_07 Not Configured

CONT OP RESET_G_08 Not Configured  

SETPOINT > RELAY CONFIGURATION > LEDS

LED SOURCE SOURCE LOGIC LOGIC LED NAME 

LED01 VO_000_PROTECTION_ALARM PROT ALARM

LED02 Not Configured

LED03 Not Configured

LED04 Not Configured

LED05 Not Configured

LED06 Not Configured

LED07 Not Configured

LED08 Not Configured

LED09 Not Configured

LED10 Not Configured

LED11 Not Configured

LED12 Not Configured

LED13 Not Configured

LED14 Not Configured

LED15 Not Configured

SETPOINT > RELAY CONFIGURATION > OSCILLOGRAPHY

DIGITAL CHANNEL NAME SOURCE SIGNAL LOGIC SOURCE LOGIC

DIG_CHANNEL#1 Not Configured Not Configured

DIG_CHANNEL#2 Not Configured Not Configured

DIG_CHANNEL#3 Not Configured Not Configured

DIG_CHANNEL#4 Not Configured Not Configured

DIG_CHANNEL#5 Not Configured Not Configured

DIG_CHANNEL#6 Not Configured Not Configured

DIG_CHANNEL#7 Not Configured Not Configured

DIG_CHANNEL#8 Not Configured Not Configured

DIG_CHANNEL#9 Not Configured Not Configured

DIG_CHANNEL#10 Not Configured Not Configured

DIG_CHANNEL#11 Not Configured Not Configured

DIG_CHANNEL#12 Not Configured Not Configured

DIG_CHANNEL#13 Not Configured Not Configured

DIG_CHANNEL#14 Not Configured Not Configured

DIG_CHANNEL#15 Not Configured Not Configured

DIG_CHANNEL#16 Not Configured Not Configured

OSCILLO TRIGGER Not Configured Not Configured

SETPOINT > RELAY CONFIGURATION > OUTPUTS

OUTPUT ID OUTPUT NAME SOURCE SIGNAL LOGIC SOURCE LOGIC
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SETPOINT > RELAY CONFIGURATION > OPERATIONS

OPERATION OPERATION TEXT SETTINGS VALUE/SOURCE

Operation1 Not configured INTERLOCK(LOGIC) Not configured

FINAL STATES AND LOGIC Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT Not configured

CHANNELS Not configured

Operation2 Not configured INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT Not configured

CHANNELS Not configured

Operation3 LEDS RESET INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation4 THERMAL RESET INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation5 BRK COUNTERS RESET INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation6 ENERGY RESET INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL
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Operation7 DEMAND RESET INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured
INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation8  TRIGGER OSCILLO INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation9 Not configured INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT Not configured

CHANNELS Not configured

..... ...... INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT Not configured

CHANNELS Not configured

Operation24 Not configured INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT Not configured

CHANNELS Not configured

SETPOINT > RELAY CONFIGURATION > EVENTS

EVENT NAME SOURCE SIGNAL LOGIC SOURCE LOGIC

EV1 Not Configured

EV2 Not Configured

... ...

EV128 Not Configured

SETPOINT > RELAY CONFIGURATION > OPERATIONS

OPERATION OPERATION TEXT SETTINGS VALUE/SOURCE
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SETPOINT > RELAY CONFIGURATION > SWITCHGEAR

SWITCHGEAR SETTING VALUE/SOURCE SIGNAL LOGIC SOURCE LOGIC

SWITCHGEAR 2 CONTACTS Not Configured

OPENING TIME Not Configured

CLOSING TIME Not Configured

CONTACT A SOURCE Not Configured

CONTACT B SOURCE Not Configured

OPEN TEXT Not Configured

ALARM Not Configured

CLOSED TEXT Not Configured

ALARM Not Configured

ERROR 00 TEXT Not Configured

ALARM Not Configured

ERROR 11 TEXT Not Configured

ALARM Not Configured

OPENING INIT Not Configured

CLOSING INIT Not Configured

... ... ... ... ...

SWITCHGEAR 16 CONTACTS Not Configured

OPENING TIME Not Configured

CLOSING TIME Not Configured

CONTACT A SOURCE Not Configured

CONTACT B SOURCE Not Configured

OPEN TEXT Not Configured

ALARM Not Configured

CLOSED TEXT Not Configured

ALARM Not Configured

ERROR 00 TEXT Not Configured

ALARM Not Configured

ERROR 11 TEXT Not Configured

ALARM Not Configured

OPENING INIT Not Configured

CLOSING INIT Not Configured
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C650 Bay Controller & Monitoring System

Appendix H:  Miscellaneous

GE
Grid Solutions

MISCELLANEOUS 

H.1  Warranty
For products shipped as of 1 October 2013, GE warrants most of its GE manufactured products for 10 years. For warranty 
details including any limitations and disclaimers, see our Terms and Conditions at https://www.gegridsolutions.com/
multilin/warranty.htm
For products shipped before 1 October 2013, the standard 24-month warranty applies.
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H.2  Revision History

H.2.1  Major Updates
For information on the updates included in this release of the C650 Bay Controller & Monitoring System, please refer to the 
latest release notes for Firmware version 7.7x, EnerVista F650 Setup version 8.1x online.

MANUAL P/N RELEASE DATE

113541A 2009

113541B 2011

113541C July 2015

113541D December 2018

1601-0801-A1 November 2020

1601-0801-A2 March 2021


